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Mark of the Unicom License TO PERSONS WHO PURCHASE OR USE THIS PRODUCT: 
Agreement and Limited — Carefully read all the terms and conditions of this agreement before using this software package."Using this software package indicates your 

Warranty acceptance of the terms and conditions of this license agreement. 

Mark of the Unicom, Inc. (MOTU”) owns both this program and its documentation. Both the program and the documentation are protected 
under applicable copyright laws. Your right to use the program and the documentation are limited to the terms and conditions described herein. 

License 
YOU MAY: (a) use the enclosed program on a single computer; (b) physically transfer the program from one computer to another tit that 
the program is used on only one computer ata tme and that you remove any copies of the program from the computer from which the program 
is being transferred; (c) make copies of the program solely for backup purposes. You must reproduce and include the copyright notice on a label 

on any backup copy. 

YOU MAY NOT: (a) distribute copies of the program or the documentation to others; (b) rent, lease or grant sublicenses or other rights to the 
program; (c) provide use of the program in a computer service business, network, time-sharing, multiple CPU or multiple user arrangement 
without the prior written consent of MOTU; (d) translate or otherwise alter the program or related documentation without the prior written 
consent of MOTU. 

Term 
Your license to use the program and documentation will automatically terminate if you fail to comply with the terms of this Agreement. If this 
license is terminated you agree to destroy all copies of the program and documentation. 

Limited Warranty 
y MOTU warrants to the original licensee that the disk(s) on which the program is recorded be free from defects in materials and workmanship 

under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of your receipt. If failure of the disk has 
resulted from accident, abuse or misapplication of the product, then MOTU shall have no responsibility to replace the disk(s) under this Limited 
Warranty. 

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF, AND YOU HEREBY WAIVE, ANY AND ALL OTHER 
WARRANTIES, BOTH EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY AND 
FITNESS FORA PARTICULAR PURPOSE. THE LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL BE LIMITED 
TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO EVENT SHALL MOTU BE LIABLE FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS OF DATAOR DATA 
BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD PARTIES EVEN IF MOTU HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS WHICH MAY VARY FROM STATE TO 
STATE. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL DAMAGES, SO 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

Update Policy 
In order to be eligible to obtain updates of the program, you must complete and retum the attached Mark of the Unicom Purchaser Registration 
Card to MOTU. 

General 
This License Agreement shall be govemed by the laws of the Commonwealth of Massachusetts and shall inure to the benefit of MOTU, its 
successors, administrators, heirs and assigns. 

Copyright Notice 
Copyright ©1995, 1994, 1993, 1992, and 1991 Mark of the Unicom, Inc. and its licensors. All rights reserved. No part of this publication may 
be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language, in any form or on any 
means whatsoever, without express written permission of Mark of the Unicom, Inc., 1280 Massachusetts Avenue, Cambridge, MA 
USA 

_ The Macintosh operating system portions are copyrighted programs of Apple Computer, Inc., licensed to Mark of the Unicom, Inc., to distribute 
for use only in combination with Digital Performer. Apple Software shall not be copied onto another diskette (except for archive purposes) or into 
memory unless as part of the execution of Digital Performer. When Digital Performer has completed execution, Apple Software shall not be 
used by any other program. 

Digital Performer, Performer, Professional Composer, Composer's Mosaic, Unisyn, MIDI Time Piece, MIDI Time Piece II, Video Time Piece, 
Video Distribution Ampiifier, MIDI Mixer 7s, MIDI Express, MIDI Express PC and Mark of the Unicom are trademarks of Mark of the Unicom, 
Inc. 

Macintosh™ is a trademark licensed to Apple Computer, Inc. Apple @ The Finder™, MultiFinder™ and eee are trademarks of Apple 
Computer, Inc. 

DAE™, Pro Tools™, AudioMedia™, AudioMedia II™, Sound Tools™, Sound Tools IT™, and Sound Designer II™ are trademarks of 
Digidesign, Inc. * 1360 Willow Road, Suite 101, Menlo Park, CA 94025. 
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About this guide 

Important! Register your 
software 

If you upgraded directly 
from Mark of the Unicorn 

If you upgraded through 
your dealer 

If you purchased Digital 
Performer 

Welcome to Digital Performer! Mark of the Unicorn is pleased to 

present you with our award-winning, integrated sequencing and 

digital audio recording software for Macintosh. 

This guide provides important information about Digital Performer 

Version 1.6 not found in the other manuals. 

Before you go any further, take a moment to register your new | 

Digital Performer software as described in the following section that 

applies to you. Doing so entitles you to: 

m A free backup master disk (if applicable) 

= Free, unlimited technical support 

a Free newsletters, software updates, and announcements 

about major software upgrades and new products 

Since Mark of the Unicorn can only provide customer service and 

technical support to registered users, please be sure to send the card 

in immediately after purchase. 

You are already registered as a Digital Performer user with your 

original Performer registration and serial number. Keep your original 

Performer manual with the registration card page inside the front 

cover for your future reference. You may also want to write down 

the serial number in your copy of the Digital Performer Guide to 

Digital Audio manual. 

You will be automatically registered when the dealer returns your 

upgrade coupon to Mark of the Unicorn. We will acknowledge its 

receipt by mailing you a backup key disk, along with your new 

Digital Performer registration number. 

Take a moment now to fill in and mail the registration card found at 

the beginning of the Digital Performer Guide to Digital Audio, which 

accompanies this booklet. Leave the rest of the cardboard page in 

the manual for your future reference. : 



Audio hardware 
requirements 

Macintosh requirements 

System software 
requirements 

RAM requirements 

Install and test your 
Digidesign hardware 
first 

Digital Performer 1.6 supports the following Digidesign audio cards: 

=» Audiomedia I and II 

a Audiomedia LC 

= Sound Tools II 

a Pro Tools (4-16 channels) 

= Pro Tools III (16-48 channels) 

Refer to Digidesign for information about the compatibility of the hard 

disk(s) you plan to use with the Digidesign Audio Engine (DAE) and 

their audio hardware. 

Some of these audio cards may not be supported in future versions of 

DAE. Please check with Digidesign for the latest information regarding 

future compatibility. 

Digital Performer will run on any Macintosh that is compatible with the 

Digidesign audio cards listed in the previous section. Please contact 

Digidesign about the compatibility of these audio cards with specific 

Macintosh models. 

Digital Performer requires System 7.0 or higher with 32-bit memory 

addressing enabled. If your Mac is not 32-bit clean, the Digital 

Performer installer will automatically install MODE32 or the 32-bit 

Enabler, whichever is correct for your Mac model. However, you must 

still enable 32-bit addressing manually after running the installer. 

Digital Performer requires a minimum of 12 megabytes of RAM, but this 

configuration may require you to lower Digital Performer’s default 

memory partition or strip your system of extensions, control panels and 

fonts. More RAM is recommended. If you have System 7.5 or higher, 

you will probably need more than 12 Mb of RAM because of the size 

of System 7.5. 

We recommend that you install and test your Digidesign hardware 

before installing Digital Performer 1.6. If possible, try playing back 

some audio with Sound Designer II or other Digidesign software to 

verify that the hardware is properly installed and functioning normally. 

If you experience problems, this will help narrow your focus and 

eliminate Digital Performer as a possible cause. Once you’ve got the 

Digidesign hardware working, you will most likely not have problems 

with Digital Performer. 



Installing Digital Before installing Digital Performer, we recommend that you review the 

Performer 1.6 hardware requirements listed above before proceeding. 

1: Restart your Macintosh with Extensions OFF by holding down the 

Shift key while powering it up. 

Insert the Digital Performer 1.6 master disk (the disk with the 
colored glossy label) in any floppy drive and double-click the 

installer program named “Double-Click to Install”. 

Follow the instructions provided. Currently, the installer installs 

DAE 1.32, DigiSystem 2.8, AROSE 1.19 (only needed on System 

Accelerator-equipped Macs) and Pro Tools SysAxe 2.34 (only 

needed on System Accelerator-equipped Macs). If you already 

have any of these Digidesign files in your system, the installer will 

only replace them if they are older versions. Please contact 

Digidesign for information on newer versions of these files. 

. After completing the installation, restart your Mac. 

. Launch Digital Performer 1.6 and you will be asked to write-enable 
and insert the Digital Performer 1.6 master disk. 

This will authorize Digital Performer 1.6 to run on your hard disk. 

If you want to install Digital Performer on a hard disk other than 

the one to which the installer copied it, drag the Digital 

Performer™ 1.6.f folder to that hard disk before launching and 

authorizing. If you would like more information about 

authorizing, see “Authorizing your hard disk” on page 36 of the 

Performer Getting Started manual, as well as “About authorizing” 

on page 37. 

lf, after authorizing, you see a message about FreeMIDI as shown 
below, proceed to Chapter 5, “Getting Started with FreeMIDI” on 

page 41 of the Performer Getting Started manual. 

Don’t worry if you see this message. It just means that you need 

to describe your MIDI setup to Digital Performer. 

There is no current FreeMIDI | 

Configuration. Please run the FreeMID! 
Setup program to create one. 



A brief overview of the 
Digital Performer 1.6 
manuals 

Digital Performer 1.6 ships with three separate manuals, which are 

briefly described below. 
* 

Performer “Getting Started” Manual 
The Performer Getting Started book contains basic installation and 

setup information. It tells you how to set up FreeMIDI. It provides a 

brief overview of Performer’s main features (including a summary of 

new ones), as well as two extensive tutorials. One tutorial takes you 

step by step through the process of recording your first MIDI track. 

The second tutorial shows you step by step how to build an entire 

song, while introducing you a number of basic tasks such as cycle- 

recording, quantizing and step recording. 

This book is ideal for anyone who is new to Performer and would 

like a quick look at “the lay of the land”. 

Performer Reference Manual 
The Performer Reference Manual contains all the chapters having to | 

do with Digital Performer’s MIDI capabilities (although see the note 

below). If you are already familiar with Performer, consider this to 

be an up-to-date reference for Performer’s MIDI features, and turn to 

the Guide to Digital Audio for information about audio features that 

are unique to Digital Performer. 

Please note: there are a few new, non-audio features described in the 

following places in the Guide to Digital Audio: 

= chapter 4, “The Movie Window” (page 23) 

= “MIDI Time Code Generation” on page 20 

= “Frame Rate command in the Basics menu” on page 20 

a “New preferences for what appears when you double- 
click a track” on page 21 

Digital Performer Guide to Digital Audio 
The Digital Performer Guide to Digital Audio contains all 

information having to do with Digital Performer’s audio capabilities, 

including tutorial and troubleshooting chapters, written exclusively 

for audio features. In addition to being an audio reference, this book 

is ideal for anyone who is already familiar with Performer and would 

like information about Digital Performer’s audio features. 



Where to go next 

What you want to do: 

If you would like a brief overview of new 

digital audio features in Version 1.6 

If you would like a brief overview of other 

new features in Performer 

If you would like a brief overview of 

Performer in general 

If you would like a brief, step-by-step tuto- 

rial for recording MIDI 

If you would like an extensive tutorial about 

how to cycle-record and build a sequence 

If you are new to digital audio recording and 

you'd like some basic information about it 

If you need to start recording audio right 

away 

If you need to start sequencing right away 

Here are some recommendations for where to go next. 

Where to go next: 

Guide to Digital Audio 

chapter 3, “New Features in Version 1.6” (page 15) 

Performer Getting Started 

“What's New in Performer® 5” on page 13. 

and 

Guide to Digital Audio 

chapter 4, “The Movie Window” (page 27) 

“Using the mouse to edit values in text boxes” on page 15 

| “MIDI Time Code Generation” on page 24 

| “Frame Rate command in the Basics menu” on page 24 

| “New preferences” on page 25 

Performer Getting Started 

chapter 7, “Performer Overview: A Picturebook Tour” (page 69) 

Performer Getting Started 

chapter 8, “Getting Started: Recording Your First Track” 

| (page 87). 

Performer Getting Started 

chapter 9, “Tutorial: Building a Sequence” (page 103). 

Guide to Digital Audio 

chapter 5, “Hard Disk Recording Basics” (page 33) 

| chapter 6, “Audio Track Basics” (page 43) 

Guide to Digital Audio 

chapter 7, “Recording Audio” (page 57) 

Performer Getting Started 

chapter 7, “Performer Overview: A Picturebook Tour” (page 69). 
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MIDI IN / OUT 

Computer connection 

MIDI channels 

Maximum units / ports / 
channels in a network 

Total merging, routing, 
muting, re-channelizing 

SMPTE tape sync 

SMPTE conversion 

SMPTE jam sync 

Adjustable freewheeling 

Convert click to MIDI 

Foot mT inputs 

Foot pedal types 

Stripe SMPTE / front panel 

Panic button / front panel 

Modem/printer THRU port 
with front panel switch 

Internal power supply 

Scene memory 
(battery backed) 

Front panel programming 

Accepts program changes 

Front panel MIDI ports 

Operates without computer 

Fast 1/X data transfer rate 

MIDI Time Piece Il MIDI Express FastLane MIDI Time Piece ll MIDI Express Express Notebook 
Macintosh Macintosh Macintosh “PC/ Windows PC | Windows PC / Windows 

| 8/8 4/6 ins 8/8 6/6 4/6 

modem / printer port modem / printer port modem / printer port 8-bit card 8-bit card parallel port 

128 96 16 128 96 96 

nie! 512 es aaa ee re atic 

All ports All ports s ae Fee All ports All ports All ports 

All frame rates All frame rates no All frame rates All frame rates All frame rates 

MTC & DTLe _ MTC & DTLe no MTC MTC | MTC 

continuous / one-time continuous /one-time — no continuous / one-time — continuous/one-time continuous / one-time 

0-32 frames 0-32 frames no 0-32 frames 0-32 frames 0-32 frames 

yes yes no yes yes yes 

2 (1 rear, 1 front) 1 rear none 2 (1 rear, 1 front) 1 rear 1 rear 

continuous / switch switch only no continuous / switch switch only switch only 

yes yes no yes yes yes 

yes yes no yes. yes yes 

yes yes yes n/a no no 

yes yes no power required yes powered by computer —yes 

8 base setups 16 a6 8 base setups 16 16 
with 128 variations (8 preset / 8 user) with 128 variations (8 preset / 8 user) (8 preset / 8 user) 

16x2 Backlit LCD scene select buttons THRU buttons 16x2 Backlit LCD scene select buttons scene select buttons 

yes yes no yes no yes 

1 IN /1 OUT no n/a TIN / 1 OUT TIN J TOUT no 

yes yes yes yes no yes 

yes no no | no no no 



Choosing the MIDI interface that’s right for you. 
MOTU interfaces are engineered to meet your needs today—and in the future 

Plug and play Mark of the Unicorn MIDI interfaces 

ship with “plug and play” settings so you can begin using 

them right away with your sequencer, patch editor/librar- 

ian, and other music software, without touching the unit’s 

front panel or running the control panel software acces- 

sory (available for both Macintosh® and Windows®). 

“Set it and forget it” The MIDI Express and MIDI 

Time Piece families have built-in, battery-backed memory. 

If you need to make a change to the factory default set- 

tings, just run the intuitive, graphic control software. The _ 

interface remembers the change, even 1 if you turn it off. 

You can even store multiple operating configurations for 

instant front-panel recall in any situation (studio versus 

stage, for example). 

Much more than a MIDI patchbay With com- 

pletely independent MIDI ports, the MIDI Express and 

MIDI Time Piece families provide totally flexible MIDI data 
routing. Route and merge data from any combination of 

inputs to any combination of outputs; mute any type of 

data you wish, on input or output. Even switch data from 

one channel to another as it is sent to or from any MIDI 

device. All it takes is a few clicks of the mouse. 

Compatibility Our Macintosh interfaces are fully com- 

patible with all Macintosh music software. In fact, they've 

become a standard —so much so that many programs 

specify the MIDI Time Piece by name. They fully support 
FreeMIDI, Mark of the Unicorn’s MIDI operating system. 

~ OMS (Opcode MIDI System) has a “MIDI Time Piece” 

mode to ensure compatibility. Our PC/Windows interfaces 

support all music applications compatible with the 
Microsoft Multimedia Extensions™ (MME) driver. 

_ With or without a computer Our interfaces serve 
as more than just interfaces: they are the “MIDI hub” of | 

your studio. Even when the computer is turned off, they 

offer instantly accessible THRU functions on the front 

panel that let you route data from your controller to any 

connected device. With the MIDI Time Piece H, you can 
program all of its features—routing, merging, muting, 

rechannelizing, and more—right from the front panel. It’s 

so complete, you'll never need to unplug your gear again. 

Reliability From hit records to mega-star concert tours, 

top professionals rely on Mark of the Unicorn interfaces 

every day. Just look in their racks of gear: you’re bound to 

see a MIDI Time Piece. 

FastLane 

Affordable and Portable 

FastLane is a flexible and eco- 

nomical way to add MIDI to your 

Macintosh. FastLane can be 

installed in seconds and will 

open your Mac to the world of 

music software. It even has a 

unique MIDI THRU button that 

allows you to play your MIDI 

gear even when the computer is 

turned off—without having to 

disconnect cables. No other 1x3 

interface for the Mac offers this 

important feature. 

MIDI Express 
Making the jump to 
multiple MIDI ports 

The MIDI Express is ideal for 

medium-sized MIDI setups and 
eccentiyal tacke euch ac MIT) 

sequencing, multimedia produc- 

tion, and sound management 

with patch/editor librarian soft- 

ware. When sequencing with 

more than one or two MIDI 

devices, you want to connect 
each device directly to the inter- 

face so it gets its own set of 16 

MIDI channels, which means 

you don’t have to worry about » 

sysex ID’s or MIDI channel con- 

flicts in your software. Just pick 

an instrument, choose a sound, 

and go! If you use editor/librar- 

ian software—or get sysex bulk 

dumps in your sequencer— 

you'll need the MIDI Express’s 

multiple ports for bi-directional 

MIDI connections (both IN and 

OUT). The MIDI Express is 

based on the same time-tested 

technology as the MIDI Time 

Piece II, so it provides the same 

level of performance you'd 

expect in a multi-port interface. 

~ It’s the affordable choice when 
you don’t require the full-bore 

features of the MTP IL. 

MIDI Time Piece Il 
When you have to have 

the best 

The MTP II gives you more of 

everything: more MIDI ports, 

more MIDI channels, more 

internal memory, expandibility 

via networking, faster MIDI data 

throughput to your MIDI rig 

from the computer (Macintosh 

version), complete control via 

the front panel, and the list goes 

on. It’s ideal for live perfor- 

mance situations, where intense 

MIDI routing and processing— 

along with instant, flexible 

changes to its internal settings— 

are a must. And the MTP II has 

what it takes to support even the 

largest studio rigs, with features 

like networking, which provides 

up to 512 MIDI channels, and 

cable lengths of up to 1,000 feet. 

The MTP II is completely com- 

patible with the original MIDI 

Time Piece. In fact, it’s a perfect 

addition because networked 

— together, they function as a 

16x16 interface with 256 MIDI 

channels. You can even program 

the settings of the original MTP 

from the MTP Il’s front panel. 
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Mark of the Unicorn License 
Agreement and Limited 

Warranty 

TO PERSONS WHO PURCHASE OR USE THIS PRODUCT: 
Carefully read all the terms and conditions of this agreement before using this software package. Using this software package indicates 
your acceptance of the terms and conditions of this license agreement. 

Mark of the Unicorn, Inc. (‘MOTU”) owns both this program and its documentation. Both the program and the documentation are 
protected under applicable copyright laws. Your right to use the program and the documentation are limited to the terms and conditions 
described herein. | 

License 
YOU MAY: (a) use the enclosed program ona single computer; (b) physically transfer the program from one computer to another provided 
that the program is used on only one computer at a time and that you remove any copies of the program from the computer from which 
the program is being transferred; (c) make copies of the program solely for backup purposes. You must reproduce and include the 
copyright notice on a label on any backup copy. 

YOU MAY NOT: (a) distribute copies of the program or the documentation to others; (b) rent, lease or grant sublicenses or other rights to 
the program; (c) provide use of the program in a computer service business, network, time-sharing, multiple CPU or multiple user 
arrangement without the prior written consent of MOTU; (d) translate or otherwise alter the program or related documentation without the 
prior written consent of MOTU. 

Term 
Your license to use the program and documentation will automatically terminate if you fail to comply with the terms of this Agreement. If 
this license is terminated you agree to destroy all copies of the program and documentation. 

Limited Warranty 
MOTU warrants to the original licensee that the disk(s) on which the program is recorded be free from defects in materials and 
workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of your receipt. If failure 
of the disk has resulted from accident, abuse or misapplication of the product, then MOTU shall have no responsibility to replace the disk(s) 
under this Limited Warranty. 

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF AND YOU HEREBY WAIVE, ANY AND ALL OTHER 
WARRANTIES, BOTH EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE. THE LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL 
BE LIMITED TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO EVENT SHALL MOTU BE LIABLE FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS 
OF DATA OR DATA BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD PARTIES EVEN IF MOTU HAS 

_ BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS WHICH 
MAY VARY FROM STATE TO STATE. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
CONSEQUENTIAL DAMAGES, SOTHE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

Update Policy 
In order to be eligible to obtain updates of the program, you must complete and return the attached Mark of the Unicorn Purchaser 
Registration Card to MOTU. 

General 
This License Agreement shall be governed by the laws of the Commonwealth of Massachusetts and shall innure to the benefit of MOTU, 
its Successors, administrators, heirs and assigns. ; 

Copyright Notice 
Copyright ©1994, 1993, 1992, 1991, 1990, 1989, 1988, 1987, 1986, 1985 Mark of the Unicorn, Inc. and its licensors. All rights reserved. 

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or 
computer language, in any form or by any means whatsoever, without express written permission of Mark of the Unicorn, Inc., 1280 
Massachusetts Avenue, Cambridge, MA, 02138, U.S.A | 

The Macintosh operating system portions are copyrighted programs of Apple Computer, Inc., licensed to Mark of the Unicorn, Inc., to 
distribute for use only in combination with Digital Performer. Apple Software shall not be copied onto another diskette (except for archive 
purposes) or into memory unless as part of the execution of Digital Performer. When Digital Performer has completed execution, Apple 
Software shall not be used by any other program. 

Digital Performer, Performer, Professional Composer, Composer's Mosaic, Unisyn, MIDI Time Piece, MIDI Time Piece II, Video Time 

Piece, Video Distribution Amplifier, MIDI Mixer 7s, MIDI Express, MIDI Express PC and Mark of the Unicorn are trademarks of Mark of the 
Unicorn, Inc. 

Macintosh" is a trademark licensed to Apple Computer, Inc. Apple ® The Finder ™, MultiFinder™, and PatchBay™ are trademarks of 
Apple Computer, Inc. 

MacProteus™, SampleCell™, Pro Tools™, Audiomedia™, Audiomedia I™, Sound Accelerator™ Sound Accelerator I[™™, and Sound 

Designer II™are trademarks of Digidesign, Inc. ¢ 1360 Willow Road, Suite 101, Menlo Park, CA 94025. 

Vision™, Studio 5™ and OMS™ are trademarks of Opcode Systems, Inc. 3950 Fabian Way, Suite 100, Palo Alto, CA, 94303. 
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Chapter1 Welcome to Performer’ 

Mail in the Registration 
Card 

Overview of this guide 

Welcome to Performer! Mark of the Unicorn is pleased to present you 

with our industry-leading professional sequencing environment for 

the Macintosh computer. 

Before you go any further, take a moment now to fill in and mail the 

registration card found at the beginning of the Performer Reference 

Manual, which accompanies this guide. Doing so entitles you to: 

m A free backup master disk Gif applicable) 

mw Free, unlimited technical support 

= Free newsletters and software updates 

» Announcements about major software upgrades and new 

products 

Leave the rest of the cardboard page in the manual for your future 

reference. Since Mark of the Unicorn can provide customer service 

only to registered users, please be sure to send the card in 

immediately after purchase. 

This guide is organized into six sections: 

What’s new in Performer Version 5 
This section provides you with a brief overview of the advanced, 

state-of-the-art features added to Performer in this major upgrade. 

Installation 
This section is for beginners and Macintosh sequencing experts alike. 

It provides step-by-step installation and setup instructions for those 

who would like them, including how to customize Performer for 

operation in your MIDI studio. It also provides summary information 

for expert users regarding unique aspects of Performer’s installation 

(such as the FreeMIDI setup process). 



Tutorials 
This section provides the following introductory approaches to 

Performer: 

a A picturebook tour, which gives a short overview of 

Performer’s main windows and features. 

a A short tutorial to teach you how to record a single track. 

a A longer tutorial that introduces you to most of Performer’s 

main features and helps you record a short, multiple track 

sequence, including a cycle-recorded drum loop and step- 

recorded chords. 

Other FreeMIDI Releases 
Performer Version 5 offers MIDI software system integration with the 

Mark of the Unicorn products listed below. If you have purchased 

one or more of these products, read this section for important 

information about how to use them together with Performer 

Version 5. 

m Unisyn 

a» MIDI Time Piece II 

mw MIDI Express 

Appendices 
The appendices provide important information about using 

Performer Version 5 with OMS and MIDI Manager. There is also a 

troubleshooting and customer support appendix. 

10 Welcome to Performer ® 
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Chapter 2 What's New in Performer’ 5 

Performer Version 5 is packed with the following new features and 

enhancements: 

m Redesigned interface 

m Groove Quantize and Create Groove 

m Cycle-recording with instant update and spot-erase 

= Enhanced Split Notes command 

= Better music notation display, editing, note entry, printing, 

and vastly improved transcription algorithms in the 

QuickScribe Notation window 

= Support for MIDI Machine Control devices such as the 

Alesis ADAT™, the Akai DR4d, and the Tascam DA-88 

m= Large counter window for improved visibility in the 

recording studio 

a MIDI System Integration with FreeMIDI 

mw Bank select 

a» DNA™ Grooves and DrumTrax™ Special Edition drum 

patterns included free of charge 

mw Many other enhancements 

The following pages provide a glimpse into these new features, along 

with page references to the Performer Reference Manual. 

For a similar overview of Performer’s main features, see chapter 7, 

“Performer Overview: A Picturebook Tour” (page 69). 
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Redesigned 
interface 

Conductor track 

You'll find that many of Performer’s existing 
features are greatly enhanced and clarified 
by color. You may even discover features 
and shortcuts that you never knew existed. 

14 

If you just upgraded to Version 5, don’t worry! You won't have to 

learn a whole new program. Performer is still Performer. But we have 

added a pleasing color interface to all Performer’s familiar features, 

along with many refinements. Version 5 even looks great on a black 

and white monitor, but once you see it running on a color monitor, 

you'll never look back. Below are a few highlights of the new look 

and feel. 

In addition to the new look and feel, Version 5 
is full of refinements. The example shown here 
is the new Tempo Control pop-up menu in the 
Metronome panel. 

Many enhancements in Version 5 
are the direct result of feedback 

from Performer’s thousands of 

users. The new Start Time button 

has been added to the main 

counter to quickly allow you to set 
SMPTE offsets and add pick-up 
measures. 

What’s New in Performer® 5 



Groove 
Quantize and 
Create Groove 

For more information, see 

chapter 30, “Groove 
Quantize” (page 487) in 
the Reference Manual. 

What’s New in Performer® 5 

Performer’s Groove Quantize and Create Groove commands in the 

Region menu add a new dimension to sequencing. A groove is a 

unique rhythmic feel that you can instantly apply to your music. You 

get immediate feedback as you dynamically adjust the feel of grooves 

with faders. Use the Create Groove command to create your own 

grooves, of any length, from any music you have recorded into 

Performer or loaded from a standard MIDI file. Then apply it to any 

other track, and even edit the groove to perfect the feel. You can 

build your own groove library, or purchase commercially available 

libraries with hundreds of carefully crafted grooves. Performer 

Version 5 even ships with a sample library of DNA™ grooves, 

including straight, shuffle, laid back, and pushing grooves. 

Groove Quantize — : 

i 229.9 MB in disk 2 MB available 

DNA Grooves Old Grooves Cubase grooves 
0) Hip Hop 1 

Hip Hop 2 

Hip Hop Grooves Jazz Riffs Shuffles 

Rock 'n Roll Grooves Straight Grooves 

15 



Cycle-record 
with instant 
update and spot- 
erase 

For more information 

about this feature, see 

“Cycle-recording” on 
page 130 in the Performer 
Reference Manual. 

Memory-cycle button 

Use spot-erase, or just click the 

Performer is now more interactive than ever when it comes to 

building loops in real time. Three key enhancements make Performer 

a powerhouse for drum machine style loop-recording. First, 

Performer’s main counter loops seamlessly, just like traditional drum- 

machine style pattern recorders with the improved Memory-shuttle 

feature. Secondly, notes and other data show up immediately as you 

record them, so with a graphic or notation editing window open 

while you record, you can immediately edit the notes you record 

without ever hitting the stop button. Finally, a new spot-erase remote 

control lets you erase notes while cycle-recording by holding down 

the key for the pitch you want to erase, just like your favorite drum 

machine or hardware sequencer. 

Memory bar start and stop 
times are displayed here. You 
can change them by typing or 
by clicking the Start and Stop 
buttons on the fly during 
playback. 

Repeat barlines are displayed in all time rulers. They can be dragged left and right, 
even during playback. When you drag them in the Graphic Editing, they snap to the 
Current edit resolution, which you can set to any value or turn off completely. 

note and hit the delete key. 

The wiper indicates the current playback 
location, which continually repeats between 
the repeat barlines in the Time Ruler. 

You can easily erase (or otherwise edit) the last 
pass when recording a drum loop such as this 
one by double-clicking the corresponding key 
on the pitch ruler, which selects all notes of that 
pitch in the track. Once they are selected, you 

can do anything you want to them, such as 
quantize, transpose, erase, or shift them. 
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Enhanced Split 
Notes command 

For more information, see “Split 
Notes” on page 441 in the 
Performer Reference Manual. 

What’s New in Performer® 5 

Split Notes has been greatly enhanced to save you valuable time. Split 

notes can now automatically create a new track and Paste the split 

notes to it. It can even create a set of new tracks and Paste the split 

notes to each track according to their pitch. You can select what 

pitches to split by playing them on your MIDI controller. 

Split Notes 
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including new MIDI transcription technology that produces the most 

accurate transcription ever in Performer. In addition, Performer’s 

Performer Version 5 provides more advanced music notation features, 

enhanced QuickScribe window now provides palette-based note 

improved. Text is now handled with familiar, Macintosh-style text 

entry and editing directly on the page. Note insertion is especially 

boxes to give you complete flexibility. 

tion, 
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Notation” (page 345) in the 

For more information, see 

chapter 23, “QuickScribe 
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MIDI Machine Performer Version 5 serves as a command center for the modern 

Control desktop recording studio. MIDI Machine Control allows you to 
manipulate the transport controls of popular multi-track recording 

systems such as the Alesis ADAT™, Akai DR4d, and Tascam DA-88. 

Play, stop, rewind, fast forward, record-enable, and punch in and out, 

all from Performer’s familiar tape-deck style transport controls. 

For more information, see 

chapter 39, “Using MIDI 
Machine Control” 

(page 629) in the Performer 
Reference Manual. 

Lar ge counter The counter window has been enlarged to improve visibility in the 
dis 0 lay recording studio. All three time formats can be displayed. Other than 

its increased size, this window functions exactly as explained in the 

Reference Manual in chapter 11, “The Counter Window” (page 161). 
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MIDI System 
Integration with 
FreeMIDI 

To see how easy it is to set 

up your FreeMIDI studio, 
see chapter 5, “Getting 
Started With FreeMIDI ™” 
(page 41). 

Figure 2-1: FreeMIDI provides an 
intuitive, graphical representation 
of your MIDI studio. You can 
arrange the icons in the window to 
match their location in your studio 
using familiar Macintosh System 7 
conventions. 

20 

FreeMIDI is a Macintosh system extension that is automatically placed 

in the System Folder when you install Performer Version 5. FreeMIDI 

is easy to use because it is seamlessly integrated with Performer, and 

provides many advantages for all FreeMIDI-compatible software, 

including: 

a A “virtual” studio on your Macintosh that graphically 

mirrors your entire MIDI hardware setup and is shared by 

all FreeMIDI-compatible programs 

= A simple, intuitive pop-up list of your MIDI devices 

whenever you need it in any FreeMIDI program 

= A pop-up list sound list for each one of your MIDI devices, 

which make it easy for you to choose sounds by name 

a» The ability to start playback, stop playback, rewind and 

cue all FreeMIDI-compatible programs at once (For 

example, you can slave Mosaic to SMPTE time code via 

Performer and FreeMIDI.) 
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Bank select Together, Performer and FreeMIDI let you break the 128-sound 

barrier imposed by the MIDI patch change event. Now, you have 

hundreds of sounds at your fingertips from within Performer using 
For more information, see “Using odul rin MIDI studio ec Multiple Patch Lists & Bank Select any sound module or keyboard in your studio that support 

Messages” on page 747 in the MIDI bank select messages. FreeMIDI provides hierarchical pop-up 

Performer Reference Manual. patch list menus in Performer that let you select any sound from any 

bank instantly. You can even sort the patch lists alphabetically to help 

you find sounds more quickly. 

Bank select provides access to multiple banks in any 
MIDI device that supports MIDI bank select 
messages. In this example, The Kurzweil K2000R 
sound module provides three banks: Bank 0, Bank 1, 
and Bank 9. All are instantly available from the hierar- 
chical patch select pop-up menu in Performer’s tracks 
list. The Korg O5R/W shown below supplies drum kits 
on channel 10. 

What’s New in Performer® 5 21 



Enhanced The Graphic Editing and Notation Editing windows have been 

Graphic Editing redesigned to show more data in a clearer fashion. 

eS ee ee Gj Unit = # ol0ea beats 
2000 [3000 yj] . 1 (4 : 211/000 

‘| 113 osee|a | 01120 beats: 

For more information, see “The 
Graphic Editing Window’ on 
page 281 and chapter 22, “The 
Notation Editing Window’ (page 335) 
in the Reference Manual. 

L Mootinctinatinntinnthadtatnata tet odtod 
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DNA Grooves & 
DrumTrax ™ 
patterns 

Other 
enhancements 

What’s New in Performer® 5 

Performer Version 5 ships with 50 free DNA Grooves created by WC 

Music Research, an industry leader in rhythmic analysis. These 

grooves can be fully incorporated into Performer’s new Groove 

Quantize features. DNA Grooves provide a variety of feels derived 

from hit records and drum tracks by top studio drummers; they can 

be varied by the Groove Quantize beat divisions to provide a total of 

500 distinct Groove styles. 

Version 5 also ships with the DrumTrax™ Special Edition drum 

pattern library, a set of drum patterns in Performer format that offer a 

variety of popular percussion styles. Created by professional studio 

drummers, these patterns can be used as the rhythmic foundation for 

sequences, as practice material, and as inspiration for new ideas. The 

DrumTrax Special Edition also includes Humanize maps to generate 

new patterns and fills. 

If you are upgrading from previous versions of Performer, you'll 

notice many refinements. Here are just a few: 

m YOu can now click on the text for radio button and check 

boxes to select the button. 

m= Step Record now locks to the main controls in a more 

intuitive fashion, playing the rest of the sequence as you 

step. Step Record is more fun than ever before. 
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Chapter3 Performer System Requirements 

To avoid problems later on, carefully review the information in this 

chapter before you install Performer. 

This chapter provides important requirements and recommendations 

for the following components in your Macintosh computer system: 

mw Type of Macintosh 

= Type of monitor 

=» RAM (memory) 

m= System software 

bay di 



Computer Below is a chart summarizing how Performer supports each type of 
Macintosh computer. A Macintosh with a 68020 processor or faster is 

Requir emen ts required, as well as a hard disk and a total of at least 5 megabytes 

(MB) of RAM. 

Not supported:t Supported:* Recommended: 

512K Classic II, SE/30 

Color Classic 

512KE LC/LC II LC III, LC 475, 520, 
350, 575 

Plus Ici, Isi, Ivx, Ifx 

SE Performa 200, 400, PowerBook 145, 

405, 410, 430 145B, 160, 165, 165c, 
170, 180, 180c, 520, 

520c, 540, 540c 

Classic PowerBook 140 Centris 610, 650, 

660AV 

PowerBook 100 Quadra 

605, 610, 650, 700, 

800, 840AV, 900, 950 

Portable Performa 450, 460, 

466, 467, 475, 476, 

550; 560, 575, 577, 

578, 600 

Duo 210, 230, 250, 

270c, 280, 280c 

Power Macintosh 

6100/60, 6100/60AV, 

7100/66, 7100/66AV, 

8100/80, 8100/AV, 

8100/110, 8100/ 

110AV 

@ *You may experience delays in Performer because of 

the slower microprocessor in these machines. 

@ +Any of these Macs may experience problems with 

Performer Version 5 if an accelerator with a 68020, 

68030, or 68040 processor is installed. 

Please note that these computer requirements may change as future 

updates become available. 
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Computer The faster the Macintosh, the more responsive Performer is. Scrolling 

Recommendations during playback is smoother, the counter updates regularly, and 

actions that you take with the program are faster—especially during 

playback. Below is a list of eligible Macintosh computers, ranked 

approximately from slowest to fastest, moving from top to bottom 

respectively in the list: 

Computer: Processor Processor 
type: clock: 

LC & Mac II 68020 16 MHz 

Mac SE/30, IIx, Icx, IIvi, Classic II, 68030 16 MHz 

Color Classic, LC II, PowerBook 140, 

Performa 200, 400, 405, 410, 430 

IIsi 68030 20 MHz 

IIci, PowerBook 145, 145B, 160, 170, 68030 25 MHz 

LC II, Duo 210, LC 520, Performa 450 

Performa 600, IIvx 68030 32 MHz 

PowerBook 165, 165c, 180, 180c 68030 33 MHz 

Duo 230, 250, 270c, LC 550, Performa 

460, 466, 467, 550, 560 

Ilfx 68030 40 MHz 

Centris 610 68LC040 20 MHz 

Quadra 605 LC 475, Performa 475, 476 | 68LC040 25 MHz 

PowerBook 520, 520c 

LC 575, Performa 575, 577, 578, 68LC040 33 MHz 
Duo 280, 280c, PowerBook 540, 540c 

Centris 650, Quadra 610, 660AV, 700, 68040 25 MHz 

900 

Quadra 650, 800, 950 68040 33 MHz 

Quadra 840AV 68040 40 MHz 

Power Macintosh 6100/60, 6100/60AV_ | PowerPC 601 60 MHz 

Power Macintosh 7100/66, 7100/66AV_ | PowerPC 601 66 MHz 

Power Macintosh 8100/80, 8100/80AV 80 MHz 

Power Macintosh 8100/110, 8100/ PowerPC 601 110 MHz 

11OAV 
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Math Co-processors 

Accelerator Boards 

RAM Recommendations 

How to Check RAM 

Monitor , 
Recommendations 

30 

Math co-processors do not have an effect on Performer’s speed of 

operation. 

Performer’s speed of operation is increased by accelerator boards that 

enhance or replace the computer’s CPU—and thus speed up all 

operations on the computer. We strongly recommend that when you 

purchase an accelerator, you purchase it on a “try-before-you-buy” 

basis because some accelerators can be fundamentally incompatible 

with Performer. Please contact Mark of the Unicorn Technical 

Support at (617) 576-3066 before you purchase an accelerator board 

in order to check compatibility with Performer. 

If you will be working with sequences that contain lots of MIDI data, 

you may need more than the minimum recommendation of 6 MB, 

depending on the size of your system software and the amount of 

additional start-up software or other applications you run at the same 

time as Performer. 

To check how much RAM your Macintosh has, choose About this 

Macintosh (or About the Finder in System 6) from the Apple menu 

and look for the Total Memory indication. 

When you run Performer, the Memory Monitor displays the amount 

of free memory (RAM) available to Performer. Try to keep at least 

150K free. To increase this amount in MultiFinder or System 7, quit 

Performer, select the Performer program icon, and choose Get Info 

from the File menu. Increase the application memory size in the Get 

Info window. 

Performer is designed specifically for the following screen depths: 

= Black and white (1 bit) 

m 256 colors or grays (8-bit) 

To set your monitor to one of these color depths, use the Monitors 

Control Panel in the Apple menu. 

Performer System Requirements 



System 
Software 

Installing 32-bit 
QuickDraw in System 6 
for Color 

FreeMIDI is Required 

Performer 5uses 
TrueType™ 

Performer System Requirements 

To run Performer, a Macintosh computer must be booted with System 

System 6.0.7 or higher. System 7 is recommended. Please note that 

these minimum requirements may change in future updates. 

To obtain the version number of the System and Finder files, choose 

About this Macintosh...(or About the Finder in System 6) from the 

Apple menu just after you switch on the computer. 

To determine Performer’s version number, run Performer and choose 

About Performer from the Apple menu. A window then displays 

Performer’s logo and version number. This is the same screen that 

you see when you first run the program. This display remains until 

you click the mouse. 

If you are running in System 6, and you would like to run Performer 

in color, 32-bit Color QuickDraw must be installed in the system. 

32-Bit Color QuickDraw is built into some Macintoshes running 

System 6.0.7 or 6.0.8, but not all. If not, Performer will display in 

black and white. If you would like to run Performer in color in this 

case, use the Customize option on your System 6 installer disks to 

install 32-Bit Color QuickDraw. 

Performer requires FreeMIDI, a Macintosh System Folder extension 

developed by Mark of the Unicorn. FreeMIDI is automatically placed 

in your system when you install Performer as described in this 

booklet. 

FreeMIDI greatly enhances the way in which Performer interacts with 

your MIDI hardware. It provides Performer with the names of all of 

your MIDI hardware devices, and it even provides Performer with the 

names of the sounds currently available in each one of your MIDI 

synthesizers. 

Mark of the Unicorn has developed a TrueType music font called 

QuickScribe™ to support Performer Version 5’s notation printing and 

editing features. This font is provided free of charge with Performer, 

and provides the highest possible printing quality and screen display 

available on the Macintosh. It is automatically installed in your 

Macintosh System Folder by the Performer installer. 

In System 7, no special preparations are required for the use of this 

font. 

31 



Do Not Use Virtual 
Memory 

Support for 32-bit 
memory in System 7 

MultiFinder 

MIDI Hardware 
Requirements 
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In System 6, TrueType fonts require a minimum of System 6.0.7, 

LaserWriter Driver 6.1 or higher, and the TrueType INIT. (An INIT is 

a startup document that should be placed in the top level of the 

System Folder.) The TrueType INIT is automatically installed, if 

necessary, when you run the Performer installer. 

Do not use Virtual Memory with Performer. Virtual memory causes 

the computer to operate too slowly for Performer to maintain real- 

time operations such as playback and recording. 

Performer supports the use of extended RAM with 32-bit memory 

mode in System 7. 

Performer is compatible with MultiFinder, which allows several 

applications to run concurrently in System 6. At least 5 megabytes of 

RAM are required to run MultiFinder with Performer. More RAM may 

be required depending on the number and size of the applications 

you are running together. 

In MultiFinder, you should only switch to other applications from the 

main Performer screen. Avoid switching in the middle of a command, 

or while working in a dialog box. 

By default, Performer allocates a certain amount of memory to itself 

in MultiFinder. To assign more, Get Info on the Performer icon and 

type in a large application memory size. 

The following MIDI hardware is the minimum necessary to work with 

Performer: 

m a standard MIDI/Macintosh interface 

mw at least two MIDI cables 

m at least one MIDI device 
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Chapter4 Installing Performer 

Running the 
installer 

This chapter provides step-by-step instructions for installing 

Performer. It also contains helpful information about the installation 

process. 

All Mark of the Unicorn software products are installed for you by an 

installer utility on the product’s master disk. For software that ships 

on several disks, such as Performer, the master disk is the one with 

the glossy, colored label. 

To run the installer: 

1. Disable all Control Panel Devices and Extensions, including virus 

protection utilities such as SAM, Virex, Vaccine, Disinfectant, or 

GateKeeper during the installation process. 

These files can sometimes interfere with installation. To do so 

under System 7, restart or turn on your Macintosh with the shift 

key held down until you see the message, “Extensions Off”, which 

appears right after “Welcome to Macintosh”. Doing so turns off all 

extensions until the computer is restarted. Under System 6, 

remove all non-Apple INIT’s and Control Panel devices from your 

System Folder and then Restart your Macintosh. It is especially 

important to do this right before you install the program and 

authorize the hard disk. Once the program has been installed and 

authorized, you can re-enable them. 

. Insert the master disk and run the installer by double-clicking the 

icon called “Double-click to install”. 
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S items Sf OK in disk 216K available 

Figure 4-1: The Performer master disk, with the 
installation and authorizing utilities. 

3. Follow the directions that the installer gives you, and insert the 

appropriate disks when they are requested. 

When you finish, the installer may ask you to restart. 

@ If you have more than one hard disk, the installer may 

only let you install on hard disks that have a System 

Folder on them. If you want to install on a disk that 

doesn’t, install on a hard disk that does and copy the 

resulting folder to the desired disk afterwards. 

If you have one of these computers, the installer places the Serial 

Switch control panel into the System. Before you proceed any further 

in the installation, you must set the Serial Switch control panel to 

compatible before you run Performer. 

To set the Serial Switch control panel to compatible: 

1. Choose Control Panel from the Apple menu. 

2. Double-click the Serial Switch icon. 

3. Select the “Compatible” option. 

4. Close the Control Panel and choose Restart from the Special 

menu. 
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What does the installer 
do? 

Installing Performer 

The installer checks the computer to make sure it meets the hardware 

and software requirements necessary to run the program. If so, the 

installer places the program in a folder on the top level of the hard 

disk, along with several additional files in some cases. The installer 

also adds other necessary files to your Macintosh System Folder such 

as fonts, system extensions, and other necessary items. 

The following table provides a summary. The information in this 

table is subject to change. 

Installed item: 

Performer 

FreeMIDI System Extension 

FreeMIDI Folder 

FreeMIDI Applications Folder 

FreeMIDI Setup™ 

PatchList Manager™ 

Explanation: 

The program itself is placed in a 

folder with the same name on the 

top level of your hard disk. 

This system extension is placed in 

your System Folder and serves as an 

integrated MIDI operating system 

for all FreeMIDI-compatible soft- 

ware. It it required by all Mark of 

the Unicorn programs. 

This folder is placed in your System 

Folder and contains files that are 

required by FreeMIDI. 

This folder is placed on the top 

level of your hard disk. It contains 

several programs that help you con- 

figure FreeMIDI. 

FreeMIDI Setup is a program found 

in the FreeMIDI Applications folder. 

It allows you to create a FreeMIDI 

Configuration, which describes 

your MIDI studio and is required for 

MIDI recording and playback. 

PatchList Manager™ is a program in 

the FreeMIDI Applications folder. It 

obtains the names of the sounds in 

your MIDI synthesizers so you can 

choose sounds by name from 

within any FreeMIDI-compatible 

program. 
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Serial Switch If you have a Quadra 900, 950, or 

Macintosh IIfx, this system exten- 

sion is placed in the Control Panels 

folder by the installer to allow MIDI 

communication on the modem and 

printer ports. Without it, none of 

your MIDI software would work. 

Once it is installed, it must be set to 

“Compatible” mode. 

Unicorn Power If you have a Macintosh PowerBook 

140, 145, 145B, 160, 165, 165c, 170, 

180, or 180c, this system extension 

is placed in the Control Panels 

folder by the installer to provide 

error-free MIDI communication on 

the modem and printer ports. With- 

out it, you might have trouble using 

Mark of the Unicorn software. 

Performer Help Leave this file in the Performer 

folder. It contains all of the informa- 

tion provided by Performer’s on- 

line help feature. 

Performer Fonts This font suitcase contains several 

fonts required by Performer, and 

they are placed in your System by 

the installer. The fonts are: Quick- 

Scribe, PerfPrintGeneva 9, and Perf- 

Printlcons 12. 

Author, izing your Performer requires you to authorize your hard disk. Authorizing 

ha rd dis k allows the program to run without asking you to insert the master 

disk. Otherwise, the program will ask you to insert the master disk 

each time you run it, briefly scanning the disk before opening. 

In some situations, you may not want to authorize. For example, you 

may be working at a temporary location. If you don’t want to 

authorize, do not double-click the Authorizer. Instead, see “Running 

programs without authorizing” on page 38. 

To authorize a hard disk: 

1. If the master disk is not currently in a disk drive, insert it now. 
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What next? 

About 
authorizing 

Deauthorizing a hard 
disk 

Installing Performer 

2. Double-click the Authorizer/Deauthorizer on the master disk to 

authorize your hard disk. 

3. Follow the directions that appear on the screen. 

If you have more than one hard disk, be sure to authorize the disk 

from which you will be running the program. 

Mark of the Unicorn programs do not authorize one another. For 

example, if you authorize your hard disk for Performer, and you have 

Unisyn, you need to authorize the hard disk for Unisyn using the 

Unisyn master disk. 

The rest of this chapter tells you several things you should know 

about authorizing and deauthorizing. After you complete this chapter, 

proceed to the next one, chapter 5, “Getting Started With FreeMIDI 

™” Jt has important information about setting up your FreeMIDI 

configuration, which is essential for all Mark of the Unicorn MIDI 

software products. 

Once you have authorized your hard disk as described earlier, the 

program will run without asking for the key disk. Because the 

authorization is not specific to one copy of the program, you can 

even make several copies of the program on the hard disk, including 

updated versions. Likewise, you can drag a copy of the program to 

the trash without losing the hard disk authorization. 

A master disk can authorize one hard disk. Mark of the Unicorn 

provides a second, identical back-up master disk free of charge when 

you mail in your signed registration card. This backup disk should be 

stored in a safe place and only used if the original master disk 

authorization somehow becomes damaged. 

If needed, you can deauthorize the hard disk for any reason, such as 

to reformat the disk, switch to a different hard disk, etc. To 

deauthorize a hard disk, insert the original master disk, open the disk, 

and double-click the Authorizer/Deauthorizer. From there, just follow 

the instructions provided on the screen and click the Deauthorize 

button when it is presented to you. 
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@ If the Deauthorize button is greyed out (can’t be 

clicked), you are not using the master disk that you 

originally used to authorize. Quit and check your other 

master disk using this same procedure. 

Deauthor. ize before : If you reformat an authorized hard disk, it loses its authorization. 

reformatting a hard disk Therefore, always deauthorize an authorized hard disk before you 
reformat it. After reformatting, you can authorize it again. 

Handling hard disk If your hard disk fails before you have an opportunity to deauthorize 

emergencies it, use your backup master disk to authorize a new, repaired, or 
reformatted hard disk. (Disk authorizations cannot be restored from 

hard disk backups.) Contact Mark of the Unicorn technical support 

for information about getting a replacement authorization. 

Telephone: (617) 576-3066. Fax: (617) 576-3609. 

Running programs If you would like to install and run a program without authorizing the 

without authorizing hard disk, do not run the Authorizer/Deauthorizer on the master disk. 

Instead, launch the copy of the program on your hard disk. Insert the 

master disk when it asks you to do so. At the first window you see, 

click Continue instead of Authorize. The master disk will be scanned 

briefly, and the program will open without authorizing the hard disk. 

About the authorization Mark of the Unicorn’s installation/authorization process is different 
procedure from past installation procedures. 

m It authorizes the entire hard disk rather than a specific 

copy of the program. 

m Once a hard disk is authorized, any copy of the program 

will run without the master disk, including updates. In fact, 

you can have two or more copies of the program on the 

same authorized hard disk and all copies will run without 
asking for the master disk. 

= Updating is much easier: you drag the update onto the 

hard disk as you would drag any file. 

mw Authorization is not lost by dragging the program icon into 

the trash. (The hard disk remains authorized even when 

there is no copy of the program present.) 
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Taking care of your 
master disks 

Installing Performer 

The master disk for authorized programs like Performer is crucial, as 

is the backup key disk that you receive in return for your registration 

card. Without one or the other, you cannot install and use the 

program. Treat them with care, and store them in a safe place when 

you are not using them! 

@ Rule of thumb: always keep your original disks locked. 

The only exception is that you need to unlock the 

master disk briefly during the process of authorizing 

and deauthorizing your hard disk. At all other times, 

we strongly recommend locking all original disks. 

Locked (Hole is open) Unlocked (Hole is covered) 

a 
& 
a Si 
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Chapter 5 Getting Started With FreeM/DI™ 

Introducing 
FreeMIDI 

This chapter is required 

Are you in a hurry? 

You can skip this 
chapter if... 

FreeMIDI is a Macintosh system extension that is automatically placed 

in your Macintosh System Folder when you install any Mark of the 

Unicorn software product. FreeMIDI provides many advantages for 

all FreeMIDI-compatible software. Here are a few of the most 

important features. FreeMIDI provides: 

a A “virtual” studio on your Macintosh that graphically 

mirrors your entire MIDI hardware setup and that is shared 

by all FreeMIDI-compatible programs 

a A simple, intuitive pop-up list of your MIDI devices 

whenever you need it in any FreeMIDI program 

a An intuitive sound list for each one of your MIDI devices, 

which makes it easy for you to choose patches by name 

mw The ability to use several FreeMIDI-compatible programs 

simultaneously (for example, you can play back Performer 

while editing patches in Unisyn at the same time) 

mw The ability to start playback, stop playback, rewind and 

cue all FreeMIDI-compatible programs at once 

This chapter takes you through the initial process of creating your 

FreeMIDI studio configuration, which Performer requires. This 

chapter represents the bare minimum necessary to get MIDI input 

and output going. A section at the end tells you where to go for 

further information about FreeMIDI. 

If you are in a hurry, see “For MIDI Experts: Setup overview and 

quick-start guide” on page 42. 

You can skip this chapter if you already have another FreeMIDI- 

compatible program for which you have already created a FreeMIDI 

configuration and successfully achieved MIDI input and output with 

the Macintosh. 
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For MIDI Experts: Setup overview and quick-start guide 

If you already have experience with the Macintosh, MIDI, or 

Mark of the Unicorn software, and you are in a hurry, this 

overview should give you a pretty good idea of what you 

need to do to make the transition to FreeMIDI. A page 

number is included next to each step so you can get more 

detailed information about that step. 

To install FreeMIDI: 

1. Set up your MIDI gear. (page 43) 

Make sure that your MIDI gear is connected and turned 

on, including your MIDI interface. 

2. If you use OMS, decide if you want to use FreeMIDI instead, and, 
if so, install the OMS emulator as described in “Emulating OMS” 
on page 176. 

FreeMIDI can emulate the Opcode MIDI System™ (OMS), 

allowing you to completely remove OMS from your 

system if you like. If you use software that requires OMS, 

you have two choices: 

m you can remove OMS (by dragging the OMS system 
extension out of the System Folder) and install the 
FreeMIDI emulator. (See page 176 for details.) 

m You can use both OMS and FreeMIDI independently. 

If you aren’t sure what you want to do, see “OMS Compat- 

ibility” on page 175 for more information about making 

this decision. 

3. If you use any program that requires MIDI Manager, install the 
FreeMIDI MIDI Manager driver as described in “FreeMIDI and 
MIDI Manager” on page 179. 

MIDI Manager adds much complexity. Only use it if you 

have a program that absolutely requires it. Remember, if 

you have applications that need to run simultaneously 

(such as Digidesign’s Sample Cell™ software), and they 

support FreeMIDI or OMS, you don’t need MIDI Manager. 

4. Run FreeMIDI Setup. (page 46) 

This application is located in the FreeMIDI Applications 
folder. 

5. Set the FreeMIDI System Preferences to tell FreeMIDI Setup 
which serial ports to search for MIDI interfaces. (page 51) 

The preferences dialog should appear automatically. If it 

doesn’t, choose FreeMIDI Preferences from the File menu. 

. Create your FreeMIDI Configuration by defining each device one 
at a time or, if possible, by defining them automatically using 
one of several shortcuts. 

In a nutshell, here are the three shortcuts. Choose the one 

that best suits your situation: 

mw Use the Auto Config button option in the Quick Setup 
dialog box to have FreeMIDI search for all the devices 
in your studio automatically. This only works for 
devices that are connected with both their MIDI IN and 

MIDI OUT. (page 51) 

mw Use the Continue button in the Quick Setup dialog box 
to define each device by hand using pop-up menus to 
indicate manufacturer, model, and device ID. (page 56) 

mw Use the Open command in the File menu to open an 
existing Performer (version 4.2 or earlier), Digital 
Performer (version 1.4 or earlier), or OMS (version 1.2.1 

or earlier) configuration file. The Performer configura- 
tion can be loaded from any source, either a regular 
Performer file or a separate configuration file. (page 55) 

. Use the Save command in the File menu to save the FreeMIDI 

Configuration to any location on your hard disk. 

. Use the Check Connections command in the MIDI menu to make 

sure that FreeMIDI is successfully sending and receiving MIDI 
data to and from your MIDI devices. (page 62) 

. Quit FreeMIDI Setup. 

You will now be ready to use any FreeMIDI-compatible 

software. You do not need to keep FreeMIDI Setup open. 

42 Getting Started With FreeM/IDI™ 



Setting up your 
MIDI equipment 

o 
oo ae, 

Printer port icon Modem port icon 

Getting Started With FreeMIDI™ 

Before you set up FreeMIDI, connect your MIDI hardware to the 

Macintosh. To so do, you will need: 

mw Any standard MIDI/Macintosh interface 

m At least two MIDI cables 

m At least one MIDI device 

1. Before you start, make sure the Macintosh is turned off. 

2. Connect the MIDI interface to the Macintosh. 

Refer to the owner’s manual of the interface for specific directions. 

FreeMIDI can send and receive MIDI information through both the 

modem and printer serial ports on the back of the Macintosh. If 

your interface connects to only one, and the owner’s manual does 

not specify which port to use, connect it to the modem port. If you 

have a MIDI Time Piece I] or a MIDI Express interface, connect it 

to the modem port. You can also connect two separate interfaces, 

one to each port, or a single interface that attaches to both. 

Modem 

port 
iia earn «se 

MIDI Interface 
-<G§eer en 

Printer Serial cables 
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3. Connect your MIDI device(s) to the interface as shown in one of the 

following diagrams. 

Serial cable OU T :tatascesanssmmonsssncmsssssmnenstiie ||\| 
MIDI cables 

Figure 5-1: Connecting a single MIDI device. Connect the device’s MIDI OUT and MIDI IN ports to the MIDI 
interface as shown here. 

Serial cable IN 

Controller 

IN 

Serial cable eS Ace oe . Ee 

aa 
Figure 5-3: Connecting several devices to a simple 1-IN/3-OUT interface. 

aateate"a"eatea ioT OUT aa"a"a"aa"e"a"ea"e"s"e"a"e"a"s"a"s"a"s"a"e"e's"e"s"t IIH CG @) n n e ct | @) n B 

OOO000000 OO000 000 FF 

=. 

Serial cable 

Connection A 

Figure 5-4: Connecting several MIDI devices to a multi-port interface such as the MIDI Time Piece I. 
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Setting up 
FreeMiDI 
Installing FreemMiDI 

OMS compatibility 

MIDI Manager 
compatibility 

What is a FreeMIDI 
configuration? 

Getting Started With FreeMIDI™ 

Once your MIDI hardware is connected to the computer, you are 

ready to begin setting up FreeMIDI. 

FreeMIDI is automatically installed in your System Folder when you 

install Performer as described in the previous chapter. 

If you currently use the Opcode MIDI System (OMS) and it is 

required for OMS applications that are not yet FreeMIDI-compatible, 

you can use FreeMIDI to emulate OMS. We recommend that you 

proceed now to Appendix A, “Using FreeMIDI with OMS” in this 

booklet for information on enabling FreeMIDI’s OMS emulation. After 

enabling OMS Emulation, please return to this page to continue your 

FreeMIDI configuration session. 

FreeMIDI Setup can read OMS configuration files created by OMS 1.2 

and 1.21 and translate them into FreeMIDI configurations. Please read 

on for more information on this feature. 

If you need to use applications that require MIDI Manager and do not 

yet support FreeMIDI, we recommend that you proceed now to 

“FreeMIDI and MIDI Manager” on page 179 for information on 

installing the FreeMIDI MM Driver for MIDI Manager. After 

installation the FreeMIDI MM Driver, please return to this page to 

continue your FreeMIDI configuration session. 

A FreeMIDI configuration is a file that you create and save on your 

hard disk using a program called FreeMIDI Setup. The file contains a 

graphical representation of the MIDI hardware devices in your studio, 

and it shares this list of devices with all FreeMIDI applications. 

Here is an overview of the process we will go through in this chapter 

to create it: 

1. Run FreeMIDI Setup. 

2. Set the FreeMIDI System Preferences to tell FreeMIDI 

Setup which serial ports to search for MIDI interfaces. 

3. Create your FreeMIDI Configuration by defining each 

device one at a time or, if possible, by defining them 

automatically using one of several shortcuts. 

4. Save the FreeMIDI Configuration to disk. 
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5. Use a feature called Check Connections to make sure that 

FreeMIDI is successfully sending and receiving MIDI data 

to and from your MIDI devices. 

Launching FreeMIDI Locate the FreeMIDI Setup program. During installation, it is placed 

Setup in the FreeMIDI Applications folder on the top level of your hard 

disk. 

1. Double-click the FreeMIDI Setup application icon to launch the 

program. 

After the initial splash screen, the Welcome to FreeMIDI dialog box 

appears: 

Welcome to FreeMIDI! 

Use FreeMIDI! Setup to create a studio configuration to 

which all FreeMiIDI applications have access. 

After clicking “Continue’ you will be presented with 

Quick Setup. You can use this feature to automate the 

process of creating a studio configuration, and to make 

manual additions very quickly. 

If you would like to use an existing OMS or Performer 

configuration, click "Cancel" from Quick Setup and 

choose "“Open’" from the File menu. 

Figure 5-5: Welcome to FreeMIDI Dialog Box 

2. Click Continue. 

The FreeMIDI Preferences dialog box appears. 
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FreeMIDI Preferences 

Software Compatibility 

(; FreeMIDI! applications only 

MID! Configuration 

Serial Ports: 
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Figure 5-6: FreeMID/ Preferences Dialog Box. 

Cancel 

3. Set the FreeMIDI Preferences as described below. 

Preference How you should set it 

the modem or printer port while FreeMIDI applications are running. 

have a MIDI interface connected. Be sure your MIDI gear is turned on. 

requires that it be checked. 

Sample Cell If you have a Digidesign Sample Cell or Sample Cell II card installed in your 

Macintosh, check its box. 

Monitor patch changes Make sure this option is checked. 

Generate active sensing Leave this option unchecked, unless you have a MIDI device in your studio that 

Yamaha Clavinova-series electric pianos. 

Getting Started With FreeMIDI™ 

Software compatibility Choose the FreeMIDI Applications only option, unless you want to run other 

non-FreeMIDI software at the same time as FreeStyle. If so, use the Allow other 

applications option. This option may also be necessary if you have FAX/ 

modem, networking, or other communication software that requires access to 

MIDI Configuration Click the check box for each serial port Gnodem and printer) to which you 

Inter-application MIDI Leave this option unchecked, unless you have another FreeMIDI program that 

does not function correctly unless it receives Active Sensing data at all times. 

In our experience, the only MIDI devices that are in this category are some 
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4. Before you click OK in the Preferences dialog box, check to be sure 

that your MIDI interfaces are connected and powered-up. 

Click OK to confirm your preference settings. 

When you click OK, FreeMIDI Setup scans the serial port(s) that 

you have selected for MIDI interfaces. If you selected the printer 

port option under MIDI Configuration, and AppleTalk is enabled 

on the printer port, a warning alert box appears to ask if you 

would like to claim the printer port for MIDI. 

( The Printer port seems to be in use by: 

Appletalk 

Are you sure you want to Claim the port 
claim this port for MIDI? 

6. 

Leave it alone 

Figure 5-7: Apple Talk Warning Alert 

If you are using AppleTalk for network communications or an 

AppleTalk printer, you should click Leave it alone and re-think your 

MIDI studio setup. 

Otherwise, click Claim the port and FreeMIDI will be able to use 

the printer port for MIDI. If you do so, remember to disable 

AppleTalk in the Chooser when you are through configuring 

FreeMIDI in order to avoid seeing this warning alert again. If you 

are using AppleTalk for an Ethernet network and your Ethernet 

connection is made via NuBus or SCSI or some other bus that does 

not utilize the printer port, FreeMIDI should not ask about 

disabling AppleTalk and network communications should not be 

interrupted. 
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7. If there are interfaces in your setup that are not powered on or 

connected properly, FreeMIDI Setup cannot find them. 

If FreeMIDI cannot find any interfaces, the No Interface Found 

dialog appears: 

( No interface could be found on the Modem 

Port. If itis off-line, make sure the interface 

is turned on and connected, set any 

MIDI/Thru switches to MIDI, and click "Try 

Again.” 

If your interface is not present, you may 

click "Choose..." to choose an interface from 

the available options. 

Figure 5-8: No interface Found Dialog Box 

8. Check the connections and power switches and any MIDI/Thru 

switches on your interfaces and click Try Again. 

If your interfaces are not currently connected or not powered on, 

you can still create a FreeMIDI configuration at this time, but you 

will need to use the Update Interfaces feature. For more 

information, see “Adding Interfaces” on page 701 in the Performer 

Reference Manual. If FreeMIDI Setup cannot find some or all of 

your interfaces and you believe that they are connected properly 

and are powered on, proceed to Appendix C, “Troubleshooting 

FreeMIDI”. 
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Initiating the Auto , After you click Begin, FreeMIDI checks every cable on all of your 
Config process MIDI interfaces for MIDI devices. The piano keyboard progress bar 

gradually fills up as FreeMIDI searches your studio for MIDI devices 

as shown in Figure 5-10 on page 51. 

As FreeMIDI finds MIDI devices, it lists them in the status box below 

the piano keyboard. If you have the FreeMIDI Applications only 

option set in the FreeMIDI preferences, you can even switch out of 

FreeMIDI Setup to another application and FreeMIDI will continue 

searching your studio for MIDI devices while you do other work on 

your Macintosh! If you have the Allow other applications option set in 

the FreeMIDI Preferences, you can still switch to another application 

during the Auto Config procedure, but FreeMIDI will stop searching 

for MIDI devices until you switch back into the FreeMIDI Setup 

application. 

This search can take several minutes depending on the number of 

MIDI devices and the type and number of MIDI interfaces in your 

studio. Click Stop if you want to interrupt the search process at any 

time and Auto Config will stop searching for MIDI devices. The Quick 

Setup dialog box opens and displays all the devices found up to that 

point. 

Keep in mind that Auto Config may not be able to find a// the MIDI 

devices in your studio. It is also possible that one MIDI device from 

a manufacturer could not be distinguished from another, closely 

related MIDI device from the same manufacturer. An example of this 

A few things that can happen during Auto Config 

If you have a MIDI device that echoes (merges) incoming 

MIDI data to its MIDI out, this may cause errors during the 

Auto Config process. For best results, we recommend 

disabling this feature. Unfortunately, in some MIDI devices, 

echoing cannot be disabled. If this is the case, we recom- 

mend powering off these units until Auto Config is complete. 

You can then power them back up and add them to your 

FreeMIDI configuration manually. Some examples of such 

devices are the Yamaha KX-88 and Roland SBX-80. 

Due to their MIDI implementation, some MIDI devices may 

display “MIDI Buffer Full”, “MIDI Overflow error” or “device 

ID number mismatch” error messages in their front-panel 
display during Auto Config. This is due to the large number 

of sysex messages that are sent to each device. Don’t worry. 

This is harmless. (Hopefully, more and more manufacturers 

will support the universal MIDI device inquiry message, 

which will prevent messages like these.) 

Some MIDI devices may be found more than once because 

they are able to respond to more than once device ID at a 

time. If possible, try to set these devices to a single ID before 

using Auto Config. 
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is the Korg M1 family, which consists of the M1, M1R, M1EX, and 

M1REX. Auto Config will probably find all of these units and identify 

them all as Korg MIs. 

To fine-tune and finalize your configuration, proceed to “Adding 

devices manually with Quick Setup” on page 56. 

Auto Configuration 

piano keyboard Auto-Configuring studio... 
progress bar 

LT) 7 ?% Complete 

Status: Found 3 Devices 

1. Found Ensonig ESO-M/ESQ-1 (ID 1) 
2. Found E-mu Systems Proteus/1 (1D 0) 
4. Found Kurzweil K2000 

Figure 5-11: Auto Contig Progress Window 
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Customizing Auto Contig 

If you know which MIDI devices are in your studio, click 

Customize... so that you can tell FreeMIDI what devices to 

search for. This can greatly reduce the amount of time it 

takes for Auto Config to find your MIDI devices. 

1. After clicking Customize, the Customize dialog box appears as 
shown in Figure 5-12. 

If you change your mind and no longer want to customize 

Auto Config, but you still want FreeMIDI to search for 

MIDI devices and configure your studio automatically, 

click Simplify to return to the Auto Config dialog box and 

proceed to “Initiating the Auto Config process” on 

page 52. 

2. Select a device or devices from the list on the left and click Add. 

To select more than one device, command-click each 

device that you wish to add. Shift-drag to select multiple 
devices that are together in the list. To select all the 
devices from the list at once, click Add All. 

. If you accidentally add a device or some devices for which you 
do not want FreeMIDI to search, select the device or devices 
from the list on the right and click Remove. 

. Keep adding devices until you have told FreeMIDI about all the 
devices in your studio that are in the list. 

. When you are done, click Begin. 

FreeMIDI proceeds to check every cable of all of your 

MIDI interfaces for all the MIDI devices you have defined. 

You'll see the progress dialog box shown in Figure 5-10 

on page 51. 

. Proceed to “Initiating the Auto Config process” on page 52. 

Auto Config will only scan for devices in the list on 

the right. Add the devices you own from the list of 

available devices on the left. To simplify Auto 

Config, press "Simplify." 

Device Choices: 

Akai $1000 

Alesis HR-16 

Alesis Quadraverb 

Alesis SR-16 

ART DR1 

ART Multiverb EXT 

ART Multiverb II 

ART Multiverb SGE 

Cancel 

Look For: 

Make sure all of your interfaces and MIDI devices are turned on. 

Figure 5-12: Auto Config Customize Dialog Box 
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Translating Performer, 
Digital Performer, or 
OMS files 

Getting Started With FreeMIDI™ 

FreeMIDI Setup can open configuration files created by 

Performer 4.2, Digital Performer 1.4, or OMS Setup 1.2 or 1.21 and 

create a FreeMIDI configuration that closely matches this configu- 

ration. This can save a considerable amount of setup time. When 

translating Performer and Digital Performer configurations, you can 

open either a regular Performer/Digital Performer file or the 

configuration file, which may be saved separately. 

To translate any of these files: 

1. Choose Open from the File menu. Alternately, you can type 

command-O on your Mac keyboard. 

A standard Macintosh File Open dialog box opens. 

Select the Performer, Digital Performer, or OMS Setup file that you 

wish to translate and click Open. 

Use the directory pop-up menu to navigate to the disk and folder 

that contains the configuration you wish to translate. See your 

Macintosh owner’s manual for more information on opening files 

and navigating to disks and folders. 

The selected file is translated as closely as possible into a 

FreeMIDI configuration. 

If, after the translation process, all of your MIDI devices now appear 

in the FreeMIDI Configuration window and are connected to the 

proper MIDI interface input and outputs, proceed to “Arranging the 

FreeMIDI Configuration window” on page 58 in this chapter for the 

next steps in the configuration process. 

You may find, however, that some devices are misnamed, missing, 

incorrectly duplicated, or improperly defined. If so, you will need to 

edit the configuration using Quick Setup: 

1. Choose Quick Setup from the Configuration menu and click 

Continue. 

The About Quick Setup dialog box appears. 

Click Continue. 

Proceed to “Adding devices manually with Quick Setup” on 

page 56. 
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Adding devices At this point, you have completed one of the following: 

manually with Quick 
Setup m You have just completed the Auto Config process (the 

search is 100% complete). 

m You have just translated a Performer, Digital Performer, or 

OMS file and have skipped to this step. 

m You have just clicked the Quick Setup button to configure 

your studio manually. 

In any case, you now see the Quick Setup dialog box on-screen as 

shown below in Figure 5-10. 

New Device: Current Configuration: 

Manufacturer: MIDI Express, Printer 

git 
Steet MIDI Time Pieces, Modem 
whee CBH-D5 
K2000R Bek Video Time Piece 

Studio Location: Wavestation SF 

MIDI Express, Pri... PC-200 

ESO-M 
Cable: TG?7 

>> Add >> 

ito an interface device, choose the 

icorresponding interface from the “Studio 

Location” menu. : | S< PRSSYPECERFS << 

Figure 5-13: Quick Setup Dialog Box 

If all the MIDI devices in your studio already appear in the list, you 

are done! Click Done and the FreeMIDI Configuration window will 

appear containing all your MIDI devices and their connections. If 

there are no devices listed, or the list is incomplete, you will now 

need to tell FreeMIDI about these devices manually as follows: 
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1. Select the correct manufacturer, model, studio location and 

cable (if applicable) from the pop-up menus on the left and then 

click Add Device. 

If the pop-up menus do not contain a description of a particular 

device, choose Other and click Add Device. The first generic 

device you add is given the name Device-1. You will learn how 

to re-name and re-define these devices later on. 

2. If Auto Config found devices that are not the exact model 

installed in your studio, such as a Korg M1 instead of a Korg 

M1R, you can easily edit these devices. 

Select the device on the right and click Remove. Now choose a 

new model from the pop-up menu on the right and click add. A 

new device is added with the same manufacturer and studio 

location. 

3. When you have added all the devices to the list that are in your 

studio, click Done. 

The FreeMIDI Configuration window appears, displaying all of 

your MIDI devices and their connections. 

FreeMID! Configuration 

Proteus /2 

lad 

seme 
Drumk at 

ammueave 

MIDI Mixer fs 

Figure 5-14: FreeMIDI Configuration Window 
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The Clean Up Window 
Command 

Arranging the FreeMIDI 
Configuration window 

Making MIDI thru 
connections 

Making multiple MIDI 
input connections 
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You can use the Clean Up Window command in the Views menu to 

quickly arrange all the devices in the window into uniform columns. 

You can arrange the FreeMIDI Configuration window any way you 

like. We suggest that you drag device icons so that they appear as 

they do in your studio. For instance, you can arrange all the modules 

to the left of your Mac on the left side of the window and do the 

opposite for the modules to the right of your Mac. You can drag the 

patch cords, which connect the devices to the interfaces, up or down 

so that you can view the connections clearly. You can drag MIDI 

ports in a multi-cable interface, such as the MTP, MTP II or MIDI 

Express, up or down to create more or less space between them. You 

can delete input or output cables, which are not part of your studio 

setup, by clicking the patch cord to select it and typing the backspace 

or delete key on your Mac keyboard. You can also make and break 

connections by just dragging the ends of the patch cords. You can use 

the different options in the Views menu to change the size of the 

icons and to view input and outputs separately, together, or only 

when the device to which they are connected is selected. 

When more than one MIDI device shares a single output port from a 

MIDI interface, you need to connect the MIDI Thru port of the device 

to the input of the other device. This mirrors the physical connection 

that you should have between the devices. 

ao ee ™ 
ba— BRC ‘ta = Rama 
| Video Time Piece 

Figure 5-15:MIDI Thru Connection 

FreeMIDI Setup allows you to connect more than one MIDI output 

from a device to a single MIDI input on an interface. When you make 

such a connection, you are telling FreeMIDI that both devices’ MIDI 

outputs are connected to a single MIDI input on an interface. Without 

some type of MIDI merger, this type of connection is not possible. 
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MIDI Time Piece Il, Modem MIDI Time Piece Il, Modem 

. * | 

a i T —_ > 

Connecting a device to 
an interface output 

MIDI Time Piece Il, Modem 

Dragging a 
connection 
horizontally 

a 

a MIDI Time Piece Il, Modem 

Ee ee 

aan I 

aes BED (7) 

ere Seer he > (B)e 

Oe 
Dragging a oo 
device to change ad 
its position 

Dragging a MIDI port 
to change its position 

Figure 5-16: Arranging FreeMIDI devices and connections 
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Connecting devices to 
other devices 

Using MidiLocate to 
make connections 

60 

FreeMIDI Setup allows one connection per port Ginput output, or 

thru) on each device. You cannot connect devices to each other 

except from MIDI Thru to MIDI In of a separate device. If you would 

like to make such connections, use the Cable Routing (on MIDI Time 

Piece and MIDI Express interfaces) or similar features in your MIDI 

interface or MIDI patch bay/merger gear. 

MidiLocate is a unique feature designed to make adding devices to 

your FreeMIDI configuration easier. In this mode, FreeMIDI 

automatically determines the proper input cable to which a device is 

physically attached and then displays this connection in the FreeMIDI 

Configuration window. 

MidiLocate is a checkable menu item. This means that its state (on or 

off) is toggled each time you choose it from the menu. When there is 

a check next to the MidiLocate menu item in the MIDI menu, 

MidiLocate is enabled. 

To use MidiLocate: 

1. Select a FreeMIDI device in the FreeMIDI Configuration window. 

2. Check to be sure that MidiLocate menu item in the MIDI menu is 

enabled. 

The MidiLocate command should have a check next to its name. 

If it does not, choose it to select it. You can also use the Mac 

keyboard shortcut to toggle the state of MidiLocate by typing 

command-L. 

3. Play some MIDI data from the MIDI device. 

FreeMIDI will determine from where the MIDI data is coming and 

redraw the FreeMIDI Configuration window to indicate the 

appropriate connection. 

Here is an example of MidiLocate in action. Let’s say you have a 

Kurzweil K2000 that is connected to some MIDI input on your 

MTP II, but you are not sure which input: 

1. Add a K2000 FreeMIDI device your configuration using Quick 

Setup or Create Device. 

2. Enable MidiLocate. 
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3. Select the K2000 device by clicking its icon. 

4. Play some notes on its keyboard or send some other MIDI data 

from it and the K2000 device automatically is connected to the 

correct MIDI input port on your MTP Il in the FreeMIDI 

Configuration window. 

Saving the FreeMIDI Once you have a FreeMIDI configuration, it is a good idea to save it 

Configuration to disk so that you will not have to configure FreeMIDI for your 

studio again. 

To save your configuration: 

1. Choose Save from the File menu. Alternately, you can type 

command-S on your Mac keyboard. 

A standard Macintosh File Save dialog box opens. 

=) My Configurations ¥ <— Hard Disk 

ffi 7 

Desktop 

Save new configuration as: 

FreeMIDI! Configuration 

Figure 5-17: Macintosh File Save dialog box 

2. Use the suggested name “FreeMIDI Configuration” or enter 

another name for your configuration, if you like, and click Save or 

click Cancel to cancel the operation. 

Use the directory pop-up menu to navigate to a disk and folder in 

which you wish to save this configuration. 

@ If you are using System 7, you can use the New Folder 

button to create a new folder in which to save this 

configuration and others that you might create in the 
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future. See your Macintosh owner’s manual for more 

information on saving files and navigating to disk and 

folders. 

The current FreeMIDI There is no need to make this configuration “current”. Whichever 

Configuration configuration is visible in the FreeMIDI Configuration window is the 

current configuration that all FreeMIDI applications will use. 

Whenever you launch FreeMIDI Setup to view or edit your FreeMIDI 

configuration, the configuration document with which you were last 

working is opened automatically. 

Testing for MIDI input You are almost done setting up your FreeMIDI configuration. The last 

and output thing you need to do is test the MIDI connections between your MIDI 

devices and FreeMIDI. To test for MIDI input and output: 

1. Choose Check Connections from the MIDI menu. 

This command puts FreeMIDI Setup in a special studio testing 

mode which allows you to easily test MIDI inputs and outputs. 

When the menu item is checked, Check Connections mode is 

enabled and the mouse cursor will change to the Check 

Connections cursor as shown in Figure 5-10 below. 

Figure 5-18: Check Connections mouse cursor 

2. Check MIDI input by playing notes on your MIDI controllers or 

sending other MIDI data such as patch changes, controller data or 

system exclusive data from your other MIDI modules. 

When FreeMIDI is receiving MIDI correctly in Check Connections 

mode, the MIDI port to which the MIDI device sending the MIDI 

data is connected will flash the eighth note symbol as shown in 

Figure 5-10 below. If no activity is indicated, check to be sure that 

the MIDI device that is sending the data has its MIDI output 

connected to the proper MIDI input on your MIDI interface. 

ote 

~& (1 O0)e 

Figure 5-19: Incoming MIDI Data indicator 
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Quitting FreeMIDI Setup 

Where to go next 

Getting Started With FreeMIDI™ 

3. Check MIDI output by clicking devices. 

In Check Connections mode, FreeMIDI Setup generates a C major 

chord on the default play channel and sends it to the MIDI output 

to which the device you click is connected. If all is well, this 

device should play a C major chord. If the MIDI device does not 

play notes, check to be sure that the MIDI device has its MIDI 

input connected to a MIDI output on your MIDI interface. 

If your connections check out OK, you are finished! You are now 

ready to use any FreeMIDI-compatible software. All of your FreeMIDI 

configuration devices will appear in any places where you choose 

MIDI devices for playback and recording Gnput and output). 

You do not need keep FreeMIDI Setup open. The only time you need 

to open FreeMIDI Setup is when you would like to make changes to 

your FreeMIDI studio configuration. Conversely, you can open 

FreeMIDI Setup at any time, even while you have other FreeMIDI- 

compatible programs open. 

Regardless of your level of experience, turn now to chapter 6, 

“Starting Performer for the First Time” for some important things you 

need to know before you begin using Performer. 
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Chapteré Starting Performer for the First 
Time 

Before you start up Performer for the first time, be sure that you have 

already completed the installation process described in the previous 

chapters. At this point, you should have: 

= Connected your MIDI hardware to your Macintosh 

m Installed Performer and FreeMIDI 

» Authorized your hard disk to run Performer Gf desired) 

ms Created your FreeMIDI configuration and tested your MIDI 

connections in the FreeMIDI Setup program 

If you have completed the above installation procedures, you are 

now ready to start Performer. 

To open Performer for To open Performer, double-click the Performer program icon. 
the first time 

The Performer 
program icon 

Performer™ 

@ If you see a message informing you that Performer 

cannot run yet because FreeMIDI is not installed in the 
system or because there is no FreeMIDI configuration 

yet, refer to the previous chapter in this booklet to 

make these preparations. 

@ The examples of Performer’s windows that you see in 

this manual are what you see when Performer is 

running on a Macintosh with an 8-bit color monitor 

(with 256 colors). If you have a black and white 

monitor, what appears on your screen will be slightly 

different than what you see printed in this book. 
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Where to go next At this point, you are ready to open a file to begin working with 

Performer. Where you go next depends on what you would like to 

do. 

What you want to do: 

If you would like a brief overview of Per- 

former 

If you would like a brief, step-by-step tutorial 

If you would like an extensive tutorial about 

how to cycle-record and build a sequence 

If you don’t read manuals and would like to 

begin sequencing right away 

If you would like brief overview of the most 

recent changes in Performer 

If you have a MIDI Time Piece II or a MIDI 

Express and you are just getting started with 

Version 5 and FreeMIDI 

If you would like to be able to choose 

sounds (patches) on your MIDI synthesizer 

by name in Performer and other FreeMIDI- 

compatible programs 

If you would like to learn more about Free- 

MIDI 
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Where to go next: 

Turn to chapter 7, “Performer Overview: A Picturebook Tour” 

(page 69) in this guide. 

Turn to chapter 8, “Getting Started: Recording Your First Track” 

(page 87). 

Turn to chapter 9, “Tutorial: Building a Sequence” (page 103). 

Go for it. Before you do, though, you might want to check out 

chapter 7, “Performer Overview: A Picturebook Tour” (page 69). 

Turn to “What’s New in Performer® 5” on page 13. 

Turn to chapter 10, “Using Other FreeMIDI Releases with Per- 

former” (page 151) for information about how to run their soft- 

ware with FreeMIDI and Performer Version 5. 

Turn to chapter 48, “Using PatchList Manager” (page 725) in the 

Reference Manual. It discusses how to load lists of sounds into 

FreeMIDI from your MIDI gear. If you have Unisyn, also consult 

chapter 44, “Using Performer With Unisyn” in the Reference 

Manual. 

This installation guide has told you the basic things you need to 

know. However, FreeMIDI provides much more. For example, 

you can create your own icons for your MIDI devices in the Free- 

MIDI configuration. As another example, you can connect Per- 

former’s transport controls (play, stop, rewind) to another Free- 

MIDI application, like Unisyn, so that you can control Performer 

from Unisyn. For more information, the see the following Free- 

MIDI-related chapters in the Performer User’s Guide: 

e chapter 46, “Using FreeMIDI Setup” 

e chapter 47, “Quick Reference for FreeMIDI Setup” 

e chapter 48, “Using PatchList Manager” 

e chapter 49, “Editing FreeMIDI Device Files” 

Starting Performer for the First Time 
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Chapter7 Performer Overview: 
A Picturebook Tour 

If you don't like to read 
manuals 

Following along in 
Performer 

This chapter provides a quick overview of Performer’s main features. 

Each page gives you a brief introduction to Performer’s important 

windows and features. You'll probably get a good idea of how to get 

around in the program just by scanning these pages. Once you have, 

you'll be primed and ready for the step-by-step tutorials that follow. 

Or you can try to begin sequencing on your own. 

You can read this tour without actually being in front of your 

computer and without running Performer. If you would like, 

however, you can run Performer so that you can try things in the 

software as you read. To do so, just double-click the Performer 

program icon now to launch the program Cif you haven’t already 

done so). A new file appears, and at the top of the window, you'll 

see... (turn the page) 
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The The Consolidated Controls panel provides tape-deck style transport 

Consolidated controls, a metronome panel for tempo control, a counter, and 

buttons that open most of Performer’s important windows. Because 

Contr ols panel this panel is so central to Performer’s operation, it appears whenever 

you open a new or existing file, and it cannot be closed. 

Metronome Panel Skip Buttons Transport Controls Counter 
Controls the tempo of the music. You can have several— Function just like a standard tape deck. Displays the current playback time in 
Drag the tempo slider, or type in even many—sequences From left to right: rewind, stop, play, pause, the music in bars, beats, and ticks. 
the desired tempo in beats per in one Performer file and —_ and record. The position bar below can be There are 480 ticks per quarter note. 
minute. skip between them, just used to cue quickly anywhere in the music. The auxiliary counter displays one of 

like a CD player. Performer’s other two time formats: 
real time or SMPTE time code. 

Window Buttons Window Buttons 
These buttons open windows for Memory Bar These buttons open editing windows. 
commonly used features in Performer, Displays the start and stop time of the From left to right: Tracks, Event list, 
such as the Markers window. memory-cycle playback loop. These are the Graphic Editing, and QuickScribe 

locations Performer will shuttle between notation windows. 
when Memory-cycle is turned on. 

Metronome Click Auto Record Countoff Wait Set Loop 
Press this button to turn the Lets you automate Gives you a countoff Makes Performer wait for Click this button to insert a 
metronome click on and off. recording punch-in before playback or a MIDI event trigger or permanent loop in the 
Double-click it to set the click and punch-out. recording. Double-click key press before it begins currently selected region in 

preferences. to set preferences. playback or recording. one or more tracks. 

Overdub Record 
During normal recording, Performer erases 
existing music in the track. Use Overdub 
Record to preserve existing material and 

Memory Cycle merge new material with it. Use it 

When this button is highlighted (on), For more information, see whenever you are cycle-recording so that 

Performer cycles playback and recording chapter 5, “The Consolidated each new pass through the loop doesn't 
between the Start and Stop times displayed Controls Panel” (page 63) in the erase the last pass. 
below in the Memory bar. Performer Reference manual. 
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Pe for mer sS " Before you ge any further, here are several unique aspects to 

un ique interface Performer’s overall design that you should be familiar with. They are 

easy to learn and streamline your working environment in Performer. 

| Pushdown button Zoom button 
The Pushdown button moves the window Opens the window to the full size of your 
behind all other windows. This is useful when screen or to a size that show all of its 
you don’t want to close the’window, but you’d contents. If you click it again, it returns to its 
like to move it out of the way temporarily. original size. 

Close button 
Closes the window. 

Window mini-menu 
Contains commands that apply only 
to the window that contains the 

menu. To pull it down, press on the 
menu icon and then select a menu 

option as you would in a standard 
Macintosh menu. 

Drag the title bar of the 
dialog box to move it on the 
screen—in case you need 
to see something behind it 
before closing it. 

Performer’s three dimen- 

sional radio buttons and 

check boxes function just 
like standard Macintosh 

buttons. For example, you 
can click the text label of 

the button to select the 

button. 

Three dimensional OK 

and Cancel buttons. 
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The Tr acks The Tracks windowwis based on the familiar concept of a multi-traek 

Window tape deck. Each track can beplay-enabled, recorded into, and soloed. 
Each track has an activity level meter, a MIDI playback assignment 

(one of the devices in your MIDI studio), a track name, comments, 

and perhaps an initial patch (sound) to play. You can add an 

unlimited number of tracks, and you can place them in any order in 

Window” (page 163) in the the list. The Tracks overview on the right provides you with a bird’s- 
Performer Reference manual. eye view of the music, showing which measures have music in them. 

You can drag segments that contain music to move them and to select 

them for editing. A scrolling playback indicator is also provided to 

show the current playback location. 

For more information, see 

chapter 12, “The Tracks 

Selecting and editing with The Edit Bar The Tracks Overview 
The start and end times in the edit bar determine the region of time Provides you with a view of the music in the tracks. The time ruler 
in the currently selected track(s) that will be affected by commands above indicates the measure in each column. The ruler also displays 
you choose from the Edit and Region menus. In addition to typing in draggable memory-cycle repeat barlines and auto-record punch 
times by hand, there are many useful shortcuts for setting the start points. Double-click the ruler to make playback jump to that location. 
and end times. For example, you can click the Start and End buttons In the grid, colored segments contain music (or other MIDI data). 
to set them to the current playback location—even on the fly during Dark segments indicate dense data. Drag segments to move them. 
playback. You can also double-click them to automatically go to the Click them or drag over them to select them for editing using the 
beginning or end of the sequence. . commands in the Edit and Region menus. 

A track is represented as one row in the list. It has a move Cas The ruler can be zoomed to show more 
handle, record-enable button, play-enable button, MIDI device Drag this handle left or less time in each column. Right now, 

assignment (for playback), a name (option-click to rename it), and right to show more each column represents one measure. You 

level meter that shows MIDI activity, a default patch (sound), a or less of the Tracks can zoom in, however, so that each column 
current patch, and a comment. You can choose to hide any of Overview. represents one beat. Or zoom out so that 
these columns by double-clicking the column title. For example, each column is two bars instead of one. 

if you never use default patches, you can hide the column. The 
Conductor track at the top of the list doesn’t hold MIDI data; 
instead, it holds tempos, meter changes, key changes, and 
markers (explained later). 

Opening a new file 
When you open a new file, the Tracks window 
looks something like this. The columns may be 
in a slightly different order from left to right. 
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The Event List 

For more information, see 

The event list gives you a precise, numerical display of the MIDI data 

in a track. To open it, double-click the track name or a segment in the 

Tracks Overview. Or highlight either one and click the Event List 

button in the Consolidated Control panel. To temporarily hide any 

type of data, use the View Filter in the mini-menu. 
chapter 20, “The Event List 
Window” (page 257) in the 
Reference manual. 

Audible Mode 
When this button is turned 
on, notes play when you click 
them. To play a phrase, 
select a group of notes and 
option-click the button. 

Chord 
These three notes are a 

chord because they all occur 
at the same time. 

Location 
(measure, beat, and tick) 

Pitch 

A note event 

Performer Overview: A Picturebook Tour 

Insert Menu 
Select any type of data from 
this menu to insert it at any 
location in the track. 

Event List button 

Solo button 
Solos the current track during 
playback. Double-click the 
button to configure soloing. 

Window Title 
In all of Performer’s edit windows, as a short- 

cut, you can switch to a different track by 
command-clicking the title to open a pop-up 
menu of other tracks. 

Selecting events 
To select a single note or 
event, click it. To select several 
in a row, drag over them. (Use 
command-click to extend the 
selection.) Once you've 
selected notes, you can edit 
them any way you want with 
the commands in the Edit and 
Region menus. 

Legend 
On-velocity Use the Legend in the Event List mini- 

Duration menu to identify each type of MIDI data. 

(Beats and ticks) 

Pop-editing 
Double-click any value to pop-edit it 
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The Gr aphic The Graphic Editing window displays notes and MIDI controllers in a 

Editing window track on a piano-roll style grid. To open it, command-double-click the 

track name or any segment in the Tracks Overview. Or click them 

once and then click the Graphic Editing button in the Consolidated 

Control panel. 

For more information, see 

chapter 21, “The Graphic 
Editing Window’ (page 281) in 
the Reference manual. Graphic Editing button 

Zooming Selected Notes Note Grid Scrolling Wiper Edit Resolution 
Zoom the time To select several notes, Insert and edit notes in this grid. Drag Indicates the current Check the Edit resolution 
ruler and pitch drag the cursor over them, notes up and down to change pitch. playback location. Double- box to make everything 
ruler with just like you would in a Drag left and right to change their click anywhere in the ruler “snap” to a rhythmic grid as 
these buttons. graphics program. time. To change duration, drag the to make the playback wiper you drag it, including notes, 

right end of the note. jump to that location. loop points, and even 
region selection. 

Pitch Ruler 
Double-click a 
key to automati- 

cally select all ———_» 
notes of that 

Time Ruler 
Shows time in measures, 

beats and ticks. To select a 

pitch in the region, drag in the ruler. To 
track. change the memory-cycle 

points or auto-record punch 
points, drag them. 

Drag this handle to 
display more or less 
of the note grid and 
continuous data 
grid. You can even 
drag it all the way up 
or down to hide 
either grid. 

Continuous Data Ruler Continuous Data Grid Selected note velocities Inserting curves 
Click this ruler repeatedly to Displays note velocities, MIDI To graphically edit velocities (or a To insert a curve like this, set the edit resolu- 
switch between three different controllers, and pitch bend data. _ controller curve), select them by tion to determine the time interval of the 
controller displays: controllers dragging over them. Then click the individual events. Then choose the type of 
only (0-127), pitch bend only Reshape button in the title bar and data you want to insert from the Insert menu 

(-8192 to 8191), or both. drag across the selected data. (“I”) in the title bar. Then drag from left to 

' right in the grid. Option-drag to draw a line 
that generates a smooth curve. 
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QuickScr ibe The QuickScribe notation window displays music from one or more 

notation window tracks on a page in standard music notation. To open it, select a track 

by clicking its name in the Tracks window—or shift-click as many as 

you like. Then choose the range of measures you'd like to see by 
For more information, see 

chapter 23, “QuickScribe setting the start and end times in the Edit bar. To quickly select the 

Notation” (page 345) in the entire piece, double-click the Edit button. Then click the QuickScribe 
Reference Manual. 

notation button in the main control panel. The music is formatted just 

like it will print out. 

: ; Entering notes with Mac keyboard 
QuickScribe Click the staff with the arrow to get this cursor. Choose 
Notation button durations from the keypad. Press return to insert the note. 

Cursor coordinates 
Shows the exact location of 

the cursor for note insertion. What Else Can ! Do? 

Vocals 

Tool Palette 
Click a duration in the palette. Press 
anywhere in the desired measure and 
while holding down the mouse, drag to 
any pitch and location. Watch the cursor 
coordinates for precise feedback about 
where you are in the measure. You don’t 
have to get the pitch exactly right when 
you first click because you can drag up or 
down after you press the mouse to get 
just the right pitch and accidental. The 
mouse automatically snaps to even 
subdivisions of the beat to make rhythmic 
placement easy. 

Transcription 
Even though the notation looks 
quantized, the MIDI data in the track 
remains in its original, unquantized form. 

lf Performer doesn’t transcribe a section 
quite right, you can quantize the data to 
improve the rhythmic interpretation. 

Step Recording 
Click the staff with the arrow to get the 
insertion cursor. Use the arrow keys to 
place it at the desired location. Choose 
a duration in the palette. Play the notes 
on your MIDI controller. 
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The Chunks list, So far, you’ve been introduced to the. Tracks list and three ways to 

view the MIDI data recorded into tracks. In Performer terminology, sequences, and ma 
the Tracks window and the set of tracks it. contains are called a 

SOngs sequence. But you are not limited to just one’sequence in a Performer 
file. You can have as many sequences as you want. Sequences are 

displayed in the Chunks list window. The Chunks list also displays 

another type of chunk called a song. Together, sequences and songs 

are referred to as chunks, so read the word chunk as sequence and/ 

For more information, see or song. The Chunks window is great for “pattern-based” sequencing, 
chapter 14, “The Chunks Window” where you build parts of a song separately and then combine them 
(page 205) in the Reference manual. 

into a song as shown on the next page. 

The Chunks list 
Only one chunk can be play-enabled at a time. Each chunk has a 
move handle, play-enable button, song select number, end time 
(which indicates its length), a name (option-click to change it), and 
comment. To make a copy of a sequence, highlight its name and 
choose Copy from the Edit menu. Then choose Paste. 

To open the Chunks list window, click 

the Chunks list button. 
x 

¢ . 

_¢. Opening a Tracks window ~~. 
2° Toopen the Tracks window for a Se 

ao sequence, double-click its name, or click er 
= its name once and click the Tracks window 

button in the main control panel. Each 
sequence has its own Tracks window. 
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The Song Build a song with sequences and other songs simply by dragging and 

window dropping them into the Song window. Each chunk plays seamlessly 

from one to the other. The song even has its own conductor track, 

which can have either a unique tempo map, or a composite tempo 

map built from its component sequences and songs. 

Building live performance sets 
Songs are ideal for building live perfor- 
mance sets because each sequence (or 
song) can play seamlessly into the next. 

For more information, see 
chapter 15, “The Song Window” 
(page 217) in the Reference manual. 

To open a song 
Unique Non-linear Display 

Building a song oe pees weg: The Song window has a unique, non-linear 
To build a song, drag any : ee mise i. display. Each chunk is given equal length, regard- 
eee eee : pts less of its actual duration, which provides you with 
other songs into the song Be a condensed view of your music. 
window and “drop” it at an exist- 
ing column. To drag and drop, 
grab the chunk’s handle. 

Column ruler 
Shows the measure and beat 

location of each chunk in the 

song. 

Stacking chunks 
Stack chunks vertically to make 
them play simultaneously. 

Columns Song Chunk Sequence chunks 
Columns get automatically created atthe beginningandend = Songs can be placed To move sequences, drag them up and down or left and right to 
of each chunk. To create a column at any location, use the inside other songs. Go another column. They “snap” to the nearest column. Double-click 
Insert column button (“I”) in the title bar. Chunks “snap” to as many layersdeepas § asequence to open its tracks window. 
the nearest column when you drag them. you want. 
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The Markers 
window 

For more information, see 

chapter 19, “The Markers Window” 
(page 245) in the Reference manual. 

La. 
Playback Position 

indicator 
Click on this strip to immediately 
jump playback (and the position 
indicator) to the marker at that 
location. 

Marker location \ ee indicato 
Marker times can be displayed 
in all three time formats: 

measures and beats, SMPTE 

time code, and real time. 

78 

To open the Markers window, choose Markers from the Windows 

menu, or click the Markers window button in the Consolidated 

Controls. A Marker is a particular location in your sequence. It may 

be at the beginning or end of a section, or it may be a visual “hit 

point” that occurs at an exact location when you are scoring for film 

or television. You can add as many markers as you want to your 

music. They are useful for identifying any location. You can instantly 

cue to the marker location using the Markers window. Markers 

appear in all editing windows. The can be cut, copied, and pasted in 

the Conductor track. 

To open the Markers list window, 
click the Markers list button. 

Marker name 
Click the marker 

name to rename it. 

eeMIDI seek point 
Attaches the marker to its If you are cueing multiple FreeMIDI 
current SMPTE time code programs, up to eight markers can 
location, regardless of serve as FreeMIDI seek points. 
tempo changes. 
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Device Groups 

For more information, see “Creating 
a device group” on page 112 in the 
Reference manual. 

Often when you are sequencing, you’ll want to be able to make a 

track play back using several MIDI devices together (or several 

channels on the same device) to create a layered sound. The Device 

Groups window lets you define groups of devices. You can then 

assign any track to the device group. Notes and other data in the track 

will play on all devices in the group. 

Creating a device group Using Default Patches 
To create a device group, choose Add Device Group from lf you want, you can choose a MIDI patch change event that 
the mini-menu. To name it, double-click the name to pop- gets sent to the MIDI synth automatically to call up the sound 

edit it. Then click the arrow beneath the name to add the you want for each layer. Patch names like the ones shown 
first device to the group. The arrow moves down one line here appear when you set up the appropriate patch lists with 
below the new device so that you can always add another FreeMIDI’s PatchList Manager utility, with Unisyn, or with any 
device. You can add up to 10 devices in a group. 

Using Device groups 
To assign a track to a device group, just 
select it from the device pop-up menu 
next to the track. Device groups are avail- 
able in Performer wherever this playback 
assignment pop-up menu appears. 

FreeMIDI-compatible librarian software. 
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Recor ding Recording into Performer is easy. This section gives you a quick 

overview. The tutorial chapters following this one provide a more in- 

depth introduction. 

For more information, see chapter 9, 
“Recording” (page 127) in the Refer- 
ence manual. 

Open a new file. 
If you haven’t opened Performer yet, 
double-click the Performer icon and a 

new file will open after a moment. If 
Performer is already open, and you 
have a file on the screen, choose 

Close from the File menu and then 

choose New. 

Check to make sure that Performer is receiving MIDI from your 
controller. 
To do so, open the MIDI Monitor from the Windows menu. When you play 
notes on your controller, watch the MIDI activity indicators. One of them 
should light up. If not, see “Testing for MIDI input and output’ on page 62 of 
this guide. If your controller isn’t present in the MIDI Monitor, choose it from 
the MIDI Monitor window mini-menu. 

Record-enable the track you want to record on. Choose a playback device and channel for the Track. 
In a new Performer file, the first track is already Select the device and MIDI channel you want to hear as you record. 
record-enabled. When it is, the record button is red Remember, you can always change the playback assignment later. To 
(black ona monochrome monitor). select a playback device, press the name of the current device (in the 

device column) next to the record track to get a pop-up menu of devices 
in your studio like the one shown below. 
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Memory-cycle vy 

Choose a sound on the Track’s playback device and channel. 
You have several ways to do this. One way is to call up the sound on the synthesizer itself using the front panel controls. If you have already 
set up patch lists using FreeMIDI’s PatchList Manager, you can choose a sound by name from the Patch column pop-up menu as shown 
here. Otherwise, you'll see a generic list with “Patch-1, Patch-2” etc. 

If you want to cycle-record (loop record), turn on Memory- 
cycle and Overdub record, and set the loop points. 
The memory-cycle button causes Performer to loop a region. 
Set the length of the region by dragging the repeat barlines in 
the Tracks overview or by typing in the desired times in the 
Memory bar. Overdub record mode causes each new record 
pass to be merged with previous ones. Without Overdub, 
Performer drops out of record at the end of the first pass. 

Overdub record 

Memory-cycle loop points 

/\ 
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Record 

If you want a few bars of countoff before you begin recording, 
press the Countoff button. 
This button gives you two measures of the metronome click before 
Performer begins recording. Double-click the button to change the 
number of countoff measures and other metronome settings. 

Countoff 

Set the tempo with the tempo slider. When you are ready to 
begin recording, press the record button. 

Don’t worry about making a mistake. You can always delete the 
notes and try again. Or you can choose Undo Record from the Edit 

menu. If you want to see what you are recording, open the track’s 
Event List, Graphic Editing window, and/or QuickScribe Notation 
windows. The notes appear in these windows as you record. 
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Step-Record 

For more information, see 
chapter 10, “Step Record” 
(page 139) in the Reference manual. 

Steps 1 through 5 are the 

Step-Record, available in the Basics menu, is one of the most 

important and powerful features in Performer. It is an alternative to 

real-time recording: it waits for you to enter notes one at a time and 

allows you to specify the duration of each. Step-Record is ideal for 

passages too complex for real-time entry. Notes you enter in Step- 

Record are rhythmically precise (they won’t need quantizing). 

Set the main counter to the 

same as steps 1-5 for regular 
recording described in the 
previous section. 

location at which you 
would like to begin step- 
recording. 
You can type in the location 
directly into the counter. You 
can also double-click the time 
ruler in the Tracks Overview 
or a Graphic Editing window. 

Choose the desired duration of the 
note(s) you would like to enter. 
Click the appropriate note duration 
button and a dot, if necessary. If you 
are inserting triplets or tuplets, use the 
tuplet check box and type in the 
desired tuplet value. 

Open the Step-Record window by choosing it 
from the Basics menu. 
When you do so, Performer automatically goes into 
record mode and is ready to record the first note. 

Play one or more notes on your MIDI controller. 
Notes are inserted into the track with the chosen duration. Notice that the main counter updates with each step. Here are a few tips: 

Notes are inserted when you release the key. 
Play notes as slowly as you like. 
Change duration whenever you want by simply clicking a different duration. 

Play notes and chords in a staccato fashion to prevent accidentally inserting 
notes from the next step. 
To prevent other tracks from playing as you step, use the Solo Playback 

option. 
m As you step, Performer’s main counter follows your progress, and other tracks 

play back at the same time. To disconnect from the main counter, click the 
Lock button in the Step Record window title bar. 

m 10 insert a rest, press the Step button. 
= lo insert silence and advance to the next beat or measure, click the Beat or 

Measure buttons. 
mw Open an Event List, Graphic Editing, or Notation window so you can see what 

you are recording. 
= To stop, close Step Record. 
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Selecting Once you’ve recorded, Performer provides powerful editing features 

to mould your music any way you want. But before you can edit even 

a single note, Performer needs to know exactly what you want to 

For more information, see - edit. This sections shows you some of the many convenient ways to 
chapter 25, “Selecting Regions” 
(page 387) in the Reference manual. 

select music in Performer. Once you've selected it, you can unleash 

Performer’s powerful editing features. 

Using the Edit Bar in the Tracks window 
Set the start and end times, and then select the tracks you want to edit within the those times. To set the start 
and end times, type them in. Or click the start and end button during playback to load the current playback 
location. To quickly select the entire length of the sequence, double-click the edit button. To select a single 
track, click its name. To select several non-adjacent tracks, shift-click each one. To select a group of adjacent 
tracks, drag over their names. To select all tracks, press command-A. 

Using the Tracks Overview 
Zoom the display to a useful zoom level. 
Then drag over the segments you want to 
select. To select non-adjacent segments, ia : 
shift-click each one. To select an entire E pemmmens Berean pee 
column, click in the time ruler above the 
column. To get rid of the current selection, 
Click in the blank space below the grid. 

Selecting the Memory-cycle region 
Double-click either loop point in the Tracks Overview 
or Graphic Editing window ruler. 

Dragging in the graphic editing window time ruler 
Any notes or controller data within the highlighted region becomes 
selected. To make your dragging “snap” to rhythmic grid locations, 
check the Edit Resolution box and set the desired grid resolution. 

Selecting all notes of the same pitch 
Double-click the key on the pitch ruler in the 
Graphic Editing window. 

Selecting in 
the note grid Using the event list 
Drag a rectangle | Click an event to select it. 
over the beginning = oe oo oe To select several non- 

of the notes you 1 —r———””————C—=E adjacent events, shift- 
want to select. click each one. To select 

a group of adjacent 
events, drag over them. 
To extend the current 
selection, command- 

Click. To select all events, 

press command-A. 

Also read about the Remember Times 

command in the section “Shortcuts for 

using the Edit Bar’ on page 388 in the 
Reference manual. 
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Editing Once you’ve selected your music, you can choose any command in 

the Edit menu or Region menu. For many of them, a dialog box 

appears on the screen with many powerful options—much more 

fy aos pale og eaiag 26, than can be covered here. A few samples are shown below. Most Edit 

chapter 27, “Region Commands 1” and Region menu commands can be applied during playback, so you 

(page 409), and chapter 28, “Region don’t have to stop the music to hear the effect. Some, like Groove 
poe soo: ee ne neter Quantize, allow you to apply the effect in real time, so you have 

instant feedback, without even closing the command’s window. 

Edit 

Undo Erase #2 Transpose...  Guantiz 
Quantize... 

Groove Quantize... 

Create Groove... 

Smart Quantize... 

Humanize... 

DeFlam... 

Change Velocity... 

Change Duration... 

Split Notes... 

Thin Continuous Data... 

Create Continuous Data... 

Change Continuous Data... 

Reassign Continuous Data... 

Set Edit Filter... 3F 

Show Clipboard iii 

Select All 3 
Invert Pitch... 

Reverse Time 

Retrograde 

Scale Time... 

Scale Tempos... 

Harmonic Minor 

Dorian 

Natural Minor 

Harmonic Minor 
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Mixing with After recording and editing comes mixing. Many MIDI devices 

consoles nowadays respond to automatic mixing effects such as volume and 

panning that you program directly in Performer. Performer can 

instantly generate a mixing console for your sequence, with a volume 

<Cupiom Comrol Consoles’ tpane 605) fader and pan knob for each track. You can even build your own 

in the Reference manual. customized consoles, adding your own faders, knobs, pop-up menus, 

value boxes and more. 

For more information, see chapter 31, 

To create a mixing console, 
select the tracks you would like 
to include in the mix. 

Choose Create Console from the 

Tracks window mini-menu. 

Choose the orientation you'd like, and click 
the volume and pan options. 
These are the only buttons you need to click to 

Use the techniques you just get the console. You can add other controls, if 
learned in the section “Selecting” you'd like. Click OK when you are done. 
on page 83. 

{Create Console 

Edit mode 

Use edit mode to refine 
the appearance of the 
console as desired. 
In edit mode, you can drag 

controls wherever you want 
and insert additional ones 

with the insert menu. 

Record an automated 
mix-down with the 
faders and knobs. 
Volume and pan data gets 
recorded into the appro- 

EPad| [Perc.| (Sax |= (Solo) (Effects) : priate track automatically. 
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Using on-line Hopefully, this chapter has piqued your curiosity and you now want 

he Ip to explore Performer even more. Performer’s on-line help feature can 

help greatly: it provides a brief explanation for every window, menu, 

dialog box, button—and just about anything else you can click on. To 

For more information, see chapter 2 get help, choose Show Balloons from the Help menu and then click 

“On-Line Help” (page 27) in the Refer- anything with the balloon cursor to get help on it. There’s even a way 

ence manual. to get help on how to get help! Just choose About Help from the Help 

menu. 

About Help... To get help on a feature, click it with the Help To get help on 4 menu item, select the item 

Cursor. Normally, the cursor looks like an arrow: from the menu with the Help Cursor: 

h 
To get the Help Cursor, hold down the command, 

option, and shift keys together: 

Transmit Sync... 

| shift | - @ 

Show Balloons 

: : ‘fou can get help on anything in Performer : 

: menus, menu items, greyed menu items, title 

(cotin)( wae) bars--even options in dialog boxes. For an 

The Help Cursor indicates that Performer is in Help overview of one of Performer'’s windows, 

mode. ‘fou can then click something to make a hlep get help on the ‘window's name in the windows 

screen appear. Click again to make the help screen menu. Also click the window's title bar for 

disappear. As soon as you release the keys, you information about its mini-menu and more. 

are no longer in Help mode. If you want to stay in Important words and names of features in the 

Help mode, choose Show Ballons from the Help help text are in boldface so you can more 

menu at the top of Performer’s screen. easily refer to them. 
he 

‘You can then lf Performer asks you AAs 

to locate the Help file, (HELP) 
leave Help mode About Help... anda centt ile Keclermer™sisis 
by choosing Hide 

put the Performer Help 

File icon into the same 

folder as Performer. 

Balloons. 
Show Balloons, 

 pommcinicetennttet 

-| 120.00 

The Rewind Button 

Clicking on the Rewind button sets the current location to the start of the 

sequence. If the Memory Bar is showing, clicking on the Rewind button 

will rewind to the Memory Start location. If the Rewind button is clicked 

during playback, playback is held for a moment while the sequence 

rewinds. Playback then resumes from the rewind location. If the 

Rewind button is clicked during recording, the record button is turned 

off. The sequence rewinds normally and resumes in playback mode. 

Although Performer rewinds much faster than a tape deck, long 

sequences may take one or two seconds to rewind. Using the 

Auto—Rewind function is a fast way of locating a frequent rewind 

location. See The Auto-Rewind button below. 
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Chapters Getting Started: 
Recording Your First Track 

This chapter is a brief introduction (approximately 20 minutes). These 

step-by-step instructions will lead you through starting Performer, 

recording and playing back a single track, and viewing and editing 

Peteriier™ MIDI data. Working through this chapter is a good way of confirming 

that you have correctly set up your MIDI system. 

To begin, start Performer by double-clicking the Performer program 

icon. If this is the very first time you are opening the program, please 

refer briefly to chapter 6, “Starting Performer for the First Time”. 

Recor ding a After a few moments, the screen should look like what you see 

below. If not, choose New from the File menu: scale 
Metronome Main transport controls Counter 

| 
Tracks list Tracks overview 
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The top portion of the screen shows the Consolidated Controls 

window. Across the top you see the Tempo controls, Main Transport 

Controls, and the Counter. Just below are buttons that open windows 

for Performer’s main features. Underneath is the Tracks window for 

sequence 1 (Seq-1). These windows contain the basic controls and 

information you will need to record and play a sequence. 

Record enabling a track At this point, eight tracks are shown in the Tracks window. The first 
track is named “Track-1”. (in later chapters you will learn how to 

rename tracks and add descriptive comments to the Tracks window). 

To record-enable a track, click its record button to make it black. 

Track-1 should already be record-enabled, as shown below. If not, 

click its record button. 

Track 1 is record-enabled: 

Setting the playback At this point, Track-1 is set to play back on channel 1 of one of your 

Device MIDI devices. If you would like to change the channel, or even the 

device altogether, you can select the desired one easily by choosing 

it from the play destination pop-up menu. If you don’t need to 

change the channel or device, you can skip this step. 

@ The list of MIDI devices that appears in the play 

destination pop-up menu is provided by FreeMIDI. If 

the device you wish to use is not present in the list, see 

“Using Quick Setup to Add FreeMIDI Devices” on 
page 685 in the Performer Reference Manual. 

1. In the Tracks window, press on the Device assignment next to the 

Track-1 name. 

A pop-up list of devices appears. 
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Setting up a piano 
sound 

2. Select the desired MIDI device and channel from the hierarchical 

pop-up menu. 

In the example below, the original device was the Yamaha TG100 

and the new device being selected is the Kurzweil K2000R, MIDI 

channel 8. This pop-up menu is a standard Macintosh hierarchical 

menu. 

Now let’s set up a piano sound for the track. This is done by calling 

up a piano sound on the same MIDI device and channel that you 

chose in the previous step. In the example above, we chose the 

Kurzweil K2000R channel 8. So we would need to set up a piano 

sound on channel 8 on the K2000R. 

For many popular MIDI devices, you can do this directly from within 

Performer: just choose the sound by name from the Patch column 

next to the track as shown in the next picture. 

If you see a generic list of names (“Patch 1, Patch 2, Patch 3”, etc.), 

Try Patch 1. Many synths have a piano sound there. Play a few notes 

on your controller keyboard. Do you hear a piano? If not, try a few 

different choices from the pop-up menu until you find one that kind 

of sounds like a piano. It doesn’t have to be exactly like a piano for 

the purposes of this tutorial. By the way, you can replace the generic 

patch names with actual ones; see chapter 48, “Using PatchList 

Manager” (page 725) in the Reference Manual for details. 
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Setting a metronome Performer organizes MIDI data into measures, beats, and ticks (there 

click and tempo are 480 ticks per quarter note). To ensure that your music lines up 

with the beat correctly, always listen to Performer’s built-in 

metronome while recording: 

1. Make sure the Metronome click button is turned on. 

On a color screen the inset portion of the button turns yellow 

when the click is on. Try clicking the button a few times to toggle 

it back and forth so you can see the difference between off and 

on. 

Metronome click button 

2. Drag the Tempo Slider to 60 bpm. 

Performer can handle a wide range of tempos and tempo changes. 

For now, simply set a steady tempo of 60 beats per minute. You 

can click on the + and - buttons to make fine adjustments. 

Alternately, you could click the tempo marking in the box, type in 

“60”, and press return to confirm your typing. 
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Setting a countoff 

Turning off Memory- 
cycle and Overdub 

Recording a scale 

The final step to prepare for recording is to set a couple of countoff 

bars. A countoff helps you play in tempo, and gives you time to get 

to your MIDI keyboard after pressing Record in Performer. 

m Click on the Countoff button below the Transport controls. 

The Countoff button 

A Countoff of two bars is provided, with a metronome click every 

quarter note. Uf you want to change the number of countoff bars, 

double-click the button to open a dialog box that lets you do so.) 

The Memory-cycle button causes Performer to loop a region of the 

music indefinitely. This extremely useful feature is explored later. For 

now, let’s make sure that it is off, as shown below. The same goes for 

Overdub record. 

Memory-cycle 

You are now ready to record. Read over the next couple of steps 

beforehand, and make sure your controller keyboard is turned on 

and set up to send MIDI. When you're ready: 
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The Record button 

1. Click the Record button in the Consolidated Controls window. 

The two bars of countoff will begin as soon as the Record button 

is pressed. Count the eight beats of introduction while you move 

to your controller keyboard and prepare to play. 

2. Play an ascending C major scale, starting on Middle C and ending 

on the C an octave above. 

Use quarter notes, one per metronome click. 

3. When you’re finished, click on the Stop button. 

Performer will stop recording. Note that the counter has advanced, 

and that the position bar arrow has moved to the far right, indicating 

that you are currently at the end of your sequence. 

If you make a mistake, don’t panic. Press the Rewind button to return 

to the start of the sequence, then repeat the previous three steps. 

Playing back your To hear what you just recorded: 

sequence 

1. Click on the Rewind button in the Controls window. 

This returns Performer to the start of the sequence. Note that the 

Counter and position bar are reset to their starting values. 

2. Click on the Play button. 

You should hear the scale play back on the assigned keyboard(s) 

or sound modules. If you don’t hear anything, turn to “Problems” 

on page 99. 
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Opening an You have just recorded a MIDI sequence, that is, a string of MIDI 

"g" commands that exactly describe your performance. The Tracks 

ven t Edi tl ng Overview shows the data that you have just recorded into Track-1: 

window 

The first few measures of Track-1 now contain the scale you 
just played. Double-click any segment to open the Event List 
window of the track, which shows each note that you played. 

Performer allows you to view and edit these MIDI ‘events’ directly by 

opening an Event Editing window for a recorded track. Each track 

can be viewed in one of four Event Editing windows: the Event List 

window, the Graphic Editing window, the Notation editing window, 

or the QuickScribe notation window. In this example we’ll use the 

Event List window. For detailed information on the other windows, 

refer to their respective chapters, starting with chapter 20, “The Event 

List Window” (page 257) in the Performer Reference Manual. 

To see the data you have just recorded: 

» Double-click on one of the filled-in track segments for 

Track-1 in the Tracks Overview. Alternately, you can 

double-click the track name Track-1 in the Tracks List. 
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A new window will appear, looking more or less like this: 

Setting the View Filter MIDI-equipped keyboards transmit a wide variety of MIDI data. Your 

event list should contain the notes you just played, indicated by a 

small note symbol: 

You may see additional events, such as aftertouch events: 

Later in this manual, you'll learn how to set the Input Filter to filter 

out aftertouch data during recording if you don’t want to record it. 

If your event list contains anything other than note events, follow 

these steps to temporarily hide the other data: 

1. Select Set View Filter from the Event List window mini-menu. 

Place the pointer on the mini-menu icon at the top of the Event 

List window and press the mouse. Still pressing, slide the mouse 

pointer down until the option ‘View Filter’ is highlighted, then 

release the mouse. 
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2. Option-click on the Notes check box. 

This is a shortcut for deselecting everything but Note events for 

viewing: hold down the option key and click on the small box 

next to the Notes symbol. 

Set View Filter 
Cee 
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3. Click OK to confirm your choice. 

Now you should only see Note events in your event list: 

Editing an event The information for a Note event is displayed as follows: 

Attack time On and off velocities 

Pitch Duration 

The Attack Time is the time, displayed here in measures | beats | ticks, 

at which the note is played. This note begins in the first measure, 

third beat, and 453rd tick (there are 480 ticks in a beat). 

The Pitch of the note is indicated by its letter name and octave 

number. This note is an F3, that is, the F just above middle C. 

The Duration is displayed in quarter notes and ticks. Like attack 

times, there are 480 ticks per quarter note; a value of 11027 ticks is 

just a little longer than a quarter note. 
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You may directly change any of these values. For example, to move 

your first note to the exact start of the sequence: 

1. Double-click on the attack time of the first note event. 

The event is highlighted and the attack time field ‘pops up’. 

2. Click on the ‘ticks’ field and type in 000. 

3. Press the Return key to confirm your change. 

The note event is redisplayed with its new attack time. 

Editing a group of While directly editing events in an Event List window allows precise, 

events flexible control over your sequence, editing notes one at a time can 

be time consuming when editing dozens of notes. The commands in 

the Edit and Region menus let you edit whole sections, tracks, or 

sequences at once, while maintaining precise control over the final 

results. For example, we can use the Quantize command from the 

Regions menu to align the notes of our scale exactly on the beat: 

1. Click in the Tracks window to activate it. 

The Tracks window comes to the front. 

2. Click Track-1 once to highlight it. 

This selects Track-1 for editing. Alternately, you could also drag 

over the filled-in track segments in the Tracks Overview; they will 

highlight. 

3. Double-click on the Edit button above the track names. 

This is a shortcut to set the Start and End times in the Edit bar at 

the top of the Tracks window to the beginning and end of your 

sequence, respectively. You can alternatively set these times 

manually, by clicking on the Start and End time fields and typing 

in the desired values. 

4. Choose Quantize from the Region menu. 
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The Quantize dialog box appears. There is a full description of this 

box and how it works in chapter 27, “Region Commands 1” 

(page 409). For now, simply select a quarter note as the rhythmic 

value: 

1. Click on the quarter note icon. 

2. Click on the OK button to confirm your choice. 

Performer will process the command and remove the dialog box. 

At this point, if you examine the Event List window you will note 

that the Attack Times are all precisely on the beat, i.e. the tick 

fields all show ‘000’: 
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Saving your 
sequence 

Problems 

Use the Rewind and Play buttons on the Controls window to play 

back your sequence again. The notes of the scale will play precisely 

on the beats. 

The sequence you have recorded and edited is currently stored in the 

Random Access Memory (or RAM) of your computer. You should 

make a permanent copy of any work you do with the Save and Save 

As commands on the File menu: 

1. Select Save As from the File menu. 

A standard Macintosh file dialog box appears. 

2. Type a name for your file. 

Always try to use descriptive names, so you can identify your files 

later. “Simple Scale” might be a good name for this file. 

3. If necessary, use the Desktop and Eject buttons to select the 

correct disk on which to save. 

If you are not sure how to do this, please review your Macintosh 

manual. 

4. Click the Save button to save the file. 

If you follow the steps described in this chapter you should be able 

to record, view, and edit a simple sequence. If, for some reason, you 

have a problem, don’t panic. Try to pinpoint the problem with these 

steps: 

If Performer won't run, or doesn’t recognize the key disk, or displays 

a Macintosh System Error message: 

Getting Started: Recording Your First Track 99 



@ Turn to the Appendix C, “Troubleshooting FreeMIDI” 

in this booklet for more suggestions and instructions 

on how to contact Mark of the Unicorn’s Customer 

Support program. 

If Performer runs, but doesn’t record (i.e. nothing appears in the 

Event List window): 

1. Select Quit from File menu. 

2. Shut down your Macintosh. 

3. Make sure that your MIDI equipment is on and correctly set up, and 

that the MIDI cables are working and firmly plugged in to the 

equipment. 

To test your MIDI cables, try a simple hook up between two MIDI 

modules, or exchange input and output cables. 

4. Start the Macintosh again, insert your Performer disk(s) if 

necessary, open a new file, and open the MIDI Monitor window. 

The MIDI Monitor window shows incoming MIDI data from your 

MIDI devices. 

MIDI Devices 

aes 

This indicator shows that MIDI data is being received 
from the Korg 01/W Pro on MIDI channel 5. If none of 
these indicators blink when you play your MIDI control- 
ler, then something is wrong with the cables, MIDI 

interface, FreeMIDI settings, or other connections. 
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5. Play notes on your MIDI controller and watch the MIDI Monitor. 

If no indicators blink, then Performer is not receiving any MIDI 

data, which probably means that something is wrong with the 

MIDI cables, MIDI interface, or other connection. If an indicator 

does blink, then you are receiving data successfully. 

6. Go through this chapter again. 

Follow each step carefully; it’s easy to miss something the first 

time through a program of this scope. 

If you can record a track and view the notes in the event list, but can’t 

get your sequence to play back: 

@ Check the volume and MIDI setting for your MIDI 

keyboard and/or sound module. Make sure the 

playback destination in the Tracks window in 

Performer corresponds with the channel setting on 

your MIDI device, otherwise the MIDI information will 

not reach your synth. 

Further troubleshooting If these steps don’t help, you almost certainly have a problem with 

your MIDI interface, cables, or keyboard. Check with the dealer or 

manufacturer for help on testing the hardware. Appendix C, 

“Troubleshooting FreeMIDI” in the Performer Reference manual 

contains more suggestions and instructions on how to contact Mark 

of the Unicorn’s Customer Support program. 
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Chapter9 Tutorial: Building a Sequence 

What's in this tutorial In this tutorial, you will: 

Cycle-record a drum loop and use the Graphic Editing 

window during recording 

a Apply a groove to the drum loop 

Step-record a keyboard part 

Insert a bass line in the notation window by hand 

Mix the sequence with a fader console 

Build a song out of several sequences 

The tutorial will probably take about an hour and a half. You can stop 

at any time by choosing Quit from the File menu. 

Tutorial checklist To make the tutorial as clear as possible, we assumed the following: 

You've successfully completed the entire installation 

section of this guide, including the setup of your FreeMIDI 

studio configuration. 

You have a MIDI keyboard (or other MIDI controller) and 

a multi-timbral MIDI setup. If you’d like a further 
explanation of this, see “Categorizing your MIDI setup: 

how many notes can you play at once?” on page 104. 

You know how to call up sounds in your MIDI gear, 

including a drum kit. 

If you are using your controller keyboard as a sound 

source, you have turned off Local Control. If you’d like a 

further explanation of this, see “Disabling Local Control in 

your MIDI controller keyboard” on page 104. 

It helps if you have gone through the previous two 

chapters, but they are not required. 
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Perhaps the most fundamental concept of MIDI sequencing is 

that the sequencer itself produces no sound whatsoever. 

Instead, the sequencer triggers synthesizers, which produce the 

actual sound. A sequencer just records and plays back perfor- 
mance information: when notes were played, what notes were 

play, how hard they were struck, how long they were held 
down, and so on. This is one of the reasons why sequencing is 

so powerful. It gives you incredible flexibility in working with 

the instruments and sounds in your music. 

So the maximum number notes you can play at one time when 

sequencing in Performer depends on your MIDI hardware. 

Only the most basic MIDI synthesizers are limited to one note 

at a time, and fortunately, this type of instrument is a thing of 

the past for the most part. An instrument that can only play one 

note at a time is referred to as being monophonic. 

Today, most keyboards, sound modules and other types of 

synthesizers (often referred to as a sound sources) can play 
several notes at once. For example, you can play a chord on 

them consisting of 3 or more notes at one time. A device that 

can do this is referred to as polyphonic. Keyboards and sound 

modules produced in the late 1980’s could typical play up to 

eight notes at a time (eight note polyphony). Today, affordable 
synths are 32-note and even 64-note polyphonic. 

Most of today’s synths are also multi-timbral, which means that 

they can play different types of sounds at the same time. For 

example, you may have a sound module that can play drums, 
bass, piano, guitar, sax, synth pad, and a solo instrument all at 

once. Many devices can play up to 16 different sounds at once 

(one per MIDI channel). 

To take full advantage of Performer’s power, a multi-timbral 
MIDI setup is highly recommended. Even a single general MIDI 

sound module such as the Yamaha TG100, Korg 05R/W, or 

Roland Sound Canvas gives you an entire orchestra at your 

fingertips in Performer. 

Local Control is a setting found on just about every MIDI 

keyboard. It’s easier to understand what local control does if 

you first understand the basic architecture of a keyboard 

synthesizer. 

Most keyboard synthesizers actually consist of two separate 

components as shown below. The keyboard controller sends 

performance information to both the built-in synthesizer and 
the MIDI OUT port. 

MIDI OUT 

| Sound Engine | 

It’s easy to think of them as being one and the same, but 

actually, the sound engine inside the synth is separate from the 

keyboard. In fact, many synth manufacturers ship a rack- 

mountable version of their popular keyboards that is simply 
the sound engine by itself, without the keyboard. Often the 

unit fits a single rack space—sometimes even a half-rack space. 

Local Control is the setting that connects the keyboard to the 

sound engine. When Local Control is on, the keys on the 
keyboard trigger notes in the sound engine. When Local 

Control is turned off, this connection is temporarily severed, 

and the keys no longer trigger sounds within the synthesizer. 

When you are using your keyboard as a sound source as well 

as a controller with Performer, turn Local Control off. (Consult 

the manual; it may be called “Local On” or “Local Off.) Don’t 
worry, though. You’ll still be able to trigger sounds via 

Performer’s Patch Thru feature in the Basics menu, which 

echoes controller keyboard input to any sound source in your 
MIDI studio. 

MIDI IN 

MIDI IN 4 MIDI OUT 

Sound Engine 

Keyboard 
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Open a new file Lets begin with a new, empty Performer file. 

1. If Performer is not currently running, double-click its icon to Jaunch 
the program. 

2. If Performer is currently running, choose New from the File menu. 

If a file is currently open, you’ll have to close it first by choosing 

Close from the File menu. 

Set up memory-cycle 
recording 

Tutorial: Building a Sequence 

Memory-cycle lets you build a section of music by loop recording. We 

are going to build a two-bar drum loop. 

1. If it isn’t already highlighted, click the Memory-cycle button to 

highlight it. 

Memory-cycle 
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2. Click the Overdub Record button to highlight it. 

Overdub record mode causes newly recorded material to merge 

with data that is already in the track instead of erasing and 

replacing it. 

Overdub 

3. Drag the Memory-cycle stop point to bar 3 in the Tracks Overview. 

The “tab” snaps to barlines as you drag, so you don’t have to be 

exact. Performer will now loop the first two bars indefinitely. 

Memory-cycle stop point 

Set up a Metronome When you first record in real time into Performer, you need a 

click metronome click so that you can play along with the measures and 

beats in Performer. Actually, it is possible to record without a click 

and afterwards line up the beats and barlines with your performance. 

For more information, see chapter 36, “The Record Beats Command” 

(page 591) in the Reference Manual. But for building our drum loop 

now, let’s play to a click. 

1. Make sure the Metronome click button is turned on. 

On a color screen the inset portion of the button turns yellow 

when the click is on. Try clicking the button a few times to toggle 

it back and forth so you can see the difference between off and 

on. 
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Metronome click button 

2. Set the tempo slider to a comfortable recording tempo. 

A great thing about MIDI sequencing is that you can record at a 

slow tempo and then move up to full speed afterwards. Let’s set 

the tempo slider to about 80 bpm (beats per minute). 

Tempo slider Tempo indicator 

3. To test the metronome click, press the play button and listen for 

the click sound produced by the Macintosh’s internal speaker. 

Performer begins to play, looping the first two measures. The 

main counter gives you a running update, and the playback 

location indicator scrolls in the Tracks Overview. Play for as long 

as youd like. 

Play button 
(Turns blue ona Counter gives a 

color screen) running update 

Playback location indicator 
(Green on a color screen) 
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4. Press the Stop button to stop playback and press Rewind to return 

to the beginning of the sequence. 

When you are done with this step, the Counter should read 

measure 1, beat 1 as shown below. 

Rewind Stop After rewind, the Counter 
button button returns to measure 1. 

5. If you did not hear the internal speaker click during playback, or if 
you feel that it won’t be loud enough during recording, see the 

side-bar “Setting up a MIDI click”. 

Performer cannot produce an internal speaker click on some 

Macintosh system configurations. 

In addition to Performer’s internal speaker click, you can use a 7. Make the Normal click settings in the same fashion. 
drum machine, sampler, or other sound source to generate a 

: The Normal click falls on beat boundaries within each measure. 
click sound of your choice. 

8. Click OK. 
To set up a MIDI click: 

mr Click & Countoff Options | 
1. In the Tracks window, record-enable any track that is currently : ef 

assigned to the drum machine, sampler, or other device that you’d 
like to use for the click sound. 

If you need help with this step, see “Record enabling a track” on page 88 
and “Setting the playback Device” on page 88. 

2. From the Basics menu choose Click and Countoff Options. 

3. Check the MIDI check box at the top of the window. 

4. On the right, choose the device you would like to use for the 
accented click from the pop-up menu provided. 

The accented click falls on the downbeats of measures. 

5. Double-click in the Pitch box to select it and either type the desired 
note or simply play the desired note on your controller keyboard. 

6. Set the note-on velocity (0-127) and gate (duration in milliseconds) 
as desired. 
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Set up a one bar Performer can give you a countoff before you begin recording, just 
countoff like a conductor would, to get you into the tempo before the first 

downbeat. In fact, as you probably know, it’s almost impossible to 

play in time with the first downbeat without a countoff. 

Performer defaults to giving you a two-bar countoff. But we are 

recording at a fairly slow tempo, and we don’t want to have to wait 

through a full two bars, so let’s change the countoff to one bar. 

1. Click the Countoff button once to turn it on. 

ountoff button 

2. Double-click the Countoff button to open the Click and Countoff 

Options dialog box. 

For a full picture of this dialog box, see the picture that 

accompanies “Setting up a MIDI click” on page 108. 

3. In the Countoff Options section, change the 2 in the text box to a 1. 

4. Check the “Countoff only when recording” option. 

This option causes Performer to skip the countoff when you click 

the Play button. 

5. Click OK to confirm the new settings. 
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Set up a track for Let’s set up Track-1 for recording the drum loop. 

recording 
1. Make sure that Track-1 is record-enabled. 

In a new Performer file, Track-1 is record-enabled by default. If for 

some reason it is not, click its record button so that it is red (or 

black on a black and white screen). 

Record- 

enable 

button 

2. Choose a sound source that can produce a drum kit from the pop- 

up menu in the Device column next to Track-1. 

Press on the current device assignment to open the pop-up menu. 

Choose your drum machine, sampler, or other device. On many 

multi-timbral synthesizers and sound modules, the drum kits can 

be found on MIDI channel 10. 

Press here to open a pop-up menu of 
devices similar to the ones shown on the 
right. Of course, your list of devices will be 
different than what is shown. The list of 
devices is provided by FreeMIDI. 
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3. Make sure there is a drum kit currently playing on the device and 

channel that you chose. 

First, check in the Patch column next to the track. If you see 

sounds listed by name similar to Figure 9-1 below, choose a drum 

kit. If you see a generic list of names (“Patch 1, Patch 2, Patch 3”, 

etc.), don’t choose anything for now. Instead, set up a drum kit 

manually using the front panel controls on the MIDI device itself. 

Make sure you set up the drum kit on the same MIDI channel as 

the one you’ve assigned to Track-1 in Performer. By the way, you 

can replace the generic patch names with actual ones; see 

chapter 48, “Using PatchList Manager” (page 725) in the Reference 

Manual for details. 

Figure 9-1: Choosing a drum kit for the drum track. 

Tutorial: Building a Sequence 17117 



4. Rename Track-1 by option-clicking the name to pop-edit it. 

Type in the name “Drums” and then press the return key to 

confirm your typing. 

Option-click a track name to pop-edit the name. Press return to confirm the new name. 

@ Shortcut: when you are naming several tracks in a row, 

use the down arrow key to finish with the current track 

and pop-edit the next one in the list. 

5. Test the track setup by playing a few notes on your MIDI controller; 

you should hear drum sounds as you play. 

When you play notes on your controller, Performer receives them 

and then echoes them to the playback device for the currently record- 

enabled track—even when Performer is stopped. At this point, your 

controller should be playing the drum kit source you selected. If not, 

check the volume of the MIDI device. If it has a MIDI activity 

indicator, check to see if the indicator blinks when you play notes on 

your controller. If you have a multi-port MIDI interface such as a 

MIDI Time Piece II or MIDI Express, see if the MIDI OUT light 

corresponding to the MIDI Device blinks when you play your 

controller. These things will give you an indication of whether the 

MIDI note information is reaching the device or not. If not, see 

“Testing for MIDI input and output” on page 62. 

112 Tutorial: Building a Sequence 



Open the Graphic Let’s open the Graphic Editing window before we begin recording so 

Editing window to see we can see the notes we record. 

what you record 
1. Click the track name “Drums” to highlight it. 

Doing selects the track. 

2. Click the Graphic Editing window button in the Consolidated 
Controls panel. 

Graphic Editing button 

3. After the Graphic Editing window appears, use the controls shown 

in the following diagram to optimize the position of the window on 

your screen. 

Be sure to keep the main control panel visible, as you'll need to 

use it during recording. 
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Click the Time ruler “zoom in” If you'd like to quickly open the To move the Graphic Editing 
button once (maybe twice) to fill window to the full width of your window, drag its title bar. 
the window with the looped screen, click the resize button. 
region (the first two bars). 

Click the Pitch 

ruler “zoom in” 

button twice to 

zoom in on 

about a one- 

octave range. 

Use the pitch 
ruler scroll bar to 

scroll the ruler 

and note grid to 
the note range 
that contains the 

drum pitches for 
kick, snare, and 

hi hat. These 

sounds are 

usually in the 
octave from C1 to 

C2 as shown 

here. 

Drag the median strip handle all Drag the resize box to resize the 
the way down to temporarily entire window. 
hide the continuous data grid 
(which will be covered later). 
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Quantize on input 

Tutorial: Building a Sequence 

Performer records what you play very accurately, including every 

timing nuance. Performer’s Input Quantize feature can be a great 

help when recording drums, regardless of your level of drum or 

keyboard chops. Input Quantize places notes on an evenly spaced 

timing grid so that they are recorded in a rhythmically precise 

fashion. This helps get notes on the proper beat right as they are 

recorded so you don’t have to spend time afterwards making slight 

corrections. 

Don’t worry about sounding stiff or robotic; we are going to apply a 

groove to the drum loop a little later in the tutorial to give it some 

feel. 

1. Choose Input Quantize from the Windows menu to open the Input 

Quantize window. 

2. Click the check box at the top of the window labeled Enable Input 

Quantize. Leave the rest of the options alone for now. 

3. Close the Input Quantize window. 

This window could be left open, but for now, click its close button 

at the far left of the title bar, or press command-w. 
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And now the fun really You are ready to record! You’ll now build the drum loop, one pass at 

begins a time. Try adding one drum part at a time as described in the next 

few sections, and feel free to let the loop play as many times as you 

want before recording the next part. If you make a mistake, you can 

either fix it in the Graphic Editing window or erase the pass entirely. 

If you haven’t done this sort of thing before with a drum machine or 

other pattern-based sequencer, you may find it useful to record 

related sounds together, such as kick and snare, and closed hi-hat 

with open hi-hat. 

@ Once you begin recording below, try to complete the 

drum loop without ever stopping the music. We’ve set 

up the tutorial so that you can fix mistakes, and do 

everything you need to do without ever having to hit 

the stop button. It’s fun, and more importantly, you'll 

learn to become more interactive with the music. 

Record kick and snare Let’s start with the kick and snare: 

first 
1. Before you start recording, find the kick and snare keys on your 

controller keyboard. 

For the purposes of this tutorial, it doesn’t really matter what you 

play. If nothing else, play the kick “four on the floor” and the 

snare on beats two and four. 

2. When you are ready, click the Record button, listen to the countoff, 

and play a two bar kick-snare pattern. 

3. If you make a mistake, don’t worry. Let the loop keep playing for 

now and proceed to the next section. 
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Record button Scrolling wiper shows 
playback position. 

Kick and snare notes 
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Fix mistakes and get 
ready to add the hi-hat 
part 

118 

Here are several things you might want to do next: 

What you want to do: 

Erase all the notes and start over 

Erase all notes of one particular 

sound (such as all hi-hats) 

Erase a wrong note 

Move a note earlier or later 

Hear the drum loop at full tempo 

Practice the hi-hat part without 

recording it yet 

Record the hi-hat part 

Stop loop recording altogether 

(because the phone rang or 

something) 

How to do it: 

Choose Undo from the Edit menu. 

Double-click the corresponding key 

on the pitch ruler, which selects all 

the notes of that pitch, and press the 

delete key. 

Click the Edit Resolution note in the 

upper right corner of the window, 

change it to a sixteenth note, and 

then drag any note in the note grid. 

Unit = 8 01120 beats 

3111000 
i 

Drag the tempo slider up to the 

desired tempo. 

Click the Record button to take Per- 

former out of record and keep play- 
ing. 

Click the Record button again to put 

Performer back into record mode 

and wait for the next iteration of the 

loop. 

Again, try to resist pressing the Stop 

button. But if you absolutely have 

2 ae 
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Add the hi-hat To add the hi-hat, slow the tempo way down and play a boring, 

sixteenth-note pattern (four notes to each beat). (We'll spice it up 

later with a groove.) 

1. 

2. 

Drag the tempo slider down to about 60 bpm. 

Click the Record button to take Performer out of Record mode 

temporarily while you find a closed hi-hat key on your MIDI 
keyboard. 

You may also want to practice playing the part once or twice 

before going back into record, just to get the hang of it. 

Once you’ve found the key, put Performer back into record by 
clicking the record button. 

Wait for the loop to cycle back to the beginning. 

Play the closed hi-hat part, in a sixteenth pattern, four notes to 
each beat. 

Notice that Input Quantize makes them rhythmically precise. If 
you make a mistake, don’t panic. Refer to the chart of the previo 
page to fix it or erase it and try again. 

You should now have something like this: 
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Add a few open hi-hats Adding open hi-hats to the closed hi-hat part is easy. Just change a 
few closed hi-hat notes into open hi-hat notes by dragging them up 
or down. 

1. Drag one of the closed hat notes up or down to the open hi-hat 
pitch. 

2. If you aren’t sure what pitch is the open hi-hat, click the Audible 

mode button in the title bar and then click keys on the pitch ruler. 

In audible mode, notes and keys on the pitch ruler play when you 

click them. Keep clicking the pitch ruler keys until you find the 

open hi-hat sound. Then drag the closed hi-hat note straight up or 

down to that pitch. 

—— —— 
mode button teh an : 

Click the pitch ruler 
to hear each pitch in 
Audible mode. 

3. Do the same for a few other notes of your choice. 

Try using ones that are just before a measure downbeat. 

Drag closed hi-hat notes up (or 
down) to the appropriate pitch to turn 
them into open hi-hat notes. 
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Add more percussion 
with what you already 
know 

Pitch ruler 

scroll bar 

Save what you have 
done so far 

Tutorial: Building a Sequence 

Congratulations! You’ve just created your first drum loop in 
Performer. With what you already know, feel free to add more 
percussion parts to the loop if you’d like. Just keep in mind that if the 
drum sound you want to record is not in the octave currently 

showing in the note grid, you'll need to scroll the grid with the pitch 

ruler scroll bar to see the notes. 

E 

As you sequence, Performer stores your work in the computer’s 

memory. But memory is volatile; it is completely erased when the 

computer is shut down or restarted. If this happens unexpectedly (the 

computer crashes, or the power goes out), you loose everything— 

unless you save it to disk. Therefore, get in the habit of saving every 

time you reach a point where you like what you’ve got so far. Try to 

save every few minutes during a session so you never risk losing 

more than a few minutes worth of work. If magic happens in a 

session and you record that perfect take, save it immediately. Once 

saved to disk, you run much less of a chance of losing your work, 

although even on disk it can be lost. So back up your hard disk, too. 

To save your file: 

1. Press the Stop button. 

Saving is one of the few things that Performer can’t do while 

playing. 
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Select the loop and 
apply a groove 
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2. Choose Save from the File menu. 

The standard Macintosh Save dialog box appears. 

=) Performer™ ¥ 

C Alpha Test files 4} <— Centris 650... 

OO OrumtTran™ 

CO Performer Files 
i £> ; ii Perfoprier Fie aed Desktop 

(7 Performer Groove Vers... 

OO Performer™ 4.2 

Save the current state as [| Save | 

My Tutorial File 

‘e; Normal (>) Standard MIDI File 

(3 Performer 2.41 () Professional Composer 

fii 

3. Type in a name for the file. 

4. If desired, choose a folder in which to save the file. 

5. Click Save. 

Now that we’ve successfully recorded the notes, let’s apply a groove 

to the drum loop to give it some feel with the Groove Quantize 

command in the Region menu. You'll use the commands in the 

Region and Edit menus all the time. 

1. Press the Play button to start playback again. 

2. Set the tempo slider to a tempo around 104 bpm. 

This tempo suits the grooves we will apply in a moment. 

3. Select the drum loop by double-clicking either repeat barline icon 

in the time ruler. 

The ruler and note grid highlights between the loop points. 
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Double-click the 
loop point tab to 
quickly select the 
entire loop. 

4. Choose Groove Quantize from the Region menu. 

The Groove Quantize dialog appears. 

@ If you get a message saying that Performer couldn’t 

find the Grooves folder, you’ll need to stop the tutorial 

for a moment to locate the groove folder in the 

Macintosh Finder and drag it into the same folder as 

Performer. If you’d rather not disrupt the flow of the 

tutorial, you can skip this section of the tutorial and 

flip to the next section. 
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- Groove Quantize 

(—]) Cubase grooves | 

[1 ONA Grooves 

ea) Hip Hop Grooves 

] Jazz Riffs 

Old Grooves 

1 Rock 'n Roll Grooves 

Shuttles 

Y Straight Grooves 

5. Double-click the folder called DNA Grooves. 

Grooves are stored in groove files. The DNA Grooves folder has 

several groove files, called DNA Grooves™, provided free of 

charge with Performer by WC Research, Inc., who provide an 

extensive library of commercially available grooves. 

6. You'll now see a few groove files in the list as shown below. 

Double-click the file labeled “1eDNA Shuffles” to open it. 

eel 2 @ DNA Straight 

3 @ DNA Pushing 

4 @DN4 Laid Back 
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7. Now you'll see a list of shuffle grooves. Make sure the “Instant 
Preview” check box is checked below the list, and click one of the 

grooves in the list to apply it to the drum loop. 

When Instant Preview is turned on, the groove is applied to the 

loop as soon as you click on the groove name. But the groove 

doesn’t get permanently applied until you click OK. So feel free to 

experiment with different grooves in the list. To try a different 

groove, just click its name. 

Drag the title bar to move the 

When you click on a groove, it gets applied immediately to the selected region of notes. ee ere OO, 
The groove changes the timing, duration and on-velocities of the notes. You can 
actually see these changes occur to the notes in the Graphic Editing window when you I 

first click the groove. If the Groove Quantize window is in the way, just drag it to the | : ne 
side using its title bar. Watch the notes change as you try different grooves. 

[j Start: 111/000 End: 3i1/oo0 : 
va dadtaietn ___ ues 

40) 2 ® Shuffle Feel B 

3 @ Soft Shuffle 

1 4 @ Medium Shuffle 

ay @ Hard Shuffle ; 

1 6 @ Soft & Med Shuffle 

4°) 7 @ Med & Hard Shuffle 

é rly Snare 

rm 

8. When you find a groove you like, click the More Choices button. 

This button adds more controls to the Groove Quantize window. 
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Groove Quantize 

4 @ Soft Shuffle 

4 @ Medium Shutfle 

2 ® Hard Shuffle 

6 @ Soft & Med Shuffle 

7 @ Med & Hard Shuffle 

& @ Early Snare 

9. Use the three faders to experiment with changing the degree to 

which the groove is applied. 

The three faders control how much timing, velocity, and duration 

information is applied from the groove. They let you fine-tune the 

effect of the groove. With Instant Preview turned on, changes you 

make to a slider occur as soon as you release the slider handle. 

10. After you’re done experimenting, and you have the groove the way 

you like, click OK to apply the groove to the drum loop. 

The Groove Quantize dialog goes away, and the groove is 

permanently applied to the drum loop. 

11.Press the Stop button to stop playback at this time, and press 

rewind to rewind to measure 1, beat 1. 

12. Now would be a good time to save the file again. Choose Save from 

the File menu. 

Since you already created and named the file once already, it 

doesn’t ask you for a name this time. Instead, it just saves the file 

to disk in its current state. 
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Prepare to record a 
second track 

Step record a piano part 

Tutorial: Building a Sequence 

Let’s put away the Graphic Editing window for now. To do so, click 

its close button at the far left of the title bar. Now let’s prepare Track-2 

for recording. 

 ? Record-enable Track-2. 

There are two ways to do this: 1) click the record-enable button in 

the Tracks list window, or 2) press the down arrow key. 

Choose a playback device for Track-2 from the Device pop-up 

menu. 

For a review of this procedure, see “Set up a track for recording” 

on page 110. 

Choose a bright piano or bright synth sound for the new track from 

the Patch column (or call up the sound manually from the device 

itself, if sound names are not yet showing in Performer’s patch 

pop-up menu). 

If you have a general MIDI sound module, use “Honky Tonk 

Piano”. 

Rename the track “Chords”. 

As you did earlier in the tutorial, option-click the word “Track-2” 

to pop-edit the name. 

Test the track by playing a few notes on your controller keyboard. 

You should hear the piano sound you called up earlier. 

Step Record is a powerful sequencing feature because it lets you 

record notes one at a time. It is especially useful if you don’t have 

well-practiced keyboard skills. We’ll use it to enter some half-note 

chords: 

1. Press the Rewind button to make sure that the sequence is 

rewound to measure 1, beat 1. 

To be able to see what you are entering, double-click the track 

name “Chords” to open the event list window for the Chords track. 
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3. Choose Step Record from the Basics menu. 

The Step Record window appears. If necessary, move the Step 

Record window by dragging its title bar so that it doesn’t obscure 

the event list window. 

Half note 

128 Tutorial: Building a Sequence 



5. The first chord you’ll enter is a simple C major triad (C-E-G) starting 

on middle C (C3). To enter the chord, press these three keys down 
together once and then release them together. 

The chord is actually entered when you release the keys. Notice 

that the current step and the main counter advance the duration of 

a half note to beat 3. In addition, Performer plays the first two 

beats of the measure when you enter the notes so you can hear 

the chords in context with the rest of the sequence. Notice also 

that the chord notes displayed in the event list are precise half 

notes: they have a duration of two beats (21000) and all occur 

together exactly on beat 1 (1111000). 

The first chord 

@ If you make a mistake, Don’t worry. Press the 

Backstep button and try again. 

6. In a similar fashion, play the second chord: F maj (for beats 3 and 

4 of measure 1). 

Remember, when you are step recording, you can take as much 

time as you want with each step. Use the Backstep button if you 

make a mistake and need to re-enter the chord. 

The second chord The third chord The fourth and last chord 
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7. At your leisure, play chords three (G minor) and four (F major 

again). 

Be sure to completely take your hands off the keys before playing 

the next chord. In fact, it is good technique when step-recording 

to play in a staccato fashion—almost as if you were pecking at the 

notes. This ensures that you won’t play too many notes on a beat. 

8. When you are done, close the Step Record window. 

You now have two bars of chords in the sequence. 

9. To hear the chords play back in real time with the drums, press the 

Memory-cycle button to turn it back on (Step Record turns it off), 

press the Rewind button, and then press the Play button. 

Two bars of step- 
recorded chords. 

Set up a bass track 

130 

S$eq-1 

Now let’s add one more track: a bass part. 

1. Record-enable Track-3. 

2. Choose a playback device and channel from the Patch column in 

the Tracks window. 
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3. Choose a bass sound for the track from the Patch column (or call 

up the sound manually from the device itself, if sound names are 

not yet showing in Performer’s patch pop-up menu). 

4. Change the name of Track-3 to “Bass”. 

Enter the bass part in the You're now ready to enter the bass part. Let’s do it by inserting notes 

QuickScribe notation graphically in the QuickScribe notation window. If you don’t read 

window music notation, don’t worry. You'll still be able to follow the tutorial 

here. 

1. Select the Bass track by clicking its name. 

2. Check to see that the end time in the Edit bar is 3111000. If not, 

double-click the Edit button in the Edit bar. 

This selects the first two bars in the Bass track. 

Edit bar—» 

3. Click the QuickScribe notation button to open the QuickScribe 

window. 

QuickScribe notation button 

4. Click the eighth note in the tool palette to select an eighth note 

duration. 

The cursor turns into a cross hair to indicate it is ready to insert 

Eighth note—— > notes. 
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5. Place the cross-hair cursor in the middle space on the staff on beat 

one in the first measure. 

Use the cursor coordinates display to help you position the cursor. 

Before you click, the cursor coordinates should read 

“1111000 C4 e 72”. 

@ We are entering the bass part in the middle of the 

treble clef staff to avoid dealing with lots of ledger 

lines below the staff. We will transpose the notes 

down to the proper octave after we enter them. The 

clef with then automatically change to a bass clef. 

Cursor coordinates —————_>} 

Cross-hair cursor. 

6. Click the mouse to insert an eighth note on beat one. 

@ If you make a mistake, don’t worry. To fix it, you have 

two choices: 1) choose Undo from the Edit menu and 

try again, or 2) drag the note up, down, left, or right to 

the correct pitch or location. To drag the note, click the 

notehead and drag as needed. 

Bass 
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7. Ina similar fashion, enter the next two eighth notes in bar 1. 

Use the cursor coordinates display to position the cursor at the 

proper beat and pitch before you click. Notice also that the cursor 

“snaps” to a grid to help guide you. 

@ Don't worry about the rests, ties, and beams. 

Performer adds them automatically. 

Bass 

G3 at 1111240 A3 at 1121000 

8. Now let’s enter a quarter note. Click the quarter note icon in the 

tool palette and click as shown below. 

Performer properly notates the quarter note as two tied eighth 

notes because it lies across a beat boundary. 

Click here to insert a 

Bass quarter note as two tied 
eighth notes. 

C4 at 1121240 ’ 

Bass 

Complete bar 1 by Let’s complete bar 1 by learning how to copy and paste notation. 

copying and pasting 
1. Click the arrow in the tool palette to select it. 

The cursor changes back to the standard Macintosh arrow. 

1. Select all the notes except the first one by dragging as shown 

below. 
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Finish bar 2 with 
Macintosh keyboard 
note insertion 
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Bass 

2. Choose Copy from the Edit menu. 

This copies the notes into the Clipboard. 

3. Click in measure 1 to the right of the last note. 

An insertion cursor appears on the staff. 

4. Choose Paste from the Edit menu. 

The notes are pasted into the measure. 

Bass 

The QuickScribe notation window also provides note insertion 

directly from the Macintosh keyboard. Let’s finish bar 2 from the 

Macintosh keyboard. First, we need to place the insertion cursor back 

on the staff. 

1. Click in bar 2 on the rest after the first note to place the insertion 

cursor there. 
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Bass 

Bass 

2. Use the up and down arrow keys to move the cross-hair to the 

second line from the bottom as shown below. 

= 
. Press the right bracket key ( ] ) twice. 

This selects the eighth note tool in the palette. You can freely use 

the right-bracket and left-bracket keys to select any duration tool 

in the palette. 

. Press the return key. 

Another eighth note appears in bar 2. 

es — 
. Press the up-arrow key to move up to the second space 

. Press return to enter the next eighth note in the second space. 
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Transpose the bass part 
to the proper octave 
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7. Press the left-bracket key once to change to the quarter note tool 

in the palette, and press the up-arrow twice to move the cross hair 

to the middle space. 

8. Press return to enter the quarter note. 

9. Use the keys shown below to finish the measure. 

To do this: 

Select the eighth note tool 

Move the cross-hair up and down 

Move the cursor left and right 

Insert a note 

Fix a mistake 

Bass 

Type this: 

Left-bracket ([ ) & right-bracket ( ] ) 

Up arrow & down arrow 

Left arrow & right arrow 

Press return 

Choose Undo from the Edit menu 

For ease of entry, we entered the bass part on a treble clef staff in the 

octave of C3 to C4, which is too high. Let’s transpose it down to the 

proper octave. 
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1. Choose Select All from the Edit menu to select all the notes. 

Alternately, you could press command-A. This convention works 

in just about every window in Performer. 

2. Choose Transpose from the Region menu. 

The Transpose dialog box appears. 

Transpose 

Let’s transpose by interval down three octaves: 

3. Play C4 on your MIDI keyboard so that it shows up in the 

highlighted “From” box on the screen. 

If you don’t get C4 on your first try, don’t worry. Keep playing 

until you see “C4” appear in the box. 

4. Press the tab key once to highlight the second box labeled “to”, 
and then play C1. 

The dialog should now say From C4 to C1”. 
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Make a four bar phrase 
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5. Click OK. 

The notes are transposed down three octaves. 

1 2 

Fi 
2 A PT a ONE SRAM 

Bass Gs py $$] py 
eS i A TT PE OEROS REE SSG tees Soe SR Ok OE MEE Gee eS 

6. To switch the clef to a bass clef, choose Repaginate from the 

QuickScribe window mini-menu. 

The staff is automatically redrawn with a bass clef. Performer 

automatically senses the appropriate clef for each staff. 

Bass 

7. Close the QuickScribe window for now by clicking its close box at 

the far left of its title bar. 

You can print out the contents of the QuickScribe window. For more 

information, see chapter 23, “QuickScribe Notation” (page 345) in the 

Reference Manual for more information. 

Let’s make our two bar loop into a four bar phrase now by making a 

copy of it in bars 3 and 4. 

1. In the Tracks Overview, press on the upper left segment in the 

Drum track and drag down and to the right over the last segment in 
the bass track. 

This selects the first two bars in all three tracks. 
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Drag from this 
segment... 

... down to this 

segment. 

2. While holding down the option key, click the upper left segment 

again and drag two columns to the right to drop it in bar 3. 

Option-drag 
this segment... 

... to bar 3. 

Create a mixing console Now let’s create a mixing console to control volume and panning. 

1. Select the three tracks by dragging over their names in the Tracks 

lists. 
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2. Choose Create Console from the Tracks window mini-menu. 

A dialog box appears. 

[Create Console 

3. Choose the orientation and size that you would like, and click the 

Volume and Pan options. 

4. Ignore the other options for now and click OK. 

Performer creates a new console for you, complete with a master 

fader. You can create an unlimited number of consoles in 

Performer. This console emulates a hardware mixing console, and 

you can create a real-time, automated mix-down of your music. 
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Volurne 

Volume 

Volume 

Volume 

5. Start playback by pressing the space bar, and adjust the mix as 

follows. 

To do this: Do this: 

Adjust a track’s volume Drag each track slider individually. 

You can also press on the plus and 

minus buttons, or click anywhere 

on the slider to make a sudden 

jump. 

Tutorial: Building a Sequence 141 



Adjust panning Drag a knob up and down or left 

and right. You can also click on the 

value box next to the knob and type 

in the desired value (between zero 

and 127, where 64 is pan center). 

Smoothly fade all tracks at once Drag the master fader. 

Record a fader movement 1. Record-enable any empty track. 

2. Press the Record button. 

3. Move the fader you want to record. 

When you record a fader, it generates a stream 
of continuous controller data in the track it 
controls. Since you are Memory-cycle record- 
ing, be aware of where you are in the loop as 
you record so that you don’t overlap. For 
example, try to start recording in bar 1 and finish 
in bar 4. To start recording the slider, just grab 
it's handle with the mouse. To stop, just let it go. 

Watch a fader animate after Just play the sequence. 

recording 

@ Some MIDI synthesizers don’t respond to a MIDI 

mixing console like this one. If you don’t get any 

response from your MIDI device as you adjust the 

controls in the console, this is probably the case. Try 

assigning the tracks to a different MIDI device, if you 

have one. 

6. Before we move to the last section of the tutorial, adjust the mix to 

a comfortable setting. 

7. Close the mixing console by clicking its close box. You can re- 

open it at any time by choosing it from the Windows menu. 
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Open the Chunks list Congratulations! You have just built a sequence in Performer. You 
now know enough to build your own sequences of any length with 

any number of tracks. Many people use the Tracks window as their 

sole organizing tool for their music. You can create sequences 

hundreds of bars long and you can organize them with markers. 

Performer has another way to organize your music: the Song 

window. The Song window gives you a graphical, structural view of 

your music. And creating a song is easy. First you build sequences 

just like the one we made in this tutorial. Then you arrange them in 

a song window. Let’s try it now. 

1. Close the Tracks window. 

2. Open the Chunks List window by clicking its button in the Control 

panel. 

The Chunks list window shows you all of the sequences and 

songs—collectively referred to as chunks—in the Performer file 

you have open. 

The Chunks list button. 

3. The Chunks list window appears, showing Seq-1, the sequence 

have been working on in this tutorial. 

Seq-1 is play-enabled, and it is four bars long, so it has an end 

time of 5111000, which is the downbeat of measure five. 
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4. Rename Seq-1 by option-clicking its name to pop-edit the name. 

Call it “Verse 1”. Press Return to complete the change. 

Create an intro Let’s create a modified version of “Verse 1” so we have two sequences 

sequence to work with: 

1. Click the sequence name to select it. 

2. Choose Copy from the Edit menu. 

3. Choose Paste from the Edit menu. 

A second copy of Verse 1 appears in the list. Currently, they are 

identical. 

4. Rename the second copy; call it “Intro”. 

Now let’s modify the Intro sequence a little bit so that it sounds 

different from Verse 1. 

5. Double-click the name “Intro” to open the Tracks list window for it. 

First, let’s delete the empty tracks. 

6. Select Track-4 through Track-8 and choose Delete from the Tracks 

window mini-menu. 

Now let’s delete the first two bars of bass. 

7. Select the first two bars of the bass track in the Tracks overview. 

To do so, you can drag over them, or shift-click each one. 
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8. Press the delete key to clear the selected segments. 

Now let’s delete all but the last two beats of the drum track. 

9. Click the track name “Drums”. 

10. Set the Start time in the Edit bar to 1111000, and set the End time to 

4131000. 

To set the times, click on one of the numbers, type to change it, 

use the tab key to cycle to the next number, and press return 

when you are done. 

11. Choose Erase from the Edit menu, or press the delete key. 

12. The Tracks Overview should now reflect the changes we have 
made. 

13. Close the Tracks window by pressing command-w. 
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Listen to the intro Now let’s listen to the Intro. 

1. Click the Play button in the Chunks list next to the Intro sequence. 

Notice that the Verse 1 sequence un-play-enables when you do so. 

Only one sequence can be play-enabled at a time in this list. You'll 

see in a moment how to play several at once. 

2. Start playback by pressing the space bar. Press the space bar 

again to stop when the sequence reaches the end of the four bars. 

Create a song Let’s build a song with these two sequences. 

1. Choose Add Song from the Chunk list window mini-menu. 

A song appears in the list. Notice that it has a different icon than 

the sequences. 

2. Double-click the name “Song-1” to open the Song window. 

The Song window appears. 
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Add sequences to the Now we can build the song out of the component sequences. 
song 

1. Drag the icon for the Intro sequence from the Chunks list into the 
middle of the Song window. 

You may need to reposition the windows beforehand. 

2. The Intro sequence snaps to the first column at 1111000. 

Notice also that a new column is automatically created after the 

sequence. 

3. Add the Verse 1 sequence in a similar fashion, dropping it into the 

song to the right of the intro sequence. 

Notice that the Verse 1 sequence snaps to the column at the end 

of the intro sequence. 
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4. Duplicate the Verse chunk by option-dragging it to the right. ne 

the duplicate to the right of the column at 9111000. 

You can freely drag sequences—and even other songs—around in 

this window. If you option-drag, you make a duplicate. The 

duplicate is actually a reference to the original sequence in the 

Chunks list window; duplicating in the Song window does not 

create new data. Instead, it creates another reference to the 

original data. If you change the original, all instances of it change, 

too. 

Play the song To play the song: 

1. Click its play button in the Chunks list window. 

2. Set the metronome slider to 104 bpm. 

A song has its own tempo setting—although you can make it 

follow the tempos of its component sequences if you want. 

3. Turn off Memory-cycle. 

4. Press the play button, or hit the space bar. 

Congratulations! You now know enough about Performer to sequence your heart out. 

Believe it or not, we’ve only scratched the surface. Performer has 

many more powerful features. We strongly urge you to check out the 

Reference Manual. You'll probably find features not covered in this 

tutorial that will be of immediate use to you. Also be sure to consult 

the addendum section in this guide: it contains important information 

about enhancements that have been made to Performer not covered 

in the Reference Manual. Enjoy! 
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Chapter 10 Using Other FreeMIDI Releases 
with Performer 

This section provides information about the following software 

updates: 

m Unisyn 1.1 

a MTP II Console 1.1 (for the MIDI Time Piece II interface) 

= MIDI Express Console 1.1 (for the MIDI Express interface) 

These updates are available free of charge to all registered users of 

these products. They provide support for FreeMIDI, the integrated 

MIDI operating system upon which Performer Version 5 is based. In 

some cases, other non-FreeMIDI features have been added as well, 

free of charge. 

Performer Version 5 does not require these versions. You can use 

earlier versions if you like without losing any capabilities. These 

versions (and higher), however, provide the benefits of working with 

FreeMIDI. For an overview of these benefits, see the “Introducing 

FreeMIDI” on page 41, as well as the introductions in following 

update chapters. 
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Chapter 11 Unisyn 1.1 Update Notes 

New featur ES All new features in Unisyn 1.1 have been added to accommodate 

FreeMIDI. These changes are: 

mw All Profiles have been updated 

m Device Setup is simplified 

= MIDI Setup is controlled by FreeMIDI 

= Standard FreeMIDI commands have been added to 

Unisyn’s command set 

Device Setup The first time you launch Unisyn 1.1 after installation, you will need 

to create a Device Setup file. You are prompted to do this by the 

appearance of the Device Setup dialog box. 

To create a Device Setup file: 

1. Launch Unisyn 1.1 for the first time by double-clicking its icon. 

The Device Setup dialog appears: 
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Device Setup 7 
For each physical device in your : rs rr 

system, select a Profile by using Add : ha 

Device... and edit the Device Settings. 
Setup File Name: 

Device (Profile List evice ‘Profile Lis A Open... #0 Save As... #0 

Add Device... #A 

Replace Profile... RA 

Delete Device 

:Device Settings 

ie 2S aaa 

Figure 11-1: Device Setup Dialog Box 

2. Click Add Device or type command-A. 

A standard Macintosh File Open dialog appears: 

3. Navigate to your Profiles Folder containing the new Unisyn Profiles 

and select a profile for one of your MIDI devices. 

4. Click Open. 

The Profile name appears in the Device Setup dialog devices list. 

When profiles are added to the Device Setup, Unisyn tries to 

automatically match the profile to its corresponding FreeMIDI 
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Unisyn 1.1 Update Notes 

Device from your current FreeMIDI Configuration. So when you 

add a Profile, Unisyn displays a FreeMIDI Device in the Device 

Settings pop-up menu. 

Device Setup fk 
Drag items in Device ‘Profile list to a sity iH 
rearrange them in the Modules window. 

Setup File Name: setup 
Device ‘Profile List 
ESQ-M Open... #0 Save #5 Save As... #0 
M11 

TG?? Add Device... #A 
Vintage Keys 

ESci-M 

HF-16 

1-1 

Video Time Piece 

CBx-BS 

MIBI Tirn 

Figure 11-2: Device Settings Pop-up Menu 

If the FreeMIDI Device displayed in the pop-up menu is correct, 

proceed back to Step 2 above and add more profiles until you 

have completed the Device Setup. If the FreeMIDI Device 

displayed in the pop-up menu is incorrect, choose the correct 

FreeMIDI Device from the menu and then proceed back to Step 2 

above and add more profiles until you have completed the Device 

Setup. 

@ In Unisyn 1.1, Auto Bank Update is enabled for all 

devices by default. We recommend using this setting 

for all devices in order to produce the best results 

when using FreeMIDI’s patch lists. For more 

information on Auto Bank Update, consult your 

original Unisyn user’s manual. 
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MIDI Setup 

Transport 
Controls 
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5. When you have added all the profiles needed for your MIDI setup, 

click Save to save the Device Setup file to disk. 

A standard Mac File Save dialog box appears. 

6. Name the Setup file, navigate to the Data Folder contained in the 

Unisyn 1.1 Folder and click Save. 

7. Click OK to close the Device Setup dialog box and proceed with 

use Unisyn 1.1. 

MIDI Setup is now controlled by FreeMIDI. Use the FreeMIDI Setup 

application to make changes to your MIDI Setup as outlined in the 

FreeMIDI update notes. The MIDI Setup command has been replaced 

by the /nterface Settings command. 

Use the /nterface Settings command to open the Interface Settings 

dialog box. This dialog box is the same dialog box that appears in 

other FreeMIDI applications and will control FreeMIDIs access to the 

serial ports of your Macintosh for all FreeMIDI applications. This 

dialog box allows you to enable and disable the two serial ports for 

MIDI. If, for instance, you have a printer attached to the Thru port of 

your MTP II and the MTP II is connected to the Printer serial port, you 

will need to disable MIDI on the printer port in order to do any 

printing. 

The Transport Controls window contains buttons that can control the 

transport functions (Play, Stop, Rewind, Locate) of other FreeMIDI 

applications from within Unisyn. For instance, you might want to start 

a sequence playing in Performer while you are using Unisyn to 

audition various patches. You do so by opening the Transport 

Controls window, enabling FreeMIDI Sync, and clicking Play. With 

this feature there is no need to switch to Performer. 

Once FreeMIDI Sync is enabled you can also stop or pause 

Performer, rewind the sequence, or auto-locate to up to 8 predefined 

positions within the sequence directly from Unisyn. 

FreeMIDI Sync can be enabled from any FreeMIDI application that is 

currently open and that supports this feature of FreeMIDI. In 

Performer, this switch is in the Basics menu. When you enable 

FreeMIDI Sync in any open FreeMIDI application, it is enabled for all 

FreeMIDI applications on that Macintosh. 
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To use the Transport Controls: 

1. Choose Transport Controls from the Play Menu. 

The Transport Controls window appears. 

4 Controls 

REWIND STOF FLAY FAUSE 
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Figure 11-3: Transport Controls Window 

Auto-locate buttons 

2. Click FreeMIDI Sync to enable FreeMIDI Sync. 

You can skip this step if FreeMIDI Sync has already been enabled 

by some other FreeMIDI application. If it is already enabled, the 

FreeMIDI Sync check box appears selected (filled-in). 

@ The state of FreeMIDI Sync (ON or OFF) cannot be 

changed while a FreeMIDI application, such as 

Performer, is playing. 

3. Click the Transport Control function that you want to use. 

Click Rewind, Play, Stop, or Pause to send those commands to the 

FreeMIDI application that you are controlling. The FreeMIDI 

application should respond to these commands as if you were 

using its own controls. 

4. If the FreeMIDI application that you are controlling supports their 

use, you can use any of the 8 auto-locate buttons to auto-locate to 

some pre-defined location in the sequence or song that is currently 
playing. 

In Performer, you can define these auto-locate points in the 

Markers window. Assign a number from 1-8 for a marker in the 

Seek column and that marker’s location in the sequence will be 

defined as one of the 8 FreeMIDI auto-locate points. Click the 
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corresponding button in the Transport Controls window and 

Performer will locate to that point. You can auto-locate at any 

time, even during playback. 

There is an Edit FreeMIDI Configuration command in the MIDI menu. 

Choosing this command will launch the FreeMIDI Setup application 

(or switch to FreeMIDI Setup if it is already open) and display the 

current FreeMIDI Configuration. There is a Return command in 

FreeMIDI Setup (command-R) that will switch back to Unisyn if you 

entered FreeMIDI Setup using the Edit FreeMIDI Configuration 

command. Please note that this feature is only supported in System 7 

and higher. 
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Chapter 12 MTP Il Console 1.1 Update Notes 

Serial Port Setup 

Interface 
Settings 

Changes to MTP II Console 1.1 from Version 1.03 have been made to 

accommodate the FreeMIDI System. Other new features have been 

added as well. These changes are: 

m Serial Port Setup is controlled by FreeMIDI 

= Standard FreeMIDI commands have been added to MTP II 

Console’s command set 

m Cable Names are produced by FreeMIDI 

= The current Base Setup or Modifier name displays in the 

title bar of other windows [new MTP II feature] 

a» MIDI Cannon [new MTP II feature] 

= Custom Pedal Curves [new MTP II feature] 

Serial Port setup is now controlled by FreeMIDI. The Serial Ports 

window and its corresponding command in the Windows menu have 

been removed. Additionally, all the command key equivalents in the 

Windows menu have changed accordingly. Use the FreeMIDI Setup 

application to control which serial ports the MTP II Console will 

search for MTP and MTP II interfaces as outlined in the FreeMIDI 

reference chapter. 

Use the /nterface Settings command in the Utilities menu to open the 

Interface Settings dialog box. This dialog box is the same dialog box 

that appears in other FreeMIDI applications and will control 

FreeMIDI’s access to the serial ports of your Macintosh for all 

FreeMIDI applications. This dialog box allows you to enable and 

disable the two serial ports for MIDI. If, for instance, you have a 

printer attached to the Thru port of your MTP II and the MTP II is 

connected to the Printer serial port, you will need to disable MIDI on 

the printer port in order to do any printing. 
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The Transport Controls window contains buttons that can control the 

transport functions (Play, Stop, Rewind, Locate) of other FreeMIDI 

applications from within MTP II Console. For instance, you might 

want to start a sequence playing in Performer while you are using 

MTP II Console to edit Modifiers. You do so by opening the Transport 

Controls window, enabling FreeMIDI Sync, and clicking Play. With 

this feature there is no need to switch to Performer. 

Once FreeMIDI Sync is enabled you can also stop or pause 

Performer, rewind the sequence, or auto-locate to up to 8 predefined 

positions within the sequence directly from MTP II Console. 

FreeMIDI Sync can be enabled from any FreeMIDI application that is 

currently open and that supports this feature of FreeMIDI. In 

Performer, this switch is in the Basics menu. When you enable 

FreeMIDI Sync in any open FreeMIDI application, it is enabled for all 

FreeMIDI applications on that Macintosh. 

@ The state of FreeMIDI Sync (ON or OFF) cannot be 

changed while a FreeMIDI application, such as 

Performer, is playing. 

To use the Transport Controls: 

1. Choose Transport Controls from the Windows menu. 

The Transport Controls window appears. 

[ei reean ame 
Figure 12-1: Transport Controls Window 

Auto-locate buttons 

2. Click FreeMIDI Sync to enable FreeMIDI Sync. 

You can skip this step if FreeMIDI Sync has already been enabled 

by some other FreeMIDI application. If it is already enabled, the 

FreeMIDI Sync checkbox appears selected (filled-in). 
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@ The state of FreeMIDI Sync (ON or OFF) cannot be 

changed while a FreeMIDI application, such as 

Performer, is playing. 

3. Click the Transport Control function that you want to use. 

Click Rewind, Play, Stop, or Pause to send those commands to the 

FreeMIDI application that you are controlling. The FreeMIDI 

application should respond to these commands as if you were 

using its own controls. 

4. If the FreeMIDI application that you are controlling supports their 

use, you can use any of the 8 auto-locate buttons to auto-locate to 

some pre-defined location in the sequence or song that is currently 
playing. 

In Performer, you can define these auto-locate points in the 

Markers window. Assign a number from 1-8 for a marker in the 

Seek column and that marker’s location in the sequence will be 

defined as one of the 8 FreeMIDI auto-locate points. Click the 

corresponding button in the Transport Controls window and 

Performer will locate to that point. You can auto-locate at any 

time, even during playback. 

There is an Edit FreeMIDI Configuration command in the Utilities 

menu. Choosing this command will launch the FreeMIDI Setup 

application (or switch to FreeMIDI Setup if it is already open) and 

display the current FreeMIDI Configuration. There is a Return 

command in FreeMIDI Setup (command-R) that will switch back to 

MTP II Console, if you entered FreeMIDI Setup using the Edit 

FreeMIDI Configuration command. Please note that this feature is 

only supported in System 7 and higher. 

Cable names in the Cable Routing, Channel Mapping, Event Muting, 

Knobs & Pedals, Patch List, MIDI Cannon, and Setups & Modifiers 

windows are produced by FreeMIDI. MTP II Console gets the names 

of each input and output cable from the names of connected 

FreeMIDI Devices. Use FreeMIDI Setup application to change these 

names. 
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The name of the currently selected preset appears in parentheses in 

the Cable Routing, Channel Mapping, Event Muting, SMPTE Controls, 

Pedal & Click, and Setups & Modifiers windows. This makes it easier 

to know which Preset is currently selected without opening or finding 

the Presets window. 

The MIDI Cannon allows you to store a group of MIDI events in a 

Modifier to be sent to any or all MIDI devices on an MTP network 

when the Modifier becomes current. There are two ways to make a 

Modifier current, by selecting it in the Setups & Modifiers window 

and by selecting an MTP II patch with a patch change command. 

Please consult your original MTP II user’s manual for more 

information on Modifiers and Patches. 

Open the MIDI Cannon window by selecting its command from the 

Windows menu. 

Insert event mini-menu 
MIDI Cannon button 

Sf [er] Et, MIDI Cannon (my modifier) 
I EVENT SUTFUT CHELE CH. HEH 

127 fall PAN: BOO? 7F 
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M1 : 7: CO5A 

FOF? <11> iVintageKeys : {| FO 22 22222223 

Figure 12-2: MIDI Cannon Window 

This window allows you to add, edit, and delete MIDI events in a 

specific MIDI Cannon message. It also allows you to test the current 

MIDI Cannon message. 

To create a MIDI Cannon message: 

1. Select or create a Modifier in which you wish to store the MIDI 

Cannon message. 

See your original MTP II user’s manual for more information on 

selecting and creating Modifiers. 
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2. Select MIDI Cannon from the Windows menu. 

The MIDI Cannon window appears. 

3. Select a MIDI event from the Insert mini-menu 

You can select any type of MIDI data that is in the mini-menu. 

Insert mini-menu 

+, MIDI C annon (my modifier) 
Nate ian — “Se 
Note off BO OU? ¢F 
Pitch bend PAN; EOOO 40 

: 7: C6 5A Patch change 

Controller 

Channel aftertouch}| : 

Poly aftertouch : —_ 

' FO 22 22 22 22 23 

System exclusive i i Er 

Figure 12-3: Insert mini-menu 

4. Edit the values of the newly inserted event. 

For instance, if you inserted a patch change event, you will need 

to enter the patch change number you want, or if you entered a 

controller event, you will need to enter the controller number and 

the value you want. Each event type has a different set of fields for 

entering the desired values. 

5. Assign a Cable and Channel (CH) for the event by using the Cable 

and Channel pop-up menus. 

6. Add more MIDI events by repeating steps 3-5 until all the MIDI 

events that you want in this message are displayed in the MIDI 

Cannon window. 

You can add as many events as you like up to the maximum size 

for the Modifier. 

@ the maximum size for a Modifier is determined by the 
amount of free RAM in the MTP II’s memory. Please 

consult your original MTP II user’s manual for more 

information. 
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: Test the MIDI Cannon message by clicking the MIDI Cannon button. 

All of the MIDI events in the list are transmitted to the assigned 

cables and channels. 

If the MIDI Cannon message is correct, save the Modifier and “MIDI 

Cannon message” appears in the script for that Modifier in the 

Setups & modifiers window. 

You can edit MIDI Cannon messages that you have already created in 

two ways. 

To 

1. 

To 

=» Remove the MIDI Cannon message from the Modifier and 

then create a new MIDI Cannon message for that Modifier. 

» Change the MIDI events in a MIDI Cannon message. 

remove a MIDI Cannon message from a modifier: 

Make the Modifier that contains the MIDI Cannon message you 

wish to edit current by selecting it in the Setups & Modifiers 

window. 

. Select the MIDI Cannon message line in the script for the Modifier 

and type delete or backspace on your Mac keyboard. 

The MIDI Cannon message is removed and you can then open the 

MIDI Cannon window to insert a new MIDI Cannon message as 

described above in “Creating MIDI Cannon Messages” on 

page 162 in this chapter. 

change the events in a-MIDI Cannon message: 

. Make the Modifier that contains the MIDI Cannon message you 

wish to edit current by selecting it in the Setups & Modifiers 
window. 

Open the MIDI Cannon window. 

The MIDI Cannon message appears as a list of MIDI events. 

Select MIDI events in the list and type delete or backspace on your 

Mac keyboard to remove them. 

Alternately, you can use the Clear command in the Edit menu to 

remove MIDI events from the list. 
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4. Double-click events and type to change their values. 

A double-clicked event pops-up for editing as illustrated below. 

Double-click and enter a new value here 

Saf] OS MIDI Bepeen (my modifier) 
. Aca OUTFUT CABLE HEX 

a #7 = lE All: BOO? 7F 
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I FOF? <11> i¥intageKeys : | FO22 22 2222 23 
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Figure 12-4: Editing a MIDI event 

5. Use the Cable and Channel pop-up menus to change the MIDI 

destination for an event. 
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Figure 12-5: Changing Cables and Channels for a MIDI event 

6. Test the MIDI Cannon message by clicking the MIDI Cannon button. 

All of the MIDI events in the list are transmitted to the assigned 

cables and channels. 

7. If the MIDI Cannon message is correct, save the Modifier and “MIDI 

Cannon message” appears in the script for that Modifier in the 

Setups & modifiers window. 
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Custom pedal curves can now be created and saved within Modifiers 

to allow the MTP II’s Pedal inputs to react in a non-linear manner to 

control voltage foot pedals. When Pedal A or B input is assigned to 

be controlled by a Korg or Roland Expression-type foot pedal, you 

can make a custom pedal curve for that pedal in the Pedal Curves 

window. The Knobs & Pedals window contains a new check box to 

toggle whether a pedal input uses the current custom pedal curve. 

To make a custom pedal curve: 

1. Select or create a Modifier in which you wish to store the pedal 

curve. 

To save a pedal curve, it must be part of a Modifier. Pedal curves 

cannot be saved as part of Base Setup. See your original MTP I 

user’s manual for more information on selecting and creating 

Modifiers. 

2. Choose Pedal Curve from the Windows menu. 

The Pedal Curve window appears. 

APeLtitittte 
Pedal position: 0 

Output yalue: SO 
Shift-click and drag to draw a line. 

Figure 12-6: Pedal Curve 
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3. Choose the pedal, A or B, for which you wish to create a custom 

pedal curve, by clicking A or B in the Pedal Curve window title bar. 

The current pedal curve for the selected pedal displays. 

4. Use the mouse to draw a new curve. 

Shift-click and drag the mouse to draw a straight line. 

5. Save the Modifier and “Pedal Curve Message” appears in the script 

for that Modifier in the Setups & modifiers window. 

The custom pedal curve is saved as part of the modifier. 

MTP II Console 1.1 Update Notes 167 



168 MTP II Console 1.1 Update Notes 



Chapter 13 MIDI Express Console 1.1 Update 
Notes 

Serial Port Setup 

Interface 
Settings 

Transport 
Controls 

Most of the changes to MIDI Express Console 1.1 from Version 1.01 

were made to accommodate the FreeMIDI System. These changes 

are: 

m Serial Port Setup is controlled by FreeMIDI 

m Standard FreeMIDI commands have been added to MIDI 

Express Console’s command set 

m Cable Names are produced by FreeMIDI 

a The current Preset name displays in the title bar of other 

windows 

Serial Port Setup is now controlled by FreeMIDI. The Serial Ports 

window and its corresponding command in the Windows menu have 

been removed. Additionally, all the command key equivalents in the 

Windows menu have changed accordingly. Use the FreeMIDI Setup 

application to control which serial ports the MIDI Express Console 

will search for MIDI Express interfaces as outlined in the FreeMIDI 

reference chapter. 

Use the /nterface Settings... command in the Utilities menu to open 

the Interface Settings dialog box. This dialog box is the same dialog 

box that appears in other FreeMIDI applications and will control 

FreeMIDI’s access to the serial ports of your Macintosh for all 

FreeMIDI applications. This dialog box allows you to enable and 

disable the two serial ports for MIDI. If, for instance, you have a 

printer attached to the Thru port of your MIDI Express and the MIDI 

Express is connected to the Printer serial port, you will need to 

disable MIDI on the printer port in order to do any printing. 

The Transport Controls window contains buttons that can control the 

transport functions (Play, Stop, Rewind, Locate) of other FreeMIDI 

applications from within MIDI Express Console. For instance, you 

might want to start a sequence playing in Performer while you are 
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using MIDI Express Console to edit presets. You do so by opening 

the Transport Controls window, enabling FreeMIDI Sync, and 

clicking Play. With this feature there is no need to switch to 

Performer. 

Once FreeMIDI Sync is enabled you can also stop or pause 

Performer, rewind the sequence, or auto-locate to up to 8 predefined 

positions within the sequence directly from MIDI Express Console. 

FreeMIDI Sync can be enabled from any FreeMIDI application that is 

currently open and that supports this feature of FreeMIDI. In 

Performer, this switch is in the Basics menu. When you enable 

FreeMIDI Sync in any open FreeMIDI application, it is enabled for all 

FreeMIDI applications on that Macintosh. 

@ The state of FreeMIDI Sync (ON or OFF) cannot be 

changed while a FreeMIDI application, such as 

Performer, is playing. 

To use the Transport Controls: 

1. Choose Transport Controls... from the Windows menu. 

The Transport Controls window appears. 

4 Controls 
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Figure 13-1: Transport Controls Window 

Auto-locate buttons 

2. Click FreeMIDI Sync to enable FreeMIDI Sync. 

You can skip this step if FreeMIDI Sync has already been enabled 

by some other FreeMIDI application. If it is already enabled, the 

FreeMIDI Sync checkbox appears selected (filled-in). 

@ The state of FreeMIDI Sync (ON or OFF) cannot be 

changed while a FreeMIDI application, such as 

Performer, is playing. 
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Cable Names Produced 
by FreeMIDI 

Current Preset Display 

3. Click the Transport Control function that you want to use. 

Click Rewind, Play, Stop, or Pause to send those commands to the 

FreeMIDI application that you are controlling. The FreeMIDI 

application should respond to these commands as if you were 

using its own controls. 

4. lf the FreeMIDI application that you are controlling supports their 

use, you can use any of the 8 auto-locate buttons to auto-locate to 

some pre-defined location in the sequence or song that is currently 

playing. 

In Performer, you can define these auto-locate points in the 

Markers window. Assign a number from 1-8 for a marker in the 

Seek column and that marker’s location in the sequence will be 

defined as one of the 8 FreeMIDI auto-locate points. Click the 

corresponding button in the Transport Controls window and 

Performer will locate to that point. You can auto-locate at any 

time, even during playback. 

There is an Edit FreeMIDI Configuration... command in the Utilities 

menu. Choosing this command will launch the FreeMIDI Setup 

application (or switch to FreeMIDI Setup if it is already open) and 

display the current FreeMIDI Configuration. There is a Return 

command in FreeMIDI Setup (command-R) that will switch back to 

MIDI Express Console, if you entered FreeMIDI Setup using the Edit 

FreeMIDI Configuration... command. Please note that this feature is 

only supported in System 7 and higher. 

Cable names in the Cable Routing, Channel Mapping, Event Muting, 

Pedal & Click, and Presets windows are produced by FreeMIDI. MIDI 

Express Console gets the names of each input and output cable from 

the names of connected FreeMIDI Devices. Use FreeMIDI Setup 

application to change these names. 

The name of the currently selected preset appears in parentheses in 

the Cable Routing, Channel Mapping, Event Muting, SMPTE Controls, 

Pedal & Click, and Presets windows. This makes it easier to know 

which Preset is currently selected without opening or finding the 

Presets window. 
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AppendixA Using FreeMIDI with OMS 

OMS Compatibility FreeMIDI is compatible with the Opcode MIDI System™ (OMS). If 

you currently use OMS and it is required for OMS applications that 

are not yet FreeMIDI-compatible, you have two options: 

Option: 

Option 1: Keep both FreeMIDI 

and OMS in your System, and 

set each to “Allow other appli- 

cations”. 

Option 2: Remove OMS, install 

the FreeMIDI OMS Emulator, 

and have FreeMIDI emulate 

OMS. 

Explanation: 

In this scenario, FreeMIDI and OMS 

peacefully coexist with no interaction 

whatsoever. You maintain two studio 

configuration files, one for OMS and 

one for FreeMIDI. You'll continue to 

use OMS normally, and FreeMIDI 

operates as if OMS wasn’t even there. 

You completely remove OMS from 

your System by dragging the System 

extension out of the System folder. 

You then install a replacement for it, 

the FreeMIDI OMS emulator. Free- 

MIDI then looks like OMS to OMS 

applications: they share the FreeMIDI 

studio configuration, and they func- 
tion just like they do with OMS. For 

example, all of your FreeMIDI 

devices appear in each OMS applica- 

tion in the same places that OMS 

devices would. 

Pros and cons: 

Cons: you have to maintain two separate 

studio configuration files: one for OMS 

and one for FreeMIDI. OMS and FreeMIDI 

applications can’t send and receive MIDI 

at the same time. 

Pros: this method maintains the MIDI pro- 

cessing features available with the Studio 4 

and Studio 5. Also, with OMS present, you 

can more easily put the Studio 4 and 5 into 

“MTP” emulation mode, which is required 

with FreeMIDI. 

Pros: all applications share the FreeMIDI 

studio configuration file, and all applica- 

tions can send and receive MIDI at the 

same time. 

Cons: the MIDI processing features in the 

Studio 4 and Studio 5 become unavailable. 

Also, if you have a Studio 4 or 5, you still 
have to run OMS once before using Free- 

MIDI to put them into “MTP” emulation 

mode. 

Note: As of this writing, Galaxy, Opcode’s 

universal editor/librarian software, does 

not share patch lists with FreeMIDI, so 

Galaxy patches will not show up in Free- 

MIDI applications like Mosaic and Per- 

former. Galaxy patch lists, can, however, 

still be shared with Vision when using this 

option. 
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FreeMIDI emulates Opcode MIDI System (OMS) in the following 

way. You install a system extension called OMS Emulator, along with 

the FreeMIDI System Extension and other FreeMIDI System files and 

restart your Macintosh and FreeMIDI will then appear to be OMS to 

your OMS applications. 

@ Before proceeding with OMS Emulation, you should 

put your Studio 4 or Studio 5 MIDI interface Gf you 

have one) into “MTP emulation” mode and then 

remove OMS by dragging the OMS Extension out of 

your System folder and restarting your Mac. 

To install the OMS Emulator extension: 

1. Disable all Control Panel Devices and Extensions, including 

virus protection utilities such as SAM, Virex, Vaccine, 

Disinfectant, or GateKeeper during the installation process. 

These files can sometimes interfere with installation. To do so 

under System 7, restart or turn on your Macintosh with the shift 

key held down until you see the message, “Extensions Off”, 

which appears right after “Welcome to Macintosh”. Doing so 

turns off all extensions until the computer is restarted. Under 

System 6, remove all non-Apple INIT’s and Control Panel 

devices from your System Folder and then Restart your 

Macintosh. It is especially important to do this right before you 

install the program and authorize the hard disk. Once the 

program has been installed and authorized, you can re-enable 

them. 

Insert the Performer master disk and run the installer. 

The installer is the icon called “Double-click to install”. 

. Click OK when the installer logo screen appears. 

Click Customize. 

This produces the Custom install window where you can select 

individual files to be installed. 

Click the Drive as necessary in order for the current drive 

selected to be the disk which contains your System Folder. 

Select the OMS Emulator file from the scrolling list on the left 

side of the window. 

. Click Install. 
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8. When the Install is complete, you will be asked to Restart your 

Macintosh. Click Restart. 

OMS Emulator installation is completed. 

Once OMS Emulator is installed, all your OMS applications should 

work as if OMS were present only they will use your FreeMIDI 

Configuration to communicate with your MIDI gear. 
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Appendixes FreelMIDI and MIDI Manager 

FreeMIDI is MIDI Manager-compatible. However, we strongly 

recommend that you only use MIDI Manager if you have a program 

that absolutely requires it. MIDI Manager eats up a considerable 

amount of extra CPU processing power and makes your MIDI system 

much more complex. And you won’t lose any capabilities by not 

using MIDI Manager because FreeMIDI does everything that MIDI 

Manager does (and a lot more, too). 

@ If you have applications that need to run simulta- 

neously (such as digidesign’s Sample Cell™ software 

together with Performer), and the programs support 

FreeMIDI or OMS, you don’t need MIDI Manager. 

If ort absolutely require If you require MIDI Manager, please read this entire chapter. This 

DI Manager... chapter makes three assumptions: 

m You have already created a FreeMIDI Configuration and 

are familiar with the majority of FreeMIDI’s features and 

commands. If you are not familiar with FreeMIDI or have 

not yet created FreeMIDI Configuration, please see 

chapter 5, “Getting Started With FreeMIDI ™” before 

proceeding. 

m» MIDI Manager is correctly installed and functioning. 

Consult your Apple MIDI Manager user’s manual for 

information on installing and using MIDI Manager. 

m You understand how MIDI Manager functions. 

If you need to use MIDI Manager-only applications that are not yet 

FreeMIDI-compatible, you need to install FreeMIDI’s MIDI Manager 

Driver. This file is called FreeMIDI MM Driver. Once the FreeMIDI MM 

Driver is installed, you use the PatchBay application to connect all 

your MIDI Manager-compatible applications to FreeMIDI. 

The FreeMIDI MM Driver allows you to add up to 4 output and 10 

input ports for playing MIDI between MIDI Manager and FreeMIDI. 

The output ports route MIDI data from FreeMIDI sources (devices or 

179 



applications) to the MIDI Manager port. The input ports route MIDI 

data from MIDI Manager to FreeMIDI destinations (device or 

applications). 

Remove all other drivers Before starting to use FreeMIDI and MIDI Manager together, we 

before you start recommend that you remove the Apple MIDI driver and any other 

MIDI Manager drivers that may be installed. You will find these 

drivers in the top level of your System Folder or in the Extensions 

folder within your System Folder. It is best to let FreeMIDI handle all 

communication with the serial ports. If these other drivers are 

installed, you will get potentially confusing alerts as FreeMIDI and 

MIDI Manager both try to gain access to the serial ports. 

Installing the To install FreeMIDI MM Driver. 

FreeMIDI MM 1. Disable all Control Panel Devices and Extensions, including virus 

Driver protection utilities such as SAM, Virex, Vaccine, Disinfectant, or 

GateKeeper during the installation process. 

These files can sometimes interfere with installation. To do so 

under System 7, restart or turn on your Macintosh with the shift 

key held down until you see the message, “Extensions Off”, which 

appears right after “Welcome to Macintosh”. Doing so turns off all 

extensions until the computer is restarted. Under System 6, 

remove all non-Apple INIT’s and Control Panel devices from your 

System Folder and then Restart your Macintosh. It is especially 

important to do this right before you install the program and 

authorize the hard disk. Once the program has been installed and 

authorized, you can re-enable them. 

2. Insert the Performer master disk and run the installer. 

The installer is the icon called “Double-click to install”. 

3. Click OK when the installer logo screen appears. 

4. Click Customize. 

The Custom install dialog box appears. Select individual files to be 

installed here. 
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Click the items you want to select; 

Shift-click to select multiple items. 

Performer™ Application 

On-line Help File 

Example Files 

Fonts for System ?.1 or later ce = Hard Disk 
Fonts for $ystem ?.0.1 or earlier 

fff Giek 

Easy Install 

| Quit | 

Figure 13-1: Custom Install Dialog Box 

5. Click Switch Disk as necessary in order for the current drive 

selected to be the disk that contains your System Folder. 

6. Select the FreeMIDI MM Driver file from the scrolling list. 

Some help text appears giving information about the file you 

select. 
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Click the items you want to select; 

Shift-click to select multiple items. 

FreeMIDI 

MIDI Manager Driver 

OMS Emulator 

Serial Switch Control Panel 

Unicorn Power Control Panel 

a MIDI Manager Driver = 

Size: 5K 
Date: Thu, Oct 14,1993 

Yerstion: 1.0 

; This package contains 4a MIDI Manager driver for using 

i FreeMIDI together with MIDI Manager. It will be installed in 

your System Folder. ‘You must already have MIDI Manager 

i installed for this to be useful. 

Figure 13-2: Selecting the FreeMIDI MM Driver 

7. Click Install. 

8. When the install is complete, you will be informed of its status. You 

should Restart your Macintosh now in order to make FreeMIDI and 

MIDI Manager active. 

The FreeMIDI MM Driver installation is completed. 

Using the To connect FreeMIDI to your MIDI Manager-compatible applications: 

Fi r eeMIDI MM 1. Adjust the memory allocation for the PatchBay application in its 

Driver Finder Get Info window. 

We recommend allocating at least 128K to the PatchBay. 

Allocating even more memory seems the make the PatchBay less 

prone to crash or cause system errors. 
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@ Only use the PatchBay application. The PatchBay DA 

does not function with the FreeMIDI MM Driver. 

2. Open PatchBay by double-clicking its icon in the Finder. 

The PatchBay window appears with the FreeMIDI MM Driver 

installed. 

PatchBay 

Figure 13-3: PatchBay Window 
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3. Double-click the FreeMIDI MM Driver icon. 

The FreeMIDI MM Driver Control Panel appears. 

=— FreeMIDI/MIDI Manager 

eae 
MIDI Manager Port — FreeMIDI Destination 

pL 
>— [Composer's Mosaic _~ | 

Modem All Cables 

Printer All cables 

Composer's Mosaic 

CBX-DS 

Video Time Piece 

M-1 

TG77 
Semel Te fa | | 

aS 
XX Filter Timecode 

Figure 13-4: FreeMIDI MM Driver Control Panel 

4. Define up to 4 input and 10 output ports for the FreeMIDI MM Driver 

by choosing FreeMIDI devices and/or applications from the pop-up 

menus. 

You can assign multiple devices/applications to the same port by 

selecting them from the same pop-up menu. Each selection will 

be retained and indicated by a check mark in the pop-up menu. 

By default, the name of the port is the same as the device/ 

application selected. If more than one device/application is 

selected, the name is a list of all selected devices/applications 

truncated with an ellipsis. If you like, you can enter your own 

names for the ports in the text boxes in the MIDI Manager Port 

column. 

FreeMIDI MM Driver ports appear in the PatchBay window as they 

are defined. 
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5. Close the FreeMIDI MM Driver Control Panel by clicking its close 
button. 

The PatchBay window appears and the FreeMIDI MM Driver icon 

displays its input and output ports. 

PatchBay 

Figure 13-5: PatchBay Window with FreeMIDI ports 

6. Connect the outputs and inputs of your non-FreeMIDI MIDI 

Manager-applications to the FreeMIDI MM Driver outputs and 

inputs. 

You can now send and receive MIDI between FreeMIDI and your 

MIDI Manager applications. 

When the FreeMIDI MM Driver Control Panel is open in the PatchBay 

application, a FreeMIDI menu that contains some standard FreeMIDI 

commands, appears in the menu bar. 

Appendix B: FreeMIDI and MIDI Manager 185 



186 Appendix B: FreeMIDI and MIDI Manager 



Appendixc Troubleshooting FreeMIDI 

Troubleshooting Troubleshooting is always simplest and most effective when the exact 

problem can be specified clearly and concisely. If you are surprised 

by an error message or by seemingly erratic behavior in the program, 

take a moment to jot down the relevant details: exactly what the error 

message said (including any error ID numbers), what actions were 

done on-screen just before the problem occurred, what kind of file 

you were working with, how you recovered from the problem, and 

any unusual conditions applying during the occurrence of the 

problem. This may not enable you to solve the problem at once, but 

will greatly aid in isolating the problem should it recur. 

If the problem you are encountering seems inconsistent, try to 

determine what the necessary pattern of actions are that will cause it 

to occur. Genuine bugs in application software like FreeMIDI are 

almost always consistent in their manifestation: the same set of 

actions under the same conditions invariably brings about the same 

results. Determining the exact cause of a bug often requires 

experiments which replicate the problem situation with one factor 

changed: starting the program from a different disk drive, restarting 

the Macintosh with a system folder containing different versions of 

the System File and the Finder, working with a new configuration 

instead of an existing one, etc. 

If the problem is truly inconsistent, then it is likely to be a hardware 

problem: improper disk drive alignment, a loose connection, over 

long cables, signal ‘aliasing’, etc. 

The most important tools for tracking down problems are the Check 

Connections and PatchThru commands. Using these commands can 

isolate problems that stop the flow of MIDI data from your MIDI gear 

to the Macintosh and back again. 

If screen display in a FreeMIDI sequencer such as Performer is erratic or 

seems to stall and skip: You may be running into the limits of your 

Mac’s processing power. FreeMIDI gives priority to sending and 
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receiving MIDI data over most screen redisplaying. However, with 

enough of an overload you may hear delays or erratic timing in your 

music. 

Usually the overload is caused by vast reams of aftertouch (mono or 

poly key pressure), controller, or pitch bend events in one or more 

synthesizer tracks. 

To solve the problem, you must reduce the amount of MIDI 

information being passed through the modem and/or printer port in 

the following ways: 

mw Slow down the tempo of the sequence during the problem 

passages. 

ms Delete a track or tracks from the sequence. 

If FreeMIDI starts correctly, but you are unable to record (or play) anything: 

double-check your cable connections and synthesizer settings. Use 

the Check connections command to find out where the break in the 

data flow has happened. Often you will find that FreeMIDI may think 

that a certain device is connected to an incorrect MIDI port. 

If you cannot open a particular configuration file: First try opening other 

existing configuration files, or a new configuration file, to be sure 

FreeMIDI is working at all. If a file is opened and seems damaged, 

will not let you save changes, etc., you still may be able to save some 

or all of its information by using the Clipboard to copy the devices 

and paste them into another configuration file. 

If FreeMIDI Setup will not start up at all, or always brings up an irregular 

or damaged file when the FreeMIDI Setup icon is opened from the 

Finder, your working copy may be damaged. Re-install FreeMIDI 

from one of your Master disks. Restart the Macintosh and try opening 

another (new or existing) file with your new working copy to see if 

you have the same problem. Check also to see if other applications 

(Performer, MacWrite, MacPaint, etc.) are working properly. 

If one of your key disks becomes damaged and fails to work as a key, our 

Customer Support Department will be glad to replace it. See the 

Customer Support section below for more information. 
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Disk Repair S We are glad to replace damaged disks belonging to registered users. 

Please contact Mark of the Unicorn Technical support by phone, fax, 

or letter, if your disk needs to be repaired or replaced. Our Technical 

support phone number is: (617) 576-3066. Our Fax number is: (617) 

576-3609. We also provide technical support on-line with 

CompuServe. You can talk to a MOTU technical support represen- 

tative in the Section 12 of the MIDI Vendor C Forum. 

Customer We are happy to provide customer support to our registered users. If 

Support you haven’t already done so, please take a moment to complete the 

registration card in the front of the manual and send it in to us. When 

we receive your card, you'll be placed on our mailing list and sent a 

free backup key disk. 

Registered users who are unable, with their dealer’s help, to solve 

problems they are encountering with FreeMIDI may call our technical 

support line. The number is (617) 576-3066, and is staffed Monday 

through Friday 9 AM to 8 PM, Eastern Time. If you decide to call, 

please have your FreeMIDI manual at hand, and be prepared to 

provide the following information to help us solve your problem as 

quickly as possible: 

a The serial number of the program. This is printed on the 

cardboard page (at the front of the manual) which holds 

the registration card. Be sure to retain this page in the 

manual for your reference. You must be able to supply this 

number to receive technical support. 

= The version of FreeMIDI you are working with. This is 

displayed briefly in the start-up screen when FreeMIDI is 
started; it is also available through the About FreeMIDI 

command on the Apple menu from within FreeMIDI. 

a A brief explanation of the problem, including the exact 

sequence of actions which cause it, and the contents of 

any error messages which appear on the screen. It is often 

very helpful to have brief written notes to refer to. 

= The pages in the manual which refer to the parts of the 

program which you are having trouble with. 
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= The version or creation date of the system software you are using 
to run the Macintosh. See the Installation Guide for help in 

finding version numbers for the system software. 

We’re not able to solve every problem immediately, but a quick call 

to us may yield a suggestion for a problem which you might 

otherwise spend hours trying to track down. 

Our technical support telephone line is dedicated to helping 

registered users solve their problems quickly. In the past, many 

people have also taken the time to write to us with their comments, 

criticism and suggestions for improved versions of our software. We 

thank them; many of those ideas have been addressed in this version 

of FreeMIDI. If you have features or ideas you would like to see 

implemented in our music software, we’d like to hear from you. 

Please write to the FreeMIDI Development Team, Mark of the 

Unicorn Inc., 1280 Massachusetts Avenue, Cambridge, MA 02138. 

Although we do not announce release dates and features of new 

versions of our software in advance, we will notify all registered users 

immediately by mail as soon as new releases become available. If you 

move from the address indicated on your registration card, please 

send us a note with your change of address so that we can keep you 

informed of future upgrades and releases. 
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Chapter 1 About This Guide 

Performer Getting 
Started Booklet 

Performer Reference 

Manual 

Digital Performer Guide 
to Digital Audio 

This guide is one of three that ship with Digital Performer. All three 

guides are summarized below. 

The Performer Getting Started book contains basic installation and 

setup information. It tells you how to install Performer and set up 

FreeMIDI. It provides a brief overview of Performer’s main features 

(including recent new ones), as well as two extensive tutorials. One 

tutorial takes you step-by-step through the process of recording your 

first MIDI track. The second tutorial shows you step-by-step how to 

build an entire song, while introducing you to a number of basic 

tasks such as quantizing and step recording. 

This book is ideal for anyone who is new to Performer and would 

like a quick look at “the lay of the land”. 

The Performer Reference Manual contains all the chapters having to 

do with Digital Performer’s MIDI capabilities. If you are already 

familiar with Performer, you can consider this to be an up-to-date 

reference for Performer’s MIDI features, and you can turn to the 

Guide to Digital Audio (described below) for information about audio 

features that are unique to Digital Performer. 

The Digital Performer Guide to Digital Audio contains all information 

having to do with Digital Performer’s audio capabilities, including an 

overview, tutorial, and troubleshooting chapter written exclusively 

for audio features. In addition to being an audio reference, this book 

is ideal for anyone who is already familiar with Performer and would 

like information about Digital Performer’s audio features. 

The guide to digital audio is divided into three parts: 

Part I: What's New 
This section contains a brief overview of new audio features in 

Version 1.6, as well as a chapter documenting the new Movie 

window, which provides synchronized digital video playback with 

audio and MIDI. 
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Part Il: Tutorials 
This section provides a brief overview of audio features in the form 

of a guided tour through the demo project that ships with Version 1.6. 

It also provides a chapter on digital audio basics for those who are 

new to random access digital audio recording. 

Part Ill: Digital Audio Reference 
This section contains complete documentation on all of Digital 

Performer’s audio-related features. 

About This Guide 



Chapter2 About Digital Perfor, mer 

Overview 

Integration with 
Performer’s existing 
interface 

Digital Performer™ provides a powerful new approach to making 

music in the MIDI era: it integrates MIDI with desktop digital music 

production on the Macintosh computer. Digital Performer allows you 

to simultaneously record and play back multiple tracks of digital 

audio and MIDI data in a comprehensive, totally integrated, creative 

environment. Digital Performer’s award-winning multitrack 

sequencer design, combined with new non-destructive digital audio 

editing capabilities, provide you with unprecedented flexibility and 

control over the music that you make. 

Digital Performer supports the following Digidesign hard disk 

recording systems: 

a» Audiomedia 

a Audiomedia II 

mw» Audiomedia LC 

sw Sound Tools II 

= Pro Tools (4 - 16 channels) 

= Pro Tools III (16 - 48 channels) 

s TDM and TDM-compatible software plug-ins 

In developing Digital Performer, we have integrated audio features 

into Performer’s existing features in a way that complements 

Performer’s unique user interface—and accommodates those of you 

who are already familiar with Performer. In fact, many features in 

Performer work on audio data in exactly the same way as MIDI data. 

For example, soundbites (parcels of audio data) have on-velocities 

just like notes. You can edit them in the same way as you edit note 

velocities. Soundbites can be cut, copied, and pasted in exactly the 

same fashion as MIDI note data. 
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If you are not familiar with hard disk recording and playback, there 

are aspects to Digital Performer that may be entirely new to you. If 

so, we recommend that you review chapter 6, “Hard Disk Recording 

Basics” (page 47) for a briefing on concepts that are crucial for 

working with Digital Performer. 

Digital audio Digital Performer records professional, CD-quality monophonic 

specifications digital audio at whatever sampling rates are offered by the recording 

hardware being used. Digital Performer can record in stereo by 

recording into a pair of audio tracks. Recording with Digital 

Performer produces approximately 5 Megabytes of data per minute of 

monophonic audio at 44.1 kHz (10 megabytes per minute of stereo). 

Digital audio data can be backed up and mixed down to any standard 

digital audio medium. 

File formats Digital Performer generates 16-bit, Sound Designer II files at any 

available sampling rate. It can load and play back files in the 

following formats: Sound Designer, Sound Designer II (mono), and 

Audio IFF. 

12 About Digital Performer 
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Chapter3 New Features in Version 1.6 

All new features Digital Performer 1.6 has all of the new features introduced in 

introduced in Performer Performer Version 5, including color, Groove Quantize, and more. 

Version 5 Features new to version 5 are summarized in chapter 2, “What’s New 

in Performer® 5” (page 13) of the Performer Getting Started book. 

Movie Window for digital Digital Performer 1.6 can play back QuickTime movies. See 

video playback chapter 4, “The Movie Window” (page 27). 

Using the mouse to edit You can now change number or note values in text edit boxes 

values in text boxes throughout the program by clicking on the text box and dragging up 

or down. You can also still edit text box values in the usual ways (by 

typing, etc.) 
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Support for the Digital Performer Version 1.6 has been completely re-engineered for 

Digidesign Audio Engine the Digidesign Audio Engine (DAE). DAE handles the core tasks of 

(DAE) interacting with the Digidesign audio recording hardware. Digital 
Performer’s support for DAE provides support for: 

gs Pro Tools III (16-48 tracks) 

m Pro Tools (4-16 tracks) 
DAE 

m= 4 independent audio inputs/outputs in Sound Tools II 

systems 

m» Audiomedia LC support 

= Complete support for TDM 

= Future compatibility with Session 8 

Support for TDM Digital Performer’s TDM-related features allow you to mix and 

process audio tracks with TDM plug-ins if you have a Pro Tools I with 

TDM or Pro Tools III hardware setup. TDM effects are accessed via 

the effects inserts in the new Mixing Board window (described later). 

pananrnneti The number of effects that you can apply simultaneously depends on 

TBM Plug-Ins the amount of DSP processing hardware you have in your system. 

The example below shows Digidesign’s 4-band EQ plug-in. 
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Multi-track graphic 
editing window for audio 
tracks 

There is now one graphic editing window for all audio tracks in a 

sequence. In the window, you can quickly display and hide any 

combination of the audio tracks in a sequence. In addition to many 

other advanced graphic editing features, this window displays and 

edits audio volume, audio pan, and loop data directly on top of the 

audio waveforms in each track as shown in the example below. 

New Features in Version 1.6 Pa 



The Mixing Board The new Mixing Board window has channel strips controlling 

window: totally volume, pan, inserts, solo, mute, and automation for every audio and 

integrated mixing, EQ, MIDI track. You can configure this window to display all or any 
and effects combination of the tracks in a sequence, and you can save board 

layouts for instant recall. Volume and Pan are available for both MIDI 

and audio tracks. Effects are available for all MIDI tracks and all audio 

tracks Gif the hardware supports audio effects). Choosing an effect 

from one of the insert pop-up menus opens the Effects window. 

Figure 3-1: The Mixing Board and 
Effects windows. 
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Effects window The Effects window can be accessed by choosing the desired effect 

from the channel insert pop-up menus in the Mixing Board as shown 

in Figure 3-1 on page 18. The Effects window provides access to all 

third-party TDM plug-ins you have in your system, as well as MIDI 

processing parameters for MIDI tracks. 

MIDI output processing MIDI tracks can now be non-destructively processed with MIDI 

“effects”. This means that you can transpose a track on the fly, for 

example, without affecting the original data in the track. MIDI 

processing is located in the effects section of the new Mixing Board 

window. This new feature offers two initial effects: transposition and 

velocity compression. Look for many other MIDI processing modules 

in future versions of Digital Performer, including quantizing, shifting, 

and many more. 
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Improved audio file Digital Performer offers improved sound file management. Audio files 

management and for a Digital Performer project are stored in an automatically created 

organization Audio Files folder. You can store the audio files wherever you want— 

even on a different hard drive—and Digital Performer will keep track 

of them by placing System 7 aliases in the folder. Digital Performer 

keeps better track of audio files by taking advantage of other System 

7 file management enhancements. 

24 = New Project. 
2 items 230.6 MB in disk 11.5 MB availa 

Su , » « 

Album Project Audio Files 

Figure 3-2:A typical Digital 
Performer recording project. 

Audio scrubbing Version 1.6 offers scrubbing in soundbites by command-dragging 
inside a pop-edited soundbite as shown below. 

Scrub wiper “Scrub wheel” cursor 

You can now scrub audio by 
command-dragging within a 
pop-edited soundbite. 
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Scrubbing while 
selecting 

Adjusting soundbite 
boundaries 

New Features in Version 1.6 

When you are selecting a region of audio within a soundbite, you can 

scrub the audio as you select to get auditory feedback of what you 

are selecting. 

While scrubbing, you can 
hold down the shift key to 
select as you scrub to 
quickly make precise edits. 

The boundaries of soundbites can now be freely adjusted by 

dragging the endpoints of the soundbites. The waveform is 

“uncovered” or covered as you drag to show more or less of the 

audio data in the audio file. 

You can now adjust the 
endpoints of soundbites 
by dragging. 
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Dragging and dropping 
soundbites 

Soundbite “throwing” in 
the Graphic Editing 
window 

Enhancements for 
selecting and editing 
inside soundbites 

22 

You can drag and drop soundbites from the Soundbites window into 

the Tracks Overview, Event List window, and the Graphic Editing 

window. In the Graphic Editing window and Tracks Overview, use 

the command key while dragging to place the soundbite at the end 

of the previous one to quickly build a playlist. 

By command-dragging soundbites in the Graphic Editing window, 

you can “throw” them to the edge of the next or previous soundbite. 

You can achieve a similar effect by dragging soundbites from the 

Soundbites window into an event list, which drops the soundbite into 

the track at the end of the last soundbite. 

Many enhancements have been made to select and edit audio within 

a pop-edited soundbite. For example, you can now scroll and zoom 

the window as needed while the soundbite remains popped up. You 

can even do so with a portion of the soundbite highlighted. You can 

also cut, copy, or erase a highlighted region within a soundbite. 
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Enhancements to the 
Audio Monitor window 

The patch thru feature has been 
moved to the title bar so you can 
easily see if it is turned on or off. 

The Audio Monitor has numerous small enhancements to improve its 

usefulness during a session. 

New record time column shows the 
amount of available recording time in 
minutes or amount of free hard disk 
space. Click to toggle the display. 

The level meters The takefile for the currently record- New Take Folder column shows 
now have an adjust- — enabled track appears in regular type; all the location of the takefile. Click 

able range from other channels appear in italics so you to toggle between full and 
-42 dB to -6 cB. can easily see which one is currently abbreviated path name. 

record-enabled. 

Edit on Zero Crossings 
command 

New Features in Version 1.6 

You can now control whether Digital Performer will automatically 

find zero crossings when you edit soundbites with commands such as 

cut, copy, split, trim, etc. Turning off Edit on Zero Crossings mode 

gives you greater precision. Turning it on helps avoid noise artifacts 

at edit boundaries. 
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MIDI Time Code Digital Performer can now transmit MIDI Time Code to any piece of 

Generation MIDI hardware in your setup via the Transmit Sync command in the 

Basics menu. It can also transmit MTC to other applications running 

at the same time as Digital Performer when Inter-application MIDI is 

turned on in FreeMIDI Setup preferences (File menu). 

MTC is generated at the SMPTE frame rate specified for the current 

file except when Digital Performer is set to Slave to External Sync and 

is receiving MTC. In this case, incoming MTC is echoed directly. 

To generate MTC: 

1. Choose Transmit Sync from the Basics menu. 

2. Choose a destination for MTC from the pop-up menu. 

You can choose more than one destination by clicking on the 

menu as many times as needed. Choose the destination again 

from the menu to turn off MTC transmission. If Inter-application 

MIDI is enabled in FreeMIDI Preferences (FreeMIDI Setup, File 

menu) you can send MTC to other FreeMIDI applications 

(including OMS applications, if OMS Emulator is installed). 

Frame Rate command in You can now set the SMPTE frame rate for a file using the Frame Rate 

the Basics menu command in the Basics menu. When you choose this command, a 

hierarchical menu appears containing the various supported SMPTE 

frame rates. Choose one and it will change the SMPTE frame rate for 

the current file. This has the same effect as setting the SMPTE frame 

rate from within the Receive Sync dialog. 
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Improved audio track 
muting and soloing 

Soundbite names can be 
edited in edit windows 

Audio faders now 
animate during playback 

New preferences 

New Features in Version 1.6 

Audio tracks now mute and solo faster than previous versions. When 

muting, the response is instantaneous. When unmuting, the response 

depends on whether the DAE still has audio data to play. If it does, 

then the response is instantaneous. If not, then there is a delay while 

the DAE reloads its buffers. 

Option-click to pop-edit soundbite names now in the event list 

window and in the graphic editing window info bar. 

Audio faders in consoles now animate during playback to reflect 

audio volume and pan controller data in the track. Faders for audio 

tracks in the Mixing Board also animate during playback. 

There are several new audio-related preferences. You can set 

preferences in by choosing Preferences from the File menu. 

Preference 
$ F, 
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Chapter 4 The Movie Window 

Random access digital 
picture 

QuickTime 2.0 (or 
higher) is required 

Opening and closing 
movies 

Digital Performer’s Movie Window provides synchronized playback 

of a QuickTime Movie with both MIDI and audio tracks in a 

sequence. 

QuickTime movies provide a quantum leap in flexibility and 

convenience over the process of synchronizing to video decks 

because QuickTime movies give you random access picture—just 

like digital audio. Here are just a few example benefits. You can: 

w Instantly locate to any spot in the movie 

m Advance forwards or backwards one frame at a time 

through the picture and music 

= Scrub forward or backward 

= Seamlessly loop both picture and music 

And all of this can be done without the hassles of slaving to external 

time code. The time you save and the flexibility you gain more than 

make up for the cost of digitizing your film, video, or other media. 

The Movie command is grayed out if you do not have QuickTime 2.0 

or later properly installed in the Extensions Folder inside your System 

Folder. 

The Movie Window command in the Windows menu opens a 

QuickTime movie in Performer. To open a movie, choose this 

command to get a standard Macintosh Open dialog box. You may 

choose any QuickTime movie file, or any other file which QuickTime 

knows how to convert to a movie. 

You may close the Movie window, and Performer will still remember 

which movie file you opened -- this information will be saved with 

the file. To reopen the movie, just choose Movie from the Windows 

menu again. 

at 



Movie controls 

The Lock button 

Volume slider 

Play/Stop button 

Slider 

Step buttons 
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To close the movie permanently so that Performer forgets about it, 

chose Close Movie from the mini-menu. 

If you have a movie open and want to choose a different movie, 

choose Open Movie... from the mini-menu. Only one movie may be 

open at a time. 

Here is an overview of the controls in the movie window: 

Lock button 

Volume Play/Stop Slider Step Grow box 
Buttons 

If the lock button in the movie window’s title bar is on, the movie is 

locked to Performer’s transport. The movie will slave to Performer as 

you play, stop, and locate. Conversely, you can use the movie 

controls at the bottom of the movie window to control Performer. If 

the lock button is off, you can control the movie and Performer’s 

sequences independently. This is useful if you want to preview a 

movie without synths blaring, wipers scrolling, and so on. 

The volume control allows you to set the playback volume for the 

movie’s audio track. If the movie has no sound, there will be no 

volume control. Option-clicking will mute or unmute the movie’s 

sound. Shift-clicking lets you “overdrive” the volume up to 300%. 

The Play/Stop control toggles between playing and stopping. Also, 

clicking the movie itself will stop; double-clicking will play. 

The slider shows where in the movie you are, and can be used to 

“scrub” the movie or to set your location in the movie. 

The step buttons move forward or backward through the movie one 

frame at a time. Note that this means movie frames, not SMPTE 

frames. A movie may have 15 fps, 30 fps, or even a number which 
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Grow box 

Movie window mini- 

menu commands 

The Movie Window 

varies throughout the movie. Option clicking moves to the beginning 

or end of the movie. The left and right arrow keys will also work if 

the window is in front. 

The grow box works as usual, with these additions: 

= Holding down the option key while resizing the window 

constrains the window to a “good” size, meaning one 

which QuickTime is able to playback efficiently. This 

means one quarter, half, three quarters, full size, double, 

triple, etc. 

» Holding down the shift key while resizing the window 

keeps the aspect ratio correct at any size, but the movie 

is not likely to play back efficiently. 

Open Movie: Presents you with a standard Macintosh Open dialog box. 

You may choose any QuickTime movie file, or any other file which 

QuickTime knows how to convert to a movie. You can use this 

command to switch to a different movie. 

Close Movie: Closes the movie permanently, so that Performer forgets 

about it. 

Set Movie Start Time: Allows you to set the SMPTE time which 

corresponds to the beginning of the movie. If you want the movie to 

start at the beginning of the sequence, this should be set to the same 

time as the SMPTE chunk start time. You may need to try adjusting 

the start time by +40 time code bits if you find that the frames in the 

movie don't precisely line up with the frame numbers in Performer's 

counter. 

Use Movie’s Color Table: Movies can have preferred color tables stored 

inside them. If the movie window is on a screen in 256-color or 16- 

color mode, and the movie has a color table, this item will be enabled 

(not grayed out). If you check it, Performer will use the movie’s color 

table whenever the movie window is open, giving Chopefully) truer 

colors. 

Half Size, Normal Size, and Double Size: Resize the window. One of 

these may be checked if the window is already that size. 
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Improving the QuickTime can tell if it has the power to play all the frames in the 

performance of the movie. If not, it drops one or more frames, but keeps playing at full 

movie window speed. So a movie with 30 fps in it might play at 30 fps on a fast 

machine, but only at 15 fps on a slow machine, dropping roughly 

every other frame. 

The following things may hinder the computer’s ability to play a 

movie back smoothly: 

= Larger movies (in pixels) 

= Movies with higher frame rates 

mw Playing the movie from slower drives, e.g. a CD-ROM 

drive 

m Resizing the window to non-optimal sizes (not double, 

full, or half size) 

mw Having many other open windows with scrolling wipers, 

auto scroll, level meters, etc. 

Avoiding these things will help your movies play back more 

smoothly. 

Movie audio while The Movie window’s audio track is automatically disabled in Slave to 

slaved to external sync External Sync mode. The volume control will disappear in this case. 
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Chapters A Guided Tour of Digital Performer 

An overview of audio 

features 

Following along in 
Digital Performer 

Have you seen the 
Performer picture-book 
tour yet? 

Before you begin... 

This chapter provides an overview of Digital Performer’s audio 

features in the form of a guided tour through a typical Digital 

Performer recording session. 

The tour begins by opening the demo file that ships with Digital 

Performer 1.6, allowing you to get “hands-on” in front of your 

Macintosh. If you aren’t at your computer, don’t worry: you can still 

get just as much out of this chapter, which provides a great 

introduction to Digital Performer’s extensive audio features. 

This tour is similar to the Picture-book Tour of non-audio Performer 

features in the Performer Getting Started Booklet (starting on 

page 69), which provides a brief overview of Performer’s essential 

features. If you are new to Performer and have not yet reviewed the 

Picture-book Tour, we strongly recommend doing so before reading 

this chapter because it will help you place the audio features shown 

here in context with the rest of the program. 

The tour assumes that you have successfully installed Digital 

Performer as described in the Version 1.6 Installation Guide booklet. 

This includes creating your FreeMIDI configuration. If you haven’t yet 

done so and you plan to follow along in the Digital Performer, refer 

to the installation guide before proceeding. 
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Opening and playing the To open the Digital Performer 1.6 demo file, look for it in the Digital 

demo music Performer folder as shown below and double-click the file icon. 

lf you have trouble playing, or you 
When the device mapping 
dialog appears, choose a 
general MIDI synth in 
your studio. 
If you don’t have one, just 
choose any multi-timbral 
synth or sound module, in 
which case the MIDI tracks 
may not play back with the 
proper sound at first. The 
diagram below shows how 
to choose another sound on 
your synth for each track. 

don’t hear anything, see chapter 20, 
“Audio Troubleshooting” (page 225). 

Open the demo file by 
double-clicking the file icon. 
The file is located in the DP 1.6 
Demo oe oie 

8 iterns 

; Hee 
Digital Performer™ 1.6 OP 1.6 Derno Project 

DRUMTRAX files MMC-88/DA-88 Consoles Grooves 

SimpleText ProMix 01 file: 

Look over the diagram below and then press the play button to start playback. 
This sequence has four audio tracks at the top of the track list assigned to audio voices 1, 2, 3, and 4. The audio tracks contain repeated, 
single-measure audio ‘soundbites’ of a drum loop, a ‘scratch’, and crowd noise. Notice that the soundbites are repeated many times. To 
experience the power of random access disk-based audio, use the markers to instantly locate anywhere in the music. 

To stop playback 
Click stop & rewind. 

To start playback ” @ File Edit Region Basics e Windows 

Click the play button, 
(= 

Counter 
Shows the current bar and beat during playback. 

pge Windows Audio Help. gw 

: Markers 
i. Ry a i Identify important 

- locations in the 

music. Click on the 

bar to instantly skip 
around in the music. 

Audio track 
Appear here in the 
track list along with 
MIDI tracks. a 

MIDI tracks = 
Appear with the as ttt er arias 
device they are 

assigned to here. Audio level meters 
Show the input level 

MIDI track sounds for each audio input 
ifthe MIDI tracks Say raresre arrears = in your hard disk 
don’t play withthe =| z 1 recording hardware. 

correct instrument, 
drag this handle to 
the right and 
choose a sound 

from the “Default 

patch” menus. Audio display 
The audio graphic 
editor shows the 

audio data in all of 

the audio tracks in 

the sequence. 

Playback wiper 
Shows the current Soundbites 

playback location. Regions of audio like these are called ‘soundbites’. 
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Audio tracks in the Digital Performer records and plays audio in audio tracks, which are 
Tracks window located in the Tracks window alongside MIDI tracks. You can create 

an unlimited number of audio (and MIDI) tracks, giving you as many 

For more information, see chapter 7, “virtual” tracks as you want for alternate takes, different mixes of the 

“Audio Track Basics” (page 59). same audio, and more. Depending on your hardware, there are limits 

to the number of audio tracks you can play and have active at one 

time. 

Many of the actions you take in Digital Performer apply to the 
ae Click the title bar of the tracks window to activate the window. 

active window. Notice that the window’s borders are fully detailed 
Zoom the Tracks window. when it is active, and the other windows are not. 
The zoom button expands the window 

so that it displays all the tracks and 

fills the entire width of your screen. Time ruler Selecting data allows you to edit 
me oe — This is one of Digital Performer's Each column represents one MIDI and audio tracks together. 
and. Ard Audio Track many convenient shortcuts. measure. Clicking selects the Try dragging over track segments 
commands here in measure for editing. Use the to select them. You can apply edit 
the mini-menu. Opening tracks magnifying glass buttons in commands such as cut, copy, snip, 

Double-click track names the scroll bar below to zoom in and splice. 

to see the data inside. and out. 

Audio track assignments MIDI sounds Track list Tracks overview 
Press here to see the audio hardware Thesoundsyouseein Shows all audio Graphically shows 
input, output, and voice assignment = these pop-up menus _and MIDI tracks. what is in each track. 
pop-up menus for each track. The may be different than 
number of inputs, outputs and voices _ what you see here Drag this handle to show more or less 

you see in the menus depends on because you have a of the track list on the left and the 
your hard disk recording system. different MIDI synth. es tracks overview on the right. 

Zoom the window back. 
Click the zoom button in the title bar 

again as you did in step 2 to shrink the 
window back to its original size. If it 
doesn’t (because you dragged the 
window’s grow box at some point), 
use the grow box to do this (it’s in the 
lower right corner of the window). 
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Audio graphic editing Digital Performer gives you hands-on, precision control of digital 

audio data in the multitrack graphic editing window. Here, you will 

insert a volume curve, scrub audio, and much more. For more information, see chapter 13, 
“Audio Graphic Editing” (page 125). 

Click the track list button to 
open the track list. 
The track list lets you quickly show 
and hide audio tracks simply by 
clicking their name. Try it. 

Turn off Edit Resolution. 
Edit resolution causes dragging 
Operations to ‘snap’ to a precise 
grid. For now, let’s turn it off by 
unchecking the check box. 

Expand the graphic editing window. 
Click its title bar and then click the zoom 

button. The controller grid appears below 
the soundbites. 

Display volume for the ‘scratch’ track. 
Choose ‘volume’ from this track display 
pop-up menu. 

Click on the line to create a point and 
drag it down to lower the volume. 

Create a volume curve. 
Now let’s create a volume curve. Click the 

Volume/Pan curve button in the title bar. 

The cursor turns into a cross hair. 

Drag here to insert the line tool. Press return to insert the curve. 
After you insert the line tool, drag the A series of individual volume 
red (or black) handles on the line tool events are inserted in the track in 
to give it any shape you want. the shape of a smooth curve. 

Moving and ‘throwing’ soundbites. 
Try grabbing the first ‘Crowd’ soundbite and dragging it to the left to make it play 
earlier as shown below. (You can also drag soundbites vertically between tracks.) Remove the curve you just inserted. 

To do so, grab the point you inserted in Now try ‘throwing’ the soundbite back to the edge of the soundbite to its right. To 
step 5 above and drag it to the right to do so, command-drag a short amount to the right and then let go. The soundbite 

“wipe out” the curve. Now delete the point ‘snaps’ to the edge of the next soundbite to its right. 

itself by command-clicking it. 
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Trim the soundbite. 
Now try trimming the soundbite. Place the 
mouse cursor over the left or right edge of 
the soundbite and drag towards the 
middle of the soundbite to make it smaller. 

Notice that all instances of the soundbite 

Undo the Trim. 

Now undo the 

trim so that we 

Make a copy while trimming. 
13) Trim the soundbite again, but this time, hold down the 

option key while grabbing the edge of the soundbite. When 
you finish trimming, notice that a number is added to the 
end of the soundbite name to indicate that it is an entirely 
new soundbite based on the original, leaving the original 
untouched—as well as all other instances of the original. 

can do it again, 
but slightly differ- 
ently. Choose 
Undo Trim from 

Crowd 

Turn on Audible Mode and 

audition the soundbite. 

Click the Audible Mode button in 

the title bar so that it turns yellow 
(or black). To audition the sound- 
bite, press on it. It will continue to 

play as long as you press. 

. ‘Gruve Loop 

Shift-click and shift-drag to 
extend or shorten the 

selection. 

You can shift-click near either 

edge of the selection. You can 
even shift-drag. Turn Audible 
Mode on or off as desired. 

18 

Gruve Loop 
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Scrub wiper 

the Edit menu. 

Double-click the soundbite to 

@® ‘pop up’ the waveform inside. 
Doing so allows you to select a 
portion of the waveform in the 
soundbite, as apposed to clicking 
the soundbite, which selects it as 
a whole. 

Gruve Loop 

Command-drag to ‘scrub’ the audio 
waveform. 
The scrub wiper indicates the current 
scrub location. The ‘scrub wheel’ cursor 
position determines speed (up to 2 times 
normal). Drag farther to play faster; drag 
closer to the wiper to play slower. 

Scrub wheel 

cursor 

Crowd 2 

Drag inside the soundbite to 
select a portion of the waveform. 
You can select any portion of the 
waveform you want. Notice that what 

you select plays as soon as you 
release the mouse. If you don’t want 
this, turn off Audible Mode. 

Gruve Loop 

@® Command¢-shift drag to scrub while 
selecting. 
You can scrub and select at the same 

time to hear what you are doing as you 
make accurate selections. You can 

Zoom in also zoom in for finer resolution. 
button 

Zoom back the graphic editing window and 
2.0) open the track’s event list. 
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Integrated, automated Digital Performer has powerful MIDI and audio mixing features that 

mixing for audio and allow you to automate a mix-down for both types of tracks in one 

MIDI tracks seamless environment. The tools for mixing audio and MIDI data are 

one and the same to save you time on the learning curve. Perhaps the 

most powerful mixing feature is Digital Performer’s Mixing Board 

“The Mixing Board” (page 175). window, which gives you animated faders and knobs in a console. 
For more information, see chapter 15, 

Rewind to the beginning and Adjust individual faders. Open the Mixing 
as Board window. start playback. Try both audio and MIDI tracks. These faders 

Choose Mixing You'll see the faders animate at generate audio volume controllers and MIDI 
Board from the the beginning, and you'll see the volume controllers (#7), which are recorded into 
Windows menu. level meters pump during the track they monitor. You can automate your 

playback as well. entire mix right from this window. 

Glide across the Solo and 
Mute buttons. 
Drag across a row of buttons 
to enable or disable a group 
of tracks quickly. This allows 
you to ‘ride’ the mix, making 
quick changes to groups of 
tracks in real time. 

5 Open the track list 
Just like in graphic “4 
editing, you can 
quickly show and 
hide tracks simply by 
Clicking their name. 

Change the board layout quickly and easily. Go back to a full console. 
Try this. Hold down the option key and choose Faders from the Mixing Board window mini-menu. You To instantly display all sections 
instantly see faders only. You can show and hide any section you want — on a dime. Just check or and tracks, command-click title 
uncheck it in the mini-menu. You can even save your favorite board layouts for instant recall. bar as shown below and 

choose Show Everything from 
the pop-up menu. 

how Everything 
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MIDI output processing The Mixing Board window provides real-time MIDI output 

and integrated audio processing effects such as velocity compression and note transpo- 

effects sition. In addition, it provides access to built-in EQ (on Digidesign 

systems that have it), the powerful TDM bus Gf you have it), and all 

third-party plug-ins that you have installed in your TDM system. All 

of these features are accessed via effects inserts in the Mixing board, 

which open the Effects window shown below. 

Open the velocity compressor. 
To do so, press on one of the two pop-up 

Choose an audio effect. 
This is done in the same fashion: choose the 

menus above the Slap Bass track (or any effect from one of the pop-up menus above 
other MIDI track) and choose Velocity the audio track. If you have a TDM system, 
Compressor from the menu. you'll see plug-ins as shown below. 

Use the threshold, ratio, and 

gain controls to affect the 
graph, which shows the 

resulting compression. 

Some Digidesign systems 
offer built-in EQ, which is 

accessed via this effects 

window. 

Close the Mixing Board by 
clicking its close button. 
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The Audio menu 

For more information, see chapter 14, 

“Editing Audio” (page 157). 

The audio menu serves as a central location for many of Digital 

Performer’s audio features. 

~ @ File Edit Region Basics Change Windows [itm Help | = —=7 

Divides a soundbite into 
smaller pieces so you can 
edit them separately. 

Removes unwanted 

portions of audio. 

Digitally mixes as many audio 
tracks as you want down to one 
channel (or two as a stereo 
pair). You can use Mix to build a 
composite of pieces from many 
takes; you can also use it to 
hear many tracks at one time. 

These commands help manage 
soundbites in their parent audio files 

on disk. 

Provide options for configuring your 
hardware, such as global sample rate for 
recording and playback. 
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“Edit on Zero-Crossing$ #E 

Split 364 

Trim 

Strip Silence..: 

Min... 

Reload Soundbite 

Replace Soundbite... 

Edit in Waveform Edito 

Configure Hardware... 

Configure Buffer Size... 

Soundbites } 
“Audio Monitor 

“hed Sune fo Time Code 

This command is grayed out unless 
you are slaving Digital Performer to 
SMPTE time code via MTC, DTL, 
or DTLe. For more information 

about it, see chapter 17, 

“Synchronizing Audio to SMPTE 
Time Code” (page 213). 

Helps avoid clicks and pops at audio 
soundbite boundaries when you edit 
them. Unchecking it gives your edits 
greater precision. 

Removes periods of silence from a soundbite, 
which take up unnecessary space on your 
hard disk. Acts just like a noise gate. The 
resulting pieces can be edited separately. 

“Hey! Watch Out!” 

Takes you directly into another program such 
as Sound Designer II, which allows you to 
perform destructive waveform editing opera- 
tions like ‘pencil tool’ editing of digital audio 
samples and DSP operations such normalize, 
reverse, time dilation, etc. 

These commands open the Soundbites 

window and the Audio monitor, which are 
covered next in the guided tour. 
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Preparing for recording The Audio Monitor provides important information about the audio 
in the Audio Monitor files that you generate on disk when recording in Digital Performer. 

It is crucial to the process of recording audio. 

For more information, see chapter 9, 
“The Audio Monitor” (page 85). 

Expand the Audio monitor window Notice that input 1 is record-enabled. 
= by clicking its title bar and clicking Zz Input 1 is record-ready because the audio track named ‘Record 

the zoom button. Audio Here’ is record-enabled in the Tracks window. (Its button is 
The number of audio channels you red or black.) The other takefile names are italicized to show that 
see in this window depends on your they are not record-enabled. 
audio hardware. 

The Take Folder shows you 
the location of the takefile. 
Click it to toggle between 
abbreviated name and full path 
name. 

Patch Thru button 
This button causes signal received on the 
record-enabled input to be patched thru to 
the audio hardware’s output. 

Set the range for the level meters. See how much record time you have available. 
The Level Range command in the The available record time on your hard disk is shown in minutes 
mini-menu lets you choose the and seconds. Click the time available to toggle between 
dynamic range for the meters. You minutes:seconds and megabytes on disk. 
can change it any time. 

Zoom the audio monitor 
back to its original size. Other commands 

The other commands you see in 
this mini-menu can vary depend- 
ing on your hardware. 
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The audio event list The audio event list gives you precise, numerical control over the 
audio data in audio tracks. It looks almost exactly like a MIDI track 

event list, and it works identically, too. 
For more information, see chapter 12, 
“The Audio Event List” (page 117). 

Open the event list. 
There are many ways to do 
this. One way is to click the 

In the event list, double-click a soundbite velocity to 
pop-edit it and type in a new velocity between 0-127. 
Soundbite velocities affect the soundbite volume. The 

soundbite called ‘gruve loop’ even list gives you precise numerical control over them, 
and then choose Event List as well as the soundbite’s attack time. Note, however, 
from the graphic editing that this numerical information is also available in the info 
window mini-menu. bar of the graphic editing window. 

Close the event list. 
To do so, click the 

close button in the 

title bar. 
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Cataloging audio and 
building playlists in the 
Soundbites window 

For more information, see chapter 10, 

“The Soundbites Window” (page 93). 

Import an audio file or 
soundbite. 
Click the Import button to 
open the audio import dialog 
box. This dialog allows you 
to import any audio file or 
any region inside an audio 
file into Digital Performer. 

soundbites into it. 

“Record Audio Here”. 
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Open an event list to “drag and drop” 

You can quickly place soundbites end to end 
in a track by dragging and dropping them into 
an event list or Graphic Editing window. To 
open an event list for an empty track, 
command-double-click the track called 

The Soundbites window serves as a catalog of all the soundbites 

(audio regions) in the file. It tells you the duration, sample rate, 

number of channels, and parent audio file for each soundbite. 

Bring the Soundbites window to the front by 
choosing its name from the Audio menu. 

Click a soundbite’s name to hear it. 
Ss) Unlike the Graphic Editing window, 

you just click on the name. You don’t 
have to keep holding the mouse down. 

Click here to 
toggle the parent 
audio file display 
between name 
only and full path. 

Turn on Audible mode, if 
it isn’t already on. 
The button should be 
yellow (or black). 

Drag the ‘Gruve Loop’ soundbite by its 
handle anywhere on top of the event list 
window to build a playlist. 
A playlist is a series of soundbites placed 
end to end to create the effect of continuous 

playback. Try dropping 8 or more copies. 

Solo the track with the solo 

button in the event list title 
bar and press the play 
button to play back what 
you have done. 

Stop playback, turn 
off solo mode, close 

the event list, and 

close the Soundbites 

window. 
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Get quick answers with 
on-line help 

Digital Performer’s on-line help feature offers you quick answers. 

You can get help on just about everything, including windows, menu 

items (even grayed out ones), and buttons and other options in 

dialog boxes. Try getting help on a few things as shown below. 

Hold down the command, option, and shift keys 
together to get the help cursor shown below. 

I © 

~ @ File Edit Region Basics Change Windows Bitte Help 

“Edit on Zero-Crossings #E 

Split a6 ¥ 

Trim 36 U 

Choose ‘Trim’ from the Audio menu. 

A help window for the Trim command appears, 
although Digital Performer may ask you to locate 
the help file first (if it is not currently located in the 
same folder as Digital Performer.) 

Duplicate 

Reload Soundbite 

Replace Soundbite... 

Fdit ‘- Wlayeform**" 

Tram allows you to remove portions of a soundbite that you don’t want. For example, you 

might want to extract a single measure from a soundbite that is 3 measures long. Or you 

might want to trim off a little bit of unwanted noise at the end of a soundbite. 

Read the help and then 
click anywhere to make 
the window disappear. 

To trim a soundbite, select the portion of the soundbite you wish to trim. Use the edit bar in 

the tracks window, or double-click the soundbite in the Graphic editing window to pop-edit it. 

Or highlight the desired time region in the time ruler of the Graphic Editing window. ‘when 

selecting, choose a start and end point that is as close to zero as possible to avoid clicks and 

pops at the end points of the new soundbite. Next, choose Trim from the Audio menu. All of the 

non-highlighted material in the soundbite is removed, and the highlighted portion remains as a 

completely new soundbite with a default name based on the name of the original soundbite plus 

a number extension. To rename it, option-click the new name to pop-edit it in the Soundbites 

window, event list, or Graphic Editing window info bar. 

Time ruler selection 

Before 

Trim oe if 

Guitar 
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Integrated digital video Digital Performer 1.6 has the ability to open and play back 
playback in the Movie QuickTime movies. However, movie playback requires QuickTime 

window 2.0 or higher to be installed in your Extension Folder. If you don’t 

have QuickTime installed, skip this page of the guided tour and 

proceed to the next page. 

For more information, see chapter 4, 

“The Movie Window’ (page 27). 

Choose Movie from the Windows menu. 
The movie window appears. If you don’t have QuickTime installed in your 
System Folder, Digital Performer will tell you that it cannot open the movie. 

Press the play button to start playback: 
You can also press the play button in Digital 
Performer’s main transport panel. 

To improve movie performance, close other windows, 
especially scrolling ones like Graphic Editing and the 
Tracks Window. Closing the Audio Monitor also helps. 

Stop playback and try cueing around in the movie with the slider in the 
movie’s control bar. 
Notice that the movie and Digital Performer are synchronized together. If the 
movie was recorded at a standard frame rate, such as 30 frames per second, 
its frames will match Digital Performer’s frames in the SMPTE counter. 

Option-drag the resize box until the movie ‘snaps’ to one size larger. 
You may need to move the window into the center of the screen first to give you enough 
room to do so. Option-dragging constrains the size of the movie window to sizes that 
provide optimum playback quality, such as half, full, double, and triple size. 

Click the lock button. 
This button disconnects the movie from Digital 
Performer’s main transports so you can play 
the movie separately from the music. 

Play the movie unlocked and at double size. 
Press the play button in the movie control bar. 
Press it again to stop the movie. 

After stopping the movie, lock it again and try 
frame-advancing forwards and backwards 
using the movie’s frame advance buttons. 
This demo movie was recorded at approximately 
15 frames per second, so it won't line up exactly 
with the SMPTE frames in Digital Performer’s 
main counter. But notice that it will stay in sync 
with the music as is. 

o0®8 090 © 

Close the movie window. 
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Congratulations! Congratulations! You are now familiar with several of Digital 

Performer’s most important audio features. 

Continuing on your own Feel free to play around further with any of the features you have 

learned about already, or poke around to find ones we didn’t cover. 

Don’t worry about “messing up” the tutorial file because you can quit 

without saving the changes you make. 

Recording your first If you'd like to try recording some audio, now is a good time. The 

audio track called “Record Audio Here” at the top of the list is already 

record-enabled and ready to go. Check disk space and input level in 

the Audio Monitor and then just press the record button in Digital 

Performer’s main transport panel. For a more detailed step-by-step 

recording tutorial, see chapter 8, “Recording Audio” (page 71). 

? Quitting the guided tour To quit the tutorial, choose Quit from the File menu and answer ‘No 

when it asks if you would like to save changes. 
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Chapteré Hard Disk Recording Basics 

Know the basics so you This chapter briefly covers several important concepts about hard 

can work smart disk-based digital audio recording. You may not feel that you have 

the time to review the “basics”, but the more you know, the more you 

will be able to accomplish. After you read this chapter Cit will only 

take a few minutes): 

m You will get a better sense of the vast creative 

possibilities open to you with this technology. 

m You will work more efficiently. 

mw You will be less likely to make costly mistakes. 

Also be sure to consult the owner’s manual of the hard disk recording 

hardware you have, as the hardware can impact Digital Performer in 

many important ways. 

How hard disk recording Consider for a moment how audio is recorded on a tape deck: it is 

differs from recording essentially a Jinear process. The audio signal gets recorded in a 

with a tape deck straight line (on the tape) from beginning to end. To play back, the 

tape passes over the head of the tape deck. If you want to start 

playback at a certain location in the music, you have to fast-forward 

or rewind the tape to that location. This is true for traditional analog 

tape decks as well as digital tape machines like the Alesis ADAT™. 

Tape Audio recorded on tape 

Figure 6-1: On a traditional tape deck, audio is 
recorded linearly on the tape from beginning to end. 

Consider, on the other hand, how a computer hard disk works: it is 

very similar to a CD player. The hard disk consists of a round, 

magnetic platter that spins very fast and stores data. Suspended above 
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this spinning platter is an extremely fast read/write mechanism, 

similar to the optical mechanism in a CD player, which reads and 

writes data to the platter. The read/write “head” moves incredibly fast 

(faster than the eye can see), providing virtually instantaneous access 

to any location on the hard disk. 

Sectors on the 

hard disk 

Digitally encoded 
audio data 

Figure 6-2: With a hard disk recording system, audio is converted into 
digital form (numbers) and stored on the hard disk platter, much like a 
CD player. The hard disk read/write mechanism moves so fast, it has 
virtually instantaneous access to any location on the hard disk. 

Random access This instantaneous access, often called random access, allows you to 

cue immediately to any location in your music, without having to 

wait for the hard disk mechanism to locate it. Hard disk recording 

systems convert an audio signal into digital data (basically 

transforming the audio signal into a continuous stream of numbers), 

and then write the digital data sequentially to the hard disk. Because 

of the extremely high speed of the hard disk read/write mechanism, 

you have instant access to any part of the recorded audio. 

Non-destructive editing With their random access capability, hard disk recording systems 

provide other important advantages over tape machines. For 

example, you can cut, snip, splice, shift, re-arrange, and otherwise 

edit the original pass of audio without actually modifying the original 

data. For example, if you rearrange the order of a few sections in a 

digital audio track, Digital Performer simply rearranges references to 

those sections of data without affecting the original audio data itself. 

This process, called non-destructive editing, is possible because 

Digital Performer stores the edit points separately from the audio 
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Audio track in Digital Performer with original take: 

The same track after non-destructive editing: 

data. You can always revert to the original audio data if you want, up 

until the time that you decide to permanently erase it from the hard 

disk. 

Verse 1 Verse 2 Chorus 

cal Edit points at section boundaries —~ 

Verse 1 Chorus Verse 2 

Figure 6-3: Hard disk recording systems provide non-destructive editing, which gives you 
instantaneous flexibility, as well as the ability to revert back to the original take at any time. 
Note that when you do this type of editing in Digital Performer, the audio data stored on 
hard disk does not move. Digital Performer just rearranges ‘pointers’ to the audio data. 

Instantaneous editing 

Non-linear editing and 
playback 

Repetition without 
duplication 

Hard Disk Recording Basics 

Non-destructive editing is a virtually instantaneous process because 

the edit points you create during editing are very small (only a few 

bytes) and can therefore be handled quickly by the computer. As a 

result, your edits in Digital Performer take effect immediately as you 

do them. 

As you can see in Figure 6-3 above, non-destructive editing makes it 

quick and easy to re-arrange the order of any portion of the originally 

recorded audio. And you can revert to the original take at any time. 

Random access also allows you to repeat the same section of music 

as many times as you like within your piece of music without 

duplicating the actual audio data itself. For example, the demo file 

that ships with Digital Performer has a one-measure drum loop that 

repeats for the entire 60 bars of the piece, but it only consists of one 

measure’s worth of audio—approximately two seconds. The loop is 

simply placed end to end in the track sixty times. (Alternately, it 

could be looped with a loop in the track.) You can even play back 

the same region of audio on several tracks at the same time. For 

example, you might create a chorus effect with a vocal passage by 

placing it in four separate tracks and slightly offsetting the audio in 

each track. When you do so, Digital Performer does not actually 

create four copies of the audio data on your hard disk; instead, the 
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How much audio can 
you record on a hard 
disk? 

Hard disk requirements 
and maintenance 

Digital audio terms 
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computer references the same passage of audio on the hard disk four 

times simultaneously. As a result, you are actually conserving hard 

disk space when using a single region of audio in multiple places. 

The freedom you enjoy as a result of the benefits described above 

comes at a price: hard disk space. One mono minute of audio takes 

up about 5 megabytes (Mb) of space on your hard disk. A stereo 

minute takes up 10 Mb. If you have a four-channel hard disk 

recording system, and you have audio playing on all four channels 

for a five minute tune, that’s 4 channels times 5 minutes, which adds 

up to 20 minutes of audio. Multiply that by 5 Mb per minute, and 

your 5 minute song takes up 100 Mb of hard disk space! And that 

doesn’t count alternate takes, overdubs, and other audio that you 

generate during the course of a recording session. During a typical 

session, you can fill a 500 Mb hard disk in no time. 

Fortunately, Digital Performer’s Audio Monitor always shows you 

how much hard disk space you have available on your hard disk 

during a session so that you can manage your audio tracks 

intelligently and never run out of space at a crucial moment (such as 

the middle of a record pass!) 

In addition, Digital Performer provides audio management features 

that let you easily identify unused audio and delete it from the hard 

disk. 

Digital Performer itself does not have any special requirements with 

regard to the performance of the hard disk(s) on which you will be 

recording audio. However, the hard disk recording system you 

purchase to use with Digital Performer probably does. To avoid 

problems, be sure to consult the hardware manual for information 

about hard disk performance requirements. You may also learn about 

hard disk maintenance procedures such as defragmenting and 

re-initializing, which can help improve performance. 

Here are some terms and concepts you should be familiar with. 

Project 
A project is a folder that Digital Performer creates on your hard disk 

when you start a new recording session. It includes a Digital 

Performer file, along with a folder for the audio files you’ll generate 

while recording. 
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Audio file (or Sound file) 
An audio file is a document on your Macintosh hard disk that 

contains digital audio data. Its size is determined by the duration of 

the audio data, by the sample resolution, and by the number of audio 

channels (1 for mono files, 2 for stereo files). A one-minute mono 

audio file recorded at 44.1 kHz takes up about 5 megabytes of hard 

disk space. Stereo files are twice as large as mono files. Therefore, a 

one-minute stereo file is about 10 megabytes. 

Audio files come in several different formats. The most common 

format on the Macintosh, and the only format you can generate when 

recording in Digital Performer, is a Sound Designer II file. Digital 

Performer can import and play back old Sound Designer files, as well 

as AIFF (Audio Interchange File Format) files. 

Audio files contain more than just the audio information. They also 

contain a list of regions (explained below) in the audio file, as well as 

any playlists (also explained below) that have been created for it 

using other software programs, such as Sound Designer II. 

, Audio data 

SS 2 a 

Regions Playlists 
Drum Loop 

A Sound Designer II file 

Figure 6-4: A sound file contains the original audio recorded 
into it, as well as any regions (soundbites) and playlists created 
by Digital Performer or other audio editing software you might 
use to edit the file, such as Digidesign’s Sound Designer II. 

Region 
This is the term most commonly used to refer to a section of audio in 

an audio file. It could be a one-second sound effect, a 16-bar phrase, 

or the entire length of the audio file. You can define an unlimited 

number of regions in an audio file. Technically speaking, a region 

consists of pointers, which are references to the exact location (digital 

sample) in the audio file where the region begins and ends. These 

pointers are very small compared to the amount of audio data they 

represent. This is why region editing is so fast and efficient: it deals 

with the manipulation of pointers, which consist of a very small 

amount of data. 
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Soundbite 
The word Soundbite is synonymous with the word Region as 

described above. In Digital Performer, we call regions soundbites 

because the word region means something entirely different in 

Digital Performer: it is a period of time within one or more tracks 

over which an editing command will take effect. (For example, 

consider Digital Performer’s Region menu.) Therefore, to avoid 

confusion with the word region, we use the term soundbite to 

describe a Sound Designer II file region. They are one and the same. 

An mono audio file contains a single : 

channel of audio data. (Stereo audio Soundbite. 1 Soundbite.2 Soundbite.3 
files contain two channels.) Sound- 
bites (regions) of any length can be 
defined within the audio file. 

Soundbites that you record or import into a Digital 
Performer file are cataloged in the Soundbites window. 
They appear as regions of audio in the Graphic Editing 
and Event List windows of audio tracks. 

Figure 6-5: Soundbites (regions) exist within an audio file. A sounabite 
is any portion of an audio file. It can even be the entire audio file. 

Soundbites can be placed in any audio track at any time location. 

They can be duplicated as many times as you like with virtually no 

additional memory overhead, since they are merely pointers to audio 

data on the hard disk. With only two exceptions, soundbite editing 

and management in Digital Performer is entirely non-destructive. 

(The exceptions are the Compact command and deleting the very last 

soundbite in an audio file, which cause audio data to be deleted from 

disk.) 
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Playlist 
A playlist is a collection of regions played end-to-end to produce a 

continuous presentation of music. Some programs, like Digidesign’s 

Sound Designer II™, can save playlists within the audio file itself, just 

like regions. Playlists stored in audio files can be imported into Digital 

Performer as a single audio track in the Tracks window. You can also 

build a playlist in Digital Performer by dragging soundbites from the 

Soundbites window into a track’s event list window. 

Audio track 

An audio track is a track in Digital Performer’s Tracks list that can 

hold audio regions (soundbites), as well as audio volume and pan 

data. You can view the contents of an audio track with its event list 

window and/or its graphic editing window. 

Audio voice 
MIDI synthesizers have a maximum number of notes that can play at 

one time. Similarly, hard disk recording systems have a maximum 

number of channels, also referred to as voices, that can play at one 

time. For example, if you have a Digidesign Audiomedia II card, it 

provides Digital Performer with four audio voices. Digital Performer 

lets you assign any voice to any audio track as shown below. You can 

even assign the same voice to several tracks, but only one of the 

tracks can play at a time. When assigning voices, you can control 

how the playback resources of your hardware are allocated among 

the audio tracks in your music. 

Figure 6-6: Assigning an audio track to an 
audio voice. In this case, there are 16 audio 
voices because the audio hardware being 
used is a core Pro Tools III system. 
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Audio input/output 
An dudio input or output refers to the physical input or output jack 

in the recording system you are using. Digital Performer allows you 

to freely assign audio tracks to the inputs and outputs in your system. 

DAE 
DAE is an abbreviation for the Digidesign Audio Engine, a software 

application developed by Digidesign that is shipped with Digital 

Performer. The DAE application is automatically installed in your 

system when Digital Performer is installed, and it automatically starts 

up every time you run Digital Performer. It is required by Digital 

Performer to record and play back audio data. 

The DAE is the software “driver” for Digidesign hard disk recording 

hardware, serving as the link between Digital Performer’s recording 

and playback features and the actual hardware itself. 

You never need to be concerned about launching or quitting DAE. It 

launches itself and quits automatically when you run and quit Digital 

Performer. 

If you don’t have enough RAM to run Digital Performer and DAE at 

the same time, you will be informed of this when you first try to run 

Digital Performer. You can run Digital Performer without DAE, but 

you won't be able to record or play back any audio. 

Because you may be using other programs that rely on DAE, you may 

need to keep track of what version of DAE you currently have (DAE 

is periodically updated by Digidesign) to make sure that it is 

compatible with Digital Performer. Consult the “Read Me” file and 

update notes included with new versions of Digital Performer as they 

become available. They will keep you informed of DAE version 

compatibility. In general, newer versions of DAE will most likely be 

compatible with the latest version of Digital Performer. 

TDM 
TDM is a software addition to DAE developed by Digidesign to allow 

comprehensive signal processing and mixing within the DAE 

environment. It consists of a folder of TDM plug-ins that resides in 

the DAE Folder with the DAE application. TDM is an open system, 

with plug-ins being offered by Digidesign and a host of other third 

party developers. All of these plug-ins can be used in Digital 

Performer’s Mixing Board inserts and the Effects window. 
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Technically speaking, TDM is an acronym for Time Division Multi- 

plexing. Digidesign has coined their own phrase for their implemen- 

tation of this technology, Trans-system Digital Matrix Bus™, or TDM 

Bus™. The Digidesign TDM bus is a 256-channel, 24-bit digital audio 

bus that provides communication between all TDM-compatible 

hardware and software. 
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Chapter7 AUCIio Track Basics 

Audio tracks 

Digital Performer totally integrates the playback of digital audio 

tracks with the playback of MIDI tracks. You can use all of 

Performer’s powerful and flexible cueing features to play audio and 

MIDI tracks together. 

This chapter explains the following important aspects of audio tracks: 

m Creating and managing audio tracks 

ms Assigning inputs and outputs 

m Assigning voices 

= Managing track and voice limits 

mw Registering and unregistering audio tracks 

m Viewing audio track output levels 

In Digital Performer, audio tracks are very similar to MIDI tracks, and 

they all appear together in the Tracks window. An audio track is 

where digital audio data is recorded, edited, and played back. It 

could be a recording of a single instrument, containing any number 

of punch-ins and overdubs for the instrument. Or it could contain a 

wide variety of sounds occurring at different times, such as sound 

effects. You can record any audio you want into an audio track, 

including speech, vocals, sound effects, etc. 
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Creating an audio track To create an audio track in the Tracks window, choose Add Audio 

Track from the Tracks window mini-menu. New audio tracks are 

named Audio-1, Audio-2, etc. You can change the name by option- 

clicking the name to pop-edit it. Each audio track has the settings 

shown below in Figure 7-1. 

Record Play-enable Audio 
button button voice 

and input and output 
assignment assignment 

Figure 7-1: Creating an audio track. Note: the track columns shown 
here are ones that pertain to audio tracks. Columns pertaining only 
to MIDI tracks have been hidden in this example. 

Adding several audio If you want to add several audio tracks at once, hold down the 

tracks at once option-key while choosing the Add audio track command from the 

mini-menu. By default, newly created tracks are panned center 

(across the output pair that the track is assigned to). When adding 

multiple tracks, however, you are given the option of adding them in 

stereo pairs panned hard left and right. 

Assigning inputs and For each audio track, you choose an input and output as shown in 

outputs to an audio track | Figure 7-1, which correspond directly to the physical input and 
output jacks on your audio hardware system. For example, 

Audiomedia II cards have 2 inputs and 2 outputs; single Pro Tools 

cards have 4 inputs and 4 outputs; core Pro Tools III systems have 8 

inputs and 8 outputs. A red (or black) dot in the input pop-up menu 

indicates that the input is currently record-enabled. 
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Output assignments are 
made in left/right pairs 

Audio voices 

Assigning a voice 

Audio Track Basics 

Output assignments are actually made in pairs, such as 1-2 or 3-4. The 

track is panned across the two outputs using the track’s pan knob in 

the Mixing Board window, as well as pan controller events that you 

insert in the track. For example, the track in Figure 7-1 on page 60 is 

assigned to —and panned across — outputs 1 and 2. To play a track 

on a single output, pan hard left or right (where the odd numbered 

output is left and even is right). 

In addition to their output assignment, audio tracks have a playback 

assignment called a voice. An audio voice is one of the channels of 

simultaneously playback provided by your hard disk recording 

hardware. The maximum number of voices you have depends on 

your hardware, as shown in the table below: 

Digidesign Number of Number of 
System audio voices audio outputs 

Audiomedia I, II, LC ? 

Sound Tools I 4 

Pro Tools + SysAxe 8, 12, or 16 

| : Session 8* 

Pro Tools III 16+ St 

*Session 8 will be supported in a future version of Digital Performer. 

tThese figures are for a core configuration. More voices and outputs can be added with 
expanders and additional I/O modules. Contact Digidesign for more information. 

When you add an audio track, it is assigned to Voice 1 by default. To 

assign an audio track to a different voice, press on the current voice 

assignment next to the track name as shown below. 

Red (or black) 
dots indicate 
which voices are 
currently record- 
enabled. 

Figure 7-2: Choosing a voice for an audio track. 
The number of voices in this pop-up menu 
depends on your hardware. 
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Managing voice As mentioned in the previous section, “Audio voices”, the number of 

tracks you can actually hear at the same time depends on the 

and tr ack limi ts maximum number of audio voices your hard disk recording system 

provides. 

Don’t resign yourself, however, to thinking in terms of the limited 

number of voices shown on page 61. Digital Performer allows you to 

work in ways that make it seem like you have many more. 

Track bouncing with the One way to hear more tracks at once is to mix many tracks down to 

Mix command one track (and therefore one voice). You can do this freely in Digital 

Performer because in the realm of digital audio, there is no noise 

build-up as a result of mixing. Another great advantage to digital 

mixing is that the original tracks remain intact, so you can always go 

back to them if you want (or you can delete them to free up space on 

your hard disk). You can even create multiple versions of a mix and 

quickly A/B the mixes. For more information about using the Mix 

command, see chapter 18, “The Mix Command” (page 219). 

Using a single playback Another way to overcome a small number of playback voices is to 

voice for multiple tracks assign multiple tracks to the same audio voice—up to 32 tracks—as 

long as the material in each track doesn’t occur at the same time. For 

example, if you had several different instruments playing solos at 

different times during a song, you could place each instrument in its 

own track and still assign them to the same audio voice because they 

never play at the same time. 

Sax Track, voice 1 

Guitar Track, voice 1 

Keyboard Track, voice 1 

Keyboard solo 

Figure 7-3: Several tracks can share the same audio voice if they don’t overlap during the song. If they do 
happen to overlap, the track that gets priority is the one that is higher up in the list in the Tracks window. 

Recording multiple Another situation in which you can assign multiple tracks to the same 

takes of the same voice is when you record multiple takes of the same instrument. You 

instrument can record each new take into its own track, assign all of the tracks 
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Overlapping soundbites 
and track priority 

Track 1 (voice 1) § 

Track 2 (voice 1) 

Track 3 (voice 1) 

to the same audio voice, and then play them one at a time (by muting 

all except one). This lets you do A/B comparisons between takes, 

and it provides you with complete freedom to choose among them. 

You can keep alternate takes around for as long as you want, 

provided you have enough space on your hard disk. 

During playback, soundbites in each track play back on the audio 

voice assigned to that track. Only one soundbite can play at a time on 

the voice. 

Digital Performer does not dynamically allocate playback across 

audio voices. Tracks can be assigned to one voice, and soundbites in 

the track play on that voice only. 

If overlapping soundbites are placed in the same track, each 

soundbite “takes over” the voice when it begins and continues to play 

until it ends or until another new soundbite takes over. 

If overlapping soundbites are placed in separate tracks assigned to 

the same audio voice, the soundbites “steal” the voice according to 

their track priority. Track priority is determined by the position of the 

track in the Tracks list: the higher the track, the higher its priority. 

Soundbite. 1 

Soundbite.2 

Soundbite.3 

Figure 7-4: Voice stealing during playback is determined by track priority. The higher the track is 
in the list, the higher its priority. To change a track’s priority, drag it higher or lower in the list. 

Audio Track Basics 

If tracks 1, 2, and 3 in Figure 7-4 above are assigned to the same 

audio voice, Soundbite.1 plays first as playback proceeds from left to 

right. Soundbite.2 never plays because Soundbite.1 has priority 

during its entire duration. Soundbite.3 steals the voice from 

Soundbite.1, but only after Soundbite.1 has finished. 
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If all of the soundbites shown in Figure 7-4 on page 63 were placed 

in the same track as shown below, then each one would “take over” 

playback as soon as it begins. Therefore, Soundbite.2 will take over 

as soon as it begins, as will soundbite.3, which will then play through 

to its end. 

Track 1 

Soundbite. 1 Soundbite.2 Soundbite.3 

Figure 7-5: If the soundbites shown in Figure 7-4 are 
placed in the same track, this is the resulting playback. 

Audio track limits Just as it does with MIDI tracks, Digital Performer allows you to 

create and record into an unlimited number of audio tracks. 

However, Digital Performer’s audio playback and recording 

capabilities depend on the Digidesign Audio Engine (DAE), and DAE 

has built-in track limits. A DAE track limit is the maximum number of 

audio tracks that can be enabled simultaneously. We refer to this as 

the number of audio tracks that can be registered with the DAE. 

Registered tracks can play, record, scrub, etc. Unregistered tracks 

cannot. 

Each Digidesign hardware system has a maximum number of audio 

tracks that can be registered at one time. Here are the limits for the 

various hardware configurations: 

Digidesign Number of Track 
System Audio Voices Limit 

Audiomedia I, I 12 

Audiomedia LC 

Sound Tools II 32 

| &iorle | 
ass. ee 

Pro Tools 64* 

Pro Tools + SysAxe S- 12.0716 64* 

Session 8 8 

Pro Tools III core 16 55 
system 

*On Pro Tools | systems with TDM, the track limit is 61 instead of 64. 
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Registered and 
unregistered audio 
tracks 

Registered tracks 
Display a record button and play-enable 
button as usual. 

Track assignments that 
are not available 

Audio track assignments (input, output, or 
voice) that are no longer available 
(because the digidesign hardware system 
has changed) appear in italics. 

Manually unregistered tracks 
Display a ‘--’ for the voice assignment 

In addition, there is a non-hardware specific limit of 32 audio tracks 

per audio voice in the DAE. This means that you can assign up to 32 

tracks to the same voice (but only one will play at a time. See “Using 

a single playback voice for multiple tracks” on page 62 and 

“Overlapping soundbites and track priority” on page 63.) 

Digital Performer does not limit the number of audio tracks that can 

be present in a Digital Performer file, but it does limit the number of 

audio tracks that are registered with the DAE at any given moment. 

Digital Performer automatically unregisters audio tracks temporarily 

when needed. When a track becomes unregistered, its record-enable 

and play-enable buttons disappear as shown below in Figure 7-6 to 

indicate that the track is unregistered and will not play back. 

Unregistered tracks also do not take up any DSP playback 

bandwidth. 

because it has been set to “None”, in addition 

to not having a record and play button. 

Audio Track Basics 

Figure 7-6: Unregistered audio tracks are displayed without a record button 
or play-enable button. You can manually unregister a track by setting its 
voice assignment to “None”, which appears as a “--” in the Device column. 
A track automatically becomes unregistered if its voice or output assign- 
ment is no longer available (italic). In the example above, the file was last 
saved on a Pro Tools I/l system and is now opened on a Pro Tools | system. 

Whenever audio tracks are going to become unregistered, Digital 

Performer displays the Audio Track Limits alert box to inform you. 

This alert can be turned off in the Preferences command in the File 

menu. We recommend that you leave this alert on for at least a little 

while, so that you can learn how and when these limits are reached. 
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Manually unregistering You can assign an audio track to any audio voice or to None. When 

tracks an audio track is assigned to None, its assignment is displayed as two 

dashes (--) in the Tracks window as shown above in Figure 7-6 and 

it is unregistered with the DAE. 

Soundbites within tracks that are assigned to None or are 

unregistered automatically cannot be played back or scrubbed. 

Examples of when Here are some examples of when tracks will become unregistered: 

tracks are automatically 
unregistered m You are opening a Digital Performer file from any 

previous version that contains more than 32 audio tracks 

assigned to any one voice or more than the total audio 

track limit for your specific hardware. All the extra tracks 

retain their voice assignments, but the voice assignments 

appear italicized in the Tracks window and those tracks 

are muted. 

mw You have a file that is already at (or near) the audio track 

limit and you try to add a few more audio tracks using 

the Add Audio Track or Duplicate Track Layout 

commands from the Tracks window mini-menu. Digital 

Performer allows you to add as many tracks as you like, 

but the tracks beyond the limit are unregistered and 

muted. 

m You play-enable a Song chunk that contains two or more 

sequence chunks with audio tracks and the total number 

of audio tracks in all the sequences exceeds the audio 

track limits for your hardware. This is important if you 

work with Songs. The total number of audio tracks 

within all the chunks contained in the Song cannot 

exceed the audio track limit. 

m You open a Digital Performer file that was last saved 

under a hardware system that supports more voices and/ 

or inputs and outputs than the current system. For 

example, if you save a file running under Pro Tools II 
(with 16 voices), and you then open the file on a system 

that has an Audiomedia II card (4 voices), audio tracks 

assigned to voices 5-16 will be unregistered (italicized). 

Since Digital Performer automatically disables tracks when the limit is 

reached, there is potential for confusion, so keep track limits in mind 

as you work with audio tracks so that you can effectively manage 

them. 
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Re-registering tracks 

Displaying audio track 
levels in the Tracks list 

Audio Track Basics 

To play back or record into an unregistered track, you must first 

reregister it by choosing a valid (not italic) output assignment and 

voice for the track from their respective pop-up menus. If either of 

these conditions is not met, the track will not play back and does not 

take up any playback bandwidth. 

The level meters in the Tracks list next to each audio track give you 

an indication of playback activity in the track, including an accurate 

display of true clipping. For a larger reading, use the level meters in 

the Mixing Board. (See the next section.) 

Level meters 
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Viewing audio track The level meters in the Mixing Board display the output level on each 

levels in the Mixing audio track. 
Board 

Audio track level meter MIDI track level meter 

Volume Digital Performer provides audio volume controller events that work 

in much the same way as MIDI volume controllers. The value range 

of an audio event is 0 to 127, and it can be use together with 

soundbite velocities to control volume in an audio track. 

For more information about inserting and handling volume 

controllers, see chapter 15, “The Mixing Board” (page 175). 

Panning Panning is handled using special audio track pan controller events, 

which function similarly to MIDI continuous controller data. Each pan 

controller can have a value between -64 and +63, where O is dead 

center, -64 is hard left, and 63 is hard right. Pan controllers can be 

used one at a time to make a sudden change, or as an entire stream 

of events changing gradually to create smooth panning effects, just 

like MIDI continuous controllers. 
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Playing back stereo 
sound files 

Screen redisplay 

Event chasing 

Audio Track Basics 

Audio tracks default to pan center when they are first created, unless 

you add multiple tracks as stereo pairs (see “Adding several audio 

tracks at once” on page 60), in which case they are panned hard left 

and right. 

For information about panning, see chapter 15, “The Mixing Board” 

(page 175). 

At the time of this writing, the Digidesign Audio Engine (DAE) does 

not support the recording or playback of interleaved, stereo sound 

files. (You can, however, work in stereo in Digital Performer. See 

“Recording in stereo” on page 81.) 

Some digital audio applications have the ability to create interleaved, 

stereo Sound Designer II audio files. These files can be imported into 

Digital Performer, but DAE only plays the left channel when you play 

them back. You can, however, split up the stereo soundfile into two 

separate mono soundfiles and then place them in separate tracks in 

Digital Performer. This allows you to properly hear both channels. 

For information about de-interleaving stereo soundfiles, “Converting 

soundbites that cannot be played” on page 98. 

For late-breaking news about stereo sound file recording and 

playback, consult the “Read Me” files and update notes of future 

versions of Digital Performer. 

During playback, Digital Performer does its best to update items on 

the Macintosh screen, such as the Counter and scrolling windows. 

However, audio recording and playback does place a high demand 

on the computing power of the machine, and Digital Performer 

makes playback a much higher priority than refreshing the screen 

display. Therefore, you may find at times that the counter will stop 

and start during playback or recording. 

Some hard disk recording systems, such as the Digidesign System 

Accelerator (or “SysAxe”), have a separate SCSI bus for digital audio. 

These systems relieve the Macintosh from the audio processing tasks. 

As a result, you will notice dramatically higher performance in Digital 

Performer’s screen redisplay when using these systems. 

Event chasing causes Digital Performer to always begin playback with 

the correct settings for chased events. The Event Chasing dialog box 

contains options for soundbites, audio pan, and audio volume. These 

options, when enabled, ensure that you hear the correct audio, level, 

and pan settings no matter where you start playback. 
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Muting and unmuting 
audio tracks during 
playback 

Scrubbing audio 

Slow and fast 
forwarding 
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Under most circumstances, you should leave these options turned on 

to achieve accurate playback. The only effect they have when 

disabled is to give Digital Performer slightly faster response when you 

press the play button. 

Remember, when you disable the Soundbites option, Digital 

Performer will not play a soundbite when playback begins in the 

middle of the soundbite. 

Audio tracks can be muted and unmuted during playback by using 

solo mode or by clicking their play-enable button in the Tracks 

window. 

When muting a track, the response is instantaneous. 

When unmuting a track, the response depends on whether the DAE 

still has audio data to play. If it does, then the response is instanta- 

neous. If it does not, then there is a delay while the DAE reloads its 

buffers. However, since the DAE loads its buffers far ahead of the 

actual counter time, there may be several seconds before the track 

becomes unmuted. The exact amount of delay depends mainly on 

the DAE buffer size and whether a System Accelerator is being used. 

You can scrub the audio in a soundbite in the Graphic Editing 

window. For information, see “Scrubbing audio inside a popped-up 

soundbite” on page 147. 

Fast forward advances the counter at four times normal speed and 

skips audio like a CD player. Slow forward advances the counter at 

half speed and slows audio down without skipping. 

Audio Track Basics 



Chapter 8 Recor ding Audio 

Chapter overview 

Introduction 

Recording audio requires a few careful considerations before you 

begin. This chapter explains how to: 

m Create an audio track and record into it 

# Punch in and out during recording (manually and 

automatically) 

= Record in stereo 

mw Record multiple tracks at one time 

m Record audio and MIDI tracks at the same time 

Digital Performer records audio in much the same way as a multitrack 

tape system, but with increased flexibility. Once audio data has been 

recorded, you have a great deal of control when editing, rearranging, 

and mixing audio tracks with your MIDI tracks. 

In regular record mode, you record one audio track at a time. In 

MultiRecord mode, you can record several audio tracks at once—as 

many as your audio hardware will allow. In MultiRecord, you can 

also record in stereo. 

In either record mode, Digital Performer generates mono Sound 

Designer II soundfiles. Digital Performer does not currently create 

stereo soundfiles, although this capability is expected in future 

versions of DAE and Digital Performer. In the meantime, however, 

you can still record and play back in stereo, and this chapter explains 

how. 
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Preparing to Before you begin an audio recording session, make the following 

preparations for each audio track you would like to record into. If 

recor d you are recording multiple tracks at once, also see “Using 

MultiRecord mode to record several audio tracks at once” on page 79 

and “Recording in stereo” on page 81 for additional information. 

Set up an audio track To create an audio track, choose Add Audio Track from the Tracks 
window mini-menu. To add several audio tracks at once, hold down 

the option key while doing so. Remember, you can control the 

position of the new audio track(s) in the list by highlighting an 

existing track before you add them. The new track is added below 

the highlighted track. If nothing is highlighted, the new track is added 

at the bottom of the list. 

Record-enable the audio track 
When you first create an audio track, it automatically gets record- 

enabled. If you are recording into an existing audio track, make sure 

that it is record-enabled by clicking the record-enable button to the 

left of its name. 

@ This step must be done before you actually begin 

recording; audio tracks cannot be record-enabled 

during playback or recording. 

@ if the track’s record button is missing, then the track 

has become unregistered. To re-register the track, 

see “Re-registering tracks” on page 67. 

Record-enabled 

audio track 
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Specify the audio input you will be recording from 
This is the physical input on your recording hardware from which 

you want to record. To choose the audio input for recording, press 

on the current input assignment next to the track as shown below. 

Press on the current audio input assign- 
ment to change it. 

The red (or black) dot in the menu indicates 
the currently record-enabled input. 

Set up the Audio Monitor | Now you are ready to check the following information in the Audio 

Monitor. 

Turnonaudio Note! This button does Check how much record 

Patch Thru not appear on TDM time is available on your 

so you can systems. See hard disk (click to toggle 
hear input. “Monitoring input between min/sec or Mb). 

levels on TDM 
systems” on page 186. 

Play some sample Confirm that the take file for the record Confirm the location of the audio file. Is it 
input to make sure input is on standby (not italicized). This located where you want it (or where your 
the input level meter means that the file has been created hard disk recording system requires it to 
reads as Close to zero on the hard disk. If it isn’t, record- be)? Click to toggle between full and 
dB as possible. (See enable the audio track in the Tracks abbreviated path display. 
note above about window. 
TDM systems.) 

Figure 8-1: The Audio Monitor is an important component of the audio recording process. Always check the 
settings shown above before recording. In this example, recording is being done on input 2. 
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Confirm the current When you record-enable an audio track in the track list as discussed 

record input in the previous section, the corresponding takefile in the Audio 

Monitor switches to plain text (instead of being italicized) as shown 

in Figure 8-1. This occurs on the audio input currently chosen for the 

record-enabled track. Plain text indicates that the takefile has been 

created on disk and that the system is ready to record. 

Turn on Audio Patch Press the Patch Thru button in the title bar of the Audio Monitor as 

Thru shown in Figure 8-1 if you want to send the input signal to the track’s 

output assignment on your hard disk recording hardware. Doing so 

allows you to monitor what you are recording. (if you have a TDM 

system, see “Monitoring input levels on TDM systems” on page 186.) 

Recording with Patch Thru on overrides any existing audio in tracks 

assigned to play back on the audio voice assigned to the track being 

recorded into. For example, if Track A and Track B are both assigned 

to Voice 1, and you are recording on Track B, Patch Thru will 

override any audio in Track A. 

If Patch Thru is turned off, 
you'll hear audio in this 
track during recording 
because it has a higher 
playback priority. 

lf Patch Thru is turned on, 
you'll hear audio in this track 
during recording, regardless 
of playback priority. 

Check the audio input Next, adjust the level of the input signal to make sure that it peaks as 

level close to zero dB as possible without clipping. 

@ On TDM systems, input monitoring is done in the 

Mixing Board level meters. For more information, 
see chapter , “Monitoring input levels on TDM 

systems” (page 186). 

1. Check Retain Clip in the Audio Monitor mini-menu. 

2. Play the input signal at its peak levels. 

3. Watch the level meter and adjust the input so that the peaks 

occur as close to 0 dB as possible without triggering the Clip 

indicator shown below. 
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Changing the level 
meter range (optional) 

Check for free hard disk 
space 

Recording Audio 

Clip indicator 

Digital clipping is much harsher than analog clipping. Therefore, it’s 

better to err on the low side. Use discretion. 

If the audio level is fairly consistent, and you would like it to provide 

you with more detailed feedback closer to zero dB, use the Level 

meter range mini-menu command in the Audio Monitor to adjust the 

range covered by the level meters. 

Now you are ready to see how much free hard disk space you have 

in the Audio Monitor, which automatically displays this amount in 

either minutes or megabytes (click to toggle the display as shown in 

Figure 8-1). One mono minute of audio takes up approximately 5 

megabytes of disk space (at 44.1 kHz). One stereo minute of audio 

takes up twice that (10 megabytes). Plan your session accordingly. If 

necessary, you may need to back up and remove audio files left over 

from other projects from the hard drive. Or you may need to record 

onto a different hard drive than the currently selected one (see the 

next two sections). 

It's a good idea to give yourself extra space (several megabytes at 

least) because hard disk fragmentation is more likely to adversely 

affect audio recording when the hard disk is almost full. 

If you are recording multiple tracks at once, you can record them on 

separate hard drives—as long as your hard disk recording hardware 

allows this. Check the requirements of your system before attempting 

to do so. The next section explains how to choose a drive. 
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Check the location of the When Digital Performer records audio, it places the audio data in an 

current takefile audio file on your hard disk and assigns the default name Takefile to 

it followed by an input number and take number for that session. By 

default, takefiles for an input are located in the same place on your 

hard disk as the last takefile recorded for that input. For new projects, 

takefiles are initially located in a folder called Audio Files, which is 

located in the project folder. 

@ When a SysAxe is installed, Digital Performer 

automatically puts takefiles in a folder on the SysAxe 

drive(s). 

ei New Project 2s 
2 items 230.6 MB in disk 11.5 MB availa 

Aiuan Pea ject Audio Files 

In a new project, takefiles are 
placed by default in the Audio Files 
folder, which is located in the project 
folder. If you want, you can change 
the default location of takefiles in 
your new file template. 

The current takefile location is displayed in the Audio Monitor as 

shown below. 

Step 1: Click here to toggle the 
display to full path names. 

Step 2: Click the resize button to 
expand the window. Click it 
again to shrink the window back 
to its original size. 

Figure 8-2: To quickly check the full path name, click the current take folder once to toggle 
to the full path name display, and then click the window resize button to fully expand the 
window. To shrink the window to its prior size, click the resize button again. 
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Changing the location of If necessary or desired, you can change the location of the takefile. 

the takefile (optional) For example, you might want to organize the audio files in a session 

by instrument. Or you may need to move the takefile to a hard drive 

that has a large amount of free space on it. 

To change the takefile location, just double-click the takefile name in 

the Audio Monitor to open a standard Macintosh open dialog box as 

shown below. Notice that this dialog box includes a New Folder 

button, which lets you easily organize takefiles into your own folders. 

Since you can often generate dozens of takefiles during the course of 

a session, you may want to organize them as you go along. For 

example, you might want to put all of the vocal takes into a folder 

called Vocals. It helps to do this before you begin recording. 

Choose a take folder for audio channel ?: 

<< Projects w 

You can easily 
organize 
takefiles into 

<> PowerPC 

ee folders usin 
Use this button 7 |G My DP File Project 9 

| |c New File Project the convenient 
to select the New Folder 
folder shown button. 
here. 

Select "Projects" 

Keyboard short- 
cut for this Available disk space: 16.0 MB 

button: Available mono recording time: 3:10.00 

Command-S 

@ In SysAxe systems, you will not be able to select 

non-SysAxe hard drives in this dialog box. 

Digital Performer automatically keeps track of the audio files 

associated with the project, regardless of where you store them on 

your hard disk(s). For more information, see chapter 11, “Audio File 

Management” (page 109). 

Renaming the takefile By default, the audio file that you generate when recording is given 

(optional) the name “Takefile” followed by a take number. If you want, you can 

give it a more appropriate name to better identify it. (Alternately, you 

could rename it later on after recording.) To set the takefile name 

before recording: 

1. Option-click the takefile name in the Audio Monitor. 

2. Type in the desired name. 
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Set the tempo! 

Begin recording 

78 

3. Press return to confirm or press command-period to cancel. 

It greatly simplifies things if you set the desired tempo of the 

sequence before you record any audio because changing the tempo 

after recording causes audio tracks to fall out of sync with MIDI 

tracks. To set the tempo, set Digital Performer’s tempo slider 

accordingly, or program a tempo map using the Change Tempo 

Command in the Change Menu. 

Choose the desired tempo control source 

(tempo slider or conductor track) and then 
set or program the desired tempo. 

As a rule of thumb, it is advisable to program tempos in the 

Conductor Track using Change Tempo instead of just setting a tempo 

manually with the tempo slider, because you won't run the risk of 

changing the tempo slider setting after you’ve recorded audio, which 

will throw off the timing between audio and MIDI tracks. If you 

program the tempo, it is “hard-coded” in the conductor track. 

If you get into a situation where you must change the tempo after you 

have already recorded audio, see “How soundbites are affected when 

you change the tempo” on page 209. 

To begin recording: 

1. Set the Counter to the location in the sequence at which you 
want to begin recording. 

2. Click the record button in the main controls. 

You can use any of Digital Performer’s alternate ways of 

initiating record: press the [3] key on the keypad, or initiate 

recording via a MIDI remote control. Digital Performer will 

begin recording. 

@ To achieve the fastest response possible when you 

begin recording, use pause-record. That is, press the 

pause button first and then record. Digital Performer 

allocates record buffers as needed and then waits for 

you to press pause again to begin recording. 

Recording Audio 



Using MultiRecord mode 
to record several audio 
tracks at once 

Recording Audio 

During recording, Digital Performer replaces any existing audio, pan, 

and volume data in the track with the new data being recorded. To 

merge new data with existing data, use Overdub mode as described 

later in this chapter. 

To stop recording: 

m= Stop Digital Performer by clicking the Stop button, 

pressing the space bar, or pressing the [0] key on the 

keypad. 

Digital Performer stops recording and takes a moment to process the 

audio data. 

Each record pass gets placed in the audio track as a single soundbite. 

The soundbite also gets added to the list in the Soundbites window. 

You can view the soundbite by opening the Event List window or 

Graphic Editing window of the track. 

MultiRecord mode allows you to record into multiple audio tracks 

simultaneously. It also allows you to record into MIDI tracks at the 

same time as audio tracks. 

The total number of audio tracks you can record into at one time 

depends on your hard disk recording hardware. For example, an 

Audiomedia II card provides two inputs. A single Pro Tools card 

offers four inputs. A core Pro Tools III system provides eight inputs, 

and so on. 

Figure 8-3: A single Pro Tools card allows you 
to record four inputs at once. 

When recording multiple audio inputs at once, you can treat them as 

separate mono inputs or as left/right stereo pairs. In either case, 

Digital Performer records each input into a separate track and stores 

the data on disk as a mono Sound Designer II soundfile. 
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To prepare for MultiRecord: 

1. Check the MultiRecord mini-menu item in the Tracks window. 

2. Make sure the audio tracks you want to record into have different 

input and voice assignments as shown in Figure 8-3 on page 79. 

In Digital Performer, two tracks with the same voice assignment 

cannot be record-enabled simultaneously. The same is true for 

two tracks with the same input assignment. 

3. Record-enable the tracks you want to record into. 

If the track’s record button is missing, the track has become 

unregistered. See “Re-registering tracks” on page 67. 

Figure 8-4: A typical track setup for stereo recording. 

4. (Optional) Record-enable as many MIDI tracks as you want. 

See “Recording audio and MIDI at the same time” on page 81 

for more information. 

5. In the Audio Monitor, prepare each input as described earlier in 

this chapter, paying special attention to the hard disk location of 

the takefile for each input. 

Are all inputs being recorded onto the same hard drive? Does 

your hard disk recording system have special requirements 

when recording more than one input at a time? Most systems 

can easily handle two inputs on the same hard disk. Pro Tools 

can handle four inputs on one disk, as long as it is an officially 

recommended disk. Systems with more than four inputs usually 

require that inputs be recorded onto separate disks. Check the 

documentation for your hard disk recording system for these 

special requirements. 
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Recording in stereo Use MultiRecord to record in stereo as described in the previous 

section and shown in Figure 8-4 above. To do so, enable MultiRecord 

mode and set up two audio tracks assigned to separate voices (such 

as voice 1 and 2). Use the track names to indicate that they are a 

stereo pair, such as Vocals/L and Vocadls/R. You'll also probably want 

to place both takefiles into the same folder. 

Recording audio and In MultiRecord mode, you can record audio data and MIDI data at the 

MIDI at the same time same time. Just record-enable all the tracks that you want to record 

into. Make sure the input MIDI channel assignments are set properly 

for the MIDI tracks. For more information about using MultiRecord 

with MIDI tracks, see “Auto-Record” on page 136 of the MIDI 

Reference manual. 

Punching in and out Digital Performer provides both manual and automatic punch-in, 

with the following exception: Pro Tools systems with a System 

Accelerator (SysAxe) do not allow manual punch-in. This system 

requires that you use auto punch-in as described below. 

In all cases, Digital Performer only allows you to punch in once per 

record pass. This means that you cannot punch in and out multiple 

times in a single pass. Instead, you have to stop Digital Performer’s 

transports after you punch in the first time and before you can punch 

in again. 

Automatic punch-in produces the most accurate results possible 

when punching in. When you punch-in manually, there may be a 

brief delay—on the order of a few hundred milliseconds—before 

recording actually begins. 

To manually punch in, press play and then press the record button in 

the main transports at the desired time. Press record again to punch 

out. You can also use the 3 key on the Macintosh extended keypad. 

Audio track record-enable buttons Figure 8-5: To punch in manually, use the 
cannot be used to punch in on the fly. record button in the main transports. 
MIDI tracks can, however. 
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To punch in automatically, set up Digital Performer’s Auto Record 

feature in the Consolidated Control panel as shown below in Figure 

8-6. For information, see “The Auto Record Bar” on page 82 of the 

MIDI Sequencing reference manual. 

Figure 8-6: Use the Auto Record button in the main transport controls to automate 
punch-ins on audio tracks. This process works the same as for MIDI tracks. 

You cannot punch in using the record-enable buttons next to audio 

tracks in the Tracks window. Instead, you must record-enable the 

track before you begin playback and then use either the record 

button in the main transport controls or the Auto Record feature as 

described above. 

Cycle-recording When cycle recording with the memory shuttle feature, Digital 

Performer automatically punches out at the end of the cycle if any 

audio tracks are recording. 

Overdub recording To understand how Overdub Record mode works with audio tracks, 

consider first how overdub works with MIDI tracks: newly recorded 

notes are merged with existing notes in the track. Any existing 

material in the track is left untouched, and the new material is added 

to it. 

Overdub works the same way with audio tracks: newly recorded 

soundbites are simply “overlaid” on top of the existing ones, leaving 

existing soundbites in the track untouched. 

82 Recording Audio 



How audio is recorded 
on disk 

Getting an error 
message 

Recording Audio 

@ Note, however, that the waveforms of each soundbite 

are not merged. To merge soundbites together into 

one soundbite, use the Mix command in the Audio 

menu. 

When the track plays back after overdubbing, it plays one soundbite 

at a time. Each soundbite takes over playback as it occurs in the track, 

and keeps playing until it ends or another soundbite begins. See 

“Overlapping soundbites and track priority” on page 63 for more 

information about how multiple, overlapping soundbites play back in 

a track. 

Digital Performer, Sound Designer II, and other Macintosh-based 

digital audio recording systems record audio data in much the same 

way. Audio data gets recorded onto the hard disk in the form of an 

audio file: you press record in Performer, play in some music, and the 

audio signal is encoded digitally in the audio file. 

Digital Performer automatically creates a separate audio file for each 

record take. Every time you press the record button, record some 

music, and then stop, Digital Performer automatically creates a new 

audio file when you start recording, records the audio data into the 

audio file as you play, and then closes the audio file when you press 

stop. Digital Performer immediately readies another audio file for the 

next take while inserting the last one into the audio track at the 

appropriate time and adding it to the list in the Soundbites window. 

Both Digital Performer and the Digidesign Audio Engine (DAE) keep 

close track of whether or not they had any trouble processing the 

audio data during recording. If conditions prevent them from 

successfully encoding all the digital audio information, you will be 

presented with an error message letting you know that an error 

occurred. These errors can be due to conditions such as: 

m AppleTalk was accidentally left active in the Chooser 

mw Other background software interruptions (such as FAX 

modem software, etc.) 

= A highly fragmented hard disk 

= A hard disk that has an access time that is too slow 

mw Other interruptions 

See chapter 20, “Audio Troubleshooting” (page 225) for more 

information about how to handle error messages. 
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Chapter 9 The Audio Monitor 

Quick reference 

Input(IN) 

Level meters 

Note! If you have a TDM system, 
see “Monitoring input levels on 
TDM systems” on page 186. 

Takefiles 

The Audio Monitor displays important information about recording 

for each digital audio input. 

Figure 9-1: The Audio Monitor window. 

The leftmost column in the Audio Monitor indicates each audio input 

provided by your hardware. 

The level meters work like a standard VU meter on a mixing console. 

They indicate the amplitude of audio being recorded on each input. 

The meters in the Audio Monitor show input levels only. Playback 

levels are displayed in the level meters in the Mixing Board window. 

(See “Viewing audio track levels in the Mixing Board” on page 68.) 

The Level Range mini-menu command allows you to change the 

range of the meters from 6 dB to 42 dB. 

The Takefile column displays the name of the audio file that will 

contain the next portion of audio to be recorded on each input. As 

soon as you record-enable an audio track, Digital Performer 

automatically creates an audio file with a temporary name, 7akefile, 

followed by an input number and a take number. For example, 

Takefile Ch2-15 indicates channel (input) 2, take 15. Here’s a brief 

summary of what you can do with takefile names: 

To do this: Do this to the takefile name: 

To rename the takefile Option-click 

To relocate the takefile Double-click 

To select one or more takefiles for Click (or shift-click) 

mini-menu commands 
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Available record time Displays the total amount of time available for recording on the hard 

disk where the take file is currently located. Time is displayed in 

minutes and seconds. Click the value to toggle between 

minutes:seconds and megabytes (Mb). Option-click to toggle all 

inputs at once. One minute of audio at 44.1 kHz takes up about 5 Mb 

of hard disk space. 

Take Folder Displays the current location on disk of the takefile. Click to toggle 
the display between showing the full path name and the abbreviated 

path name. 

Mini-menu quick Set Take Folder: lets you change the location of the currently selected 

reference takefile(s) in the Audio Monitor window. Click, shift-click, or use 

Select All to highlight the take file names before choosing this 

command. 

Level Range: lets you choose among several different level ranges for 

the meters in the Audio Monitor, from 6 dB to 42 dB. 

Retain Clip: when checked, this command causes the clip indicators to 

remain lit after clipping has occurred (instead of only remaining lit as 

clipping occurs). Click the clip indicator to turn it off. 

Input Level (Audiomedia I or II card only): Lets you set the input level for 

the Audiomedia card inputs. 

Microphone Input (Audiomedia I card only): Enables the Audiomedia 

card's high-impedance mic input. 

Naming a takefile before If you want, you can give the takefile a more appropriate name to 
recording better identify it. To set the takefile name before recording: 

1. Option-click the takefile name in the Audio Monitor. 

2. Type in the desired name. 

3. Press return to confirm or press command-period to cancel. 

To rename the soundfile after it has been recorded, option-click its 

name in the Soundbites window. 

Changing the location of By default, Digital Performer places takefiles into a folder named 

the takefile before Audio Files, which it automatically creates in the project folder when 

recording you first open a new project. If necessary or desired, you can move 

the takefile to a different disk or folder. For example, your hard disk 

recording hardware may require that you record on a specific hard 

drive. Or you may just want to organize your takefiles into folders as 
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you record them for convenience. Each input can be assigned a 

different location, allowing you to record into separate folders and 

even hard drives. For general tips about audio file management, see 

chapter 11, “Audio File Management” (page 109). 

@ When a SysAxe is installed, Digital Performer 

automatically locates the current take folder for each 

takefile on the SysAxe drive(s). 

To change the location where a takefile will be recorded: 

1. Double-click the takefile name in the Audio Monitor. 

Alternately, you can click the takefile name once to highlight it 

and choose Set take folder from the mini-menu. The Change 

Directory dialog box appears. 

Choose a take folder for audio channel 1: 

=] Audio Files ¥ 

Directory 

Pop-up 
menu 

Select “Audio Files" [New Folder] 

Available disk space: 36.1 MB 

Available mono recording time: 7:09.00 

2. If necessary, use the Drive button and directory pop-up menu to 

navigate to desired folder or location on your hard disk. 

3. If you want to create a new folder, click New Folder. 

4. If you want to select an existing folder, click the folder’s name in 

the list to highlight it, and click Select or type command-S. 

Changing the takefile To change the takefile location for all inputs at one time, click and 
location for several (or shift-click the takefiles you want to change and then choose Set Take 

all) inputs once Folder from the Audio Monitor mini-menu. 
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Organizing audio files Use this capability to organize your audio files. For example, let’s say 
into folders as you go you're currently adding the following to a sequence: backup vocals 

on input 1 and acoustic guitar on input 2. And you know you will be 

recording at least several takes for each part, thus creating several 

audio files for each. 

In this situation, you might find it handy to place the vocal takes into 

one folder and guitar takes (record files) into another so that you 

don’t get the vocal audio files mixed up with the guitar audio files. (it 

isn’t absolutely necessary to separate record files like this, but the 

more takes you record, the easier it will be to sort through them later 

on if necessary.) 

Checking the current The current location of the takefile for each input is shown in the 

takefile location Take Folder column in the Audio Monitor as shown below. 

The abbreviated take file The full path name 
location is shown as the hard of the take file 
disk and folder name location is shown 
separated by two colons. with single colons. 

To view the full path to the takefile’s location: 

1. Click the take folder location as shown below. 

Click here to toggle between full 
and abbreviated path display. 

2. Click the window’s resize button in the title bar to expand the 

window so you can see the full path name. 

Click the resize 

button to 

expand the 
window. 

3. Click the resize button again to return the window to is original 

size and position. 
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Remembering takefile 
locations 

Adjusting the level meter 
range 

Using the clip indicator 
to avoid clipping 

The Audio Monitor 

Digital Performer remembers the takefile location settings when you 

save the file so that it will remember to put takefiles in the same 

folder the next time you record. If you like, you can save takefile 

locations in your new template file using the Save As New Template 

command. 

By default, the level meters have a full range from -42 dB to zero dB 

(clip). The Level Range mini-menu command lets you adjust the 

range to as small as 6 dB. Just choose the desired range from the 

menu. You can even change it during recording. For a signal with a 

wide dynamic range, use a larger value; for a signal with a fairly 

consistent and narrow dynamic range, use a smaller value and record 

it as close to zero as possible. But be sure not to clip. (See the next 

section.) 

@ The Level Range setting here in the Audio Monitor 

also controls the dynamic range of the output level 

meters in the Mixing Board window. 

Each sample in a digital audio signal is expressed as a number within 

a certain range. Un 16-bit audio, the value of each sample is 

expressed as a binary number containing 16 bits, which provides a 

range of over sixty five thousand values.) If the level of audio being 

recorded or played back exceeds the range that can be expressed, the 

result is clipping. Those portions of the audio waveform that exceed 

the maximum value of the dynamic range get cut off at the maximum 

value that can be expressed. This causes the top of the waveform to 

get chopped off, giving it a shape more like a square wave, as shown 

below. The clipped audio signal on the left will sound distorted: 

Clipped Not Clipped 
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When clipping occurs, the level meter’s clip indicator will light up as 

shown below: 

Clip indicator 

Retain clip If Retain Clip is checked in the Audio Monitor mini-menu, the clip 

indicator lights up at the first occurrence of clipping and remains lit 

as a reminder that clipping has occurred. To clear the clip indicator, 

click it. This is a convenient way to keep track of clipping without 

having to stare continuously at the meter. 

@ The Retain Clip setting here in the Audio Monitor 

also affects the clip indicators of the output level 

meters in the Mixing Board window. 

Clearing the clip Click an indicator to clear it. Double-click it to clear all indicators. 

indicators 

Setting the input level When recording, get as high a level as possible without any clipping. 

Before you record, always sample the entire range of the audio input 

you will be recording and adjust the input level accordingly. Ideally, 

the loudest part of the signal should peak just below zero dB (when 

the meter is all the way up without the clip light). Digital clipping is 

harsh, with virtually no headroom, so try to avoid it as much as 

possible. 
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Audio Patch thru 

Adjusting the input level 
for Audiomedia | and Il 

Enabling the mic input 
for Audiomedia | 

The Audio Monitor 

When the Audio Patch Thru button is enabled in the Audio Monitor 

mini-menu title bar, audio received on a record-enabled audio input 

is echoed to the hardware’s audio outputs so that the signal can be 

monitored from the recording hardware’s outputs. 

Audio Patch Thru button 

@ The Audio Patch Thru button in the title bar of the 

Audio Monitor window does not appear when TDM 

hardware is present. For details, see “Monitoring 

input levels on TDM systems” on page 1860. 

If you do not need to monitor the incoming audio via the outputs of 

the audio hardware’s outputs, disable Audio Patch Thru. 

The /nput Level command appears in the Audio Monitor mini-menu 

when you have an Audiomedia I or II card in your system. This 

command lets you set the input level for the Audiomedia card inputs. 

The Microphone Input command appears in the Audio Monitor mini- 

menu when you have an Audiomedia I card in your system. This 

command enables the Audiomedia card's high-impedance mic input. 
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Chapterio The Soundbites Window 

This chapter assumes that you are familiar with terms like audio file, 

region, soundbite, playlist, Sound Designer II file, and audio track. If 

you aren’t familiar with these terms, review chapter 6, “Hard Disk 

Recording Basics” (page 47). 

As you work with Digital Performer, you’ll create many soundbites. 

The soundbites window helps you manage them. Think of the 

Soundbites window as your “catalog” of audio data. It lists all of the 

portions of audio that you are dealing with in the file. It helps you 

keep the ones you want and throw away the ones you don’t.. 

Quick Reference 
Duration Channels 

Move Handle Indicates the length of the sound- Indicates the number of audio 
Drag up or down to reposition the sound- sey snide h ded to play back 
ie : bite in minutes, seconds, and cnannels needed to play Dac 

bite in the list. Also use it to drag and drop th dbite. F 
4 hundredths of a second. Durations € sounabite. ror example, a 

the soundbite into the Tracks overview, ; eis ae can be expressed in SMPTE and stereo soundbite, which contains 
event list, or graphic editing windows. separate left and right channel 
Command-drag to make it “snap” to the real time when soundbites are ' and rig 

displayed in an event list. signals, requires two channels. 
end of the previous soundbite in the track. 

This icon means that Digital 
Performer does not currently know 
the location of the audio file 
containing the soundbite. The 
soundbite can’t be played and its 
waveform can’t be displayed. 

This icon means that Digital Performer 

cannot currently play the soundbite for 
some reason. For example, it may be 
located on a hard disk that isn’t supported 
by your hard disk recording hardware. 

Sample Rate Soundbite Name Audio File 
Indicates the rate in Displays the name of the soundbite This is the name of the audio file 

samples per second at (region). Click the name to select it. To that contains the soundbite. Audio 

which the audio data hear it play back, turn on Audible Mode in _ files can have one of the following 
making up the soundbite __ the title bar and then click it. Option-click formats: Sound Designer, Sound 
was sampled. to pop-edit the name. Double-click the Designer Il, or Audio IFF. Double- 

name to edit the soundbite ina separate _ lick to replace or relocate the 
waveform editor program such as Sound Soundbite. Option-click to change 
Designer II. the name of the audio file. Click it 

to show the full path name. 
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Mini-menu Add Soundbite: Opens a dialog box that allows you to audition and 
load audio files, soundbites (regions), and playlists (a sequence of 

regions). 

Sort by name: Reorders the soundbites alphabetically by their names. 

Sort by size: Reorders the soundbites in the list by their size on disk. 

The shortest one appears at the top of the list and the longest at the 

bottom. 

Sort by soundfile: Reorders the soundbites by the names of their parent 

audio files, with the audio files listed alphabetically. 

Select unused soundbites: Highlights all soundbites in the list that are 

not currently being used in any tracks in any sequence in the file. 

Once highlighted, these soundbites can be removed from the list with 

the Delete command. 

Compact: Caution! Unlike Delete, this command actually removes 

audio data from the hard disk. It cannot be undone. Compact 

removes all portions of the parent audio file of the currently selected 

soundbite(s) which are not defined as a region in the audio file 

region list. This command can be used to remove unused audio data 

in One or more audio files to free up space on the hard disk. 

Remove from list: Deletes the soundbite from the Soundbites window 

list without deleting its corresponding region in the audio file region 

list. 

Delete: Removes the selected soundbites from the list. This command 

does not delete audio data on the hard disk. It removes Performer’s 

reference to the data from the Soundbites window. If the soundbite 

is the last one in the parent audio file to be deleted, Performer asks if 

you would like to delete the parent audio file entirely. 

Recording soundbites in A new soundbite is created in Digital Performer every time you 

Digital Performer record audio. For example, when you record-enable an audio track, 

hit the record button, play in some audio, and press stop, you have 

just created a soundbite in the track. In addition, the soundbite gets 

added to the list in the Soundbites window. 

Generating soundbites Soundbites can also be created in Digital Performer with soundbite 

while editing editing commands like Trim, Split, and Strip Silence. For example, 

when you select a portion of the existing soundbite and choose Trim, 
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the unselected portions get stripped away, and the highlighted 

portion that you are left with is a new soundbite. As always, the new 

soundbite gets added to the list in the Soundbites window. 

Impor ting soundbites, Soundbites (audio regions), playlists and audio files can be imported 

playlists, audio files into Digital Performer from existing audio files. For example, if you 

created a Sound Designer I file that contains regions, you can load 

the regions into Digital Performer. In Digital Performer, regions 

appear as soundbites in the Soundbites window. Once imported, 

soundbites can be placed into audio tracks. 
Import Audio button 

To import a soundbite from an audio file: 

1. Choose Add Soundbite from the Soundbites window mini-menu, 

or press the Import Audio button in the title bar. 

The standard import audio dialog box appears. 

2. Select the desired soundbite(s) as shown below. 

Locate and select the audio file here This area shows audio files, audio regions This area shows what audio files or 

using the directory pop-up menu (soundbites) and playlists created and regions (soundbites) you have selected to 

above the list and the Eject and stored in the audio file by Digital be loaded into Digital Performer. Double- 
Desktop buttons below buttons. Performer or other audio programs. click them in the other two lists to add 

Banion.. | Audis file them here (or use the Add button.) 

] Audio Files ¥ \ $s in current file: Items currently chosen: § 

<| E) Drum Loop 
a Scratch 

Strings Hit.SDII 
x Drum Loop! 

i Drum Loop! 

This list greys out if you 
have a SysAxe installed 
and you are looking ata 
non-SysAxe hard drive. | (Desktop } (, Done _| 

| Sound File: Drum Loop ¥ 

File Type: Sound Designer II 
Sample Rate; 44100.000 

Sample Size:| 16 Bit Mono 

Duration: 0:00:02.14 

1 11/9/93-2:28 PM 

This area shows infor- When you are finished Use the Add and Remove buttons to Use these controls to 
mation about the selecting what you want choose what audio files and regions audition the currently 
currently selected audio. to import, click Done. (soundbites) you want to import selected audio. 

(shown in the right-hand list). 

Figure 10-1: Importing audio into Digital Performer. 
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Importing a playlist 

The imported audio files or regions appear at the bottom of the list in 

the Soundbites window. The soundbite’s parent audio file is listed on 

the right. If the soundbite already exists in the list, it will not be 

loaded twice. You can insert the imported audio at any location in 

Digital Performer audio tracks. 

Some audio editing programs, such as Sound Designer II, allow you 

to build playlists. A playlist is series of regions placed edge to edge in 

a particular order for playback. Since the regions within the playlist 

are merely pointers to the audio data in the audio file, you can 

arrange them with great flexibility without altering the original audio 

data. For example, you could record 4 bars of music and then define 

a handful of regions consisting of single measures and even single 

beats. You could then arrange them in a playlist in various 

combinations, mixing and repeating them in a musical fashion to 

generate a playlist that lasts for several minutes—all with only 5 

seconds of music. 

Like regions, playlists are stored in the audio file, along with the 

audio data, and they can be imported into Digital Performer just like 

audio regions. Please note, however, that Digital Performer does not 

load playlist cross-fades. 

To import a playlist, use the same procedure as described in 

“Importing soundbites, playlists, audio files” on page 95. The playlist 

appears as an audio track in the Tracks window with the same name 

as the playlists. The regions making up the playlist get added to the 

Soundbites window list. 

Figure 10-2: A playlist imported into Digital Performer appears as an audio track that 
contains all of the constituent soundbites (regions) in the playlist. In addition, all 
regions in the playlists are added to the list in the Soundbites window. 
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Importing an entire 
audio file 

Loading soundbites 
from other Digital 
Performer files 

The Soundbites Window 

An entire audio file can be imported using the procedure described 

in “Importing soundbites, playlists, audio files” on page 95. Just select 

the audio file name, which is displayed with the audio file icon as 

shown below, and click Add: 

Region Audio 
(soundbite) file 

icon icon 

Items in current file: Items currently chosen: | 

Dirt Gruve 

fhe 

Figure 10-3: An audio file that has been imported into Digital Performer 
appears as a sounabite with its matching audio file name listed on the right. 

You may encounter a situation in which you have created soundbites 

in another Digital Performer file and you would like to work with 

them in the current Digital Performer file. To load soundbites from 

another Digital Performer file: 

, Choose Load from the File menu. 

The standard Macintosh Open dialog box appears. 

Open the file that contains the soundbites you wish to load. 

Digital Performer’s Load dialog box appears. 

. Click the Load soundbites option. 

Click any other items you wish to load and click OK. 
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Converting soundbites When you import soundbites into Digital Performer, it may be the 

that cannot be played case that they cannot be played properly. The most common causes 

for this are: 

= The imported audio’s sample rate does not match the 

playback sample rate currently chosen in the Configure 

Hardware dialog box, which means that the audio will 

play back at the wrong speed. 

m= The audio is an interleaved stereo audio file CDAE 

cannot currently play interleaved stereo audio files). 

m You have a SysAxe system and the audio file is currently 

located on a hard drive other than the SysAxe drive, 

which means that the SysAxe cannot play it. 

In any of these cases, Digital Performer presents the Convert Sound 

Files dialog box shown below: 

muert sound Files | 

To de-interleave a stereo audio file, 

Click its name to highlight it (shift-click 
to select several) and click Convert. 

nternal HD 

Internal HD 

Internal HD 

Internal HD 

“~y Aplause 2.5DI1/ Internal HD 

“yy Aplause 1.SDI1I Internal HD 

To convert the sample rate of an audio 

file, you have to do so in another 
program such as Sound Designer Il. 

This dialog box shows which audio files cannot be played, and it 

underlines the reason why, as shown above. In the case of stereo 

soundbites, Digital Performer allows you to highlight them in the list 

and then click Convert to generate two separate mono soundfiles. 

The original stereo audio file is preserved. Click Replace to locate the 

two mono files corresponding to the left and right channels of the 

stereo file. 
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Managing soundbites 

Sorting the soundbites 
list 

Sorting by audio file 

The Soundbites Window 

For SysAxe systems, soundbites located on non-SysAxe drives must 

be moved or copied to the SysAxe drive from the Finder. 

To convert the sample rate of a file, use a program like Sound 

Designer II. 

As you work with Digital Performer, you'll create many soundbites. 

The Soundbites window helps you manage them. Think of the 

Soundbites window as your “catalog” of audio data. It lists all of the 

portions of audio that you are dealing with in the file. It helps you 

save the ones you want to keep and throw away the ones you don’t. 

The Soundbites window mini-menu provides several ways for you to 

list soundbites: alphabetically, by parent audio file, and by size. For 

example, if you would like to see all of the soundbites that belong to 

a particular audio file, choose Sort by audio file. All soundbites 

belonging to an audio file will be listed together. Or, if you need to 

see which soundbites are largest, sort by size. 

When you choose one of these options, the soundbites in the list get 

re-ordered accordingly. Keep in mind, however, that re-ordering does 

not continue automatically. New soundbites are always added at the 

bottom of the list. In addition, soundbites that you re-order by 

dragging remain so until you choose one of these commands. Choose 

one of the sort by options to re-establish the ordering that you wish. 

Use the Sort by audio file option in conjunction with the other two 

options. The sort by audio file command lists audio files alphabeti- 

cally, and groups together all soundbites from a particular audio file. 

For example, all the soundbites from audio file A would be listed at 

the top, followed by soundbites from audio file B, and so on. 

Once grouped by audio file, the order depends on what it was in the 

list before you chose sort by audio file. 

If you want soundbites within each audio file listed alphabetically: 

1. Choose Sort by name first. 

2. Then choose Sort by audio file. 

If you want soundbites within each audio file listed by size: 

1. Choose Sort by size first. 

2. Then choose Sort by audio file. 
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Auditioning soundbites 
with Audible Mode 

Renaming a soundbite 
| 

Figure 10-4: Renaming a soundbite 

7100 

There are two ways to audition (play back) a soundbite in the 

Soundbites window: 

1. Click the Audible mode icon so that it is highlighted. 

2. Click the name of the soundbite you wish to hear. 

3. To stop playback, wait for the soundbite to finish playing, or click 

the mouse. 

Alternately, you can do the following, regardless of whether the 

Audible mode button is highlighted or not: 

1. Highlight the name of the soundbite you wish to hear. 

2. Option-click the Audible Mode button. 

3. To stop playback, wait for the soundbite to finish playing, or click 

the mouse. 

To rename a soundbite in the soundbites window, option-click its 

name. 

Audio file 

| Audio data | 

Regions 

Hi bit 
Turnaround 

Playlists 

When you change the name of a soundbite, Digital Performer 

updates the name of the corresponding region in the audio file. For 

example, if you use the Split command to create a new soundbite, it 

appears in the Soundbites window with a name like Soundbite.3. 

Digital Performer adds a new region to the audio file region list called 

Soundbite.5 as well. At this point, if you open the audio file with 

The Soundbites Window 



Lost soundbites 

Finding lost soundbites 

Soundbites that cannot 
be played 

The Soundbites Window 

Sound Designer II, you would see Soundbite.3 in the region list. If 

you change the name of Soundbite.3 to Low whistle in Digital 

Performer’s Soundbites window, Digital Performer updates the name 

of Soundbite.5 to Low whistle in the audio file region list as well. 

At times, Digital Performer may lose track of the location of an audio 

file. For example, the audio file may have been dragged to the trash 

since the Digital Performer file was last saved. Or the hard disk on 

which the audio file is located may be off line at the moment. In this 

case, Digital Performer displays the move handle of the soundbite 

with a question mark as shown below: 

Figure 10-5: Digital 
Performer displays this icon 
when it does not currently 
know the location of the 
audio file containing the 

If Digital Performer does not know the location of a soundbite as 

shown in Figure 10-5, you can remind Digital Performer where it is 

using the Replace Soundbite command in the Audio menu. Click the 

name of the soundbite to highlight it and choose Replace Soundbite 

from the Audio menu. Use the Replace Soundbite window to relocate 

the audio file. For more information, see “Replace Soundbite” on 

page 172. 

Some hard disk recording systems, such as Pro Tools with a System 

Accelerator or Session 8, require audio files to be located on a 

particular hard drive. If an audio file is not located on the necessary 

drive, DAE cannot play it back. In this case, Digital Performer 

displays an “X” icon as shown below: 

Figure 10-6: Digital 
Performer displays this icon 
when it cannot play back the 
soundbite for some reason. 

To make the soundbite playable, move the soundbite’s parent audio 

file Gits name is displayed to the right of the soundbite in the 

Soundbites window) to the appropriate hard drive by dragging it in 

the Finder. If you aren’t sure which hard drive to drag it to, check 

your hard disk recording system’s documentation. Don’t worry about 
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Digital Performer losing track of the audio file: Digital Performer uses 

System 7’s alias manager to keep track of audio files regardless of 

where you drag them. 

@ [MPORTANT: If you copy an entire project to 

another volume and don’t delete the original, then 

when you open the copied project file, it will still be 

using the original audio files, not the copied audio 

files in the copied project folder. System 7 aliases do 

too good of a job keeping track of audio files and 

will continue to use the originals. Use the “Replace 

Soundbite” command to relocate your audio file 

sources. See “Replace Soundbite” on page 172. 

In some rare cases, you might see this icon even when the audio file 

is already located in the correct location. If so, try reconfiguring the 

hardware with the Configure Hardware command in the audio menu. 

Also check available memory for Digital Performer and DAE. 

Selecting unused While you work with Digital Performer, you may find that you have 

soundbites many soundbites in the list, but some of them are not going to be 

used in the sequence and are no longer needed for any other 

purpose. 

The Select unused soundbites command searches through every track 

in every sequence in the file to determine which soundbites are being 

used in a track and which ones are not. It then highlights all the 

soundbites that are not being used. Once highlighted, you can 

inspect, audition, delete, or group them as desired to clean up the list. 

To select unused soundbites, choose Select unused soundbites from 

the Soundbites window mini-menu. All soundbites that are not being 

used in a track become highlighted in the Soundbites window list. 
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Deleting soundbites The Delete command in the Soundbites window mini-menu removes 

currently selected soundbites from the list. In addition, the 

soundbite’s corresponding region is removed from the audio file 

region list as shown in Figure 10-7 below (unless the region is being 

used as part of a playlist in the audio file). 

Note that the Delete command does not remove the actual audio data. 

It simply removes the region and its pointers, which are merely a 

reference to the audio data in the file. To delete the audio data itself, 

you need to use the Compact command. See “Compacting audio 

files” on page 113. If you do not want Performer to remove the 

region from the audio file region list (because it is used in another 

Performer file, for example), use the Remove from list command 

described in the next section. 

Audio file (before deleting) Audio file (after deleting) 

Regions 

Hi bit 
Turnaround 

Regions Playlists Playlists 

Figure 10-7: Deleting soundbites removes their corresponding region in the 
audio file. Just the region and its pointers are removed; not the actual audio data. 

The Soundbites Window 

To delete one or more soundbites: 

1. Select the soundbite by clicking its name. Shift-click or drag to 

select multiple soundbites. 

Alternately, you can use the Select unused soundbites command 

in the Soundbites window mini-menu (described in the previous 

section). 
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2. Choose Delete from the Soundbites window mini-menu. 

If the soundbite is being used in a track, Performer presents a 

warning box as shown below. As a shortcut, hold down the 

option key while choosing Delete from the mini-menu to bypass 

the warning dialog. 

The soundbite "Comp two" is being usedin | 

an audio track or the clipboard. Do you 

really want to delete it? 

Removing soundbites There may be times that you wish to delete a soundbite from the list, 

from the soundbites list but you do not want to delete its corresponding region in the audio 

without deleting their file region list as shown in Figure 10-7 on page 103. For example, the 

corresponding region in region might be part of a sequence in another Digital Performer file. 

the audio file In this situation, use the Remove from list command. 

Once this command severs the connection between the soundbite 

and the region in the audio file, you won’t have access to the region 

unless you import it again. (See “Importing soundbites, playlists, 

audio files” on page 95.) Also, when using this command, keep in 

mind that you cannot compact the audio data in the region with the 

compact command without first importing it and then deleting the 

soundbite. (See “Compacting audio files” on page 113 for more 

information.) 

To remove a soundbite from the Soundbite window list without 

deleting its corresponding region from the audio file region list: 

1. Select the soundbite by clicking its name. Shift-click or drag to 

select multiple soundbites. 

Alternately, you can use the Select unused soundbites command 

in the mini-menu. 

2. Choose Remove from list from the Soundbites window mini- 

menu. 

If the soundbite is being used in a track, Performer presents a 

warning box. Click yes if you still want to remove it; click no to 

cancel the command. 
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Audio file (before) Audio file (after) 

Audio data 

Regions Playlists 

i bi i bit 
Turnaround Turnaround = 

Figure 10-8: The Remove from list command leaves the region list in the audio 
file untouched. You can re-import the soundbites later, if desired. 

Deleting the last 
soundbite in an audio 
file 

Deleting an audio file 
that contains regions 

A shortcut for deleting 
audio files 

The Soundbites Window 

If you delete a soundbite, and it is the last soundbite belonging to a 

particular audio file, Digital Performer asks you if you wish to 

completely remove (delete) the audio file from the hard disk: 

The soundfile “Takefile-1.5” no longer 

contains soundbites or regions. Do you 

want to delete it from the hard disk? 

(This can't be undone.) 

Remember, Digital Performer is cautious about deleting audio data: it 

never deletes audio data that is possibly being used in other files. 

Therefore, if an audio file has regions in its regions list, Digital 

Performer won’t allow you to accidentally delete it. 

If an audio file contains regions, but you are absolutely sure that you 

want to throw away the file, you can do so by dragging the file into 

the trash in the Finder. 

If you are absolutely sure that you don’t need a file anymore, you can 

bypass warning dialog boxes by holding down the option key while 

you choose Delete from the mini-menu. Digital Performer proceeds 

as if you answer Yes to both warning boxes. 
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Getting rid of unused After a recording session with Digital Performer, you can quickly get 

soundbites after a rid of all the soundbites that you did not use in a track as follows: 

session 
1. Choose Select unused soundbites from the Soundbites window 

mini-menu. 

This highlights all soundbites that are not being used in a track. 

2. Hold down the option key and choose Delete from the 

Soundbites window mini-menu. 

All of the highlighted soundbites are removed from the list, and 

their parent audio files are deleted from the hard disk. 

Compacting audio files The Compact command in the Soundbites window mini-menu 
deletes portions of an audio file that are not part of a soundbite and 

then closes the gaps between the leftover regions. This is one of the 

few ways to destructively edit audio data from within Digital 

Performer. For more information, see “Compacting audio files” on 

page 113. 

Draggin and dropping You can “drag and drop” soundbites into the Tracks window 

soundbites overview, event lists, and graphic editing windows. To do so, grab 

the move handle of the soundbite as shown below in Figure 10-9 and 

drop it on top of the desired window’s data region. 

In the Tracks overview the soundbite is placed at the beginning of the 

grid segment you drop it into. If you hold down the command key 

while dragging, the soundbite will “snap” to the end of the previous 

soundbite from the drop point or to the beginning of the track. 

In the graphic editing window, the soundbite is placed where the 

cursor is located when you drop. If you hold down the command key 

while dragging, the soundbite will “snap” to the end of the previous 

soundbite in the track from the drop point or the beginning of the 

track. For more information, see “Dragging and dropping audio from 

the soundbites window” on page 137. 

In an event list, the soundbite is placed end-to-end with the last 

soundbite at the bottom of the list. For more information, see 

“Dragging soundbites into the event list from the Soundbites 

window” on page 121. 
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Figure 10-9: Dragging and dropping Soundbites into the Tracks window track overview. 
Soundbites can also be dropped into graphic editing windows and event lists. 

More about soundbites... 

The Soundbites Window 

There are several other commands that affect soundbites. 

Reload Soundbite 

Reload Soundbite updates a soundbite to match its corresponding 

region in the audio file. For example, if you tweak the pointers 

(boundaries) of a region in an audio file, the Reload Soundbite 

command loads those new boundaries into the soundbite. This 

command is useful after using the Edit in Waveform Editor command 

(see below). For more information, see “Reload Soundbite” on 

page 168. 

Replace Soundbite 
Replace Soundbite replaces a soundbite with a completely different 

region. For example, if you have inserted a soundbite called Riff in 

many places throughout your sequence, but later you record a better- 

sounding riff, you can quickly replace the old one with the new one 

using Replace Soundbite. For more information, see “Replace 

Soundbite” on page 172. 

Edit in Waveform Editor 

Edit in Waveform Editor switches you directly into waveform editing 

software such as Sound Designer II to edit the soundbite using their 

powerful sample editing features. Once there, you can edit the sound 

data itself, such as edit the waveform with a pencil tool or apply 

digital signal processing. For more information, see “Edit in 

Waveform Editor” on page 174. 
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Chapter 11 Audio File Management 

The Project Folder 

The Audio Files folder 

This chapter tells you: 

m Where audio files are stored on disk 

=» How manage the audio files associated with a Digital 

Performer project 

a How to get rid of unused audio 

= How to reclaim hard disk space using the Compact 

command 

When you first create a new file, Digital Performer sets up Project 

folder in which it places your new Digital Performer file, as well as 

an empty folder titled Audio Files. As you record, Digital Performer 

places all of the audio files into the Audio Folder, unless you tell it to 

put them elsewhere before you record. (See “Changing the location 

of the takefile (optional)” on page 77.) 

Album Project 

In future versions of Digital Performer, the Project folder will likely 

store additional documents related to the project. 

The Audio Files folder keeps track of all of the audio files for a Digital 

Performer project. In a new project, takefiles are initially located in 

the Audio Files folder by default. You can record an entire Digital 

Performer session without concern for the location of the audio files 

you record because Digital Performer will automatically store them 

by default in this folder. However, audio files do not have to be 

located in this folder. For example, you might import an audio file 

into the project that is located on another hard drive. Or you might 
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want to record audio on another hard drive that has much more free 

space on it. (See “Changing the location of the takefile (optional)” on 

page 77.) 

Aliases in the Audio When you record, import, or move audio files to a location other than 

Files folder the project’s Audio Files folder, Digital Performer automatically 

creates Finder aliases for them in the Audio Files folder. An alias is an 

icon that is a reference to its original, “parent” file. Aliases are very 

small. If you use the Finder’s Get Info command on them, they have 

a Find Original button that lets you easily locate their parent file. 

Aliases help you keep track of the audio files associated with the 

project. 

These audio files are located elsewhere, perhaps 
even on a different hard disk, but since they are 
being used in the file “Joe’s Blues”, Digital 

Performer automatically puts aliases for them 
here in the project’s Audio Files folder so that you 
(and Digital Performer) can always find them. 

ie Joe's Blues Project = 
2 items 223.4 MB in disk 18.6 MB a 

: 4K on disk (550 bytes used) 

: PowerPC; Joe's Blues Project: 

Audio Files : 

| aie —— 

_fudio Files = Se Created - Mon, Oct 24, 1994, 1:28 PM 
223.4 MB in disk 4.6 MB available | Modified : Mon, Oct 24, 1994, 1:28PM 

= wees Original: J Boat : Digital Performer™ : 

2 Audio Files : Scratch 

aa jo bee bn bon Comments - 

Long Solo Comp 1 Comp 2 Soft comp More solg 

ee bn 
Intro Solo Soft comp.normalized  Takefile Ch2-2 Drumtoge  Soratah 

Oy? Greve 

Figure 11-1: Aliases in the Audio Files folder for audio files that are located at other locations. 

Here are a few examples of how an audio file alias gets created in the 

Audio File Folder: 

m Using the Audio Monitor window, you move a takefile to 

a different hard disk before recording into it. An alias is 

placed in the Audio Files Folder after recording. 

mw Using the Soundbites window, you import a soundbite 

from another folder on the hard disk. The audio file 

remains in its original location, and Digital Performer 

places an alias for it in the Audio Files folder for the 

project. 

110 Audio File Management 



m In the Finder, you drag an audio file out of the Audio 

Files folder and place it in another location (perhaps 

even on a different hard disk). Digital Performer makes 

note of the new location and generates an alias in the 

Audio Files folder for the project. 

Renaming audio files You can rename audio files at any time by editing the file name in the 

Finder or by option-clicking its name in the Soundbites window. In 

either case, Digital Performer automatically updates the name in the 

other location so that they always match. 

$$$ fludio Files <<< , 

11 items 224.7 MB in disk 

ee 
Long Solo Comp 1 

bh 
Soft comp 

Edit the name in the Finder or... ...option-click the audio file name in the Soundbites window. 

Moving audio files As explained earlier in “Aliases in the Audio Files folder” on 

page 110, you can freely move audio files to any location you want 

and Digital Performer will automatically keep track of them using 

aliases in the Audio Files folder. You can even place them ona 

different hard drive. 

If you copy a file onto another volume and delete the original, Digital 

Performer will not know about it and will ask you to find it. 

Copying entire projects If you copy an entire project to another volume and don’t delete the 

to another hard disk original, then when you open the copied project file, it will still be 

location using the original audio files, not the copied audio files in the copied 

project folder. System 7 aliases do too good of a job keeping track of 

audio files and will continue to use the originals. In this case, you 

need to sever the connection with the original audio files and 

establish a new connection with newly copied files. See “Reloading 

all soundbites in an audio file at one time” on page 171. 

Deleting audio files You can delete audio files by dragging them into the trash in the 

Finder. The only drawback to this method is that you can’t view or 

audition the regions that the file contains to verify that you don’t need 

them. If you want to inspect the soundbites in the audio file before 
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deleting it, use Digital performer’s Soundbites window. Open the 

Digital Performer file associated with the audio file (or import its 

soundbites into Digital Performer) and do the following: 

1. Choose Sort by Soundfile from the mini-menu. 

This groups the soundbites together by audio file. 

2. If you want to check the soundbites by listening to them, turn on 

the audible mode button (in the title bar) and click them. 

3. Drag over their names to highlight them. 

4. Choose Delete from the mini-menu and answer Yes when asked 

if you would like to delete the audio file. 

As a shortcut, hold down the option key when selecting the 

Delete mini-menu command to bypass the warning dialog. 

Getting rid of unused Digital Performer provides several simple techniques for permanently 

audio removing unused audio data from the hard drive. You can employ 

these techniques at any time to generate more free hard disk space. 

Just be aware that they permanently remove audio data, so be careful 

when choosing what to delete. The next few sections cover these 

techniques. 

Selecting and deleting The Soundbites window mini-menu has a command called Select 

unused soundbites Unused Soundbites. This command highlights all soundbites in the 

list that are not being used in any track in any sequence in the file. 

(For more information, see “Selecting unused soundbites” on 

page 102.) 

Once highlighted, you can delete the soundbites by choosing Delete 

from the mini-menu. 
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Compacting audio files After a recording session, you should get rid of all the data that ended 
up not being used in any of the tracks to reclaim significant amounts 

of free space on the hard disk. Compacting is a process that deletes 

portions of an audio file that are not part of a soundbite and then 

closes the gaps between the leftover regions. 

All unused audio 
gets removed. 

Audio file before compacting: | — | 

Soundbite A Soundbite B Soundbite C 

Audio file after compacting: 

Soundbite Soundbite B Soundbite C 

Figure 11-2: Compacting removes all audio data that doesn't fall within an existing region. Depending on 
how much unused audio gets removed, this process can free up large amounts of space on the hard disk. 

As shown in Figure 11-2 above, the unused data between soundbites 

is removed, and the remaining soundbites are placed end to end. 

Compacting conserves disk space by removing unwanted data from 

within a file, while preserving data being used for soundbites. 

You can compact all audio files at once or individually. 

When compacting occurs, there is only one criterion for determining 

if data is thrown out: 

@ |s the data part of a region in the audio file’s region 

list? 

If the data is part of a region in the audio file’s region list, it is mot 

deleted. 

If the data is not part of a region, it 7s deleted. 

The key to successfully compacting a file is to make sure that the 

region list in the audio file contains regions that you want to keep, 

and only those regions that you want to keep. 

How do you do this? With the Soundbites window. If you delete a 

soundbite that you want to discard, Digital Performer removes the 

soundbite’s corresponding region in the audio file’s region list (see 
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“Deleting soundbites” on page 103), and the remaining audio data is 

deleted when compacted. Conversely, soundbites that are not deleted 

are not compacted. 

If any audio data in the audio file is being used by other Digital 

Performer files, it is not deleted by these commands as long as you 

have not deleted the region from the audio file’s region list with 

Digital Performer or other sample editing software such as Sound 

Designer II. Digital Performer does not delete any regions in the 

audio file, even if they are not used in the currently open Digital 

Performer file. 

Since compacting results in the erasure of audio data on the hard 

disk, and possibly very large amounts of audio data, this operation 

may take a few moments, depending on how much audio data is 

being removed. 

To compact one or more audio files: 

1. (Optional) Choose Select unused soundbites from the 

Soundbites window mini-menu. 

This highlights all of the soundbites that are not being used in 

any track in the file. These are likely candidates for disposal. 

2. Delete all soundbites from the Soundbites window that you want 

to discard using the Delete command in the mini-menu. 

If necessary, you can audition ones that you aren’t sure about 

using Audible mode. To delete the soundbite, highlight its name 

and choose Delete from the mini-menu. Don't use the Remove 

from list command—it will not remove the regions from their 

audio files. 

3. Highlight a soundbite from each audio file that you wish to 

compact. 

If you want to compact all the audio files, choose Select All from 

the Edit menu (or press command-A). 
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Compacting won’t work 
if... 

Audio File Management 

4. Choose Compact from the Soundbites window mini-menu. 

A warning box asks you if you are sure you want to compact, 

since deleted data cannot be recovered. The compacting 

operation may take some time. 

This operation cannot be undone. Are you 

SURE you want to compact the selected 

soundfiles? 

5. Click Yes. 

There is one condition in which compacting won't do the right thing 

for you: if the data you want to get rid of exists as a region in the 

audio file and there is no corresponding soundbite for it in Digital 

Performer’s Soundbites window. This situation can arise if: 

m the region wasn’t created in the current Digital Performer 

file 

OR 

m at some point you highlighted the region and chose the 

Remove from list mini-menu command, which removes 

the soundbite name from the Soundbites window but 

doesn’t delete the corresponding region from the audio 

file region list. 

The first case is rare. It isn’t often that you want to delete a region 

from anywhere other than the file it was first created in. Otherwise, 

the region is probably there for a purpose—and therefore you don’t 

really want to delete it. 

To avoid the second case, only use the Remove from list command 

with soundbites you are absolutely sure that you will never want to 

discard. Otherwise, they might take up precious hard disk space 

without you even knowing it. If this is the case, import the region into 

Digital Performer and then delete the soundbite with the Delete 

command. 
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Chapter 12 The Audio Event List 

This chapter focuses on features that are unique to audio Event List 

windows. For basic information, please refer to the Event List 

Window chapter the MIDI sequencing reference manual. 

Quick Reference 
Insert 

Audible audio Track Sequence 
Mini-menu mode events Solo name name 

Audio volume even 

Soundbite 
Audio pan event velocity 

Soundbite 
Soundbites duration 

Soundbite name is tata 

Soundbite Loop 

attack 

times 
Soundbites 

inside the loop 

Mini-menu: Choose items from the mini-menu in the same way as 

regular menus. The Event List mini-menu contains commands for 

controlling the display, etc. 

Audible Mode: Click this button to activate Audible Mode. The button 

becomes highlighted. Audible Mode plays back soundbites one at a 

time as you click them in the Event List. You can also play an event 

by highlighting it first and option-clicking audible mode. 

Insert: Inserts soundbites, pan, or volume events into the Event List. 
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Mini-menu 
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Solo: Mutes all other tracks except the one shown in the event list 

window (as long as the window is front-most). Option-click to open 

the solo setup dialog, which lets you partially solo other MIDI tracks. 

Pop-up box: A box that appears when you double-click or option-click 

on a field of an event. You can enter a new value for the field by 

either typing or by dragging up or down. 

Sequence Name: Identifies the sequence that contains the track. 

Soundbite Attack Time: Indicates the location at which the soundbite 

starts playing back. Both attack time and duration can also be 

expressed in SMPTE and real time. 

Soundbite Duration: Indicates the length of the soundbite. This cannot 

be pop-edited. To edit the length (start or end time) of a soundbite, 

drag its edges in the Graphic Editing window. Both duration and 

attack time can also be expressed in SMPTE and real time. 

Soundbite Name: Identifies the soundbite by name. Click it to select the 

soundbite. Option-click it to change the name. Double-click the 

name to replace the soundbite with another. Command-double-click 

to edit in Sound Designer II. 

Soundbite Velocity: Similar to MIDI notes, soundbites have a velocity 

between zero and 127. This velocity affects the volume of the 

soundbite. In addition to pop-editing, soundbite velocities can be 

edited with the Change Velocity command or in the Graphic Editing 

window. 

Soundbites: Each row of information represents a single soundbite or 

volume or pan event. Events at different locations are separated by a 

dotted line. 

Track Name: Identifies the track that contains the data. 

Set View Filter: Calls up a dialog box from which you select the types 

of events which are visible in the Event List window. The View Filter 

applies to all open Event Editing windows. 

Goto Counter: Automatically scrolls to the time currently displayed in 

the Counter. 

Goto: Automatically scrolls the Event List display to a time you specify. 

Relnsert: Inserts an event of the same type that you last inserted. 
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Audio Event List basics 

Event list soundbites are 
“clones” of their original 

Inserting a soundbite in 
the event list 

The Audio Event List 

Legend: Opens a window that shows what each kind of event looks 

like in the Event List. 

Graphic Editing: Opens the Graphic Editing window for the track. 

Measures/Real time/Frames: These checkable entries control the types 

of time displayed for the attacks and durations in the Event List. You 

can use any combination of these three time formats. You can even 

uncheck all three to display no attack or duration times. 

The Event List window gives you precise information about 

soundbites and complete control over their playback. It consists of a 

chronological list of all the soundbites in the track. It also displays 

audio pan and volume events. Similar to MIDI data, audio data can 

be viewed and edited in both the Event List window and Graphic 

Editing window at the same time. 

The most important thing to realize about soundbites in the event list 

is that they are “clones” of their original soundbite in the Soundbites 

window as shown in Figure 14-1 on page 158. For further 

explanation, see “Soundbites in a track are ‘clones’ of the original” on 

page 158. 

Soundbites can be placed in an event list in one of several ways: 

m by inserting from the Event List window 

mw by dragging and dropping it from the soundbites 

window 

To insert a soundbite into an event list from the Event List window: 

1. Choose Soundbite from the insert menu in the title bar. 
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2. In the popped-up event that appears, type in the measure, beat, 

and tick location at which you want to insert the soundbite. 

Use the tab key to move from measures to beats to ticks. 

3. Press tab again to select a soundbite. 

4. Select the desired soundbite from the list that appears. 

Click the soundbite name and then click OK, or—as a 

shortcut— simply double-click the soundbite. You can also 

select the desired soundbite by typing the first letter of its name. 

Dirt Gruy 

&% Scratch 
&? Crowd 

5. When the soundbites list disappears and the velocity field pops 

up, type in a velocity between 0 and 127. 

6. Press return to insert the soundbite. 

The soundbite appears in the event list at the location you 

specified. 
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Dragging soundbites You can also insert soundbites into an event list by dragging them 

into the event list from from the Soundbites window into the event list. Just grab the move 

the Soundbites window handle of the soundbite as show below and drop it on top of the 

open event list window. The soundbite is placed end-to-end with the 

last soundbite at the bottom of the list. 

Figure 12-1: Dragging and dropping 
Sounabites into the event list from 
the Soundbites window: grab the 
move handle and drop it anywhere 
on top of the Event List window. 

Building a playlist A playlist is a collection of regions played end-to-end to produce a 

continuous presentation of music. You can quickly build a playlist 

using the drag-and-drop technique shown in Figure 12-1 above. Just 

make sure that the soundbites you drop into the event list have 

lengths that generate an even tempo when they are placed end to 

end. For example, notice in Figure 12-1 that most of the soundbites 

being used in the playlist have a duration of exactly one bar so that 

the next soundbite used begins on a downbeat. You don’t, of course, 

have to use one-bar lengths: just plan your durations accordingly 

when you are creating the soundbites you will use in the playlist. 

Changing the name ofa To change the name of a soundbite from the audio Event List 

Soundbite window, option-click the soundbite’s name. When you change the 

name of a soundbite, you change the name for all instances of that 

soundbite. 
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Replacing a soundbite 
with another sounabite 

Editing soundbite 
velocities 

Audio volume and pan 
events 

122 

You can replace a soundbite with another by double-clicking the 

soundbite name in the event list. A list appears showing of all the 

soundbites in the file: 

Sm Dirt Gruve 

Double-click the desired soundbite. The new soundbite is placed in 

the same location as the original one with the same velocity. 

There is one unique parameter that an instance of a soundbite can 

have in a track: velocity. Each instance of a soundbite can have its 

own velocity. If you set a velocity for one instance of the soundbite, 

this velocity does not affect other instances of it. For example, the 

following track contains the same drum loop soundbite played 

several times in a row. Notice, however that each instance of the 

soundbite has a different velocity: 

Audio volume and pan events function identically to MIDI 

continuous controller data. They are not, however, MIDI events. 

(They can only be used in audio tracks.) Audio volume controllers 

affect the output volume of the soundbite that is currently playing in 

a track. Audio pan events control panning of the soundbite as it plays 

back on the pair of outputs its track is assigned to. 
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Audio volume and pan events can be identified by their name and 

continuous controller icon in the event list: 

Volume events have a range from 0 to 127. Pan events have a range 

from -64 to +63, where O is dead center, -64 is pan left, and 63 is pan 

right. 

For more information about controlling audio pan and volume, see 

chapter 15, “The Mixing Board” (page 175). 

Inserting an audio To insert audio volume or pan events one at a time in the event list: 

volume or pan event 
1. Choose pan or volume from the Insert menu in the title bar. 

2. Type in the location and value for the event (0-127 for volume, -64 
to +63 for pan). 

3. Press return to enter the event or command-period to cancel. 

Using the View Filter As with all types of data in Digital Performer, soundbites, volume 
events, and pan events can be removed from the display with the 

View Filter in the Event List window mini-menu. 
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Chapter 13 Audio Gr aphic Editing 

There are many features packed into Digital Performer’s Audio 

Graphic Editor. Its design is based on Digital Performer’s graphic 

editing window for MIDI tracks (explained in the Graphic Editing 

Window chapter in the MIDI sequencing reference manual). 

However, this chapter focuses on the many additional features 

unique to digital audio. It also shows you many time-saving shortcuts. 

This chapter is divided into the following main sections: 

“Quick Reference” on page 126 

“Mini-menu” on page 129 

“The Audio Graphic Editor” on page 130 

“Audio graphic editing basics” on page 133 

“Inserting soundbites” on page 136 

“Moving soundbites” on page 138 

“Edge-editing soundbites” on page 141 

“Selecting audio” on page 144 

“Scrubbing audio inside a popped-up soundbite” on 

page 147 

“Editing volume, pan, and loops graphically” on 

page 149 
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Quick Reference Below is an overview of the Audio Graphic Editor, followed by a brief 

explanation of each item. 

Track list Insert Volume Solo Show Zoom _ Pointer Marker Event Time Edit grid Edit grid 
audio &pan & hide buttons coordinates __ strip Information ruler on/off resolution 
events controller Track bar 

curves list 

Prac curd PEE teen Hi Bit torn Turnaround - 

Track Play- Track Controller Loop Volume Selected Pan 
name & display | Automation automation soundbite automation 

Record- pop-up on/off data data event 
enable 
buttons 

Figure 13-1: The Audio Graphic Editor 
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Audio Graphic Editing 

Track list: Click or drag over the names of the audio tracks in this list 

to show or hide them in the Audio graphic editor. Option-click to 

hide all except the one you click; command-click to show all except 

the one you click. 

Insert Audio Events button: Pops up the Insert menu when clicked, from 

which a soundbite can be inserted. 

Volume and pan controller curves: Produces a cross-hair cursor that can 

be dragged in a track strip to insert a smooth line or curve of audio 

volume or pan controllers. Before choosing this tool, select either Pan 

or Volume from the track’s display pop-up menu in the control strip 

to the left of the grid. 

Solo button: Solos all audio tracks visible in the Audio Graphic Editor. 

Show & Hide Track list button: Shows and hides the list of tracks at the 

left side of the window. 

Zoom buttons: Reduce and enlarge the display vertically or 

horizontally. Click the plus sign to zoom in; click on the minus sign 

to zoom out. Zooming out gives you an Overview; zooming in 

focuses on a shorter period of time at higher resolution. Editing can 

be done at any zoom level. Option-click to zoom in or out to 

minimum or maximum zoom level. 

Pointer Coordinates: Displays the mouse pointer’s current location, 

including the name of the soundbite it is currently over. 

Marker Strip: Displays markers, meter changes, and key changes. 

Markers and meter changes must be edited in the Conductor track or 

Markers window. No MIDI or audio data appears in the Marker Strip. 

Event Information: Displays the currently selected soundbite or 

controller event as it would appear in the Event List and allows you 

to edit the event’s parameters, such as name, velocity, and attack 

time. If a region is selected by dragging in the Time Ruler, this box 

shows the region’s start and end time. If a group of events is selected, 

this box displays information about the last event that was selected. 

Time Ruler: Measures time in any combination of Performer’s three 

time formats: measures |beats |ticks, SMPTE time, and real time. The 
Time Ruler can zoom in and out to enlarge or reduce the Soundbite 

display and Controller Data Grid. Command-drag to zoom the display 

to fit the selected region. 
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Edit Grid Resolution: Displays the current time resolution for editing. 

When the check box is selected, notes and data ‘snap’ to locations 

that correspond to the resolution displayed. If the check box is 

deselected, data does not ‘snap to grid’. Edit resolution can be 

changed by typing in a different number of beats |ticks, or by 

choosing a duration from the note pop-up menu. 

Track display pop-up: Lets you choose what type of data to view and 

edit in the track: soundbites only, volume, pan, or loops. Use the 

option key while selecting from this menu to change all tracks. 

Controller Automation on/off button: Turns volume and pan automation 

on or off for the track. When automation is turned off, pan and 

volume events in the track are ignored, e.g. they do not play back. 

Volume automation data: Volume automation data events are viewed by 

choosing Volume from the Track’s display pop-up menu in the 

control strip to the left of the grid. Volume level is displayed as a line 

superimposed on top of the audio waveform, with volume events 

appearing as dots on the line, which can be inserted (by clicking), 

dragged, and deleted (by command-clicking). 

Pan automation data event: To insert a single pan or volume event, 

choose Pan or Volume from the track’s display pop-up menu in the 

control strip to the left of the grid and then just click in the track strip 

where you want the event. Drag the control point to move it. 

Command-click it to delete it. To insert a smooth line or curve 

(consisting of many events), use the reshape button in the title bar. 

Soundbite: A reference to a region of audio data. Soundbites do not 

consist of actual audio data; instead, they consists of pointers—a start 

time and end time—to a region of audio data in a soundfile on a hard 

disk. The soundbite displays the waveform of the sound, along with 

the soundbite name. 
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Mini-menu 

Audio Graphic Editing 

Set View Filter: Calls up a dialog box in which you specify types of 

events to be visible in the Graphic Editing window. The View Filter 

applies to all tracks and affects both the Graphic Editing and Event 

List windows. 

Goto Counter: Scrolls the graphic display to the time currently 

displayed in the Counter. The counter location appears at the left- 

most position in the window. 

Goto: Scrolls the graphic display to a time you specify, which appears 

at the left-most position in the window. 

Set Rulers: Allows you to configure the Time Ruler in any combination 

of Performer’s three time formats: measures |beats |ticks, SMPTE time, 

and real time. The main ruler is displayed lowest and determines the 

time format for editing. 

Set Ptr. Coords...(Set Pointer Coordinates): Allows you to choose what 

time and pitch formats are displayed in the Pointer Coordinates Box. 

MultiRecord: Toggles MultiRecord mode. When MultiRecord is on, you 

can record into several audio tracks at once. 

Display Waveforms: When this command is checked, soundbites 

display a waveform that represents the audio contained in the 

soundbite. When this command is unchecked, soundbites display a 

grey bar and redraw on the screen faster. 

Edge Edit Copy: When checked, this command causes a soundbite to 

be copied when you drag one of its edges, which preserves the 

original soundbite. When unchecked, dragging a soundbite edge 

affects the original soundbite, as well as every other instance of it. In 

either case, option-dragging a soundbite edge temporarily overrides 

the current setting of this command. 

Selections use Edit Resolution: When this menu item is checked, 

selections will snap to the edit resolution when you drag them (if Edit 

Resolution is turned on). 

Event List: Opens the Event List window for the currently selected 

soundbite. This menu item is grayed out until you select a soundbite. 

MeasuresiReal timelFrames: These checkable entries control which time 

formats are displayed in the Information Bar and Event List. 
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The Audio This section explains several important concepts to keep in mind 

Graph ic Edito r 
when you work in the Audio Graphic Editor. 

Opening the Audio There are several ways to open the Audio Graphic Editor: 

Graphic Editor 
mw Double-click an audio track in the track list (this can be 

set in the Preferences command in the File menu) 

mw Click an audio track name (or track segment in the 

overview) to highlight it, and click the graphic editing 

window button in the main control panel 

= Choose Graphic Editing from an audio event list window 

mini-menu 

=» Command-click the tithe of a MIDI track graphic editing 

window and choose Audio Tracks from the menu 

Choosing tracks To choose which tracks you want to display, click the track list button 

in the title bar as shown below to open the track list. Then just click 

tracks to either show them or hide them. Option-click to hide all 

except the track you click; command-click to show all except the 

track you click. Use the vertical zoom buttons to further control how 

many tracks are displayed in the window. 

Track list Track list Vertical 

button zoom 

Click, 

option-click, 

and 

command-lick 

in this list. 

To change the 

order of the 
tracks, drag them 
by their move 
handle in the 
Tracks window. 

Moving tracks up or To move tracks up or down in the Audio Graphic Editor, drag them 

down by their move handle in the Tracks window. 
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Zooming The Audio Graphic Editor lets you zoom the display both horizontally 
and vertically. Zoom in using the ‘plus’ button to get more detail. 

Zoom out with the ‘minus’ to get more of an overview. Shortcut: 

option-click to zoom to the maximum or minimum setting. 

Zoom buttons 
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The track controls Each track in the Audio Graphic Editor has a control panel along the 
left side of the window. 

Track name Automation 

enable/disable 

Input and 

output settings et a RT a RN MO : 

Record- and 

Play-enable 
buttons 

Audio voice 

Track display 

The Track display at 
reduced zoom levels 

Figure 13-2: The track controls. The display of these controls 
changes slightly depending on the vertical zoom setting as shown. 

Displaying soundbites, The track display pop-up menu lets you choose what type of data 

volume, pan, and loops you would like to display in each track. Volume, pan, and loops are 

displayed directly on top of the soundbites, which are dimmed in the 

background. For more information about volume, pan, and loops, 

see “Editing volume, pan, and loops graphically” on page 149. 

A shortcut for changing Hold down the option key when choosing what to display to change 

all tracks at once all tracks at once. You can do so from any track. 
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Audio graphic This section explains several important concepts to keep in mind 

a di ting basics when you work in the Audio Graphic Editor. 

Wor king with waveforms The Audio Graphic Editor displays soundbites — and the audio data 

within them — as a waveform in a standard time-versus-amplitude 

display as shown below. The waveform shown inside soundbites is a 

representation of the sound in graphical form. Time is expressed on 

the horizontal axis. Amplitude oudness) is expressed on the vertical 

axis, and the waveform oscillates up and down over a center axis 

which represents zero, or no sound at all. The louder the sound is at 

a certain point, the greater the deviation is from zero. Silence is 

represented by a straight line. 

+100% Zero crossing 

Amplitude 

cS 

-100% 

Figure 13-3: A simple audio waveform displayed on a time versus amplitude scale. 

A soundbite is represented as a “block” of waveform data with 

adjustable boundaries. The waveform inside it represents the actual 

audio data in the audio file on disk. This graphic display allows you 

to make edit decisions based on what you see, as well as what you 

hear. 

Sax New .2 

Figure 13-4: A soundbite is represented as a block of audio with a waveform inside. 

Stereo versus mono As of this writing, the Digidesign Audio Engine (DAE) does not 

waveforms support the recording or playback of interleaved stereo audio files. 

They can, however, be imported into Digital Performer, but only the 
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Choosing not to display 
the waveform 

Soundbites are clones 

Graphic editing is 
nondestructive 
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left channel will play (unless you de-interleave them when importing. 

For more information, see “Converting soundbites that cannot be 

played” on page 98.) Stereo audio files consist of two interleaved 

channels of audio data. They appear in the Graphic Editing window 

as two smaller waveforms joined together as shown below. A Stereo 

Soundbite shows both channels connected together as one unit, so 

that they can always be edited simultaneously. 

Lead solo (stereo) 

Figure 13-5: A stereo soundbite is represented as two audio channels joined together. 

Most of the time, the waveform display inside soundbites is critical for 

the tasks of editing digital audio. It does, however, require a 

significant amount of calculation on the part of Digital Performer. For 

example, when Digital Performer displays a newly recorded 

soundbite in the Audio Graphic Editor, it pauses briefly to calculate 

the waveform before you can see it for the first time. If you are in a 

hurry, and you don’t want to wait, the Display Waveforms mini-menu 

command, when unchecked, eliminates these brief delays. Or, you 

can close the graphic editing window to prevent waveform 

calculations. 

Sax New 2 Sax New 2 

Figure 13-6: A soundbite displayed with and without its waveform. 

An important thing to realize about soundbites in the graphic editing 

window is that they are “clones” of their original soundbite in the 

Soundbites window as shown in Figure 14-1 on page 158. For further 

explanation, see “Soundbites in a track are ‘clones’ of the original” on 

page 158. 

All of the editing procedures described in this chapter are non- 

destructive. For an explanation of non-destructive editing, see “Non- 

destructive editing” on page 48. 
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Using the edit grid 

Editing on zero 
crossings 

Editing audio events 
numerically in the info 
bar 

Opening the event list 
for a track from the 
Audio Graphic Editor 

Audio Graphic Editing 

The edit grid in the Audio Graphic Editor works the same as it does 

in MIDI graphic editing windows. When it’s on, it causes whatever 

you are dragging to ‘snap’ to evenly spaced, rhythmically precise grid 

locations. When it’s off, no snapping occurs when you drag. Turn the 

edit grid on and off with the button as shown in Figure 13-1 on 

page 120. Set the resolution of the grid with the note pop-up menu 

(also shown in Figure 13-1) or by typing in a value. 

The edit grid affects all dragging operations, including: 

a Dragging soundbites to move them 

mw Dragging in the time ruler to make selections 

= Dragging the edges of soundbites 

m Inserting volume and pan curves, including the density 

of the data inserted 

Edit resolution does not, however, affect dragging inside a soundbite 

while pop-editing it. 

When editing waveforms, you can often get noise artifacts such as 

clicks and pops at soundbite boundaries due to edit points that don’t 

fall on a zero crossing. You can avoid this by using the Edit on Zero 

Crossings command. For more information, see “Editing on zero 

crossings” on page 159. 

The Info bar displays precise information about any audio event after 

you click it, and you can directly edit any of the information shown. 

This display is identical to the event list window. Use the time format 

commands in the mini-menu to choose the formats you want to see. 

Attack time Name On-velocity Length 

Figure 13-7: The info bar shows specific information about any event 
after you Click it, including loops and volume and pan control points. 

To open an event list for a track in the Audio Graphic Editor, click a 

soundbite to select it and choose Event List from the mini-menu, or 

click the event list button in the Consolidated Control Panel. 
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Inserting The following sections explain several different ways to insert 

4 soundbites into the Audio Graphic Editor. The soundbite must be 

soun dbi tes present in the Soundbites window list before doing so. If it isn’t, you 

must import it beforehand. See “Importing soundbites, playlists, 

audio files” on page 95. 

Using the insert button To insert a soundbite in the graphic editing window: 

1. Click the Insert button in the title bar as shown below. 

2. Select the desired soundbite from the list that appears. 

Click the soundbite name and then click OK, or—as a 

shortcut— simply double-click the soundbite. You can also 

select the desired soundbite by typing the first letter of its name. 

When the list disappears, the cursor turns into a cross-hair. 

&? Comp one 

2 Soft/hi comp 
2 Comp two 
tore Solo 

eS Stevie! 
&% Soft comp.n 

&% Turnaround 

“% Hi Bit 
&% The coverup 
Y Stevie Ray! (part 1) 
&? Stevie Ray! (part 11) 

3. Click the cross-hair cursor in the graphic editing window at the 

location where you want to place the soundbite, using the cursor 
coordinates to help determine the location. 

Use the “Set Ptr. coordinates” mini-menu cursor 

command to determine which time coordinates 

formats are displayed. Insertion 

cursor 
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Dragging and dropping You can also place audio in the graphic editing window by dragging 

audio from the soundbites from the Soundbites window. Just grab the move handle 

soundbites window of the soundbite as show in Figure 13-8 below and drop it on top of 

the open graphic editing window. The soundbite is placed at the 

exact location displayed in the pointer coordinates box at the 

moment you drop it. Command-drag the soundbite to make it “snap” 

to the end of the previous one (or the beginning of the track if it is 

empty). 

Figure 13-8: Dragging and dropping Soundbites into the graphic editing window from the Soundbites window: 
grab the move handle and drop it on top of the graphic editing window. Use the pointer coordinates for precise 
placement. Command-drag the soundbite to make it “snap” to the end of the previous one. 

Building a playlist As mentioned in the previous section, you can quickly build a playlist 

in the graphic editing window by command-dragging soundbites into 

it from the Soundbites window. Holding down the command key 

when you first grab the soundbite causes it to “snap” to the end of the 

previous soundbite when you drop it. 

Changing a soundbite To change a soundbite name in the graphic editing window, click it 

name once to select it and then option-click its name in the info bar as 

shown in Figure 13-7. 

Replacing a soundbite To replace a soundbite with a another one from the soundbites 

with another window, click it once to select it and the double-click its name in the 

info bar as shown in Figure 13-7. 
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Moving 
soundbites 

Moving soundbites 
vertically from one track 
to another 

Moving multiple 
soundbites at the same 
time 

Snapping to the edit grid 

“Throwing” soundbites 
to the next or previous 
soundbite 

Soundbites can be moved earlier or later in time by simply dragging 

them left or right, respectively. If the edit resolution check box is off, 

they move freely at the highest resolution allowed by the current 

zoom setting. 

You can freely drag soundbites from one track to another simply by 

dragging them vertically — as long as the tracks involved are 

currently being displayed, of course. 

You can move several soundbites together by selecting them and 

dragging them together as a unit. Shift-click to select multiple 

soundbites. Also see “Selecting audio” on page 144. 

When the edit resolution check box is checked, soundbites “snap” to 

the edit resolution grid when you drag them. See “Using the edit grid” 

on page 135 and the edit grid controls in Figure 13-1 on page 120. 

There is a shortcut for making a soundbite “snap” to the next or 

previous soundbite in the window: command-drag the soundbite in 

the direction you want it to snap. For example, if you want a 

soundbite to be placed end-to-end with the next soundbite to the 

right as shown below, command-drag it to the right. You only have 

to drag a short distance—enough to determine the direction. 

Figure 13-9: Command-dragging a short distance in either direction 
causes the soundbite to “snap” to the next or previous sounabite. 
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Option-dragging to To quickly make a copy of a soundbite while dragging, option-drag 

make a copy it. The new soundbite is an exact clone of the original; in other 

words, they both refer to the same original soundbite listed in the 

Soundbites window. For example, if you rename either copy, they 

will both change to the new name. 

Figure 13-10: Option-dragging to make a copy of a soundbite. 

Option-commana- By holding down both the option key and the command key when 

dragging to copy dragging soundbites, you can copy and place soundbites end-to-end 

soundbites & place them at the same time. This is a great shortcut for building playlists made 

end to end up of many repeating soundbites, as shown in the example below. 
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Creating a stutter effect You can easily make a stutter effect by option-dragging a soundbite 

several times and overlapping the copies. For rhythmic precision, it is 

easiest to do so with edit resolution turned on and set to a fairly small 

increment, such as 16th notes. 

Figure 13-11: This 16th-note stutter effect was created by option-dragging 
copies of a soundbite with edit resolution turned on. 
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Edge-editing As explained in Figure 6-5 on page 52, a soundbite represents a 
portion of audio from its parent audio file stored on disk. For 

sounabi tes example, a soundbite can be as short as a fraction of a second or as 

long as a half hour. A soundbite can represent a portion of the parent 

audio file, or it can represent the entire file. 

Digital Performer allows you to drag the edges of soundbites to 

change their boundaries. Just click the edge of the soundbite and 

drag left or right (the current edit resolution applies). When doing so, 

you “uncover” or “cover up” the audio in the audio file as illustrated 

in Figure 13-12 below. 

Soundbite 

Re nN 

Sax solo (bars 9-16) 

— as it appears in Parent audio file 
the graphic editing window (stored on disk) 

New a ae: boundary 

SIE OO I MONT = ae ia tees ota ssc 

Edge-dragging cursor 

Figure 13-12: Edge-editing a soundbite by dragging its boundaries. 

If the edge stops when you drag it, preventing you from going any 

further, then you have reached the end of the audio file. 

Affecting all copies of a 
soundbite versus one 

copy 

The Edge Edit Copy command in the graphic editing window mini- 

menu allows you to choose whether you want to modify the original 

soundbite you are dragging or preserve the original by making a 

copy of it when you drag. 
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Edge-editing all copies When Edge Edit Copy is unchecked, dragging a soundbite edge 

affects the original soundbite, as well as every other instance of it. For 

example, if you edge-edit a soundbite called Drum Fill that has been 

placed many times throughout a percussion track, all copies of it in 

the track will change. 

Edge-editing one copy When Edge Edit Copy is checked, it causes a soundbite to be copied 

when you drag one of its edges, which preserves all original copies 

of the soundbite. The result is a new soundbite that is identical to the 

original except for the new boundary and a slightly different name. 

You probably won’t even notice that a copy is being made. Instead, 

it will seem like you just moved the edge of the soundbite. The only 

noticeable change is a number appended to the soundbite (or, if it 

already has a number, it will increment by 1). The new soundbite is 

also added to the list in the Soundbites window. 

Phill Phill.2 

Original soundbite New soundbite 
after option-dragging its edge 

Option-dragging to Option-dragging a soundbite edge temporarily overrides the current 

override Edge Edit Copy setting of the Edge Edit Copy command. This allows you to set it the 

way you prefer most of the time, and the option-drag to temporarily 

override it when necessary. For example, if you may want to edit all 

instances of a soundbite most of the time, uncheck the Edge Edit 

Copy command so you can simply drag soundbite boundaries, and 

use the option-key to override this setting when needed. 
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Edge-editing when 
soundbites overlap 

Grab the right edge of Comp Two 
by command-clicking its left edge. 

When soundbites overlap one another, you may not have direct 

access to the soundbite edge you wish to edit because it may be 

covered up by another soundbite. In this situation, you can edit the 

hidden edge by command-clicking the opposite, visible edge. Doing 

so gives you control over the edge you didn’t command-click. 

Comp Two ends at measure 8, 
but its right edge is covered. 

Figure 13-13: Edge-editing when the edge you want to drag is covered by another soundbite. 

Using the edit grid when 
edge-editing 

Audio Graphic Editing 

The edit grid affects edge-editing, so if you want edges of soundbites 

to snap to the grid when you drag them, turn on the grid and set it to 

the desired resolution using the controls shown in Figure 13-1 on 

page 120. 
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Selecting audio Digital Performer offers a variety of ways to select audio. Once audio 

is selected, you can apply one of Digital Performer’s many powerful 

editing operations. 

Selecting soundbites The table below summarizes a variety of ways to select soundbites. 

To do this: Do this: 

To Select an entire soundbite Click it. 

To select several adjacent sound- Click anywhere in the background 

bites directly behind the soundbites and 

then drag over them. 

To select non-adjacent sound- Shift-click each one. 

bites 

To select a soundbite when it is Click any portion of the soundbite 

behind another that is visible. 

Selecting a region in the To select any time range of audio, regardless of the soundbites 

time ruler over one or contained in within the region, drag in the time ruler as shown 

more tracks below. Notice that the time ruler selection affects a// visible tracks, as 

well as all data currently visible in the view filter. Be sure to hide 

tracks and data types you don’t wish to include. The start and end 

time of the selected region is displayed in the info bar. Pan and 

volume data in the region will also become selected, unless they are 

hidden in the view filter. Shift-click to extend or shorten the current 

selection. You can also turn on the edit grid when dragging. 

Be sure to hide the Start and end time of Drag in the time ruler. Use 
tracks you don’t want to the selected region the edit grid if desired. 
include in the selection. 

Audio-4 
_Audio-S 
FPereussian 

Out takes 

Figure 13-14: Selecting a time region across soundbites. 
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Selecting a portion of a 
soundbite using the time 
ruler 

Using Cut, Copy, and 
Erase on a time ruler 
selection 

Pasting into a time ruler 
selection 

Using Snip, Splice, 
Repeat, and Shift ona 
time ruler selection 

Using Split and Trim on 
a time ruler selection 

Selecting audio inside a 
soundbite by 
pop-editing it 

A soundbite before pop-editing 

Audio Graphic Editing 

To select a portion of audio within a soundbite using the time ruler, 

just drag in the time ruler above the soundbite as described in 

“Selecting a region in the time ruler over one or more tracks” on 

page 144 and shown in Figure 13-14. All of the editing procedures 

discussed in the sections below apply to this case, too. 

Once a region is selected in the time ruler as shown in Figure 13-14, 

you can cut, copy, and erase the selected audio using the Edit menu 

commands. 

If there is audio data in the clipboard, you can use the Paste or Merge 

commands. Doing so pastes the clipboard contents into the same 

track (or tracks) it was copied or cut from starting at the beginning of 

the selected region. 

The Edit menu commands Snip, Splice, Repeat, and Shift will only 

affect soundbites whose attacks fall within the selected region. 

However, you can make these edit commands affect the selected 

region as a whole by using the Split command in the Audio menu 

before applying Snip, Splice, Repeat, or Shift. For more information 

about this technique, see “Splitting audio in the selected region 

before editing” on page 1061. 

The Audio menu edit commands Split and Trim can be used ona 

time ruler selection. For complete information about these 

commands, see “Split and Trim” on page 164. Note, however, that the 

Strip Silence command does not affect this type of selection. To apply 

Strip Silence, click the soundbite to select it. 

To pop-edit a soundbite for selecting and editing, double-click it. The 

soundbite “pops up” to indicate that you can drag inside it. This 

method of selection offers several advantages, which are discussed in 

the following sections. 

The same soundbite after it has been 

double-clicked for pop-editing 
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Selecting audio inside a soundbite 
Once a soundbite is popped up, you can select any portion of it by 

dragging over the waveform inside. If necessary, you can scroll the 

window horizontally and zoom in or out to select portions of audio 

not currently visible in the window. 

Selecting inside a 
soundbite 

Extending or shortening the selection 
Once a selection has been made, you can adjust the edges of the 

selection, extending or shortening them as much as you like. Just 

shift-click (or shift-drag) near the edge you want to adjust. 

Adjusting the 
boundaries of the 
selection by shift- 
clicking and shift- 
dragging 

Listening as you make a selection 
If you turn on the Audible mode button in the graphic editing 

window title bar, Digital Performer will play the selected region as 

soon as you release the mouse after making the selection. The same 

will happen when adjusting the edges of the selection as described in 

the previous section. 

Audible mode 

Listening to the current selection 
To listen to the currently selected region of audio inside a soundbite, 

option-click the Audible mode button as shown above. Doing so 

causes the selected region to play in its entirety. 

146 Audio Graphic Editing 



Scrubbing while selecting 
You can also scrub audio while selecting audio in a pop-edited 

soundbite. For more information, see the next section, “Scrubbing 

audio inside a popped-up soundbite”. 

Editing the selected region inside a soundbite 
Once a portion of audio is selected inside a soundbite, you can cut, 

copy, erase, delete, split and trim the selection using the Edit menu 

commands. If there is audio data in the Clipboard, you can also use 

the Paste command to paste it; doing so will place it in the track asa 

separate soundbite starting at the beginning of the selected region. 

@ The pasted soundbite will be placed on top of the 

popped-up soundbite. 

Scrubbing audio inside To scrub audio inside a soundbite, first double-click the soundbite to 

a popped-up soundbite pop-edit it. Then command-drag in either direction to scrub forwards 

or backwards as shown below. The scrub wiper indicates the current 

scrub location. 

Scrub wiper “Scrub wheel” cursor 

Figure 13-15: Commanda-drag to scrub audio within a pop-edited 
soundbite. In this example, the audio is being scrubbed forwards. 
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Controlling scrubbing speed 
To speed up scrubbing — up to two times normal speed — move the 

“scrub wheel” cursor further away from the scrub wiper as shown 

below. To slow down, move the scrub wheel cursor closer to the 

scrub wiper. For a finer degree of control, zoom in the display 

horizontally. 

ax oO10 ax 3010 

Scrubbing forward slowly Scrubbing forward quickly (2x normal) 

Scrubbing while selecting 
When dragging to make and adjust selections inside a soundbite, you 

can scrub the audio while selecting by holding down the command 

and shift keys together as shown below in Figure 13-16. This lets you 

hear what you are selecting as you drag. For example, if you have 

made a selection already, and you want to extend its edge and scrub 

at the same time, hold down both the command and shift keys while 

you drag. 

Figure 13-16: Scrubbing while selecting. 

data described in the previous sections, you can employ Digital 

Performer’s numerous editing commands. For complete information, 

| 

| 

| 

| 
| 

Editing selected audio Once you have selected audio data using one of the methods 

| 
see chapter 14, “Editing Audio” (page 157). 
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Editing volume, The Audio Graphic Editor provides the ability to display, insert, and 

edit volume and pan automation data in the form audio controller 

pan, and loops events. In addition, it allows you to do the same for loops in audio 

graphically tracks. The sections below provide complete details. 

Switching a track to To display and edit an audio track’s volume, pan, and loop data in 

display volume, pan, or the Audio Graphic Editor, you need to switch the track display using 
loops the pop-up menu as shown below. Only one type of data can be 

displayed at a time in each track (together with soundbites). Once a 

data type is displayed, you are ready to edit. 

Choose the type of data 
you want to see from the 
display pop-up menu. 

The soundbites in the 
track become dimmed 
and the volume, pan, or ___ 
loop data is superim- 
posed on top of the 
waveform. 

The current volume level or Changes in the volume or pan A controller curve like this 
pan setting in the track is level in the track appear as one actually consists of 
displayed as a horizontal line. control points on the line. They many events that change 

represent discrete volume or gradually over time. 
pan events in the track. 

Bass loop 

The loop itself is shown as a loop icon with a This shaded region indicates the 
bracket, which indicates the region being looped. period of time covered by the loop. 
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Zooming for a better 
view 

Check the edit grid 
setting before editing 

Working with control 
points on a line 

Inserting a control point 
to create a sudden 
change 
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When inserting controllers, it helps to get a zoom setting that best 

suits what you are doing. For example, if you are making fine 

adjustments to the track level, use a large vertical zoom setting for 

better resolution. If you need to check out the overall level 

throughout a track, zoom out. 

The edit grid affects all dragging operations in the Graphic Editor. For 

example, it determines the density of events when you insert a 

smooth line or curve. So be sure to keep an eye on it as you work 

with volume and pan controllers, as well as loops. 

As mentioned earlier, the pan and volume level in the track is 

displayed as a horizontal line. Changes in level are represented as 

control points on the line, which you can insert, drag, and remove. 

The next few sections give you a summary of techniques for 

inserting, editing, and removing control points on the line. 

Inserting a single volume or pan event creates a sudden change in the 

volume level or pan setting. To insert a single event: 

1. Check the edit grid settings. 

2. Make sure the track is currently displaying either volume or pan. 

3. Click the line at the location you want to insert the control point. 

A control point is inserted on the line as shown in Figure 13-17 

on page 151. 

4. While watching the cursor coordinates box, drag the control 
point to the location and level you want. 

You can drag both vertically and horizontally. Zoom in for 

greater resolution as you drag. 
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Use the cursor coordinates Set the edit 

for exact placement. resolution first. 

Figure 13-17: Inserting a single volume or 
pan event to create a sudden change. 

Inserting a line or curve A line or curve actually consists of many control points placed close 

to create a smooth together that change gradually. The reshape tool in the title bar, 

change however, allows you to insert them as a line or curve as follows: 

1. Choose the density of the data you are going to insert by setting 

the edit grid. 

The edit grid setting determines how often events will be 

inserted. When the grid is turned on, events are inserted at 

regular intervals at the current grid resolution. For example, if 

you want events spaced at least every 60 ticks apart, choose a 

32nd note resolution. If you want a higher density, pop-edit the 

tick value directly, either by typing or dragging. The higher the 

density, the smoother the change, but the higher the strain on 

DAE. If you turn off edit resolution altogether, events will be 

inserted as needed, but not necessarily at regular intervals. 

A volume swell at an edit resolution of 60 ticks. The same swell re-inserted with edit resolution turned off. 
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2. Click the reshape tool in the title bar. 

The cursor turns into a cross hair. 

The reshape too 

Cross-hair cursor. 

3. Drag out the line tool as desired, using the red (or black) handles 

on the line to achieve the desired placement and shape. 

Use the cursor coordinates for exact placement. 

4. When you are done adjusting the line tool, click anywhere in the 

soundbite grid to insert the curve, or press the return key. 
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Reshaping an existing 
line or curve 

Dragging control points 

Moving the control 
point to the left 

Moving the control 
point to the right 

Removing a control 
point 

Removing a line or curve 

Audio Graphic Editing 

Use the same procedure as in the previous section to reshape an 

existing line or curve. Just drag over the existing data with the 

reshape tool. 

You can drag any control point on a line anywhere within the track 

strip. Notice that you can even drag it past events on either side of it 

as shown below. When you do, you delete the events that you drag 

over. This is a convenient shortcut for removing a line or curve. 

In this example, the 
control point is being 
dragged both down 
and to the right. 

To remove a control point, command-click it. To remove several, 

drag over them as described in the above section. 

To remove a line or curve, drag a single control point over it as 

described in the section, “Dragging control points” above. 
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Cutting, copying, and The only way to select audio controllers in the Audio Graphic Editor 

pasting audio is by dragging in the time ruler to select a region of time. Note, 

controllers however, that when doing so, you are also selecting all data in the 

track, including soundbites, volume, pan, and loops (unless you hide 

them beforehand with the View Filter command in the window’s 

mini-menu). In addition, you are selecting all currently visible tracks. 

Once a time region is selected, you can cut, clear, or copy the 

material and then paste it elsewhere. To paste, select a region in the 

time ruler and the clipboard data will be pasted at the beginning of 

the selection. 

Disabling volume and You can temporarily disable the volume and pan data in an audio 
pan automation track by turning off the Auto button in the track information panel as 

temporarily shown below. When Automation is disabled, volume and pan levels 

are displayed as a dashed line. They can inserted, edited, and deleted 

as usual, even when they are disabled. 

Automation 

buttons 
Automation 

disabled 

Automation 

enabled 
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Inserting a loop To insert a loop in the Audio Graphic Editor: 

1. Choose Loops from the track display pop-up menu. 

2. Turn on edit resolution as set it as desired. 

3. Drag over the region you wish to loop. 

4. To set the number of repetitions in the loop, pop-edit the loop 

parameters in the info bar as shown below. 

Pop-edit the number if 
times here 

Changing the loop To change an existing loop’s location or duration, drag either end of 
points by dragging the loop’s bracket. 

Changing the loop To change the loop numerically, click the loop icon to make the 

numerically in the info loop’s information appear in the info bar, and then pop-edit the 

bar values in shown in the info bar. 

Changing the number of To change the number of repetitions in the loop, edit the loop 

repetitions in a loop numerically as described in the previous section. 

Deleting a loop To delete a loop, command-click the loop icon. 

Duplicating a loop To duplicate a loop, option-drag the loop icon. 
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Chapter 14 Editing Audio 

Digital Performer provides powerful, non-destructive editing features 

for digital audio. Most of them can be applied to audio tracks and 

MIDI tracks at the same time, giving you a quantum leap in flexibility 

over systems that handle MIDI or digital audio only. 

You can apply just about all of Digital Performer’s powerful Edit 

menu and Region menu commands to digital audio. This chapter 

explains how and covers special considerations unique to audio. 

This chapter is divided into the following main sections: 

m “Audio editing basics” on page 158 

a “Region editing in the Tracks window” on page 161 

a “Split and Trim” on page 164 

a “Strip Silence” on page 166 

m “Reload Soundbite” on page 168 

m “Replace Soundbite” on page 172 

mw “Duplicate” on page 173 

m “Edit in Waveform Editor” on page 174 
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Audio editing The following Spetions explain. several important concepts to keep in 

2 mind when editing digital audio. 
basics 

All audio editing is non- All of the editing procedures described in this chapter (cut, copy, 

destructive paste, snip, erase, etc.) are non-destructive. (For an explanation of 

non-destructive editing, see “Non-destructive editing” on page 48.) 

However, destructive waveform editing operations, such as ‘pencil 

tool’ editing of digital audio samples and DSP features such 

normalize, reverse, time dilation, etc. are provided by third-party 

applications such as Digidesign’s Sound Designer II program. 

Conveniently, Sound Designer can be accessed directly from within 

Digital Performer by the Edit in Waveform Editor command. See “Edit 

in Waveform Editor” on page 174. 

Soundbites in a track are It is important to understand that soundbites in a track are “clones” of 

‘clones’ of the original the original soundbite in the Soundbites window as shown below in 

Figure 14-1. They do not actually consist of the soundbite itself; they 

are a reference to the original soundbite. As a result, you can freely 

cut, copy, paste, duplicate, and re-arrange a soundbite in a track as 

much as you want without affecting or duplicating its original in the 

Soundbites window. On the other hand, if you change the 

soundbite’s name or length, all instances of it will change, too, 

including the original. 

5 === Audio Files 
3 items 

Drum Loop 

bn 
Seratch 

Figure 14-1: Soundbites in tracks are merely references, or “clones”, of the 
original soundbite in the Soundbites list. In turn, the Soundbites there are 
references to the original audio data in the audio file on the hard disk. 
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Using the Edit and View 
Filters 

You can’t mix audio and 
MIDI in the same track 

Editing audio and MIDI 
data simultaneously 

Editing soundbites in 
the event list 

Editing soundbites in 
the graphic editing 
window 

Editing on zero 
crossings 

Editing Audio 

Interestingly, the original soundbite is itself merely a reference to 

something else: it is a pointer to the original audio data in the audio 

file, as shown above in Figure 14-1. As a result, the amount of data 

that you generate by duplicating soundbites is insignificant, since 

soundbite data is merely a pointer to the actual audio data. 

As with MIDI data, soundbites are affected by the View Filter and Edit 

Filter. If the View Filter is set to filter soundbites in the Event List 

window, Graphic editing window, or Tracks Overview, soundbites 

are not affected by selecting and editing operations in these 

windows. Likewise, if soundbites are deselected in the Edit Filter, 

they are not affected by Edit Bar selection in the Tracks window. 

In Digital Performer, there are two kinds of tracks: MIDI tracks and 

Audio tracks. You cannot mix the two data types together into one 

track. You can, however, edit both types of tracks simultaneously as 

described in the next section. 

As an integrated audio and MIDI editing environment, Digital 

Performer lets you to select audio tracks at the same time as MIDI 

tracks for simultaneous editing of audio and MIDI data. For example, 

you can select all tracks of an eight bar chorus, including audio 

tracks, to cut, copy, or paste the audio data along with the MIDI data. 

Be aware, however, that in many cases you'll need to use the Split 

command in the Audio menu before applying the edit operation you 

would like to get the desired results. See “Splitting audio in the 

selected region before editing” on page 161. 

Editing soundbites in audio track event list is pretty much the same 

as editing MIDI note data. Soundbites are treated as single ‘events’ in 

the track, and Edit menu commands such as Cut, Copy, Paste, Snip, 

Repeat, etc. affect soundbites in the same way that they affect MIDI 

notes. For information about audio event lists, see chapter 12, “The 

Audio Event List” (page 117). For basic information about event list 

editing, see the Event List chapter in the Performer MIDI Sequencing 

reference manual. 

The graphic editing window offers many special audio editing and 

selection features. For detailed information, see “Selecting audio” on 

page 144 and “Editing selected audio data” on page 148. 

A zero crossing is a point in the audio waveform where its value is 

exactly zero — or when it has no amplitude, positive or negative, as 

shown in Figure 14-2 on page 160. By their very nature, sound waves 

oscillate back and forth across the zero point many times per second. 
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Digital Performer gives you precise control over editing audio 

waveforms, allowing you to edit them at any point you choose. 

Chances are, however, that your edit points won’t fall exactly on a 

zero crossing and will instead fall somewhere else between +100% 

and -100% amplitude in the waveform. The further away in amplitude 

an edit point is from zero, the more likely it is to cause an audible 

click, pop, or similar noisy artifact. 

The Edit on Zero Crossings command in the Audio menu 

automatically prevents noise artifacts by making your edits gravitate 

to the nearest zero crossing. When this command is checked, 

soundbite boundaries will automatically be placed at the nearest zero 

crossing in the waveform, as shown in Figure 14-2. The trade-off is 

that your edits may occasionally get moved a few ticks before or after 

the point you originally chose. When you need precise control over 

soundbite start and end points — such as editing soundbites that 

consist of a stereo pair, uncheck this command and try to make your 

edits at points in the waveform where it is relatively low (as close to 

zero as possible). Otherwise, leave it checked to avoid clicks and 

pops. 

Soundbite edge 

Edit on zero crossing Edit on zero crossings 
turned OFF turned ON g 

q Nearest zero crossing 

Figure 14-2: A simplified example of how the Edit on zero crossings command works. 
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editing 
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Digital Performer’s Tracks window provides flexible region editing 

across multiple audio tracks. You can also edit audio and MIDI tracks 

simultaneously. The process of region editing consists of the 

following basic steps: 

1. Select a region. 

2. If necessary, choose Split from the Audio menu to create 

soundbite boundaries at the edges of the selected region. 

3. Apply the desired operation from the Edit or Region menus. 

These steps are discussed briefly in the following sections. 

There are two basic ways to select regions of audio in the Tracks 

window: 

mw Highlight track names and set times in the Edit bar 

m Select segments in the Tracks overview 

In both cases, you can select MIDI and audio tracks together at the 

same time. For a detailed review of these methods, refer to the 

chapter called “Selecting Regions” in the Performer MIDI Sequencing 

reference manual. 

After selecting a region, it is important to realize that Edit and Region 

menu operations only affect a soundbite when its attack falls within 

the selected region, and, if so, the soundbite is treated as whole, 

discrete event. For example, if a note and a soundbite both start 

outside the currently selected region and extend into it as shown 

below in Figure 14-3, they would not be affected by the edit 

operation. 

The currently selected region 

kt Re mM kt Kk kt Ee ke 

A MIDI Note 

An audio soundbite 

“ 

. 

: 
ee ee ee ee 

Figure 14-3: These two events would not be affected by a command like 
Change Velocity because their attacks occur outside the selection. 
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In some situations, this may be exactly what you want. But often, 

you ll want to edit the portions of audio that you’ve selected, 

regardless of soundbite attack times. For example, let’s say that you 

have a guitar solo track that consists of a single, long soundbite that 

you recorded for the entire length of the sequence. 

Guitar Solo starting at bar 1 
(Soundbite plays for the entire track) 

And you would like to copy an eight-measure verse from bar 9, along 

with the accompanying MIDI data, to paste it at the end for a fade. So 

you select bars 9 to 16 in the overview time ruler as shown below: 

No audio is selected yet 

But no audio data is selected yet because the soundbite attack falls 

outs side the selection (it’s back at bar 1). To select the guitar solo 

audio in bars 9-16, you now have to choose Split from the Audio 

menu to make it a separate soundbite. This new soundbite can then 

be copied along with the MIDI data, as shown below. Once split, the 

chorus soundbite can be copied with the rest of the MIDI data within 

the region as shown below. 

@ Disable the Edit on Zero Crossing command when 

employing this technique to keep the new soundbite 

inside the selected region. 
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Applying Edit and 
Region menu operations 
to audio 

Editing Audio 

Anew, 8-bar soundbite is created in 

bar 9, which can now be copied along 
with the MIDI data in the other tracks. 

This technique can be applied before using just about any command 

in the Edit and Region menus. 

Once you’ve selected a region and, if desired, split the audio, you can 

choose any command from the Edit or Region menu. Region menu 

commands affect audio as discussed below. 

The Change Duration command does not affect soundbites. 

Soundbite durations can only be changed by dragging them in the 

graphic editing window. 

Region menu commands that affect timing (such as quantizing) only 

affect the placement of soundbites—that is, the attack time of the 

soundbite. They do not have an effect on the audio data within the 

soundbite. For example, if you use Reverse Time over a region 

containing a soundbite, the soundbite audio data does not play 

backwards like a reversed sample. Instead, the placement of the 

soundbite within the region is modified, along with other soundbites 

and MIDI note data, according to their attack times within the region. 

For details about Reverse Time, Retrograde, and other Region menu 

commands, see the chapter called Region Commands 1 in the MIDI 

Sequencing Reference manual. 
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Split and Trim 

Split 

Trim 

Using Split and Trim 
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The Split and Trim commands let you break up soundbites and trim 

them to the size you want. 

The Split command in the Audio menu allows you to break up a 

soundbite into separate, smaller soundbites. Split makes soundbite 

divisions at the boundaries of the region you select. 

Split, Cut, and Erase all do a similar thing: they split out a section of 

the soundbite. The difference is that Split leaves behind the resulting 

piece, whereas Cut and Erase remove it. Split is a great way to break 

up audio soundbites so that pieces of a soundbite can be edited in 

the Tracks window along with MIDI data. If the region of audio that 

you want to edit along with MIDI is a portion of a soundbite, split the 

portion into its own soundbite and you can then cut, copy, and paste 

it right along with the MIDI data. 

The Trim command in the Audio menu allows you to select a portion 

of a soundbite and remove the parts of it that are not selected. For 

example, you might want to extract a single measure from a 

soundbite that is 8 measures long. It is also very useful for removing 

silence at the beginning and/or end of a recorded soundbite. 

To split or trim a soundbite: 

1. Select the region of audio you wish to split or trim. 

You can use any region selection method you want. See 

“Selecting regions” on page 161, “Selecting a region in the time 

ruler over One or more tracks” on page 144, “Selecting a portion 

of a soundbite using the time ruler” on page 145, and “Selecting 

audio inside a soundbite by pop-editing it” on page 145. 

2. Set the “Edit on Zero Crossings” command as desired. (See 
“Editing on zero crossings” on page 159 for details.) 

3. Choose Split or Trim from the Audio menu. 

The soundbite is split or trimmed as shown in Figure 14-4. In the 

case of splitting, the soundbite is divided into three separate 

soundbites, each with a different name. There is no audible gap 

between split soundbites at this point Cunless you move them). 

4. To change the name of the resulting soundbites, click each 

soundbite to select it and option-click its name in the info bar. 

Once split, soundbites can be dragged and edited independently. 

Editing Audio 



Ing a region Select 

165 

Split and Trim. ing : Us. Figure 14-4 

After using Spl 

After using Trim 
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Strip S jlence Strip Silence breaks up a soundbite into several smaller soundbites by 

removing all of the portions that consist of silence. For example, the 

following soundbite consists of the spoken phrase “Hey! Watch out!”: 

“Hey! watch Gut!” 

You could use Strip Silence to remove the silence from between the 

words and create three separate soundbites. 

To use Strip Silence: 

1. Click the soundbite to highlight it. 

"Hey! yvatch Out!” 

2. Choose Strip Silence from the Audio menu. 

A dialog box appears asking for several parameters. See the 

discussion below for more information. 
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Setting the Strip Silence 
options 

Threshold 

Editing Audio 

3. Set the options accordingly and Click OK. 

The space between each portion of sound (Cin this case each 

word) is removed and what remains are new, separate 

soundbites. 

“Hey! Watch Out! "1 “Hey! Watch Out! *.2 “Hey! Watch Out!”. 

4. Play back the new soundbites to check for clicks, pops, or 

cutoffs. 

If the parameters you chose do not produce soundbite regions 

that are satisfactory, choose Undo from the Edit menu and try 

again with different parameters. 

5. When you get soundbite regions you are satisfied with, you can 

pop-edit their names in the Soundbites window to rename them. 

“Hey!” “watch ” “out!” 

When Digital Performer creates new soundbites after stripping 

silence, it adds regions with the same name as the new soundbites to 

the parent audio file region list. 

When you remove silence in a soundbite, Digital Performer needs a 

precise definition of silence from you, since there is always some 

noise in a recorded audio signal. The three options in the Strip 

Silence dialog box define silence. Together, they act just like a noise 

gate. They define a volume threshold, an Attack period, and a Release 

period. 

The Threshold is a cut off point for the (amplitude) level of the audio. 

If audio falls below the threshold, it will be cut. If it rises above the 

threshold, it won’t be cut. 

The Threshold is expressed in percent of amplitude; values range 

from 1 to 100%. What value you should use depends on the nature of 

the audio and the signal to noise ratio. The rule of thumb is to try to 
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set it as low as possible without generating unwanted soundbites 

(that are merely “noisy silence”) or extensions at either end of 

soundbites. Using a low setting results in less clicks, pops, or clipping 

at the beginnings and ends of the soundbites created. But if you set 

the threshold too low, then hardly any audio will be removed, and 

you may still have unwanted low portions of the signal. 

For “clean” audio with a high signal to noise ratio, use a Threshold 

value below 5%. You may be able to go as low as 1%, which will 

reduce a possible clipping effect at the beginning or end of each new 

soundbite and still produce individual soundbites that do not have an 

excessive amount of near silence at either end. With more noisy 

audio, you may have to select a higher Threshold to avoid creating 

lots of short, unnecessary soundbites. 

The Attack is the minimum amount of time in milliseconds that audio 

must remain above the Threshold in order not to be cut. If the audio 

contains percussive attacks, such as drum sounds, you can set this 

fairly low (ess than 10 milliseconds) to obtain a clean attack on the 

resulting soundbites. If the audio contains longer, sloping attacks, or 

irregular attacks, you might need to set this higher to avoid a clipped 

effect at the beginning of the soundbite. 

The Release is the period of time in milliseconds in which the audio 

must remain below the threshold in order to be cut. If the audio stays 

below the threshold for as long as the duration, it will be cut. If it rises 

above the threshold before the duration has passed, it will not be cut. 

Try values around 100 milliseconds. Set this value higher if the 

soundbites sound clipped at the end. 

A zero-crossing is a point in the audio at which the waveform crosses 

zero amplitude (complete silence). 

When checked, this option helps prevent clicks and pops at the 

boundaries of the soundbites by automatically moving the 

boundaries of each soundbite to the nearest zero crossing. 

When a soundbite is created, Digital Performer adds a corresponding 

region in the audio file with the same name as the soundbite. Digital 

Performer does this so that other applications (such as Sound 

Designer IID) can access and use the regions. Most importantly, it 

prevents the region from being deleted when using the Compact 

command. (The Compact command never deletes audio data that 

falls within a region in the audio file’s region list.) 
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Use Reload Soundbite any time that you have made changes to a 

region in an audio file using software other than Digital Performer 

and wish those changes to be reflected in the region’s corresponding 

soundbite in Digital Performer. 

For example, let’s say that you have changed a region’s boundaries in 

an audio file using Sound Designer II, and you then switch back into 

Digital Performer. But now a discrepancy exists between the region 

in the audio file and the soundbite in the Performer file: the 

soundbite still consists of the original region, not the modified one. 

To make the soundbite match the region again, use the Reload 

Soundbite command. 

To reload a soundbite, select the soundbite(s) by highlighting them in 

the Soundbites window, Event List, or Graphic Editing windows. (The 

Reload Soundbite command operates on only one soundbite at a 

time. If you select more than one in the Soundbites window, it 

replaces the highest one in the list. If you select more than one 

soundbite in the event list or Graphic Editing window, it replaces 

only the earliest one.) Choose Reload Soundbite from the Audio 

menu. Digital Performer searches in the parent audio file for a region 

that matches the name of the soundbite and loads the parameters for 

the region into the soundbite. Reload Soundbite affects all instances 

of a soundbite in a Performer file. 

Reloading after As another example, let’s say that you have created several 
destructive editing in an soundbites in Digital Performer. 

audio file 

Digital Performer soundbites as 
regions in an audio file 

Audio file: [1] 
Soundbite. 1 Soundbite.2 Soundbite.3 

Audio data that will be 
cut in Sound Designer II 

If you open the audio file with Sound Designer II and cut a region of 

audio data at the beginning, all of the regions after the cut are shifted 

earlier. Sound Designer IJ takes care of updating the region list within 
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the audio file, but Digital Performer, which may not even be running 

at the time, has no indication that anything has changed in the audio 

file. 

Digital Performer soundbite pointers remain the same 
after audio has been cut with Sound Designer II. 

Audio file: 

Soundbite. 1 Soundbite.2 Soundbite.3 

The soundbites in Digital Performer no longer correspond correctly 

with the original regions of audio data, which have shifted earlier in 

the audio file due to the removed data. In fact, as you can see in the 

above example, Digital Performer is pointing to Soundbite.3 in a 

portion of the audio file that no longer even exists! 

By using the Reload Soundbite command on the soundbites, you can 

properly re-align the soundbites in Digital Performer with their 

original regions of audio data: 

The Reload Soundbite command realigns soundbite 
pointers with their original regions of audio data. 

Soundbite. 1 Soundbite.2 Soundbite.3 

To reload a soundbite: 

1. Select the soundbite you wish to reload. 

You can do so by highlighting it in the Soundbites window, 

Event List, or Graphic Editing windows. 
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Reloading all soundbites 
in an audio file at one 
time 
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2. Choose Reload Soundbite from the Audio menu. 

Digital Performer searches in the parent audio file for a region 

that matches the name of the soundbite and loads the 

parameters for the region into the soundbite. 

The Reload Soundbite command can be used any time that you need 

to refresh the boundaries of a soundbite. 

In general, always use Reload Soundbite after modifying an audio file 

with other software besides Digital Performer. 

@ Please note: Reload Soundbite affects all instances of 

a soundbite in a Digital Performer file. In other 

words, reloading affects the soundbite and all 

“clones” of that soundbite wherever they may exist 

in audio tracks. 

You'll notice that Reload Soundbite isn’t really going to be used much 

if you don’t use any other programs besides Digital Performer to 

work with the audio file. However, any time that you edit regions or 

audio data in an audio file, think about what impact the editing has 

on any Digital Performer files that contain soundbites from that audio 

file. 

Often, you'll have several — and usually many — soundbites that 

originated the same audio file, and you'll need to reload all of them. 

Certainly a tedious task if you had to do so one at a time. But there 

is a shortcut for reloading all of them at once: 

1. Command-double-click the name of the parent audio file next to 

one of the soundbites in the Soundbites window. 

It doesn’t matter which soundbite you choose, as long as its 

from the parent audio file you need to reload from. 
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These soundbites 

all belong to the 
same parent 

audio file called 

“Sax.new’. 

Command-double click the audio file ee 
to reload all soundbites from the file. 

2. In the dialog box that appears, locate and select the parent audio 

file. 

If you are doing this procedure after having moved the entire 

project from one hard disk location to another, be sure to select 

the newly copied version of the audio file — not the original. 

That’s it. Digital Performer automatically reloads all of the soundbites 

in the file. 

If reloading fails The Reload Soundbite command fails if Digital Performer cannot find 

a region with the same name as the soundbite in its parent audio file. 

Or, it may not be able to find the parent audio file. If so, Digital 

Performer warns you that this is the case and asks you to select 

another region to replace the soundbite. For information about 

replacing soundbites, refer to the next section. 

| 

| 

The Replace Soundbite command is similar to Reload Soundbite but 

gives you more flexibility. It allows you to replace a soundbite with 

| any audio file region— even an entirely different region from another 

| audio file. In addition to updating the soundbite’s start and end 

| pointers, Replace Soundbite also updates the name if the soundbite is 

Replace 
Soundbite 

being replaced by a region with a different name. 

Just like Reload Soundbite, Replace Soundbite replaces all instances 

of a soundbite in a Digital Performer file. Here’s an example. Let’s say 

that you recorded a vocal soundbite, named it Yeah/, and are using it 

as an effect in a mix. You have placed it fifteen or twenty times 

throughout the mix. During the course of the session, you decide that 
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Duplicate 
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you would like to replace all the Yeah/’s with a different soundbite 

that you recorded and named Hey/ Replace Soundbite makes 

substitutions like this easy. 

To replace a soundbite: 

1. Select the soundbite that you wish to replace. 

The Replace Soundbite command operates on only one 

soundbite at a time. If you select more than one in the 

Soundbites window, it replaces the highest one in the list. If you 

select more than one soundbite in the event list or Graphic 

Editing window, it replaces only the earliest one. 

2. Choose Replace Soundbite from the Audio menu. 

The open audio file dialog box appears. (See Figure 10-1 on 

page 95 for an example of this dialog.) 

3. Select the audio file and region you want to replace the 
soundbite with using the controls in the dialog box as shown in 

Figure 10-1 on page 95. 

After you click the Done button, the new region takes the place 

of the old region. Likewise, all instances (“clones”) of the old 

region in all the tracks are replaced as well. 

The Duplicate command in the Audio menu creates an entirely new 

soundbite based on the currently selected soundbite. The new 

soundbite is given a different name from the original by adding a 

number extension to the end of the original name. For example, if 

you duplicate a soundbite with the name Snare Hit, Duplicate creates 

an identical soundbite with the name Snare Hit.1. The important 

thing to realize here is that you now have two separate soundbites 

that are not connected to each other. As a result, you can freely 

modify Snare Hit.1 (drag an edge, for example) without affecting the 

original soundbite, Snare Hit. 

Duplicating is different from copying a soundbite, which produces a 

“clone” of the original that is still connected to it. If you modify a 

copied soundbite, the original is modified, too (and vice versa). 

@ The Duplicate command does not duplicate the 

actual audio data; it duplicates pointers to the audio 

data. Therefore, destructive editing that you perform 
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on the duplicate soundbite with Sound Designer II 

will affect the original soundbite. So be careful when 

editing duplicate soundbites with Sound Designer II. 

To use duplicate: 

1. Select the soundbites you wish to duplicate. 

You can select as many at once as you wish. You can do so by 

highlighting them in the Soundbites window, Event List, or 

Graphic Editing windows. 

2. Choose Duplicate from the Audio menu. 

A duplicate of the soundbite is placed at the bottom of the 

Soundbites window. 

Edit in The Edit in Waveform Editor command in the Audio menu provides 

direct entry into Sound Designer II 2.5 (or higher) from Digital 

Wa vef orm Edi tor Performer. (Look for support of other waveform editing software in 

future releases of Digital Performer.) 

This command allows you to perform “destructive” audio editing 

tasks not currently available directly in Digital Performer such as 

‘pencil tool’ editing of digital audio samples or DSP features such 

normalize, reverse, time dilation, and so on. 

For convenience, this command is activated by selecting a soundbite 

so that when you switch into Sound Designer II, the waveform 

window appears with the soundbite region already highlighted. Once 

in Sound Designer II, you can perform any Sound Designer II editing 

function that you wish on the selected region. 

This command can be used to view the audio data in Sound Designer 

II’s waveform window and to perform destructive editing tasks such 

as changing gain. 

You can launch Sound Designer II from the Soundbites window, the 

Event List, or the Graphic Editing window. Highlight the soundbite 

you wish to edit and choose Edit Waveform Editor from the Audio 

menu, or command-double-click the soundbite. In the Soundbites 

list, you can simply double-click the soundbite. If this is the first time 

that you have opened Sound Designer II (or you have moved it since 

the last time you opened it) from within a copy of Digital Performer, 

a dialog box appears asking you to locate Sound Designer II on your 

hard disk. 
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Chapter15 The Mixing Board 

Digital Performer’s Mixing Board window provides a powerful 

integrated mixing environment for both MIDI and audio tracks. It also 

provides access to real-time effects processing for both MIDI and 

audio tracks, including access to Digidesign’s powerful TDM mixing 

and effect environment, as well as the built-in EQ capabilities of 

Audiomedia II and non-TDM Pro Tools systems. 

The Mixing Board will seem very familiar because it is modeled after 

standard hardware consoles. Lurking under the hood, however, are 

many powerful features, as well as many time-saving shortcuts. This 

chapter covers them all. 

Here is an overview of the main topics covered in this chapter: 

m “Quick Reference” on page 176 

mw “Mini-menu” on page 177 

a “Mixing Board window basics” on page 179 

m “Track strips” on page 182 

a “Automated mixing” on page 186 

mw “Mixing in real time” on page 189 

m “Grouping” on page 191 

m= “Remote control” on page 192 

mw “The Effects window” on page 194 

m “MIDI Effects: the velocity compressor and transposer” 

on page 196 

mw “Working with TDM” on page 197 
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Quick Reference 

Track list Snapshot Show/Hide 
Track list 

Track Insert 

Section 

Solo/mute/Auto 

: Pan 

Faders and 

level meters 

=o 

Tracks 

Track list: Click or drag over the names of the tracks in this list to 

show or hide them in the Mixing board. Option-click to hide all 

except the track you click; command-click to show all except the 

track you click. 

Snapshot button: Takes a snapshot of the current settings for all visible 

pan and volume controls in the mixing board for every track currently 

being displayed. Command-click to include a// tracks (even ones not 

currently displayed). The snapshot inserts controller events in each 

track at the current main counter location. This can be done while 

Digital Performer is stopped or playing back. 

Show/Hide Track list: Shows and hides the list of tracks at the left side 

of the window. 
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Mini-menu 

The Mixing Board 

Track Insert Section: Displays track inserts for MIDI and audio tracks. 

Choose the desired effect from the insert pop-up menu, or click a 

menu to open an effects window for the insert. MIDI track inserts 

consist of MIDI processing effects such as the transposer and velocity 

compressor. Audio inserts consist of TDM plug-in effects, such as EQ, 

dynamics, reverbs, delays, and any TDM-compatible plug-ins you 

currently have installed in your system. Built-in EQ is also provided 

on Audiomedia II and non-TDM Pro Tools systems. 

Solo/Mute/Auto: These buttons perform standard soloing and muting 

functions. When the Auto button is turned off, volume and pan 

automation data in the track is temporarily disabled. “Glide” 

horizontally across these buttons with the mouse to quickly toggle 

several tracks at once. t 

Pan: Pans an audio track across its pair of outputs, as assigned in the 

Tracks list window. For example, if a track is assigned to outputs 3 

and 4, pan left sends the track to output 3; pan right sends it to 4. For 

MIDI tracks, these pan pots generate standard MIDI panning data. 

Double-click the pan knob to go to pan center. If automation data has 

been recorded, knobs animate during playback (when the Auto 

button is enabled). 

Faders: Control volume for each MIDI and audio track by generating 

MIDI and audio volume events, which can be recorded into the track 

for automation. If automation data has been recorded, faders animate 

during playback (when the Auto button is enabled). 

Level Meters: For audio tracks, the level meters display the audio 

output level for the track as determined by the soundbite velocities 

and volume controller data in the track. For MIDI tracks, the level 

meters indicate MIDI note-on velocities. 

Tracks: Each strip in the Mixing Board represents a MIDI or audio 

track in the currently play-enabled sequence. Show or hide them as 

desired using the Show/Hide track list (described above). Drag the 

track strip name horizontally to re-order them. 

The top section of the mini-menu displays checkable menu items that 

show and hide each section of the console. Checked items are visible. 

Unchecked items are hidden. Hold down the option key to hide all 

sections except the one you choose; use the command key to show 

all sections except the one you choose. If the Auto Resize command 

is checked, the console window will automatically resize itself when 

sections are shown or hidden. 
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Auto Resize: When checked, this menu item causes the Mixing Board 

window to resize itself when sections or tracks are shown or hidden. 

Load Board Layout: Redraws the window with the mixing board layout 

that you choose from the sub-menu. A /ayout consists of which tracks 

and sections are currently showing in the window. There are several 

preset layouts, such as Show Everything, which shows all tracks and 

sections. You can also load a layout that you have previously created 

with the Save Board Layout command. A shortcut for this command 

is to option-click the title bar of the Mixing Board window. 

Save Board Layout: Saves the tracks and mixer sections currently being 

shown in the window as a customized board layout, which you can 

name, save, and recall at later time using the Load Board Layout 

command described above. 

Delete Board Layout: Discards the customized board layout that you 

choose. 

Edit Group: Lets you add or remove faders or pan knobs from an 

existing group. 

Create Group: Lets you create and name a group of volume faders and/ 

or pan pots that will move together when you move any member of 

the group. To add or remove items from the group, choose the Edit 

Group command after creating it. 

Delete Group: Discards a fader or knob group that you created. 

Attach MIDI Controller: Lets you connect a mixing board fader or knob 

to an external MIDI controller, such as a mod wheel. 

Clear MIDI Controller: Removes the connection to an external 

controller from the knob or fader that you select with the cursor. 

Auto Punch-In/Out: A special record mode for volume faders and pan 

pots which causes them to record data into their track only when the 

control item is moved, either with the mouse or an external source. 

Auto Punch-Out Delay: Allows you to adjust the delay before punch-out 

when you are in Auto Punch-In/Out mode and are controlling a 

control item from an external MIDI source. The Punch-Out time is the 

amount of time (in tenths of a second) after the last event is received 

by a control item from its external source before the control item 

drops out of Record. 
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Mixing Board 
window basics 

Opening the Mixing 
Board 

Showing and hiding 
tracks 

The Mixing Board 

Min Time and Value Change: Allows you to set the minimum amount of 

time between volume and pan events that the mixing board controls 

will generate when you move them. Also lets you choose the 

minimum value change. Raising these values can prevent 

unnecessarily high data density. But raising them too high can result 

in zipper noise, or audible “stepping” during smooth changes. 

The mixing board is a track-based mixing console for all MIDI and 

audio tracks. It has one strip for each track in the sequence. 

To open the Mixing Board, choose the Mixing Board command from 

the Windows menu. If you have tracks selected at the time, the 

mixing board will appear with only those tracks showing. If you have 

multiple sequences in the file, it chooses the sequence to open by the 

front-most window on the screen, or alternately, by which sequence 

is currently play-enabled. 

To choose which tracks you want to display, click the track list button 

in the title bar as shown below to open the track list. Then just click 

tracks to either show them or hide them. Option-click to hide all 

except the track you click; command-click to show all except the 

track you click. 

Track list Track list button 

Click, 

option-click, 
and 

command-click 

in this list. 

Figure 15-1: Showing and hiding tracks. 
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Changing the order of To move tracks left or right, drag them by their name at the bottom 

the track strips of the strip. 

Showing and hiding Use the section names at the top of the Mixing Board window mini- 

sections menu to show and hide console sections, such as the Inserts section. 

Checked items are visible. Unchecked items are hidden. This allows 

you to optimize the console appearance for your screen size. Hold 

down the option key to hide all sections except the one you choose; 

use the command key to show all sections except the one you 

choose. If the Auto Resize command is checked, the console window 

will automatically resize itself when sections are shown or hidden. 

Figure 15-2: A simplified mixing board layout with 
several sections hidden, including inserts. 

To change the order of 
the tracks, drag them by 
their name section at the 
bottom of each strip. 

Saving custom board If you have favorite board layouts that you use frequently, you can 

layouts save them and later recall them by name. To create a custom board 

layout: 

1. Using the window’s show/hide track list, show the tracks you 

want to include in the layout; hide tracks you don’t. 

2. Using the show/hide section mini-menu commands, show the 

sections you want to include and hide the ones you don’t. 

3. Choose Save Board Layout from the mini-menu. 

4. Type in a name for the layout and click OK. 
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Switching board layouts There are several ways to change board layouts: 

=» Choose the layout you want from the Load Board Layout 

mini-menu command 

mw Option-click the Mixing Board window title bar and 

choose the layout you want from the pop-up menu 

Rhythm Section Onl 

Figure 15-3: Switching mixing board layouts. 

Renaming board layouts To rename a board layout, choose the Rename Board Layout 

sub-menu item from the Load Board Layout mini-menu command. 

Manually resizing the You may notice that the mixing board window automatically resizes 

Mixing Board window itself when you add or remove tracks, show or hide sections, or 

switch board layouts. This is because the Auto Resize mini-menu 

command is checked. If you would prefer to resize the window 

manually using the grow box in the lower right corner, uncheck Auto 

Resize. 

Switching sequences To quickly switch the sequence you are looking at in the Mixing 

Board window, command-click the window’s title bar and choose the 

desired sequence from the pop-up menu. The tracks shown in the 

Mixing Board will change when you change the play-enabled 

sequence. 
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Track strips Each MIDI and audio track strip has the sections shown below. 

Inserts 

Solo / Mute / Auto 

Pan and pan ato { 

Clip indicator 

Volume fader Level meter 

Track name 

Figure 15-4: A Mixing Board track strip. 

Inserts An insert is a real-time effect that is non-destructively applied to the 

data in the track on playback. MIDI tracks can be processed with a 

velocity compressor or a transposer. (Look for more MIDI processing 

effects in future versions of Performer.) Audio tracks can be 

processed by built-in EQ Cwith audio hardware that supports it) or by 

TDM plug-ins (with hardware that supports TDM) such as reverb, 

dynamics, delays, or any TDM-compatible plug-ins you currently 

have installed in your system. 

Each insert in the track is represented as a pop-up menu from which 

you can choose the desired affect. Audio tracks have 5 inserts. MIDI 

tracks have 2 inserts (with more becoming available in future versions 

of Digital Performer as more MIDI processing modules become 

available). When you select the desired processor type from a pop- 

up menu, the Effects window opens to display the selected 

processor’s parameters. See “The Effects window” on page 194 for 

more information. 

@ Selecting audio effects during playback causes audio 

playback to pause while the change is being made. 

This is normal. 
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Solo and Mute buttons 

Auto buttons 

The Mixing Board 

The audio signal passes through the inserts from top to bottom. 

Accordingly, inserts are labelled A, B, C, etc. from top to bottom. 

Similar to hardware mixing consoles, the order in which effects are 

applied makes a difference, so keep this in mind when employing 

multiple inserts. 

Audio effects are applied pre-fader, so it is possible to accidentally 

cause clipping if you boost insert gains too high. Be careful when 

setting insert levels in the Effects window. 

Insert settings apply globally to the entire track and are remembered 

until you change them, even if you open the file using a non-TDM 

system and then re-open it again on a TDM system. Effects cannot be 

automated in Digital Performer Version 1.6. Look for this feature in a 

future update. 

Solo and Mute buttons perform standard soloing and muting 

functions for each track. In fact, they correspond directly to the 

soloing and muting features in the Tracks List window. For example, 

when you mute a track in the Mixing Board, its play-enable button 

becomes disabled in the Tracks List window. 

When soloing and muting, the volume fader background color 

changes to indicate the playback state of the track as follows: 

Fader background color Meaning 

Color screen | Black & white 

Blue Dark gray Track can play 

Orange Light gray Track cannot play because at least 

one other track is soloed 

Gray White Track is muted 

When the Auto button is turned off, volume and pan automation data 

in the track — including controller chasing — is temporarily disabled, 

allowing you to override the automation data with the current pan 

knob and volume fader setting. 

@ Auto buttons cannot be turned on and off during 

playback or recording. 
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Button shortcuts The table below describes several shortcuts for the Solo, Mute, and 

Auto buttons: 

To do this: Do this: 

To solo or mute all tracks except the Command-click the track’s 

one you Click solo or mute button 

To unsolo or unmute all tracks except Option-click the track’s solo or 

the one you click mute button 

To change the solo, mute, or auto set- | Drag across the buttons hori- 

ting for several adjacent tracks quickly | zontally with the cursor 

Figure 15-5: Gliding across the Solo, Mute, and Auto buttons. You can combine gliding with 
the command and option key modifiers as described in the table above. 

Panning Pan knobs pan an audio track across its pair of outputs, as assigned 

in the Tracks list window. For example, if a track is assigned to 

outputs 3 and 4, pan left sends the track to output 3; pan right sends 

it to 4. For MIDI tracks, these pan pots generate standard MIDI 

panning data. 

The data range for MIDI tracks is zero to 127, where zero is hard left. 

The data range for audio tracks is <64 Chard left) to 63> Chard right). 

Below is a summary of techniques for pan knobs: 

To do this: Do this: 

Change panning smoothly Drag the pan knob up and down or left 

over time and right, or click on the number in the 

value readout and drag up or down 

Go directly to pan center Double-click the knob 

Increment or decrement Click the left or right arrow button 

the pan setting by one 
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Volume faders 

Controlling pan and 
volume from an external 
MIDI controller 

Level meters 

The Mixing Board 

The volume faders control the output level for each MIDI and audio 

track by generating MIDI and audio volume events, which can be 

recorded into the track for automation. If automation data has been 

recorded, faders will animate during playback (when the Auto button 

is enabled). 

The background color of volume faders changes depending on the 

solo and mute state of the track. See “Solo and Mute buttons” on 

page 183 for details. 

Below is a summary of mousing techniques for changing the values 

of Mixing Board volume faders: 

Drag the handles to change 
the slider’s value smoothly. 

Click anywhere on the bar to snap 
the slider to that position. 

Click the fader value directly to 
Drag up and down on the fader value type in a number. 
to change the number smoothly. 

Press the +/- buttons to Click the +/- buttons to 
move the slider smoothly. move the slider by one. 

Drag up and down on these arrows to 
change the number smoothly. 

To control a volume fader or pan knob from an external MIDI 

controller such as a mod wheel on a keyboard, use the Attach MIDI 

Controller command in the Mixing Board window mini-menu as 

described later in this chapter in “Remote control” on page 192. 

For audio tracks, the level meters display the audio output level for 

the track as determined by the soundbite velocities and volume 

controller data in the track. For MIDI tracks, the level meters indicate 

MIDI note-on velocities only (the fader indicates controller #7 MIDI 

volume). 

The Set Level Meter Range mini-menu command in the Audio Monitor 

window controls the dynamic range displayed in the Mixing Board 

level meters. For details, see “Adjusting the level meter range” on 

page 89. 
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Monitoring input levels 
on TDM systems 

Clip indicators 

Track name 

Automated 
mixing 

The importance of event 
chasing 
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Option-selecting the level meter mini-menu command in the Mixing 

Board window creates a meter bridge, which you can save as a 

custom board layout. 

When recording audio tracks in TDM systems, the input level is 

monitored in the Mixing Board output level meter for the currently 

record-enabled track (see the note below, however). This means that 

you can control the monitor level and pan position from the Mixing 

Board window and can apply effects to the monitored signal as well. 

@ Due to the way DAE works, input is not necessarily 

monitored out the track that is record-enabled. If 

another track exists that is assigned to the same 

voice AND has higher priority G.e. is higher in the 

list), then that track will monitor the input instead. 

To work-around this situation, you can move the 

record-enabled track to the top of the list or you can 

make sure that the record-enabled track is the only 

track assigned to that particular voice. 

Audio tracks display a clip indicator above their level meter as shown 

in Figure 15-4 on page 182. If the Retain Clip mini-menu command in 

the Audio Monitor window is checked (see “Retain clip” on page 90 

for details), these clip indicators will remain illuminated until you 

click them. Double-click to clear all clip indicators. 

Track names appear here, with an ellipsis for long names, if 

necessary. You can drag a name horizontally to reposition its channel 

strip in the Mixing Board window. 

The Mixing Board is a powerful environment in which to automate 

the combined mix of your MIDI and audio tracks. This section 

explains how to accomplish basic mixing tasks with the Mixing 

Board. 

@ Most of these procedures are identical to working 

with sliders in Performer’s custom console feature. 

Automated mixing in Digital Performer is heavily dependent on audio 

and MIDI controller event chasing. Event chasing causes Digital 

Performer to always scan tracks for controller events to make sure 

that playback levels are correct, regardless of where you start 

playback. (For complete information, see “Event Chasing” on 

page 116 of the Performer Reference Guide.) 
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Setting initial levels with 
the Mixing Board 

The Mixing Board 

For a consistency during the mixing process, it is best to enable event 

chasing for audio volume, audio pan, and MIDI controllers. To do so, 

choose the Set Event Chasing command from the Basics menu and 

make sure that these items are checked. 

Regardless of whether you plan to automate your mixing directly in 

Digital Performer or externally using an automated mixing console or 

other hardware automation system, it is always best to set initial 

volume and pan settings in all of your tracks. This ensures 

consistency in your mix, gives Digital Performer an initial setting to 

chase to, and gives you a basis for any changes made later in each 

track. 

In Digital Performer’s MIDI tracks, there is no default volume or pan 

setting per se, which means that when you first open a new or 

existing Digital Performer file, the pan and volume settings for each 

track will be in whatever state they were last left in the MIDI device 

itself. Setting initial levels takes care of the consistency problems that 

arise from this situation. 

In audio tracks, Digital Performer defaults to pan center and unity 

gain. For example, if you open a new file, open the mixing console, 

and press play, the volume faders for the audio tracks will snap to 

their maximum position (assuming that their Auto buttons and event 

chasing haven’t been turned off). Obviously, you’ll want to set initial 

lower levels so that you have room to mix. 

The procedure for setting initial values is simple: 

1. Open the Mixing Board. 

2. Show all tracks you wish to initialize; hide ones you don’t. 

Use the show/hide track list as shown in Figure 15-1 on 

page 179. Tracks don’t actually have to be visible on the screen, 

just selected in the track list. 

3. Rewind Digital Performer to the beginning of the sequence (or 

locate to wherever you'd like to place the initial settings). 

4. Make the desired volume and pan settings for each track. 
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5. Click the Snapshot button in the Mixing Board window title bar. 

Command-click the button to capture a// controls, including 

ones that are not currently showing in the window. 

Snapshot butto 

If you change your mind, you can undo the snapshot. 

Viewing initial settings You can view the initial settings for audio tracks in the Audio Graphic 

Editor by opening it and selecting volume or pan from one of the 

track display pop-up menus with the option key held down (which 

switches all tracks to display volume). To make changes graphically, 

drag the control points up or down as desired. 

hs lure 

Making snapshots You can make snapshots as described above anywhere in your 

elsewhere in the mix Digital Performer mix. 
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Changing initial levels 
(or any snapshot) 

Mixing In real 
time 

Turn off all track record- 

enable buttons before 
you start recording a mix 

Recording fader moves 

Recording with Auto 
Punch-in/Out turned off 

The Mixing Board 

You can change your initial settings at any time, or any snapshot for 

that matter, by queuing to the same tick location in the main counter 

and repeating the procedure described earlier in “Setting initial levels 

with the Mixing Board”. The snapshot feature will never duplicate 

controller data on the same tick, replacing existing data with the new 

snapshot value if data already exists at that location. Just make sure 

the main counter is exactly at 1|1]000 (or wherever your initial 

settings are located). 

Once you have set initial levels, you have established a basis from 

which to create automated changes in the mix by recording in real 

time. The next few sections explain how to do so. 

When the Mixing Board window is the front-most (active) window, 

Digital Performer allows you to start recording without having a track 

record-enabled. But be sure to turn off all record-enable buttons in 

the Tracks window before you begin recording a mix to avoid 

accidentally erasing notes, soundbites, or other data. 

After doing so, click the Mixing Board window title bar (or choose it 

by name from the Windows menu) to make it the active window. 

Once you’ve made the above preparations, you are ready to record. 

Just press the record button in the Consolidated Control panel and 

drag faders as desired. All of your moves will be recorded in real 

time, including entire fader groups when you move them. 

Faders automatically punch in when you drag them and punch out 

when you release them, so you can punch in on top of existing 

automation data on the fly. If you want, you can disable automatic 

punch in as described in the next section. 

When you uncheck the Auto Punch-In/Out command in the Mixing 

Board mini-menu, and the Mixing Board window is open, all faders 

and knobs currently visible in the window punch in as soon as you 

begin recording. As recording continues, they continuously wipe out 

any existing automation data in the tracks as shown in Figure 15-6 on 

page 190. This is useful for “wiping out” existing automation data on 

multiple tracks in one record pass. 
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Initial fader positions at 1111000 
before recording begins. 

Existing Data Auto Punch-In/Out Auto Punch-In/Out 
Existing volume automation turned on turned off 

data in tracks. Results after recording a Results after recording a 
2-measure fade out at bar 3 with 2-measure fade out at bar 3 with 

Auto Punch-In/Out turned on. Auto Punch-|n/Out turned off. 

Figure 15-6: Recording faders with Auto Punch-In/Out turned off. 
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Controlling data density 

Editing your mix 
graphically 

Grouping 

Creating a new group or 
modifying an existing 
one 

The Mixing Board 

The Min Time and Value Range mini-menu command in the Mixing 

Board window lets you control the density of the automation data 

events generated by the Mixing Board faders and knobs. Higher 

minimum values produce lower density, which places less strain on 

the audio playback engine (DAE), but densities that are too low can 

cause zipper noise or “stair-stepping”. When experimenting with data 

density, factors such as playback tempo also come into play. 

Keep in mind that all of the procedures above describe the mixing 

process from the standpoint of the Mixing Board. You can also edit 

your mix graphically in the Audio Graphic Editor. For details, see 

“Editing volume, pan, and loops graphically” on page 149. 

The Mixing Board allows you to create an unlimited number of fader 

and/or knob groups. Once a group is created, dragging any fader 

within the group moves all members of the group, scaling them 

proportionally to their current values. Option-dragging temporarily 

overrides the group to adjust a control relative to the group. 

To create a fader group or modify an existing one: 

1. If you are creating a new group, first choose Create Group from 

the Mixing Board mini-menu, type in a name for the group, and 

click OK. 

2. If you are modifying an existing group, choose Edit Group from 

the Mixing Board mini-menu and select the group you just 

created from the sub-menu. 

After either step 1 or 2, the cursor turns into a plus sign to 

indicate that you are now ready to add (or remove) faders and/ 

or knobs from the group. Existing faders in the group display a 

flashing green (or black) box. 

3. Click the faders (and/or knobs) you want to add. 

A flashing green (or black) box appears around the fader to 

indicate that it has been added to the group. 

4. To remove faders (and/or knobs) from the group (ones that 

already have a flashing box), click them. 

5. When you are finished adding and removing items, press the 

return or enter key to confirm the group, or double-click the last 

item you want to add or remove. 

To cancel, press command-period, the escape key (esc), or click 

elsewhere in the window (such as the title bar). 
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Temporarily overriding 
the group on the fly 

Deleting and renaming 
groups 

Temporarily disabling 
automation 

Remote control 

Attaching a MIDI 
controller to faders and 
knobs 

192 

To temporarily override a group when moving a fader, option-drag it. 

This allows you to adjust a track’s level relative to the rest of the 

group. 

To delete or rename a group, use the Delete Group and Edit Group/ 

Rename Group mini-menu commands. 

You can temporarily disable the automation data in a track by turning 

off the track’s Auto button in the Mixing Board (shown in Figure 15- 

4 on page 182) or the Audio Graphic Editor. 

You can control any of the faders or knobs in the Mixing Board from 

any external source that can generate MIDI controller data, such as a 

mod wheel on your controller keyboard, a MIDI fader box such as 

JL Cooper’s FaderMaster™, or a battery of faders on a 

MIDI-controlling mixing console such as Yamaha’s ProMix 01™. 

Use the Attach MIDI Controller command to set up external control 

of faders and knobs as follows: 

4 Choose Attach MIDI Controller. 

The cursor changes to a plus sign. 

. Click the fader or knob you wish to control externally. 

A red box appears around the control indicating that Digital 

Performer is waiting for an incoming MIDI controller event. 

Transmit the data from your MIDI Controller and the box flashes 

green. 

Only MIDI continuous controller data can be used; pitch bend, 

note-ons, etc. cannot. 

(Optional) Click another fader or knob, or use the arrow keys to 

move the flashing box around to attach other controls in a 

similar fashion. 

When you are done attaching controllers, press return or enter, 

or double-click the last item you attached. 

To cancel, press command-period, the escape key (esc), or click 

elsewhere in the window (such as the title bar). 
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Clearing MIDI controllers Use the Clear MIDI Controller command to display all controls that 

have MIDI controllers attached. They all flash green. Click a control 

to detach it from the controller. Type Return or Enter to confirm the 

detachment or command-period to cancel. 

Setting the punch-out When you record a fader or knob via remote control, it punches in 

delay and out in much the same fashion as when you grab it with the 

mouse. To punch in, the fader or knob waits to receive an event from 

its external controller. When it does, it punches in. Punch out, 

however, is done automatically by Digital Performer and is 

determined by the amount of time after the last event was received 

from the controller. Since controllers send data with different degrees 

of sensitivity, you may find that punch out occurs too frequently. To 

avoid stuttering the punch out, you can lengthen the delay before 

Digital Performer punches out with the Auto Punch-Out Delay 

command in the Mixing Board window mini-menu. 

‘Set Punch Out © 
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The Effects 
window 

MIDI, audio, and TDM 
effects 

EQ for Audiomedia Il 
and non-TDM Pro Tools 
systems 

How effects settings 
apply to a track 

Opening the effects 
window 
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The Effects window is a like a “floating palette” for Digital 

Performer’s real-time MIDI and audio processing effects. It displays 

all of the controls for a given effect on a given insert on a certain 

track. You can quickly and easily switch the effect, insert, and track 

you are viewing in the Effects window at any time. 

The Effects window provides velocity compression and transposition 

for MIDI tracks (with more MIDI effects on the way in future 

updates). Built-in EQ is available for hardware configurations that 

support it. For example, AudioMedia II has one EQ, and Pro Tools 

has two. The Effects window also provides access to all TDM- 

compatible plug-ins installed in your system for audio hardware 

systems that support TDM. 

Digital Performer provides access to the built-in EQ capabilities of 

Audiomedia II systems and non-TDM Pro Tools. Audiomedia I 

provides one EQ and Pro Tools (without TDM) provides two. These 

built-in effects are accessed in the usual way via the insert pop-up 

menus and Effects window as described in this section. 

Effects settings apply globally to the entire track and are remembered 

until you change them, even if you open the file using a non-TDM 

system and then re-open it again on a TDM system. Effects cannot be 

automated in Digital Performer Version 1.6. Look for this feature in a 

future update. 

There are several ways to open the effects window: 

m Choose an effect from any insert pop-up menu in the 

Mixing Board window 

m Click an insert pop-up menu that already has an effect 

m Choose Effects from the Windows menu 
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Quick reference Below are the basic controls in the effects window. The controls for 

each specific effect will, of course, vary. 

The Effects window with no effect 

currently being displayed. 

Use the pop-up menus to switch the track, 
“~Y insert, and/or effect being displayed. 

The track menu The Insert menu The Effect menu 

Effect-specific controls 

Figure 15-7: Digital Performer’s Effects window. 
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Choosing a new effect To choose an effect for an insert, select the desired effect from the 

for an insert insert pop-up menu. When creating a new effect, Digital Performer 

uses the most recent settings for that effect. For example, if you tweak 

EQ parameters on one track until they are just right, adding the EQ 

effect to another track will initially apply the same settings. 

Opening an existing To open an existing effect on an insert, click the insert pop-up menu. 

effect on an insert 

Copying and pasting You can copy and paste effects parameters from one insert to 

parameters from one another. Just choose Copy from the Edit menu while a specific insert’s 

insert to another effect is being displayed, switch to a different insert with that same 

effect, and choose Paste. 

Effects settings are Effects settings are saved with the file. In addition, the settings for 

remembered each insert and track are remembered even if you temporarily 
remove the effect and re-apply later on. Settings are also remembered 

if you switch audio hardware. For example, if you add TDM effects, 

switch to a non-TDM system and save the file, the TDM effects 

remain saved with the file, so that they will still be there when you 

switch back to a TDM system. 

MIDI Effects: the velocity Digital Performer currently provides two MIDI effects: a velocity 

compressor and compressor and transposer, which are described below. 

tr. ansposer 

This diagonal line 
represents no 
compression. 

Current 
compression 
settings 

0 to 127 grid 

Transposer 
Choose any interval of chromatic transposition using the 

slider or by editing the pitch text box (type, drag up/down, or 
click the arrow buttons). The specific pitches do not matter: 

the interval between them determines the degree of trans- Velocity compressor 
position. For example, to transpose an octave up or down, The graph shows the result of the compression settings. A 

choose C4 or C2, respectively. diagonal line from lower left to upper right represents no 
compression. The higher the ratio, the higher compression. 
Gain allows you to raise or lower the overall level while 
compressing. Threshold sets a cutoff value, below which 
no compression will occur. 
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Working with 
TDM 

Virtual mixing with TDM 

The impact of mixing on 
effects 

Using TDM effects 

Mono versus stereo 

effects 

The Mixing Board 

TDM is Digidesign’s virtual mixing and routing environment for Pro 

Tools™ systems. If you have TDM hardware and software installed in 

your system, the Effects window provides access to all of the 

TDM-compatible plug-ins currently installed in your system. 

Consult your TDM User’s Guide for complete information about TDM 

installation and setup, as well as general information about what 

TDM is and how it works. The sections below explain how you 

access and use TDM within the Digital Performer environment. 

When TDM is installed, it provides the following features to Digital 

Performer: 

m Virtual mixing 

a» TDM effects plug-ins 

These features are discussed in the following sections. 

TDM’s virtual mixing capabilities are employed when you make 

output assignments for audio tracks in the Tracks window. For 

example, if you assign several audio tracks to outputs 1 and 2, TDM 

takes care of the mixing necessary to merge the tracks to a single 

stereo Output pair. 

From the standpoint of Digital Performer, the only thing you need to 

know about TDM mixing is that it requires DSP resources. The more 

mixing that TDM has to do, the less DSP power is left over for TDM 

effects such as EQ, reverb, etc. For a “guerilla guide”, see “Managing 

your DSP resources” below. For a complete understanding of this 

topic, consult your TDM manual. 

One of the best things about TDM is how powerful — and yet easy 

to use — it is. Basically, all you have to do is choose the TDM plug-in 

effect(s) you want for each track. The Effects window displays the 

parameters for the effect, exactly as they are implemented by 

Digidesign or third-party TDM developers. For information about 

specific effects, consult the documentation for the effect. 

TDM effects can be either mono, stereo or mono-to-stereo. By 

default, audio tracks are mono and are panned across the output pair 

assigned to the track in the Tracks window. If you assign mono TDM 

effects, the track remains mono. However, as soon as you choose 

either a stereo or mono-to-stereo effect, the track’s output becomes 
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Be careful when 
boosting gain 

Panning with stereo 
effects 

Managing your DSP 
resources 
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stereo. In addition, all other effects currently assigned to the track will 

dynamically switch to stereo as well. If you remove the stereo effect, 

the track will then dynamically revert to mono. 

Some TDM plug-ins provide volume controls of their own. Because 

Digital Performer’s effects inserts are pre-fader, it is possible to boost 

level above unity gain with a plug-in’s volume control. Because 

everything is happening digitally, there is no headroom at all, and 

distortion will occur immediately past zero dB, so be careful. 

Stereo effects cause the track’s pan knob to become “stereo pan”. The 

following chart explains the results of stereo panning. In general, 

center the knob for full separation of the stereo signal. 

Stereo pan knob position Left signal Right signal 

The trickiest part about using TDM effects in Digital Performer (or 

any TDM system) is managing your DSP resources. TDM hardware 

has limits to the amount of mixing and effects processing it can 

provide at one time. Fortunately, TDM has an open architecture, 

allowing you — finances permitting — to purchase extra DSP farm 

boards to extend the capabilities of your system. But regardless of 

your hardware configuration, the following pointers will help you 

best manage your processing resources. 

Each DSP chip can only do one type of processing 
Each DSP chip in your system can only do one type of processing 

(mixing, EQ, reverb, dynamics, delays, etc.) at a time. On the other 

hand, one chip can share several similar types of processing. For 

example, one chip might be able to process several different types of 

EQ’s. So, for example, when you choose an EQ plug-in for the first 

time, you have just dedicated an entire DSP to EQ — even if the EQ 
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you choose doesn’t require all of the DSP’s power. If you then choose 

a reverb effect, another DSP chip is then allocated for reverb-type 

effects. 

A single DSP can hold many simple plug-ins or a single 
complicated plug-in 
For example, a DSP may be able to hold seven 4-band EQ plug-ins, 

but only one reverb plug-in. 

At least one chip is always dedicated to mixing 
The diagram below shows the minimum allocation for disk I/O and 

mixing in a core Pro Tools system and a core Pro Tools III system. 

The other DSPs are available for any other type of TDM effect that 

you have. 

Core Pro Tools System with TDM Core Pro Tools II System 

Pro Tools Pro Tools III 
Nubus card Be Nubus card 

DSP chips 

Reserved for DAE 

Reserved for DAE 

DSP farm DSP farm 

Mixing Mixing 

Available for: . 

Additional mixing Available for: 

or Additional mixing 

Effects or 

Effects 

Figure 15-8: DSP allocation in the core Pro Tools | and III systems. 

Audio track output assignments affect DSP usage 
The number of different output pairs you use, in addition to the 

number of audio tracks you have assigned to them, affects the 

amount of DSP processing power used for mixing. The table below 

in Figure 15-9 shows the maximum number of output pairs and tracks 

a single DSP chip can hold for mixing. If you go over these limits in 

your audio track assignments, then mixing will spill over into a 
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second, additional DSP chip. Mono audio tracks consist of one TDM 

mixer input; tracks with stereo TDM effects on them take up two 

TDM mixer inputs. Audio voice assignments have no impact on DSP 

allocation. 

Number of output pairs Maximum number of TDM mixer 
used for audio tracks inputs possible on one DSP chip 

1 output pair 24 inputs 

2 output pairs 22 inputs 

3 Output pairs 19 inputs 

4 output pairs 16 inputs 
In this example, two output 
pairs are being used. 5 output pairs 13 inputs 

6 output pairs 10 inputs 

7 Output pairs 8 inputs 

Figure 15-9: The maximum number of output pairs and tracks that a single DSP can support. Mono tracks 
consist of one TDM mixer input; tracks with stereo TDM effects on them take up two TDM mixer inputs. 

Additional considerations 
Here are a few additional things to keep in mind: 

a A single DSP can support up to 28 bands of mono EQ 

a A single DSP can support up to 8 mono dynamics 

plug-ins or 4 stereo plug-ins 

a A single DSP will support a maximum of 2 short, 2 slap, 

and 2 medium mono delays 

m Stereo DSP plugs-ins use twice as much DSP as mono 

plug-ins 

Digital Performer warns Don’t worry about accidentally exceeding your DSP resources. Digital 

you when resources are Performer will warn you if it cannot successfully allocate resources as 

exceeded a result of something that you do, such as add more audio tracks or 

choose a new type of effect. 
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Additional 
mixing 
techniques 

Using soundbite 
velocities to control 
volume 

Creating volume 
changes and crossfades 
with audio volume 
controllers 

The Mixing Board 

In addition to the powerful features in the Mixing Board, Digital 

Performer provides a host of other techniques to handle mixing tasks. 

Volume control in audio tracks is very similarly to the volume control 

of MIDI notes: on-velocities and audio volume continuous 

controllers. The following sections provide an overview of ways to 

edit them, along with references to further information elsewhere in 

this manual and the Performer Reference Manual. 

Soundbites have on-velocities that affect their volume, just like notes. 

The range is from zero to 127. You can edit velocities individually in 

the Event Editing windows, or you can use the Change Velocity 

command in the Region menu to edit a region of them. You can even 

select audio tracks together with MIDI tracks to change the velocity. 

Pop-editing a soundbite 
velocity in the Graphic 
Editing window info bar. 

Keep in mind, however, that velocity only affects the initial volume of 

the soundbite and offers no way to change the soundbite’s volume 

while the soundbite is playing. Digital Performer provides audio 

controller events to give you continuous control of volume and pan, 

as described in the next section. 

Digital Performer provides audio volume continuous controller 

events to create volume and crossfade effects in audio tracks. Audio 

volume controllers can be inserted, generated, drawn, reshaped, and 

otherwise handled just like MIDI volume controllers. Similar to MIDI 

volume controllers, audio controllers have a range from zero to 127. 
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Unlike soundbite velocities, which only affect the initial volume of 

the soundbite, audio volume controllers can affect the soundbite’s 

volume at any time while it is playing. For example, you could use 

audio volume data to create volume changes during a soundbite as 

shown below in Figure 15-10: 

Figure 15-10: Audio volume controllers. This smooth volume curve is shown in 
both the graphic editing window and the event list. 

Inserting audio volume You can insert volume controller events into a track using the 

controllers methods summarized below. If you need more information about 

them, refer to the Performer MIDI sequencing reference manual. 

Inserting an individual audio volume event 
You can insert an individual audio volume event in the event list 

using the insert menu in the title bar. Or you can do so in the Audio 

Graphic Editor as described in the section “Inserting a control point 

to create a sudden change” on page 150. 
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Controlling audio pan 

The Mixing Board 

Drawing volume curves 
You can draw volume curves in the Audio graphic editor as explained 

in “Inserting a line or curve to create a smooth change” on page 151 

and “Reshaping an existing line or curve” on page 153. 

Generating volume curves 
You can generate volume curves using the Create Continuous Data 

command in the Region menu. Be sure to select the region over 

which you'd like to generate the events first. This method gives you 

precise numerical control over the curve. 

Recording volume changes with audio volume faders 
As described earlier in this chapter, you can easily record volume 

changes for audio tracks using the faders in the Mixing Board 

window. Record fader moves in real time or instantaneous snapshots 

using the console. 

Audio pan controllers are similar to audio volume (and MIDI) 

continuous controllers. They can be identified by their name and 

continuous controller icon in the event list. 

An audio pan event 
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Working in stereo 

204 

Audio pan events control the output of the track across its two 

corresponding audio outputs on your audio hardware. Audio outputs 

are grouped in pairs, starting with 1 and 2 as a left/right pair. Each 

pan controller can have a value between -64 and +63, where 0 is 

dead center, -64 is pan left, and 63 is pan right. Pan controllers can 

be used one at a time to make a sudden change, or as an stream of 

events changing gradually to create smooth panning effects, just like 

continuous MIDI controllers. 

You can insert, draw, generate, edit, and otherwise handle pan 

controllers in the same manner as audio volume (and MIDI) 

controllers. See “Inserting audio volume controllers” on page 202 for 

a summary of insertion techniques. 

As of this writing, the Digidesign Audio Engine (DAE) does not 

support the recording or playback of interleaved stereo audio files. As 

a result, if you want to record and playback audio in stereo, you must 

do so by recording separate mono audio files into a pair of audio 

tracks as shown below Figure 15-11. Uf you import a stereo audio 

file, you are given the opportunity to de-interleave it into two 

separate mono audio files.) 

The two tracks are 
assigned to the 
same output pair. 

Initial pan events have 
been inserted into the 

tracks: -64 for the left 

track and +63 for the right. 

The tracks are 

panned wide in 
the mixing board. 

lf you are mixing externally, 
/ the outputs for the track pair 

P are routed to a pair on the 
mixing console. 

Figure 15-11: A typical track setup for stereo recording and playback. 
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Volume control for a 
stereo pair 

Future enhancements 

Hints and tips 

Audio volume and pan 
controllers are track- 
specific 

Inserting initial volume 
and pan settings 

Event Chasing 

The Mixing Board 

Most of the time, you will want both channels of a stereo track pair 

to have the same level. One of the easiest ways to handle this is to 

group the two faders in the Mixing Board. This allows you to exactly 

match control changes in both tracks at the same time. 

A somewhat less convenient way to match level settings is to 

generate volume control data in one of the two tracks as described in 

“Inserting audio volume controllers” on page 202 and then copy and 

paste the resulting volume data to the second track in the pair. 

Look for future support of interleaved stereo audio files in DAE, as 

well as feature enhancements in Digital Performer to support stereo. 

The following sections briefly give you suggestions for mixing in 

Digital Performer. 

Audio volume and pan controllers only affect the audio track in 

which they reside. They will not affect audio in other tracks assigned 

to the same audio voice or outputs. If you have multiple tracks 

assigned to the same voice, only one track has playback priority at a 

time, and the priority is determined by the order of the tracks in the 

list. For complete information, see “Overlapping soundbites and track 

priority” on page 63. 

It is useful to insert volume and pan events at the beginning of each 

audio track to initialize their values. This ensures that each time you 

play back the track, it begins with the pan and volume settings that 

you want. If you enable event chasing (described in the next section), 

inserting an initial value gives Digital Performer a level and pan 

setting to which it can always chase. See “Setting initial levels with the 

Mixing Board” on page 187. 

Don’t record over these initial controllers after inserting them. Use 

Overdub record mode to avoid doing so. 

If you always want audio tracks to play at the proper volume and pan 

setting, no matter where you begin playback in the sequence, use 

Event Chasing. 

To enable Event Chasing: 

1. Choose Set Event Chasing from the Basics menu. 

2. Choose the audio volume and/or audio pan options as desired. 

3. Click OK. 
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Chapter 16 Tempo and Digital Audio 

Audio isn’t as flexible as 
MIDI 

How Digital Performer 
handles tempo 

This chapter explains how to handle tempos when working with 

digital audio. 

One of the most flexible things about MIDI is tempo: you can easily 

change the playback tempo of MIDI data by simply dragging Digital 

Performer’s main tempo slider —even drastically so — and the music 

always stays at the same pitch. The notes (and other data) just play 

slower or faster. 

This is not the case with audio data. Digital Performer always plays 

audio at the speed (samples per second) at which it was originally 

recorded. Digital Performer never speeds up or slows down the 

sample rate because, although the tempo would change, the pitch of 

the audio would change, too. To change tempo and maintain the 

same pitch, the audio data needs to be processed by sophisticated 

digital signal processing (DSP) procedures that preserve the original 

pitch at a comparable level of sound quality. This type of processing 

is so intensive that it can only be performed in real time by powerful, 

dedicated hardware. Similar results can be achieved by software, too, 

but not in real time. 

Digital Performer always plays audio at the tempo it was originally 

recorded. If you change the tempo slider in Digital Performer, 

soundbites will start at their original location in the sequence, but 

they will play back at their original tempo. 

Depending on the situation, this may or may not be a problem. Take 

the two-bar drum loop shown below, for example. On top, it is 

shown as a single soundbite. On the bottom, it has been split up into 

a separate soundbite for each beat using the Strip Silence command. 
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A 2-bar drum loop as one soundbite: 

Notice the backbeats on 2 & 4 Bi 

The same loop split into separate beats: 

When we change the tempo from 78 bpm to 96 bpm, the single- 

soundbite loop won't play in tempo because the audio inside it 

doesn’t change tempo. 

The split-up loop, however, changes tempo and sounds fine because 

each beat independently maintains its position relative to Digital 

Performer’s time ruler. 

Backbeats are no longer in time here 

Backbeats stay in time here sm 
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How soundbites are 
affected when you 
change the tempo 

Try to set tempos before 
recording audio 

Get in the habit of 
programming tempos in 
the conductor track 

Aligning the tempo to 
existing audio 

Tempo and Digital Audio 

As you can see from the example in the previous section, short 

soundbites can often survive “after-the-fact” tempo changing, but 

even short ones can sound wrong if the change is fairly large. The 

same is true on both counts for soundbites that have no inherent 

tempo (such as speech). 

You can also see that changing the tempo does not impact the attack 

times of soundbites. If a soundbite occurs at 3|3|240 before you 

change the tempo, it will still occur at 3|3|240 afterwards, too. The 

same is true for the soundbite’s SMPTE time code frame location. 

The earlier example also shows that it is often undesirable to change 

tempo after you have recorded audio. Therefore, you should try to 

determine your tempos before you record any audio and set them 

beforehand. 

As a rule of thumb, it is advisable to program tempos in the 

Conductor track instead of just setting them manually with the tempo 

slider. This permanently stores the tempos in a way that you will 

never loose them. If you use the tempo slider instead, you run the 

risk of changing the tempo slider setting after you’ve recorded audio, 

which throws off the timing between audio and MIDI tracks — timing 

that is very hard to get back. 

Often you may start with digital audio and want to align Digital 

Performer’s tempo with the inherent tempo in the audio. To do so: 

1. Import the audio into Digital Performer and place it in a track. 

For information, see “Importing soundbites, playlists, audio 

files” on page 95. 

2. Open the Graphic Editing window for the track if it isn’t already. 

3. Identify the first downbeat in the audio waveform and align it with 
a downbeat in the time ruler as shown below. 

Zoom in if necessary to get accurate placement. 
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Downbeat in audio waveform aligned 

with a downbeat in the time ruler 

4. If the soundbite begins before the waveform downbeat, drag the 
soundbite’s left edge over to the downbeat. 

5. Adjust Digital Performer’s tempo slider until the other beats in 

the waveform line up with the appropriate beat in the tempo ruler. 

This can’t be done while playing back, but playback isn’t 

necessary. You can drag the slider to get close and then type in 

tempos Cup to a hundredth of a decimal) to fine-tune the 

alignment. 
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Using other programs to 
change the tempo of 
audio 

Tempo and Digital Audio 

6. If the soundbite is long, scroll to a point near the end of it to 

check if the waveform beats line up with the time ruler. 

Use hundredth of a bpm adjustments to fine tune the alignment. 

7. When you are done, program the resulting tempo into the 

Conductor track using the Change Tempo command in the 

Change menu. 

Changing the tempo of audio data without changing its pitch and 

without compromising audio quality requires sophisticated digital 

signal processing (DSP) technology. Several Macintosh programs 

offer this capability, including Digidesign’s Sound Designer II™, 

Steinberg’s Time Bandit™, and others. These programs also allow 

you to change the pitch of audio — and even harmonize it — with or 

without changing tempo. You can use these programs together with 

Digital Performer in cases where you need to change the tempo of 

audio data after it has been recorded. In the case of Sound Designer 

II, you can do so from within Digital Performer using the Edit in 

Waveform Editor command. For information, see “Edit in Waveform 

Editor” on page 174. 
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Chapter 17 Synchronizing Audio to SMPTE 
Time Code 

Preparing Digital 
Performer for SMPTE 
sync 

SMPTE Time Code Source | SMPTE 
(Multitrack) 

SMPTE to MIDI Converter MTC, DTLe, or DTL 
(e.g.MIDITime Piece ll) | 

Digital Performer provides accurate and reliable synchronization to 

SMPTE time code using MIDI Time Code (MTC), Direct Time Lock 

(DTL), or Direct Time Lock Enhanced (DTLe). The section below 

explains how to set things up, followed by a discussion of the Audio 

Sync to Time Code command in the Audio menu, which plays an 

important role in audio synchronization. 

First, slave Digital Performer to SMPTE time code in the usual fashion 

as described in the Receive Sync chapter of the Performer Sequencing 

reference manual. In review, the basic steps are: 

1. Set up a SMPTE-to-MIDI converter (such as the MIDI Time 

Piece Il) to send MTC, DTLe, or DTL to Digital Performer. 

Digital Performer System 

2. Click the SMPTE Start Time button in Digital Performer’s main 

counter to set the start frame for the sequence. 

3. Choose Receive Sync from Digital Performer’s Basics menu and 

choose the “MTC, DTL, or DTLe” option. 

4. Check the “Slave to External Sync” command in the Basics 

menu. 

5. Check or uncheck the “Audio Sync to Time Code” option in the 

Audio menu as desired. 

If this option is grayed out, go to the Basics menu and check 

“Slave to External Sync”. See the next section for an explanation 

of this option. 
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Software sync versus 
hardware sync 

Software sync 

The Audio Sync to Time 
Code command 

Best possible 
synchronization 

Highest possible audio 
quality 

214 

Digital Performer is now ready to record and playback while slaved 

to incoming time code. Just start the time code and Digital Performer 

will chase. 

There are two approaches to synchronizing MIDI and audio to 

external SMPTE time code: software sync and hardware sync. 

Software sync provides continuous, accurate, high-quality synchroni- 

zation without additional hardware. Hardware sync involves an extra 

piece of fairly costly gear, but it produces the highest possible quality 

and the tightest possible lockup. With products like Mark of the 

Unicorn’s Digital Time Piece™ audio synchronizer, the cost of these 

audio sync devices is now well within the reach of most of us. 

The sections below discuss software synchronization in Digital 

Performer without extra digital audio synchronization hardware. 

Hardware sync is discussed in “Hardware sync: the best of both 

worlds” on page 215. 

The Audio Sync to Time Code command in the Audio menu lets you 

turn Digital Performer’s software synchronization on and off. Digital 

Performer’s software sync lets you choose between two trade-offs: 

=» Best possible synchronization 

versus 

mw Highest possible audio quality 

These two scenarios are discussed below. 

When Audio Sync to Time Code is checked and Digital Performer is 

slaved to SMPTE time code, Digital Performer (DAE) performs an 

advanced form of real-time sample rate conversion on the audio data 

to either slow it down or speed it up as necessary to keep audio in 

syne with SMPTE. This continuous form of synchronization is very 

tight, but it does affect the audio samples occasionally. How much 

depends on how stable the time code is. Under normal circumstances 

you won't hear any artifacts in the digital audio, thanks to DAE’s 

advanced DSP algorithms, which provide one of the best solutions for 

audio sync short of the expensive word clock converters discussed in 

the next section. 

When Audio Sync to Time Code is unchecked, audio may not play 

precisely in time with MIDI, and sometimes you may hear them drift 

apart. The advantage, however, is that no signal processing occurs, so 

the audio data remains completely pristine—exactly as recorded. 
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Recommendations 

Hardware sync: 
the best of both 
worlds 

Under most circumstances, you can leave Audio Sync to Time Code 

checked without any noticeable effect on your audio. This is 

especially desirable for long soundbites, which otherwise drift 

noticeably. 

You can uncheck Audio Sync to Time Code in some situations, such 

as when precise timing is not critical (e.g. triggering ambient sounds). 

Or you may be working with short soundbites (several measures or 

less) that won’t noticeably drift. You can also try recording with 

Audio Syne unchecked and then play back with it checked, which 

reduces the effects of continuous resyncing. 

Several Digidesign audio cards provide a third scenario for locking 

audio to SMPTE time code: these systems can slave to word clock, a 

form of digital audio synchronization that provides sample-accurate 

resolution. These systems offer the best solution for synchronization 

because they lock digital audio to SMPTE without affecting the digital 

audio samples with real-time sample rate conversion. Instead, they 

adjust the overall sample rate using a continuous calibration scheme. 

These systems never modify the actual audio samples, while at the 

same time providing continuous re-sync. 

In this scenario, synchronization is handled as shown below. The 

master clock source drives both audio and MIDI independently, and 

audio and MIDI stay in sync because they are locked to the same 

timing source. Digital Performer does not control the timing of audio 

in this case, and the Audio Sync to Time Code command should be 

turned off (unchecked). 

Master Clock (SMPTE) 

Audio Clock MIDI Clock 

A few examples of systems that have word clock synchronization 

capabilities are Digidesign’s Sound Tools II™, Pro Tools™, and Pro 

Tools III™ systems. 
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Syncing to blackburst If you are working with video, you need an additional hardware 

device that converts video blackburst (a master video timing source )— 

—referred to as house sync—into word clock. The word clock is then 

passed onto the digital audio hardware. 

Digidesign’s Pro Tools Video Slave Driver™, TimeLine’s MicroLynx™ 

(with the word clock option), and Mark of the Unicorn’s soon to be 

released Digital Time Piece™ are examples of such a converter. 

Below is an example of how a system like this is configured with Pro 

Tools: 

House Sync Generator 
(video blackburst) 

alee) 

Video Tape Deck 
(with SMPTE time code on tape) 

SMPTE time code 

SMPTE-to-MIDI converter 

MIDI Time Code 

(MTC, DTL or DTLe) 

Converter 

Black Burst to Word Clock 

(e.g. Video Slave Driver™) 

Word Clock 

Pro Tools Audio Interface 

Digital Performer System 

Audio Sync To 
Time Code 

Unchecked 

Digital Audio 
(Pro Tools card) 

Figure 17-1: Slaving digital audio hardware to video house sync via word clock. 
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Syncing toa SMPTE If you use SMPTE time code as a master sync source (such as LTC 

time code source recorded on a multi-track) instead of video black burst, you can use 

a device that converts SMPTE time code into word clock, such as the 

TimeLine MicroLynx, Digidesign’s SMPTE Slave Driver™, or Mark of 

the Unicorn’s Digital Time Piece™. 

SMPTE Time Code Source 

(Multitrack) 

SMPTE time code (LTC) 

SMPTE Slave Driver™ 

SMPTE SMPTE 
to to 

MIDI Word Clock 

converter converter 

a Word Clock 

Pro Tools Audio Interface 

= MIDI Time Code 

Digital Performer System 

Audio Sync To 

Time Code Digital Audio 
Unchecked (Pro Tools card) 

Figure 17-2: Slaving digital audio hardware to SMPTE via word clock. 
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Summary 
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Here is a summary of the information in this chapter regarding Audio 

Sync to Time Code: 

Situation: What happens: 

Digital Performer is not MIDI always stays perfectly in time with audio. 

synced to SMPTE Audio Sync to Time Code command is grayed 

(“Slave to external sync” _—_— out to indicate that it is not needed and is not 

in the Basics menu is being used. No sample-rate conversion or 

unchecked). other DSP is applied to digital audio; 100% 

pristine audio quality is achieved. 

Digital Performer is Audio slaves to Digital Performer’s clock. Some 

slaved to SMPTE time DSP sample-rate conversion occurs in the 

code with the Audio Sync audio during recording and playback to main- 

to Time Code command _ tain tight synchronization with MIDI, but it is 

checked. not noticeable under normal synchronization 

conditions. 

Digital audio hardware Audio Sync to Time Code command is turned 

and Digital Performer are off (unchecked). Everything is slaved to a mas- 

separately slaved to a ter clock source, either video black burst or 

master clock source SMPTE time code. Synchronization with digital 

(video black burst or audio is maintained by a word clock converter 

SMPTE). Audio hardware that employs a continuous calibration scheme 

is slaved via a word clock instead of sample rate conversion. Highest 

converter. audio quality and tightest synchronization are 

both achieved. 
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Chapteris The Mix Command 

The Mix command in the Audio menu allows you to merge the audio 

of one or more soundbites, along with any volume data, to a single 

soundbite that is the sum of all the sound and controller data within 

a region that you select. 

The Mix command can be used to simulate an analog multitrack 

technique called ping-ponging or bouncing to free an audio voice for 

playing or recording more digital audio data. 

It can also be used to create a soundbite into which volume control 

is built from a soundbite which has its volume controlled by volume 

events. For example, this technique can be used for creating 

soundbites that fade in or out. 

To Mix soundbites: 

1. Select a region containing soundbites just as you would select a 

region of MIDI data from one or more tracks. 

You can select the region from an Event List, the Graphic Editing 

window, or the Tracks window. You can even select a region in 

the middle of a long soundbite; Digital Performer will 

automatically perform a split command if necessary to mix a 

portion of a soundbite. 

2. Choose Mix from the Audio menu. 

The Mix dialog box appears. 
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3. Select a option as desired. 

See the following sections for details. 

4. Click OK. 

After okaying the dialog, a standard save dialog appears 

allowing you to name the mix soundbite and save it into a 

desired folder. 

©) Audio Files ¥ 

|) dir? ree 

Name the mix soundfile 

5. After okaying the save dialog, a mix progress window appears 

for every soundbite in the selected region. 

The mix can be cancelled at anytime by clicking the Cancel 

button or typing command-period. 

Mixing ‘Dirt Gruve' 

6. A new audio track is added to the tracks list, and the newly 
created soundbite is placed in the new track at the same time 

location as the original mixed data. 

If the “Replace original” option is unchecked or grayed, the 

audio data in the original tracks is left untouched. If this option 

is checked, the original data is removed. 

220 The Mix Command 



Undoing an out-of-range 
mix 

The Mix Command 

7. After the mix is completed, the “scanning sound file” progress 

window appears as Digital Performer scans each new mix 

soundbite so that it can display its waveform in the Graphic 

Editing window. 

Cancelling this window does not affect the mix; doing so causes 

the resulting soundbite to be displayed without its waveform in 

the Graphic Editing window. 

Scanning sound file ‘Mix.1'. Click Cancel or press 

command-period (.) to cancel. 

Cancel 

Since all the sound data from the selected region is added together 

when it is mixed, occasionally the resulting soundbite will contain 

some sound data whose gain is greater than the maximum allowed 

by the resolution of the digital recording hardware. Such soundbites 

contain clipping and may sound distorted. The Mix command warns 

you when this occurs. 

There were 20 samples out of range. You 

may want to "Undo Mix," lower soundbite 

volumes, and try again. 

You can Undo the Mix and lower the volumes of the soundbites to be 

mixed. Or you can use the Normalize option to automatically scale 

the sound data of the newly created soundbite. 

See the following sections for information about the Normalize 

option. 

When undoing the Mix command, any newly created soundbites will 

be removed from tracks that they occupy, but they will remain in the 

Soundbites window for easy deletion from the hard disk. 
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The results 

The Replace Original 
option 

The Normalize option 
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The Mix command creates a new track with a single new soundfile 

into which all the sound data from the selected region is mixed. The 

Mix command disregards any pan data that is in the selected region. 

However, volume data and soundbite velocities are taken into 

account. 

If the region you select to mix is within a single track, the Replace 

Original option is available. 

Check this box if you want the new mixed soundbite to replace the 

original soundbite(s) and volume events in the selected region. 

The Normalize option causes the resulting mixed soundbite to be 

normalized: the peak of the resulting audio data is scaled to 

maximum gain (with no clipping) and all the rest of the audio data is 

scaled proportionally. 
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Chapter 19 AUCIio Preferences 

Timer type 

Audio options 

There are two audio-related options in the Preferences dialog box, 

which can be opened by choosing Preferences from the File menu. 

Digital Performer has the ability to run simultaneously with other 

audio applications, such as Digidesign’s Pro Tools™ and OSC’s 

DECK II™. On most Macintosh models, you can improve Digital 

Performer’s timing performance by choosing the Audio Tolerant 

Timer option (as shown above). This option is only available when 

Digital Performer is mot using DAE; when Digital Performer is using 

DAE, it will gray out. If you are not running other audio applications, 

use the Normal Timer option. For more information, see “If timing 

problems arise when running with another audio application” on 

page 230. 

The Bring up alert whenever the DAE track limit is exceeded option 

causes Digital Performer to present you with a dialog box whenever 

the current DAE track limit is exceeded. This is a helpful reminder, 

because Digital Performer has to un-play-enable existing tracks in 

order to comply with your last requested action (usually adding 

tracks). Without this reminder, track may become muted without your 

being aware of it. If you are well aware of your current track limits, 

and you do not need this reminder, you can disable it by unchecking 

this preference. 

For more information about rack limits, see “Managing voice and 

track limits” on page 62. 
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Chapter 20 AUCIO Tr oubleshooting 

Isolate the problem 

Simplify your setup 

Check version numbers 
of everything 

Remember that Digital Performer’s audio capability is based on the 

Digidesign Audio Engine and the recording hardware in your system. 

Consider the nature of the problem to determine if it may have to do 

with DAE or your hardware. For example, if the problem is that you 

cannot hear anything when you try to play back soundfiles from 

within Digital Performer, quit Digital Performer and try playing back 

the audio file in Sound Designer II. This approach will help you 

isolate and solve the problem quickly. 

One of the most common causes of problems is a conflict with other 

software in the System. You can often solve problems quickly by 

starting up the computer with a “generic” System. A generic system 

consists of: 

m A fresh System Folder installed from Apple installer disks 

that are appropriate for your model of the Macintosh 

=m No additional system extensions or control panels except 

for those necessary to run Digital Performer (such as 

FreeMIDI, DAE, A/ROSE, the DigiSystem INIT, etc.) 

Digital Performer, as well as DAE and other Digidesign-related system 

extensions, are continually being updated. In addition, chances are 

that you are running more than one DAE-dependent program on 

your system. If you experience problems with Digital Performer, 

check the Read Me notes that ship with the current version you are 

using to find out the required versions of DAE, etc. Always avoid 

running earlier versions than those recommended. 

@ Digital Performer 1.6 ships with DAE version 1.32. 
Digital Performer may not work properly with 

higher versions of DAE. If you have a higher version 

of DAE and are experiencing problems, try going 

back to DAE version 1.32. 
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lf Digital Performer can’t 
find the card 

If you record and get 
nothing 

If you don’t hear sound 

If you see an error 
message after playback 
or recording 

226 

If you launch Digital Performer and see a warning box that says that 

there is no audio hardware, when actually there is, quit Digital 

Performer, shut down your computer, and make sure that the audio 

recording card is seated properly in its slot. Make sure you have the 

correct version of the DigiSystem INIT in the Extensions Folder and 

the DAE in the DAE Folder in you System Folder. For expansion 

chassis owners, make sure that the chassis and cable are properly 

seated and connected. 

If you record but don’t get anything, the track you are recording on 

may be set to the wrong channel. Set it to another channel and try 

again. 

If you don’t hear sound, check the following things: 

= Make sure the volume is turned up on the audio units. 

m Make sure you have cables connected to the correct 

plugs on inputs and outputs for the audio recording 

hardware 

m Try setting the volume in the Mixing Board. See the 

Mixing Board chapter for details. 

a If you don’t hear sound while recording, make sure the 

patch thru button is on in the Audio Monitor title bar. 

If you still don’t hear sound, and you have Sound Designer II (2.5 or 

higher), quit Digital Performer and try playing back from Sound 

Designer II. If it plays back and Digital Performer doesn’t, and you 

double-checked the things in the above list, call the technical support 

department at (617) 576-3066. 

Digital Performer keeps close track of whether or not it had any 

trouble processing the audio data during the last record or playback 

pass. If conditions prevent Digital Performer from successfully 

handling all of the digital audio information, it presents an error 

message letting you know how many errors occurred. These errors 

can be due to conditions such as these: 

m= Highly fragmented soundfiles on the hard disk 

a A hard disk with an access time that is too slow (check 

with Digidesign for compatibility) 
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Adjusting DAE’s buffer 
size to avoid playback 
error messages 

If audio doesn't sync 
with MIDI 

Audio Troubleshooting 

mw AppleTalk (This is a major cause of problems! AppleTalk 

must be disabled when you are working with digital 
audio.) 

mw Other background software interruptions (such as FAX 

modem software, etc.) 

a Other third party software 

If you get such an error message, try removing all third party software 

from the System folder and turn off AppleTalk in the Chooser in the 

Apple menu. If this doesn’t work, optimize the hard disk with defrag- 

mentation software. You can also try adjusting the buffer size of DAE 

as described below. 

The Configure Buffer Size command in Digital Performer’s Audio 

menu allows you to change the DAE's playback buffer size. 

According to Digidesign, the buffer size is factory-set to ‘1’ and 

should not require adjustment on most systems. This command is 

only for non-System Accelerator systems. If you experience 

unwanted audio artifacts such as skipping or clicks, or if the “disk too 

slow or fragmented” dialog appears, set the buffer size to the next 

higher value. Verify that your disk is not heavily fragmented before 

adjusting the buffer setting. If the drive is fragmented, use an 

optimization program, such as Norton's Speed Disk, to de-fragment 

the disk. It should not be necessary to go beyond ‘2’. 

If you do decide to reconfigure the DAE's buffer size in this dialog 

box, Digital Performer must quit and relaunch the DAE to affect the 

change. If other applications besides Digital Performer are using the 

DAE, Digital Performer will not be able to quit the DAE and, as a 

result, will not be able to reconfigure the buffers. An alert appears 

when this happens to warn you that this is the case. 

See the discussion of tempo “Tempo and Digital Audio” on page 207. 

You can’t successfully change the metronome setting of a sequence 

after you have already recorded audio and sequenced MIDI to it. The 

audio data does not change tempo. 

If you haven’t changed the tempo, and things aren’t lining up, try 

thinning as much MIDI and audio controller (volume and pan) data 

as possible. Also try turning off AppleTalk in the Chooser in the 

Apple menu, which can interfere with MIDI data transmission. 
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If you get an error DAE error -9073 can appear when you pop up a soundbite for 

message while scrubbing and begin scrubbing quickly by immediately command- 

scrubbing audio dragging the cursor. To avoid this error, wait a moment before 

command-dragging left or right. 

If you experience a crash) When Digital Performer begins recording or playback, it allocates a 

or other interruption large amount of the free space on your audio hard disk to the current 

while playing or take file(s) in the Audio Monitor. If audio recording (or playback with 

recording at least one track record-enabled) is ever interrupted at this point due 

to a power failure or system error, this free space will remain 

allocated to the interrupted takefiles. When this happens, The next 

time Digital Performer is launched, it displays the Rescued Takefiles 

dialog as shown below. 

31 KB PowerPC :Trash: 

This dialog shows partially recorded takefiles and allows you to 

recover or delete these files. You can click the takefile to audition it 
and determine whether there is useful audio data in it. In most cases, 

you should choose to delete the file(s). If you believe that important 

audio data exists in the file(s), use the Recover button to move the file 

into the Trash. You can then drag the file out of the Trash (double- 

click the Trash can to open it) and then use Sound Designer II to 

extract the important audio data from the file. You should choose to 

either recover or delete these file(s). Otherwise, they will needlessly 

take up precious hard disk space. 
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If you suddenly have 
very little hard disk 
space free 

lf Digital Performer 
crashes ona Mac IIfx, 
Quadra 900 or 950 

If the screen redisplay 
gets jerky 

If you run out of disk 
space 

If you experience 
problems recording into 
tracks with loops 

If you get error 
messages while editing 
audio during playback 

If you experience 
problems when playing 
back 

Audio Troubleshooting 

@ Before auditioning soundbites in this window, turn 

down the volume of your sound system or 

headphones, as the results can sometimes be 

random noise at full volume (O dB). 

See the previous section regarding the rescue of takefiles after a crash 

or other interruption during playback and recording. 

Open the Serial Switch Control Panel in the Apple menu and set it to 

Compatible. Then restart the computer before running Digital 

Performer again. 

During playback, Digital Performer does its best to update items on 

the Macintosh screen, such as the Counter and scrolling windows. 

However, audio recording and playback places a high demand on the 

computing power of the machine, and Digital Performer makes 

playback a higher priority than refreshing the screen display. 

Therefore, you may find at times that the counter will stop and start 

during playback or recording. This effect is minimized on faster 

computers such as Quadras and Power PC Macintoshes. 

If you run out of hard disk space, compact existing soundfiles and 

delete unused soundfiles. For details, read the Soundfile Management 

chapter. 

Recording audio into tracks containing loops does not work well. We 

recommend only inserting loops into audio tracks after recording is 

completed. This problem will be addressed in a future version of 

Digital Performer. 

Making any type of edit to audio data during playback can sometimes 

result in an error message appearing after stopping the transport. This 

includes such actions as inserting/deleting soundbites and Cutting, 

Copying, Splitting, and Trimming soundbites. The frequency of these 

error messages appearing after such edits depends upon the location 

and type of the edit. These error messages generally state that a 

soundbite could not be “queued for playback”. These messages can 

be ignored. This problem will be addressed in a future version of 

Digital Performer. 

Are you playing back a playlist that was created in Sound Designer II? 

If you load a playlist that was created in Sound Designer II, and the 

playlist has crossfades (to smooth out the transitions between 

soundbites in the playlist), the crossfades do not get loaded into 
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Digital Performer—only the soundbites get loaded. Thus, you may 

hear brief gaps or other glitches when playing the playlist in Digital 

Performer due to the missing crossfades. 

There have been unconfirmed reports of problems with partitioned 

hard drives. Drives that have partitions may cause playback glitching. 

If you are experiencing playback glitching, try removing the 

partitions from your hard drive. 

Apple’s MIDI Manager can cause serious audio playback problems. If 

you have MIDI Manager in your system, remove it completely. 

(Remove both the “Apple MIDI Driver” icon and the “MIDI Manager” 

icon.) 

If Digital Performer freezes during playback, and you have a 

CD-ROM drive attached to your computer, the problem is most likely 

caused by the fact that the CD-ROM drive does not have a disc in it. 

Either remove it from the chain, or place a cartridge in it. 

If timing problems arise You can run (and synchronize) Digital Performer simultaneously with 

when running with another audio application such as Digidesign’s Pro Tools™ or OSC’s 

another audio DECK II™ by running Digital Performer without DAE (as a MIDI only 

application application). There are two different ways of doing so. 

a Drag DAE out of your System Folder, launch Digital 

Performer (which will run MIDI only), put DAE back, 

and, finally, launch the other audio program, which will 

log into DAE. 

=» (This method works for Pro Tools only.) Launch Pro 

Tools, turn on the Active in Background command in the 

Options menu, and then launch Digital Performer, which 

will run as a MIDI only application because Pro Tools is 

already logged into DAE. 

If you experience timing problems in Digital Performer when running 

audio simultaneously (in real time) in another audio application, the 

Audio Tolerant Timer option in the Preferences dialog box (in the File 

menu) modifies Digital Performer’s timer to enhance timing when 

another application is using up large amounts of CPU bandwidth for 

digital audio. Try enabling this option, but please note that it may not 

work on some Macintosh models. If you are not running other audio 

applications, use the Normal Timer option. For more information, see 

chapter 19, “Audio Preferences” (page 223). 

230 Audio Troubleshooting 



If audio data is garbled 
upon recording 

If you have a Jambox 

Contacting Mark of the 
Unicorn for technical 
support 

Audio Troubleshooting 

If audio data is garbled when it is recorded in Digital Performer, and 

you have a CD-ROM drive attached to your computer, the problem is 

most likely caused by the fact that the CD-ROM drive does not have 

a disc in it. Either place a disc in the drive, or remove the drive 

completely from the chain. 

The Jambox DA must be setup as follows to sync Digital Performer to 

SMPTE with it: Setup Parameters window should be set with “use 

Cable 4 in/out for MTC.” However, there is no need for an actual 

physical connection required on cable 4. 

The Sync Window Time Reference should be set to “SMPTE” and the 

Tempo Source should be set to “MAC*. 

We hope that you enjoy using Digital Performer. We look forward to 

hearing from you about your experiences. We are always reviewing 

and prioritizing feedback from all our users. 

Meanwhile, if you have questions, our technical support line is open 

between 9 am and 8 pm Eastern time, Monday through Friday, at 

(617)-576-30060. 

You can also reach the technical support department at our dedicated 

technical support fax number: (617) 354-3068, AppleLink at 
UNICORN, CompuServe E-mail at 71333,3006, or America On Line 

(AOL) at “MOTUTEC”. 

You can send e-mail via the Internet to either the AppleLink, 

CompuServe, or AOL addresses with the following addressing: 

CompuServe: 71333.3666@compuserve.com 

AppleLink: unicorn@applelink.apple.com 

AOL: MotUTEC@aol.com 
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A/ROSE 225 
Add audio track 60 
Add Soundbite 94, 95 
AOL address 231 
AppleLink address 231 
AppleTalk 227 
Attach MIDI Controller command 178, 192 
Audible Mode 

Event List window 117 
Soundbites window 100 
speaker icon 117 

Audio 
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track assignment 61 

checking input level 74 
menu 

Duplicate 173-174 

Edit in Waveform editor 174 

Reload 168-172 
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Split 164 
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Trim 164 
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Monitor 85-91 
MultiRecord 79 
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Patch Thru 91 
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synchronizing with MIDI 227 
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track 
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Event List window 117-123 

Graphic Editing 125-155 
playback 59-70 

tracks 
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volume 201 
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italicized 65 

Index 

Audio data 
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disk space requirements 12 
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how it is recorded 83 
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importing 95 
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quick reference 126 
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setting up for recording 73 
Take Folder 86 
Takefiles 85 
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Audio Sync to Time Code command 214 
Audio Tolerant Timer option 223, 230 
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adding 72 
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muting & unmuting 70 
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record channel 74 
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Automated mixing 186, 189 
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volume and pan data 128 
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Audio menu 173-174 
Duration 

soundbites 93 
Dynamics 
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Edge Edit Copy command 129 
Edit Filter 159 
Edit Group command 178, 191 

Rename Group sub-menu command 192 
Edit in Waveform Editor 107, 174 
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Editing 
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soundbites 161-174 

Effects window 194 
applying effects 194 
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MIDI processing 19 
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opening existing 196 
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TDM processing 197 

EQ 194 
Error messages 

audio playback/recording 226 
Errors 

recording audio 83 
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audio tracks 205 
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Soundbites 69 
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Event List window 

Audible Mode 117 
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Goto 118 
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Legend 119 

Index 
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mini-menu command 129 
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View Filter 118 
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F 
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recording 189 
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Filters 
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Frame Rate command 24 
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Graphic Editing 
mini-menu item 119 
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introduction to 17 
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mini-menu 129 
Set Pointer Coordinates 129 
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View Filter 129 
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faders and knobs 191 
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Hard disk 

access time 83, 226 
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deleting soundfiles 111 
fragmentation 83, 226 
managing soundfiles 109 
recommendations 50 
recording explained 47 
requirements 50 
running out of space 229 
size of files on disk 50 

Headroom 90 

/ 
Importing 

audio (Soundbites) 95-97 
playlists 96 
soundfile 97 

Input level (audio) 74 
Inputs (IN) 85 
Insert 

Event List window 117, 118 
Graphic Editing 127 

Insert (1) button 127 
Inserts 182 

choosing an effect 196 
opening the current effect 196 

Internet address 231 

J 
Jambox 231 
JL Cooper FaderMaster 192 
Jupiter Systems 

MDT 19 

Legend 
Events List window 119 

Level meters 67, 85 
adjusting range 89 
audio playback 68 
changing their range 75 
Mixing Board window 185 
monitor input on TDM systems 186 
setting input level 90 

Line tool 152 
Load 

Soundbites 97 
Load Board Layout command 178 
Loop recording 82 
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graphic editing of 149 
inserting graphically 155 
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Mark of the Unicorn 

technical support 231 
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Graphic Editing window 127 
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Mic input (AudioMedia) 

enabling 91 
MicroLynx 216 
MicroLynx™ 216 
MIDI processing 19, 194 
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generating from Performer 24 

Min Time and Value Change command 179 
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Mini-menu 

Audio Monitor 90 
Soundbites window 95 

Mini-menus 
Audio Monitor 86 
Event List 118 
Graphic Editing 129 
Movie Window 29 
Soundbites window 94 
Tracks window 

Add audio track 60 
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Agreement and Limited Carefully read all the terms and conditions of this agreement before using this software package. Using this software package indicates 

Warranty your acceptance of the terms and conditions of this license agreement. 

Mark of the Unicorn, Inc. (‘MOTU”) owns both this program and its documentation. Both the program and the documentation are 
protected under applicable copyright laws. Your right to use the program and the documentation are limited to the terms and conditions 
described herein. 

License 
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arrangement without the prior written consent of MOTU; (d) translate or otherwise alter the program or related documentation without the 
prior written consent of MOTU. 

Term 
Your license to use the program and documentation will automatically terminate if you fail to comply with the terms of this Agreement. If 
this license is terminated you agree to destroy all copies of the program and documentation. 

Limited Warranty 
MOTU warrants to the original licensee that the disk(s) on which the program is recorded be free from defects in materials and 
workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of your receipt. If failure 
of the disk has resulted from accident, abuse or misapplication of the product, then MOTU shall have no responsibility to replace the disk(s) 
under this Limited Warranty. 

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF, AND YOU HEREBY WAIVE, ANY AND ALL OTHER 
WARRANTIES, BOTH EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE. THE LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL 
BE LIMITED TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO EVENT SHALL MOTU BE LIABLE FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS 
OF DATA OR DATA BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD PARTIES EVEN IF MOTU HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS WHICH 
MAY VARY FROM STATE TO STATE. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

Update Policy 
In order to be eligible to obtain updates of the program, you must complete and return the attached Mark of the Unicom Purchaser 
Registration Card to MOTU. 

General 
This License Agreement shall be governed by the laws of the Commonwealth of Massachusetts and shall innure to the benefit of MOTU, 
its successors, administrators, heirs and assigns. 

Copyright Notice 
Copyright ©1994, 1993, 1992, 1991, 1990, 1989, 1988, 1987, 1986, 1985 Mark of the Unicorn, Inc. and its licensors. All rights reserved. 
No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or 
computer language, in any form or by any means whatsoever, without express written permission of Mark of the Unicorn, Inc., 1280 
Massachusetts Avenue, Cambridge, MA, 02138, U.S.A 

The Macintosh operating system portions are copyrighted programs of Apple Computer, Inc., licensed to Mark of the Unicorn, Inc., to 
distribute for use only in combination with Performer. Apple Software shall not be copied onto another diskette (except for archive 
purposes) or into memory unless as part of the execution of Performer. When Performer has completed execution, Apple Software shall 
not be used by any other program. 

Performer, Digital Performer, Professional Composer, Composer's Mosaic, Unisyn, MIDI Time Piece, MIDI Time Piece II, Video Time 
Piece, Video Distribution Amplifier, MIDI Mixer 7s, MIDI Express, MIDI Express PC and Mark of the Unicom are trademarks of Mark of the 
Unicorn, Inc. 

Macintosh™ is a trademark licensed to Apple Computer, Inc. Apple ® The Finder ™, MultiFinder™, and PatchBay™ are trademarks of 
Apple Computer, Inc. 

MacProteus™, SampleCell™, Pro Tools™, Audiomedia™, Audiomedia II™, Sound Accelerator™, Sound Accelerator II™, and Sound 
Designer II" are trademarks of Digidesign, Inc. * 1360 Willow Road, Suite 101, Menlo Park, CA 94025. 
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Chapter1 About Performer 

Performer™ 

Mail in the Registration 
Card 

Performer is a powerful MIDI sequencer designed for the music 

professional. It provides a comprehensive MIDI recording, playback, 

and editing environment for a large variety of applications. Its speed, 

accuracy and flexibility make it the sequencer of choice for working 

musicians the world over. 

Take a moment now to fill in and mail the registration card found at 

the very beginning of this manual. Doing so entitles you to: 

a A free backup master disk 

mw Free, unlimited technical support 

m= Free newsletters and software updates 

» Announcements about major software upgrades and new 

products 

Leave the rest of the cardboard page in the manual for your future 

reference. Since Mark of the Unicorn can provide customer service 

only to registered users, please be sure to send the card in 

immediately after purchase. 

To use Performer, you must have a Macintosh computer, a MIDI 

interface and a MIDI instrument (most probably a synthesizer). This 

is the minimal setup you will need, although Performer can support 

any configuration of MIDI instruments, including NuBus devices such 

as the MacProteus™, SampleCell™, and SampleCell II™. Performer 

works well with all MIDI instruments and is capable of handling the 

most complex MIDI situations. It is compatible with any 

MIDI-equipped device, such as synthesizers, drum machines, 

hardware sequencers, synchronization devices and more. 

A MIDI sequencer is like a cross between a tape recorder and a 

player piano: the physical actions you make when playing the 

keyboard or other MIDI controller instruments are stored not as audio 

signals (as your tape machine would record) but as numerical 
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information that represents music (pitches, attacks, releases, pitch 

bends and more). The nuances in your musical performance are 

analyzed and its components encoded and stored. When played 

back, the synthesizer recreates your original performance. In this 

way, the recorded sequence is more like a player piano roll, telling 

the instrument exactly how to play itself. One nice thing about MIDI 

is that you can use any compatible instrument for playback. You can 

also edit the individual elements of your sequence, such as a single 

bad note in an otherwise flawless performance. MIDI sequencing 

provides you with a way to manipulate virtually any parameter of a 

musical performance. 

Performer is loaded with features, structured in a layered fashion 

such that you can use the ones you want and not worry about the 

others. This is helpful for those of you who are new to the program, 

as well as experienced users who need functional power without 

unnecessary complexity. The rest of this chapter provides a brief 

description of some of Performer’s salient features. 

The basic recording and playback functions are very straightforward, 

modeled after tape deck functions. They are located in Performer’s 

main control panel: 

Music recorded with Performer is played back exactly as entered: the 

resolution of 480 ticks per quarter note assures accuracy. As many 

tracks as you need for recording and playback are available to you. 

Several tracks can be recorded onto simultaneously from multiple 

MIDI channels. Both the modem and printer ports can be used simul- 

taneously for input and output of data as well as timing information. 

Performer’s Patch Thru utility allows you to either echo incoming 

data directly or channelize it. Any track can be assigned to play back 

from one or more of sixteen channels on either port, giving you 32 

separate channels for playback. If you have a multi-port interface 
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such as the MIDI Time Piece II or MIDI Express, Performer provides 

as many channels as the interface allows (128 or 96, respectively). 

Since many of Performer’s operations can be done while the 

sequence is playing back or recording, you don’t have to stop the 

music to get things done. 

A flexible step-recording mode precisely enters passages too fast or 

complex to be recorded in real time, plus there are several auto- 

locator features such as punch-in/out and auto stop/rewind to make 

real-time recording easier. 

Once you’ve recorded, there is a great deal of editing power at your 

fingertips — you can change anything in your sequence, from a 

single event to a whole region of data. Single events or entire regions 

of data can be edited or inserted anywhere in the sequence. The 

basic cut and paste operations and the region editing commands 

allow you to edit and create data: you can transpose whole sections, 

change controller values smoothly, create new pitch bend data, 

control velocity to create dynamic effects, create echo effects and 

more, each in only a few steps. State-of-the-art quantizing features 

such as Humanize and Groove Quantize help you perfect the 

rhythmic nuance in your sequences. 

To access the data that makes up your sequence, Performer offers 

three powerful event-editing environments on top of standard Event 

List window editing: the Graphic Editing window, the Notation 

Editing window, and the QuickScribe Notation window. All windows 

support single-event and region editing as described above, and 

every track in your sequence can be viewed and edited in either 

window at any time. 

The Graphic Editing window plots the elements of your sequence on 

a scrolling, piano-roll graph that makes melodies, chords, dynamics 

and tempo changes easy to recognize and adjust. As in the Event List 

window, you can choose from measure, real, or SMPTE time display, 

and edit any visible event from your Macintosh or MIDI controller. 

Unlike the Event List, however, to edit events or groups of events you 

simply drag them to a new location in time, pitch (or controller 

value), or both. You can even create continuous data by drawing the 

desired curve on screen. 

re 



The QuickScribe Notation Editing window displays as many tracks as 

you want together in one window, formatted on a page exactly as it 

will print. The notation can be edited with all of Performer’s powerful 

editing commands. You can drag notes vertically and horizontally to 

change pitch, location and duration. You can also step-enter notes 

directly in the notation window. 

Performer has extensive synchronization capabilities, including Tap 

tempo. This type of sync allows you not only to control the tempo of 

an existing sequence as it plays back, but to create a tempo map in 

real time before, during, or after recording — all by simply tapping 

the tempo on your MIDI controller. For example, you can tap along 

to a prerecorded acoustic performance, creating a precise tempo map 

complete with accelerandos, ritards, and rubato passages, then sync 

your Performer sequence to the recording. Once you’ve got a tempo 

map, the powerful Scale Tempos command provides you with every 

conceivable way of tweaking your tempo map, including scaling 

tempos to fit time. 

Since its inception, Performer has supported standard MIDI clock 

signals, allowing you to sync to FSK or SMPTE time code. SMPTE 

locations can be referenced and displayed directly on screen, and 

lockup is simple and clean. Performer can serve as an intelligent 

master or slave because it sends and receives Song Position Pointer. 

Coupled with its flexible tempo features, Performer’s synchronization 

capabilities make it the sequencer of choice for musicians working in 

the film/video medium. 

Performer has expanded the art of sequencing with powerful 

Chunking™ and cueing functions. The Chunks window introduces a 

whole new type of sequence: the song. Songs allows you to create 

simple or complex arrangements of multiple Chunks (sequences and 

other songs). Chunks can be graphically arranged in any order, 

vertically and horizontally to quickly build entire songs with other 

sequences and songs. 

Sequences and songs can be automatically chained, cued up, or 

skipped to in real time using the Chain Chunks, Cue Chunks, and 

Skip buttons. These convenient controls come in handy—especially 

during live performance, where you need quick response and 

complete flexibility in choosing the next song. 
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To further enhance Performer’s Chunking capabilities, the Remote 

Controls window allows you to trigger any Performer transport 

function or song select procedure, such as play, pause, stop, etc., 

from your MIDI controller. Now you can control Performer from your 

MIDI instrument—without ever going near your Macintosh! 

Performer’s Create Console feature instantly produces a mixing 

console customized for the track layout in your Tracks window. Use 

knobs and faders to automate your entire mix, including volume and 

panning. Best of all, Performer’s consoles are can be completely 

customized to fit your sequencing needs. You can build a console 

from scratch, adding buttons, knobs, sliders, LCD readouts, and more. 

And you can program them to generate any type of MIDI data, 

including sysex. Other professional mixing console features include 

flexible grouped and master controls, as well as adjustable fader null 

points. 

Performer offers sophisticated rhythmic correction (quantizing) 

features. It is possible to vary the degree of effectiveness of 

quantization, allowing you to preserve the “free” quality of your 

performance while putting the critical notes on the beat. In addition, 

special metric effects such as beat shifting and doubling attacks can 

be done. The powerful Humanize command can produce more 

human feel in a part that may have been over-quantized. In fact, most 

of Performer’s powerful editing commands provide humanization 

options that can loosen up the feel just right. 

Performer takes full advantage of Mark of the Unicorn’s MIDI 

operating system, FreeMIDI. FreeMIDI provides an intuitive, 

convenient, and consistent way for you to interact with the hardware 

in your MIDI studio. Together, Performer and FreeMIDI provide you 

with many benefits, such as intuitive pop-up menus for device 

selection, and the ability to select patches on your synths by name 

from within Performer, as well as other FreeMIDI-compatible 

applications. Perhaps the most important benefit is sound 

management: FreeMIDI provides built-in librarian support for many 

popular synths. FreeMIDI’s PatchList Manager™ program can get a 

bulk dump and automatically display the patch names that are 

currently available in the synth. The patch names appear as a 

convenient pop-up menu directly in Performer, and it all happens 

automatically. 
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For more powerful sound management, Performer provides full 

integration with Mark of the Unicorn’s new, state-of-the-art universal 

editor and librarian software, Unisyn™. Performer can play back in 

the background when you switch into Unisyn to select sounds, edit a 

patch, etc. Also, Unisyn automatically provides up-to-date patch lists 

for FreeMIDI, so that patch names in Performer are always accurate. 

Performer also provides convenient printing capabilities for both list 

windows and music notation. The Print command prints the contents 

of Performer’s list windows, such as the Tracks List, Markers window, 

and Event Lists. The QuickScribe notation window displays any 

combination of tracks as music notation on screen exactly as it will 

print out. Select any region to display, from a single measure to an 

entire piece. QuickScribe is ideal for lead sheets, instrument parts, or 

scores, Which can be printed on any Macintosh-compatible printer. 

If you want to transfer your sequence to a dedicated notation 

program, such as Mark of the Unicorn’s Mosaic® software, simply 

save your work as a standard MIDI file. The process transferring is 

simple and fast. 

Performer can be customized to fit your needs more than ever before. 

In the Tracks window, each track has a bar-graph style meter that 

indicates MIDI activity during playback and recording. Configure the 

meters to display either data density or note velocities. You can drag 

tracks window columns left or right to place them in any order you 

wish. Double-click (or option-click) the column headings to show/ 

hide any column. Even basic features like soloing can be customized 

to fit your exact needs. For example, Partial Solo mode brings muted 

tracks down part way instead of total muting them, so you can focus 

on a certain musical element while still referencing others. 

Version 5, as with its predecessors, is filled with our obsessive 

attention to detail. You'll enjoy features like pop-up menus in title 
bars to quickly switch tracks, a customizable Tracks window, a 

scrolling highlight in tracks overview to indicate the current playback 

location, double-clicking in any time ruler to auto-locate, and more. 

We hope you enjoy using Performer’s state-of-the-art sequencing 

environment! 
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About this manual 

About Performer 

This manual provides a complete explanation for all of Performer’s 

features. For an introduction to Performer, refer to the Getting Started 

booklet that accompanies this manual. 

Each section of this reference manual contains a step-by-step 

procedural description and an in-depth explanation of each aspect of 

Performer’s operation. Each feature description is self-contained, 

enabling you to learn about Performer one piece at a time, at your 

own rate. 

We strongly recommend that you read the section on Performer’s 

user interface thoroughly. The standard Macintosh user interface is 

extended in Performer to provide a more streamlined and functional 

working environment. This knowledge is essential when working 

with Performer: otherwise you may overlook some of the program’s 

features. 

Because Performer has extensive synchronization abilities, we’ve 

marked those sections pertaining to the film and video mediums with 

a film icon. 

Zo 
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Chapter2 On-Line Help 

About the Performer 
Help file 

Performer ™ Help 

Using the Help cursor 

@ 

Performer’s On-Line Help provides you with brief, on-screen 

explanations of each feature in the program. You can get help on any 

item in Performer, including menu items, greyed out (unavailable) 

menu items, mini-menus, windows, and buttons simply by clicking 

the item with Performer’s Help cursor. 

The Help information in Performer is stored separately in a special 

file called the Performer Help file. This file is automatically installed 

in the same folder as Performer, and no further preparation is 

necessary On your part. 

@ The Performer Help file must be present on your hard 

disk in order for you to be able to get help when 

running Performer. If it is not present for some reason, 

you can run the installer on the Performer master disk 

to make a copy of it on your hard disk. 

When you are running Performer, you can get help on anything on 

Performer’s screen with the Help cursor. To turn the arrow cursor into 

Performer’s Help cursor, hold down the command, option, and shift 

keys together. When you release the keys, the cursor will turn back 

into an arrow. 

-% 

To get help on something, just click it with the Help cursor. If it’s a 

menu item, select it from the menu with the Help cursor. When you 

release the mouse button, a help window will appear that briefly 

explains the item. 

To make the help window disappear, click anywhere. 
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What should you click 
on to get help? 

Getting help on menu 
commands and dialog 
boxes 

Loading the Help file 
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All major features in Performer have a help item. Some specific items 

do not and are explained within the description of a corresponding 

feature. If you can’t get help on something, consult the index in this 

manual. 

In general, click directly on the item you wish to get help on. For 

things like buttons, pop-up menus, and text boxes, click directly on 

the button itself rather than its label or associated text. If you don’t get 

a help window the first time, try a few more times, as you might miss 

the “hot spot” the first time. 

@ The basic rule of thumb is: click all over the place with 

the help balloon cursor. You are bound to get a useful 

help balloon eventually, and it doesn’t hurt to click as 

many times as you are inclined to. 

For mini-menus in windows, click anywhere in the title bar of the 

window. 

For general information about menu commands, choose the 

command from the menu with the help cursor. For specific 

information about the menu command, choose it with the arrow 

cursor first to open its dialog box, and then click specific buttons, text 

boxes, pop-up menus, and other items in the dialog box with the 

help balloon cursor. 

If you click with the Help cursor, you may get the dialog box shown 

below: 

Please Locate the Performer™ Help File 

=) Music Folder 

CO My Performer Files 
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The Help menu 

On-Line Help 

This means that the Performer Help file is not in the same folder as 

Performer, and Performer is asking you to locate and open the Help 

File. To do so: 

1. Press the directory pop-up menu to open the folder that you 

installed the Help file in. 

The directory pop-up menu is the button labelled “Music Folder” 

in the picture above. The window below shows the contents of 

the Folder listed on that button. Select the bottom item in the 

menu to work your way back to the top level of your hard disk. If 

you are working with floppy disks, click the Drive button to look 

on another disk. 

2. If you can’t find the Help file or have not installed it yet, click 

Cancel, Quit Performer, and follow the procedure above for 

installing the Help File. 

3. If you can find the Help file, click its name in the list to highlight the 
name and click the Open button. 

Performer will remember the location of the Help file so that you 

won't have to find it each time you click the Help cursor. 

However, in some cases Performer may forget the location, so we 

recommend that you place the Help file icon in the same Folder 

as Performer so that Performer can always find it. 

The Help menu contains two items: About Help and Show Balloons. 

Choosing About Help opens a help window that describes how to use 

the On-line Help feature. You can choose About Help anytime—even 

when the Help file or a Performer file is not currently open. 

Choosing Show Balloons makes the arrow cursor turn into the Help 

cursor without holding down any keys. This is convenient when you 

would like to browse several features. In Show Balloons mode, any 

item that you click on or select from a menu will open a help 

window. 

In Show Balloons mode, you can temporarily turn the cursor back 

into the arrow by holding down the command-option-shift key 

combination. 
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Getting help on greyed 
menu items 

A word to the wise 
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To permanently turn the cursor back into the arrow, choose Hide 

Balloons from the Help menu. 

To toggle the Show/Hide Balloons command from the Macintosh 

extended keyboard, press the Help key. 

Greyed menu items are commands that are not currently available for 

One reason or another. For example, Region menu items are greyed 

unless a region has been selected. If a region is selected, they 

become black. 

To get help on a greyed menu item, simply hold down the command- 

option-shift key combination while selecting the item from the menu. 

The item will not highlight as you select it, but a help window will 

appear anyway. 

Please note that it is not possible to get help on greyed menu items 

when you are running Performer on a Macintosh with a 68000-based 

CPU such as the Macintosh Plus, SE or Classic. 

Help descriptions do not take the place of the Performer manual. 

Unfortunately, there is not enough space to cover all the intricacies of 

every Performer feature in the space of a Help window. Therefore, we 

strongly recommend that you refer to your Performer manual and 

update documentation for a complete explanation of features that you 

would like to learn more about. Then you won't miss things that the 

Help window doesn’t cover, and you will get the most out of 

Performer. 
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Performer’s User Interface Chapter 3 

The user interface encompasses everything that you do to interact 

with the program: what you see on the screen and how you use the 

mouse, keyboard and peripheral devices. In this section you’ll find 

information about Performer’s windows, dialog boxes, mouse and 

keyboard actions and how to specify and locate regions using units 

of time. This section also describes Performer’s enhancements to the 

standard Macintosh user interface. 

@ The examples of Performer’s windows that you see in 

this manual are what you see when you are running 

Performer on a Macintosh with a color monitor Cin 

either 16-level greyscale or 256-colors). If you have a 

black and white monitor, what appears on your screen 

will be somewhat different than what you see printed 

in this book. 

Before using Performer, please review the standard Macintosh user 

interface conventions. If any of them seem unfamiliar, please refer to 

the Macintosh owner’s manual for a full explanation. Be sure you are 

familiar with the following: 

= How to use the mouse and keyboard 

= How to open, copy and delete files from the Finder 

» How to choose commands from menus 

m How to select options using push buttons, radio buttons 

and check boxes 

= How to respond to dialog boxes 

ms How to use Command key shortcuts for menu commands 

= How to enter and edit text 
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Window mini-menu 

Close button —— » 

To start with, here’s an example of a Performer window: 

Pushdown button Zoom button Window title 

| 

=«—_——— Scroll tab 

a Scroll bar 

| <——_———- Grow box 

The Close button is shaped differently from the standard one but works 

just the same: click in it to close the window. 

The Scroll Bar works exactly the same as the standard one: to move 

directly to a desired location in the window, drag the Scroll tab to the 

desired location. Press on the arrows to scroll continuously, or click 

once on them to scroll one line at a time; click in the grey region to 

scroll a screenful at a time. 

The Window Mini-Menu resembles the standard menus on the top of 

the screen. It contains commands pertinent to that particular window. 

To pull it down, press on the menu icon and then select a menu 

option as you would on a standard menu at the top of the screen. 
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Mini-menu button 

A Performer mini-menu 

Window title shows the name of the window, and often the track or 

sequence that it pertains to. Command-click the title to switch to a 

different track, sequence, etc. 

Commana-click the window 

<=¥#_———————— title to switch to a different 

track or sequence. 

The Pushdown Button will put the window behind all other windows 

on the screen. This is useful when you are finished with a window 

but don’t want to close it. 
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The active window 

Closing all edit windows 
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The Zoom Button will enlarge or shrink the window. Clicking in the 

zoom box will enlarge a window to a larger size; clicking in the zoom 

box a second time will return it to its original size. 

The Grow Box lets you adjust the size of the window. Dragging the 

grow box will continuously adjust the size of the window. Note that 

it is possible to have names or other information extend past the right 

edge of the window; if you need to see this information use the grow 

box to expand the window appropriately. 

Most of the time, the window in which you are currently working is 

the active window. The active window is indicated by fully detailed 

borders; when a window is inactive its top border and scroll bar are 

blank. To activate a window so that you can work in it, simply click 

anywhere on it. The main control panel is always active; it is not 

necessary to click on it before using it. 

A single click on an inactive window makes that window active, and 

in addition, the item in the window that was clicked responds, except 

for clicking the title bar, scroll bar or re-size button. This speeds up 

working with Performer because less clicks are necessary. 

Performer provides several shortcuts for closing all open edit 

windows (Event Lists, Graphic Editing windows, and QuickScribe 

notation window): 

=» Press command-option-W. 

m= Option-click the close triangle in any edit window. 

m Press the option key and the Close command in the 

Windows menu changes to Close All Edit windows. 
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Dialog boxes Performer’s dialog boxes look more three dimensional than the 

standard Macintosh ones: 

Record beat 

Drag the title bar of the 
dialog box to move it on the 
screen—in case you need 
to see something behind it 
before closing it. 

Three dimensional radio 

buttons and check boxes. 

Three dimensional OK 

: and Cancel buttons. 

Even though these buttons look different, the act like standard 

Macintosh check boxes, radio buttons, and push buttons. For 

example, the text labels for radio button and check box options can 

be clicked to check the box or push the button. In addition, if you 

type in a text box, its corresponding radio button selects automati- 

cally. 

Clicking shortcuts Option-click: If you hold down the option key and click on a check 

box, all check boxes will be unchecked except for the one you 

Option-clicked on. 

Command-click: If you hold down the command key and click on 

a check box, all check boxes will be checked except for the one you 

clicked. 

Mouse techniques Here are the mouse actions you'll use in Performer: 

To click, move the mouse to position the arrow cursor on the object 

then press and quickly release the mouse button. Single clicks are 

generally used to select an action, confirm a selection or to select 

something for editing. 
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Keyboard and mouse 
actions 
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To double-click, move the mouse to position the arrow cursor on the 

object then click the mouse button twice in quick succession. The 

interval between the two mouse clicks can be set on the Control 

Panel on the Apple menu (refer to your Macintosh owner’s manual 

about this). Double-clicking is generally used for opening things such 

as windows. 

To press, move the mouse to position the arrow cursor on the object, 

press the mouse button and hold it down. 

To drag, move the mouse to position the arrow cursor on the object, 

press the mouse button and, holding it down, move the mouse in the 

desired direction. Dragging is used to increase the size of a window, 

to move indicators (such as the tempo slider in the Metronome 

panel), to select multiple names, events or objects, or to select a 

region. 

To scroll, press on the scroll box in the scroll bar and drag it in the 

desired direction. Scrolling can also be done by clicking or pressing 

on the arrows on the top and bottom of the scroll bar. 

To learn more about mouse actions, consult the Macintosh Owner’s 

manual. 

Some actions are done with the mouse and keyboard in conjunction: 

To Shift-click, hold down the shift key, move the mouse to position 

the arrow cursor on the object and click the mouse. Shift-clicking is 

used for selecting noncontiguous items; for example, you would use 

Shift-click to select several independent events in an Event Editing 

window. 

To Option-click, hold down the option key, move the mouse to 

position the arrow cursor on the object and click the mouse. Option- 
click is used to select the name of a track, sequence, song or marker 

for editing. After editing, the new entry can be confirmed by pressing 

the Return key. 

To Command-click, hold down the command key, move the mouse 

to position the arrow cursor on the object and click the mouse. 

Commiand-click is used for selecting regions larger than can be 
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Keyboard commands 

return 

enter 

@ #) ©) 

tab 

Cut 

Lopy 
Paste 

Erase 

Repeat... 

Merge 
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displayed on the screen. To do so, highlight an item or event at the 

start of the region, scroll with the scroll bars until the end of the 

region is visible, then Command-click at the end of the region. 

The following keyboard commands are applicable to dialog boxes 

and pop-up boxes. 

Pressing on the return key is the same as clicking on OK: it confirms 

the selection in the dialog box. 

Pressing on the enter key will also OK a dialog box. It is also used 

when editing a list of names or data, confirming the current one and 

moving to the next. 

Pressing the command and period keys together is the same as 

clicking on the Cancel button: it cancels the selection and leaves the 

previous settings/values unchanged. 

Pressing the escape key is the same as clicking a Cancel button and 

pressing command-period C. ). 

Pressing the tab key will confirm the current entry field, then move to 

the next field in the box or list and highlight it. 

The up arrow will move through a list of names or events, confirming 

the current selection and moving to the previous one. 

The down arrow will move through a list of names or events, 

confirming the current selection and advancing to the next one. 

The left and right arrows move from field to field in the event list, 

confirming the current selection and advancing to the next one in the 

arrow direction. 

In addition to these, there are many shortcut keyboard commands 

that will allow you to choose commands from menus very quickly. 

They are indicated on the menus to the right of the commands 

themselves and can be used instead of pulling down the menu and 

selecting the command. To use a shortcut command, hold down the 

Command key and press the indicated key. For example, command-X 

is the shortcut for the Cut command. Instead of pulling down the Edit 

menu and selecting Cut, hold down the Command key and press the 

X key. 
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Specification of time 
units 
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is the shortcut for the Cut command. Instead of pulling down the Edit 

menu and selecting Cut, hold down the Command key and press the 

X key. 

In Performer, you will always be dealing with time specifications. 

Performer gives you the option of using measure time 

(measure | beat | tick), real time (minutes:seconds.hundredths) and 

frame time (hours:minutes:seconds:frames). Full understanding of the 

time specifications you are using is essential. Below is a concise 

explanation of each of them: 

Measure time (measurelbeatltick): A specification of measure-oriented 

musical location. The number of beats in the measure depends on the 

specified meter: 4/4 will define 4 beats per measure, for example. 

Subdivisions of the beat vary, according to the 480-ticks-per-quarter 

note constant. Thus, a beat in 6/8 time (an eighth note) will have 240 

tick subdivisions, a beat in 2/2 time (a half note) will have 960 tick 

subdivisions and so forth. Measure time is useful since it is the most 

musical. 

Real time (minutes:seconds.hundredths): Measurement in standard clock 

time. This is a simple, already familiar method for location. 

Frame time (hours:minutes:second:frames): Frame time is a special type 

of real-time measurement. With it, you can synchronize Performer 

(via a SMPTE to MIDI converter) to a device that uses SMPTE time 

code as a time reference. Unlike measure time, frame time is used 

when absolute time location is necessary. 

SMPTE stands for Society of Motion Picture and Television Engineers. 

Although SMPTE time code is used mostly in film and video work, it 

is increasingly used for audio applications. One SMPTE frame 
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Durations used in 
specifying note lengths 

Editing the Counter 

Performer’s User Interface 

corresponds to one film or video frame. The number of frames per 

second depends on the equipment you are working with; Performer 

supports 24, 25, 30 drop frame, and 30 frames per second. SMPTE is 

useful as a standardized location scheme when synchronizing to 

production devices such as a tape deck or video deck. See the 

chapters called Receive Sync and the appendix Synchronization 

Specifications for a more detailed explanation. 

Times used in Event Editing windows and elsewhere to specify 

durations are displayed in quarter notes and ticks. Since Performer 

allows different meters in a sequence, it is necessary to use a compre- 

hensible, easily divisible format to insure clarity and a lack of 

confusion. The quarters | ticks format fulfills this requirement, making 

it easy to understand durations without having to specify a measure 

value. For instance, a whole note is 4! 000 (four quarter notes and no 

ticks), and a dotted quarter note is 11240 (one quarter and 240 ticks). 

Eighth note 

Quarter note 

Sixteenth note 

Whole note 

The current playback location can be changed at any time by editing 

the Counter. You can edit the counter even while the sequence is 

playing back. To edit the current Counter location in Performer: 

1. Click on the field in the time display to highlight it. 
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Editing during playback 
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2. Type in a new time value. 

While a field is highlighted, just type in a new value. Use the 

backspace key to erase an incorrect entry. 

Pressing the Tab or the decimal key on the keypad will cycle through 

each field of a time display, highlighting each so that you can type in 

a value. For example, to enter the time 0:07.13 as shown in the 

example above: 

1. Click on the minute field to highlight it. 

2. Press 0. 

3. Press the Tab or decimal key. 

4. Press 0 and 7. 

5. Press the Tab or decimal key. 

6. Press 1 and 3. 

7. Press the Return key. 

As a shortcut, you can press the decimal key on the Macintosh 

keypad. To cancel the edit, press command-period. 

Many of Performer’s features, such as windows, dialog boxes, edit 

region selection, edit commands, and other features can be used 

during playback. For example, you can open another window or use 

the Transpose command while the music is playing back; you do not 

have to press the stop button beforehand. So, the next time you are 

listening to your music and would like to make a change, don’t reach 

for the stop button. Just execute the command while the music is 

playing. 

Here are some examples of things you can do during playback: 

m Select a region for editing (in an Event List, Tracks 

Window, etc.). 

a Edit a region with the Edit or Region menu commands 

m Rearrange Chunks in the Song window 
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= Cut, copy, drag, option-drag (copy), etc. notes and data in 

Graphic Editing and QuickScribe notation windows 

m Reassign the playback channel for a track 

= Add, delete, rename, or reposition a track 

m Access a mini-menu command such as Set View Filter 

During playback and recording, the Counter and other displays may 

become irregular and seem to skip beats. This is due to Performer’s 

primary obligation which is to receive and output MIDI data on time. 

Performer may have to devote all of the computer’s resources 

towards this end and thus may not be able to keep the screen display 

completely smooth and current. The Click and Flash will provide an 

accurate determination of the tempo. In addition, editing commands 

may sometimes take longer due to the amount of processor time 

required to deal with playback. 

Some features, because of their nature, cannot be accessed during 

playback. These features are either greyed out Cunaccessible) during 

playback or will have no effect unless you press the Stop button 

before using them. Examples are: 

m= Using the MIDI Interface dialog box 

m Save or close a file 
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Chapter4 Wor king With Files 

A single Performer file can contain one or more sequences and songs. 

It is represented in the Macintosh Finder by the Performer file icon. 
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Opening a new file To open a new file, you must first start Performer. 

1. Double-click on the Performer program icon. 

You can also click once on the Performer icon and choose Open 

from the File menu. 

2. If you see a new file appear on the screen, with the tape-deck style 

control panel and Tracks window, you are ready to go. 

3. If you see the standard Macintosh dialog box for opening files, 

click the New button (or press command-N). 
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If you are already in Performer: 

1. Select Close from the File menu. 

This closes the file that is currently open. If you have modified the 

data in the file, Performer asks if you would like to save changes. 

The various windows will disappear and the file will close. 

2. Select New from the File menu. 

A new file will be created and the main control panel appears, 

along with the Tracks window. (You can customize the New 

command using Save as ‘New’ Template, described later in this 

chapter). 

Opening a new file automatically opens a new sequence. This 

sequence is ready to record into right away. You can create other 

new sequences by choosing Add Sequence from the Chunks window 

mini-menu. 

Opening an existing file To open an existing file from the Finder: 

1. Double-click on the file icon. 

You can also click once on the file and choose Open from the File 

menu. This will start Performer and bring up the selected file. 

To open an existing file from within Performer: 

1. Ifa file is already open, close it by selecting Close from the File 

menu. 

You are given the option of saving changes in this file. The 

Performer windows will all disappear and the file will close. 

2. Select Open from the File menu. 

A dialog box will appear, containing a list of files on the selected 

disk. To see the files on a disk in a different drive, click on the 

Desktop button. To view files on another disk which is not 

currently in a drive, click on the Eject button and insert the other 

disk. 
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3. Click on the name of the file you wish to open. 

4. Click on the Open button. 

The file you selected will be opened. Double-clicking on the 

name of the file will also open the file. 

Performer can open files in the Professional Composer® and MIDI 

file formats. To open a file in one of these formats, simply select it 

from the Open dialog box as normal. A message will appear 

informing you that Performer is converting file formats. The file will 

open as a Performer file; if you want to save it back into the 

Professional Composer or MIDI file format you must use the 

procedure described later in this chapter. 

In addition, files created in older versions of Performer can be 

opened in the new version; simply select the old file from the Open 

dialog box as normal. 

Performer cannot open Mosaic files directly. To open a Mosaic file, 

save it as a MIDI file from within Mosaic using the Save As command 

in Mosaic’s File menu. Once the file is saved in the MIDI file format, 

you can then open it in Performer. 
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Loading a chunk from Once you have opened a file, the Load command in the File menu 

another file lets you load Chunks (sequences and songs) from other files directly 
into the open file without closing it. 

Your Macintosh must have enough RAM available to support the load 

operation. Be sure to open and watch the Memory window, available 

in the Windows menu, whenever you load Chunks or Remote 

Controls. Try to have at least 100K available at all times. 

To load a Chunk into an open file: 

1. Choose Load from the File menu. 

The standard Macintosh Open dialog box appears. 

2. Click the file containing the Chunk you wish to load, then click 

Open. 

Alternately, you can double-click the file name. Performer’s Load 

dialog box appears, displaying the file name at the top. 

Chunks list 

3. Make sure the Load Chunks option is checked. 

If it is not, click its check box. The Chunks list displays all Chunks 

in the selected file. 

4. Choose the Data sub-option. 
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Linking sequence 
chunks from another file 

Working With Files 

5. Select the Chunk(s) you wish to load. 

Click the Chunk name to select it. If you wish to load more than 

one Chunk, drag to select contiguous Chunks and shift-click to 

select discontiguous Chunks. 

6. Optional: If you wish to load any other items from the selected file, 
select the appropriate option. 

7. Click OK to confirm your choice or Cancel to withdraw the Load 

command. 

Clicking OK causes the selected Chunk(s) to be placed in the 

Chunks window. You can change each Chunk’s position in the 

Chunks list by dragging its Type icon. 

Loading a song Chunk automatically loads its component Chunks. 

For example, you choose to load Song-1, which contains Seq-1, Seq- 

2, and Song-2. Song 2 contains Seq-3 and Seq-4. When you execute 

the Load command, all six Chunks (two songs and four sequences) 

will be loaded in and added to the Chunks list of the open file. 

A memory-saving option in the Load command is to Link a sequence 

Chunk instead of actually loading it. A Link serves as a reference to a 

Chunk in a different file. Since a Link requires far less memory than 

the Chunk it references, you can build an extensive list of Chunks 

without running out of memory in your Macintosh. 

Because a song in Performer is a collection of Chunks, song Chunks 

cannot be linked. Instead, just load the song using the procedure 

described in the previous section. Performer will automatically load 

the song’s component Chunks. Alternately, you could open that 

song’s file and use the Merge Chunks to Sequence command to 

transform the song into a sequence. The new sequence could then be 

linked. For more information about converting a song into a 

sequence, please refer to the chapter 7he Song Window. 

For successful playback of links, the linked Chunk’s file must reside in 

a folder with Performer or, if Performer is on the desktop, the file must 

also be on the desktop. 
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To link a Chunk from another file: 

2 
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Choose Load from the File menu. 

The standard Macintosh Open dialog box appears. If necessary, 

click the Drive button repeatedly to view each drive present. 

Click the file containing the sequence you wish to link, then click 

Open. 

Alternately, you can double-click the file name. Performer’s Load 

dialog box appears, displaying the file name at the top. 

Make sure the Load Chunks option is checked. 

If it is not, click its check box. The Chunks list displays all Chunks 

in the selected file. 

Choose the Link sub-option. 

Any song Chunks in the window become italicized, indicating that 

they cannot be linked. 

Click the sequence(s) you wish to link. 

If you wish to Link more than one sequence, you can drag to 

select contiguous Chunks and shift-click to select discontiguous 

sequences. 

Optional: If you wish the Chunk’s Remote Controls assignments to 

be loaded with the Chunk, choose the Load Remote Controls 

option. 

Deselecting this option loads only the Chunk’s song or sequence 

data. 

Click OK to confirm your choice(s) or Cancel to withdraw the Load 
command. 

Clicking OK places a Link to each selected Chunk in the Chunks 

window and a corresponding Chunk Select control in the Remote 

Controls window. 
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Saving files 

Working With Files 

After you have linked a Chunk, its name appears italicized in the 

Chunks window of the current file. The Link’s Comment field displays 

the file from which the Linked Chunk will be loaded. When the Link 

is play-enabled, Performer will take a few moments to load it; the 

amount of time this takes depends on the size of the Chunk. 

@ Please remember: for successful playback of links, the 

linked Chunk’s file must reside in a folder with 

Performer or, if Performer is on the desktop, the file 

must also be on the desktop. 

Please read this section carefully! When you open a file from a disk, 

Performer makes a copy of that file and puts it in the Macintosh’s 

temporary memory (called Random Access Memory, or RAM). When 

you work with the file, you are actually working with the copy that is 

in RAM, not the original file on the disk. If you choose Save from the 

File menu, Performer writes the changes you have made into the 

original file on the disk. If you do not save, the changes you have 

made are never written to the disk. For example, if you quit without 

saving changes, the work you have done is not saved on the disk and 

is permanently deleted from the computer’s memory. 

This is why files should be saved frequently. If Performer or your 

Macintosh should malfunction, all of the work you have 

accomplished since you last saved may be lost! However, if the file 

was recently saved, you can retrieve the latest version from the disk 

and proceed without having lost much work. 

Always be sure that the disk you are saving the file on has enough 

room! Files can be saved to any disk with sufficient space for the file. 

They can also be saved with different names. 

Here’s the basic procedure to save a file: 

1. Choose the Save command from the File menu. 

Your file is saved on the disk in its current state, replacing the old 

version with the same name. If you want to keep the old version, 

use the Save As command on the File menu (see below) instead 

to save the current version under a different name. 

If you are saving the file for the first time, a dialog box will appear 

prompting you for a name: 
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2. Type in the name of your file. 

You can’t use a colon in the name; all other characters are 

permitted, including spaces. If you enter a name that is already in 

use, a dialog box will ask you to confirm your choice. 

3. Click on the Save button. 

Pressing the Return key will do the same as clicking on the Save 

button. If you want to save the file to a different disk, click on the 

Eject button, insert a new disk and, after typing in the name, press 

the Save button. Pressing Cancel withdraws the Save command. 

Saving a file under a The Save As command is used to save a file under a different name 

different name or to a different disk: 

1. Choose Save As from the File menu. 

The Save As dialog box will appear. 

2. Type in the new name for the file. 

You can’t use a colon in the name; all other characters are 

permitted, including spaces. If you enter a name that is already in 

use, a dialog box will ask you to confirm your choice. 
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Saving a file to a disk not 
currently in a drive 

Saving a sequence in 
another format 

Working With Files 

3. Click on the Save button. 

Your file is saved on the disk in its current state under the new 

name. 

To save a file to a disk not currently in a drive: 

1. Choose the Save As command from the File menu. 

2. The Save As dialog box will appear. 

3. Click on Eject. 

The disk that is currently displayed in the dialog box window will 

be ejected. If you want to use the other drive, click on Drive 

before clicking on Eject. 

4. Insert the disk you wish to save the file on. 

5. Click on the Save button. 

The file is saved on the disk you selected. 

Performer saves almost every attribute of your file, including open 

windows and their screen positions, the on/off status of such features 

as Audible Mode and Patch Thru, your current choice of Event 

Editing display, your Chunk Start Times, and many others. If you find 

that your files often have very similar setups, use the Save As ‘New’ 

Template command, described later in this chapter, to customize your 

new files. 

Performer can save sequences in several other file formats: 

mw Standard MIDI file 

m= Performer Version 2.41 file 

m= Professional Composer™ file 

Only sequences can be saved in these other file formats. If you wish 

to save a song, you can do so by converting it into a sequence 

beforehand. Please refer to the Chunks Window chapter later in this 

manual for information about converting a song into a sequence. 

51 



52 

To save a Performer sequence in a different file format: 

1. Play-enable the sequence that you wish to save. 

Do so by clicking the play-enable button next to the sequence in 

the Chunks window. 

2. If you are saving a MIDI file, and you want the tempo and meter map 

of the sequence to be saved with the MIDI data, choose Conductor 

Track from the Metronome tempo control pop-up menu in the main 

control panel. 

Do so by choosing Conductor Track in the Tempo Control pop-up 

menu in the Metronome. 

3. Choose Save As from the File menu. 

The Save As dialog box appears with four options: Normal, 

Performer 2.41, Standard MIDI File, and Professional Composer. 
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4. Click the desired file format. 

5. Click Save to activate the conversion. 
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Saving as a standard 
MIDI file 
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6. If you are saving a standard MIDI file, the MIDI File Options dialog 

box appears. 

See “Saving as a standard MIDI file” on page 53 for more 

information about these options. 

Use the procedure explained in “Saving a sequence in another 

format” on page 51. Music saved in the MIDI file format can be 

opened with any program that also reads and writes MIDI files—even 

programs that run on other types of computers. 

MIDI File Format options 
When you save a file as a standard MIDI file, the following dialog box 

appears: 

=~! MIDI File Option: 

= Format 1: separate tracks with tempo and meter 
information as the first track 

= Format 0: one multi-channel track with tempo/meter 

information at the beginning 

= Format 0: tempo/meter map only 

Save track names as plain text 
When selected, the Save track names as plain text option causes only 

plain text events, such as track names, to be saved. No special text 

events, such as track comments, are saved. This option is necessary 
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Composer file 
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when transferring files to programs that do not support special text 

events. If you discover inconsistencies when transferring text in MIDI 

files, try using this option. 

Expand Loops 
Standard MIDI files cannot contain loops. The Expand loops option 

addresses this problem by converting each loop into a region of 

repeated data in the same way as Performer’s Repeat command. The 

End file at time option allows you to specify the end time of the 

sequence in the box provided. For convenience, the box appears 

with the sequence’s current end time. 

Performer automatically opens MIDI files. For more information, see 

the Open section earlier in this chapter. 

Performer’s file format is constantly developing as new features are 

added. Due to these changes, files saved in the current format cannot 

be loaded into earlier versions of Performer. If for some reason you 

need to work with a file in an earlier version of Performer (2.41 or 

later), Performer lets you save sequences in the version 2.41 format: 

To save a file in the 2.41 format, use the procedure described in 

“Saving a sequence in another format” on page 51. 

When you Save As 2.41, songs in the file will not be saved. This is 

because Version 2.41 does not support songs. Therefore, any songs in 

the file you save will not be present in the 2.41 version of the file. If 

you don’t want to lose the song when converting to the 2.41 format, 

you can easily convert it into a sequence, which will get saved in the 

2.41 file. To do so, open the song’s Song window, Select All, and 

choose Merge Chunks to sequence from the mini-menu. A new 

sequence, which is identical to the song, will appear at the bottom of 

the Chunks window list and get saved in the 2.41 file. 

A Performer sequence can be converted into a format that is readable 

by Professional Composer®, an earlier score editing software 

package from Mark of the Unicorn. 

To save a file in the Professional Composer file format, use the 

procedure described in “Saving a sequence in another format” on 

page 51. Make sure that you quantize both attacks and releases of all 

the notes in the sequence beforehand. Otherwise, the transcription in 
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to Mosaic™ 

Reverting toa 
previously saved 
version of the file 

Saving a file as a ‘New’ 
template 
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Professional Composer will be filled with unwanted 32nd and 64th 

notes and rests. See the section on quantization for further 

information. 

Once you have converted the file, quit Performer, start up 

Professional Composer, and open the newly created Composer file. 

To transfer a sequence to Mosaic, Mark of the Unicorn’s latest 

notation software package, save it as a Format 1 MIDI file. No 

quantization or other preparation is necessary because Mosaic does 

its own quantizing when you open the MIDI file in Mosaic. See 

“Saving as a standard MIDI file” on page 53 for information about 

saving standard MIDI files. 

If you’ve made unwanted changes to a file, you can undo the 

changes you’ve made by returning to the last saved version. This 

operation is identical to closing the file and opening it from the disk 

again. 

1. Choose Revert to Saved from the File menu. 

A dialog box asks you to confirm this choice. 

2. Click on OK to confirm the action, Cancel to withdraw it. 

Reverting to the last saved version of the file means that all 

changes you’ve made since you opened or last saved the file will 

be lost. 

Reverting to a previously saved version is useful when experimenting 

with a file. You can quickly remove any changes by using this 

command. Make sure that you save the file in the state you want it 

before beginning to experiment. 

The Save As ‘New’ Template command, found in the File menu, 

allows you to customize your copy of Performer. You control what 

appears on the screen when you open a new file, by creating your 

own New file template. A template is a “skeleton” file, a framework 

designed to save you time when building your files. 
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For example, let’s say you typically work in files with one sequence, 

the same number of tracks, Auto Channelize, measure time and 

SMPTE displays in the Counter window, and a Sequence Start Time 

of -1. In addition, you arrange Performer’s windows to suit your 

screen size and style of working. 

You can use the Save As ‘New’ Template command to give your 

‘New’ files all of these characteristics automatically. 

When you choose Save As ‘New’ Template from the File menu, 

Performer remembers the exact state of the file and reproduces it 

next time you request a new file. The New command, also in the File 

menu, will produce an untitled, empty new file identical to the source 

file. 

To use the Save As ‘New’ Template command: 

1. If you aren’t already in a Performer file, open one or choose New 

from the File menu. 

2. Configure Performer’s windows, their contents, and any other 

features as you find most useful. 

This file will be your template source file: Performer will 

remember your exact track setup, window layout, Patch Thru 

setting, and so on. 

3. Choose Save As ‘New’ Template from the File menu. 

A dialog box will ask you to confirm or cancel your request. 

4. Click OK to confirm the command, Cancel to withdraw it. 

If you confirm the command, Performer redefines your ‘New’ 

template based on the current file. All attributes specific to the 

current file, except for MIDI and Conductor track data, now 

comprise a New file in the copy of Performer you are using. 

To see the effects of Save as ‘New’ Template, close the current file 

and choose New from the File menu. A new, empty, untitled file will 

appear, identical to the last file you saved as ‘New’. 
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‘New’ Template 

Quitting Performer 
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Remember that the Save As ‘New’ Template command customizes only 

the copy of Performer in which it is used. Every copy of the program 

has its own template; a fresh copy of Performer will yield the default 

New file setup. 

For this reason, make a spare copy of your template source file using 

the Save As command described earlier in this chapter. Pick a suitably 

descriptive name for the file, like “Perf Template”. This way you can 

retrieve your preferred setup into any copy of Performer by opening 

“Perf Template” and immediately choosing Save As ‘New’ Template 

from the File menu. 

Redefining your New file template is easy. For example, you’ve used 

the Save As ‘New’ Template command in a file that contains only one 

track. 

To quickly add more tracks to your template: 

1. If you are in a Performer file, choose Close from the File menu to 

close it. 

If you’ve made any changes to the file, you’ll be prompted to save 

them. 

2. Choose New from the File menu. 

A new file will open, identical to the file you saved as New. 

3. Activate the Tracks window if it is not already active. 

Click anywhere in the window to activate it. 

4. Hold down the Option key on your Macintosh keyboard and choose 

Add from the Tracks window mini-menu. 

A small dialog box will prompt you for the number of tracks to be 

added. Type in the desired number. 

5. Choose Save As ‘New’ Template from the File menu. 

The existing file will become the new template. 

Quitting Performer returns you to the Finder. 

Choose Quit from the File menu. 
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A dialog box may appear asking you if you want to save changes 

made to the file. To save the changes, press Yes. If you don’t want to 

save changes, press No. To withdraw the Quit command and return 

to your Performer file, press Cancel. 

Setting Performer’s When Performer first opens, you have three choices for what it can 

startup preferences do: 

= Open a new file 

m Present you with the Open file dialog box, which lets you 

open either an existing file or a new file with the “New” 

button 

m= Neither of the above, which lets you either choose Open 

or New from the file menu 

To set this preference, choose Preferences from the File menu and 

choose the desired setting. This setting is remembered in the 

Performer Preferences file in the Preferences Folder inside the System 

Folder on your hard disk. 
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File and disk errors 
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The following are a few file and disk errors that commonly occur. 

Always keep plenty of up-to-date backups of your important files as 

you work. Almost any software problem is survivable as long as you 

have kept backups of your work. See Appendix B: Troubleshooting 

and Customer Support for more information about problems you may 

encounter with Performer files. 

There isn’t enough room on the disk. Your disk is too full. Eject the 

disk and insert one with plenty of free space on it. Note: If Performer 

runs out of disk space while saving a file, the file on disk will be 

damaged. If this happens, immediately use the Save As command to 

save the file to a disk with more space available. If you fail to do this, 

and you have not made a backup file, you will have lost an entire file. 

As a rule, before opening an existing file, be sure the disk on which 

it is stored has enough free memory to hold the information you 

expect to add. 

An error occurred while writing the file. This is a dangerous situation. 

In all probability, the existing copy of the file on the disk has already 

been erased so that the new copy could be saved. Because of the 

error, any partial file that has been saved cannot be read. At this 

point, the only good copy of the file is in memory. Immediately try to 

save the file on another disk. Do not attempt to use the Revert to 

Saved command on the File menu; the saved copy is damaged and 

you will lose the file in memory. 

You tried to open a Professional Composer file made by using the Save 

as Composer command in Performer and didnt get what you 

expected. If the file has all sorts of very small note values, try 

quantizing the Performer file to a larger note value. Make sure that 

you quantize both attacks and release of all the notes. To confirm that 

you have successfully quantized, check attack times and durations of 

notes in the Event Editing window of each track. If correctly 

quantized, all durations will be rounded values such as 1/000 (quarter 

note), or 0/240 (eighth note). See the section on quantization for 

more details. Once you have successfully quantized the sequence, 

save it as a Professional Composer file and try opening it in 

Professional Composer again. 

The computer ran out of memory. Either the data you were recording 

filled up memory or you edited the file quite a bit. Try recording 

smaller segments and saving the file more often. 
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The disk is locked. Unlock the disk by sliding the small tab on the 

back of the disk in the upper left-hand corner down so that it covers 

the small hole. 

The disk can't be read. The disk itself may be damaged. Return to the 

Finder and try inserting the disk again. If it still can’t be read, it may 

be irretrievable. 

File menu commands cannot be used during playback. To use a 

command in the File menu, press the stop button beforehand. 

Save your file as often as possible. You should use the Save command 

after every significant change to your file. 

Always keep backup copies of your important files. We cannot 

emphasize enough the importance of this. At the end of a working 

session, copy to a backup disk all of the files you recorded and 

edited. This way, if anything should happen to your original, you will 

have fully updated backup of the file. 

If you are working with floppy disks, you should store your files on 

a disk separate from Performer. This gives you lots of room for saving 

files. 

Saving a file under a different name while working can be useful 

when you want to keep a record of earlier versions. 

When saving files during a working session, it is a good idea to save 

alternately under different file names; if something should happen to 

one of the files, the other will be a recent version. For example, a file 

can first be saved under the name “Session1”. The next time it is 

saved, choose the Save As command from the File menu and save it 

as “Session2”. The following time, it is saved as “Session1” again, then 

“Session2” and so forth. To be even more careful, save a file to 

different disks during a working session. 

Hard disk users should make sure to backup their files to floppy 

disks. This should be done as often as is bearable, at least at the end 

of every working session and several times during the session if 

possible. The consequences of not making floppy backups are 

severe: if your hard disk is damaged, some or all of the files may be 

lost forever. 
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Using System 7’s Performer supports System 7’s “Stationery pad” feature in the Get Info 

stationery feature window for a file as shown below: 

My Performer File 

: Performer 

: 44K on disk (41 317 bytes used) 

: Centris 650 HD: Performer™: 

Created: Tue, Dec 25, 1993, 3:48 PM 

Modified: Tue, Dec 25, 1993, 3:48 PM 

Yersion: na 

Comments - 

7 Stationery pad 

Stationery pad option in the Get Info window. 

When this option is checked, the file can be opened, but System 7 

will prevent you from modifying the original file by forcing you to 

Save As when you attempt to save the file. This option is great for 

preserving files that you do not want to modify and that you use 

regularly as a “template” from which to build other files. For more 

information about the Stationery pad option, consult your System 7 

documentation. 
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Chapters ~The Consolidated Controls Panel 

Performer’s Consolidated Controls panel contains all the functions 

that make Performer “go”: buttons to record, play, rewind, set tempo, 

and more. The main transport controls look and act much like the 

transport controls for a tape recorder. Additional buttons provide 

immediate access to many of Performer’s significant features. The 

panel can be opened by choosing Consolidated Controls from the 

Windows menu. 

To conserve screen space, the Consolidated Controls panel does not 

have a title bar. To move the panel, hold down the shift key and drag. 

If the panel is behind other windows, choose Consolidated Controls 

from the windows menu to bring it to the front. 

Quick reference 
Current Current Current Tempo Skip Main Position bar Main Counter Time format 
Meter beat Tempo control buttons Transport selection buttons 

value Controls Start time button 

Tempo 
Slider 

Status 
Strip 

Chunks Markers Auto Memory | Chain | Countoff | Overdub Event list QuickScribe 
Window Window Rewind Cycle | Chunks record Notation 

Metronome Custom Opens Auto Cue Auto Wait Tracks Graphic Set loop 
Click control Free Stop Chunks —_ Record window editing 

consoles MIDI 
Setup 

Tempo Slider: Displays the current tempo in beats per minute. When 

the Tempo Control pop-up menu is set to Metronome, drag the 

triangular indicator or press on the plus/minus buttons to change the 

tempo (+ to increase the tempo, — to decrease it). 
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Current Meter: Displays the meter at the current location in the Chunk. 

To change the meter, you must use the Change Meter command on 

the Change menu or insert a Meter change event in the Conductor 

track. 

Current Beat Value: Displays which note value gets the beat in the 

beats-per-minute tempo indicator. Click on it to change it. 

Current Tempo: Displays the current tempo in beats per minute. Click 

on it and type in a new tempo or drag the Tempo slider. 

Tempo Control: Selects the current source of the tempo from a pop-up 

menu. Tempo can be controlled from the Tempo slider, the 

Conductor track, or remotely from a MIDI controller such as a mod 

wheel. 

Skip buttons: If you have more than one sequence or song in the file, 

these buttons skip to the next or previous one, much like the skip 

buttons on a CD player. To view sequences and songs, open the 

Chunks window. 

Main Transport Controls: These are Performer’s main controls for 

playback, recording, etc. The Skip buttons change the currently play- 

enabled sequence to the next or previous Chunk in the list. The 

Position Bar indicates the current playback position of the currently 

play-enabled sequence. Use the Position Bar arrows to quickly 

advance or rewind the current location while in playback. 

Position bar: Indicates the current playback location with a scrolling 

arrow. Scroll buttons on either side of the bar provide fast forwarding 

and rewinding. 

Start time button: Opens a dialog box which allows you to set the start 

time for the Main Counter’s three time formats: measure time, SMPTE 

time, and real time. 

Main Counter: Displays the current playback position in one of 

Performer’s three time formats: measures | beats | ticks, real time, or 

SMPTE time. Click the time format icon to the right to cycle through 

the three formats. Click the numbers and type to change the playback 

location. For more information about editing times in the Main 

Counter, refer to the Counter Window chapter. 
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The Consolidated Controls Panel 

Time format buttons: Cycles the display in the counter through 

Performer’s three time formats: measures | beats | ticks, real time, or 

SMPTE time. 

Set Loop button: Creates a loop over the selected region in the Tracks 

List or Tracks Overview. Select a region and click this button to create 

a loop. At least one track name or track segment must be highlighted 

to create a loop with this button. 

QuickScribe Notation Window button: Opens the QuickScribe Notation 

window for the currently selected track(s) in the Tracks List or Tracks 

Overview. At least one track name or track segment must be 

highlighted to open Notation Editing with this button. Provides 

notation editing and printing. 

Graphic Editing Window button: Opens the Graphic Editing window for 

the currently selected track(s) in the Tracks List or Tracks Overview. 

At least one track name or track segment must be highlighted to open 

Graphic Editing with this button. 

Event List Window button: Opens the Event List window for the 

currently selected track(s) in the Tracks List or Tracks Overview. At 

least one track name or track segment must be highlighted to open 

Event List with this button. 

Tracks Window button: Opens the Tracks window or brings it to the 

front if it is already open. 

Overdub record button: Toggles overdub record mode, in which newly 

recorded data merges with existing data instead of replacing it. 

Wait button: Causes Performer to wait for a keystroke from a MIDI or 

Macintosh keyboard as a signal to start playing back or recording. 

Countoff button: Causes a number of measures to countoff before 

playback or recording. The button denotes the number of measures, 

which can be set by double-clicking the button. 

Auto-Record button: Causes automatic punch in and punch out during 

recording at the start and end times specified in the Auto Record Bar. 
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Chain Chunks button: When highlighted, starts playback of the next 

Chunk in the list after the current playback Chunk reaches its End 

time. 

Cue Chunks button: When highlighted, it play-enables the next Chunk 

in the Chunks list after the current playback Chunk reaches its End 

time and stops. To begin playback of the next Chunk, press the Play 

button, or a remote control for the Play button. 

Memory-cycle button: Causes the region between the Memory Start and 

Stop points to seamlessly repeat. In the Tracks overview, repeat 

barlines appear in the time ruler to indicate the repeat points. 

Auto-Rewind button: Causes automatic rewinding to the Memory Start 

location any time playback is stopped (for any reason). 

Auto-Stop button: Causes playback or recording to automatically stop 

at the Stop location in the Memory Bar. 

FreeMIDI button: Opens the FreeMIDI setup program, in which you 

can make changes to FreeMIDI’s representation of your current MIDI 

studio setup. 

Markers Window button: Opens the Markers window for the currently 

play-enabled Chunk or brings it to the front if it is already open. 

Custom Consoles Window button: Opens the Sliders window or brings it 

to the front if it is already open. 

Chunks Window button: Opens the Chunks window, which displays all 

of the sequences and songs currently stored in the file. 

Metronome click button: Turns the audible metronome click on or off. 

Status Strip: Displays the name of the currently open file and currently 

play-enabled Chunk. Also displays the Memory bar, which allows you 

to set start and stop times for the Auto-Stop, Auto-Rewind, and 

Memory-cycle functions. 

Main Tr, ansport The Main Transport Controls are the buttons that make Performer 

Contro Is “go”: with them you can record, play, rewind and more. The Main 

Transport Controls are enabled by clicking on them. When a button 

is enabled, it is highlighted and its function is active: the Record 
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The Play button and 
playback 

The Consolidated Controls Panel 

button records, the Pause button pauses, etc. Most buttons can be 

disabled by clicking a second time. To disable the Play and Record 

buttons, press the Stop button. In some situations (when in external 

sync, for instance) buttons may turn grey signifying that they cannot 

be used. 

Think of Performer’s motion controls as similar to tape recorder 

transport controls. But Performer’s motion controls are more flexible 

than their hardware counterparts in that they are programmable via 

the Memory buttons (on the left of the window), utility buttons (on 

the right) and menu commands. 

Clicking on the Play button starts playback of the currently play- 

enabled sequence or song. Playback will begin from the current time 

specified in the Counter. Playback can be delayed by the Countoff 

button and held by the Pause and Wait buttons. 

The Play button is highlighted while the sequence is playing. It 

flashes (or turns gray on a black and white display) when waiting for 

synchronization in the External Sync mode or when the wait button 

is on. 

The Position Bar arrows can be used to quickly advance or rewind 

the current location while in playback. 

If you start playback in the middle of a sequence, you may not hear 

exactly what you expect. This is because Performer moves forward 

through the stream of data stored in each track, sending each event 

that it encounters, such as note—on and note—off commands. If you 

start playback in the middle of a sequence, notes which are 

sustaining at that point will not sound because their note-on occurred 

before the point at which playback began. Performer has a specially 

designed feature called Event Chasing to avoid this problem. To learn 

how to enable Event Chasing, see the section called Event Chasing at 

the end of the Playback chapter. 

During playback, some Performer features become unaccessible, 

such as the Save command in the File menu. Many other features, 

however, including all editing commands, can be used even during 

playback. As a general rule, commands that cannot be used will 

either appear greyed out during playback or they will have no effect. 
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The Rewind button 

The Stop button 

The Pause button 
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Clicking on the Rewind button sets the current location to the start of 

the sequence. If the Memory Bar is showing, clicking on the Rewind 

button will rewind to the Memory Start location. Double-clicking the 

button will always rewind to the start of the sequence or song. 

If the Rewind button is clicked during playback, playback is held for 

a moment while the sequence rewinds. Playback then resumes from 

the rewind location. 

If the Rewind button is clicked during recording, the record button is 

turned off. The sequence rewinds normally and resumes in playback 

mode. 

Although Performer rewinds much faster than a tape deck, long 

sequences may take one or two seconds to rewind. 

Using the Auto-Rewind function is a fast way of locating a frequent 

rewind location. See The Auto-Rewind button below. 

Clicking on the Stop button stops playback and recording. It also 

turns off the Pause button. All notes sounding when the Stop button 

is clicked will cease. 

The Stop button turns off all notes currently on. If the Auto-Rewind 

feature is on, Performer will rewind to the Memory Start location 

when the Stop button is clicked. 

Clicking on the Pause button once turns it on; clicking on it a second 

time turns it off. The Pause button is highlighted when it is on. 

Turning the Pause button on during playback will cause playback to 

be suspended without turning any notes off. Turning it off will cause 

playback to resume. 

If the Pause button is turned on before playback, playback will be 

suspended until the Pause button is turned off. 

While the Pause button is on, you can use the Rewind button, 

Position Bar, and Counter window to adjust the current playback 

location. You may also set times in the Edit, Memory, and Auto- 

Record bars. 

The Consolidated Controls Panel 



The Record button and 
recording 

Overdub record mode 

The Consolidated Controls Panel 

Clicking on the Record button turns it on and begins recording in the 

currently play-enabled sequence from the current location in the 

counter. When it is on, the Record button is highlighted and can be 

turned off by clicking on it again. This disables the record function 

while continuing playback. You can also turn on and off the record 

button during playback for manual punch-in and punch-out. A more 

general way to think of the Record button is as an on/off toggle 

switch that you control manually. 

At least one track must be record-enabled before the record button is 

pressed. This is done by clicking on the Record-Enable button for the 

desired track (or tracks). Record-enabling a track makes it the 

destination for incoming recorded data. 

If the Auto-Record button is enabled, the Record button will flash 

when clicked on (or turn grey on a black and white display). It will 

then turn red (or black on a black and white display) when the Punch 

In location is reached. When the Punch Out location is reached, the 

Record button returns to “record-ready” mode. 

If the Record button is enabled and grey due to Auto Record, clicking 

on it will turn it off, cancelling the punch-in. 

When slaved to external sync, stopping or rewinding the master 

device will turn off the record button except in the case of Tap tempo 

sync, which requires that you click the Stop button. 

If you click the Overdub button, Performer goes into Overdub record 

mode. Overdub mode causes all recorded data to merge with, instead 

of replace, pre-existing data on the record-selected track. The pre- 

existing data on the track is not erased. 

The word overdub is used in a very specific sense in Performer: real- 

time merging of incoming data with data already on a track. It works 

as if you recorded one track, recorded a second track to go along 

with it and then merged the two. You should turn off Overdub when 

you are finished using it since it can produce unwanted effects if left 

on by mistake. You can use the Overdub mode in conjunction with 

memory cycle to build patterns in multiple passes over a region. This 

method is similar to that used with many drum machines. (Overdub 
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Undo Record 

The Position bar 
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does not function on the Conductor Track; specifically, recording on 

the Conductor Track while slaved to Tap tempo sync always erases 

existing tempo events.) 

By choosing Undo Record from the File menu, the track you recorded 

into will be restored to its state before recording. The Redo command 

returns the track to its state after recording. Going back and forth 

between the two states allows you to do A/B comparisons. Note that 

only the last command can be undone; if you edit your data after 

recording you will no longer be able to undo the Record command. 

The Position Bar indicates the current position in the sequence. The 

indicator can be moved to change the location: left to rewind, right to 

advance. The far left is the beginning of the sequence, the far right is 

the end. 

To change the current position in the sequence, drag the scroll 

triangle to the desired location. If you press on the grey bar, the scroll 

triangle will move to that spot. If you keep pressing, you can drag it 

to a new location. 

The position bar can be used during playback as well as when the 

sequence is stopped. 

The same applies to the Position Bar Arrows. Using them during 

playback is called “cueing”. The right set of arrows cues forward in 

time, the left set cues backwards. The smaller arrows cue slowly, the 

larger ones cue faster. The left arrows cause playback to pause while 

cueing backwards until the arrow is released. If used during 

recording, the Record button will be turned off before cueing. The 

Position Bar can also be used while the Pause button is on during 

playback. 

The Position Bar can be used to find a relative location in a sequence. 

It may not be useful for finding exact locations (use the Counter or 

Markers instead) but is perfectly suited for finding the beginning and 

end of a sequence: simply drag the scroll triangle to the far left or 

right. 
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The Memory 
buttons 

The Auto-Stop button 

The Auto-Rewind button 

The Memory- 
cycle button 

The Consolidated Controls Panel 

Use the Position Bar to move short distances quickly in a sequence. 

Since forward cueing is audible, you can use it to accurately locate a 

particular note event or region. 

The Memory buttons (Auto-Rewind, Auto-Stop and Memory-cycle) 

allow you to automate the primary motion controls. By using the 

Memory buttons, you can program the motion controls to activate at 

times specified in the Status Strip. 

Enabling the Auto-Stop button causes playback of the sequence to 

automatically stop at the Stop location on the Memory Bar. Clicking 

on the Auto-Stop button enables it; when enabled, it is highlighted. 

Clicking on the Auto-Stop button causes the Memory Bar to appear if 

it is not already present. 

The Memory-cycle button and the Auto-Stop button cannot be 

enabled at the same time. 

Enabling the Auto-Rewind button causes the sequence to 

automatically rewind to the Start location on the Memory Bar. This 

occurs when the Stop button is pressed or when playback reaches 

the end position in the Memory Bar in Auto-stop mode. Clicking on 

the Auto-Rewind button enables and highlights it. 

Clicking on the Auto-Rewind button causes the Memory Bar to 

appear if it is not already present. 

Auto-Rewind is useful for returning to a particular location after 

stopping. It saves you from having to stop and rewind manually. 

The memory-cycle button is a cycle-playback and cycle-recording 

feature that causes a region of the entire sequence to be played 

repeatedly until the stop button is pressed, just like drum machines 

and hardware sequencers. Cyclic playback begins when the 

sequence reaches the specified Memory-cycle region. When the 

Counter reaches the end of the region, it seamlessly returns to the 

beginning and will continue to do so until you press the stop button, 

unhighlight the Memory-cycle button, or cue past the end time. 
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Use Memory-cycle for multiple consecutive playbacks of a particular 

region. This can be very useful for cycle-recording a loop section or 

drum pattern, mixdowns, rehearsing a part that you plan to record, or 

for scrutinizing a particular region of a performance. 

When cycle-recording, you add a new part to the loop with each 

consecutive pass. Before doing so, be sure Performer is in overdub 

record mode so that each new pass doesn’t erase the last one. 

If you want to permanently loop a region in one or more tracks and 

specify the number of times the loop will repeat, insert a loop as 

described in chapter 13, “Looping”. 

Click on the Memory-cycle button to enable it. This highlights it, and 

causes the Start and Stop times to appear in the Memory Bar if they 

are not already present. The next section discusses several ways to set 

the start and stop times. 

The Memory-cycle button and the Auto-Stop button cannot be 

enabled at the same time. 

Viewing Memory-Cycle When Memory Cycle is enabled, the start and stop times appear 

points graphically numerically in the Memory bar just below the Memory buttons. They 

also appear graphically as repeat barlines in the Time Ruler of the 

Tracks Overview and Graphic Editing windows at the Start and Stop 

time as shown below: 
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Memory-cycle 
button is activated. 

Repeat barlines are displayed in all time rulers. They can 
be dragged left and right; when you drag them in the 
Graphic Editing, they snap to the current edit resolution. 

Setting Memory-cycle 
points 

The Consolidated Controls Panel 

Memory bar start and stop 
times are displayed here. You 
can change them by typing or 

i. a by clicking the Start and Stop 
buttons on the fly during 
playback. 

Edit resolution 

Playback cycles between these points seamlessly. You can drag the 

repeat barlines left and right with the mouse to change the cycle 

points. If the edit resolution check box is checked, the barlines snap 

to the current resolution setting (such as 8th notes, for example) as 

you drag them. For an explanation of edit resolution, see “The Edit 

Resolution Box” on page 292. 

You can adjust the cycle points at any time, even during playback. 

This lets you build patterns and other tasks without ever having to 

stop the music. 

The Memory-cycle region is defined by the Start and Stop times in the 

Memory Bar. You can set these points by typing them into the 

memory bar. You can also set them by selecting a region in the time 

ruler of the Tracks overview or any Graphic Editing window. To do 

SO: 
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1. Set the Edit resolution in the time ruler. 

If you want the end points to land directly on beat or measure 

boundaries, the easiest way to do so is to set the edit resolution to 

an appropriate value, such as eighth notes or quarter notes. If you 

want to be able to set the loop points with no constraints 

whatsoever, uncheck the edit resolution box. 

2. Drag over the desired region in any time ruler. 

3. Choose Remember Times from the Basics menu, or press 

command-R. 

Doing so causes Performer to store the end-points of the region 

you have selected. 

4. Highlight the Memory-cycle button if it is not already highlighted. 

5. Click the word “Memory” in the memory bar. 

The region is loaded into the Memory Start and Stop times. In 

addition, the Memory-cycle repeat barlines appear in the time 

rulers at the beginning and end of the region you highlighted. 

Now Performer will cycle between them during playback and 

recording. 

Selecting the Memory- If you would like to quickly select the region within the Memory- 

cycle region for editing cycle repeat barlines to insert a loop, quantize, or any other editing 

operation, double-click one of the two repeat barlines. 

The Countoff Enabling the Countoff button causes a countoff of a specified number 

button of measures before playback or recording. The Counter does not 

move forward until after the countoff. Clicking on the Countoff 

button enables and highlights it. You must enable the Click or Flash 

(in the Basics menu) to hear or see the countoff. 
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To set the number of countoff measures, either double-click or 

Option-click on the Countoff button. A dialog box appears in which 

you can enter the number of measures and specify whether the 

countoff should occur only when recording. If the Countoff only 

when recording option is chosen, there will be a countoff before 

recording, but not before playback or any other function. 

The countoff bars are in the same meter as the first measure of the 

sequence. See the Change Meter chapter for information on changing 

meters. 

Use the Countoff button to give yourself time to adjust to the current 

tempo and prepare for recording. Using the Countoff and Wait 

buttons allows ample preparation for a recording pass; this is 

particularly useful in situations where the computer and keyboard are 

not adjacent. 

Enabling the Wait button causes Performer to wait until it receives a 

keystroke from a MIDI or Macintosh keyboard before playback or 

recording. 

To enable the Wait button, click on it; it will highlight. Then, press 

either the Record or Play buttons. The wait button will then begin to 

flash, signaling that it is waiting for a keystroke. To start playback or 

recording, press a key on the Macintosh keyboard or your MIDI 

controller instrument. If recording is enabled, the MIDI event you 

send to turn off Wait will be recorded. 

The Wait button will remain enabled until it is clicked off. Thus, it will 

be in effect every time the Record or Play button is clicked on. 

Use Wait to give yourself a moment to ready yourself at your 

keyboard or other input instrument before recording. Using Countoff 

and Wait together allow you as much time as you need to prepare for 

recording. 

While the Wait button is on, you can use the Rewind button, Position 

Bar, and Counter window to adjust the current playback location. 

You may also set times in the Edit, Memory, and Auto-Record bars. 
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The Auto- Auto-Record causes recording to automatically turn on and off in a 

Record button specific region. This allows you to record without having to manually 

enable and disable the Record button. 

Clicking on the Auto-Record button enables and highlights it. 

Clicking on the Auto-Record button also causes the Auto Record 

punch in and punch out times to appear in the Status Strip. Punch in 

and punch out times are specified in the Auto Record Bar: Punch in 

is the time where recording begins; Punch out is where recording 

ends. Auto-Record can be used while Performer is slaved to external 

sync; see the chapter Receive Sync for details on recording while 

slaved to each type of sync. 

The Auto-Record button will remain on until you click on it again to 

disable it. Remember to disable it when you finish using it. 

To use Auto-Record: 

1. Activate the Tracks window by clicking in it. 

2. Click on the Record-Enable button of a track. 

3. Press the Auto-Record button, which is located below the 

transport controls. 

The button highlights to signify that Auto-Record is on. 

4. Enter the Punch In and Punch Out locations. 

The Punch In location is where Recording will begin. The Punch 

Out location is where Recording will end. You can enter them in 

numerically in the Auto Record Bar. You can also set them up 

graphically. See “The Memory and Auto Record Bars” on page 81 

and “Setting the punch-in and punch-out points graphically” on 

page 77. 

5. Move to a location in the sequence before the Punch In point. 

This location should be a spot that will give you plenty of time to 

prepare to enter the new material, anywhere from a whole section 

to a few bars before the Punch In point. 

6. Get ready to record. 
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punch-out points 
graphically 
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7. Press the Record button. 

The sequence plays from the current location in the Counter. The 

Record button is initially flashing (or greyed out on a black and 

white screen). When the Punch In time is reached, the button 

becomes highlighted. When this happens, Performer is recording 

and you can enter the new material. When the Punch Out time is 

reached, the Record button will revert to flashing or (being gray 

on a black and white screen). 

8. Press the Stop button when you are finished. 

If Performer starts recording while a pre-existing note is sustaining, it 

does not cut off that note. Only notes with attack times after the 

punch in time are erased. For example, the two notes represented by 

light grey bars begin within the punch in region, but the sustained 

note represented by the dark grey bar begins before the punch in 

point: 

Punch-in Punch-out 

After recording, the notes that began before punch in remain, but the 

notes that begin within the recorded region are replaced by the new 

material: 

Newly 
recorded 

material 

SIMPL MMM 

Anything you play while the Record button is grey is not recorded. 

This allows you to play along with the sequence and only record 

between the Punch In and Out times. 

When Auto-Record is enabled, the punch-in and punch-out times are 

displayed graphically as arrows in the time ruler of the Tracks 

Overview, as well as the time ruler in any Graphic Editing window. 
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Auto-record button otal Auto-record bar start and stop 
is activated. times are displayed here. You 

can change them by typing or 
by clicking the Start and Stop 
buttons on the fly during 
playback. 

Punch points are displayed in all time rulers. They can be 
dragged left and right; when you drag them in the Graphic 
Editing, they snap to the current edit resolution. 

You can drag the arrows left and right with the mouse to change the 

punch-in and punch-out points. If the edit resolution check box is 

checked, the arrows snap to the current resolution setting (such as 

8th notes, for example) as you drag them. For an explanation of edit 

resolution, see “The Edit Resolution Box” on page 292. 

You can adjust the arrows at any time, even during playback or 

recording. This lets you adjust punch-in and punch-out on the fly 

without having to stop the music. 

Quickly selecting what You can quickly select the region between the punch points by 

you have recorded double-clicking one of the arrows. This is a handy shortcut for editing 

what you have just recorded with auto-record. 

The Chunk The Skip Forward and Backwards buttons play-enable the next or 

previous Chunk (sequence or song) listed in the Chunks window. 

Control buttons The Cue Chunks button play-enables the next Chunk in the list after 

the current Chunk plays to its end time and stops. The Chain Chunks 

button causes the next Chunk in the list to automatically begin 

playing when the current Chunk finishes playback. 
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Chaining using the 
Controls window 
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The Chunk cueing buttons in the Controls window allow automatic 

and real-time cueing of Chunks, and automatic playback of cued 

Chunks. The Cue Chunks, Chain Chunks, and Skip Forward and 

Backwards buttons let you play Chunks from the Chunks window, 

moving up or down the list at your command. 

Chunk cueing does not yield seamless transitions between Chunks. 

Use them for cueing situations where a pause between Chunks— 

either brief or indefinite—is acceptable or preferred. 

For example, the Chunk Controls buttons are perfect for live 

performance. Before a set, you could organize the Chunks list in the 

order you wish for the set. Then, before you begin, you could enable 

the Wait button. To begin the set, you simply press play. When the 

first song ends, the next song automatically cues up, and you can 

trigger it at your leisure from your MIDI keyboard. Or, without the 

Wait button, you can have Performer go right into the next song 

without waiting. 

It is also possible to cue and play Chunks remotely from your MIDI 

controller. For more information, please refer to The Remote Controls 

Window chapter. 

Clicking either the Cue Chunks or Chain Chunks button causes the 

Memory Bar to appear in the Status Strip. The Stop time displayed in 

the Memory Bar indicates the measure time at which the current 

Chunk will stop playing and the next Chunk will be cued. This time 

appears automatically when a Chunk is cued; it corresponds to the 

Chunk’s End time in the Chunks window. 

You can edit the Memory Bar time by clicking it, but this change lasts 

only until the next Chunk is enabled. If you wish a different End time 

to appear in the Memory Bar automatically for a particular Chunk, 

pop-edit the End time in the Chunks window. Simply click the Chunk 

name and choose Auto/manual end time from the Chunks window 

mini-menu. The time becomes bold and editable. Remember that the 

End time only affects a sequence’s playback length when using the 

Chunk control buttons, not when the Chunk is played as part of a 

SOng. 

19 



The Cue Chunks button 

The Chain Chunks 
button 

Viewing the Chunk End 
Time 

Chain Chunks (or Cue 
Chunks) button is activated. 

A barline is displayed in all time 
rulers to indicate the end time of 
the sequence. This is the point at 

The Cue Chunks button, when highlighted, play-enables the next 

Chunk in the Chunks list after the current playback Chunk reaches its 

End time and stops. 

To begin playback of the next Chunk, press the Play button, or a 

remote control for the Play button. 

The Chain Chunks button, when highlighted, starts playback of the 

next Chunk in the list after the current playback Chunk reaches its 

End time. This is a simple way of automatically chaining Chunks in 

their Chunks list order. 

Chaining with this button does not yield seamless transitions between 

Chunks. Use it for cueing situations where a brief pause between 

Chunks is acceptable or preferred. For seamless chaining, assemble 

Chunks in a Song window. For more information, please refer to the 

Song window chapter. 

When the Cue Chunks or Chain Chunks button is highlighted, the 

end time of the sequence is graphically displayed as a final barline in 

the time ruler of the Tracks Overview or any Graphic Editing 

window. 

which it will stop before the next 

sequence will be cued. 
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The Skip Forward and 
Backwards buttons 

The Status Strip 

The Memory and Auto 
Record Bars 

The Memory Bar 
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The Skip buttons enable the next or previous Chunk for playback. 

Clicking these buttons is similar to pressing the skip buttons on a 

typical compact disc player: Performer stops playback of the current 

Chunk and starts playback of the next or previous Chunk. Chaining 

Chunks in this manner does not yield seamless transitions between 

Chunks. To chain Chunks seamlessly, chain them inside a song as 

described in the Song Window chapter. 

The Status Strip has three segments that display information. The left- 

hand segment displays the name of the file. The middle segment 

contains the Memory and Auto record bars, which contain locations 

for Memory functions and Auto-Record. The right-hand segment 

displays the currently play-enabled Chunk. 

The Memory and Auto-Record bars appear in the Status Strip when 

you click one of the memory buttons or the Auto-Record button. 

Clicking directly on the measure-time fields (measure | beat I tick) in 

either bar will highlight them for editing as shown below. 

Click on the desired field and type in a number. The Tab key 

advances to the next field to the right. The Return key confirms the 

entry. It is important to remember that these bars are displayed only 

when their respective function is enabled. For example, the Auto- 

Record bar is only visible when Auto-Record is enabled. If both are 

enabled, both bars will appear in the Status Strip. 

The Memory Bar displays the start and stop times for Auto-Stop, 

Auto-Rewind, and Memory-cycle (see above). To deactivate the 

Memory Bar, turn off the currently enabled Memory button by 

clicking it. 
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Each of the words in the Memory Bar can be clicked on as a shortcut 

for entering times: 

Clicking on the word “Start” or “Stop” will load them with the current 

play location in the Counter. 

Double-clicking on the word “Start” will load it with the start time of 

the current sequence. 

Double-clicking on the word “Stop” will load it with the end time of 

the current sequence. 

Clicking on the word “Memory” will set both the Start and Stop times 

to the remembered times. Remembered times are Start and Stop times 

stored with the Remember Times command in the Basics menu. For 

more information, see Remember Times in the Event List Window 

chapter. 

Double-clicking on the word “Memory” is a shortcut for double- 

clicking on both the Start and Stop times: it loads them with the start 

and end times of the current sequence. 

The Rewind button works differently when the Memory Bar is visible: 

clicking on the Rewind button once will rewind to the Start time in 

the Memory Bar; clicking on it again will rewind to the beginning of 

the sequence. 

Memory bar times can also be loaded by selecting the region 

graphically. See “Setting Memory-cycle points” on page 73. 

The Auto Record Bar will appear when the Auto Record button is 

enabled. When it is visible, Auto Record is in effect. 

Each of the words in the Auto Record Bar can be clicked on as a 

shortcut for entering times: 

Clicking on the words “In” or “Out” will load them with the current 

play location in the Counter. 
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Double-clicking on the word “In” will load it with the start time of the 

current sequence. 

Double-clicking on the word “Out” will load it with the end time of 

the current sequence. 

Clicking on the words “Auto Record” will set both the In and Out 

times to the remembered times. For more information about 

remembered times, see the Event List Window chapter section on 

Remember Times. 

Double-clicking on the words “Auto Record” is a shortcut for double- 

clicking on both the In and Out times: it loads them with the start and 

end times of the current sequence. 

Auto Record bar times can also be loaded by selecting the region 

graphically. See “Setting the punch-in and punch-out points 

graphically” on page 77. 

The main Controls window functions can be operated from the 

numeric keypad on the Macintosh extended keyboard. 

Click 
EARS 

‘ower : 

In addition, the space bar acts as a play/stop toggle. These key 

assignments are provided for your convenience. However, you can 

create your own customize key assignments using the Remote 

Controls window. Please refer to the chapter called The Remote 

Controls Window for more information. 
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The Metr onome The Metronome panel displays the tempo and meter of the currently 

panel play-enabled Chunk (sequence or song). 

beat value Tempo control 
button 

= ; ™ = ; ; slide - _ | 

Current 

meter 133.12 bp eres 

Tempo slider 

The Tempo Control Tempo can be controlled by one of three possible sources: 

button 
a The Tempo slider 

= The Conductor track 

= By remote control from an external MIDI controller, such 

as a modulation wheel 

The Tempo Control button displays the current tempo source. Click 

it to change it. You can change the tempo source at any time, and the 

tempos you set in each mode are remembered. In addition, the 

tempo control settings saved with each Chunk. 

Tempo slider 
When the Tempo Control is set to Tempo Slider, you can change 

tempo by entering a value in the tempo box in the Metronome 

window or by dragging the slider with the mouse or by pressing the 

+ and - buttons. Tempo is expressed in beats per minute (bpm). Any 

programmed tempo changes (the tempo map) are ignored. You 

control the tempo directly with the tempo box and slider. This mode 

is useful for Chunks with one constant tempo or for temporarily 

adjusting tempos when working on a Chunk. 

Conductor Track 
When the Tempo Control is set to Conductor Track, you cannot use 

the tempo box or slider to set the tempo. Instead, the tempo map in 

the Conductor track takes control of the Chunk. In this mode, the 
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tempo slider is merely an indicator of the current tempo; the plus/ 

minus buttons become disabled and you cannot change the tempo or 

beat value directly. 

To hear tempo changes that you create with the Change Tempo 

command or by using Tap tempo sync, set the Tempo Control to 

Conductor Track, where programmed tempo changes and tempo 

maps are stored. 

Remote control of the tempo 
When the Tempo Control is set to Remote Control, the tempo slider 

can be controlled from an external MIDI source such as a modulation 

wheel on a MIDI keyboard, or any other source of continuous 

controller data. 

To set up the Tempo slider for external MIDI control: 

1. Choose Remote Control from the Tempo Control pop-up menu. 

2. Choose Set Remote Source from the Tempo Control pop-up menu. 

A dialog box appears. 

Metronome Source 

3. Select the MIDI device from which the external control data will be 

received from the pop-up menu provided. 

4. Select which type of MIDI data will be used to control the slider. 

Modulation wheels send controller #1. 
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5. Click OK to confirm your choice or Cancel to withdraw the 

command. 

The meter at the current location is displayed for your reference. To 

change meter, you must use the Change Meter command on the 

Change menu. 

The beat value is the note duration that “gets the beat” in a given 

meter. In 4/4, for example, the quarter note usually gets the beat: in 

this case, the beat value is a quarter note. In 6/8, the beat generally 

falls on the first and fourth eighth notes in the measure, thus the 

dotted quarter is the beat value. 

The beat value you set does not necessarily correspond to the value 

you set for the metronome click. The metronome click value is set 

when specifying the meter with the Change Meter command on the 

Change menu. For example, in 6/8 meter, you may set a tempo of an 

eighth note = 220, but, set the metronome click to a dotted quarter 

note (standard in 6/8 time). Quite often though, the beat value will 

be the same as the meter denominator (the lower number of the 

meter marking). 

When the Tempo Control pop-up menu is set to Tempo Slider, the 

tempo slider is used to display and change the tempo. To change 

tempo, drag the triangular indicator along the slider: to the left 

decreases the tempo, to the right increases it. You can also use the 

plus/minus buttons at either end of the slider: the + (plus) button 

increases the tempo and the — Gninus) button decreases it. 

When the Tempo Control pop-up menu is set to Conductor track, the 

tempo slider serves only as an indicator of the current programmed 

tempo; it cannot be dragged with the mouse. 

Tempos are displayed in beats per minute (bpm). The beat value can 

be any standard musical duration between a sixteenth and whole 

note. All beat values can be dotted. A dotted value is equivalent to 

one and a half times the value of the duration. (A dotted quarter note 

is equivalent to one and a half quarter notes, for example.) Tempos 

are displayed and entered with an accuracy of a hundredth of a beat 

per minute. This allows you to specify tempos with two numbers to 

the right of the decimal point, e.g. 104.78 beats per minute. In 
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addition to providing you with a high degree of resolution, this also 

allows you to easily enter tempos that match standard frame click 

metronome values. 

When the tempo slider is controlling tempo, you can enter the tempo 

directly into the Current tempo box. To change the tempo, click the 

current tempo box to edit the tempo. If necessary, click the current 

beat value to change it. 

When Performer is slaved to external syne using the Standard MIDI 

beat clocks mode, the master device generates the tempo. The tempo 

slider acts solely as an indicator in this case: the master device (drum 

machine, a hardware sequencer, etc.) has complete control over 

Performer’s tempo, and the tempo control displays the phrase MIDI 

Sync to remind you that the Tempo slider is disabled because tempos 

are being generated externally by the master device: 

When synchronizing to time code (such as SMPTE) using the Indirect 

or Direct lock modes, Performer follows its own internal tempo. Set 

the desired tempo in the normal fashion, or set the Tempo Control 

pop-up menu to Conductor track to use a tempo map you have 

programmed into the Conductor track. 

When synchronizing to Tap tempo sync, you control the tempo in 

real time by tapping (sending a MIDI event to Performer), using any 
MIDI controller. For details on creating a tempo map using Tap 

tempo sync, refer to the chapter Receive Sync. When you choose Tap 

tempo and check the Slave to external sync command in the Basics 

menu, the Tempo slider is disabled and it reminds you why: 
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Performer automatically adjusts real time and frame locations when 

the current tempo is changed. 

The Counter displays the current playback position in the currently 

play-enabled Chunk (sequence or song), expressed in three different 

forms: measure time (measure | beat | tick), real time (minutes:second- 

s.hundredths) and frame time (hours:minutes:seconds:frames). Two 

of these formats can be displayed at the same time: one as a main 

counter and the other as an auxiliary counter. These time standards 

are explained in detail in the next few sections. 

You can edit the counter fields to change the current location. You 

can change which time formats are displayed by clicking the time 

format icons. 

Measure time is the most musical of the time formats. Locations are 

displayed in standard measures and beats, with an additional unit 

called the tick. Unless you are doing film or video work, it is probably 

the only time representation you will need (though you may want to 

use real time for an objective measurement of the length of your 

sequence). The three units are separated by vertical bars. The 

example shown below shows measure 4, beat 3, tick 130. 

Performer uses a resolution of 480 ticks per quarter note. Events can 

thus be recorded and played back with an accuracy of 1/480 of a 

quarter note. 

Real time is clock time, i.e. time expressed in minutes:seconds.hun- 

dredths of a second. Real time is useful to measure elapsed time for 

your sequence. By default, the sequence begins at time 0:00.00; this 

can be changed with the Set Sequence Start command described later 

in this chapter. 
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Frame time is a visual display of SMPTE (Society of Motion Picture 

and Television Engineers) time code. It is generally used in film and 

video work, but is increasingly used for synchronization in audio 

production. It is displayed similarly to real time, in hours, minutes, 

seconds, and frames. Frames are subdivisions of a second. The first 

frame number in a second is zero. Performer supports four frame 

formats: 24 frames per second (fps), 25 fps, 30 fps, and 30 drop 

frame. 

When synchronizing to an external time code source, the counter will 

always display the same frame time that is being received from the 

external source. You may specify the SMPTE location at which the 

first measure of the sequence or song starts. 

The current playback location is the position where the Chunk will 

next play or record from. You can edit the counter fields to change 

the current location. 

You can change the current location in the currently play-enabled 

Chunk (sequence or song) by editing the counter numbers. This can 

be done while the Chunk is stopped or playing. If you edit the 

counter while the Chunk is playing, it will continue to play while you 

enter the values and will cue to the new location after you confirm 

your edit. To edit the counter: 

1. Click on the time value you wish to change. 

The number field will highlight. 

2. Enter the number you want. 

You can only enter valid values (e.g. you can’t enter 27 frames if 

you’ve chosen a 25-frame standard). Use the Tab key to move 

from one value field to the next. The decimal point on the keypad 

can also be used to cycle through fields. If you make a mistake in 

entering a value, press the Backspace key or click on the field 

again and re-enter the value. 

3. Click outside the highlighted number field or hit the Return key. 
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The decimal key on the Mac keypad will now highlight the main 

counter, even if it is SMPTE time or Real time. 

There is a shortcut for setting the measure time: using command-T or 

the decimal point on the keypad will select the measure field and set 

the beat field to 1 and the tick field to 000. You may then enter the 

number of the measure you want to move to. As soon as you click 

outside the highlighted field or press the Return key, the specified 

value will be entered. 

These keys will always edit main the counter, even when it is set to 

SMPTE time or Real time. 

To change which time format is shown in the Main or Auxiliary 

Counter, click the time format button in the right-hand side of the 

Counter. 

Format buttons 

The Counter displays dashes when no sequence or song is play- 

enabled in the file. To display numbers, play-enable a Chunk in the 

Chunks window. 

During playback, the measure time counter is updated each time a 

metronome click would occur. If the click value is set to a half note 

in 4/4 time, only beats 1 and 3 will display in each measure. The click 

value can be set with the Change Meter command on the Change 

menu. 

The start time of the sequence is what you see in the counter when 

you rewind to the very beginning. Normally, the default start time for 

a sequence or song is measure time 1111000, real time 0:00.00 and 

frame time 0:00:00:00. 

You can, however, use the Start Time button to change these start 

times to anything you want. 
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Start time button 

If you are synchronizing Performer to SMPTE time code, you'll need 

to set the SMPTE start time according to SMPTE frame at which you 

want the Performer to begin playing. For example, you may want the 

downbeat of the first measure in the sequence to begin playing when 

the time code reaches 1:00:20:00. 

The following are other examples of situations in which you might 

want to change the sequence start time: 

m You would like to create one or more pickup measures 

before measure 1 (1111000). 

m Your sequence should begin with a measure time other 

than measure 1 to match its location in a song. (For more 

information, see “Matching chunk start times with their 

location in a song” on page 230.) 

The start times you enter for measure and real time are arbitrary and 

only affect the display of time locations. The SMPTE time code start 

time, however, determines the frame at which the sequence will 

actually begin playing while Performer is slaved to external time 

code. 

To set the start times of a sequence or song: 

1. If you have more than one sequence or song in the file, make sure 

it is the currently play-enabled chunk. 

To do so, look at the current chunk indicator in the main control 

panel. If you need to switch sequences, use the Skip buttons. 
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Current sequence or song 

2. Click the Start Time button in the main counter. 

A dialog box appears. The current Chunk name is displayed near 

the top of the dialog box. 

Set Chunk Start 

3. Click on the value(s) you wish to change. 

4. Enter the new value(s). 

You may enter a value for each of the three time formats. Measure 

values range from -9999 to 9999. Real time ranges from 0:00.00 to 

59:59.99. Frame time ranges from 0:00:00:00 to 23:59:59:30. 

5. Click on OK to confirm your choice or Cancel to cancel it. 

In addition to the start frame, you may offset the SMPTE start time by 

a number of bits. There are 80 bits per frame. Although Performer 

does not have single bit time resolution, it does offer sub-frame time 

resolution. Use the bit offset to finely adjust the start time. 
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The SMPTE frame rate can be set with Receive Sync command in the 

Basics menu. See “Slaving to SMPTE with MTC, DTL, or DTLe” on 

page 609. 

Normally, when you rewind Performer back to the beginning of the 

sequence, the measure counter reads 1! 11000. But sometimes you 

may have several pickup beats (or measures) in your music, and you 

may still want the music at measure 1 to remain at measure 1. If so, 

you can create as many pickup measures before 1!111!000 as you 

need. 

To create a pickup measure: 

s¥ As described in the previous section, set the measure start time of 

the sequence to 0 to create 1 pickup measure. 

If you need two pickup measures, set the Measure start time to -1. 

If you need 4 bars, set it to -3. 

. Now, when you press Rewind back to the beginning of the 

sequence, the Counter window will read 0111000. 

If you set up two or four pickup measures instead of only one, the 

counter would read -11!11000 or -31 11000 respectively. 

If you already had data recorded in the sequence, shift the data 

back to its original location. 

When you change the Measure start time, data that used to be at 

1111000 is now at 0111000, and so on. All data has changed to 

match the new start time. To restore all data to its original position 

before you changed the start time, use the Shift command to shift 
it back to where it was before. 

Highlight all track names in the Tracks window and double-click 

the word “Edit” in the Edit bar. 

This selects the entire sequence. 

Choose Shift from the Edit menu. 
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6. Choose the Delay option and type in the number of pickup 

measures that you previously added. 

If you added 1 pickup measure by setting the start time to 

0111000, shift by 1 measure here. 

7. Click OK. 

You have now successfully restored all data back to its original 

location before changing the measure start time, and you also have 

several empty pickup measures in which to record. 

Performer’s first priority is to keep up with the flow of MIDI data. If 

it encounters a great deal of data, it selectively ignores its graphic 

display until the microprocessor load decreases. This may keep the 

counters from updating and they may skip beats during these times. 

This is Performer’s way of keeping up, and does not necessarily mean 

that MIDI data is being transmitted inaccurately. 

A side effect of this is that the counter may not always be accurate. It 

should therefore not be used as a metronome. In general, the counter 

display should not be used as a visual indication of tempo. Use the 

Flash on the Basics menu instead. 

During playback, the measure time counter is updated each time a 

metronome click would occur. For example, if the click value of the 

current meter in the sequence is set to a half note in 4/4 time, only 

beats 1 and 3 will display in each measure. The click value can be set 

with the Change Meter command on the Change menu. 
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Negative numbers in the When using an external sync source, Performer may run for a little 

counter display while before the sequence actually starts. During this time, you may 
see negative bar numbers. These increase in value (towards zero) 

until the start measure is reached. 
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Chapter 6 The Remote Controls Window 

The Remote Controls window lets you access all of Performer’s 

transport functions, such as play, stop, rewind, and so on from a 

MIDI controller. For example, a note value of CO could operate the 

Stop button in the Controls window; controller 64 On could operate 

the Skip Forward button. In addition, each Performer function has a 

reassignable Macintosh keyboard equivalent. 

The Remote Controls window also allows you to cue sequence and 

song Chunks for playback from your MIDI controller. Each Chunk in 

the file appears as a Function in the Remote Control window with a 

MIDI and Macintosh key to play-enable that Chunk. 
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Quick Reference 

Remote Master ————» | 

Group Master contro» 

Individual control— > 

Master status icon ———»> 

The Remote Controls window is opened by choosing it from the 

Windows menu. For your convenience, new Performer files contain 

both the Transport and Chunk Select controls with default MIDI and 

Macintosh key assignments ready to use. 

Remote Master: Enables or disables all MIDI Remote Controls and 

Master Controls. It remains at the top of the list and cannot be moved 

or deleted. 
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Group Master Control: Enables or disables an entire group of MIDI 

Remote Controls with a single MIDI or Macintosh keystroke. Master 

controls can be moved, added, deleted, and renamed. 

Individual Control: Displays a specific Performer function, and the 

MIDI event and Macintosh key assigned to trigger the function. An 

individual control is available when the Master above it is On; if a 

control has no Master, it is always on. 

Master Control Status Icon: Indicates the Master’s current status, either 

On or Off. The current mode is indicated by the text and color of the 

status icon: On and highlighted, or Offand white. 

Function: Defines the Performer function to be triggered. 

Event: Defines the MIDI event that will trigger the Performer function. 

To edit the event, click the field and play the new event, then press 

the Return, Enter, or arrow Keys. 

MIDI Controller: This is the MIDI device in your studio from which 

you would like to trigger the remote controls. A pop-up menu of 

devices is provided in this column by FreeMIDI. 

Mac Key: Defines the Macintosh key (or keys) that will trigger the 

Performer function. To change the key, click it, press the new key(s), 

and click outside the box to confirm your choice. 

The Remote Controls window mini-menu contains the following 

items. 

Add Defaults: Adds the Transport Master and group members, and the 

Chunk Select Master with a control for each Chunk in the file. 

Add Master: Adds a Master control to the bottom of the functions list. 

This new Master can be moved and assigned MIDI and Macintosh 

triggers. 

Duplicate: Add a duplicate of the selected item(s) to the bottom of the 

Remote Controls function list. 

Delete: Deletes the highlighted Masters and controls. Select functions 

by clicking them. Select contiguous functions by dragging. Select 

discontiguous functions by shift-clicking. 
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The Remote Controls window lists each Performer function along 

with its assignments, and allows you to edit these assignments to 

completely customize your Remote Controls. Further, you can load 

the assignments you make into any other Performer file, or even 

make them part of every new file using the Save As ‘New’ Template 

command. 

There are two types of controls: individual, for example Play or Stop, 

and Master, such as the Transport Controls Master. Individual controls 

are grouped under Master controls, which enable and disable their 

group when toggled with a MIDI event or a key on your Macintosh 

keyboard. Individual controls actually operate Performer functions, 

whereas Master controls make a group of individual controls 

available or unavailable. 

Every new Performer file automatically contains several Master 

controls: the Remote Master, the Transport Controls Master, the Step 

Record Controls Master, and the Chunk Select Master. Each one 

serves as a toggle, rendering its sub-group of controls available or 

unavailable. To customize Remote Controls, you can add your own 

Masters and change their assignments whenever you wish. 

A Master’s control group is displayed as an indented list beneath that 

Master. Each indented control can be moved into another indented 

group, thereby redefining which Master will affect it, by simply 

dragging the control’s icon up or down in the window. Likewise a 

Master can be dragged to a different position to redefine its control 

group. 

At any given time, a Master control is either On or Off. Correspond- 

ingly, the Master’s status icon displays On and is highlighted, or Off 

and is dark. 

On and inverted means that the functions under that Master are 

available. When the Master icon is Off and highlighted, the MIDI 

controls of the group under that Master are unavailable; each 

function’s trigger acts as a normal MIDI event. Macintosh controls are 

always available, regardless of the On/Off status. 

The combinations of Master status and individual control status make 

Performer’s Remote Controls extremely flexible. Here are some 

typical Remote Controls setups: 
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a The controls occupy an infrequently used range of your 

MIDI controller, and are always on. You don’t typically use 

this octave in your sequences. 

a» The controls occupy several keys of a MIDI controller 

transmitting on one channel, and on another channel you 

have a second controller for recording. 

a The controls occupy the entire span of keys on your 

controller, and you can toggle them on and off with a 

single key at the very top of the keyboard. The entire 

keyboard can switch instantly between remote controls 

and MIDI notes. 

Enabling and Disabling You can turn on and off the MIDI Remote Controls in the following 

Remote Controls ways: 

m Press option-escape (esc) 

m Click the Remote Master icon in the Remote Controls 

window 

m Play the MIDI event you have assigned to it 

Changing a Control’s Performer comes with a pre-defined set of Remote Controls for the 

Remote Assignments Transport and Chunk Select functions. You might find these defaults 
suitable for your working style. But should you wish to completely 

customize your Remote Controls, Performer makes it easy. 

To change the event assignments of a Performer function or Chunk 

select control: 

1. Choose Remote Controls from the Windows menu. 

The Remote Controls window opens or, if already open, becomes 

active. 

2. Click the MIDI assignment that you wish to change. 

The field pops up. If you wish to enter a note-off event, you must 

play and hold the note, then click the assignment. 

The Remote Controls Window 107 



Disabling a Single 
Control 

Creating Custom 
Control Groups 

102 

3. Play the MIDI event on the instrument you plan to use as the remote 

control device. 

Any MIDI event from any connected MIDI controller is suitable, 

although notes and switch controllers are easiest to use. The 

highlighted field updates to display the event you just played. 

4. Type Return or click anywhere outside the pop-up box to confirm 

the change. 

Typing the up or down arrow confirms the change and pops up 

the previous or next event, respectively. 

5. Choose the MIIDI device and channel that you will be triggering the 

remote from. 

6. Click the Macintosh keyboard equivalent that you wish to change. 

The field highlights. 

7. Type the new key combination on your Macintosh keyboard. 

Any key or combination of normal and modifier keys is suitable. 

8. Click anywhere else on the screen. 

Because of its unique function, this pop-up box cannot be 

confirmed using the Enter or Return key. The box can be exited 

only by clicking and cannot be canceled. 

To turn off an individual control click the MIDI assignment for a 

remote control and then backspace in the pop-up box. 

This is especially helpful with the Remote Master to avoid enabling 

the remote controls by accident over MIDI. Also, having lots of MIDI 

assignments in the Remote Controls window can sometimes cause 

delays when using Patch Thru. If you delete unused MIDI 

assignments from remote controls, you can prevent delays. 

Performer lets you add your own Master controls, which you can use 

to toggle on and off whole groups of individual controls. Just like the 

default Masters that Performer provides (Remote, Transport, and 

Chunk Select), the Master you add governs all controls indented 

beneath it. You can drag both Master and individual controls up or 

down in the Remote Controls window to determine their grouping. 
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To add a new Master control: 

—_s . Click anywhere in the Remote Controls window to activate it. 

2. Choose Add Master from the Remote Controls window mini-menu. 

The added Master control appears at the bottom of the Function 

list. 

” Option-click the name of the added Master to change it. 

Type Return to confirm the change. 

4. Click the Event field of the new Master to assign a MIDI event. 

The field pops up. 

o1 . Assign MIDI and Macintosh key events to the new Master. 

Refer to the section called Changing a control’s remote 

assignments for details. 

6. As mentioned, the position of a Master determines what group of 

controls it will affect. Since a newly added Master appears at the 

bottom of the Functions list, you will need to reposition the added 

Master using its icon. You can also drag individual controls from 

Master to Master. 

To reposition a Master or individual control: 

1. Drag the control’s icon to the desired group. 

2. Release a Master just above the group; release an individual 

control beneath the Master that should control it. 

An individual control dragged above the first group’s Master will 

be controlled by the Remote Master. 

To delete a control or group of controls: 

1. Click the name of the control to select it. 

Drag to select several contiguous controls; shift-click and shift- 

drag to select discontiguous controls. 
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2. Choose Delete from the Remote Controls window mini-menu. 

The selected controls disappear from the list. Their MIDI and 

Macintosh keyboard assignments cannot be retrieved. 

Restoring Deleted In the oe that you delete controls during a session and then decide 

Controls you'd like to retrieve them, Performer provides a quick mini-menu 
command to regenerate both sets of default controls. Choosing Add 

Defaults places the Transport and Chunk controls at the bottom of the 

functions list; you can arrange, reassign, and delete them to your 

satisfaction. 

The MIDI and Macintosh key event assignments of controls that you 

delete are not held in memory. Once you delete a control, restoring 

it using Add Defaults will produce the default controls with the 

default assignments. If you wish to save your custom event 

assignments, just make sure they are present when you close the file. 

The next time you open the file, your customized controls will be 

intact. 

Loading Remote Remote Controls assignments from one Performer file can be 

Controls Assignments imported into any other Performer file using the Load command, 
From Another File found in the File menu. This means you can set up the Controls the 

way you like them, once, and they'll be available for importing into 

any of your files. 

The Remote Controls assignments that you make in a file are 

automatically saved as part of that file. The Load dialog box, 

however, enables you to extract assignments from an unopened file, 

then load them into the file in which you are working. 

To load Remote Controls assignments into an open file: 

1. Choose Load from the File menu. 

The standard Macintosh Open dialog box appears. 

2. Click the file containing the assignments you wish to load, then 

click Open. 

Alternately, you can double-click the file name. Performer’s Load 

dialog box appears, displaying the file name at top. 

3. Choose the Load Remote Controls option. 
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The Remote Controls Window 

4. Optional: If you wish to load any Chunks from the selected file, 

choose the Load Chunks option and the Data or Link sub-option. 

If you wish to load more than one Chunk, you can drag to select 

contiguous Chunks and shift-click to select discontiguous Chunks. 

Deselecting this option loads only the file’s Remote Controls 

assignments. 

Click OK to confirm your choice(s) or Cancel to withdraw the Load 

command. 

Clicking OK causes the selected file’s Remote Controls 

assignments, as well as any selected Chunks, to be loaded into the 

open file. The imported assignments appear at the bottom of the 

Remote Controls window. 

Performer has a default New file format that contains the Remote 

Master, the Transport Controls Master and functions, and the Chunk 

Select Master and individual functions. However, the Save as ‘New’ 

Template command in the File menu lets you define Performer’s New 

file as you like. 

To customize your New files: 

: Configure Performer’s windows, their contents, and any other 
features as you find most useful. 

This file will be your template source file: Performer will 

remember your exact track setup and layout as well as many other 

features. MIDI and Conductor track data will not be included in 

the New template. 

Choose Save as ‘New’ Template from the File menu. 

Click OK to confirm the command, Cancel to withdraw it. 

If you confirm the command, the New template of the open copy 

of Performer is redefined based on the current file. 

Performer’s spot-erase feature consists of the spot-erase remote 

control. Spot-erasing works like most conventional drum machines: 

you hold down the spot-erase key and then hold down the pitch of 

the note(s) you want to erase. 
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To spot-erase: 

1. Start playback or overdub recording. 

You can spot-erase while playing or overdub recording. You can 

spot-erase while using memory-cycle and while looping. 

2. Record-enable the track in which you want to spot-erase. 

3. Hold down the tilde key (~ ) and, while holding it down, hold down 

the notes you want to erase. 

If you like, you can reassign spot-erase to a different key. 

Alternately, you can hold down the spot-erase MIDI remote, 

which is DO (D-zero). Notice that you can spot-erase several notes 

at the same time—as many as you can manage, in fact. 

4. As Performer continues to play (or overdub record), keep holding 

down the note(s) you want to erase for as long as you want to erase 

them. 

If you want, you can release the spot erase key, even while you 

continue to hold down the notes you are erasing. The spot-erase 

key only needs to be held down when you first hold down the 

pitch(es) you want to erase. Once you’ve held down a pitch, you 

can release the spot-erase key. 

5. Release the key(s) when you want to finish spot-erasing. 

You can freely “punch-in” and out of spot-erase mode. Spot-erase is 

undoable. 

Notice that you can spot-erase directly from your MIDI controller 

using the MIDI event assignment for it. If you don’t normally use 

Performer’s Remote Controls feature, you can still use spot-erase 

without using any other remote controls because spot erase has its 

own group master. You can even trigger the spot erase using a foot 

switch, a data slider or wheel on your MIDI controller, or anything 

that can send MIDI data. That way, you can configure spot-erase as 

conveniently as possible. 

Switching MIDI devices, The Sound Selection group of remote controls lets you choose the 

channels and patches next or previous device, MIDI channel, or default patch for the 

currently selected track. If no track is selected, these commands affect 
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the currently record-enabled track. Along with the “record next/ 

previous track” remote, you can easily change tracks, devices, 

channels and sounds, all from your controller keyboard while 

recording. 

Several commands can be triggered in succession with one keystroke 

by assigning them to the same MIDI event. For example, you can 

create the following three-step sequence of remote controls: Stop, 

Chunk select, and Play. If you place them in that order in the Remote 

Controls List and assign them to the same key, Performer will execute 

the topmost control first. The current sequence will stop, and the 

specified Chunk will cue up and begin playing—all with one 

keystroke! 

Similarly, you can assign all of your Master controls to the same MIDI 

or Mac key event — that event now turns on and off your MIDI 

Remote Controls. 

In addition to Chunk select Remote Controls, Performer also allows 

you to cue Chunks for playback by sending a Song Select message 

from a MIDI controller. The Chunks window column S¥ displays the 

Song Select number that, when received, will cue the corresponding 

Chunk for playback. If a Chunk has no Song number assigned, the S# 

column displays a single dash (-). 

Most hardware sequencers and some MIDI keyboard controllers can 

send and receive Song Select messages. Simply send a Song Select 

message as instructed in that module’s documentation. If the open 

file contains a Chunk assigned to the Song number in the message, 

that Chunk will be play-enabled. If more than one Chunk has the 

same Song number assigned, the one highest in the Chunks list will 

be cued. 
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When used in combination with the Chunk Chaining buttons in the 

Controls window, a Song Select message cues the corresponding 

Chunk to be play-enabled or played back. The information bar in the 

Consolidated Control panel indicates which Chunk has been cued. 
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Chapter 7 Playback 

When Performer is “playing” music, it is sending out stored MIDI data 

at specified times to MIDI-equipped instruments. These instruments 

use the data as instructions for when to turn notes on and off, etc. 

Conceptually, it is similar to a player piano which uses a set of 

recorded data (the piano roll) to control its “instrument” (the piano 

mechanism). The synthesizer or sound module produces the actual 

sound, and Performer tells it when and how to do so. 

To play a sequence or a song: 

1. Open a Performer file. 

Choose Open from the File menu. A dialog box will appear. Select 

the file you wish to open by clicking on it and pressing the Open 

button. 

2. Choose Chunks from the Windows menu. 

The Chunks window will open or, if it is already open, come to 

the front. 

3. Play-enable the Chunk you wish to play back. 

Since a file can contain several Chunks (sequences or songs), you 

must play-enable the one you want. 

4. Set the location from which you want playback to begin. 

To simply rewind to the beginning of the sequence, click the 

Rewind button. To choose a general location, drag the Position 

Bar below the main transport controls; to start at a specific 

location other than the beginning, type in the location in the main 

counter. Or double-click at the desired playback location inside 

the time ruler in a Graphic Editing window. You can double-click 

in the Tracks overview time ruler as well. 
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5. Play-enable the tracks you wish to play back. 

If you are playing a sequence, double-click its name to open its 

Tracks window and click the Play-enable button to the left of the 

track name(s) you wish to hear. If the track is not play enabled, 

you will hear nothing from the track. If you are playing a song, 

play-enable the tracks in each sequence that the song contains. 

6. Choose a MIDI playback device for each track. 

A track can be assigned to one channel on a single MIDI device. 

It can also be assigned to several different MIDI devices simulta- 

neously. Devices can be set by clicking on the play destination in 

the Tracks window next to the track name. A pop-up menu 

appears. The devices in the list are provided by FreeMIDI. If a 

device you want is not present in the list, use the FreeMIDI Setup 

program to add the device to your MIDI configuration. 

Current device assignment 

FreeMIDI Devices 

Device groups 

New device group command 

Figure 7-1: Selecting a playback device from the pop-up menu in the Device column next to the track name. 

You can change a track’s playback channel or Device at any time— 

—even while the sequence is playing back. 
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7. Choose a sound from the track’s patch list by clicking in the Patch 

column next to the track name as shown below. 

Click in the Patch column 
next to the track to choose a 
sound for the track. For many 
popular MIDI devices, 
Performer provides a pop-up 
list of the factory-default 
sounds in the instrument. 

If you see generic names like this, you can 
go ahead and use them anyway, as long 
as you know what sounds correspond with 
each patch change number. Or you can 
modify the list so that it shows the actual 
sound names. For details, see chapter 48, 
“Using PatchList Manager” (page 725). 

8. Press the Play button. 

The sequence will begin to play. The Counter advances. 

9. When finished playing back, press the Stop button. 

When the sequence is finished, Performer will keep playing 

indefinitely until you press the Stop button. (This doesn’t 

endanger your sequence, though it is best to stop playback when 

the sequence is done.) 

Choosing a device for To choose a playback device, choose it from the pop-up menu 

playback provided in the Device column next to the track name as shown in 

Figure 7-1 on page 110. You can also do so from your Mac keyboard. 

See “Switching MIDI devices, channels and patches” on page 106. 
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Choosing multiple To assign a track to multiple playback devices, you need to assign it 

playback devices for a to a device group. You can either choose an existing device group as 
single track shown in Figure 7-1 on page 110, or create a new one by choosing 

New Device Group, which opens the Device Groups window 

(described in the next section). A device group can contain up to ten 

MIDI channels from any combination of devices in your MIDI setup. 

To create a device group, read the next section. 

@ Hint: if a track is currently assigned to a device group, 

and you want to make changes to the device group, 

option-click the device group name in the Tracks 

window next to the track and the Device Groups 

window will automatically open and scroll to the 

group. You can then make whatever changes you 

want. 

Creating a device group A device group is a collection of individual FreeMIDI devices—or 

more specifically, MIDI channels from FreeMIDI devices. For 

example, a device group called Massive String Pad might include the 

following device channels: Kurzweil K2000 channel 1, Korg 01/W 

channel 5, Akai S1000 channel 3, and Proteus/2 channel 13. As a 

result, the device group produces a combination of the sounds 

currently playing on each of these MIDI channels. A device group can 

contain up to 10 MIDI channels. 

Devices groups appear in the same pop-up list as all the rest of your 

FreeMIDI configuration devices, and they are used to assign multiple 

MIDI channels to a single track in the Tracks window. 

To create a device group: 

1. Choose Device Groups from the Windows menu to open the Device 

Groups window. 
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Click this expand/ 
compress icon to 
toggle the check box 
display shown here. 

Click the check boxes 
to quickly add MIDI 
channels to the 

device group. 

Click the expand/compress 
icon again to return to the 
normal display, which allows 
you to a default patch for 
each channel. 

2. Choose Add Device Group from the mini-menu. 

If you would like to add more than one at a time, hold down the 

option key while selecting the command from the mini-menu. 
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Here is a summary what you can do in this window: 

To do this: Do this: 

Change the device group name Option-click the name to pop-edit it. 

Add a device to the group Click the pop-up menu arrow 

beneath the device group name and 

choose the desired device and MIDI 

channel from the pop-up menu. 

Add several devices quickly Click the Expand/Compress icon 

below the device group name to 

open up a display of all the devices in 

you studio. Then click the check 

boxes that corresponds to the MIDI 

channels you want to add to the 

group. 

Close the check box display Click the Expand/Compress icon 

below the device group name again. 

Remove a device Click the device and choose None 

from the pop-up menu. 

Set a default patch for a device If the device is currently expanded, 

close it first by clicking the Expand/ 

Compress icon below the device 

group name. Then click in the default 

patch column to the right of the 

device and choose the desired patch 

from the pop-up menu. 

Clear a default patch Click the device name to select it and 

choose Clear Default Patch from the 

mini-menu. 

Remove a device or device group — Click the name to select it and choose 
from the list Delete from the mini-menu. 

Duplicate a device group Click the name to select it and choose 

Duplicate from the mini-menu. 

Performer relies on FreeMIDI for an up-to-date list of the MIDI 

devices connected to your Macintosh. If a device is connected to the 

MIDI OUT of your MIDI interface, and the connection is accurately 
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Editing during playback 

Playback 

reflected in your FreeMIDI configuration, then the device shows up 

in the pop-up list with the same name it has been given in FreeMIDI. 

To make any changes to the playback device list, choose Edit 

FreeMIDI Configuration from the Basics menu. This command 

automatically opens FreeMIDI Setup, which lets you make changes to 

your device configuration. 

Many of Performer’s features, such as windows, dialog boxes, edit 

region selection, edit commands, and other features can be used 

during playback. For example, you can open another window or use 

the Transpose command while the music is playing back; you do not 

have to press the stop button beforehand. So, the next time you are 

listening to your music and would like to make a change, don’t reach 

for the stop button. Just execute the command while the music is 

playing. 

Here are some examples of things you can do during playback: 

= Select a region for editing Gin an Event List, Tracks 

Window, etc.) 

m Edit a region with the Edit or Region menu commands 

Rearrange Chunks in the Song window 

Cut, copy, drag, option-drag (copy), etc. notes and data in 

Graphic Editing and QuickScribe notation windows 

Reassign the playback channel for a track 

m Add, delete, rename, or reposition a track 

m Access a mini-menu command such as Set View Filter 

During playback and recording, the Counter and other displays may 

become irregular and seem to skip beats. This is due to Performer’s 

primary obligation which is to receive and output MIDI data on time. 

Performer may have to devote all of the computer’s resources 

towards this end and thus may not be able to keep the screen display 

completely smooth and current. The click and flash will provide an 

accurate determination of the tempo. In addition, editing commands 

may sometimes take longer due to the amount of processor time 

required to deal playback. 
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Some features, because of their nature, cannot be accessed during 

playback. These features are either greyed out (unaccessible) during 

playback or will have no effect unless you press the Stop button 

before using them. Examples are: 

m Using the MIDI Interface dialog box 

m Save or close a file 

Using Solo allows you to easily select a subgroup of tracks to be 

heard during playback. This allows you to focus your attention on 

one or more tracks without disrupting playback in any way. The solo 

tracks group can be changed during playback, making it possible to 

hear many combinations of tracks without having to stop playback. 

The procedure for soloing tracks is described in detail in The Tracks 

Window chapter. 

Playback of the entire sequence can be looped seamlessly between 

any two points. For information see “The Memory-cycle button” on 

page 71. 

Event chasing addresses a common problem with playback: hearing 

the wrong patch (sound) when you begin playback in the middle of 

your sequence. This happens because MIDI data consists of a stream 

of single events. If a patch change occurs early in the stream, say at 

measure five, but you start playback later on, say at measure twenty, 

the patch change will not be played and your synth will not be set to 

the proper sound. 

Here’s how event chasing fixes this problem. Every time you click 

Play, Performer searches backward in each track for the last patch 

change, volume controller, and so on. If it finds one, it transmits the 

event before playback begins, setting the synth to the correct patch, 

volume, etc. Performer can chase all types of data, including notes 

which may be playing at the current location. 

Performer allows you to choose which types of MIDI data will be 

chased. To enable Event Chasing: 

1. Choose Set Event Chasing from the Basics menu. 

The Set Event Chasing dialog appears. 
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Set Event Ch 

2. Select the types of data you wish Performer to chase. 

Click Set All to enable chasing of all MIDI events. Deselecting 

unnecessary types reduces chase time after the Play button is 

clicked. 

3. Click OK to confirm your choice or Cancel to cancel it. 

To disable Event Chasing, click Clear to deselect all data types for 

chasing. 

In general, it is best to chase only types of data that need to be 

chased. In particular, notes add considerably to the time it takes 

Performer to chase. 

Event chasing cannot recognize loops in a track. If you have loops in 

a track, and the loops contain patch changes or other data that you 

are chasing, you may get unexpected results when you begin 

playback during or after the loop. 

With the Auto-Scroll command in the Basics menu, windows with the 

ability to scroll will update during playback or recording. You can 

choose whether all windows on the screen will scroll, or only the top 

window. In addition, you can choose what kinds of Performer 

windows will scroll. 
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When Performer windows scroll, they “page” along with the music. 

That is, when playback reaches the last measure or event in the 

current window, the window jumps to the next windowful of data 

just like clicking in the grey area of a scroll bar. 
? 

With Auto-Scrolling enabled, windows will update any time you 

change playback location, even when Performer is not playing back 

or recording. For example, if Performer is stopped and you press 

Rewind, all Auto-Scrolling windows will scroll to the new location 

indicated in the Counter window. Auto-Scrolling occurs when 

pressing the cueing buttons, dragging the arrow in the position bar, 

typing a new location into the Counter window, or cueing to a 

marker in the Markers window. 

When Auto-Scroll is enabled, Graphic Editing, QuickScribe notation, 

and Event List windows open to the current playback location. 

Auto-scrolling will only occur in windows related to the currently 

play-enabled Chunk. For example, if a Song window is open, it will 

not Auto-Scroll unless the song is play-enabled in the Chunks 

window. Windows associated with Chunks inside the song will not 

scroll when the song is play-enabled. Only the Song window and its 

Markers window will scroll. 

To enable Auto-Scrolling: 

1. Choose Auto-Scroll from the Basics menu. 

The Auto-Scroll dialog box will appear. 
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2. If you would only like the top window to scroll, click the Top 

window only option. 

This option causes only the top window to scroll when you have 

more than one window open on the screen. This option also 

reduces Performer’s processing load. If your Macintosh has a 

68000-based CPU, or if your sequences tend to contain large 

amounts of dense MIDI data, this option will ensure accurate 

playback and responsive scrolling. 

3. Choose which types of windows you prefer to Auto-Scroll. 

Click the check box next to the window type to select it. Use the 

Set All and Clear buttons to select or deselect all window types. 
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4. If you would like a scrolling cursor, select the cursor option(s). 

The scrolling cursors display the current playback location as 

shown in the main counter. They can also be dragged left or right 

to change the current playback location. They can be dragged 

when Performer is stopped or while it is playing back. 

With the Cursor option checked, a 
“wiper” appears in the Graphic Editing 
and Tracks Overview windows to 
show the currently playback location 
of the sequence. This wiper scrolls 
during playback and can be dragged 
to change the playback location. You 
can also double-click inside the time 
ruler at any location to make the 
cursor jump to that location. 

5. Click OK. 

To disable Auto-Scrolling: 

1. Choose Auto-Scroll from the Basics menu. 

The Auto-Scroll dialog box will appear. 

2. Click the Clear button. 

This deselects all window types. 

3. Click OK. 

120 Playback 



Chapter 8 

ay 

Lh ee aoe 

Patch Thru 

Patch Thru allows you to hear incoming MIDI data from your MIDI 

controller instrument played back on your output synthesizers. More 

technically, Patch Thru echoes MIDI data received by Performer to 

any MIDI device in your studio that you choose. You'll want to use 

Patch Thru when most of the time because it allows you to hear what 

you are playing on your MIDI sound modules while recording. Patch 

Thru also provides an easy way to experiment with different 

playback synthesizers without having to manually reconnect patch 

cords and change MIDI channels on the instruments. 

MIDI Cable 

2a MIDI sound module 

dal iic 

pe) 
Here is an overview of how Patch Thru works. You press a key on your controller keyboard. 
The note gets sent to Performer. Performer determines which device (MIDI channel) the note 
will be echoed to by the track is currently record-enabled in the Tracks window. It then sends 
the note to the device assigned to that track, which plays the note using whatever sound 
(patch) is currently selected on that channel. 

Patch Thru works whether you are recording or not. However, MIDI 

data will only be patched through tracks which are record-enabled. If 

you don’t hear anything on your synthesizer modules when playing 

your controller, check to be sure that the correct track or tracks are 

record-enabled. 

Timing and synchronization data are not echoed in Patch Thru. 
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To turn on Patch Thru, choose it from the Basics menu and select 

either Direct Echo or Auto Channelize: 

—— PatchtThru © 

Direct Echo causes incoming MIDI data from your controller to be 

echoed back out on the same channel it was received. For example, 

if your MIDI controller is transmitting on channel 3, MIDI data is 

echoed back out on channel 3 by Performer. The Input Filter settings 

do not affect direct-echoed data; information is simply echoed 

straight through, by-passing most of Performer’s MIDI processing. 

Direct Echo is useful in situations where you want to be able to 

change the channel you are echoing to from your MIDI controller 

keyboard by simply changing its transmit channel. 

Auto Channelize causes incoming MIDI data from your controller to be 

echoed back out to the device and channel for the currently record- 

enabled track in the Tracks window. The following sections discuss 

several scenarios that affect Auto Channelize. 

When a sequence is play-enabled in the Chunks window, here is 

how Auto Channelize Patch Thru works. In normal recording mode 

(MultiRecord off), incoming data is echoed to the device specified for 
the record-enabled track in the currently play-enabled sequence. In 

the example shown below, any incoming data received by Performer 

will be sent to the Kurzweil K2000R channel one. This is because the 

Funk Bass track is record-enabled, and its play destination is channel 

one on theK2000R: 
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Auto Channelizing with 
Multi-record turned on 

Patch Thru 

Every time you change the record-enable track, Patch Thru repatches 

your controller instrument to echo out to the specified device for that 

track. Thus you always hear your incoming data as it would be 

played back. 

If the record-enabled track is assigned to several playback devices at 

the same time, all of the devices will receive the patched thru data. 

If MultiRecord is on, only MIDI data received on the specified 

recording Device for a track will be echoed to the corresponding 

playback channels for that track. In the following example, notes 

played on the Korg 01/W will be heard on the K2000R, channel 5. 

Notes played from the DrumKat will be heard on the K2000R channel 

10. 

In the above example, the two controller instruments will be 

rechannelized separately. If two different tracks had the same input 

recording channel and had a common output channel, the incoming 

data will be echoed twice to that output channel. This may cause 
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problems with some synthesizers; caution is advised. Note that when 

in MultiRecord mode, the recording channel specified in the Input 

Filter will be ignored. 

Since Patch Thru works even when you're not recording, you can use 

Performer as a sophisticated MIDI merger, mapper, or rechannelizer 

when in playback or when stopped (as well as during recording). 

Patch Thru allows you to route MIDI information from your controller 

instrument to any combination of synthesizer modules. By adding a 

group of tracks, each assigned to a different MIDI channel or set of 

channels, you can change the module configuration used for 

playback by simply clicking on the record-enable button for the track 

or tracks with the desired channel configuration. This allows you to 

experiment with channelization freely. 

If a song is play-enabled in the Chunks window instead of a 

sequence, the following two conditions are necessary for Auto 

Channelizing to occur: 1) a sequence within the song must be record- 

enabled, and 2) a track within that sequence must also be record- 

enabled. If both are true, then Patch Thru will operate in the same 

manner as described above. For information about record-enabling 

sequences in a song, please refer to the Chunks Window chapter. 

The Input Filter affects incoming data in Patch Thru mode. All data 

selected to be filtered out will not be echoed to the outputs. For 

example, if the pitch bend box is not checked in the Input Filter 

dialog box, pitch bend information will not be echoed through in 

Patch Thru. 

If you use Patch Thru with a drum machine or any device that 

outputs timing information, the timing information will not be echoed 

through. To echo timing information, see the chapter called 7ransmit 

Sync chapter. 

Using Patch Thru will cause a small delay Cup to three milliseconds) 

since Performer must read all incoming data before sending it out 

again. 

Some MIDI interfaces, such as the MIDI Time Piece I, have a patch 

thru option built into them. The MIDI delay factor will be smaller 

when using this option since it is closer to the MIDI signals. If you 

choose to use the echo feature, turn off Patch Thru on Performer or 
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incoming data will be echoed twice. If you choose to use Patch Thru 

in Performer, turn off the echo feature on the interface for the same 

reason. 
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Chapter 9 

Real-time 
Recording 

Recording 

Performer records very much like a multi-track tape deck: you make 

the right connections, specify the tracks onto which to record and 

push the record button. Performer, however, has a great deal more 

flexibility than a tape deck. There are many options you can use 

while recording that affect which types of data are recorded and the 

time span in which recording takes place. 

Recording is the main method by which MIDI data is input into the 

sequence. There are two types of recording: real-time recording and 

step recording. This chapter describes the basics of both methods and 

discusses real-time recording; the next chapter describes step 

recording in detail. 

Real-time recording has two modes: standard and MultiRecord. In 

standard mode you can record on one track at a time. Data incoming 

on all channels (or the one you specify) is sent to this track. 

MultiRecord mode allows you to record on several tracks simulta- 

neously, each receiving data from a different incoming MIDI channel. 

Before recording in either mode, you should do the following things: 

1. Make sure your MIDI instruments are connected and configured 

the way you want them. 

Set the correct patches on your controller and playback 

instruments. 

2. (Optional) Check to make sure that Patch Thru is turned on so that 

you'll record the track with the same sound as it will play back with. 

Patch Thru echoes incoming data to any device you choose in 

your MIDI studio. This is essential when using a separate MIDI 

controller instrument: it allows you to hear what you are playing 

while it is being recorded. Patch Thru is also useful to check 

whether your instruments are working and connected correctly. 
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3. (Optional) Set the Input Filter if needed. 

If you wish to filter out some MIDI data when recording or record 

only from one specific channel, use the Input Filter from the 

Basics menu. The Input Filter defaults to notes, velocities, pitch 

bend, patch and song changes, and controller data checked. 

4. If you have more than one sequence or song in the file, make sure 

it is the currently play-enabled chunk. 

To do so, look at the current chunk indicator in the main control 

panel. If you need to switch sequences, use the Skip buttons. 

Current sequence or song 

If the sequence is inside a song, open the song’s window by 

double-clicking on the song, highlight the sequence, and choose 

Set Record Sequence from the Song window mini-menu. 

5. (Optional) Choose the starting meter or set up a meter map. 

A meter map is the layout of meters for the entire sequence. If you 

have a number of meter changes in your sequence, it is a good 

idea to set these up beforehand; it will make recording much 

smoother and more musical. A meter map can be made with the 

Change Meter command on the Change menu. Consult the 

Change Meter chapter for more on this command. 

6. (Optional) Set the tempo with the metronome in the main control 
panel. 

To set the tempo manually, choose Tempo Slider from the Tempo 

Control pop-up menu and drag the tempo slider to the desired 

tempo. Using the tempo slider is handy for quickly setting a 

straight tempo. A tempo map is the layout of all tempo changes 

for the entire sequence. If you have a number of tempos in your 

sequence, especially ones that change over time (such as an 

accelerando), you may prefer to set these up before actually 
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Recording 

recording any MIDI data. A tempo map can be made with the 

Change Tempo command on the Change menu. Consult the 

Change Tempo chapter for more on this command. Tap Tempo is 

a way to tap the tempo manually while you record, such as with 

a foot pedal. For more information, please refer to the Zap Tempo 

section in the chapter called Receive Sync. 

Record-enable the track(s) you wish to record on. 

To do this, open the Tracks window of the sequence you are 

recording into by double-clicking its name. In the Tracks window, 

click the Record-Enable button next to the track. If the button is 

red (or black on a black and white screen), the track is record- 

enabled. In standard record mode, only one track can be record- 

enabled. In MultiRecord mode, several may be record-enabled 

(more on this below). 

. Select the playback device(s) for the track being recorded. 

See “Choosing a device for playback” on page 111 for details. 

Select a location at which to begin recording. 

If you are recording into a new sequence, you'll probably want to 

start at the beginning of the sequence. To do so, click the Rewind 

button. To start at a specific location other than the beginning, 

type in the location in the Counter window. 

10. (Optional) Select the Wait and Countoff features if desired. 

11. 

The Wait feature holds recording until you hit a key on your MIDI 

keyboard or the Macintosh keyboard. Countoff gives you a 

number of measures of countoff in the starting tempo before 

recording begins. Wait and Countoff can be activated in the 

Consolidated Controls window. See the Consolidated Controls 

Panel chapter for specific details. 

To begin recording, press the Record button in the main transport 

controls. 

The Record button will turn solid black, signalling that Performer 

is recording in real-time. You can also trigger recording by 

pressing the 3 key on the Macintosh keypad or, if you have 

already set up a MIDI remote control, by sending a MIDI event 
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from your controller. For more information about setting up MIDI 

remote controls, please refer to the chapter called The Remote 

Controls Window. 

12. To stop recording, press the Stop button. 

Or, press the zero key on the Macintosh keypad. Stop can also be 

mapped to a MIDI remote control. To hold recording, you can 

press the Wait or Pause button. 

The above steps are used for standard recording mode. MultiRecord 

mode requires a few additional steps. 

Cycle-r eCcor ding Several of Performer’s features can be combined to provide 
comprehensive cycle-recording, complete with spot-erase and 

erasing the last pass. To get basic cycle-recording going: 

1. Click the Memory-cycle and Overdub record buttons in the 

Consolidated Controls panel. 

The memory-cycle button causes Performer to loop a section 

indefinitely. Overdub prevents each new pass from erasing the 

last one. 

Memory-cycle Overdub 

2. Set the start and end times of the region you want to loop in the 
Memory bar. 

For a two bar loop, make the stop time 3111000. For a four bar 

loop, make the stop time 5111000. Stop time is always the 

downbeat of the measure after the last one in the loop. You can 

set the loop points graphically by dragging the loop repeat 

barlines in the Tracks overview as shown below. 
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MIDI data appears 
immediately during 
recording 

Erasing the last pass 
and spot-erasing 

Recording 

Loop points (can be dragged) 

3. Check Auto Scroll in the Basics menu to make sure that the cursor 

option is checked for the Tracks Overview. 

This option provides a scrolling “wiper” to show you where 

playback is during looping. 

4. Set the tempo in the tempo slider. 

5. If needed, make sure that the Click is enabled in the Basics menu. 

6. Cue Performer to the beginning of the loop region. 

7. Click the record button in the main transport controls and begin 

recording. 

In Performer, recorded data appears immediately as you record it, 

before you press the Stop button. This allows you to edit the data 

(erase, transpose, quantize, etc.) without stopping cycle-recording. 

You can easily accomplish common cycle-recording tasks such as 

erasing the last pass and spot-erasing by opening an event editing 

window while cycle-recording. As you record, notes appear in the 

window right away, so you can do whatever you want to them 

without having to press the stop button. You can even insert notes by 

hand in the looped region, as well as continuous controllers such as 

volume controllers. 

To quickly erase the last pass while recording a drum track, open the 

Graphic Editing window and double-click the key on the pitch ruler 

that corresponds to the note you just recorded. Doing so selects all 

the notes of that pitch in the track. Then hit the delete key. 

To spot-erase graphically, click the note and hit delete. 
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A set of cycle-record remote controls, including a a spot-erase 

function, is included in the Remote Controls window. These controls 

help further provide drum-machine style loop recording by providing 

the ability to spot erase from your MIDI controller while cycle- 

recording. See “Spot-erase” on page 105 for more information. 

While you are cycle-recording, you can change the device, MIDI 

channel, or current default patch on the fly while recording as 

follows: 

Next/Prevous item Key to press 

Device Shift up-arrow 

Shift down-arrow 

MIDI channel Option up-arrow 

Option down-arrow 

Default patch (sound) Command up-arrow 

Command down-arrow 

You can also map these remote controls to MIDI keys on your MIDI 

controller, so that you can do everything from your MIDI controller 

during recording. See chapter 6, “The Remote Controls Window” for 

details. 

Once you are satisfied with the loop, you can make it permanent by 

inserting a loop into one or more tracks. To insert a loop over all the 

tracks, double-click one of the two repeat barline loop points in the 

Tracks Overview to select the loop region and choose Set Loop from 

the Change menu. To insert a loop over only one track, select the 

appropriate track segments in the Tracks Overview before choosing 

Set Loop. 

MultiRecord mode is used to record from several devices simulta- 

neously; each channel may be recorded on a separate track. This is 

very useful in transferring data from another sequencer or when 

recording from several MIDI instruments simultaneously. MultiRecord 

is also useful for recording music while slaved to Tap tempo. Refer to 

the chapter Receive Sync for more information on Tap tempo 

synchronization. 
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In addition to the steps listed in Real-time recording above, you need 

to do the following to prepare for recording in MultiRecord mode: 

1. Find out what the current transmit channel is on your controller 

keyboard(s) or devices. 

If you are recording from multiple sources, you may want to set 

each instrument or source sequencer track to transmit on a 

different channel. This helps avoid accidently merging them. 

2. Choose MultiRecord from the Tracks window mini-menu to check 

the menu item. 

The Rec/Source column appears. 

3. Record-Enable the tracks that you wish to record on. 

Click on the Record-Enable button next to the track. 

4. Select the input device and channel for each track from the pop-up 

menus provided in the Rec/Source column. 
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MIDI Controller devices are Specify the transmit channel of 
provided by FreeMIDI in a pop-up the controller by choosing the 
menu here. appropriate channel from this 

pop-up menu. 

5. Get ready to record. 

If you are sending data from another sequencer or a time-based MIDI 

device, you will probably want Performer to synchronize with it. To 

put Performer in External Sync mode, see the Receive Sync chapter. 

Also refer to the Receive Sync chapter for information on recording 

while slaved to Tap tempo sync. 

Step Recor ding In step recording, MIDI note events are input one at a time, not in 

real-time. Step recording is done with the Step Record command on 

the Basics menu. Step recording is very useful for entering music 

which is too fast or complex to play accurately in real time. It is also 

useful when entering a score to be converted to music notation 

programs. For details about step recording, see the Step Record 

chapter. 

The Input Filter The Input Filter allows you to specify what types of MIDI information 

are recorded. 

To use the Input Filter: 

1. Choose Set Input Filter from the Basics menu. 

A dialog box appears. 
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2. Choose the types of data to be input by clicking on the 

corresponding check box(es). 

You can choose multiple types of data. You can choose all types 

of data at once by clicking on the Set All button. You can uncheck 

all the check boxes by clicking on the Clear button. Use Option- 

click to check only the check box you click on, unchecking all 

others; use Command-click to check all boxes except the one you 

click on. 

3. Press OK to confirm your choice or Cancel to cancel it. 

@ Caution! The types of data you select will stay in effect 

until you change the filter setting. The Input Filter 

setting will affect all data recorded. Be especially 

careful when muting types of data that you normally 

don’t filter. If you don’t remember to turn them back 

on afterwards, you may loose valuable data in the 

future during recording. 

Specifying Controller The buttons under the Controllers check box in the Input Filter allow 

Numbers in the Input you to quickly choose which controller data to record. Click in the 

Filter Controllers check box, click on the type of option you wish, and then 

enter the controller numbers if necessary. 

All: Information from all controllers will be recorded. 

All except: Information from all controllers except the controller 

numbers you enter will be recorded. 

Only: Only information from the controller numbers you enter will be 

recorded. 

To enter controller numbers for the A// except and Only options, click 

in the text boxes next to the option and type in the numbers. You can 

use the Tab key to move between boxes in the same option. 
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Auto-Record automatically turns on and off the record function at 

locations you specify. This allows you to record without having to 

manually click the Record button on and off. 

In audio recording, this process in called “punching in” and 

“punching out”. A recording engineer is relied upon to listen for 

musical cues or watch for tape counter numbers to know exactly 

when to enable and disable recording. Performer allows you to pre- 

program these actions. 

Typically, Auto-Record is used to re-record, overdub or “drop in” a 

part to an existing sequence. Recording is automatically enabled at 

the designated “Punch In” location, and disabled at the “Punch Out” 

location. You can play along with the sequence up until punch in 

without recording. Likewise, anything you play after the punch out 

location will not be recorded. This feature is useful for correcting 

notes or passages without affecting the surrounding MIDI data. Auto- 

Record can also be used in combination with Tap tempo synchroni- 

zation, to “~punch-in” a discrete passage of tempo information on the 

Conductor Track. 

To use Auto-Record, see “The Auto-Record button” on page 76 

detailed information about how to use Auto-record. Consult the 

Receive Sync chapter for information on the use of Auto-Record while 

slaved to Tap tempo sync. 

When recording in external sync other than Tap tempo, the Record 

button is turned off every time the master device stops or rewinds. 

This is a safety precaution, to prevent accidental erasure of previously 

recorded data. To record in external sync, start the master device, 

wait for Performer to lock up, and then press the record button. Refer 

to the Receive Sync chapter for details on recording while slaved to 

each type of external sync. 

If you are slaving to video with a VITC converter such as Mark of the 

Unicorn’s Video Time Piece, Performer allows you to remain in 

record mode while the video parked on a SMPTE frame. To do so, 

check the Record while still framed option in the Receive Sync dialog 

box in the Basics menu. 
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Input Quantize Performer’s Input Quantize feature quantizes notes during recording 

in the same fashion as a standard drum machine. Notes get quantized 

immediately as they are being received and appear quantized in the 

track afterwards. If you are loop recording, the notes will play back 

quantized the next time through the loop. 

For more information, please refer to the Input Quantize section in 

the Region Commands 1 chapter. 

Recording 137 



138 Recording 



Chapter 10 Step Record 

Step Record, available in the Basics menu, is an alternative to real- 

time recording: it waits for you to enter notes one at a time and 

allows you to specify the duration of each. With it, you can enter 

passages too complex for real-time entry. Whatever you enter in Step 

Record will be rhythmically accurate Git won’t need quantizing). This 

is particularly useful for entering music for conversion to music 

notation by Mosaic or other music notation software. 

Quick Reference 

Step-record Speaker click Main transport Step Duration Tuplet duration box 
Mini-menu button lock button Buttons 

Tick box 

Motion 

buttons 

Current record 

track 

Dot and double-dot 

duration buttons 
Current step 

The Current record track is selected from this pop-up menu and 

displayed for reference. This is the track that is being recorded into. 

The Step Duration buttons allow you to set the duration for the step. 

The Dot and Double Dot buttons extend the duration chosen with the 

step duration boxes by one half or three quarters of the selected 

value, respectively. 

139 



Step Record Mini-menu 

140 

The Tick box displays the duration in ticks for the step. You can enter 

the duration for the step directly by clicking in this box and typing in 

the number of ticks. 

The Tuplet duration box allows you to enter any kind of tuplet: triplets, 

quintuplets, etc. 

The Backstep button erases the previous step. 

The Step button records the current step with the chosen duration. 

The Beat button records the current step and advances you to the next 

beat. 

The Measure button records the current step and advances you to the 

next measure. 

Checking the Auto Step check box causes the current step to be 

recorded each time a key is let up on the MIDI controller. 

Checking the Speaker click button causes a click to sound when a step 

is recorded. 

The Transport lock button connects or disconnects the Step Record 

window to or from the main transport controls and counter. When 

connected, Performer plays all tracks as you step, and the main 

Counter follows the current step. When disconnected, the Step 

Record window steps independently of the main Counter. While 

disconnected, you can step record while Performer is playing back. 

The Duration box sets the duration of the notes being entered, where 

100% is the length of the current step. 

The Offset box shifts the attack time of the note being entered earlier 

or later than the current step. 

The Solo Playback check box option solos the track being step- 

recorded into. When unchecked, all play-enabled tracks will play as 

you step. 

Note Durations: lets you assign a MIDI controller such as a modulation 

wheel to control note durations as you enter them. 
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Basics 

Step Recording Notes 
and Rests 

Step Record 

Note Offset: Lets you assign a MIDI controller such as a pitch bend 

wheel to control the note offset as you enter notes. 

Clear MIDI Events: Clears any events that are currently shown in the 

step bar. 

Step Record is primarily used to enter notes and rests. For information 

about how to step record controllers, pitch bend, and patch changes, 

see “Step Recording Controllers, Patch Changes, or Pitch Bend” on 

page 153 in this chapter. 

A step consists of a particular duration (an eighth note, for example). 

In addition, a step can contain One or more notes that are being held 

over from previous steps. All notes in a step last for the complete 

duration of that step. 

A step recorded passage contains a series of adjacent steps. Each step 

has a duration specified by the user. A step can contain: 

mg nothing: i.e. a rest 

m struck notes: Notes with attacks at the beginning of the 

step. Unless held into the next step, these will be released 

at the end of the step. 

a held notes: Notes with attacks in a previous step. Unless 

held into the next step, these will be released at the end of 

the current step. 

In Step Record, the time at the beginning of a step is represented in 

measure time. In 4/4 time, a quarter note beginning at 1121000 will 

last for 480 ticks, ending just before 1131000. If a second quarter note 

directly follows the first, it will begin on 1131000. Two eighth notes 

following just after will begin on 1141000 and 1141240, respectively. 

A rest is a step containing no notes. It is an “empty” duration. 

Although rests are registered in the Step Record window, they do not 

appear in the Event Editing windows: they are the spaces between 

note events. 

Velocity information is recorded in Step Record unless specifically 

disabled by the Input Filter available from the Basics menu. 
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Getting Ready Before selecting Step Record, you should do the following: 

1. Select a sequence to record into. 

Play-enable the sequence in the Chunks window. If the sequence 

is inside a song, open the song’s window by double-clicking on 

the song, highlight the sequence, and choose Set Record Sequence 

from the Song window mini-menu. 

2. Select the track you wish to record on just as you would for real- 

time recording. 

To do this, open the Tracks window of the sequence you are 

recording into by double-clicking its name. In the Tracks window, 

click the Record-enable button next to the track. When the button 

is highlighted (solid black), the track is record-enabled. In 

MultiRecord mode, the first record-enabled track in the track list 

will receive incoming data. You cannot step-record into the 

Conductor Track. 

3. (Optional) Open the Event List, Graphic Editing, or QuickScribe 

notation window for the track on which you are recording. 

You can open all three, if you like. We highly recommend doing 

so because it allows you to see what you are step recording as you 

go. 

4. If you are using the Graphic Editing or QuickScribe notation 

windows, choose Auto Scroll from the Basics menu. 

Select the appropriate option. We also recommend that you 

choose the cursor option, which produces a scrolling cursor in the 

window, which clearly indicates the current step location. 

5. Set the Counter to the time you wish to start recording. 

If you want to start at the beginning of the sequence, set the 

Counter to 1111000. 

6. If you don’t want to erase pre-existing music on the track and want 

to merge new material with old, click the Overdub record mode 

button located just below the main transport controls. 

If there are meter changes in the passage you are about to record, 

create them with the Change Meter command. 
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7. If you want to include key signatures in the passage you are about 

to record, create them with the Change Key command. 

Note that key signatures do not affect the actual data; they only 

affect the display in the Event List window and while step 

recording. 

8. Select Step Record from the Basics menu. 

The Step Record window appears. 

The current step indicator in the Step Record window displays the 

starting location for the first step; this is automatically set to the 

current Counter location. 

When you are finished setting up, you will see the Step Record 

window, along with one or more of the event editing windows for 

the track. The notes that you step record will appear in the event 

editing windows as you proceed with step recording. 
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Figure 10-1: The Step Record window, along with the Event List, Graphic Editing, 
and QuickScribe notation windows for the track being step recorded into. Notice 
that since Auto Scroll has been enabled in the Basics menu, the windows are 
scrolling as notes are entered. Also notice that the Graphic and QuickScribe 
notation windows have the scrolling cursor to indicate the current step location. 

Setting Step Durations The duration buttons are used to set step durations. Clicking on a 
duration button will highlight it and assign that duration to the step. 

Durations remain set until changed, allowing you to enter a stream of 

notes with the same duration very quickly. 
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Setting Dotted Durations 

Entering a Tuplet 
Duration 

Step Record 

To select more than one duration box at once, hold down the shift 

key while clicking on the desired duration box(es). When more than 

one box is selected, the step duration is equal to the sum of the 

selected values. 

You can also select durations using the Macintosh extended keypad. 

To do so, press the caps lock key to toggle the keypad from its 

standard transport functions to the step-record note-duration 

functions. (You can customize how this is done in the Remote 

Controls window if you like.) Press one of the number keys to select 

a duration. It remains selected until you deselect it. To deselect it, 

press it again. 

The dot and double dot boxes can be used to modify the selected 

step duration. If the dot box is selected, it signifies a dotted step 

duration, i.e. one and one half the value of the highlighted 

duration(s). If an eighth note and dot are selected, the step duration 

will be a dotted eighth note, i.e. a metrical value of an eighth plus a 

sixteenth. If the double-dot box is selected, it signifies a double- 

dotted step duration, i.e. one and three quarters the value of the 

highlighted durations. If a quarter note and double dot are selected, 

the step duration will be a double-dotted quarter note, i.e. a metrical 

value of a quarter plus an eighth plus a sixteenth. Only one of the dot 

boxes may be active at a time. 

The tuplet box can be used to set the step duration to a tuplet value, 

allowing you to enter triplets, quintuplets, septuplets, etc. These 

values are expressed in the standard way, xin the time of y durations. 

The tuplet box, when active, actually modifies the duration you 

choose in the duration boxes (including the dot and double dot 

modifiers). For example, an eighth note duration is equivalent to 240 

ticks. If the tuplet box is set to “3 in the time of 2”, step duration 

(displayed in the tick box) becomes 160 ticks, one third of a quarter 

note. 

To set the tuplet value: 

1. Click on the Tuplet check box next to the word “Tuplet”. 

2. Enter the number of tuplet notes to be entered in the first box. 

3. This is the box to the left of the words “in the time of”. 
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4. Enter the number of regular notes the tuplet replaces in the second 
box. 

Eighth note triplets, for example, are three equal duration notes in the 

time of two eighth notes. Quintuplet sixteenth notes are five equal 

notes in the time of four sixteenth notes. 

The tuplet box is active when the check box next to the word 

“Tuplet” is highlighted: make sure to deselect it when you have 

finished entering the tuplet values. You may enter any number of 

notes in the space of any other number. Performer does all the 

necessary calculations for the proper durations; you needn’t worry 

about the exact number of ticks a single tuplet duration will require. 

Specifying an Exact Performer computes the number of ticks for each duration 

Number of Ticks for a automatically when you click on the boxes. You can directly specify 

Step the exact number of ticks for a step by clicking on the tick box. The 

equals sign will disappear and all duration boxes will be deselected 

to indicate that you are entering the number of ticks directly. At this 

time, you can type in a new duration value. Click on any duration 

box to return to specifying durations as note values. 

Choosing a Note Normally, the duration of the note being step-entered is 100%, which 

Duration makes it exactly as long as the step itself. For example, if the step was 

a quarter note, the note would be 480 ticks long. 

Often, however, you might want to choose a different duration than 

the length of the step. For example, you might want to enter staccato 

quarter notes: the step duration is 480 ticks, but the duration of the 

notes should be much shorter—say around 60 ticks. 

To set a duration that is longer or shorter than the current step 

duration, type in a percentage below or above 100%. 

The duration can be controlled on the fly using a pitch bend or 

modulation wheel. For more information, see the remote control 

section at the end of this chapter. 

Generating Random Note durations can be generated randomly within a range. To do so: 

Note Durations within a = 
Range 1. Choose Note Durations from the Step Record mini-menu. 
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Setting Default 
Step-Record Durations 

Step Record 

2. In the duration range, enter the lowest and highest percentage that 

you would like to use. 

100% equals the current step duration, so if you’d like to be able 

to enter notes longer than the step duration, make the top value 

be above 100%. 

3. Check the “Randomize Durations within a range” option. 

4. Click OK. 

Performer allows you to control the duration of the notes that you are 

step-entering independently of the step duration. For example, if you 

are entering quarter notes, the step duration is 480 ticks. However, if 

you would like the quarter notes to be played in a staccato fashion, 

you would probably set the duration to approximately 120 ticks or 

some other value less than 480 ticks. 

One way to control the duration is with the duration option described 

in the section called “Choosing a Note Duration” on page 146. 

Often, however, you might like to select a different duration for each 

type of note (quarter note, half note, whole note, sixteenth, etc.). For 

example, you might want quarter notes to be 80% of their step 

duration, half notes to be 100%, and sixteenth notes to be 65%, where 

each duration has an independent duration. 

You can set up default durations for each note duration as follows: 

1. Double-click the duration button that you would like to set. 

A dialog box appears in which you can set the default duration for 

that note. 
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Generating Random 
Note Offsets within a 
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Hetault Note Duration 

2. Type in the desired duration. 

You can either type a percentage or a number of ticks. In either 

case, the other text box will update to reflect the value you enter. 

For example, if you entered 50% in the box above, the tick value 

box would change automatically to 240. 

3. Click OK. 

4. Repeat this procedure for each desired duration. 

Normally, step entered notes are inserted exactly at the tick location 

of the current step. The offset option allows you shift their entry a 

few ticks before or after the current step location. Offset is ideal for 

passages in which you'd like to push or lay back the feel. 

To place notes a certain number of ticks before the current step 

location, type in a negative number of ticks in the offset text box. 

To place the notes a certain number of ticks after the current step 

location, type in a positive number of ticks. 

The offset can be controlled on the fly using a pitch bend or 

modulation wheel. For more information, see the remote control 

section at the end of this chapter. 

Note offsets can be generated randomly within a range. To do so: 

1. Choose Note Offsets from the Step Record mini-menu. 

Step Record 



Soloing the Record 
Track 

Performing Step 
Entry 

Stepping Automatically 

Step Record 

2. In the offset range, enter the earliest and latest offset that you 

would like to use. 

Use a negative number to indicate the earliest offset, such as -15. 

3. Check the “Randomize Durations within a range” option. 

4. Click OK. 

Normally, all play-enabled tracks play along with you as you step 

record. However, if you want to mute all other tracks in order to solo 

the one being recorded into, click the Solo Playback check box. 

After setting the step duration, you are ready to enter notes. When 

entering them, you can proceed to each next step automatically Qwith 

the Auto Step option checked) or manually (with the option 

unchecked). 

Enter one or more enter notes with Auto Step in the following 

manner: 

1. Hold down one or more notes on your MIDI controller. 

2. Release the note(s) to enter the step. 

When Auto Step is enabled, a step is automatically recorded when 

you release a key on your MIDI input keyboard, just as if you had 

pressed the Step button. This makes entry quick and easy. 

For example, using Auto Step, you could enter an eighth note scale 

without using the step button: just set the duration to an eighth note 

and play the scale on your MIDI keyboard. 

When using Auto Step, be aware of the following things: 

Play staccato: make sure that the notes for each step are attacked and 

released crisply, with clean gaps between the notes. If the release of 

a note overlaps with the attack of the next one, you may get two 

notes in a step in which only one was intended. Don’t worry about 

the duration. Remember, it is determined by the duration option. 

Wrong notes will be recorded automatically. If you hit a wrong note, 

you must use the Backstep button to erase it and re-enter the note or 

chord. This differs from manual step mode in which you can replay 
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the notes as many times as you like before you click on the Step 

button, and only those notes being played at the moment you click 

on the button are recorded. 

At times, you may wish to choose when to proceed to the next step, 

such as when you are holding a note or chord through several steps. 

To do so: 

1. Hold down one or more notes on your MIDI input keyboard. 

2. Click on the Step button. 

3. Release the note(s). 

This will cause one step to be recorded containing the notes you 

played. Clicking on the Step button will record those notes which are 

being held down on the controller keyboard. The step will not be 

completed until you press the Step button. If you continue to hold the 

same notes down and press the Step button again, the notes will be 

recorded as “held” since they were not released in the previous step. 

You can use the space bar on the Macintosh keyboard instead of 

pressing the Step button. 

If you play a wrong note, simply play the correct one before pressing 

the Step button. 

Rests are entered by pressing the step, beat, or measure buttons with 

no notes held down. This records a step with no notes for the chosen 

duration. 

Click the speaker click button to highlight it. When highlighted, it 

causes a click to sound every time a step is entered. This is highly 

recommended when using Auto Step, as it is a useful indicator of step 

completions. The volume of this click can be adjusted with the 

Speaker Volume feature on the Control Panel desk accessory; any 

adjustment to the click volume must be made from the Finder. 

When you are finished step recording, and youd like to hear what 

you have done, press Rewind, or cue to the desired start measure. 

Then press Play. 
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Notice that when you rewind and play back, or do just about 

anything else besides step-recording, the Transport Lock button in 

the title bar of the Step Record window unhighlights. (You can also 

unhighlight it by clicking it.) This indicates that the main Counter in 

the Controls Window is no longer locked to the current step location 

in the Step Record window. 

In this mode, the Step Record window acts entirely independently of 

Performer’s main transports (play, stop, rewind, etc.), as well as the 

main Counter. Thus, you can play, rewind, fast forward, stop, and 

otherwise cue around in the sequence completely independently of 

where you are step recording. 

In this mode, other tracks do not play along with the track that you 

are step recording into. To get them to play along, click the Transport 

Lock button again to highlight it. Doing so locks the transports to Step 

Record. 

If, as you Step Record, you would like other tracks to step along with 

you, highlight the Transport Lock button before you begin. Doing so 

causes Performer’s main Counter to follow the current step indicator 

in the Step Record window. All play-enabled tracks will play as you 

step through the sequence. 

To change the current step location: 

1. Click the Current Step location to edit it. 

2. Type in the desired location. 

3. Press the return key. 
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4. If you wish to connect the main Counter to the new Step Record 

location, highlight the Transport Lock button. 

Doing so causes the main Counter to follow you as you step, and 

all play-enabled tracks will play with you as you step. 

Notes that you step enter appear in the event editing windows of the 

track as you enter them. To view them either during or after entry, 

open the Event List, Graphic Editing, and/or QuickScribe notation 

window for the track on which you are recording. See Figure 10-1 on 

page 144. 

Pressing the Backstep button will erase the step you just entered (the 

one displayed just above the current step bar). After pressing the 

Backstep button, the time in the current step bar will be the exact 

starting time of the step erased with the Backstep button. 

The Beat and Measure buttons are special step advance buttons. They 

compute the duration necessary to get to the next beat or measure: 

the step is recorded using that duration and you are advanced to the 

next beat or measure for the next step. For example, if the current 

step is on 2111212 and the meter is 4/4, when the Beat button is 

pressed, a step of 268 ticks will be recorded and the next step will be 

entered at 2!21000. If the Measure button is pressed, a step of 2! 268 

(2 quarter notes and 268 ticks) will be entered and the next step will 

be entered at 3111000. 

To change the current record track, click the “Recording on...” pop- 

up menu and select a different track. 
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Step Record 

You can add to existing material in a track as long as you first turn on 

Overdub record mode with the Overdube record button in below th 

main transport controls. Otherwise, the newly step recorded data will 

replace existing data in the track. 

To step record a controller event, patch change, or pitch bend event: 

1. Play the event. 

The event appears in the current step bar. 

2. Press the Step button or any other motion button to record the 

event. 

Events, such as patch changes, controllers, and pitch bend do not 

trigger auto step. In these cases, play the event and proceed to the 

next step by pressing the Step button (or any other motion control 

button.) 

Step recording can be done during playback. For example, you can 

step record notes into a loop and have Performer play back the loop 

in real time as you build the loop. This can be ideal for building drum 

loops with Step Record. 

To Step Record into a loop during playback: 

1. Choose Step Record from the Basics menu and unhighlight the 
Transport Lock button in the title bar of the Step Record window. 

This disconnects the main Counter from Step Record. 

2. Set up a loop in a track. 

If necessary, you can initially make the loop repeat infinitely while 

you are building it and later on change it to the desired number of 

repetitions. 

3. Choose the track with the loop from the “Recording on” pop-up 

menu in the Step Record window. 

153 



4. Click the Overdub record button located just below the main 

transport controls to enable Overdub record mode. 

This allows you to step record over the same region in the loop 

without erasing existing material in the region. 

5. Set up any other Step Record options as desired, such as Solo 

Playback and Auto Step. 

6. Press the Play button to begin Playback. 

As the sequence plays, notice that the Current Step in the Step 

Record window remains where you begin. 

7. Pop-edit the current step counter to set it to the location where you 

want to begin step-recording. 

8. Begin Step Recording as desired. 

9. When you reach the end of the loop, pop-edit the current step 

indicator to step record the next pass through the loop. 

As Performer keeps playing, you can repeat this step as many 

times as necessary as you build the loop. As you build it, you will 

continue to hear it playback. 

10.When you are finished, press Stop. 

Using the Step All of the functions in the Step Record window are available as 

remote controls in the Remote Controls window. This allows you to 
Record Remote map them to your MIDI controller so that you can perform the entire 

Contr ols step recording process from in front of your MIDI instrument, rather 
than in front of your computer screen. 
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@ Important note! Be careful about the other Remote 

Controls, such as the Transport controls or the Chunk 

Select controls. Be sure that you have either disabled 

them (with their group master) or remapped them so 

that they do not interfere with the notes that you are 

step recording. See the Remote Controls chapter for 

information about how to remap and disable groups of 

remote controls. 

Controlling Duration You can set up Step Recording such that a mod wheel or other 
with a MIDI Controller continuous controller controls the duration of the notes being 

inserted. 

To assign a pitch bend wheel, mod wheel, or data slider to the 

duration: 

1. Choose Note Durations from the Step Record window mini-menu. 
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= Durations | 

2. For duration range, enter the lowest and highest percentage that 

you would like to use. 

100% equals the current step duration, so if you’d like to be able 

to enter notes longer than the step duration, make the top value 

be above 100%. The maximum value you can enter is 200%. 

3. For the MIDI Remote Control, enter the controller type, and enter a 

range of controller values that will be mapped to the duration range 

you specified above. 

For example, if you specify a duration range of 50% to 150%, and 

you specify a controller range of 0 to 100, when you move the 

mod wheel (pitch bend wheel, or data slider) to 100, the duration 

will be set to 150%. Likewise, if you move the controller to 0, the 

duration value will be set to 50%. You can enter any of the above 

values by highlighting the text box with the tab key and moving 

the controller wheel or slider. 

4. To enable MIDI Remote Control, click the MIDI Remote Control 

check box. 

5. If you wish notes to be assigned a random duration within the 

duration range you’ve chosen, click the “Random Duration within 

range” check box. 

6. Click OK to confirm your choices. 

Now you can control the duration with your mod wheel. As you 

move the wheel, notice that the duration value changes in the Step 

Record window. 
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Controlling the Offset 
with a MIDI Controller 

Step Record 

You can set up Step Recording such that a mod wheel or other 

continuous controller controls the offset of the notes being inserted. 

To assign a pitch bend wheel, mod wheel, or data slider to the offset: 

1. Choose Note Offset from the Step Record window mini-menu. 

Offset 

2. For the offset range, enter the earliest and latest value over which 

you would like to set the offset. 

Type a negative tick value in the first text box for the earliest 

value; type a positive tick value in the second box for the latest 

value. 

3. For the MIDI Remote Control, enter the controller type, and enter a 

range of controller values that will be mapped to the offset range 

you specified above. 

For example, if you specify an offset range of -15 to 15, and you 

specify a controller range of 0 to 100, when you move the mod 

wheel (pitch bend wheel, or data slider) to 100, the offset will be 

set to 15. Likewise, if you move the controller to 0, the offset value 

will be set to -15. You can enter any of the above values by 

highlighting the text box with the tab key and moving the 

controller wheel or slider. The minimum is -240 ticks and the 

maximum is 240 ticks. 

4. If you would like the note’s duration to be maintained, check the 

“Subtract offset from durations” option. 
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5. To enable MIDI Remote Control, click the “Use MIDI Remote 

Control” check box. 

6. If you wish notes to be assigned a random offset within the range 

you’ve chosen, click the “Randomize offset within range” check 

box. 

7. Click OK to confirm your choices. 

In addition, the step record commands are mapped to the Macintosh 

keypad as shown below. The caps lock key must be down to use 

these key assignments. Pressing the key performs the same actions as 

pushing the buttons in the Step Record window, with one exception: 

a duration remains selected until you press it again; pressing a 

different duration does not deselect currently selected durations. This 

allows you to easily specify a composite duration (such as an eighth 

and a quarter). To clear all durations, use the Clear Note Grid key: the 

Clear key on the keypad. 

Tuplet 

Clear 
Note = Ee AutoStep 

= HHnE= Measure 

+. is = 
Anne on 

Step recording will record over previously recorded material in the 

same time span in the track. Use Overdub record in the Consolidated 

Controls Panel if you want to merge your step recorded material with 

what is already on the track in that time span. 

If you enter notes or backstep quickly, the display might temporarily 

be suspended in order to accurately process the events. Don’t worry: 

as soon as you slow down or stop entering or backstepping, the 

display will catch up. 

You may find that velocities recorded in step record are uneven. If 

this occurs, you can edit them by selecting the step recorded region 

and using the Change Velocity command in the Region menu to set 

all velocities to the desired values. 
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Hints 

Step Record 

Be sure to uncheck the tuplet box as soon as you are through with it; 

otherwise, subsequent durations will be incorrect. 

If you discover that you’ve left out a note after step recording, use the 

Shift command on the Edit menu to remove or add extra space to 

avoid having to re-enter the entire passage again. 

To enter a chord with staggered releases, use manual stepping. 

You can enter chords with more than five notes (one hand’s worth) 

by making two or more recording passes, for instance, one for each 

hand of a piano part. This can be done by recording on separate 

tracks or by using overdub record to merge in the second part. 

If there are a number of duration changes in a step record passage, it 

may be easier to choose the smallest common duration value and 

hold notes through steps to create longer durations. For example, a 

half note can be entered by holding an eighth note over four steps. If 

the passage you are entering is rhythmically complex, it may be best 

to use manual stepping (Auto Step off) in order to keep track of each 

step entered. 
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Chapter 11 The Counter Window 

Setting the Counter 
window display 

The Counter Window is identical to the main counter in the 

Consolidated Controls Panel, except that it is a large, separate 

window, and it can display all three time formats at once. For 

complete information about using either counter, see “The Counter” 

on page 88. 

The counter window can display one or more of the three time 

formats in any combination. One format is designated as the Main 

Counter. It will appear at the top of the window. You can also specify 

two “Aux” (auxiliary) Counters which appear below the Main display. 

The format is identified by a small icon positioned just to the right of 

it in the Counter window: 

Counters can continuously display the current location of the 

sequence or song or can update the location only after the stop 

button is pressed. The former mode requires some microprocessor 

overhead; turning off the continuous update option will improve the 

program’s responsiveness during recording and playback. 
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To set the counter display: 

1. Choose the Set Display command from the Counter window mini- 

menu. 

2. Choose the time display for the main counter by pressing the 

desired button in the Main Counter column. 

3. Choose zero, one, or two other time formats by clicking on the 

desired box(es) in the Aux Counter column. 

4. Specify which of the displays will be continuously updated by 

clicking in the desired box in the Running Update column. 

If the Running Update box is not checked, the corresponding time 

display will change to dashes while the sequence is playing or 

recording. 

5. Press the OK button to confirm your choice or the Cancel button to 

cancel it. 

Counter window mini- In addition to the Set Display command mentioned in the previous 

menu section, the Counter window mini-menu has two other commands. 

Set Frame Rate 
For complete information about setting the SMPTE frame rate, see 

“Slaving to SMPTE with MTC, DTL, or DTLe” on page 609. 

Set Chunk Start 
For complete information about setting the start time of a sequence 

or song (chunk), see “Setting the start time” on page 90. 
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Chapter 12 The Tracks Window 

The Tracks window is one of the most important features in 

Performer: it allows you to define and organize the contents of each 

sequence in your Performer file. It is also perhaps the most powerful 

and flexible window in Performer. The Tracks List portion of the 

window allows you to create tracks, assign MIDI channels for 

recording and playback, set regions for editing, customize track 

names, add comments, and more. The Tracks Overview portion 

allows you to view, select, and edit the data in each track. 

Quick Reference 

Tracks List Tracks Overview 

Solo button Play-enable Edit bar Conductor Time Ruler Memory-cycle Sequence 
buttons track end points name 

Move Loop MlDlActivity Record- Playback Track Current Window Empty Track — High-density Time 
handle — Indicator meters enable devices names patch divider segment track segment zoom 

buttons (sound) buttons 
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Tracks List: Displays the track names and important information about 

each track: the play channel or device assignment, the play and 

record buttons, the current patch setting, and comments. Option-click 

the track name to pop-edit it. 

Tracks Overview: Displays each track in equal-length segments, which 

can be zoomed to show as much as 16 measures per segment or as 

little as 30 ticks. Each segment displays how much data is present in 

that segment. To view the data in a segment, double-click, command- 

double-click, or option/command-double-click to open the Event 

List, Graphic Editing, or QuickScribe notation window. 

Solo Button: Enabling this button by clicking it puts Performer into 

Solo mode—the same as using the Solo command in the Tracks 

window mini-menu. Highlighted tracks play; unhighlighted tracks are 

muted. 

Playback device: Each track has a playback device (or a combination of 

several devices), which can be selected from a pop-up menu by 

clicking in this column next to the track. Devices in the menu are 

provided by FreeMIDI. 

Edit Bar: Determines the start and end times of the current selection 

region in any tracks whose names are currently highlighted. Click the 

values to edit them. Click the words “Start” or “End” to load the 

current Counter location. Double-click the word “Start” to 

automatically load the beginning of the sequence; double-click the 

word “End” to automatically load the end. Double-click the word 

“Edit” to automatically select the entire length of the sequence. 

Single-click the word “Edit” to load remembered times. 

Loop Indicator: Shows whether a loop exists in the track. 

Time Ruler: Displays the location of each segment in any combination 

of Performer’s three time formats: measures | beats | ticks, SMPTE time, 

or real time. 

Memory-cycle loop points: These repeat barline icons indicate the 

points where the entire sequence will loop when the Memory-cycle 

button is highlighted. 
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The Tracks Window 

Sequence Name: Displays the name of the sequence. A Performer file 

can contain any number of sequences, each with their own Tracks 

window. Command-click to switch between sequences. 

Time Zoom Buttons: Zooms in the Time Ruler so that each segment 

represents a smaller or larger duration. For example, in the Quick 

Reference diagram, each segment currently represents one measure 

of music. Clicking the Zoom In button will cause each segment to 

represent one quarter note (480 ticks). Other zoom-in levels are: 240, 

120, 60, and 30 ticks per segment. Other zoom-out levels are: 4, 8, 

and 16 measures per segment. 

High-Density Track Segment: Indicates that the segment contains more 

than 10 MIDI events. Segments can display several degrees of data 

density. The threshold between density levels can be adjusted with 

the Set Density Threshold mini-menu command. 

Empty Track Segment: Indicates that the segment contains no MIDI 

data. 

Window Divider: Separates the Tracks list from the Tracks Overview. 

Drag the divider left to see more of the Tracks Overview or right to 

see more of the Tracks List, comments, etc. 

Track Comments: Display remarks that you can type in for the track. To 

enter or change a comment, simply click on it and enter or edit the 

text. Press OK or the Enter key to confirm your entry, or press the up 

or down arrow keys to confirm your entry and move to adjacent 

tracks, or press Cancel or command-period to cancel it. 

Current Patch: Displays the name of the currently selected patch 

(sound) for the Device. 

Default patch: Displays the name of the patch that will initially be 

called up when the sequence starts playing. This is saved with the 

file. 

Conductor Track: A special track that contains the tempo map, meter 

changes, and key signatures for the sequence. The Conductor track 

also contains Markers. Data in the Conductor track can be edited just 

like MIDI data in regular tracks. 
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Playback Device: Displays the playback assignment for the track. The 

list of devices matches your MIDI studio. Device names are set up in 

the FreeMIDI Setup software. 

Play-Enable button: Enables or disables a track for playback. To toggle 

its play status, simply click the button. Any number of tracks may be 

play-enabled. Most commonly, all tracks will be play-enabled. When 

solid black, the track is play-enabled and will be audible. If hollow, 

the track will be muted or silent. If muted, the data for the track is still 

there; you are just “turning off” the track during playback. 

Record-Enable button: Selects a track for recording. In normal 

recording mode (MultiRecord off), only one track may be recorded 

into at once; when you record-enable a track, the previous record- 

enabled track will be automatically disabled. Record-Enable buttons 

are only present if the sequence is selected for playback in the 

Chunks window or it is record-enabled in a Song window. 

Move Handle: Drag up or down to change the position of a track in the 

tracks list. 

MIDI Activity Meters: Indicate the intensity of MIDI playback coming 

from the track. They monitor either note-on velocities or amount of 

data. When monitoring amount of data, level meters monitor any type 

of data. 

Tracks Window Mini- Add: Adds a track to the track list. There is no limit to the number of 

menu tracks you can add. Hold down the option key while choosing Add 

to add more than one track at a time. New tracks are added to the 

bottom of the list or just below the currently highlighted track name. 

Duplicate track layout: Selecting a track or multiple tracks and choosing 

this command duplicates the selected tracks and their playback 

assignments. The word copy is appended to each new track’s name. 

This command does not copy the data in the track; instead, it copies 

only the track’s name and playback assignment. Use the option key 

while selecting the command to make more than one duplicate copy. 

Solo: Enables Solo mode. In Solo mode, only tracks whose names are 

highlighted will play. To disable Solo mode, choose Solo again to 

uncheck it. 
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The Tracks Window 

Solo Setup: Calls up a dialog box that lets you configure solo mode. 

Solo mode can be configured so that muted tracks are not muted all 

the way. Instead, their volume is brought down part way by reducing 

their note-on velocities by a percentage that you choose. 

Level Meter Setup: Provides several different ways to configure the 

level meters. See “Configuring the MIDI level meters” on page 193. 

Columns setup: Lets you choose which columns to show and hide in 

the Tracks list. 

Edit: Opens the Event List for the currently highlighted tracks. 

MultiRecord: Enables MultiRecord mode. In MultiRecord, more than 

one track can be record enabled at a time with a separate record 

channel for each one. To disable MultiRecord mode, choose the 

MultiRecord menu item to uncheck it. 

Set View Filter: Calls up a dialog box in which you specify types of 

events to be visible in the Tracks Overview window. The View Filter 

applies to all tracks and the Event List, Graphic Editing, and 

QuickScribe notation windows. 

Set Density Threshold: Calls up a dialog box in which you specify the 

difference between low-density and high-density track segments. The 

default value is 10 MIDI events. You can set the threshold to any 

value between 1 and 999. 

Set Rulers: Allows you to configure the Time Ruler in any combination 

of Performer’s three time formats: measures | beats | ticks, SMPTE time, 

or real time. The main ruler is displayed lowest. 

Goto Counter: Scrolls the graphic display to the time currently 

displayed in the Counter. The counter location will appear at the left- 

most position in the window. 

Goto: Scrolls the graphic display to a time you specify, which will 

appear at the left-most position in the window. 

Create Chunk: Creates a sequence chunk made up of the currently 

selected segments and places it at the end of the list in the Chunks 

window. In the new sequence, the earliest selected segment will be 

placed at measure one. 
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Create Console: Creates a Slider console for the currently selected 

tracks. A dialog box will appear asking what type of console, e.g. 

volume, pan, etc. 

Clear default patch: Removes the default patch assignment in the 

Default patch column for the currently selected tracks. 

Delete: Removes the currently selected tracks from the Tracks 

window. 

A track in Performer stores a series of MIDI events within a sequence. 

Each sequence contains its own set of tracks. Performer allows you 

create as many tracks as you like, each holding a separate stream of 

MIDI events. The only limitation to the number of tracks is the 

amount of random access memory in your computer. (We’ve seen 

some sequences with over 300 tracks!) 

The Conductor Track is the exception; it stores meter, key, tempo, 

and marker information. For more information, see the chapter 7he 

Conductor Track. 

In Performer, MIDI data is stored in the track without channel 

information. Instead, each track in Performer can be assigned to one 

or more MIDI channels. During playback, or while recording using 

the auto-channelize Patch Thru feature, the MIDI data in the track is 

sent out through the assigned channels. Any MIDI instrument that is 

listening to (receiving on) that same channel will respond to the MIDI 

information it receives. 

In summary, each sequence in a file has its own Tracks window, 

which lists all of the tracks in the sequence. Each track has a MIDI 

channel assignment consisting of one or more channels. The data in 

the track is played on whatever the playback channels the track is 

assigned to. 

When you select New from the File menu, a new file containing a 

single sequence is created. (See the Working with Files and Chunks 

Window chapters for more information.) The Tracks window for this 

new sequence is already open by default. 
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The Tracks Window 

If you wish to add another sequence and display its track window: 

1. Open the Chunks window by choosing Chunks from the Windows 

menu. 

The Chunks window appears: 

2. Choose Add Sequence from the Chunks window mini-menu. 

Add Sequence 

Add Song 

Duplicate Track Layout 

Open Chunks 

Auto /manual End Time 
Set Chunk Start... 

Delete 

A new sequence appears in the Chunks list. 

3. Double-click the name of the new sequence. 

A new Tracks window will appear for that sequence. The name of 

the sequence will appear in the title bar of the window. 

To open a new file with a new, empty sequence: 

1. Ifa file is open, close it by choosing Close from the File menu. 

2. Choose New from the File menu. 

A new file opens with one sequence and a Tracks window for that 

sequence. 
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The Tracks L ist The Tracks window is divided into two portions: the Tracks List on 

P the left and the Tracks Overview on the right. This section discusses 

& Overv: lew the Tracks List. The Tracks Overview is discussed later in the chapter. 

Tracks List Tracks Overview 
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Tracks List Quick The Tracks List provides a list of all the tracks in the sequence. In 

Reference addition, it provides useful information about each track, such as 

what MIDI devices the track is playing on. This information is shown 

in the same row as the track. 

Recordenable Edit Bar 
button 

Record 
Loop indicator device and Playback Conductor Default Patch Track 

channel (only device Track (The sound Comments 
appears when the track starts 
Multi-record is with) 

enabled) 

Move MIDI Activity Play-enable Tracks List Current patch Window divider 
handle meters buttons (sound) (Dragged all the way - 

to the right to cover 
up the Tracks 
overview) 

Hiding Columns in the Even though The Tracks List has a lot of columns of information in it, 

Tracks List you can completely customize the display to suit your tastes. You can 
hide columns you don’t need to look at, and you can rearrange the 

order of the columns. For example, if you don’t have any comments, 

you don’t need to display the column. 

To hide or show columns in the Tracks List: 

1. Choose Columns Setup from the Tracks window mini-menu. 

As a shortcut, you can double-click any column heading instead. 

The column Setup window appears. 
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Rearranging the order of 
the columns 

The Move Handle 
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Track Columns Setup 

2. Uncheck the columns you want to hide, and check the ones you 

want to see. 

3. Click OK. 

You can rearrange the order of the columns simply by dragging the 

title of the column left or right. 

See “Customizing the Tracks Window” on page 192 for an example of 

a more compact, customized Tracks List. 

The Move Handle allows you to shift the position of a track in the 

tracks list. Use it to rearrange the tracks in an order that is most useful 

to you. To use the Move Handle, press on it and drag the track where 

you want it to go. A dotted outline of the track will follow your 

mouse movements. The track will be moved to the position in the 
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The Loop Indicator 

MIDI Activity Meters 

The Record-Enable 
Button 

The Record Device 

The Tracks Window 

tracks list where you release the mouse. If you drag the track above 

the top or below the bottom of the Tracks List, it will scroll until it 

reaches the top or bottom of the list. 

This column displays a loop icon if the track contains one or more 

loops. 

The MIDI Activity Meters act very much like the level meters on a 

tape deck: when there is signal on the channel, the level meter 

registers the signal. Similarly, at the moment the track is playing MIDI 

data, the MIDI activity meter registers the outgoing MIDI data. 

You can configure how the level meters operate. For details, see 

“Configuring the MIDI level meters” on page 193. 

The Record-Enable button selects a track for recording. In normal 

recording mode (MultiRecord off), only one track may be recorded 

into at once; when you record-enable a track, the previous record- 

enabled track will be automatically disabled. Record-Enable buttons 

are Only present if the sequence is selected for playback in the 

Chunks window or it is record-enabled in a Song window. 

The Conductor Track has a record-enable button, which is used to 

record tempo information while slaved to Tap tempo synchroni- 

zation. See the chapter Receive Sync and Tap Tempo While Slaved to 

Tape for details on using Tap tempo to record a tempo map in real 

time. 

Normally, the record-enabled track will record data from all channels. 

In MultiRecord mode (set in the Tracks window mini-menu), you can 

record from individual MIDI device on a particular MIDI channel into 

a particular track. This lets you record into several independent tracks 

from several independent sources all at once. Each track has its own 

incoming MIDI device and channel number displayed next to its 

Record-Enable button. Recording channel assignments are only 

present in MultiRecord mode. See the Recording section for details 

about using MultiRecord. 
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The Recording Channels display consists of a device name followed 

by a channel number. Click them to change them. If the record device 

is blank, click in the blank space next to the record button to open a 

pop-up menu of devices. You can select only one device and channel 

for each track. 

The Play-Enable button readies a track for playback. To toggle its 

play status, simply click the button. Any number of tracks may be 

play-enabled. Most commonly, all tracks will be play-enabled. When 

blue (or solid black on a black and white screen), the track is play- 

enabled and will be audible. If gray Cor hollow on a black and white 

screen), the track will be muted or silent. If muted, the data for the 

track is still there; you are just “turning off” the track during playback. 

The Play-Enable button turns grey when the track is temporarily 

muted due to Solo mode. The Conductor track contains no standard 

MIDI data, therefore it has no Play-Enable button. 

To Play-enable all tracks except for one, command click its play- 

enable button. To play-enable only one track and unplay-enable all 

others, option-click the track’s play-enable button. This convention 

also applies to track record-enable buttons in Multi-record mode, the 

Sliders window record-enable buttons, and the Lock icons in the 

Markers window. 

The Playback device consists of the name of one of the MIDI devices 

in your studio followed by a dash and a MIDI channel number 

(between 1 and 16). It can also consist of several devices. 

For information about how to change playback assignments, see 

“Choosing a device for playback” on page 111. 

For information about how to assign a track to more than once device 

at a time, see “Choosing multiple playback devices for a single track” 

on page 112. 

For information about how to add, remove, or rename devices in the 

list, see “Changing your playback device list” on page 114. 

To change the name of a track, click it while holding down the 

Option key. A box will pop up: click in it and use the Macintosh 

keyboard to edit the name. To confirm your change, press the Return 

key. To cancel the change, press the Command and period keys. You 
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must do one of these two things to terminate track name editing 

(otherwise, the pop up box will remain.) Use the Enter or down 

arrow key to OK the name change and move to the next track in the 

list. Use the up arrow key to OK the name change and move to the 

previous name in the list. The Conductor Track’s name cannot be 

changed. 

The conductor track contains meter changes, tempo changes, key 

changes, and markers. See the Conductor track chapter for more 

information. 

This column displays the name of the currently selected patch for the 

Device that is assigned to the track. If a patch has not been selected, 

no patch name appears in the column. 

@ The FreeMIDI option called Monitor Patch Changes in 

the FreeMIDI Setup Preferences command affects this 

column. When the option is turned on, this column 

will show the current patch change sent by any 

FreeMIDI application. If it is unchecked, it will not 

give you a running update of the current patch, even 

with patch changes sent from Performer. 

To select a patch for a track, click in the patch column next to the 

track and select the desired patch from the pop-up menu provided. 

Its name then appears in the column. 

If you have patch changes in the track, the Device Patch column will 

update during playback to show the current patch (and the Monitor 

Patch Changes command is turned on in FreeMIDI Setup). 

The list of patches you see in the pop-up menu in this column is 

provided by FreeMIDI. By default, the factory default sounds names 

for most popular synths are provided. In some cases, patches are 

given the generic name “Patch-1”, “Patch-2”, etc. However, you can 

use the PatchList Manager program, Unisyn, or any other FreeMIDI 

compatible librarian software to provide the actual names of the 

sounds in each one of your MIDI instruments. See chapter 48, “Using 

PatchList Manager” (page 725) for details. 
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The Default Patch The Default patch is the patch the track always begins with. It is 
remembered when you save the Performer file so that the next time 

you open the file and press play, the default patch is called up from 

the synthesizer before playback begins so that the track will play with 

the correct sound. 

To select a default patch for a track, click in the default patch column 

next to the track and select the desired patch from the pop-up menu 

provided. Its name then appears in the default patch column. 

The list of patches in the pop-up menu is provided by FreeMIDI. As 

mentioned in the previous section, this list can display the actual 

sound names in the synth if you use PatchList Manager, Unisyn, or 

any other FreeMIDI-compatible librarian software. 

The Comment The Comment is a remark that you can display for the track. It is 
simply a space for text that you can use for whatever purposes you 

wish. To enter or change a comment, click on it and enter or edit the 

text. Press OK or the Enter key to confirm your entry, or press Cancel 

or command-period to cancel it. As much of the comment as possible 

is displayed in the Tracks window. If you wish to see the entire 

comment, click on it. The comment box will appear. Press the Enter 

key to get rid of the box. When entering or editing a comment, the 

Return key starts a new line of text instead of approving the changes 

as usual in Performer’s user interface. 

You can edit the comments for each track in succession: after 

bringing up a comment box, press the down arrow key to approve 

the changes you’ve made and move to the comment for the next 

track. The up arrow key likewise moves to the comment for the 

previous track. 

The Scroll Bar The horizontal scroll bar allows you to scroll the Track List display 

when part of it is obscured by the Tracks Overview. 

The vertical scroll bar allows you to scroll up and down through the 

Tracks List. Clicking or pressing the Scroll Arrows scrolls by single 

tracks. Clicking the grey part of the bar scrolls by several tracks at 

once. Use the scroll box to move to a particular location in the track 

list. 
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The Window Divider separates the Tracks List from the Tracks 

Overview. You can then drag the divider handle (at the bottom) left 

or right to resize each portion of the window proportionally. If you 

drag all the way to the right, the scroll bar disappears (the divider 

remains). 

The Grow Box allows you to resize the Tracks window. It works just 

like a regular Macintosh window grow box: press and drag it to 

change the size of the window. 

Soloing tracks allows you to isolate tracks for playback. Only selected 

tracks (i.e. those that are highlighted) will be audible when Solo is 

on. This is a quick way to temporarily mute or unmute many tracks 

at once without having to click on the Play-Enable buttons of each. 

Solo is turned on and off from the Tracks window mini-menu or by 

pressing the solo button in the Tracks window title bar; its status can 

be changed during playback. You may also select and deselect tracks 

during playback to change the solo group. 

Individual tracks can be soloed when their edit window is open 

(Event List, Graphic Editing, or QuickScribe notation window) by 

pressing the solo button in the title bar. 

Tracks chosen for soloing must be play-enabled. If the current Tracks 

window is deactivated (for instance, if another window such as the 

Counter window is activated), the solo tracks remain in effect during 

playback even though the tracks lose their highlighting (unless a 

track edit window becomes active, in which case it becomes soloed). 

The highlighting will return when the Tracks window is activated 

again. If the Tracks window is closed, solo is automatically turned off. 

Tracks which are temporarily muted due to soloing have orange Play- 

Enable buttons (or grayed-out buttons on a black and white screen). 

When tracks are muted during soloing, Performer continues to 

process the MIDI data contained in them. This allows tracks to be 

soloed and unsoloed during playback without pauses or glitching. If 

you want to entirely turn off tracks during playback, deselect their 

Play-Enable buttons. To solo tracks: 
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1. Select the tracks you wish to solo by clicking on their names. 

You can change track selection during playback. Use Shift-click to 

select non-contiguous tracks. 

2. Press the Solo button in the Tracks window title bar. 

The Solo button becomes highlighted. 

3. To turn Solo off, click the Solo button again. 

You can turn Solo on and off during playback. 

The solo command (and button) provides an additional capability: 

“partial solo mode”. In this mode, tracks that are being muted are not 

muted all the way. Instead, their volume is brought down part way 

by reducing their note-on velocities by a percentage that you choose. 

To enable partial-solo mode: 

1. Option-click the “S” button in any Edit window title bar, or choose 

“Solo Setup” from the Tracks window mini-menu. 

The Solo Setup dialog appears. 

2. Choose a percentage from the pop-up menu. 

The value you choose is the percent that note velocities in each 

muted track will be reduced to when muted. (Velocities are not 

permanently changed, they are only modified temporarily during 

playback.) 
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3. If desired, check the “Solo tracks selected in Tracks window” 

option. 

This option determines what is soloed when you are editing a 

track in an event editing window (i.e. an Event List, Graphic 

Editing, or QuickScribe notation window is open and active). 

When this check box is unchecked, the solo button in event edit 

window title bar solos the track you are editing. When this option 

is checked, the solo button in the event edit window solos the 

tracks that are currently selected in the Tracks window Cinstead of 

just the one track you are editing). 

4. Click OK. 

Now, when you click the solo button, muted tracks will be 

lowered in volume instead of being totally silenced. To bring them 

back up, just unmute. 

To disable “partial-solo” mode, option-click the solo button and set 

the pop-up menu to “Off”. 

You can add as many tracks as you wish to the track list. When a 

track is added, its name will be “Track-7””, mn being a number. 

To add a new, empty track, simply choose Add from the Tracks 

window mini-menu and the new track will appear on the track list. 

To add several tracks at once, hold down the Option key while 

choosing Add. You will be prompted for the number of tracks to add. 

When you use the Add mini-menu command in the Tracks, Chunks, 

or Sliders windows, Performer adds the new item to the bottom of the 

list. However, if you would like to add an item to a spot in the middle 

of the list, simply highlight an item in the list first. When you use Add, 

the new item will be added just beneath the highlighted item. 

This can also be done with the Duplicate mini-menu command in the 

Sliders window. 

You can add new, empty tracks by duplicating existing tracks. To 

duplicate one or more tracks: 

1. Select the desired track(s). 

See “Selecting Tracks” on page 180. 
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2. Choose Duplicate track layout from the Tracks window mini-menu. 

The duplicate track appears in the Tracks window with the word 

copy is appended to its name. This command does not copy the 

data in the track; instead, it copies only the track’s name and 

playback assignment. 

If you would like to make more than one duplicate, hold down the 

option key while choosing Duplicate Track Layout from the mini- 

menu. A dialog asks you how many duplicates you would like. Enter 

the desired number and click OK (or press return). 

Selecting Tracks If you want to select a region in a track, change a track name, or 

delete a track, you must first select the track. There are several 

methods for selecting tracks: 

To select a single track, click on its name. It will highlight. 

To select several adjacent tracks, press on a track name and drag over 

the desired names. All tracks dragged over will highlight. 

To select several non-adjacent tracks, hold down the Shift key and 

click on the names of the tracks you wish to select. They will 

highlight. 

To deselect tracks when more than one are highlighted, hold down 

the Shift key and click on the tracks you wish to deselect. They will 

unhighlight. 

To select an extended number of tracks, click on a track name, press 

and drag over the tracks you want to select. The track list will scroll, 

selecting all tracks dragged over. 

Deleting Tracks To delete a track, select it by clicking on its name and choose Delete 
from the Tracks window mini-menu. The track will disappear from 

the track list. Delete several tracks at once by selecting them all 

before choosing the Delete command. When a track is deleted, all of 

its data is gone. You can undo the Delete command. 

Looping Tracks Each track can be looped independently. If there are loops in a track, 

the looping indicator is visible in the Tracks Overview. For a detailed 

discussion of loops, see the Looping chapter. 
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The Event Editing windows contain a display of all events in a track. 

Each track has four event editing environments to choose from: the 

Event List window, the Graphic Editing window, the Notation Editing 

window, and the QuickScribe notation window. In these windows 

the time, event type and specific event information (on and off 

velocities, controller values, duration, etc.) for each event are 

expressed numerically, graphically, or as music notation. You can 

edit, add and delete events in these windows as well as select regions 

of events to be modified by commands from the Region menu. 

To open an Event Editing window from the Consolidated Controls 

window: highlight the track name and click the Event List, Graphic 

Editing, or QuickScribe notation button in the Consolidated Controls 

Panel to open the desired window. Or click a track name or track 

segment as follows: 

Do this To open this 

Double-click The event list (or whatever you have 

set in the Preferences command—see 

below) 

Command double-click Graphic Editing window 

Option-command double-click Notation Editing window 

For your convenience, the Preferences command in the File menu 

lets you decide which window opens when you double-click a track. 

For more information, see “Preferences” on page 680. 

For a detailed explanation of event editing in the Event List, Graphic 

Editing, and QuickScribe notation windows, see the Event List 

Window, Graphic Editing, and Notation Editing chapters. 

The Edit Bar holds the starting and ending locations for a region. To 

enter a starting location, click in a field in the Start time and enter a 

value; to enter an ending location, click in a field in the End time and 

enter a value. You can use the Tab key (or decimal point key on the 

keypad) to cycle through the measure | beat | tick fields. 
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There are several quick ways to load times into the Edit Bar. 

Clicking on the word “Edit” loads remembered times into the Edit 

Bar. To “remember” a pair of Start and End times, activate the 

window containing the times and choose Remember Times from the 

Basics menu (or press command-R). Times are remembered for each 

type of window as follows: 

a in a Markers window, the times of the first and last 

highlighted markers are remembered. 

a in an Event Editing window, the times of the first and last 

highlighted events are remembered. 

a in a Tracks window, the times in the Edit Bar are 

remembered. 

a in the Consolidated Controls panel, the times in either the 

Memory or Auto Record bar are remembered, whichever is 

visible. 

Clicking on the word “Start” enters the current time as displayed in 

the Counter window as the Start time. Clicking on the word “End” 

enters the current time as displayed in the Counter window as the 

End time. 

Double-clicking on the word “Start” enters the beginning time of the 

sequence as the Start time. Double clicking on the word “End” enters 

the end time of the sequence as the End time. 

Double-clicking on the word “Edit” set the Start and End times to the 

beginning and end of the sequence. This is equivalent to double 

clicking on both the “Start” and “End” words. 

Selecting a Region This method of region selection allows you to select a region 

Using the Tracks List containing several tracks at once. 

1. Click the Tracks window of the sequence you wish to modify to 

activate it. 
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2. Enter the Start time of the region in the Edit bar. 

See the preceding section, Using the Edit Bar for details on 

entering the Start time in the Edit Bar. 

3. Enter the End time of the region in the Edit Bar. 

See the preceding section, Using the Edit Bar for details on 

entering the End time in the Edit Bar. 

4. Select the track or tracks that contain the region. 

Consult the Selecting Tracks section above for the details about 

track selection. The region is now selected in all the highlighted 

tracks. 

Events occurring on or after the Start time and before the End time 

will be affected by a region command. For example, in 4/4 time, if 

the Start time is 9111000 and the End time is 13111000 all events 

starting on the very first tick of the first beat of bar 9 through the very 

last tick of the fourth beat of bar 12 (12141479) will be modified. An 

event occurring directly on 13111000 (the very first tick of the first 

beat of measure 13) will not be modified. 

The Conductor track is a special track containing markers, meter, 

tempo and key change information. Every sequence always has a 

Conductor track; it cannot be deleted. In the Tracks window, the 

Conductor track has a Move Handle and Comments. The Conductor 

track cannot be looped. Certain editing commands can be used on 

the Conductor track. For more information, see the chapter called The 

Conductor Track. 

A convenient way to create consoles is with the Create Consoles 

command in the Tracks window mini-menu. This command can 

automatically create volume, pan, modulation, and other consoles all 

at once for the tracks you select. 

To create one or more consoles from the Tracks window: 

1. Highlight the Track(s) for which you wish to make consoles. 

Click each track name to highlight it. Shift-click to select tracks not 

next to one another. 
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2. Choose Create Consoles from the Sliders window mini-menu. 

The Create Consoles dialog box appears. 

r Create Console : 

3. Select the dimensions, type, and (optionally) the source setup of 

the sliders for each console. 

You can create more than one type of console. You can even enter 

a custom console name and data type using the Other option. 

4. Click OK to create the console. 

The Console is created and its name is added to the Windows 

menu. 

Tr, acks List Hints There is a difference between using Solo and the Play-Enable Button 

to turn off a track. If a track is muted with Solo, Performer continues 

to scan through the data for that track so that it may resume playback 

of the track at any moment. If the Play-Enable Button for a track is 

disabled, the data for that track is not scanned during playback, 

resulting in slightly less overhead for the computer. Disabling tracks 

may thus result in slightly better performance in playback. If one or 

more tracks are not needed for a particular playback pass, it is best to 
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disable them. A pertinent example is transferring tracks to a multi- 

track tape recorder one at a time: rather than using Solo to mute the 

other tracks, use the Play-Enable buttons to enable one at a time. 

There may be an audible glitch if you re-enable a track during 

playback. 

It is easier to split drum and percussion parts into separate tracks 

because you can quickly and easily select them individually. If all the 

drums are in one track, you have to go into the Graphic Editing 

window to select individual drum parts (snare, bass, high hat, etc.) By 

splitting them into separate tracks, you can simply highlight the track 

name and do your editing. You can split them easily either during 

recording or afterwards with the Split Notes command. 

The Tracks Overview portion of the Tracks window provides you 

with a global view of the MIDI data in a sequence. It is useful for 

arranging parts among tracks, using edit commands such as Cut and 

Paste, and other region operations that affect more than one track at 

a time. It allows you to view and edit the data in your sequence all at 

once instead of one track at a time. 

The Tracks Overview divides each track into equal-length segments, 

which can be zoomed to show as much as 16 measures per segment 

or as little as 30 ticks. Each segment displays how much data is 

present in that segment. Blank segments contain no data. Purple 

segments (or gray ones on a black and white screen) contain 

between 1 and 9 MIDI events, and dark purple (or black) segments 

contain 10 or more events. The threshold between low-density and 

high-density segments (10 events) can be adjusted with the Set 

Density Threshold mini-menu command. 

The Time Ruler shows the time span of each segment. 

Segments can be selected for editing by commands from the Edit and 

Region menus. In addition, Event Editing windows can be opened 

from the segment by clicking as described in the next section. 

The Auto-Scroll command in the Basics menu can make the Tracks 

Overview window scroll during playback. In addition, the window 

will automatically open to the current playback location of the 
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sequence. A scrolling “wiper” can be displayed as well to indicate the 

current playback location. Please refer to the Auto-Scrolling section in 

the Playback chapter for more information. 

The contents of a track segment can be view with any of Performer’s 

three Event Editing windows. To open a window double-click the 

segment as shown below: 

To open this: Do this: 

Event List Double-click (depending on how 

you've set the preferences—see 

below) 

Graphic editing Command double-click 

Notation editing Option-command double-click 

For your convenience, the Preferences command in the File menu 

lets you decide which window opens when you double-click a track. 

For more information, see “Preferences” on page 680. 

The Time Ruler displays the time of each segment in any one of 

Performer’s three time formats. To change time formats, choose Set 

Rulers from the mini-menu. 

You can double-click a segment in the time ruler to make Performer 

jump to that location for playback. You can do so when Performer is 

stopped or during playback. This is an ideal way to quickly locate to 

a desired point with the mouse. 

Zooming the Time Ruler in the Tracks Overview changes the amount 

of time shown in each segment. If you zoom out, each segment 

represents a longer duration, resulting in a more global view of the 

sequence. If you zoom in, each segment represents a shorter 

duration, allowing for more detailed work. 

The Tracks Overview window defaults to showing one measure per 

segment. Zoom-Out levels zoom up to 2, 4, 8, and 16 measures per 

segment (regardless of meter). Zoom-In levels zoom from 1 measure 

down to a quarter note (480 ticks), an eighth note (240 ticks), a 

sixteenth note (120 ticks), a thirty-second note (60 ticks), and a sixty- 

fourth note (30 ticks). 
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To zoom in, click once (or repeatedly) on the magnifying glass with 

the plus sign ( + ). To zoom out, click once (or repeatedly) on the 

magnifying glass with the minus sign ( - ). 

To edit the data in a segment, you must first select the segment. When 

a segment is selected, it highlights, and its contents can be edited 

with any Edit menu or Region menu command. 

Segment selection is exclusive from track name selection in the 

Tracks List. If you select segments, any highlighted track names will 

deselect. 

Below are several convenient shortcuts for selecting segments: 

To select a single segment, click it. 

To select several adjacent segments, drag over them. If the segments 

are in several adjacent tracks, drag over them in a diagonal fashion. 

To select several non-adjacent segments, hold down the Shift key and 

click the segments you wish to select. They will highlight. 

To deselect segments when more than one are highlighted, hold 

down the Shift key and click the segments you wish to deselect. They 

will unhighlight. 

To select a segment in all tracks, click the segment in the Time Ruler. 

All segments beneath will highlight. 

To select one or more segments in all tracks, drag in the Time Ruler. 

After you select one or more segments, Performer loads the start and 

end times of the region into the Edit bar for convenient selection in 

the Tracks List. 
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Clicking anywhere below the tracks in the Tracks Overview deselects 

all currently selected segments. 

Using the View Filter The View Filter allows you to choose what types of MIDI events are 
displayed in the Tracks Overview window. For example, if you 

would momentarily like to see which segments contain patch 

changes, you can open the View Filter and option-click the patch 

change check box (to select it and deselect all others). With only 

patch changes selected, only segments that contain a patch change 

will become grey. As you can see, the View Filter can be an effective 

tool for working with only a few types of data at a time. The View 

Filter affects all Event Editing windows as well as the Tracks 

Overview window. 

The View Filter also determines which types of events are affected by 

Edit menu commands when the data is selected in the Tracks 

Overview window. Here’s a simple rule to remember: if you can see 

data in the Tracks Overview window, it will be affected by edit 

commands. 

Please note that Conductor track data such as Markers and Meter 

changes, which are displayed in the Event Edit windows of regular 

tracks, are displayed only in the Conductor track in the Tracks 

Overview. 

To use the View Filter from an Event List window: 

1. Choose Set View Filter from the Event List mini-menu. 

A dialog box will appear. 
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2. Choose the data types to be displayed by checking the box for 

each. 

You can choose all types of data at once by clicking on the “Set 

All” button. You can uncheck all the check boxes by clicking on 

the “Clear” button. Option-click to check only the check box you 

click on, unchecking all others; command-click to check all boxes 

except the one you click on. Use the Controllers option to specify 

which controller information is displayed. 

3. Press OK to confirm your choice or Cancel to cancel it. 

When using the View Filter, keep these rules in mind: The View Filter 

settings you select will stay in effect until you change them. They 

affect all open Event Editing windows. The View Filter settings will 

affect all edit operations done in the Event Editing windows. 

The Set Density Threshold mini-menu command allows you to specify 

the difference between low-density and high-density track segments. 

The default value is 10 MIDI events, so that a segment containing 

between 1 and 10 MIDI events will appear purple (or gray on a black 

and white screen), and a segment containing 10 or more will appear 

dark purple (or black). You can change the 10—event threshold to any 

value between 1 and 999 events. 

In general, the lower the threshold value, the easier it is for Performer 

to count events and display segments. Higher thresholds may cause 

Performer to redraw the segments a littke more slowly. However, if 

you have a fast Macintosh (68020 or 68030 CPU), you probably won't 

notice much of a difference between low and high thresholds. 

To set a loop in the Tracks Overview: 

1. Select the segments that you wish to loop. 

Drag over them. You can select segments in more than one track 

if you like. If you select different time regions in more than one 

track, the loop region will in every track will be the earliest 

selected time to the latest selected time. 

2. Choose Set Loop from the Change menu or click the Loop button 

in the Consolidated Controls window. 

The Set Loop dialog box will appear. 
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3. Choose the number of times that you would like the loop to repeat. 

4. Click OK to create the loop or Cancel to withdraw the loop 

command. 

Creating Sequence The Create Chunk mini-menu command in the Tracks Overview 

Chunks window takes selected segments in the Tracks Overview window and 

turns them into their own sequence Chunk in the Chunks List 

window. 

The Create Chunk command makes it easy to break up a sequence 

into separate pieces (Chunks) in order to rearrange them more freely 

in a Song window. For example, let’s say that you have built several 

phrases that are a few bars long in a Sequence. But now you want to 

rearrange them and try different combinations. To do so, you can 

select the segments of a phrase and choose Create Chunk from the 

mini-menu for each one. Then, you can drag the resulting sequence 

Chunks from the Chunks list window into an empty Song window to 

try different orders and combinations. 

Once you have arranged the Song as you like, you can even convert 

it back into a sequence using the Song window mini-menu command 

called Merge Chunks to Sequence. This command takes the separate 

Chunks inside the Song window and reduces them to a single 

sequence Chunk. 

At any time, you can take your music freely back and forth from 

Sequence form to Song form with these two commands to help you 

create your music. 

To create a sequence Chunk from the Tracks Overview window: 

1. Select the Segments that you wish to be in the Chunk. 

Alternately, you can select the region from the Tracks List by 

highlighting track names and setting a region in the Edit bar. See 

the section earlier for information about selecting segments. You 

can even select non-adjacent segments. 

2. Choose Create Chunk from the Tracks Overview window mini- 

menu. 

A dialog box appears. 
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Create Chunk 

0-:00.0 

3. Type in a name for the Chunk. 

4. Type in an End Time to determine the length of the Chunk. 

By default, the end time is determined by the length of the 

selected region. 

5. (Optional) Type in any other information you wish about the Chunk. 

6. Press OK to confirm your choice or Cancel to withdraw the 

command. 
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Customizing the The Tracks window can be completely customized. This allows you 

Tracks Window to set it up in the way that best suits the way you work. The diagram 

below summarizes what you can do. 

Double-click the column headings 
to open the dialog box shown to the 
left (or choose “Columns Setup” 
from the mini-menu), which lets you 
choose the columns you want to 
see. Below, only the record-enable 

{rack Columns 

buttons, playback assignment, track 
names, and MIDI level meters are 
displayed. The rest of the columns 
are being hidden. Reorder the 
columns by dragging the column 
heading left or right. 

These Auto Scroll options (Basics menu) produce 
this scrolling highlight, which clearly indicates 
track playback position in the Tracks Overview. 

MIDI level meters display 
degree of MIDI activity or 
note-on velocities in each gees eee! SEIU 
track during playback. To oe 
configure the meters in the 

setup dialog shown to the 
right, choose “Level Meter 
Setup” from the mini-menu, 
or double-click any level 
meter. 

For details about these 
options, see “Configuring 
the MIDI level meters” on 

page 193. 

The devices that appear in this list are provided by FreeMIDI. 
You can customize your FreeMIDI device configuration to 
exactly match your MIDI studio. You can even make custom- 
ized device groups. 
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Configuring the MIDI The MIDI level meters in the Tracks window can be configured in 

level meters several ways. To set these options, double-click any level meter (or 

choose Level Meters Setup from the mini-menu) to open the Level 

Meters Setup dialog box shown below. Settings in this dialog box are 

global across files and are automatically saved in the Performer 

Preferences file in the System Folder. 

‘Level Meter Setup. 

Showing MIDI activity or velocity 
Level meters can show either MIDI activity or velocity. With MIDI 

activity, the meter is triggered every time a MIDI event is played back 

from the track. It can be any type of MIDI data, including notes, 

controllers, pitch bend, sysex data, etc. With velocity, the level meter 

reflects the note-on velocity of each note at the instant the note is 

triggered during playback. 

@ MIDI level meters do not function like audio level 
meters. For both MIDI activity and velocity, the MIDI 

level meter is triggered by a MIDI data byte, such as a 

note-on event or controller, at the time it is played 

back. The level does not sustain during the duration of 

the note. 

Monitoring 
Level meters can monitor MIDI data being played back, recorded, or 

both. With both options checked, the meters monitor playback when 

you are playing back, and they monitor recorded material on the 

The Tracks Window 193 



current record-enabled track during recording. If you are in overdub 

record mode, both recording and playback are monitored at the same 

time for the record-enabled track. 

We recommend using both options because this gives you the 

greatest amount of feedback about what is going on in your tracks. 

Level Decay Time 
Level Decay Time refers to how quickly the meters return to zero. The 

decay amount is expressed as an arbitrary value between zero and 

99. For music that consists mostly of sixteenth notes, eighth notes, 

quarter notes, and longer, try level decay time values between 5 and 

20 at tempos between approximately 80 and 160 bpm. If the tempos 

are extreme, or if notes are particularly dense or sparse, you might 

find it helpful to use level decay times below 5 or above 20. 

In general, shorter decay times are better for fast tempos and/or 

dense passages of notes. Longer decay times are better for slower 

tempos and/or sparse passages. If you find that the meters don’t stay 

up long enough for you to see them, try a higher value; lower the 

decay time if levels go up and then don’t change very much. Decay 

times above 30 are very slow and would probably only be useful in 

extreme cases (very slow music, lighting control sequences, etc.) 

Hiding level meters to Performer goes to great lengths to preserve the integrity of MIDI 

reduce overhead playback. Screen display takes a back seat to the more important 
function of playing back the sequence with as accurate timing as 

possible. However, the level meters do require some effort from 

Performer. In some situations, such as running Performer on a slower 

Macintosh, it may be desirable to hide the level meters to ensure the 

highest playback performance. The Performer installation guide 

booklet has a chart that ranks Macintoshes by power and speed. If 

you have the equivalent of a Mac Isi or above, you shouldn’t need 

to hide the meters, unless you have an unusually large number of 

tracks—more than a hundred. 

To hide the level meters, double-click the track column heading 

above the level meters Cabelled “LEV”) to open the Track Columns 

Setup dialog box as shown on page 192. Uncheck the Levels option. 
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If you’d rather not hide the meters, another overhead-reducing tactic 

is to monitor MIDI activity instead of velocities because MIDI activity 

monitoring requires less effort. Open the Level Meters Setup dialog as 

explained on page 192 and select the MIDI Activity option. 

Switching to a different If you are working with multiple sequences in a file, you can switch 

sequence within the between them in the same Tracks window by command-clicking the 

same window sequence name in the title bar. A pop-up menu appears from which 

you can choose the sequence you'd like to see. 
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Chapter 13 Looping 

Basics 

A loop is a region of data in a track that is played repeatedly. The 

result is similar to using the Repeat command on the Edit menu to 

insert multiple copies of a region. Instead of actually copying the 

data, however, the loop feature simply replays the region over and 

over. Looping is thus more memory-efficient than making repeated 

copies of a region. Also, making a change in a looped section is easy: 

instead of changing every repeat of the data as you would if you had 

copied and pasted it, you simply change the data in the looped 

region. Tracks or sections of tracks can be looped independently; it is 

thus possible to build a complex sequence out of a small number of 

events. 

A loop is different from the Memory-cycle button because a loop is a 

permanent addition to a track. In addition, the loop only loops one 

track, whereas Memory-cycle loops the entire sequence. For 

information about Memory-cycle looping, see “The Memory-cycle 

button” on page 71. 

A loop has three components: a start point, an end point and a 

number of repetitions. When a loop starts, it plays through its data 

normally. When the end point is reached, the region is played again 

from the start point. This cycle repeats for the specified number of 

repetitions, or indefinitely if an infinite loop is specified. 

When the loop finishes its number of repetitions, the next data played 

will correspond to the location on the Counter. For example, the 

region from measure 1111000 to 4111000 is looped four times. After 

the loop finishes, the Counter will be at measure 13 (four times three 

measures is twelve: measure 13 comes after measure 12). The data in 

the track continues playing from measure 13, not from measure 4. If 

there is any data in measures 4 through 12, it is skipped. The loop 

takes precedence over any intervening data. 

The reason that the data is skipped is so that there is no ambiguity 

about the current location being played. If the Counter were to 

display 20111000 and three tracks are playing back data at that spot 
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and another has finished its looping and is playing back at 15131000 

and another at 12121240 and another at 3141000... things could get 

very confusing. Therefore, the location in the Counter applies to all 

tracks; it is not affected by loops. 

When moving to a location in a sequence, Performer figures out 

whether any tracks are in the middle of a loop and keeps count of 

where in the looping process these tracks are. This allows you to 

begin playing or recording from any location and be sure that the 

loops will all play correctly. 

Notes can be sustained across loop boundaries: if a note is inside a 

loop, it will always sound for its specified duration. 

Each track has its own set of loops. This means that each track can 

be looped independently of others. The Conductor track cannot be 

looped. CYou can, however, temporarily loop the entire sequence 

using the Memory-cycle button.) 

A loop starts right on its Start time and ends just before its End time. 

For example, a loop set from 1111000 to 4111000 would play the 

data from 1111000 to 3141479; the next repetition would play the 

same data immediately at 4111000. The number of repetitions equals 

the total number of times you want the region to play; this includes 

the first pass. 

A loop need not be set on measure boundaries (i.e. on beat one, tick 

zero of the measure). They can start anywhere in a measure. We’ll use 

loops starting on measure boundaries as examples to keep things 

clear. In practice, any location is fine. 

If you want to set a loop in several tracks at once, just highlight all of 

the desired tracks at once before you set the loop. 

If a track contains loops, a looping indicator appears in the Loop 

column next to the track name and in the track segment in which it 

begins This indicator can’t be used to change anything: it is merely a 

reminder that the track contains loops. 

Each track may can contain multiple loops. You can even have nested 

loops in a track, i.e. loops within loops. Here’s an example of nested 

loops, all in the same track: 
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= Bars 1 to 3 played 8 times Casting from bar 1 to 17) 

mw Bars 17 to 19 played 4 times Casting from bar 17 to 25) 

mw Bars 25 to 27 played 4 times Casting from bar 25 to 33) 

a Then the whole 32 bar section is looped: 

= Bars 1 to 33 played 4 times (lasting from bar 1 to 129) 

When bar 33 is reached, bars 1 to 3 will be played another 8 times, 

bars 17 to 19 another 4 times, and bars 25 to 27 another four times. 

Then this whole process will repeat twice more until bar 129 is 

reached. 

When Loops Conflict It is possible to set up loops such that they overlap with each other 
or otherwise conflict in the same track. When this happens, the first 

loop in the track takes precedence. When two conflicting loops start 

at the same time, the one that has a later ending time takes 

precedence. 

Here are some examples of the effects of conflicting loops: 

= Bars 1 to 9 played four times, bars 5 to 13 played four 

times. 

The first loop takes precedence. Bars 1 to 9 are played and the 

loop repeats back to bar 1. The second loop is ignored. 

m Bars 1 to 17 played four times, bars 1 to 3 looped infinitely. 

Bars 1 to 3 are played eight times, lasting until bar 17. Then the 

“outer” loop (the one with the later end time) takes over, 

terminating the “inner” loop. This returns to bar 1, playing the 

inner loop eight times again. This cycle repeats four times until the 

outer loop is finished. At that point, the sequence is at bar 65 and 

it continues playing from there, all previous loops done. 
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m= Bars 1 to 5 played four times, bars 5 to 7 played eight 

times. 

The second loop is completely ignored since its time is skipped 

while executing the first lop. When a loop begins at a time that 

is skipped after executing a previous loop, that loop is ignored 

(ike all other data in the skipped region). 

Cr eating a Loop There are two ways to create loops: the Set Loop command, and the 

Insert button in the title bar of Event Editing windows. 

Setting a Loop To use the Set Loop Command: 

1. Activate the Tracks window for the sequence in which you wish to 

set the loop. 

Double-click the name of the sequence in the Chunks window or, 

if it is already open, click the window once. 

2. Select the track(s) or track segments in which you wish to set the 

loop. 

Highlight the desired track names, or drag over the desired track 

segments. If several tracks are selected, each will have the same 

loop set for it. You may not loop the Conductor track. 

3. Optional: Enter the Start and End times of the loop region in the 

Edit Bar. 

Remember Times, documented in the Event List Window chapter, 

is useful for entering times in the Edit Bar. The loop boundaries 

can also be entered in the Set Loop dialog box. 

4. Choose Set Loop from the Change menu. 

A dialog box appears. 
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Inserting Loops in the 
Event Editing Windows 

Looping 

5. Edit the Start and End times if necessary, then enter the number of 

times you want the loop region to be played. 

The number you enter will be the total number of times the region 

is played. If you want it to play indefinitely, choose the Infinite 

loop option. 

Press the OK button to confirm your entry or the Cancel button to 

cancel it. 

Loops can be inserted directly into a track from either the Event List 

window or the Graphic Editing window. 

To insert a loop into a track using the Event List window: 

1. Open the Event List containing the passage you'd like to loop. 

2. Press the Insert button in the title bar and choose Loop from the 

menu. 

A new loop event pops up. 

Enter the start and end locations and the number of repetitions for 

the loop. 

Use the Tab key to move from field to field. If you type “i” in the 

repetitions field, Performer will fill in the word “infinite”. 
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Viewing and Editing 
Loops in an Event 
Editing Window 
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4. To enter the loop, press Return. To cancel, click anywhere with the 

mouse. 

If you'd like to insert another loop, press the Enter key. This enters 

your loop and produces another new loop event. 

To insert a loop in a track’s Graphic Editing window: 

1. Press on the Insert button in the title bar of the Graphic Editing 

window and choose Loop from the menu. 

The menu will disappear and the mouse pointer will turn into a 

cross-hair. 

2. Click at the desired start location in the Marker Strip, drag to the 

right to draw the desired length, and release the mouse at the end 

location. 

A loop will appear. Use the dotted hairlines in the Time Ruler to 

align the beginning and end of the loop while inserting it. 

Information about the loop will appear in the Information bar. 

Loops can be viewed and edited in the Event List window for the 

track that contains them. Viewing loops in event lists is a good way 

to see them in context. This will help you to see when they occur, 

what data they cause to be skipped, etc. 

Nested loop 

Looped events 

Skipped loop events 

Events in a loop are indented to the right in the Event List window. 

Events in nested loops are indented further to the right. Events that 

are skipped due to loops are displayed in italics. These display 
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Editing Loops with the 
Edit Menu 

Removing Loops Using 
the Clear Loops 
Command 

Looping 

features will let you see immediately which events are within loops, 

what level of loop nesting is happening at any given location and 

what the effect of the loop is, i.e. what data will be skipped. 

You can edit loops in the Event List window just like any other 

parameter. Simply click on the data in the loop you wish to change 

and enter a new value. To clear a loop or loops from an event list, 

simply highlight the loop event(s) and select Erase from the Edit 

menu. 

Loops can also be edited in the Graphic Editing window for each 

track. For more information, see the chapter The Graphic Editing 

Window. 

Loops can be edited like any other event with the commands on the 

Edit menu. If you Cut, Paste, or otherwise edit a region that contains 

loops, the loops will be edited along with the other events. 

To edit loops using the Tracks window and the Edit menu, first make 

sure Loops are checked in the Edit Filter. Then select the track(s) to 

be edited, define the region using the Edit Bar Start and End times, 

and choose the desired command from the Edit menu. Checking only 

Loops in the Filter is useful for editing loops without altering the 

MIDI data in the selected region; this is similar to using the Clear 

Loops command. Note that by default, loops are unchecked in the 

Edit Filter. 

To remove a loop or loops, select a region that contains the loops and 

select Erase from the Edit menu, or use the Clear Loops command. 

The Clear Loops command in the Changes menu is used with the 

Tracks window Edit Bar, and is a handy shortcut for removing loops. 

To remove a loop or loops, select a region that contains the loops 

using the Edit Bar Start and End times, and choose the Clear Loops 

command from the Change menu. Loops that begin inside the 

specified region are erased; MIDI data is unaffected. 

For example, Track-1 contains loops at measures 1 to 4 and measures 

3 to 9. If the Edit Bar Start and End times are 2! 11000 and 9111000, 

only the second loop will be cleared. 
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Loop Recording “Loop recording” is the process of overdub recording into a region 

over and over again to build up a pattern. This is best done with the 

Memory-cycle feature in Performer. See “The Memory-cycle button” 

on page 71 for detailed information. Once you have built a pattern 

using Memory-cycle, you can insert a permanent loop over the 

region. See “Quickly selecting what you have recorded” on page 78. 

By using Memory-cycle with overdub recording, Performer can 

function in a manner very similar to the way most commercial drum 

machine sequencers work: by building up patterns in multiple passes 

through a section. 
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Chapter 14 The Chunks Window 

Quick Reference 

Sequence Song 

FY 

The Chunks window displays the Chunks in a Performer file. A 

Chunk is either a sequence (a collection of tracks) or a song (a 

collection of sequences and other songs). A Performer file can 

contain as many Chunks as memory in your Macintosh will allow. 

Chunks can be cued for playback, either automatically or manually, 

in order or at random. You can also build an entire song out of other 

sequences and songs by chaining and stacking Chunks in the Song 

window, which provides seamless, simultaneous playback of Chunks 

in any order and combination. 

Type: Displays each Chunk’s type by icon, either Song or Sequence. 

This icon is used to drag Chunks into Song windows and to change 

the order of Chunks in the Chunks window. 

Play: Shows the play-enable button for each Chunk. When a Chunk’s 

play-enable button is black, the Chunk is play-enabled. Only one 

Chunk can be play-enabled at a time. 

S# (Song Select Number): Displays the song select number that will 

play-enable the Chunk when received from a MIDI controller. Song 

select numbers range from 0-127. If a Chunk has no song number 

assigned, the column displays a single dash (-). 
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If Performer receives a song select number that is assigned to two or 

more Chunks, Performer will cue the Chunk that appears highest in 

the list. For this reason, it is best to assign a unique Song Select 

number to each Chunk. 

End time: Displays each Chunk’s End time. In automatic mode, End 

time is the downbeat of the measure following the last complete 

measure in the Chunk. When a Chunk’s End time is in manual mode, 

it is bold and can be pop-edited to any length. 

Name: Displays the name of the Chunk. Click the name to select the 

Chunk. Option-click the name to change it. Double-click the name to 

open the Tracks or Song window belonging to the Chunk. 

Because Chunks can be imported into other files, dragged without 

limit into Song windows, and duplicated very easily, always use the 

most descriptive Chunk name possible to avoid confusion. 

Comments: Displays as much as possible of your comments for each 

Chunk. View and edit the comments by clicking them. 

The Chunks Window The Chunks window mini-menu contains the following commands: 

Mini-menu 
Add Sequence: Adds a sequence to the Chunk list. To add several 

sequences at once, press the Option key while choosing Add. 

Add Song: Adds a song to the Chunk list. To add several songs at once, 

press the Option key while choosing Add. 

buto, Duplicate Track Layout: Creates a new, empty sequence with the same 
wee ey me Ze 

Peis coli | track layout as the selected sequence. Select an existing sequence 

before choosing this command. 

Open Chunks: Opens a Song window for each highlighted song and a 

Tracks window for each highlighted sequence. 

Auto/manual end time: Toggles the Auto/manual status of the selected 

Chunks. Automatic mode locks the Chunk’s End time at the 

downbeat of the measure following the last complete measure in the 

Chunk. Manual mode changes the time to boldface and allows it to 

be pop-edited. 
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Basics 

Opening the Chunks 
Window 

Sequences 

The Chunks Window 

Set Chunk Start: Establishes the start times of the currently selected 

Chunk(s) in each of Performer’s three time formats: measures, real 

time, and SMPTE time. The start times are what you see in the 

Counter window when you rewind back to the beginning of the 

Chunk. This is the same window that appears when you click the 

Start Time button in the main counter. 

Delete: Deletes the selected Chunks. If you attempt to delete a Chunk 

that is part of a song in the open file, a dialog box appears, 

prompting you to confirm your decision. 

The Chunks window lists the Chunks in a file and provides useful 

features to manage them, such as adding, deleting, and other 

operations. In addition, Chunks can be dragged from the Chunks 

window into a Song window to build a song. For more information, 

see the chapter 7he Song Window. Chunks can also be automatically 

cued to playback in the order in which they are listed in the Chunks 

window. For more information about cueing, see “The Chunk Control 

buttons” on page 78. Chunks can also be cued remotely from your 

MIDI controller. For more information, refer to The Remote Controls 

Window chapter. 

To open the Chunks window, choose Chunks from the Windows 

menu. The Chunks window will appear, displaying a list of all 

sequences and songs in the open file. Within the Chunks window, 

songs and sequences have different icons but behave identically. 

A sequence is a complete MIDI performance consisting of any 

number of tracks, which are listed in that sequence’s Tracks window. 

Each track contains MIDI data which may be assigned to any 

combination of channels. A sequence also has a Conductor track, 

which contains meter, key, and tempo information. 

Many essential operations on tracks are done in the Tracks window: 

tracks are added and deleted, editing regions within tracks are 

specified, Event Editing windows for tracks are opened and much 

more. See The Tracks Window chapter for complete details about its 

operation. 

Each sequence also has its own Markers window. See The Markers 

Window section for details about it. 
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Songs A song is a collection of Chunks that you organize to play back in the 
preferred order and combination. Each song has its own Conductor 

| track, End time, and markers. Each song has its own Song window, 

where you arrange the Chunks that comprise the song. The Song 

window is described later in this manual. 

Selecting Chunks There are several methods of selecting Chunks: 

To select a single Chunk, click on its name. The name will highlight. 

To select several adjacent Chunks, click a Chunk name and drag over 

the desired names. All Chunks dragged over will highlight. 

To select several non-adjacent Chunks, hold down the Shift key and 

click on the names of the Chunks you wish to select. They will 

highlight. 

To deselect Chunks when more than one are highlighted, hold down 

the Shift key and click on the Chunks you wish to deselect. They will 

unhighlight. 

Creating New Chunks To create a new, empty sequence, choose Add Sequence from the 
Chunks window mini-menu. To add several new sequences at once, 

hold down the Option key while choosing Add Sequence. You will be 

prompted for the number of sequences to add. 

To create a new sequence with the same track layout as an existing 

sequence, highlight the existing sequence and select Duplicate Track 

Layout from the Chunks window mini-menu. A new sequence will be 

added with the same name as the sequence you highlighted 

preceded by the words Copy of. It will have the same track layout as 

the highlighted sequence: the number of tracks, the track names, and 

the track playback channel assignments will be identical to the 

original. 

To create a new, empty song, choose Add Song from the Chunks 

window mini-menu. To add several new songs at once, hold down 

the Option key while choosing Add Song. You will be prompted for 

the number of songs to add. 
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Duplicating Existing 
Sequences 

Loading and Linking 
Chunks from Another 
File 

Splitting Up an Existing 
Sequence into Separate 
Chunks 

The Chunks Window 

Sometimes you may want to duplicate a sequence to experiment with 

changes or for some other reason. Be sure that the Memory window 

shows plenty of free memory before you duplicate. To duplicate a 

sequence: 

1. Highlight the sequence’s name in the Chunks window. 

2. Choose Copy from the Edit menu. 

3. Choose Paste from the Edit menu. 

An exact copy of the sequence, including all the data in the tracks, 

will be placed at the end of the list in the Chunks window. 

Rename it immediately so that you do not get the copy and the 

original mixed up. 

Performer’s Load command allows you to quickly import Chunks into 

an open file from another, unopened Performer file. 

It’s easy to run low on memory when working with several 

sequences and songs. So that you aren't restricted by memory when 

loading Chunks, Performer lets you load either a Chunk’s actual data, 

or just a Link to that data. The Data and Link sub-options determine 

which will be loaded. Loading a link to a Chunk instead of the Chunk 

itself saves a great deal of memory, allowing even a two Megabyte 

Macintosh to support a long list of Chunks. 

For step-by-step instructions to load and link Chunks, please refer to 

the chapter Working With Files. 

The Create Chunk mini-menu command in the Tracks Overview 

window takes selected segments in the Tracks Overview window and 

turns them into their own sequence Chunk in the Chunks List 

window. 

The Create Chunk command makes it easy to break up a sequence 

into separate pieces (Chunks) in order to rearrange them more freely 

in a Song window. For example, let’s say that you have built several 

phrases that are a few bars long in a Sequence. But now you want to 

rearrange them and try different combinations. To do so, you can 

select the segments of a phrase and choose Create Chunk from the 
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mini-menu for each one. Then, you can drag the resulting sequence 

Chunks from the Chunks list window into an empty Song window to 

try different orders and combinations. 

Once you have arranged the Song as you like, you can even convert 

it back into a sequence using the Song window mini-menu command 

called Merge Chunks to Sequence. This command takes the separate 

Chunks inside the Song window and reduces them to a single 

sequence Chunk. 

At any time, you can take your music freely back and forth from 

Sequence form to Song form with these two commands to help you 

create your music. 

To create a sequence Chunk from the Tracks Overview window: 

1. Select the Segments that you wish to be in the Chunk. 

Alternately, you can select the region from the Tracks List by 

highlighting track names and setting a region in the Edit bar. See 

the section earlier for information about selecting segments. You 

can even select non-adjacent segments. 

2. Choose Create Chunk from the Tracks Overview window mini- 

menu. 

A dialog box appears. 

Create Chunk > 

SSE 
___ 0:00.00 

3. Type in a name for the Chunk. 
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Deleting Chunks 

Choosing the Current 
Playback Chunk 

The Chunks Window 

4. Type in an End Time to determine the length of the Chunk. 

By default, the end time is determined by the length of the 

selected region. 

5. (Optional) Type in any other information you wish about the Chunk. 

6. Press OK to confirm your choice or Cancel to withdraw the 

command. 

To delete a Chunk, click its name to highlight it and choose Delete 

from the Chunks window mini-menu. To delete several Chunks at 

once, highlight the name of each one as described in the Selecting 

Chunks section above. You can Undo this command. 

At any given time, one Chunk is designated as the current playback 

Chunk. This Chunk is the only one you can play and record into. 

Certain functions, such as recording, are available only to the 

currently play-enabled Chunk. For example, if a sequence is play- 

enabled, its Tracks window has record-enable buttons by its tracks. If 

a song is play-enabled, one of its component sequences can be 

record-enabled. Only that sequence’s Tracks window will have 

record-enable buttons. 

You may edit any Chunk in the file at any time regardless of whether 

it is play-enabled or not. 

To play-enable a Chunk: 

m Click the play-enable button to the left of the Chunk name. 

It will turn solid black. The play-enable buttons of the 

other Chunks will be hollow. 

OR 

m Click the Skip buttons as needed until the chunk’s name is 

displayed in the Info bar in the Consolidated Controls 

panel 
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Opening Chunks 
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Current sequence or song 

Performer also provides two different methods of play-enabling 

Chunks from a remote device. 

The first method is with the Chunk select remote controls found in 

the Remote Controls window, where each Chunk is assigned a 

Macintosh key and MIDI event. You play-enable a Chunk by pressing 

its corresponding Macintosh key or sending its corresponding MIDI 

event from your MIDI keyboard (or controller). Please refer to the 

chapter 7he Remote Controls Window for more information. 

The second method is Chunk Select, which allows you to cue Chunks 

for playback by sending a MIDI Song Select message from a MIDI 

controller. The Chunks window column S¥ displays the Song Select 

number that, when received, will cue the corresponding Chunk for 

playback. If a Chunk has no Song number assigned, the S# column 

displays a single dash (-). 

Most hardware sequencers and some MIDI keyboard controllers can 

send and receive Song Select messages. Simply send a Song Select 

message as instructed in that module’s documentation. If the open 

file contains a Chunk assigned to the Song number in the message, 

that Chunk will be play-enabled. If more than one Chunk has the 

same Song number assigned, the one highest in the Chunks list will 

be cued. 

When used in combination with the Chunk Chaining buttons in the 

Consolidated Controls panel, a Song Select message cues the 

corresponding Chunk to be play-enabled or played back. 

Each sequence Chunk has its own Tracks window, and each song 

Chunk has its own Song window. To see a Chunk’s Tracks or Song 

window, click the Chunk’s name to highlight it and choose Open 

Chunks from the Chunk window mini-menu. Or just double-click the 

Chunk name. 

The Chunks Window 



Rearranging the Order 
of Chunks 

Changing the Name of a 
Chunk 

Entering Comments 

The Chunks Window 

You may rearrange the Chunks in whatever order is most meaningful 

to you. To change the position of a Chunk in the Chunks list: 

1. Press the type icon of the Chunk you want to move. 

A grey outline appears delineating the Chunk. 

2. Drag the mouse to the position where you want the Chunk. 

You can use the grey outline to determine the position of the 

Chunk. 

3. Release the mouse button. 

The Chunk will appear in its new position. 

Rearranging the order of the Chunks is a useful organizational tool. In 

addition, it lets you determine the Chunks’ default cueing order when 

using the Skip, Cue Chunks, and Chain Chunks buttons described 

later in this chapter. 

To change the name of a Chunk: 

4. Option-click the name of the Chunk. 

A small box will pop up. 

5. Type the Chunk name in the box. 

6. Press the Return key to confirm the name or Command-period to 

cancel it. 

You can use the Enter or down arrow Key to approve the change 

and edit the next Chunk name in the list. You can also use the up 

arrow key to approve the change and edit the previous Chunk 

name in the list. 

To enter or modify comments for a Chunk: 

1. Click in the comments field to the right of the Chunk name. 

A box appears. If you’ve already entered a comment for the 

Chunk, the entire comment appears highlighted in the box. 

2. Enter or edit the comment. 
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3. Click OK to confirm the changes you’ve made and close the 
comments box, or click Cancel to discard the changes. 

Press the down arrow key or the Enter key to approve the changes 

you’ve made and move to the comment for the next Chunk. The 

up arrow key likewise moves to the comment for the previous 

Chunk. 

When entering or editing a comment, the Return key starts a new line 

of text instead of approving the changes as usual in Performer’s user 

interface. 

Auto Versus Manual End The Chunks window field End Time displays either the automatic, 

Time Performer-generated ending time of the Chunk, or a time that you 

have entered manually. It’s important to understand how this time 

affects your music. 

Performer offers two ways of playing Chunks sequentially: by 

arranging Chunks vertically and horizontally in the Song window, 

and by Chunk Chaining using the Cue Chunks, Chain Chunks, and 

Skip buttons in the Consolidated Controls panel. The End time shown 

for each Chunk in the Chunks window affects these two types of 

chaining differently. 

When a Chunk is in a Song window, the Chunks window End time 

does not affect the playback length of the Chunk. Within a song, a 

Chunk will play every note it contains, regardless of its Chunks 

window End time. What it does affect is column placement. Columns 

appear automatically at the End time of each Chunk dragged into the 

Song window. This makes it easy to place Chunks end to end. 

For example, a Chunk whose last attack is at 4141322 will have an 

automatic End time of 5111000. When this Chunk is dragged into a 

Song window at time 1111000, a column will appear at 5111000, 

making it very easy for you to place the next Chunk in a metrically 

logical location. If you prefer a 5-bar phrase, just change the End time 

to 6111000. The end column will appear at 6! 11000, even though the 

Chunk only plays through four measures. 

Again, remember that the Chunk End time does not affect playback 

in the Song window, only the column placement. 
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Building a Song with 
Chunks 

When using the Chunk controls in the Consolidated Controls panel, 

you'll find that each Chunk’s End time does affect its playback length. 

For example, clicking Play with the Chain Chunks button enabled 

causes playback of one Chunk after another, each Chunk playing 

until the Counter reaches that Chunk’s End time. Phrases, even notes 

that normally would last through the End time will be cut off. You can 

avoid this by setting a Chunk’s End time to be later, thereby building 

sustain into the Chunk’s play length. 

In summary: regardless of auto/manual status, in the Song window 

the End time determines the Chunk’s ending column location but not 

its playback length. During Chunk Chaining, playback actually stops 

at the End time. 

For more information about the Song window and Chunk cueing, 

please refer to the chapter, The Song Window and “The Chunk 

Control buttons” on page 78, respectively. 

To build a Song out of Chunks in the Chunks window, drag their type 

icon into a Song Window. For complete information, please refer to 

the next chapter, 7e Song Window. 
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Copying tracks From Use the following procedure to copy between sequences that have 

One Sequence Chunk to the same track layout (i.e. the same number of tracks, preferably with 

Another the same MIDI channel assignments). Jf the sequences have different 

track layouts, this procedure will not work correctly. See the chapter 

The Tracks Window for more information. 

To copy from sequence A and paste into sequence B: 

i= 
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Activate the Tracks window of sequence A. 

Click anywhere in it to activate it. 

Set the start and end times in the Edit bar to define the region you 

wish to copy. 

To select the entire sequence, simply double-click the word Edit 

in the Edit bar. 

Highlight all the track names in Sequence A. 

Either click and drag over them, or choose Select A// from the Edit 

menu. 

Select Copy from the Edit menu. 

As a short cut, press command-C. 

Activate the Tracks window of Sequence B. 

Set the Start Time in the Edit bar to the time at which you want to 

paste the material into sequence B. 

. Highlight all the track names in Sequence B. 

. Select Paste from the Edit menu. 

The information from Sequence A is pasted into Sequence B at the 

Edit Bar Start Time of Sequence B. 
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Chapter 15 The Song Window 

In Performer, a song is a collection of Chunks. The Chunks that make 

up a song are displayed in that song’s window, plotted on a grid 

beneath a horizontal, non-linear time ruler. The Song window is the 

work space in which you arrange the Chunks in time and in relation 

to other Chunks. 

By dragging and using standard Edit commands on the Chunks, you 

can arrange them to graphically represent the order and 

combinations in which you want them to play back. What you see is 

what you will hear: adjacent Chunks will play one after the other, and 

stacked (vertically aligned) Chunks will play simultaneously. 

Arranging in the Song window can done in real time while the song 

is playing back. 

Quick Reference 

Insert Record-enabled 

chunk 

Song name 

Time ruler —>]j 

Marker strip——+» | 

Sequence chunk Selected chunk 

Song chunk 

Columns Chunk grid 

Chunk Grid: Serves as a workspace in which you arrange Chunks. The 

grid will not scroll when you drag a Chunk to one of the borders; this 

allows you to delete a Chunk by dragging it out of the window, or to 

drag a Chunk to another Song window. 
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Song Chunks and Sequence Chunks: Represent songs and sequences that 

have been dragged into the Song window. Click a Chunk once to 

select it, twice to open its Song or Tracks window. Change a Chunk’s 

name by option-clicking it in the Chunks window. If a Chunk’s name 

is longer than its Chunk icon, the first several letters will be followed 

by an ellipsis. 

A Chunk’s size in the Song window is relative to that of the other 

Chunks in the window, rather than absolute. Chunks shorten and 

lengthen so that within a region, the longest Chunk always appears 

longest in the Song window. A Chunk’s length can be changed in the 

Chunks window by setting the Chunk’s End time to manual mode 

and typing in the new value. 

The standard Edit commands (Cut, Copy, Paste, Erase, and Undo) 

and dragging operations can be used on Chunks in the Song window. 

Marker Strip: Displays the Markers associated with the open song. 

Every marker in a song automatically produces a column at the same 

time location in the Song window. 

Time Ruler: Indicates the position of each Chunk in any combination 

of measure | beat! tick, real, and SMPTE time formats. The Ruler is 

non-linear, meaning the ruler markings denote Chunk Start and End 

times rather than regular time units. Choose which time formats are 

displayed using the Song window mini-menu selections Measures, 

Real time, and Frames. 

Insert button: Produces a dialog box prompting for a 

measure | beat | tick, real, or SMPTE time at which a column should be 

inserted. Clicking this button is a shortcut for choosing /nsert Column 

from the Song window mini-menu. 

Song name: Displays the name of the song to which the window 

belongs. The song name can be changed by option-clicking it in the 

Chunks window. 

Record-enabled Chunk: Displays a record-enable button in its handle, 

indicating that if the Song is play-enabled and the Record button is 

pressed, it will begin to record data at its start time. Only sequence 

Chunks can be record-enabled. 
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The Song Window Mini- 
menu 

The Song Window 

Column: Serves as a placement guide for Chunks. Columns appear 

automatically at the end of each Chunk, and can be inserted manually 

by choosing /nsert from the Song window mini-menu or by clicking 

the Insert button in the Song window title bar. 

Selected Chunk: Appears inverted to indicate that it has been selected. 

Selected Chunks are subject to Edit commands as well as several 

Song window mini-menu commands. 

The Song window has the following mini-menu items: 

Copy Conductor Tracks: Copies the Conductor tracks of the selected 

Chunks into the song’s Conductor track. In time regions where two 

or more Chunks are selected, the information from the uppermost 

Chunk is used. Markers are not included in the copy; use the Merge 

markers command to copy Chunk markers into a song. 

Edit Conductor Track: Opens a Graphic or Event list editing window of 

the song’s Conductor track. 

Record-enable Conductor: Enables the Conductor track of the song for 

recording Tap Tempo information. 

Insert Column: Produces a dialog box prompting for a measure, real, 

or SMPTE time at which to insert a new column. Clicking the Insert 

button in the Song window title bar is a shortcut for choosing this 

item. 

Set Record Sequence: Enables or disables the selected sequence for 

recording within the song. Only one sequence can be record-enabled 

at a time. Choosing this item with more than one Chunk selected, or 

with a Song selected, produces a warning message. 

Merge Markers: Merges the markers of all selected Chunks into the 

song’s marker list. Locked markers are not included in the merge. 

Delete Markers: Deletes from the song’s marker list any markers that 

are identical to markers in the selected Chunks. 
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Inserting Columns 
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Merge Chunks to Sequence...: Produces the Merge Chunks dialog box, 

which contains the following options: 

Copy all tracks creates a sequence containing all tracks of the 

selected Chunks, and places this new sequence in the Chunks 

window. 

Merge tracks with identical names creates a sequence containing all 

tracks in the selected Chunks, merges any tracks with identical 

names, and places this new sequence in the Chunks window. 

Measures/Real time/Frames: Determine which time formats should be 

displayed in the Song window Time ruler. Choosing a format checks 

or unchecks it; the checked formats are displayed. 

When you place a Chunk in the Song window, its Start and End times 

are marked with columns. Columns serve as Chunk placement guides. 

A column following a Chunk does not necessarily mean that the 

Chunk will stop playing back at that point. 

For example, Sequence-1 is four measures long and has an End time 

of 5111000. Dragging it into a Song window produces a column at 

the End time, and playback stops there as well. 

Now let’s say that Sequence-1 contains ten bars of music, but the End 

time has been manually set to 5111000. Dragging the sequence into 

a Song window still produces a 4-bar Chunk and a column at 

5111000, but the Chunk plays back all the way to measure ten. 

Before you can place a Chunk at a time location in the Song window, 

there must be a column at that location. Columns appear 

automatically at the Song’s Start time, at each marker in the Song, and 

at the end of each Chunk dragged into the Song window. You can 

also insert columns manually. 

To insert a column manually: 

1. Click the Insert button in the Song window title bar. 

You can also choose /nsert Column from the Song window mini- 

menu. A dialog box appears, prompting you for a location in 

measure | beat | tick, real, or SMPTE time. 

The Song Window 



Creating a Song 

The Song Window 

2. Click the radio button next to the time format you wish to use, and 

enter the time. 

Click OK to confirm your entry or Cancel to cancel the Insert. 

If you click OK, the dialog box disappears and a column appears 

at the time you specified. If you click Cancel, the dialog box 

disappears and the Song window is unchanged. 

Place a Chunk at the new column location. 

Performer automatically eliminates columns that do not have an 

associated Chunk or marker. So, if you don’t place a Chunk at the 

new column you have just inserted, the column will disappear 

when the grid redraws. 

Songs are created by dragging Chunk icons from the Chunks window 

into a Song window, then arranging the Chunks in any playback 

order and combination you wish. This can be done before or during 

playback of the Song. To create a song: 

: 2 Choose Add Song from the Chunks window mini-menu. 

A new, empty song is added to the Chunks list. 

If necessary, add other songs and sequences to the Chunks list. 

For this example we’ll assume you have at least two Chunks in 

addition to the song just added. 

Open the Song window by double-clicking the song’s name in the 

Chunks window. 

The song’s window opens. Alternately, you can open the Song 

window by clicking its name, then choosing Open Chunks from 

the Chunks window mini-menu. 

Grab a Chunk by clicking the icon to the left of its name in the 

Chunks window. 

Release the Chunk in the Chunk Grid beneath the ruler. The 

Chunk left-justifies to the column at 1!11!000, and a new column 

appears to the right of the Chunk. Note that you cannot drag the 

song into its own Song window. 
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5. Continue dragging, option-dragging, and editing Chunks in the 

Song window to arrange them as desired. 

Chunks that you place end to end will play sequentially; stacked 

Chunks will play simultaneously. 

When placing Chunks into songs, keep the following in mind. Every 

Chunk has its own Chunk Start time. Every copy of the Chunk uses 

this time and will reflect any changes made to the original. 
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Playing Back a Song 

Scrolling During 
Playback 

Editing in the Song 
Window 

The Song Window 

Specifically, a Chunk’s Event List window times relate to its own start 

time, say 1111000, even if that Chunk has been dragged into a song 

to start playing at measure 300. 

Similarly, each sequence Chunk has its own Tracks and Event Editing 

windows, and each song Chunk has its own Song window. Every 

copy of a Chunk is affected by the edits performed in these windows. 

To play a song: 

1. Click the title bar of the Chunks window to activate it. 

2. Click the play-enable button of the song you wish to play. 

3. In the Consolidated Controls panel, click Play. 

Adjacent Chunks in the song play sequentially; stacked Chunks 

play simultaneously. 

For another method of playing Chunks one after the other, see “The 

Chunk Control buttons” on page 78. 

The Auto-Scroll command in the Basics menu can make the Song 

window scroll during playback. In addition, the window will 

automatically open to the current playback location of the sequence. 

Please refer to the Auto-Scrolling section in the Playback chapter for 

more information. 

Once you’ve placed a few Chunks into a song, the Song window 

offers powerful editing capabilities to help you arrange your music. 

These operations can be done before or during playback. 

Select the Chunk by clicking it, or by dragging a marquee around it. 

Open a Chunk’s Song or Tracks window by double-clicking its icon. 

The standard Macintosh Edit commands (Cut, Copy, Paste, Erase, and 

Undo) can all be used on Chunks selected in a Song window, with 

the following results. 

Cut: Removes each selected Chunk from the Chunk Grid and places a 

copy on the Clipboard. 

Copy: Places a copy of each selected Chunk on the Clipboard. 
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Paste: Makes the cursor change to a mini-likeness of the chunk to be 

pasted. Click at the desired column location in a Song window to 

complete the paste operation. 

Erase: Removes each selected Chunk from the Chunk Grid; nothing is 

placed on the Clipboard. You can also delete a Chunk from a Song 

window by dragging it out of the window. 

Undo: Returns the Song window to its state prior to the last Edit or 

dragging operation. For example, dragging a Chunk to a different 

column enables the Undo command and updates it to Undo Drag. 

Choosing Undo Drag returns the dragged Chunk to its original 

position. 

Dragging the Chunk to a different column changes its playback start 

time. Dragging a Chunk out of the Song window deletes it from the 

Song. You can drag a Chunk from one Song window to another. 

Option-dragging, consistent with Performer’s graphic track editing, 

leaves a copy of the Chunk at its original location. Option-dragging a 

Chunk out of the Song window does not affect that Song window; 

you can option-drag a Chunk into another Song window, resulting in 

a copy in each window. 

Dragging and Option-dragging do not cause the Song window to 

scroll. This allows you to drag a Chunk out of a Song window, either 

to delete it or to move it to another song. If you need to place a 

Chunk at a time location not displayed in the Song window, Cut or 

Copy the Chunk, use the scroll bars to move to the desired location, 

insert a column if necessary, and Paste. 

Recor ding MIDI Performer lets you record both MIDI and tempo information into a 

into a Song song. MIDI information can be recorded into any sequence Chunk 

contained in the song, and tempo information can be recorded into 

the song’s Conductor track. 

To record MIDI information into a song’s component sequence: 

1. In the Chunks window, play-enable the Song into which you wish 

to record. 
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2. Double-click the song’s name to open its Song window. 

If the song’s window was already open, the window activates. 

3. Inthe Song window, click the sequence Chunk into which you wish 

to record. 

The Chunk highlights; any Chunks that were selected are 

deselected. 

4. Choose Set Record Sequence from the Song window mini-menu. 

The highlighted sequence now has a record-enable indicator in its 

handle. If you change your mind, choose Set Record Sequence 

again to disable the Chunk. 

5. Double-click the record-enabled Chunk. 

The Tracks window for the Chunk opens. Each track has a record- 

enable button. 

6. Record-enable one of the sequence’s tracks by clicking its record- 
enable button. 

If you wish to record on several tracks, use Multi-Record as 

described in the Recording chapter. 

7. Locate the point in the song at which you want to begin recording. 

Use the motion controls in the transport controls or set the 

Counter directly. 
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8. Click Record. 

The song begins to playback. Performer starts recording at the 

record-enabled Chunk’s starting time or the Auto-Record In time 

and continues indefinitely or until the Auto-Record Out time. 

9. When you are finished, click Stop. 

To hear the recorded material, rewind as necessary and click Play. 

Performer also lets you record tempo information into a song. Say 

you've created a song in which you'd like to have several tempo 

changes, even rubato passages. Tap Tempo is the most musical way 

to add these changes to your song — you don’t need to guess at the 

beats per minute, or even the measure numbers where the changes 

should occur. 

Each Chunk has its own Conductor track, containing the tempo, key, 

and meter information for that Chunk. Instead of recording MIDI 

events, the Conductor track records tempo information while slaved 

to Tap Tempo. Tap Tempo lets you control the beat by simply playing 

a MIDI event like a metronome that Performer follows and can 

record. If recorded, the information becomes a tempo map that can 

be edited in the Conductor track and that Performer will follow 

during subsequent playbacks of the sequence. 

You can even record tempo information into the song’s Conductor 

track while recording music into one of the song’s component 

sequences. 

To record tempo information into a song’s Conductor track: 

1. In the Chunks window, play-enable the Song into which you wish 

to record. 

2. Double-click the song’s name to open its Song window. 

If the song’s window was already open, the window activates. 

3. Choose Record-Enable Conductor from the Song window mini- 
menu. 

The song’s Conductor track is now record-enabled, this is 

indicated by a check mark in the mini-menu next to Record- 

Enable Conductor. 
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4. Choose Receive Sync from the Basics menu. 

The Receive Sync dialog box appears. 

5. Click the radio button next to Tap Tempo, then choose the port, 

MIDI channel, MIDI event, and countoff beats you wish to use. 

Choose an event/channel combination that you are not using as a 

Remote Control. Refer to the Remote Controls chapter for 

information on Remote Controls assignments, and to the Receive 

Sync chapter for specific information on Tap Tempo. 

6. Optional: Click the sequence Chunk into which you wish to record. 

If you wish to record MIDI data while recording tempo 

information, you must record-enable the desired sequence within 

the song, and track(s) within that sequence. 

7. Choose Set Record Sequence from the Song Window mini-menu. 

The highlighted sequence now has a record-enable indicator in its 

handle. If you change your mind, choose Set Record Sequence 

again to disable the Chunk. 

8. Double-click the record-enabled Chunk. 

The Tracks window for the Chunk opens. Each track has a record- 

enable button. 

9. Record-enable one of the sequence’s tracks by clicking its record- 

enable button. 

If you wish to record on several tracks, use Multi-Record as 

described in the Recording chapter. 

10. Choose Slave to External Sync from the Basics menu. 

The Song Window 227 



11. Click Record and begin tapping the specified tap event at the 

desired tempo. 

The Play button remains grey until you have tapped the specified 

number of countoff beats. Performer starts recording at the record- 

enabled Chunk’s starting time and continues indefinitely or until 

the Auto-Record Out time, whichever is sooner. 

12.When you are finished, click Stop. 

To hear the recorded material, rewind as necessary and click Play. 

Chunking Hints The Song window can be used to quickly create special effects. Try 

some of the suggestions here to get started. 

Creating an Echo Effect To add an echo effect to part of a song, try the following. 

1. Find the Chunk(s) that you wish to echo. 

Note the starting time of each according to the Song window Time 

Ruler. 

2. Click the Insert button in the Song window title bar. 

The Insert Column dialog box appears, prompting you for the 

measure, real, or frame time at which a column should be 

inserted. 

3. Enter a measure time about 50 ticks after the original Chunk’s 

starting time within the Song. 

To create an echo that plays in rhythm with the original Chunk, 

use divisions of the beat (for example, a quarter note=480 ticks so 

try 60, 120, or 240). A column will appear in the Song window at 

the time you specify. 

4. While holding down the Option key on your Macintosh keyboard, 

drag the Chunk to the new column. 

A copy of the Chunk remains at the original location. 

5. Play back the song to hear the result. 

Experiment with different amounts of delay to achieve the best 

effect. 
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Exporting a song to 
other music software 
programs 

Managing Markers ina 
Song 

Chunking and 
Synchronization 

The Song Window 

Song Chunks cannot be directly converted to other file formats, but 

you can use the Merge Chunks to sequence command in the Song 

window mini-menu to convert the song into a sequence. The 

resulting sequence can be converted to any alternative file format 

available in the Save As command dialog box. See “Saving a 

sequence in another format” on page 51. 

Every Chunk has its own Markers list. (See “The Markers Window” on 

page 245 for an introduction to markers.) Markers serve many 

functions, from simple references to auto-locators. You'll often find 

when you place a Chunk into a song that it would be useful to see 

the Chunk’s markers in the context of the whole song. The Merge 

Markers command in the Song window mini-menu lets you do just 

that. Simply select all the component Chunks whose markers you’d 

like to copy into the song, and choose Merge Markers. All unlocked 

markers in the selected Chunks now exist in the Song, and are 

displayed in the Song’s marker strip and Markers window. 

You can just as easily delete a Chunk’s markers from a song. Select 

the Chunks whose markers should be removed from the song and 

choose Delete Markers. Performer compares the song’s markers to 

those of the selected Chunks, and removes any that match up. The 

marker list of the Chunk is not affected. Keep in mind that once you 

merge markers of a Chunk into a song, dragging the Chunk to a 

different location will not move the markers. Further, selecting the 

relocated Chunk and choosing Delete Markers will not have any 

effect, as the markers are no longer associated with the Chunk. 

Markers can be of great help when building a song or score because 

Performer automatically generates a column in the Song window for 

each marker. You can use the Song’s Markers window to create a list 

of section markers, which will become Chunk placement columns in 

the Song window. Marker-generated columns are particularly useful 

for placing Chunks at hit points, which can be created during 

playback using the Record Hits command found in the Markers 

window mini-menu for each Chunk. 

Chunking (arranging Chunks in the Song window) is the ideal 

method of playing multiple Chunks while slaved to external sync. 

Firstly, Chunking allows seamless transitions between Chunks within 

a song. What’s more, these Chunks can be edited independently even 

after they have been dragged into a song. 
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Secondly, rather than having a different Start time and tempo map for 

each Chunk within a song, the song itself has one Start time and one 

Conductor track to govern all component Chunks. In fact, when 

placing Chunks into a song you could use Set Chunk Start, found in 

the Chunks window mini-menu, to change each Chunk’s start time to 

correspond with its playback location in the song. The Chunk’s 

SMPTE start times will shift accordingly, matching those in the Song 

window Time Ruler. If a Chunk contains tempo changes, you can use 

the Copy Conductor tracks mini-menu command to make every 

SMPTE time of a component Chunk match those of the song that 

contains it. 

Finally, film scoring applications benefit greatly from the Song 

window. Using the Record Hits feature in the Markers window, you 

can create a series of SMPTE hit points associated with a song. Each 

hit point becomes a marker. Because Performer inserts a column in 

the Song window for each Marker, you automatically have a Chunk 

placement guide at each hit point in the song. 

Matching chunk start When Chunks are placed in a song, the song itself has one Start time 

times with their location and one Conductor track to govern all component Chunks. When 
ina song placing Chunks into a song, you may want to change each 

component Chunk’s start time to match its playback location in the 

song. Then, the SMPTE start time of the component Chunk will be the 

same as its SMPTE location with respect to the song. 

To match a component Chunk’s SMPTE start time with the song that 

contains it, look at the column where the Chunk starts in the Song 

window and make a note of the SMPTE time of the column. Then, set 

the Chunk’s start time to be the same SMPTE time location. For 

information about how to set the start time, see “Setting the start time” 

on page 90. 

If the component Chunk contains tempo changes, you can use the 

Copy Conductor tracks mini-menu command to copy all of its tempo 

changes into the song’s Conductor track, making every SMPTE hit 

point of a component Chunk match its SMPTE time in the song that 

contains it. 
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Auto Versus Manual End 
Time 

The Song Window 

The Chunks window field End time displays either the automatic, 

Performer-generated ending time of the Chunk, or a time that you 

have entered manually. It’s important to understand how this time 

affects your music. 

Performer offers two ways of playing Chunks sequentially: by 

arranging Chunks vertically and horizontally in the Song window, 

and by Chunk Chaining using the Cue Chunks, Chain Chunks, and 

Skip buttons in the Consolidated Controls panel. The End time shown 

for each Chunk in the Chunks window affects these two types of 

chaining differently. 

When a Chunk is in a Song window, the Chunks window End time 

does not affect the playback length of the Chunk. Within a song, a 

Chunk will play every note it contains, regardless of its Chunks 

window End time. What it does affect is column placement. Columns 

appear automatically at the End time of each Chunk dragged into the 

Song window. This makes it easy to place Chunks end to end. 

For example, a Chunk whose last attack is at 4141322 will have an 

automatic End time of 5111000. When this Chunk is dragged into a 

Song window at time 1111000, a column will appear at 5111000, 

making it very easy for you to place the next Chunk in a metrically 

logical location. If you prefer a 5-bar phrase, just change the End time 

to 6111000. The end column will appear at 6111000, even though the 

Chunk only plays through four measures. 

Again, remember that the Chunk End time does not affect playback 

in the Song window, only the column placement. 

When using the Chunk controls in the Consolidated Controls panel, 

you'll find that each Chunk’s End time does affect its playback length. 

For example, clicking Play with the Chain Chunks button enabled 

causes playback of one Chunk after another, each Chunk playing 

until the Counter reaches that Chunk’s End time. Phrases, even notes 

that normally would last through the End time will be cut off. You can 

avoid this by setting a Chunk’s End time to be later, thereby building 

sustain into the Chunk’s play length. 

In summary: regardless of auto/manual status, in the Song window 

the End time determines the Chunk’s ending column location but not 

its playback length. During Chunk Chaining, playback actually stops 

at the End time. 
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Chapter 16 Click and Flash 

The Click 

Enabling the Click 

The Click is the audible indication of the Metronome beat; the Flash 

is the visible indication. The Click is produced on the Macintosh’s 

internal speaker or through MIDI on a drum machine or other sound 

module; the Flash appears in a small box on the screen. Both are 

accessible via commands on the Basics menu. The Click & Countoff 

Options feature in the Basics Menu allows you to control the click’s 

source and volume. In addition, it provides options for when the 

click occurs e.g. only while recording or only during the countoff. 

The Click “clicks” on the beat. The beat is determined by each meter 

change in the Conductor track. If the Click is on, Performer will click 

at the beginning of every measure. The first beat of every measure is 

slightly accented. The subsequent clicks in the measure depend on 

how the metronome click value is set in the current meter. To learn 

more about setting meters, see chapter 33, “Change Meter”. 

To turn on the Click, choose Click from the Basics menu or press 

command-5. To turn off the Click, choose it again. When the Click is 

on, the Click menu item will be checked. 

To adjust the Click volume independently of the Macintosh beep 

sound, use the Click & Countoff Options dialog box described in the 

next section. You can also amplify the Click by routing the audio 

output from the speaker jack on the rear of your Macintosh to your 

sound system. See the following two sections for more information. 
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Click & Counto The Click & Countoff Options dialog box, chosen from the Basics 

Options menu, provides several options for controlling the click. 

Click & Countoff Options 

You can also open this dialog by double-clicking the Count-off 

button. 

Source of Click Source of click specifies how the click is generated. Select one or both 
options. 

The Internal speaker option produces a click sound from the 

computer’s internal speaker. 

@ (Note: the internal speaker click does not work on 
some Macintosh models with certain system configura- 

tions.) 

The MIDI option will send a MIDI note for every click. For this option, 

you must set up an instrument to receive these notes and play a ‘click’ 

sound of your choosing. For example, a drum machine could play 

rim shots, or a synthesizer could play short beeps. 
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Click options 

Countoff options 

Data for MIDI Click 

Click and Flash 

Always click makes the click audible whenever Performer is counting 

off, playing or recording. 

Only during countoff makes the click audible only during countoff 

measures. When playback or recording begins, the click will fall 

silent. See “The Countoff button” on page 74 for more information 

about the countoff. 

Only when recording makes the click audible only when Performer is 

in record mode. If the Countoff button is enabled, Performer will also 

click during the countoff in this mode. 

No accent removes the accent from the first click in each measure. This 

option affects both the internal speaker click and the MIDI click. 

Countoff n measures lets you type in the number of measures you want 

for the countoff. The countoff will be in the same meter as the current 

playback location in the main counter. 

Countoff only when recording causes the countoff to occur only before 

recording, not before playback or any other function. 

These options define what notes are played if the MIDI option is 

selected. The Accented note is played on the first beat of each 

measure; the Normal note is played at all other times. Each note has 

four parameters: 

First, you specify the device that will play the accented and 

unaccented click by choosing it from the pop-up menu provided. The 

list of devices in the menu is provided by FreeMIDI. 

Pitch is the pitch of the note, expressed as a scale letter (A-G) (use the 

number sign # to represent a sharp, or a small letter ‘b’ to represent a 

flat) and an octave number. For example, C3 means middle C. 

Velocity is the attack (on) velocity, expressed as a number from 0-127. 

Gate specifies the length of the note in milliseconds (thousandths of a 

second). 
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Internal Speaker Click 
Volume 

Setting Click & Countoff 
Options 
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The Internal speaker click volume slider controls the volume of the 

Macintosh speaker click. To increase the click volume, drag the slider 

to the right; to reduce volume, drag to the left. Or, press the + or - 

buttons at each end of the slider. 

Performer’s click volume is not affected by the volume slider in the 

Control Panel. This allows you to attenuate (or turn off) the warning 

‘beep’ sound and turn up the click. See the section later in this 

chapter called Routing the Internal Speaker Click to Your Sound 

System for information about how to set the system beep and speaker 

click to different volumes. 

@ On some models of the Macintosh, this slider has no 

effect. 

To set the Click & Countoff Options dialog box: 

1. Select Click & Countoff Options... from the Basics menu. 

2. Select /nternal speaker and/or MIDI mode. 

Click in the corresponding check box to select a mode. Both 

modes can be selected simultaneously. If both modes are turned 

off, no click will be generated, even if Click is selected from the 

Basics menu. 

3. Select a preference for when the click occurs. 

Refer to the beginning of the Click & Countoff Options section for 

an explanation of each option. 

4. Adjust the Internal speaker click volume, if necessary. 

Drag the slider to the right to increase the click volume; drag it to 

the left to decrease volume. This slider controls the click volume 

and is independent of the speaker volume setting in the Control 

Panel. 
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Routing the Internal 
Speaker Click to Your 
Sound System 

Click and Flash 

5. Set the MIDI click parameters, if necessary. 

To change a parameter, click in its box, then type in the new 

values. You can also set the value over MIDI from your controller 

keyboard. 

Click on the OK button to confirm your settings, or on the Cancel 

button to cancel the changes. 

You can amplify the Internal speaker click by routing the audio 

output from the speaker jack on the rear of your Macintosh to your 

sound system. When this is done, the Macintosh warning beep 

sound, which is much louder than the click, will also become 

amplified. To avoid an over-amplified beep, you can turn down (or 

turn off) the beep sound using the Macintosh speaker volume slider 

in the Control Panel in the Apple menu. 

To turn down the system beep sound: 

s i If you are currently running Performer, save your work and choose 

Quit from the File menu. 

The Macintosh will return to the Finder. 

Choose Control Panels from the Apple menu. 

Important: this must be done before you start up Performer. The 

Control Panel volume cannot be adjusted when Performer is 

running. 

Open the Sound control panel. 

Drag the Speaker volume slider down as low as you wish. 

If you drag the volume to zero, the system beep will be turned off, 

and the menu bar will flash in its place. 

Close the Control Panel by clicking in the close box in the upper 

left corner. 

After the above procedure, re-start Performer and turn up the speaker 

click volume slider in the Click & Countoff Options dialog box. 
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The Flash 

Placing the Flash on Top 
of Windows 
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The Flash is the visual counterpart to the Click: it “flashes” on the 

beat. This is a silent way of giving you the current tempo. 

| 
To turn on the Flash, choose Flash from the Basics menu or press 

command 6. The Flash window will appear. 

The Flash gives you the tempo by alternating the highlighting (the 

black rectangle) from side to side. When the Flash is on, the 

command will be checked on the Basics menu. 

@ The Flash only works when the computer screen is set 

to black and white. 

@ The Flash feature may not work on some models of 

the Macintosh. If this is true for the Macintosh you are 

currently running Performer on, the Flash menu item 

will be grayed out. 

The Flash window is different than other windows in Performer: 

when enabled, it will always appear on top of all other windows. 

This is necessary to keep the Flash window timing completely 

accurate. 

To move the Flash window, press the mouse anywhere in the 

window and drag the window to a new location. Performer will 

remember where you place it when you save the file. 

Sometimes when the Flash is in front of another window, it will not 

move when you try to grab it with the mouse. In this situation, click 

on the push down box of each window behind the flash. It will then 

move freely. 

To close the Flash window, choose Flash on the Basics menu again. 
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Chapter 17 The Memory Window 

Basics 

Using the Memory 
Window 

As you record and edit music in Performer, more and more of the 

Macintosh’s RAM (random access memory) is required to store it. If a 

great deal of recording or editing is done in a file, or if you are 

loading sequences from other files, it is possible to run out of 

memory. It is therefore desirable to monitor how much memory is 

being used to keep this from occurring. 

The Memory window displays the current amount of free memory. It 

is constantly updated to supply you with a running status of available 

memory. 

The Macintosh’s memory usage is dynamic: it changes according to 

the current task. The memory profile will vary widely with different 

activities. For instance, if you use a section of the program for the first 

time, you may find that you suddenly have 30K less of memory. This 

is the space that the program utilizes for that particular part of the 

program. 

For these reasons, it is a good idea to keep a watchful eye on the 

Memory window. If you have 150K or less memory free, save often; 

a long recording or editing pass may use up all your free memory. 

Also, avoid editing and recording large regions; instead, work with 

smaller sections. Performer does its best when memory is low but in 

such circumstances there is a possibility of a system crash and the 

loss of any work you haven’t saved. 

To open the Memory window, choose Memory from the Windows 

menu. The window appears. 
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To move the window, click in any part of it except the close button 

and drag it to the desired location. To save space, the Memory 

window has no title bar. 

To close the Memory window, click in the window’s close button. 
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Chapter1s The MIDI Monitor Window 

Opening the MIDI 
Monitor Window 

Basics 

MIDI channel activ- 

ity indicators 

FreeMIDI devices appear 
here in the MIDI monitor. 

The MIDI Monitor window displays incoming MIDI activity, broken 

down by input device, MIDI channel, and type of data. This feature 

is handy when testing hardware, tracing problems in your MIDI 

system, Or monitoring time codes or other special MIDI data. The 

MIDI Monitor window will function whether active or inactive. 

Choose MIDI Monitor from the Windows menu; the window will 

appear. To move it, click in the title bar and drag to the desired 

location. To close the MIDI Monitor window, click in the window’s 

close button. 

The MIDI Monitor window consists of one panel for each FreeMIDI 

system device that has its MIDI OUT connected to the MIDI interface 

in your current FreeMIDI configuration. It therefore displays any 

devices that have the ability to send MIDI data to Performer. Each 

panel contains 16 MIDI channel indicators that are normally 

unhighlighted; they highlight to indicate incoming MIDI data. 

Incoming MIDI data from the 
Korg 01/W on MIDI channel 5. 

Modem and printer port 
real-time data lights. 
Displays incoming sync. 

MIDI system common data indicator. Lights up when 
system exclusive data is being received from the device. 
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Reordering Devices in 
the MIDI Monitor 

MIDI Monitor window 
mini-menu 

242 

The window includes real-time indicators for the modem port and 

printer port. 

@ The Input Filter has no impact on the MIDI Monitor 

window’s display. 

@ The MIDI Monitor window only displays incoming 

MIDI activity—only data being received by Performer 

from somewhere else—not outgoing data being sent 

by Performer. 

Channel Activity indicators display MIDI activity by MIDI channel. 

Most normal MIDI data will cause one of these indicators to light up; 

for example, pressing a key or moving the pitch bend wheel on a 

controller keyboard will cause the corresponding Channel Activity 

Indicator to turn black. 

The System Common indicator, labelled “Co”, indicates incoming 

system common data, such as system exclusive data, tune request, 

Song Position Pointer, and Song Select commands. 

The System Real-Time indicator, labelled “Rt’, includes MIDI beat 

clocks, DTL (Direct Time Lock), DTLe (Direct Time Lock enhanced), 

and System Reset commands. This type of data is used to synchronize 

devices, and is generated by most sequencers, drum machines, and 

SMPTE-to-MIDI converters. System real-time data is not assigned to a 

particular channel and therefore has just one indicator per port. 

Active sensing messages, which are sent by some brands of MIDI 

equipment, are ignored by the MIDI Monitor window. To see if your 

equipment is “on-line” and working correctly, send note data and 

observe the Channel Activity indicators, or test it in the FreeMIDI 

Setup application. 

To rearrange the order of the devices in the MIDI Monitor, just drag 

the panels up or down. 

The MIDI Monitor window has the following mini-menu commands: 

Show all input devices 
This command makes the MIDI Monitor display all devices in your 

FreeMIDI configuration file that have a MIDI OUT connected to a 

MIDI IN on the interface. 
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Show controllers only 
This menu command makes the MIDI Monitor display only those 

devices in your FreeMIDI configuration file that have the Controller 

device property assigned to them. 

Clear all devices 
Removes all devices from the MIDI Monitor display so you can start 

from scratch again. 

Individual Device names 
The mini-menu also displays the name of each device in your studio. 

Select the name to individually display it. Select it again to hide it. 
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Chapteri9 The Markers Window 

Quick Reference 

Position indicator 

The Markers window allows you to display and edit the markers for 

a Chunk (sequence or song). A marker is a name attached to a 

particular location in a Chunk. The Markers window can be used as 

a sophisticated autolocator, allowing you to move to a location 

instantly. The Markers window provides an easy way to organize 

your music; markers are visible in the Event Editing windows for each 

track, and are useful in quickly specifying editing regions. Markers 

are particularly useful when working with film and video; you can 

record them in real time to mark hit points, then use the Markers 

window as an intelligent cue sheet. With the commands in the 

Change menu you can then adjust meters and tempos to 

automatically align musical cues to the hit points. 

Marker name 

Marker location Cs indicator FreeMIDI seek point 

Time display: Displays the marker locations in your choice of measure, 

real or frame time. Click on a location to change it. Select the formats 

you wish to use from the bottom of the mini-menu. 

Locked indicator: Indicates that the marker is locked to real/frame 

time. Toggle from locked to unlocked and back by clicking in the 

lock column next to the marker name. 

245 



Mini-menu 

Basics 

246 

FreeMIDI Seek point: FreeMIDI provides eight seek points to which it 

will cue all FreeMIDI applications. You can designate up to eight 

markers as FreeMIDI seek points. Type in the desired seek point 

number in this column. 

Names: Click on a marker’s name to select it. Option-click on the 

name to change it. Drag over several names to select several markers. 

Use Shift-click to select or deselect several non-contiguous markers. 

Position indicator: Displays the current location in the Chunk. Drag on 

the indicator to move it. Click anywhere in the grey region to move 

the indicator to a marker. Moving the indicator changes the current 

location in the Chunk. 

Add: Adds a new marker at the current location. Hold down the 

Option key while choosing Add to add several markers at once. A 

dialog box will appear, prompting you for the number of markers to 

be added. 

Delete: Deletes the highlighted markers. 

Lock: Locks the highlighted markers to real/frame time. A small lock 

icon appears by the marker’s location to indicate that it is locked. 

Unlock: Unlocks the highlighted markers. 

Record hits: Enables a special mode such that during playback, every 

time you hit a key on your controller instrument, a marker will be 

added at that location. 

Shift locked markers: Shifts all highlighted locked markers by a time 

offset. 

Generate VIP Streamers: Causes Performer to trigger a Video Time 

Piece streamer for each designated marker in the Markers list. 

Measures/real time/frames: Choosing these will determine what type of 

time will be displayed in the marker list. When chosen, the menu 

entry becomes checked. Choosing it again unchecks it. 

The Markers window is used to display and manipulate markers. 

Each Chunk listed in the Chunks window has its own set of markers. 

The title bar of the Markers window displays the sequence or song to 
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which the markers belong. Each marker consists of a name and a 

time location it is associated with. Markers are listed in chronological 

order. You can display the location of a marker in any combination of 

measure time, real time and frame time. 

Normally a marker remains at the same measure time location when 

you change the tempo of the sequence. In this case, changes in 

tempo or structure will affect the real and frame time location of the 

marker. However, when working with film or video, it is useful to 

assign a marker to a certain event in the action (termed a “hit point”). 

Such markers are necessarily attached to real or frame time locations. 

Since the location of the event in the film or video will not change, 

the location of the marker must not either, even if you change the 

tempo of the music. Performer lets you ‘lock’ markers to real/frame 

time locations. When you change tempos or edit your Chunk, the 

real/frame time location of locked markers will stay the same and the 

measure location will change to reflect the new tempo or structure. 

Opening a Markers Each Chunk has its own set of markers in the Markers window. To 

Window open the Markers window for a Chunk: 

1. Open the Chunks window. 

Do so by choosing Chunks from the Windows menu. 

2. Make sure no Chunks are highlighted. 

To unhighlight them, briefly click a type icon in the left column. If 

a Chunk is highlighted, a Markers window will be opened for that 

Chunk. 

3. Play-enable the Chunk whose Markers window you wish to open. 

Do so by clicking the play-enable button to the left of the Chunk 

name. 

4. Choose Markers from the Windows menu. 

The title bar displays the name of the Chunk to which the markers 

belong. 
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Switching between 
sequences and songs 

Scrolling During 
Playback 

Adding Markers 

Changing the Name of a 
Marker 

248 

The Markers window shows the markers for an individual sequence 

or song. If you are working with multiple sequences and songs in a 

file, you can easily switch between them by command-clicking the 

name of the sequence in the Marker window title bar as shown 

below: 

The Auto-Scroll command in the Basics menu can make the Markers 

window scroll during playback. In addition, the window will 

automatically open to the current playback location of the sequence. 

To add a marker, choose Add from the Markers window mini-menu. 

The marker’s location will be the same as that showing in the 

Counter. To add several markers at once, hold down the Option key 

while choosing Add from the mini-menu. A dialog box will appear 

prompting you for the number of markers to be added. 

The size of the name box is limited by the size of the Markers 

window. If you wish to enter a lot of text for a marker name, resize 

the window first. 

To change the name of a marker: 

1. Option-click on the marker name. 

A small box will pop up. 

2. Type in the name for the marker. 

3. Press the Return key to approve the change or the Command and 

period keys to cancel it. 

You can use the Enter or the down arrow key to approve the entry 

and move to the next marker name, or the up arrow key to 

approve the entry and move to the previous marker name. 
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Changing a Marker Time 
Location 

Setting the Counter to a 
Marker Location 

The Markers Window 

To change the time location of a marker: 

1. Click the time location you wish to change to pop-edit the value. 

2. Enter the new values. 

Use the Tab key to move between time fields. 

3. Press the Return key to enter the time or the Command and period 

keys to cancel your change. 

You can use the Enter or down arrow key to approve the change 

and move to the time location of the next marker; use the up 

arrow key to approve the change and move to the time location 

of the previous marker. 

If you change the measure time of a marker, even a locked marker, 

the real and frame times will also change. Changing the real or frame 

time of a marker will cause the measure time location to change. 

Since the markers are listed in chronological order, a marker may 

seem to vanish when you edit its location. In such cases, the marker 

has simply been moved out of the visible portion of the marker list. 

You can easily set the current location displayed in the Counter 

window to the location of a marker. This lets you to move to a 

location by its name instead of time, making it unnecessary for you to 

keep track of a number of arbitrary measures and times. 

To move to the location of a marker: 

@ Press on the position indicator and drag it to the 
marker you want. You can scroll the list up or down by 

dragging the position indicator slightly past the top or 

bottom of the marker list. 

Or 

® Click in the grey area of the position bar to the left of 

the desired marker. The indicator will appear at that 

position. The position indicator will appear under the 

pointer and you can drag it to the desired marker. This 

saves you having to scroll around to find the position 

indicator. 
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Selecting Markers 

Using Markers to Define 
an Edit Region 
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To select a marker, highlight it by clicking on its name. There are 

several methods for selecting several markers at once: 

To select several adjacent markers, press on a marker name and drag 

over the desired names. All markers dragged over will highlight. 

To select several non-adjacent markers, hold down the Shift key and 

click on the names of the markers you wish to select. They will 

highlight. 

To deselect markers when more than one are highlighted, hold down 

the Shift key and click on the markers you wish to deselect. They will 

unhighlight. 

To extend the currently selected region, shift-drag over the desired 

end location. 

You can use markers to define a region to be edited: instead of typing 

the Start and End locations in the Edit Bar of the Tracks window, you 

can use the Markers window and Remember Times command on the 

Basics menu. 

To define a region using the Markers window: 

1. Select a group of markers such that the beginning and end marker 

of the group are at the starting and end times of the region to be 

edited. 

If the marker with the start time you want for the edit region and 

the marker with the end time for the region are not adjacent, you 

must select all markers in between. Click on the starting marker 

and drag down until you reach the ending one. 

2. Choose Remember Times from the Basics menu. 

Pressing Command-R is the keyboard equivalent for Remember 

Times. The locations of the starting and ending marker are 

remembered. 

3. Activate the Tracks window. 

Click once on it. 
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Markers in the Event 
Editing Window 

Markers in the Song 
Window 

Merging Markers in the 
Song Window 

Removing Merged 
Markers from a Song 

The Markers Window 

4. Click once on the word Edit in the Edit Bar. 

The location of the first highlighted marker will be entered into 

the Start time and the location of the last highlighted marker will 

be entered into the End time in the Edit Bar. 

You can now use one of the commands from the Edit or Region 

menus. You can also use this procedure to transfer marker times to 

the Memory and Auto Record bars in the Consolidated Controls 

panel. 

Markers appear in the Event Editing windows for each track in a 

sequence. The name and location may not be edited in any of the 

Event Editing windows. However, commands on the Edit menu may 

be applied to markers only in the Conductor track Event Editing 

windows. 

You can use the View Filter to determine whether or not markers are 

displayed in the Event Editing windows. 

Markers in a song are displayed in the Markers Strip in the song 

window. Performer automatically generates a column in the Song 

window for each marker. 

Markers can be of great help when building a song or score because 

you can use the Song’s Markers window to create a list of section 

markers, which will become Chunk placement columns in the Song 

window. Marker-generated columns are particularly useful for 

placing Chunks at hit points, which can be created during playback 

using the Record Hits command. 

You'll often find when you place a Chunk into a song that it would 

be useful to see the Chunk’s markers in the context of the whole 

song. The Merge Markers command in the Song window mini-menu 

lets you do just that. Simply select all the component Chunks whose 

markers you'd like to copy into the song, and choose Merge Markers. 

All unlocked markers in the selected Chunks now exist in the Song, 

and are displayed in the Song’s marker strip and Markers window. 

You can just as easily delete a Chunk’s markers from a song. Select 

the Chunks whose markers should be removed from the song and 

choose Delete Markers. Performer compares the song’s markers to 

those of the selected Chunks, and removes any that match up by both 
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name and location. The marker list of the Chunk is not affected. Keep 

in mind that once you merge markers of a Chunk into a song, 

dragging the Chunk to a different location will not move the markers. 

Further, selecting the relocated Chunk and choosing Delete Markers 

will not have any effect, as the markers in the song no longer match 

the markers in the Chunk. 

Editing Markers in the You may apply any of the Edit menu commands (Cut, Copy, Paste, 

Conductor Track etc.) to markers only in the Conductor track for the Chunk. Select the 

Conductor track in the Tracks window and set the Start and End times 

in the Edit bar before invoking one of the Edit commands. Locked 

markers cannot be edited in the Conductor track. See the The 

Conductor Track and Edit Commands chapters for more information. 

Locking and Unlocking Markers can be connected to a real or frame time location such that 

Markers they will retain that location if the tempo is changed: they can be 

“locked” to the location. If the tempo is changed, the measure time 

location of the marker will change. 

When a marker is unlocked, it sticks to a specific measure/beat/tick, 

and its real time location is flexible. When a marker is locked, it sticks 

to a specific real/SMPTE time, and its measure location is flexible. 

To lock a marker, click on it to select it and choose Lock from the 

Markers window mini-menu. You can lock several markers at once. 

To unlock a marker, select it and choose Unlock from the Markers 

window mini-menu. To toggle a single marker between locked and 

unlocked states, click in the lock column next to the marker’s name. 

Shifting Locked Markers The Shift Locked Markers command on the Markers window mini- 

in Time menu lets you shift the times of highlighted locked markers by the 

amount you specify. Unlocked markers which are selected are 

unaffected by this command. 

This feature can be useful if the film or video you are working with 

has been recut and the locations of the events have moved slightly. It 

is generally useful when changing the real/frame time locations of 

markers by a uniform amount. 
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Recording Hits 

The Markers Window 

To shift the times of locked markers: 

2 Select the markers you wish to shift. 

Unlocked markers will not be affected by this command. You can 

include them in your selected markers group without affecting 

them. 

Choose Shift Locked Markers from the Markers window mini- 

menu. 

A dialog box will appear. 

. Specify whether to advance or delay the markers. 

Advancing markers moves them to earlier times, delaying them 

moves them to later times. Click on the radio button next to the 

desired option. 

. Choose whether to enter the shift amount in real or frame time. 

Click on the radio button next to the desired option. 

. Enter the amount of time by which you wish to shift. 

Click in the text box and type in the number. 

Click on OK to confirm your entry or Cancel to ignore it. 

You can use the Enter or Return key to confirm the entry or the 

Command and period keys to cancel it. 

New markers can be entered in a sequence during playback by 

striking a key on your MIDI controller instrument. The time location 

of each marker corresponds with the time in the Counter when the 

key is struck. This is a very useful feature for recording cue points or 

hits while viewing film or video. 

To create markers during playback: 

1. Move to the location at which you wish to start playback. 

If slaved to an external master device, this step is not necessary: 

Performer will locate automatically when you start the master. 
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2. Choose Record Hits from the Markers window mini-menu. 

A dialog box will appear. 

3. Specify whether you want the markers to be locked or unlocked. 

4. Press OK to confirm your choice or Cancel to cancel it. 

Once you press OK, Performer will start playback. If in external 

sync mode, the Play button will turn grey until the master device 

is started. 

5. Press a key on your MIDI controller every time you wish to enter a 

marker. 

A marker will be entered at the current time in the Counter. 

6. To stop entering markers in this way, press the Stop button in the 

main transport controls. 

Using the Auto Stop feature in the Consolidated Controls panel 

will also stop this type of marker entry. If you are in external sync, 

note that stopping the master device does not take Performer out 

of the Record Hits mode; you must press stop in Performer to end 

recording hits. 

Hints Below are some helpful hints for using Markers. 

Composing and Markers provide a useful tool for labeling structural sections of a 

Arranging piece of music. The music can be recorded first and markers added 

afterwards or markers can be entered first to lay out the structure of 

the sequence before recording. In the latter case, markers can be 

used as a kind of musical outline for the structure of the piece. 

Markers can be used to quickly rewind to the beginning of a section. 

They can also be used as structural place holders to mark the ends of 

unfinished sections. 

Since markers can be cut, pasted, merged, etc., in the Conductor 

Track, they can be moved around with the rest of the data as a 

sequence grows and changes. You can move them separately from 

the rest of the data if you wish. 
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Film and Video Scoring 

Streamers and the Video 
Time Piece™ 

The Markers Window 

Use the Edit Filter to specify if markers can be affected by Edit menu 

commands. In general, it is best to keep the markers box unchecked 

in the Edit Filter. Check the box only when you know you will be 

cutting, pasting, etc. markers; uncheck it after you have finished to 

prevent unwanted changes. 

If you are not working with time code, you will probably not need to 

display real or frame time in the Markers window. 

Markers make an excellent cue sheet for planning out or displaying 

the structure of your score. They can show you the relationship 

between time locations in the film and measure locations in the 

music. You can adjust meters and tempos until the metrical beats of 

the sequence line up satisfactorily with important visual events. This 

can all be done before recording a note of music. 

In addition to using markers to define the structure of your score, you 

may want to add markers for visual cues and hit points. The Record 

Hits feature is especially suited for this. These markers should be 

locked since their time location corresponds to a frame location. 

Once locked, the measure time location of the marker will be 

updated if you change the tempo and meter. The frame location will 

not change. 

If the time code on the film or video should change due to restriping 

after assembly or editing, you can use the Shift Locked Markers 

command on the Markers window mini-menu to adjust the times of 

the hit points you’ve already labeled with markers. 

If you have Mark of the Unicorn’s Video Time Piece, you will 

definitely want to read the next section, which explains how markers 

can be used to trigger streamers. 

The Markers window has an additional capability designed for Mark 

of the Unicorn’s video post-production device, the Video Time Piece. 

The Video Time Piece is a hardware device that can superimpose 

graphic images on a video picture, including streamers. A streamer is 

a solid white bar that travels across a video screen from left to right 

to reach the right-hand side of the screen at an exact hit point. 

Streamers help studio musicians and sound effects engineers to 

anticipate hit points during video post-production. 
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For more information, please refer to the chapter called Performer 

and the Video Time Piece. 
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Chapter 20 The Event List Window 

Performer provides four ways to display and edit the data in each 

track of a sequence: the Event List window, the Graphic Editing 

window, the Notation Editing window, and the QuickScribe notation 

window, together referred to as the Event Editing windows. All of 

these windows can be open at the same time for a track, and any 

number of tracks can have windows open at any time. This chapter 

describes the Event List window. See the next two chapters for 

information on the Graphic Editing and QuickScribe notation 

windows. 

The Event List window displays the MIDI data and other information 

in a track as a chronological list of “events”. Examples of events are 

notes, controller data, and program (patch) changes. Other 

information that occurs in specific time locations can be displayed in 

an Event List as well: markers, meter changes, key changes, tempo 

changes, and loop points. The Event List window can be used to edit 

individual events or select a region of events for editing with menu 

commands. Event List windows for different tracks can be open at 

one time. Event List windows can be opened, scrolled, and edited 

during playback. 
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Quick Reference 

Mini-menu Audible Mode Insert button Solo button 

speaker button 

Pop-up box 

Event: A row of information concerning a single MIDI message or 

Performer command. Events at different locations are separated by a 

dotted line. The information displayed for an event depends on its 

type; see the section The Event List Display below for more 

information. 

Mini-menu: Choose items from the mini-menu in the same way as 

regular menus. The Event List mini-menu contains commands for 

inserting, controlling the display, and more. See the section called 

Mini-menu for more information. 

Audible Mode speaker icon: Click on this button to activate Audible 

Mode. Audible Mode plays back notes one at a time as you click on 

them in the Event List. An entire phrase can be played back by 

highlighting a region and option-clicking on the speaker icon. 

Insert button: Inserts MIDI events into the Event List. Pressing this 

button produces a menu of items the can be inserted. 

Solo Button: Mutes all other tracks during playback. 

Pop-up box: A box that appears when you double-click or option-click 

on a field of an event. You can enter a new value for the field. 
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Mini-menu Quick 
Reference 

Opening an Event List 
Window 

The Event List Window 

Grow box: Drag this box to resize the Event List window. 

Set View Filter: Calls up a dialog box from which you select the types 

of events which are visible in the Event List window. The View Filter 

applies to all open Event Editing windows. 

Goto Counter: Automatically scrolls to the time currently displayed in 

the Counter. 

Goto: Automatically scrolls the Event List display to a time you specify. 

Relnsert: Inserts an event of the same type that you last inserted. 

Legend: Opens a window that shows what each kind of MIDI event 

looks like in the Event List. 

Graphic Editing: Opens the Graphic Editing window for the track. 

Notation Editing: Opens the notation editing window for the track. 

QuickScribe Notation: Opens the QuickScribe notation window for the 

track. 

Measures/Real time/Frames: These checkable entries control the types 

of time displayed in the Event List. 

If the Event List is already open for a track, you can simply click on 

it to activate it. If not, you’ll want to open one. 

To open an Event List window for a track: 

1. Open or activate the Tracks list window containing the track you 
wish to edit. 

To open a Tracks window, choose Tracks from the Windows 

menu. To activate a window already open, click on it. 

2. Double-click on the track name. 

The track’s Event List window will appear. 

You can also open the Event List window by choosing Event List from 

the Graphic or Notation Editing window mini-menus. 
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Switching to a Different If you have an event list window open for a track, you can switch to 

Track Using the Title Bar | a different track in the same window. To do so: 
Pop-up Menu 

1. Command-click the track name in the title bar. 

A pop-up menu appears as shown below. 

Commana-click the track name in the title bar to use the pop- 
up menu to move from track to track within the same editing 
window. 

2. Choose the desired track. 

The contents of the window changes to the track you select. 

The E vent List The Event List window displays MIDI data and other events 

Dis 0 lay sequentially. There is one event per line in the display. Events which 

occur at the same time (such as notes in a chord) will be grouped 

together between horizontal dotted lines. The starting time is listed 

only for the first event of these groups. Each note is defined by its 

attack time, pitch, on velocity, off velocity, and duration. 
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The Event List Window 

This example shows nine notes: 

Attack time Velocity 

Pitch Duration 

| 
<< —— FG 

In addition to MIDI note events, there are other types of events that 

are displayed in the Event List as well. These events include other 

MIDI commands, like patch changes, and events unique to 

Performer, like markers and tempo changes. 

The next example shows several different types of events. Some are 

MIDI data, like the patch change event, notes, and pitch bend. Others 

are Performer-related events, like the marker, key change, and meter 

change. 
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Scrolling During 
Playback 

262 

Looping points are also displayed on the Event List. Events within 

loop boundaries are indented. Events that will not be played due to 

the duration of a previous loop are in italics. See the Looping chapter 

for details. 

Notes that 

won't play 
because of 

the loop 

Event locations can be displayed in measure | beat|tick, real time, or 

frame time formats. Any combination of the three types of times can 

be displayed simultaneously. To display a certain type of time, simply 

check its menu entry on the Event List window mini-menu. To turn 

off a format, reselect it from the mini-menu. 

The Auto-Scroll command in the Basics menu can make the Event List 

window scroll during playback. In addition, the window will 

automatically open to the current playback location of the sequence. 

Please refer to the Auto-Scrolling section in the Playback chapter for 

more information. 
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Selecting Events in the 
Event List Window 

The View Filter 

The Event List Window 

The following actions select events: 

To select a single event, click once on it. 

To select several adjacent events, drag over the desired events. All 

events dragged over will highlight. 

To select several non-adjacent events, hold down the Shift key and 

click on the events you wish to select. They will highlight. 

To deselect events, hold down the Shift key and click on the event(s) 

you wish to deselect. They will unhighlight. 

To extend the currently selected region, Command-click or Command- 

drag at the desired end location. 

To edit an event, double-click or Option-click on the field you want 

to modify. A pop-up box appears in which you can edit the value in 

the field. 

Tab approves the change you made and moves to the next field in 

the same event. 

Return approves and completes the changes you made. 

Enter approves the changes you make and moves to the same field 

in the next event. 

the up or down arrow keys approve the changes you make and move 

to the same field in the next or previous event. 

the left or right arrow keys move from field to field in the event box. 

The View Filter allows you to specify what types of MIDI information 

are displayed in the Event Editing windows. You can open the View 

Filter dialog box from the mini-menu in any Event Editing window. 

The View Filter affects all Event Editing windows. 

The View Filter also determines which types of events are affected by 

Edit menu commands when the data is selected in the Event Editing 

window. Here’s a simple rule to remember: if you can see an event 

in the Event Editing window, it will be affected by edit commands. 
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To use the View Filter from an Event List window: 

1. Choose View Filter from the Event List mini-menu. 

A dialog box appears. 

for Re 

ae Set View Filter 

2. Choose the types of data to be displayed by checking the check 

box for each. 

You can choose all types of data at once by clicking on the “Set 

All” button. You can uncheck all the check boxes by clicking on 

the “Clear” button. Option-click to check only the check box you 

click on, unchecking all others; command-click to check all boxes 

except the one you click on. Use the Controllers option to specify 

which controller information is displayed. 

3. Press OK to confirm your choice or Cancel to cancel it. 

When using the View Filter, keep these rules in mind: 7he View Filter 

settings you select will stay in effect until you change them. They affect 

all open Event Editing windows. The View Filter settings will affect all 

edit operations done in the Event Editing windows. 

Specifying Controller The buttons under the Controller check box in the View Filter allow 

Numbers in the View you to quickly choose which controller data to be displayed. Click in 

Filter the Controllers check box, click on the type of option you wish and 

then enter the controller numbers if necessary. 
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Goto Counter 

Goto 

The Event List Window 

m All: displays all controllers. 

m All except: displays all controllers except the numbers you 

enter. 

a Only: displays only the controller numbers you enter. 

To enter controller numbers for the A// except and Only options, click 

in the text boxes next to the option and type in the numbers. You can 

use the Tab key to move between boxes in the same option. 

Choosing Goto Counter automatically scrolls the Event List to the 

location currently displayed in the Counter window. This command 

is a quick and useful tool for locating specific events in an Event List. 

For example, if you hear a wrong note in your music during 

playback, stop playback at that point, and then select Goto Counter 

in the Event List for the track. This immediately scrolls the Event List 

to the point where you stopped, allowing you to find and correct the 

mistake quickly. 

To use the Goto Counter command: 

1. Activate the Event List window for the desired track by clicking on 

it. 

2. Choose Goto Counter from the Event List window mini-menu. 

The list will automatically scroll to the event closest to the time in 

the Counter window. 

The Goto command on the Event List window mini-menu scrolls the 

Event List display to the specified location. It is a quick way to locate 

a region of events without having to manually scroll through the 

Event List. 

To use the Goto command: 

1. Activate the Event List window for the desired track by clicking on 

it. 

2. Choose Goto from the Event List window mini-menu. 

You will be prompted for a location to scroll to. 

3. Enter a time location to scroll to. 
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4. Press OK. 

The list will automatically scroll so that the event closest to the 

time you entered will be at the top. 

Relnsert The ReInsert command inserts an event of the type last chosen with 

the Insert command. It works exactly like the Insert button except 

that you don’t need to select a type of event from a menu. For 

example, if you insert a patch change with the Insert button, the next 

ReInsert command will insert a patch change as well. For more 

information, see the section called “Inserting events with the insert 

button” on page 272. As a shortcut for choosing Reinsert from the 

mini-menu, option-click the Insert button. 

Legend The legend window can be opened by choosing Legend from the 

Event List mini-menu. The legend window defines each icon found in 

the Event List. 

Graphic and Notation The Graphic Editing and Notation Editing commands open the 
Editing Graphic Editing or QuickScribe notation windows. Data in the track 

can be viewed in any one of these three windows. Editing in a 

window will affect the data in the track, regardless of which window 

you have activated. For example, if you edit a note while in the Event 

List window, the change will be displayed in the Graphic Editing 

window as well. 
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Types of Events 

Notes 

cs 

Pitch Bend 

“1132 

Patch Change 

a2 39 

The Event List Window 

There are several types of events displayed in the Event List window. 

Most are MIDI data; some are events internal to Performer such as 

tempo and meter changes. The type of each event is identified by a 

small icon. The following section describes the appearance and 

parameters of each type of event. 

A note event comprises a start time, a pitch, an on velocity, an off 

velocity and a duration. The pitch is expressed as a note name and 

an octave, e.g. C#4. C3 is middle C on a keyboard, although with 

some patches it might sound in another octave. The spelling of the 

note name is determined by the key signature you choose. 

On velocity is a value that represents how hard a note is struck. The 

harder you strike a note, the faster you are pressing it down, hence 

the term “velocity”. Off velocity is a value that represents the speed 

at which a note is released. Many synthesizers don’t respond to off 

velocities, but some use this information to determine envelope 

decay parameters or other effects. Values of on and off velocities 

range from zero to 127. You can omit on and off velocities from the 

Event List display by unchecking them in the View Filter. 

Duration is the time between the attack and release of the note. It is 

displayed in quarter notes and ticks, e.g. 31240. Note that this is 

different from measure time, displayed in measures, beats and ticks. 

There are 480 ticks per quarter note. A note must have a minimum 

duration of one tick (01001). 

A pitch bend event comprises a start time and a value. Pitch bend 

data causes the pitch of notes being played to change. When a stream 

of pitch bend data occurs, a smooth pitch change can be 

approximated. A value of zero signifies no bend, increasing values 

bend the pitch up, and decreasing values bend it down. Values are in 

the range -8192 to 8191. 

There is no specific MIDI standard for how much of a bend specific 

pitch bend data causes: each synthesizer may be different. Also, some 

synthesizers do not respond to all 16,384 values; adjacent values may 

produce the same result. 

A patch change event has a start time and a patch change number. 

When a synthesizer receives a patch change, it changes to the patch 

specified by that number. 
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Patch changes are generally in the range 0 to 127. Some MIDI devices 

use the range 1 to 128. In such cases, the patch number displayed in 

Performer may be one less than the number on the MIDI module. 

Performer thus would display a zero when a 1 was sent, a 9 when a 

10 was sent, etc. Some units have more than 128 patches. Since MIDI 

only allows for 128 different patch values to be sent, there is no direct 

way to access patches above the 127th one. In this case, there is 

usually some way to set up banks (groups) of patches and switch 

banks via a “bank select” MIDI command. If this is the case, and the 

device has been set up with bank select messages in FreeMIDI, patch 

change messages for the device appear with the appropriate bank 

select number as shown below. The bank number automatically 

appears in tracks assigned to a device that was given the bank select 

property in FreeMIDI Setup. (See “Setting up bank select devices in 

FreeMIDI” on page 749.) If the track is assigned to a non-bank select 

device, no bank number is shown. 

Patch number Bank number Patch (sound) 
(Could be one or two numbers, pop-up list 
depending on the MIDI device.) 

Song Change Song changes, also called song select, select songs (a collection of 

rhythmic patterns) on drum machines. They have a value range of 

11000 Song #127 zero to 127. Song changes have no channel number when sent over 

MIDI: all connected instruments receive them. 

Mono Key Pressure Also known as aftertouch or channel pressure, this is actually a 
special kind of controller. A mono key pressure event has a start time 

and a value between zero and 127. If you continue to press down a 

+ 56 key after you play a note, mono key pressure information is sent. The 

harder you press, the higher the value. Mono key pressure can be 

used for such things as changing the timbre (tone quality) of a sound 

or controlling the amount and depth of vibrato. 

Mono key pressure data can be voluminous, filling up memory very 

quickly. If you aren’t using mono key pressure information, it is best 

to use the Input Filter to filter it out while recording. Because of its 
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Poly Key Pressure 

119 

Controllers 

a #54 

System Exclusive 

FO 4301 05 7%C 26 322 FP 

Tune Request 

Tune request 

The Event List Window 

great volume, mono key pressure data can sometimes cause the 

playback speed to slow down when output with a fair amount of 

other MIDI data. 

This is similar to mono key pressure except that each key can 

generate its own pressure information instead of one pressure level 

for the whole instrument. This allows for much more subtle and 

complicated effects using aftertouch. A poly key pressure event has a 

start time, a pitch and a value between zero and 127. 

A controller event has a start time, a controller number which 

identifies the device being used (on the MIDI input keyboard), and a 

value. Continuous controllers (such as wheels and sliders) are 

generally numbered in the range zero to 63. These have value ranges 

from zero to 127. Switch controllers (on/off types like a sustain pedal) 

are numbered from 64 to 93 and have values of either On or Off. 

Controllers from 93 to 127 are reserved for future definitions. 

Each MIDI device can interpret controller data differently. Thus, data 

from the same controller might be used differently on two different 

synthesizers. To determine how a controller behaves on a particular 

unit, consult the owner’s manual, and see the Hints section below. 

System exclusive data can be used for a variety of purposes. Each 

musical instrument manufacturer defines special kinds of data that 

are particular to specific instruments: patch dumps, drum machine 

patterns, tuning information, sample data and so forth. System 

exclusive data begins with an ID code specifying the manufacturer 

followed by the actual data. 

Performer lets you view and edit system exclusive data in 

hexadecimal (base 16) notation. See the System Exclusive chapter for 

more information. 

The tune request is used for analog synthesizers, prompting them to 

tune their oscillators. It has no value and does not have a channel 

number when sent over MIDI: all connected MIDI instruments will 

respond to it if applicable. 
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Mode Changes MIDI modes are used to set synthesizers to respond to MIDI data in 

different ways. Not all synthesizers respond to all MIDI modes. 

Oroani on 

Orani off 

Mono mode 

Poly mode 

Local control on 

Local control off 

A]]l notes off 

Omni Mode 

A synthesizer is always in either omni on or omni off mode. In omni 

on, a synthesizer responds to all data on any channel, i.e. all 16 

channels at once. In omni off, a synthesizer responds to data only on 

its assigned channel. Usually, you can change this mode on the 

synthesizer’s front panel. Some synthesizers allow you to change this 

mode via MIDI. 

Mono Mode 

In mono mode with omni off, a synthesizer splits itself into a number 

of independent monophonic synthesizers, each responding to one 

channel. The assigned channel number of the synthesizer determines 

the channels it responds to. If you had an eight-voice synthesizer 

assigned to channel 2, it would respond to data on channels 2, 3, 4, 

5, 627-6, and 9. 

In mono mode with omni on, a synthesizer receives data from all 

channels but acts as a single voice synthesizer. This combination is 

not very useful. 

Local Control 
A synthesizer is always in either local control on or local control off 

mode. In local control on mode, the synthesizer works normally: 

notes pressed on the keyboard are played by the synthesizer unit. In 

local control off mode, the keyboard is disconnected from the 

synthesizer unit. The keyboard sends out data directly through MIDI; 

the synthesizer only plays data received over MIDI. This allows you 

to use a synthesizer as a controller while simultaneously using its 

synthesizer unit to play something else. 
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Markers 

[? Bridge 

Meter Changes 

4/4 click J 

Tempo Changes 

Key Changes 

The Event List Window 

All Notes Off 

The all notes off message causes all notes that are currently sustaining 

to be shut off. 

Markers are displayed for reference in the Event Editing windows for 

all tracks in a sequence. They cannot be edited in the Event Editing 

windows for normal tracks. Unlocked markers can be edited in the 

Conductor track. Locked markers can only be edited in the Markers 

window. 

Meter changes are displayed for reference in the Event Editing 

windows for all tracks in a sequence. They can only be edited in the 

Event Editing windows for the Conductor track. Meter change events 

display the time signature (the number of beats per bar, over the 

duration value which gets the beat) and the click value (the duration 

value between metronome clicks). See the Change Meter chapter for 

more information. 

Tempo changes can be displayed and edited in the Event Editing 

windows for the Conductor track. Tempo change events display the 

duration value for the tempo marking, i.e. which value the tempo is 

measured in (quarter note = 90 for example), and the tempo value 

itself, which signifies the number of beats per minute. See the Change 

Tempo chapter for more information. 

Key changes are displayed for reference in the Event Editing 

windows for all tracks in a sequence. They can only be edited in the 

Event Editing windows for the Conductor track. Key change events 

display the name of the key. See the Change Key chapter for more 

information. 

The loops for each track are displayed in the Event Editing windows 

for that track. A loop event displays the start and end time of the loop 

and the number of times the loop is played. A loop event can be 

edited in the Event Editing windows for the track that contains it. 

Events within loops are indented to the right for clarity. See the 

chapter Looping for more details. 
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Editing nan Commands in the Edit and Region menus work on events in Event 

Event L ist List windows. This gives you the ability to precisely specify which 

events to modify. Using the Event List window to edit events allows 

you to work with one track at a time. 

To edit events in an Event List window, you must first select them, 

and then execute an edit or region command. For information on 

selecting events, refer to the Ouick Reference section at beginning of 

this chapter. Selected events turn black to indicate that they are 

selected. Here are a few important things to remember when editing 

in the Event List. 

= Only highlighted events will be affected by the command. Also, 

events not visible due to the View Filter setting will not be 

affected. 

= The Edit Filter has no effect on highlighted events. Use the View 

Filter to display and edit only those events which you wish 

to edit. If you wish to use the Edit Filter, select events using 

the Edit bar in the Tracks window. 

= The Paste and Merge commands on the Edit menu work as 

follows: If one or more events are highlighted, the contents 

of the Clipboard are pasted at the time of the first 

highlighted event. If no events are highlighted, you will be 

asked for the time at which the contents of the Clipboard 

should be inserted. 

= The Snip, Repeat, and Retrograde commands do not affect 

highlighted events. When using these commands, you must 

use the Edit bar in the Tracks window to select events. 

= Markers, key changes, meter changes, and tempo changes can be 

edited only in the Conductor track. They are not affected 

when highlighted or when you attempt to edit them 
directly in normal Event Lists. This allows you to select 

large regions of events without having to worry about 

excluding these events. 

Inserting events with the | The Insert button on the Event List window title bar inserts an event 
insert button of the specified type. To insert an event: 

1. Activate the Event List window for the desired track by clicking on 

it. 
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2. Press the insert button in the title bar. 

A menu will appear containing the different types of events you 

can insert. 

3. Choose the type of event you wish to insert. 

An event will pop up in front of the Event List. 

4. Specify the time at which the event is to be inserted. 

If you wish to change other values for the event, use the Tab or 

the left and right arrow keys to move between the value fields. For 

example, tabbing 3 times in the above example moves the active 

field as shown below. 
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5. To enter the event, press Return. 

The event will be inserted into the Event List. If you will be 

inserting another event of the same kind, press the Enter key 

instead of Return. This will insert the event and present you with 

another to be inserted. Click outside of the event to cancel the 

Insert. 

When inserting Mode changes, or System Exclusive data, extra steps 

are required. To insert a Mode change, select Mode changes from the 

pop-up Insert menu. The pop-up menu will change to display the 

options for Mode changes; select the desired command and continue 

as described above. 

See the System Exclusive chapter for information on inserting this type 

of data. See the chapter Change Key for information on inserting key 

changes. 

Editing Individual To edit any parameter field of an event in the Event List window, hold 

Events down the Option key and click on the field. You can also double- 

click on the field. In most cases, a pop-up box will appear 

surrounding that field in which you can enter the value you want; 

some events display a dialog box. 

Once you begin to edit events by using pop-up boxes, you can use 

the Tab, Enter, and arrow keys to move between fields and events. 

Here is a list of the keys you can use when a pop-up box is present: 

a Return enters the value and closes the pop-up box. 

= Command-period cancels the entry. 

ws The Enter and Down Arrow keys enter the value and 

highlight the same field in the next event. 

a The Up Arrow key enters the value and highlights same 

field in the previous event. 
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a Tab and the Right and Left Arrow keys move through each 

field of an event. 

Changing Event Values You can use your MIDI input keyboard to enter values for events. 

from a MIDI Controller When a pop-up box is present for a parameter field, if you send an 

event over MIDI of the same type as the parameter, it will be entered 

into the field. For example, if the pitch field of a note event is 

highlighted, playing a note on your MIDI controller will set the 

corresponding pitch for the event in Performer. 

This technique is particularly useful when you are uncertain of a 

value. For example, you can set an on velocity for a note by double- 

clicking on the on velocity field so that it pops up, then hitting a key 

on your controller until the note velocity sounds correct. Each time 

you hit the key, the new velocity appears in the pop up box; when 

you hear the one you want, simply press the Return key to save the 

value in the Event List. 

Remember Times The Remember Times command is used to remember the beginning 

and end times of selected regions in the Tracks, Event Editing, and 

Markers windows. 

To remember the beginning and end times of a selected region: 

1. Activate the window with the times you wish to be remembered. 

2. Select the region whose beginning and end times are to be 

remembered. 

In a Tracks window, specify the Start and End times of the region 

in the Edit bar; these will be remembered. In an Event Editing 

window, select a region of events (see the section earlier in this 

chapter on how to select a region of events in the Event List 

window; also see the chapter 7he Graphic Editing Window): the 

times of the first and last events in the selected region will be 

remembered. In a Markers window, select a region of markers 

(see the chapter 7he Markers Window): the times of the first and 

last markers in the selected region will be remembered. 

3. Choose Remember Times from the Basics menu. 

The beginning and end times are now remembered. 
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4. To insert the remembered times into the Edit, Memory, or Auto 

Record Bars, click on the Edit button in the Tracks window edit bar, 

or clock on the Memory or Auto Record button in the Consolidated 

Control Panel. 

The remembered times will be loaded into the Edit Bar of the Tracks 

window if the word “Edit” is clicked on; they will be loaded into the 

Memory Bar in the Consolidated Controls panel if the word “Memory” 

is clicked on; they will be loaded into the Auto Record Bar in the 

Tracks window if the words “Auto Record” are clicked on. 

Audible Mode Audible Mode allows you to listen to notes one at a time, or phrase 

by phrase, as you highlight them in a Performer track. This feature 

appears as a speaker icon in the title bar of each track’s Event Editing 

windows. Audible Mode provides an easy, intuitive way to see and 

hear an individual note or phrase while you are working in 

Performer’s editing windows. Notes can be played back one at a time 

by clicking on them individually or as a phrase by highlighting a 

region. 

Audible Mode playback is similar to pressing the Play button in the 

Consolidated Controls panel, including MIDI channel assignment and 

velocity information. If you click on a note and don’t hear anything 

when Audible Mode is activated, make sure that your MIDI 

connections are set up properly and that your synthesizer is ready to 

receive MIDI data. If MIDI data in a track plays back correctly when 

you press the Play button in the Consolidated Controls panel, it will 

play back properly in Audible Mode as well. 

Enabling Audible Mode To enable Audible Mode: 

1. Open the Event List or Graphic Editing window for a track. 

Either double-click on the track name in the Tracks window, or 

click on the track name once and chose Edit from the mini-menu. 
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2. To turn on Audible Mode, click once on the speaker icon in the title 

bar. 

The icon will highlight to indicate that Audible Mode is activated. 

When Audible Mode is activated, it affects all Event Editing 

windows. 

3. To turn off Audible Mode, click on the speaker icon again. 

The icon will deselect to indicate that Audible Mode is turned off. 

Playing Individual Notes When Audible Mode is enabled and you click on a note in the Event 

Editing Window, the note will simultaneously select and play back on 

your MIDI instrument. The note will sustain for as long as you hold 

down the mouse button. When you release the mouse, the note will 

stop. If you click on a note and drag up or down to highlight adjacent 

notes, each note will play individually as it highlights. Notes will play 

in the same fashion when you shift-click to highlight discontiguous 

(non-adjacent) notes. If you shift-click to deselect an already 

highlighted note, the note will play when it unhighlights. In general, 

when you highlight or unhighlight a note, it will play back for as long 

as you hold down the mouse. 

Playing Phrases Using the Audible Mode speaker icon, it is also possible to play a 

group of notes that are highlighted in the Event List. 

To play a phrase: 

1. Highlight one or more MIDI events in the Event List window. 

You can highlight the events by clicking and dragging, or by shift- 

- + 2 clicking on discontiguous events. 
Option z 3 

2. Option-click on the speaker icon on the Event List title bar. 

The speaker icon does not have to be highlighted. Option- 

clickinge—even if Audible Mode is not currently enabled—will 

cause the highlighted events to play back. 

When you option-click on the speaker icon, all MIDI data that are 

currently highlighted will play back with the proper duration and 

velocities. The tempo of the phrase is determined by the current 

The Event List Window 27 



tempo slider setting in the Metronome panel. Playback can be 

stopped at any time by clicking the mouse or striking a key on the 

Macintosh keyboard. 

The phrase can be a contiguous (adjacent) group of notes that you 

have highlighted by clicking and dragging or a discontiguous group 

of notes that you have selected by shift-clicking. Notes that are not 

highlighted will not play. 

Playing Chords Audible Mode allows you to hear chords one note at a time, all at 

once, or only with selected notes. To listen to a chord one note at a 

time, enable Audible Mode by clicking on the speaker icon. Click on 

the first note of the chord and drag downward while holding down 

the mouse button. Or you can start on the last note and drag upward. 

Each note in the chord will play as it highlights. 

To hear the entire chord at once, highlight all of the notes and option- 

click on the speaker icon. To hear only selected notes within the 

chord, highlight only the notes you wish to hear and option-click on 

the speaker icon. 

Playing MIDI Data Other Only notes will play back when you highlight them in Audible Mode. 

Than Notes Other MIDI events such as controllers or pitch bend can be played 
with the play-phrase feature. For example, to send a patch change to 

a synthesizer directly from the Event List, highlight the patch change 

and option-click on the Audible Mode speaker icon. System exclusive 

data cannot be played back in Audible Mode. To play back a system 

exclusive event, press the Play button in the Consolidated Controls 

panel. 
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Hints You can use the Event List to find out useful information about the 

way your MIDI instruments output data. For example, you can use 

the Event List window to determine the controller number for a 

wheel, slider, foot pedal, etc. Make sure that the MIDI output from 

the device in question connects to the MIDI input of your interface; 

then: 

1. Locate a controller event in an Event Edit window. 

If you can’t find one, insert one. 

2. Option-click on the controller number field to make a pop-up box 

appear. 

3. Move the controller on your input keyboard. 

The controller number will be displayed in the pop-up box. 

4. Press the Return key to save the event, or the Command and 

period keys to close the pop-up box without making any changes. 

You can use a similar technique to find the patch numbers that 

correspond to each preset on a MIDI module. Make sure that the 

MIDI output from the device in question connects to the MIDI input 

of your interface; then: 

1. Find a Patch Change event in an Event List window. 

If you can’t find one, insert one. 

2. Option-click on the patch number field to make a pop-up box 

appear. 

3. Select the preset or patch on the MIDI module. 

The patch number box in Performer will display the MIDI patch 

number corresponding to the preset. 

4. Press the Return key to save the event, or the Command and 

period keys to close the pop-up box without making any changes. 

You can insert multiple events of the same type quickly by first 

inserting the event, selecting a region including the event by setting 

the Edit bar in the Tracks window, and then choosing Repeat from 
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the Edit menu. This will effectively duplicate the event the specified 

number of times. You can then go back and edit the locations and 

values of each event. 
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Chapter 21 The Graphic Editing Window 

Each track in a Performer sequence can be viewed with the Graphic 

Editing window. The Graphic Editing window plots notes, velocities, 

and MIDI controller data on a scrolling, piano-roll graph that makes 

melodies, chords, dynamics, and tempo changes easy to recognize. 

Graphic editing is provided as a visual alternative to the numeric 

display in Performer’s Event List window. All tracks can be viewed 

with either window at any time. 

The Graphic Editing window clearly organizes information by 

displaying MIDI data in the center of the window and then 

surrounding the data with descriptive information such as loop 

indicators, markers, key changes, and meter changes. MIDI data is 

placed on two grids flanked by rulers that precisely measure location 

and value. Best of all, Performer’s Graphic Editing window lets you 

see all types of data—notes, controllers, and pitch bend—in one 

window. 
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Quick Refer ence The diagram below and the following Quick Reference section 

describe the basic features of the Graphic Editing window: 

Pointer Insert Reshape - Solo Scrolling Event Infor- Edit 
coordinates wiper mation Resolution 

Time zoom 

Info bars» 

Time ruler» 

Marker strip-——s 

Pitch zoo | ee os vate sh ottencenenaete [eee eaten 

Pitch ruler 

Pitch ruler ee - CC 
scroll bar ee eee ne nese ee eens uc ess 

Note grid galt 

Median strip ——» , 

Median strip 

move handle 

Continuous data 

grid ruler 

Continuous Volume controller Note-on Selected 

data grid events velocity note 

Information bar: Displays precise information about mouse pointer 

location, currently selected MIDI data, and editing resolution. The bar 

is divided into three boxes: the Pointer Coordinates Box, the Event 

Information Box, and the Edit Resolution Box. 

Pointer Coordinates Box: Displays the mouse pointer’s current location 

with respect to the Time, Pitch and Continuous Data rulers. 

Insert Button: Pops up the /msert menu when clicked, from which any 

type of MIDI event can be chosen for insertion. 
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The Graphic Editing Window 

Reshape Button: Changes the mouse pointer to a cross hair that 

reshapes continuous data curves when you drag over them in the 

Continuous Data Grid. 

Solo button: Mutes all other tracks during playback. 

Event Information Box: Displays the currently selected note as it would 

appear in the Event List window. If a region is selected by dragging 

in the Time Ruler, this box shows the region’s start and end time. If a 

group of events is selected, this box displays information about the 

last event that was selected. If a continuous data event is selected, 

events of that data type can be viewed alone by clicking the 

accompanying Quick-Filter check box. 

Edit Resolution Box: Displays the current time resolution for editing. 

When the check box is selected, notes and data will ‘snap’ to 

locations that correspond to the resolution displayed. If the check 

box is deselected, data will not ‘snap to grid’. Edit resolution can be 

changed by typing in a different number of beats | ticks, or by clicking 

on the note and selecting a duration from the resulting pop-up menu. 

Time Ruler: Measures time in any combination of Performer’s three 

time formats: measures | beats | ticks, SMPTE time, and real time. The 

Time Ruler can zoom in and out to enlarge or reduce the Note Grid 

and Continuous Data Grid. 

Main Ruler Selector: Changes an auxiliary ruler into the main ruler. The 

main ruler is the lowest ruler displayed and determines the time 

format for editing. Auxiliary rulers are for visual reference only. 

Marker Strip: Displays markers, meter changes, key changes, and 

loops. Loops can be edited in this strip. Markers and meter changes 

must be edited in the Conductor track or Markers window. No MIDI 

data appears in the Marker Strip. 

Note Grid: Displays notes as horizontal bars on a time vs. pitch grid. 

Only notes are displayed on this grid. Pitch is determined vertically 

by the pitch ruler on the left. Location and duration are measured by 

the Time Ruler above, with duration determined by the length of the 

bar. Notes can be edited with the mouse one at a time, in a group, or 

by region. 
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Selected Note: When a note is selected, it highlights. Complete 

information about the selected note will automatically appear in the 

Event Information box at the top of the window. Drag the end of the 

note to change its duration. 

Median Strip: Displays discrete MIDI events such as patch changes, 

mode changes, switch controllers like #64 (sustain), and system 

exclusive events. Each type is displayed as an icon, defined by the 

Legend window. The Median Strip serves as a border between the 

Note Grid and the Continuous Data grid; it can be dragged up and 

down with the handles at either end to proportionally resize the 

grids. 

Median Strip Move Handle: Moves the Median Strip up or down. 

Dragging up will shrink the Note Grid and enlarge the Continuous 

Data Grid; dragging down will enlarge the Note Grid and shrink the 

Continuous Data Grid. 

Continuous Data Grid: Displays continuous data as small icons on a 

time vs. value grid. Pitch bend, key pressure, controllers, and note 

velocities are displayed simultaneously on this grid. An event’s 

location is measured by the Time Ruler at the top of the window. 

Value is determined by the Continuous Data Ruler on the left. Each 

type of continuous data has a unique icon. 

Continuous Data Ruler: Measures continuous data events. This ruler can 

be toggled between three scales: a controller scale from 0 to 127, 

whose origin rests at the bottom of the window; a pitch bend scale 

from -8192 to 8191, whose origin appears in the middle of the grid; 

and a combination scale that shows both pitch bend and controller 

data at once on a -80 to 127 scale. Toggle among the three scales by 

clicking on the ruler. 

Pitch Ruler: Measures pitch along the vertical axis with a standard 

keyboard format. Each C-natural indicates the octave. For clarity, 

dotted lines extend to the right from each key: a heavy dotted line for 

black keys and a light dotted line for white keys. With the Pitch Zoom 

icon, this ruler can zoom in or out to increase or decrease the number 

of visible octaves. 
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Basics 

Viewing Data three 
different ways 

Opening the Graphic 
Editing Window 

The Graphic Editing Window 

Pitch Zoom Icon: Zooms the pitch ruler in or out. Click on the large 

keys to zoom in; click on the smaller keys to zoom out. Four pitch 

zoom settings are available. Zooming out allows you to see more 

octaves at once. Zooming in allows you to focus on a particular pitch 

range. 

Time Zoom Icon: Zooms the Time Ruler in or out. Click on the ‘in- 

pointing’ arrows in the upper half to zoom in; click on the ‘out- 

pointing’ arrows in the lower half to zoom out. Eight time-zoom 

levels are available. Zooming out gives you an overview; zooming in 

focuses on a shorter period of time at higher resolution. Editing can 

be done at any zoom level. 

Graphic Editing is available in all tracks, including the Conductor 

Track. The piano-roll display of notes and the Continuous Data Grid 

allows you to manipulate MIDI data using many of the conventions 

established by Macintosh paint programs. For example, you can drag 

a note to change its location; you can lengthen the note by dragging 

its handle. If the Edit Resolution feature is enabled, the note, when 

moved, will ‘snap’ to a time grid. You can select a group of notes by 

dragging a selection box over them. When you release the mouse, 

notes inside the box will become selected. Most of the features 

described in this chapter can be used during playback. 

Each track in a Performer sequence contains MIDI data. This data can 

be viewed with the Event List window, the Graphic Editing window, 

or the QuickScribe notation window. The data in the track is the 

same regardless of which window you use. For example, if you edit 

data in the Graphic Editing window, the changes you make will be 

immediately reflected in the track’s Event List window. 

To open the Graphic Editing window for a track: 

1. Activate the Tracks window that contains the track you wish to edit. 

Click once on the Track window to activate it. 

2. Command-double-click the track name. 

The Graphic Editing window will appear. 

You can also open the Graphic Editing window by choosing Graphic 

Editing from the Event List window mini-menu. 
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Displaying More Than All three types of Event Editing windows for a single track can be 

One Event Editing open at the same time. Changes in one window are immediately 

Window at a Time reflected in the other. The current position of each window is 

remembered when you save the file. 

101120 beats 

Scrolling During The Auto-Scroll command in the Basics menu can make the Graphic 

Playback Editing window scroll during playback. In addition, the window will 

automatically open to the current playback location of the sequence. 

Please refer to the Auto-Scrolling section in the Playback chapter for 

more information. 
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Switching to a Different If you have an event editing window open for a track, you can switch 

Track Using the Title Bar to a different track in the same window. To do so: 

Pop-up Menu 
1. Command-click the track name in the title bar. 

A pop-up menu appears as shown below. 

Command-click the track name in the title bar to use the pop-up 
menu to move from track to track within the same editing window. 

2. Choose the desired track. 

The contents of the window changes to the track you select. 

The Graphic This menu is available in the title bar of every track’s Graphic Editing 
Oe “| window. Editing Window 

Mini-menu Set View Filter: Calls up a dialog box in which you specify types of 

events to be visible in the Graphic Editing window. The View Filter 

applies to all tracks and affects both the Graphic Editing and Event 

List windows. 

Goto Counter: Automatically scrolls the graphic display to the time 

currently displayed in the Counter. The counter location will appear 

at the left-most position in the window. 
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Goto: Automatically scrolls the graphic display to a time you specify, 

which will appear at the left-most position in the window. 

Relnsert: Inserts an event of the same type that you last inserted. This 

is the same as the Insert command but you are not prompted for the 

type of event. This command can also be invoked by option-clicking 

on the Insert (1) button on the Graphic Editing window title bar. 

Reshape: Changes the mouse pointer to a cross hair that reshapes 

selected continuous data curves when you drag over them in the 

Continuous Data Grid. This command can also be invoked by 

clicking the Reshape button in the title bar. 

Legend: Produces a window that shows the icon representing each 

type of MIDI event. 

/ e . 
Set Rulers: Allows you to configure the Time Ruler in any combination 

of Performer’s three time formats: measures | beats | ticks, SMPTE time, 

and real time. The main ruler is displayed lowest and determines the 

time format for editing. 

Cont. Data Icons: Opens the Continuous Data Icons window, which 

displays icons for each type of continuous data. This window also 

allows you to reassign controller icons. 

| _ Set Ptr. Coords...(Set Pointer Coordinates): Allows you to choose what 

E Meee _ time and pitch formats will be displayed in the Pointer Coordinates 

_ Se Frames _ 
MIDI Edit: Allows data in the graphic editing window to be edited 

from a MIDI controller. 

Switches are Cont. Data: Causes all controllers, including switch 

controllers #64 and above, to be displayed and edited as continuous 

controllers. This is useful for MIDI devices, such as MIDI-controlled 

lighting consoles, that use all MIDI controllers as continuous 

controllers. 

Selections use Edit Resolution: Causes the cursor to snap to the edit 

resolution when dragging to make selections in the note grid, time 

ruler, and continuous data grid. 

Event List: Opens the track’s Event List window. 
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The Insert 
Button 

The Reshape 
Button 

The Information 
Bar 

Notation Editing: Opens the track’s Notation Editing window. 

QuickScribe Notation: Opens the QuickScribe notation window with 

the track displayed in it by itself. 

Measures|Real timelFrames: These checkable entries control which time 

formats are displayed in the Information Bar and Event List. 

The Insert button appears in the title bar of the Graphic Editing 

window. It only appears when the window is in Graphic Editing 

mode. When the Insert button is clicked, the Insert menu appears, 

from which you can choose the desired event to be inserted by 

clicking once on the event type. An event will pop up to be inserted. 

Option-clicking the Insert button is just like choosing RelInsert from 

the mini-menu. 

The Reshape button appears next to the Insert button. When the 

Reshape button is clicked, the mouse pointer changes to a cross hair. 

When you drag the cross hair over a selected curve in the Continuous 

Data Grid, the curve will reshape as you drag. For more information 

about reshaping continuous data, see the section later in this chapter 

called Reshaping a Continuous Data Curve. 

The Information Bar at the top of the Graphic Editing window 

appears just below the title bar and is divided into three sections 

separated by doubled lines. The sections display precise, numeric 

information about mouse location, currently selected data, and 

minimum editing resolution. MIDI data in the bar is displayed as it 

would appear in the Event List window. 

= 1/000 beats 

The Graphic Editing Window 

Sometimes, information in each box may extend beyond the space 

provided and will be clipped on the right side of the box. If so, 

enlarge the Information Bar by dragging the window’s grow box to 

the right. 
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The Pointer Coordinates The Pointer Coordinates box is the left-most section in the 

Box Information Bar. It displays the current location of the mouse pointer 

with respect to the Time, Pitch and Continuous Data rulers. Values in 

this box are continually updated as the mouse pointer moves over the 

Note Grid and Continuous Data grid, giving you immediate, 

numerical accuracy when manipulating data with the mouse. 

The pointer’s horizontal coordinate can be expressed in 

measures | beats | ticks, SMPTE time, or real time. Which time formats 

are shown is determined by the Set Pointer Coordinates menu item in 

the Graphic Editing window mini-menu. 

To set the Pointer Coordinates box display: 

1. Choose Set Ptr. Coords... from the Graphic Editing window mini- 
menu. 

A dialog box appears. 

Set Pointer Coordinates 

2. Check the time and pitch formats you prefer. 

You can select any time format combination, independent of the 

Time rulers that are displayed. 

3. Click OK to confirm your choice or Cancel to cancel it. 

Bb? #538 2 l4l260 :0:00:03 -23 
are 
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The Event Information 
Box 

The Graphic Editing Window 

The pointer’s time and pitch coordinates will be expressed in each 

selected format. For example, if both Measures and Frames are 

checked in the mini-menu, the mouse position will be displayed in 

both measures and SMPTE time. 

The pointer’s vertical coordinate depends on its location: if it is in the 

Note Grid, the vertical coordinate may be expressed as a pitch, such 

as C3, and its MIDI note number, 60. 

If the pointer is in the Continuous Data Grid, the vertical coordinate 

is expressed as a continuous data value on one of three scales: 0 to 

127, -8192 to 8191, or -80 to 127, depending which is currently 

displayed by the Continuous Data Ruler. 

If the pointer is in the Median Strip, no vertical coordinate is shown. 

The Event Information box displays numerical information about a 

single event or region that has been selected. This box displays data 

in the same way as it appears in the Event List window. For example, 

a selected note will appear with its measures | beats | ticks location, 

pitch, on and off velocity, and duration. 

If a region is selected by dragging in the Time Ruler, the Event 

Information box displays the start and end locations of the selected 

region. 

If more than one event is selected by shift-clicking or dragging, the 

box displays information about the event that was last clicked. 
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Quick Filter 

check box 

The Edit Resolution Box 

292 

When a continuous data event is selected in the Continuous Data 

Grid, the Ouick-Filter check box appears next to the event’s data. 

When clicked, the check box causes all other data types to 

temporarily disappear from the Continuous Data Grid; the selected 

type remains visible. For example, if you select a controller #3 event 

and click the Quick-Filter check box, all controller #3’s will remain 

visible and other data types, such as pitch bend and velocities, will 

disappear. To make the other data types reappear, deselect the check 

box. 

Information displayed in the Event Information box can be pop- 

edited by clicking an item. As normal, the Tab key and arrow keys 

move from field to field. Press Return to confirm any changes you 

have made, and the event’s graphic display will change to reflect the 

modifications. 

Sometimes, information in this box may extend beyond the space 

provided and will be clipped on the right side of the box. If so, 

enlarge the Information Bar by dragging the window’s grow box to 

the right. 

The Edit Resolution box determines the minimum time unit for 

editing. The minimum time unit consists of a duration, such as 240 

ticks, or one eighth note. MIDI events, note durations, loops, region 

boundaries, Memory-cycle repeat barlines, or any object that can be 

dragged horizontally will only move in time increments equal to the 

value of the edit resolution unit. Edit resolution only affects MIDI data 

when the data is moved horizontally with the mouse. 

The Edit Resolution box can be enabled or disabled with the check 

box provided. When the check box is selected, the current resolution 

unit is shown as a note duration accompanied by a number of beats 

and ticks. When disabled, the Unit = and beats indicators become 

greyed out and editing occurs at maximum resolution, which is either 

one tick, one frame, or one screen pixel depending on the time zoom 

setting. 

You can change the edit resolution at any time. To change the edit 

resolution: 

1. Click on the note displayed in the Edit Resolution box. 

A pop-up menu will appear that displays note durations. 
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The Time Ruler 

The Graphic Editing Window 

2. Select a note duration from the pop-up menu and release the 

mouse. 

The duration you chose will now be displayed in the box. Note 

also that the number of beats and ticks now equals the note 

duration. 

OR 

3. Click on the beatsiticks values. 

A pop-up box will appear. 

4. Type in a number of beats and ticks in the box provided and press 

Return to confirm your choice. 

Note that when you type in a number of beats and/or ticks, the note 

displayed next to the ticks box will grey out if the tick value does not 

equal a standard duration, such as 120 or 240 ticks. 

Also note that when you zoom in the Time ruler, Edit Resolution may 

cause data to seem like it is “stuck”; that is, data will not move when 

you try to drag it. This is because the Edit Resolution is larger than the 

distance you are dragging. To “unstick” the data, deselect the Edit 

Resolution check box. Or hold down the option key while dragging. 

Doing so overrides the edit resolution temporarily. The option key 

temporarily overrides the current setting of the Edit Resolution check 

box. 

The Edit Resolution box affects all Graphic Editing windows. It does 

not affect the Event List window. 

The Time Ruler measures time horizontally for all MIDI data in the 

Note Grid, the Median Strip, and the Continuous Data Grid. 
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The Time Ruler consists of a main ruler, which appears just above the 

Marker Strip. Auxiliary rulers that display other time formats can also 

be displayed above the main ruler. 

To help line up MIDI events with the ruler, vertical grid lines extend 

downwards from the main ruler, through both grids and the Median 

Strip, to the bottom of the window. These hairlines are placed at 

regular intervals such that they remain a similar distance apart 

between zoom levels. 

To help align the mouse pointer with the Time Ruler, a dotted hairline 

inside the Time Ruler indicates the current position of the mouse. 

Using the time ruler to You can double-click a segment in the time ruler to make Performer 

select a playback point jump to that location for playback. You can do so when Performer is 
stopped or during playback. This is an ideal way to quickly locate to 

a desired point with the mouse. 

Choosing Time Formats The Time Ruler can display time in any combination of Performer’s 
three time formats: measures | beats | ticks, SMPTE, and real time. You 

can choose which formats to display with the Set Rulers dialog box. 

To choose the time format(s) for the Time Ruler: 

1. Choose Set Rulers from the Graphic Editing window mini-menu. 

The Set Rulers dialog box will appear. 

r Set Rulers 
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Changing an Auxiliary 
Ruler into the Main Ruler 

Zooming the Time Ruler 

Zooming 

The Graphic Editing Window 

2. Choose a main ruler and any auxiliary rulers that you prefer. 

The main ruler appears lowest and determines the time format for 

editing. Auxiliary rulers appear above the main ruler. If the Tempo 

Control setting is currently set to the Conductor track, only 

Measures can be displayed as the main time ruler. 

3. Click OK to confirm your choice or Cancel to cancel it. 

To quickly switch an auxiliary ruler into the Main Ruler: 

m Click the auxiliary ruler’s time format icon in the Main 

Ruler Selector. 

The ruler will become the main ruler and appear at the bottom. If the 

Tempo Control setting is currently set to the Conductor track, only 

Measures can be displayed as the main time ruler. 

The Time Ruler can be zoomed in or out with the Time Ruler Zoom 

icon to the left of the ruler. Zooming out gives you an overview by 

compressing greater amounts of time into the window; zooming in 

focuses on a shorter period of time at higher resolution. See the 

following section called Zooming for more information. 

The Time Zoom and Pitch Zoom icons allow you to ‘zoom’ the time 

and pitch rulers in and out. Zooming in Performer is similar to the 

magnification feature found in most Macintosh graphics programs. 

When zooming in, objects become larger as the display magnifies a 

portion of the screen. When zooming out, objects shrink as the 

display encompasses a larger region. 

Performer’s zoom feature is based on the same idea; however, the 

Time and Pitch Zoom icons allow the time and pitch axes to zoom 

independently. For example, you can zoom out the Time Ruler to see 

more measures at one time, and zoom in the Pitch Ruler to focus on 

a specific pitch range. 

Because pitch and time zooming are exclusive from one another, 

notes on the Note Grid will not magnify or shrink in the same manner 

as a standard zoom feature. In addition, the grid lines remain 

approximately the same distance apart, regardless of the zoom 

setting. 

Pig 



Zooming the Time Ruler The Time Zoom icons zooms the Time Ruler. They appear just to the 

left of the Time Ruler. Zooming out gives you an overview by 

compressing more measures into the window; zooming in focuses on 

a shorter period of time at a higher viewing resolution. The dotted 

hairlines extending from the Time Ruler remain approximately the 

same distance apart, regardless of the zoom setting. 

The Time Ruler provides 8 zoom levels if the main ruler is displaying 

measures and beats or real time. It provides 7 zoom levels when the 

main ruler displays SMPTE time. When zooming out, notes with 

extremely short durations will remain visible. 

Editing is allowed at any time zoom setting. However, the current 

zoom level may affect the resolution at which events can be edited. 

For example, let’s say that the edit resolution unit is set to 20 ticks in 

the Edit Resolution box. If you zoom the Time Ruler out as far as it 

can go, you will not be able to drag a note by only 20 ticks because 

one screen pixel, which is the smallest unit of movement on the 

Macintosh screen, will equal a time value greater than 20 ticks. So, 

even if you move the note as little as possible, you will still have 

moved it more than 20 ticks. 

In the example above, Performer handles the situation by 

constraining location to multiples of 20 ticks. When you move the 

note, its new location will become the nearest multiple of 20 ticks, 

such as 80, 140, or 420 ticks. 

Zoom in 
i ——— 

To zoom out, click once (or repeatedly) on the magnifying glass icon 

with the minus sign ( - ). To zoom in, click once (or repeatedly) on 

the magnifying glass icon with the plus sign ( + ). 

Zooming the Pitch Ruler The Pitch Zoom icon zooms the pitch ruler and provides four zoom 

settings. Zooming out reduces the size of the keys on the ruler, 

allowing you to see more octaves at once; zooming in enlarges the 

keys, allowing you to focus on a particular pitch range. 
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When the Pitch Ruler is zoomed in, notes become larger and the grid 

displays a smaller pitch range: 

When the Pitch Ruler is zoomed out, notes become slightly smaller 

and the grid displays several octaves: 

To see smaller notes and larger pitch range, click once (or repeatedly) 

on the small keys in the icon. To see larger notes (and a smaller pitch 
range), click once (or repeatedly) on the large keys in the icon. 

Smaller notes —___» | |< Larger notes 
(larger pitch range) 
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Zooming shortcuts 
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Basics 

Using the Shift Key to 
Constrain Dragging 
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Here are some zooming shortcuts: 

Do this: To zoom as follows: 

Command-drag To fill the window with the region 

you select 

Command-click To zoom out to the next standard 

zoom level 

Option-click the zoom out button To zoom all the way out 

Option-click the zoom in button To zoom all the way in 

The time ruler zoom buttons in the Graphic Editing and Notation 

Editing window, as well as the pitch ruler zoom buttons, have the 

keyboard shortcuts as shown below. 

command-right arrow 

command-left arrow 

command-down arrow 

command-up arrow 

All of Performer’s powerful editing features are available in the 

Graphic Editing window. Most editing can be done with the mouse 

using familiar actions like clicking, dragging, and shift-dragging. Such 

actions can shift data, change note pitch and duration, reshape 

continuous data curves, and more. 

The sections below describe basic features that you will find helpful 

when working in Performer’s graphic environment. 

If you hold down the Shift key just before you begin to drag the 

mouse, the pointer’s movement on the screen will be constrained to 

either the horizontal or vertical axis, depending on the initial 
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Option-dragging to 
Make Copies 

Shift-clicking to Select 
Non-adjacent Events 

Dragging Multiple Data 
Types 

The Graphic Editing Window 

direction of movement. For example, if you click the mouse, hold 

down the shift key, and drag upwards, the mouse will only move up 

or down: it will not stray left or right. 

Constraining mouse movement in this way is often extremely helpful. 

For example, if you want to modify just the pitch of a note without 

changing its location, the Shift key allows you to do so by preventing 

the mouse from moving left or right. 

To constrain the movement of the mouse: 

1. Press on an event without moving the mouse. 

2. Press the Shift key. 

It is very important to press the mouse /irst and then press the shift 

key. If you press the Shift key first, you will Shift-click, which 

produces a different action (described in the next section). 

3. Drag in the direction you wish. 

If you drag up or down, the mouse will only move on a vertical 

axis. If you drag left or right, the mouse will only move on a 

horizontal axis. Movement will be constrained until you release 

the mouse. 

Similar to Macintosh graphics programs, option-dragging in the 

Graphic Editing window leaves the original data unchanged and 

places a copy of the data at the destination. Option-dragging is a 

convenient shortcut for copying and pasting. 

Holding down the Shift key before you click serves as a useful way to 

select more than one event. For example, if you have already selected 

a note and you want to select another, scroll to the other note Gf 

necessary) and shift-click on it. It will highlight, and the first note will 

remain highlighted. 

The shift-click method of selection allows you to simultaneously 

select and drag multiple data types horizontally in the Note grid, 

Continuous Data grid, Median strip, and Marker strip. 

For example, to move a loop containing notes, pitch bend data, and 

a patch change, select all four data types by shift-clicking and drag 

them to a new location. 
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When the Edit Resolution check box is selected, MIDI data that is 

moved or inserted will ‘snap’ to positions corresponding to the edit 

resolution unit shown in the box. For example, if the current edit 

resolution unit is 240 ticks, events that are moved with the mouse will 

snap to eighth note positions (every 240 ticks) on the grid. If the Edit 

Resolution check box is not checked, events will move freely. For 

more information about the Edit Resolution box, please refer to the 

section earlier in this chapter called The Edit Resolution Box. 

In the Graphic Editing window, a region can be selected by dragging 

to the left or right in the Main Time Ruler. The region inside the ruler 

highlights, as well as the entire grid beneath, and all visible data 

within the region becomes selected. In addition, the start and end 

locations of the region are displayed in the Information Bar. Selecting 

a region in this fashion is similar to setting the Start and End times in 

the Tracks window Edit Bar. 

Highlighting a region in this way allows the following commands to 

function from the Graphic Editing window: Set Loop, Repeat, Snip and 

Retrograde. 

Dragging in the Time Ruler is constrained by the current editing 

resolution. 

To select a region with the Time Ruler: 

1. Select the desired edit resolution. 

2. Click and drag on the Main Time Ruler. 

The start and end locations of the region are constrained by the 

current edit resolution. You can drag to the left or right. 
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Using the Undo 
Command 

The View Filter 

The Graphic Editing Window 

The Undo command in the Edit menu will undo the last action you 

executed in the Graphic Editing window. For example, if you move 

a note and then change your mind, you can choose Undo Move from 

the Edit menu and the note will pop back to its original position. The 

Undo command is also useful when drawing or redrawing 

continuous data curves. If you modify a curve and are not satisfied 

with the results, simply choose Undo from the Edit menu or press 

command-Z and try again. 

In the Graphic Editing window, the View Filter serves two useful 

functions. It allows you to control what types of data you can see and 

edit in the window. In essence, the View Filter acts like an edit filter: 

if a type of data, such as pitch bend, is visible in the window, it will 

be affected by editing commands. If the data type is not visible in the 

window, it cannot be edited. 

The View Filter consists of a dialog box with each type of data listed 

next to a check box. If the check box is highlighted, the type of data 

will be visible. If the check box is not highlighted, the data type will 

not be visible. 

To use the View Filter: 

1. Choose Set View Filter from the Graphic Editing window mini- 
menu. 

The View Filter dialog box will appear. 

2. Select the check box next to the data types you wish to see. 

If you wish to see all data types, click the Set All button. If you 

option-click a check box, it will highlight and all other boxes will 

deselect. If you command-click a check box, it will deselect and 

all other boxes will highlight. If you press the clear button, all 

check boxes will deselect. 

3. Click Okay to confirm your choice or click Cancel to cancel. 

You can change the View Filter at any time. 
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The Mar, ker Str, ip The Marker Strip appears just below the Time Ruler. It displays 

markers, meter changes, key changes and loops. It is always visible 

and is not affected by vertical scrolling. 

The Marker Strip shares the Time Ruler with the Note Grid, the 

Median Strip, and the Continuous Data Grid. Therefore, the location 

of items in the Marker Strip will correspond with MIDI data displayed 

below. 

Markers, meter changes, and key changes often occur very close 

together or at the same location. In the first example to the left, the 

meter change is preceded by a marker, which appears as a bar just to 

——— > |GMarker-3 its left. If you would like to see the entire marker, press it, and the 

12/8 click ob marker will highlight and pop to the front. If the marker and meter 

change occur exactly at the same tick, they are displayed with a list 

icon, shown in the second example. If you would like to see the list, 

press the list icon, drag downwards and a pull-down menu will pop 

open. 

[izzs] > (Griarie=2 

Mar ker. Ss In the Marker Strip, a marker appears as a pointer, followed by the 

marker’s name. The pointer indicates the marker’s exact location. If 

the marker is locked, a lock icon will appear between the pointer and 

the marker name. 

Markers cannot be edited in the Marker Strip; instead, they can be 

edited in the Conductor track or the Markers window. Please refer to 

the chapter on the Markers window for more information about 

editing markers. 

In the Conductor track, markers are displayed in the Median Strip. 

Please refer to the section later in this chapter called Graphic Editing 

in the Conductor Track for more information. 
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Meter and Key 
Changes 

Loops 

Working with 
Loops 

To insert a Loop 

The Graphic Editing Window 

Meter and key changes appear in the Marker Strip in much the same 

way as they do in the event list window. (Tempo changes are not 

displayed in the Marker Strip.) Similarly, they can only be edited in 

the Conductor track. Please refer to the section later in this chapter 

called Graphic Editing in the Conductor Track for more information. 

Loops appear in the Marker Strip as a loop icon followed by a line 

that ends in a bracket. The loop icon indicates the beginning of the 

loop; the line and bracket represent the duration and end of the loop. 

Following the loop, the Marker Strip contains a greyed-out region that 

represents the time during which the loop plays. Just like italicized 

notes in the Event List display, MIDI data within the greyed-out 

region will not play back because data inside the loop plays instead. 

Data within the greyed-out region can, however, be edited normally. 

When a loop is selected, the Marker Strip area inside of the loop will 

highlight, indicating that the loop is selected. Numerical data about 

the loop will be displayed in the Event Information bar. When loops 

are nested inside one another, the outer-most loop appears above the 
loops nested inside it. 

Loops can be edited by dragging the loop icon in the Marker Strip 

with the mouse or by editing the numbers displayed in the 

Information Bar. 

To insert a loop: 

1. Press on the Insert button in the title bar of the Graphic Editing 
window and choose Loop from the menu. 

The mouse pointer turns into a cross hair. 
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To Edit a Loop 

The Note Grid 

Basics 
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2. Click at the desired start location in the Marker Strip, drag to the 

right to draw the desired length, and release the mouse at the end 

location. 

A loop will appear. Use the dotted hairlines in the Time Ruler to 

align the beginning and end of the loop while inserting it. 

Information about the loop will appear in the Information bar. 

To change the location of a loop: 

1. Click the loop icon in the Marker Strip and drag left or right to 

advance or delay the loop. 

The entire loop, from beginning to end, will move when you drag 

the loop icon in this fashion. You can align the start or end point 

of the loop by watching the hairlines provided in the ruler. 

To change the length of a loop: 

1. Select the loop by clicking on its loop icon in the Marker Strip. 

The loop will highlight. 

2. Click the end bracket of the loop and drag left or right to shorten or 

lengthen the loop. 

Align the end bracket by watching the hairline provided in the 

ruler. 

The Note Grid is the region in the Graphic Editing window between 

the Marker Strip and the Median Strip. It is flanked by the Pitch Ruler 

on the left and a vertical scroll bar on the right. 

The Note Grid functions like a standard graph. Time extends 

horizontally from left to right and pitch stands vertically. Thus, the 

higher the pitch of a note is, the higher it will appear on the grid. The 

later a note occurs, the farther to the right it will appear on the grid. 

The time and pitch axes are measured with a Time Ruler above the 

grid and a Pitch Ruler to the left of the grid. The rulers indicate the 

exact location and pitch of notes. Grid hairlines extend from each 

ruler to aid you in determining a note’s position. 
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Scrolling in the Note 
Grid 

Controlling the 
Dimensions of the Note 
Grid 

Displaying Notes 

The Graphic Editing Window 

Because the size of the Graphic Editing window is restricted, the Note 

Grid usually displays only a portion of the track at one time. The 

horizontal scroll bar at the bottom of the window moves the Note 

Grid to the left and right. The vertical scroll bar just to the right of the 

Note Grid moves the pitch axis up and down over the entire MIDI 

note range. By scrolling, you can view any region of the track at any 

pitch range. 

The size of the Note Grid is controlled by the Graphic Editing 

window grow box in the lower right hand corner of the window, and 

by the Median Strip just below the Note Grid. Drag the grow box to 

resize the entire window. Drag the Median Strip up or down with the 

move handles provided at either end to decrease or increase the size 

of the Note Grid and Continuous Data Grid respectively. For 

example, if you drag the Median Strip down as far as it will go, you 

will see just the Note Grid: 

Unit = ff 01120 beats 

Only notes are displayed on the Note Grid, and they appear as 

horizontal bars. The vertical position of the bar indicates pitch. The 

left end of the bar indicates where the note begins, and the right end 

indicates where the note releases. The length of the bar represents 

the note’s duration. All of these characteristics can be determined by 

the Time Ruler above the grid and the Pitch Ruler to the left. 
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Note-on velocity 

Note-off velocity 

Displaying On and Off 
Velocities 

Selected velocity 
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Selected note 

When the Pitch Ruler is zoomed in, each bar tapers at the ends to 

distinguish it from adjacent notes. When the Pitch Ruler is zoomed 

out, notes become smaller and do not taper. Sometimes, adjacent 

notes of the same pitch will look like one long note. The example 

below shows two adjacent notes when the Pitch Ruler is zoomed out. 

When zoomed in, the notes are easily distinguished, as shown to the 

right: 
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Two notes, zoomed out The same notes, zoomed in 

The on and off velocities of notes are not displayed in the Note Grid. 

Instead, they are displayed in the Continuous Data Grid directly 

below the note. An on velocity appears as a small “v” directly below 

the beginning of the note bar, and an off velocity appears as a small 

A” directly below the release. If a note is selected, its velocity icons 

will be selected with the note. 
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Displaying on-velocities in this manner allows you to edit them in the 

same ways as continuous data. For example, you can create a 

crescendo or decrescendo simply by editing on-velocities in the 

Continuous Data Grid. See Editing Continuous Data \ater in this 

chapter called for more information. 

Off-velocities are displayed in the continuous data grid for reference 

only; they cannot be graphically edited. On-velocities can be fully 

edited. 

Controlling the Display The View Filter, found in the Graphic Window mini-menu, allows 

of Notes with the View you to choose whether or not notes are displayed in the Note Grid. 
Filter If you have MIDI data in a track, but you cannot see the notes in the 

Note Grid, check the View Filter and make sure that the Notes check 

box is selected. 

The View Filter also controls whether on and off velocities will be 

displayed. For example, if the On Velocities check box is deselected 

in the View Filter, the “V’ icons will not appear on the Continuous 

Data Grid. 

The Pp itch R uler The Pitch Ruler lies vertically to the left of the Note Grid and 

measures pitch. It resembles a standard piano keyboard. Because the 

entire ruler cannot fit in the window at once, a vertical scroll bar is 

provided to the right of the note grid to allow you to scroll up and 

down through the entire MIDI pitch range. Octaves are indicated on 

each C-natural key. 

To help align notes to the ruler, hairlines extend to the right from 

each note, a heavier line for black keys and a lighter line for white 

keys. 

To help align the mouse pointer with the Pitch Ruler, a moving dotted 

hairline inside the Pitch Ruler follows the current position of the 

mouse. 

Listening to the Pitch When the Audible Mode button (labelled with the speaker icon) is 
Ruler pressed in the title bar of the Graphic Editing window, the keys on 

the pitch ruler play their pitch over MIDI when you click on them. 

When you click on a Pitch Ruler key, a MIDI note with that pitch is 

transmitted from Performer to the MIDI channel(s) that the track is 

assigned to. 
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Playback from a track’s Pitch Ruler has the same requirements as 

regular playback: the track must be assigned to a MIDI channel and 

a synthesizer must be set up to receive MIDI on that channel. If you 

click on a Pitch Ruler key and don’t hear anything, make sure that 

your MIDI connections are set up properly and that your synthesizer 

is ready to receive MIDI data. If MIDI data in the track plays back 

properly when you press the Play button in the Consolidated 

Controls panel, the Pitch Ruler keys will play back properly as well. 

If you are having trouble getting the Pitch Ruler keys to play, refer to 

the Getting Started booklet that accompanies this reference guide. 

Zooming the Pitch Ruler The Pitch Ruler can be zoomed in or out with the Pitch Zoom icon, 

which provides four zoom settings. Zooming out reduces the size of 

the keys on the pitch ruler, allowing you to see more octaves at once. 

Zooming in enlarges the keys, allowing you to focus on a particular 

pitch range. 

For more information about zooming the Note Grid with the Pitch 

Ruler, please refer to the section earlier in this chapter called 

ZOOMINE. 

Lengthening the Pitch The pitch ruler only displays as many keys as will fit in the window 

Ruler at the current zoom setting. If you wish to see more keys, resize the 

Graphic Editing window and drag the Median Strip down. 

You can also view more Keys at a time by zooming out the pitch ruler 

as described in the previous section. 

Inserting Notes To insert a note: 

1. If you’d like to be able to hear the pitch as you insert the note, make 

sure Audible mode is turned on in the title bar. 

Audible mode 
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Inserting a Note Using a 
MIDI Controller 

The Graphic Editing Window 

2. 

3. 

4. 

If desired, set the edit resolution. 

ol : -_ — Edit resolution 

From the insert menu in the title bar, choose Note. 

Press on the grid at the desired location, and then drag up and 

down to specify the pitch and drag to the right to specify the 

duration. 

Keep dragging until you get the pitch and duration you want. 

When you have got the pitch and duration you want, release the 

mouse to insert the note. 

Note insertion always starts with the last duration you inserted. 

If you want to insert multiple notes quickly, hold down the shift key 

when you first click on the grid each time. This preserves the note 

insertion cross-hair cursor rather than switching back to the arrow 

CUrsoOr. 

To determine the pitch of a note by playing the note when you insert 

it: 

a: Make sure that MIDI Edit is checked in the Graphic Editing Window 

mini-menu. 

If it is not checked, choose it. 

Press on the Insert button in the title bar of the Graphic Editing 

window, 

Choose Note from the menu. 

The menu will disappear and the pointer will turn into a cross 

hair. 
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Inserting a Chord Using 
a MIDI Controller 
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To 

AS 

Click at the desired time location on the Note Grid, drag to the right 

to draw the desired duration, and release the mouse. 

You do not need to be careful about pitch location, which is taken 

care of in the next step. 

With the inserted note still selected, press any key on your MIDI 

controller. 

The inserted note will pop to the pitch that you choose. The 

inserted note must still be selected from the previous step for this 

step to work. If you press the wrong note, try again. You can keep 

changing the note’s pitch in this fashion as long as the note 

remains selected. 

insert a chord: 

. Press the Insert button in the Graphic Editing window title bar. 

Choose Note from the menu. 

The Cursor will turn into a cross-hair. 

If you would like to insert more than one chord, either hold down 

the shift key, or push down the caps lock key. 

This will keep Performer in insertion mode after you insert the 

chord. 

. Play the chord you wish to insert on your MIDI controller and, while 

holding the chord, click where you want the chord to begin and 

drag from left to right to the appropriate duration. 

The vertical position of your click is not important; the notes are 

determined by what you play on your controller. Only the attack 

and release of the chord is affect by the cross-hair. 

long as you remain in insertion mode, you can enter chords in this 

fashion for as long as you like. You can even alternate between 

entering notes with the mouse only or the mouse with a MIDI 

controller. 

The Graphic Editing Window 



Selecting Notes This section describes how to select notes on the Note Grid. To learn 

how to select an entire region by dragging in the Time Ruler, refer the 

section earlier in this chapter called Selecting a Region Using the Time 

Ruler. 

Selecting a Single Note To select a note on the Note Grid: 

1. Click once on the note to select it. 

The note becomes highlighted to indicate that it is selected. 

Selecting a Group of To select a group of events: 

Notes 
1. Drag out a selection box over the events to be selected. 

A highlighted box indicates the selection area. 

2. Release the mouse. 

Only events whose attack occurs inside the selection box will 

select. 
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Selecting all Notes of a You can quickly select all notes of a specific pitch in the note grid by 

Single Pitch double-clicking a key on the Pitch ruler. Shift-double-click multiple 
keys to select discontiguous pitches. Shift-double-clicking selects or 

deselects without deselecting other events. 

This feature is extremely handy when working with drum tracks. For 

example, if you would like to select all snare drum notes in a track: 

1. Click the Audible Mode button. 

2. Click the pitch keys on the Pitch Ruler to locate the key a 

corresponds to the snare drum. 

3. Once you find the snare drum sound, double-click the key. 

All the snare drum notes will highlight in the track. You can then 

delete them, copy them, drag them up or down to a different note 

(sound), etc. 

Editing Notes The pitch, duration, and location of notes can be modified on the 

Note Grid in much the same way as objects in a graphics program. 

Note velocities can be edited in the Continuous Data Grid. 

Changing a Note’s Pitch To change a note’s pitch or location: 
or Location 

1. Click the note. 

2. Drag the note to a different position and release the mouse. 

When you begin dragging, an outline of the note will appear in 

place of the mouse pointer. Dragging the note vertically changes 

its pitch. Dragging the note horizontally changes its time location. 

Duration is not affected when dragging the entire note. When you 

release the mouse, the note will pop to the new location. 

To help position the note in time, hairlines appear in the Time Ruler 

that show the attack and release of the selected note. In addition, the 

Pitch Ruler key that corresponds to the note’s current pitch highlights 

as you move. 

If you hold down the shift key before you drag, the mouse will be 

constrained either vertically or horizontally, depending on which way 

you drag first. This allows you to change the note’s pitch without 

changing its time location, for example. 
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Changing a Note’s 
Duration 

Changing a Note’s Pitch 
Using a MIDI Controller 

Editing a Group of Notes 

The Graphic Editing Window 

To change the duration of a note: 

1. Click the note once to select it. 

2. Position the cursor near the right-hand tip of the note. 

3. Drag left or right to shorten or lengthen the note. 

To change the pitch of a note with your MIDI controller: 

1. Make sure that MIDI Edit is checked in the Graphic Editing Window 

mini-menu. 

If it is not checked, choose it. 

2. Click the note once to select it. 

A handle appears at the end of the note to indicate that it is 

selected. 

3. Press any note on your MIDI controller. 

The selected note will change to the pitch you play. This can also 

be done with more than one note selected. This is a quick way to 

convert a group of different notes to the same pitch. 

Editing a group of notes is similar to editing a single note. 

1. Select the notes that you wish to edit. 

To select them, drag out a selection box or shift-click each note. 
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Using Audible 
Mode 
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2. Click one of the notes and drag it to a new position. 

All of the notes will move together. When you begin dragging, an 

outline of the notes will appear in place of the mouse pointer. 

Dragging notes vertically changes their pitch. Dragging notes 

horizontally changes their time location. When you release the 

mouse, the notes will pop to their new locations. 

To help position the notes in time, hairlines appear in the Time Ruler 

to indicate the attack of the first selected note and the release of the 

last selected note. In addition, the Pitch Ruler key corresponding to 

the note you click highlights. If notes of more than one pitch are 

selected, the Pitch Ruler keys that correspond to the highest and 

lowest selected notes appear greyed. 

To convert a group of selected notes to the same pitch: 

1. Make sure that MIDI Edit is checked in the Graphic Editing Window 

mini-menu. 

If it is not checked, choose it. 

2. Select the notes. 

You can select a group of notes by shift-clicking each one or by 

dragging out a selection box. A square handle will appear at the 

end of each note to indicate that it is highlighted. 

3. Press any note on your MIDI controller. 

The selected notes will change to the pitch you play. 

In the Graphic Editing window, Audible Mode functions similarly to 

the Event List Window: if the speaker icon is highlighted and you 

click a note, the note will play back over MIDI. 

If you select a group of notes or other MIDI data and option-click the 

Audible Mode button, the selected data will play back as a phrase. 

For more information about Audible Mode, see the section called 

Audible Mode in the Event List Window chapter. 
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The Continuous 
Data Grid 

Basics 

The Graphic Editing Window 

The Continuous Data Grid is the region at the bottom of the Graphic 

Editing window below the Median Strip and above the horizontal 

scroll bar. It is flanked by the Continuous Data Ruler on the left and 

an empty margin on the right. 

The Continuous Data Grid displays MIDI controllers, pitch bend, 

mono and poly key pressure, and note-on/off velocities. The grid 

functions like a standard X and Ycoordinate graph, in which time lies 

on the horizontal axis and value along the vertical axis. The higher 

the value of a continuous data event is, the higher it will appear on 

the grid. The later the event occurs, the farther to the right it will 

appear on the grid. 

Location and value are measured with the Time Ruler and the 

Continuous Data Ruler respectively. Grid lines extend from the Time 

ruler to help in determining an event’s position. 

The Continuous Data Grid has no vertical scroll bar. Instead, the grid 

automatically compresses or expands to fit in the current space 

between the Median Strip and the bottom of the window. The grid 

can be stretched (or compressed) vertically by dragging the Median 

Strip up Cor down). To make more room for both the Continuous 

Data Grid and Note Grid, simply enlarge the entire window with the 

grow box. 
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A continuous data event is displayed on the grid as a small icon, such 

as a square or a circle. Pitch bend data, aftertouch, velocities, and 

controllers each have a unique icon. The icons are defined in the 

Continuous Data Icons window, which can be opened from the 

Graphic Editing window mini-menu. 

Eight different icons are available for the display of Controllers. 

Controllers can be assigned to icons in the Continuous Data Icons 

window. For more information, see the section later in this chapter 

called The Continuous Data Icons Window. 

Viewing Continuous The expression continuous data type refers to a kind of continuous 

Data Types One ata data. For example, pitch bend is one kind of continuous data. MIDI 

Time controllers between 0 and 63 are each considered a continuous data 

type. 

Continuous data types can be viewed simultaneously in the 

Continuous Data Grid. Sometimes, however, you may wish to see 

only one type (or several) at a time. Performer offers several ways to 

temporarily isolate continuous data types for viewing and editing. 

To view pitch bend data by itself, click on the Continuous Data Ruler. 

Doing so toggles the ruler among three displays, one which displays 

pitch bend data by itself. For more information about this feature, 

refer to the next section called 7he Continuous Data Ruler. 

To view a controller data type by itself, click an event of that type and 

click the Quick-Filter check box that appears in the Information Bar 

next to the event’s numerical data. Clicking the Quick-Filter box 

causes all other data types to temporarily disappear until you click it 

again. For more information, refer to the section later in this chapter 

called Editing Continuous Data. 

The Quick-Filter is useful for temporarily isolating continuous data 

types. However, data types can also be filtered with the View Filter in 

the Graphic Editing window mini-menu. Data types that are selected 

in the View Filter will be displayed; ones that are not selected will not 

be displayed. To view all data types, click the Set A// button in the 

View Filter. 
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The Continuous Data 
Ruler 

Controller scale 

The Graphic Editing Window 

Like the Quick-Filter, the View Filter affects selecting and editing. For 

example, if note velocity data has been filtered from the display, it 

cannot be selected for editing. All visible data types can be selected 

for editing. 

For information about editing continuous data, see the section later in 

this chapter called Editing Continuous Data. 

All continuous MIDI data has a value range from 0 to 127 except pitch 

bend, which has a value range from -8192 to 8191. Because of these 

two separate scales, the Continuous Data Ruler provides three 

different scales: 

1. a controller scale from 0 to 127, whose origin rests at the 

bottom of the window: 

2. a pitch bend scale from -8192 to 8191, whose origin 

appears in the middle of the window: 

3. a combination scale from -80 to 127, which combines the 

above two scales and whose origin appears just below the 

middle of the window. 

Pitch bend scale Combination scale 

To switch from one scale to another, click in the ruler. Doing so 

toggles from the currenQt scale to the next. Each scale displays data 

appropriate to that scale. The controller scale (O to 127) displays 

controller data only. The pitch bend scale (-8192 to 8191) displays 
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pitch bend only. The combination scale (-80 to 127) displays 

controller data and pitch bend together. Note velocities, if selected in 

the View Filter, appear in the controller and combination scales. The 

pitch bend scale displays pitch bend even if it is deselected in the 

View Filter. 

All three scales provide numbered marks in the ruler and an origin 

line extending to the right that indicates where zero is on the ruler. 

Controlling the Length The entire Continuous Data Ruler is always visible. If you resize the 

of the Continuous Data grid using the Median Strip or the Graphic Editing window’s grow 
Ruler box, the Continuous Data Ruler will compress or expand to fit in the 

available space. The data within the grid will also compress or 

expand to conform to the ruler. 
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If you wish to enlarge the view of the Continuous Data Grid, resize 

the Graphic Editing window and drag up the Median Strip. If you 

move the Median Strip a// the way up, the Continuous Data Grid will 

occupy the entire window. 

Zooming the The Continuous Data Grid can be zoomed along the time (horizontal) 

Continuous Data Grid axis. Time zooming has the visual effect of expanding or compressing 

a continuous data curve in the window. If you zoom in, the curve 

spreads out: 
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Editing Continuous Data 

The Graphic Editing Window 

If you zoom out, the same curve compresses: 

; -. 
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The data that comprises the curve does not change between these 

two views: only its appearance changes. Time zooming allows up to 

eight different settings. For more information about zooming the 

Time Ruler, refer to the section earlier in this chapter called Zooming. 

The Continuous Data Grid displays more than one type of continuous 

data at a time. For example, the grid can display pitch bend, 

controller #7, and mono key pressure all at once. Each type is 

distinguished by the shape of its icon. 

Because data types are displayed simultaneously, they can be 

selected and edited together. Sometimes, however, you may wish to 

edit only one type (or several) at a time. Performer provides two 

ways to isolate continuous data types for viewing and editing. For 

example, if the Continuous Data Grid currently displays the three 

types of data mentioned above, you can filter out pitch bend and key 

pressure to view controller #7 data by itself. 

The most convenient way to filter data is with the Quick-Filter check 

box. To view controller number #7’s only, click any controller #7 

event to select it and click the Quick-Filter check box next to the 

event’s numerical data in the Information Bar. All other data types 

will temporarily disappear, and you can then easily select controller 

#7’s without inadvertently selecting other data types. To make other 

data types reappear, click the Quick-Filter check box again. 

The regular View Filter, found in the mini-menu, also filters data 

types. In the View Filter dialog box, select the continuous data type(s) 

you wish to see and deselect all others. Only visible data can be 

selected for editing. 
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When a continuous data event is selected, a line extends from the 

icon to the origin line on the continuous data grid. Once events are 

selected, they can be edited. 

The diagram below shows three deselected controller events on the 

left. To the right the events are selected: a line extends to the origin 

line; selected events can be edited. 

Deselected Selected 

Events selected in this fashion can be edited with the following 

commands in the Edit menu: Cut, Copy, Paste, Erase, Merge, Splice, 

and Shift. To Snip or Repeat, you must select a region by dragging in 

the Time Ruler. 

Quick-Filtering Data To view certain continuous data types and quickly filter the rest: 
Types 

1. Select an event of each data type that you want to see. 

Quick Filter 

check box 

Click the event, or drag a selection box over it. To select more 

than one data type, shift-click an event of each type. 

2. Click the Quick-Filter check box that appears next to the numerical 

data in the Information Bar. 

All data types will disappear except those that you selected. To 

make all data types reappear, click the Quick-Filter check box 

again. You can toggle freely between filtered and unfiltered mode. 
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Selecting a Single To select an event: 
Continuous Data Event 

1. Click the event. 

The event will become selected. The selected event displays a 

vertical line extending from its icon to the origin line. 

Selecting a Group of To select a group of continuous data events: 

Continuous Data Events 
1. Drag a selection box over the events and release the mouse. 

When you release, any events inside the dotted selection box will 

be selected. All other highlighted events will deselect. If other 

events are selected before you drag and you want them to remain 

selected, hold down the shift key before you drag out the 

selection box. 

Drag out a selection box... ...and release. 
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To select a// events of a single data type: 

1. Double-click an event of that type. 

All events of that type will become selected. All events of other 

types will deselect. If events of other types are selected 

beforehand and you want them to remain selected, shift-double- 

click and the other events will remain selected. 

To deselect a// events of a single data type: 

1. Shift-double-click a selected event of that type. 

All events of that type will deselect. 
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Inserting a Single 
Continuous Data Event 

Editing a Single 
Continuous Data Event 

Editing the Value of an 
Event Using a MIDI 
Controller 
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To 

1. 

To 

To 

insert an event on the Continuous Data Grid: 

Press the Insert button in the title bar of the Graphic Editing 

window, 

. Choose the type of event you wish to insert from the menu. 

The mouse pointer will turn into a cross hair. For some types of 

data, an additional box may appear requesting further 

information. 

Click the cross hair once at the desired time location and value. 

The event will appear where you click, and the mouse will switch 

back to an arrow. If you wish to insert multiple events, press the 

shift key before you click and the cursor will remain a cross hair. 

change the value or location of a single continuous data event: 

. Click the event and drag it to a different position or value. 

Drag vertically to change its value. Drag horizontally to change its 

location. Press the shift key after you click to constrain the mouse 

vertically or horizontally. For exact positioning, refer to the Pointer 

Coordinates Box and the rulers. 

change the value of an event with your MIDI controller: 

. Make sure that MIDI Edit is checked in the Graphic Editing Window 

mini-menu. 

If it is not checked, choose it. 

. Click the event to select it. 

Transmit a corresponding event from your MIDI controller. 

For example, if you have selected pitch bend event, move the 

pitch bend wheel on your controller and the event will change to 

the new value you set with the wheel. 

When you have entered the value you wish, press the Return key or 

the mouse to confirm the new value. 
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Working With 
Continuous Data Curves 

Selecting a Continuous 
Data Curve 

Inserting a Continuous 
Data Curve 

The Graphic Editing Window 

A continuous data curve is a group of many individual events. Events 

that form a curve can be edited together in much the same way as a 

single event. The only difference is that more than one event is 

selected. 

To select a continuous data curve: 

1. Filter other data types, if necessary. 

Click an event in the curve you wish to select and click the Quick- 

Filter check box in the Information Bar. Filtering is only necessary 

if the region that the curve occupies contains other data types that 

you do not want to select. 

2. Drag a selection box over the curve and release the mouse. 

The portion of the curve inside the selection box will become 

selected. All other events will deselect. If you want other events to 

remain selected, press the shift key while you drag out the 

selection box. 

To select all events of a continuous data type: 

1. Double-click an event of the desired type. 

To deselect all, shift-double-click a selected event. 

Shift-double-clicking selects or deselects all without affecting the 

status of other types. 

To insert a curve of continuous data: 

1. Press the Insert button in the title bar of the Graphic Editing 

window. 

2. Choose the type of event you wish to insert from the menu. 

The mouse pointer will turn into a cross hair. For some types of 

data, an additional box may appear requesting further 

information. 
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Reshaping a Continuous 
Data Curve 

324 

3. 

To 

Me 

Click on the grid where you want the curve to begin and drag the 

desired shape of the curve over the region. 

Events will appear at regular intervals as you drag the mouse. The 

events will be spaced according to the current edit resolution. The 

value of events is determined by the vertical position of the 

mouse. If you wish to insert multiple curves, press the shift key 

before you drag; the cross hair will remain, indicating that you are 

still in Insert mode. 

OR 

Option-drag from the start point to the end point of the curve. 

A straight line will appear with handles on either end and a handle 

at its midpoint. This line represents a curve to which continuous 

data events will be fitted. You can adjust the location and shape 

of the line by dragging its handles. The end-point handles can be 

dragged both vertically and horizontally to position the start and 

end point of the curve. The middle handle sets the curvature. 

Once you have adjusted the line as you wish, click anywhere else 

on the screen or press the Return key. 

The line will disappear and events creating a curve with the same 

shape as the line will appear. 

reshape a continuous data curve: 

Select the curve you wish to reshape. 

You can either double-click an event of that type to select all or 

drag out a selection box over a portion of the curve. If the curve 

intermingles with other visible data types, use the Quick-Filter 

before selecting to avoid inadvertently selecting events of other 

types. 

. Click the Reshape button in the title bar of the Graphic Editing 

window or choose Reshape from the Graphic Editing window mini- 

menu. 

In both cases, the mouse pointer will turn into a cross hair. 
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3. Drag above or below the selected events to change their values to 

the position of the mouse. 

Each event will snap to the position of the mouse as the mouse 

passes over it. The location of events will not change. If you like, 

you can deselect the Quick-Filter before dragging to view other 

data types while dragging. If you wish to remain in Reshape 

mode, press the shift key before you drag; the cross hair will 

remain when you finish dragging, indicating that you are still in 

Reshape mode. 

OR 

4. Option-drag along the selected region of the curve. 

A straight line will appear with handles on either end and a handle 

at its midpoint. This line represents a curve to which continuous 

data events will be fitted. You can adjust the location and shape 

of the line by dragging its handles. The end-point handles can be 

dragged both vertically and horizontally to position the start and 

end point of the curve. The middle handle can be dragged to set 

the curvature. 
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Offsetting or Scaling a 
Continuous Data Curve 

326 

5. Once you have adjusted the line as you wish, click anywhere else 

on the screen or press the Return key. 

The line will disappear and selected events above or below the 

line will adjust their values to match the shape of the line. 

You can offset a continuous data curve by dragging it in any direction. 

Offsetting modifies events in the curve by a constant amount: 

dragging up or down changes events’ values; dragging left or right 

changes their location. For example, dragging a curve up by a value 

of 30 will add that amount to all events in the curve. 

You can scale a continuous data curve by command-dragging it in 

any direction. Scaling modifies events in the curve proportionally: 

dragging up or down scales values proportionally; dragging left or 

right scales time. For example, when a bell-shaped curve is scaled up, 

the start and end points of the curve remain at zero, and the slopes 

become steeper as the top of the curve rises. Scaling is a useful way 

to exaggerate or diminish a curve’s musical effect without changing 

its fundamental nature. For example, you can scale an existing 

crescendo so that it swells in the same manner but ends at a softer 

volume. 

To offset or scale a continuous data curve: 

1. Select the curve you wish to modify. 

You can either double-click an event of that type to select all or 

drag a selection box over a portion of the curve. 
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Cancelling Lengthy 
Editing Operations 

Summary of Continuous 
Data Editing Features 

Selecting 

Deselecting 

The Graphic Editing Window 

2. Click (to offset) or command-click (to scale) a selected event and 

drag in the direction you wish. 

Press the shift key before dragging if you wish to constrain motion 

horizontally or vertically. As usual, horizontal position Cocation) is 

constrained by the current edit resolution. 

A wristwatch icon may appear when Performer executes a 

continuous data edit operation. To cancel an operation in progress, 

press command-period (command-.). The operation will abort. Data 

modification that occurred before cancelling will not be undone 

unless you choose Undo from the Edit menu. 

This section summarizes features available when working with the 

Continuous Data Grid. 

Select a single event by clicking it. 

Select several events by dragging a selection box over them. 

Select all events of a single data type by double-clicking an event of 

that type. 

Select all events of several types by shift-double-clicking an event of 

each type. 

Select all continuous data by choosing Select All from the Edit menu 

or pressing command-A. All other MIDI events in the track will 

become selected as well, including notes and data in the Median 

Strip. 

Deselect a single event by shift-clicking it. 

Deselect all events of a single data type by shift-double-clicking a 

selected event. 

Deselect all continuous data by clicking in an empty area on the 

Continuous Data Grid. 
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Quick-Filtering 

Offsetting 

Scaling 

Constraining 

Inserting and Reshaping 

The Continuous Data 
lcons Window 
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Quickly isolate a data type by clicking an event of that type and then 

clicking the Quick-Filter check box in the Information Bar. Isolate 

more than one type by shift-clicking an event of each type before 

clicking the Quick-Filter check box. To unfilter, deselect the Quick- 

Filter check box. 

Offset the location or value of selected events by dragging 

horizontally or vertically. 

Offset the location of a copy of all selected events by pressing the 

option key and dragging horizontally. 

Scale the time or value of selected events by pressing the command 

key and dragging horizontally or vertically. 

Constrain the movement of the mouse vertically or horizontally while 

scaling or offsetting by pressing the shift key after clicking and before 

dragging. 

Click the Insert and Reshape buttons (or choose Insert or Reshape 

from the mini-menu) to change the mouse cursor to a cross hair. 

Insert events or Reshape existing selected events in any shape you 

wish by dragging the cross hair. 

Insert or Reshape events against an adjustable curve outline by 

pressing the option key before dragging the cross hair. A straight line 

with moveable handles will appear to which events will be fitted 

when you click elsewhere on the grid. 

Remain in Insert or Reshape mode by pressing the shift key before 

dragging the cross hair. 

The Continuous Data Icons window serves as a legend for the icons 

you see in the Continuous Data Grid. In addition, it allows you to 

assign controller data types to eight unique icons to help differentiate 

between them on the grid. 

To open the Continuous Data Icons window, choose Cont. Data 

Icons from the Graphic Editing window mini-menu. The window 

remains until you click its close box and serves as a handy reference 

when working with continuous data. 
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Assigning Icons to 
Controllers 

The Median Strip 

The Continuous Data Icons window offers eight different icons to 

represent controllers. Because more than eight types of controllers 

exist, the most commonly used controllers have been assigned to 

icons by default. However, you can change which controller an icon 

represents. For example, a square can represent controller #7 or 

controller #38. All controllers that have not been assigned to one of 

the first seven icons are automatically assigned to the last “u”-shaped 

icon. The icons for pitch bend, velocity, and key pressure cannot be 

changed and are displayed for reference. 

To assign a controller to an icon: 

1. Open the Continuous Data Icons window. 

Select Cont. Data Icons from the Graphic Editing window mini- 

menu. 

2. Click in the box to the right of the icon of your choice. 

The box will highlight. 

3. Type in the controller number that you wish to assign to that icon. 

The number you type must be between 0 and 63. Controllers 64 

through 127 are switch controllers and will appear in the Median 

Strip. 

4. Press the Return key or click anywhere to confirm your choice. 

The Continuous Data Grid will reflect any changes you have 

made. 

The Median Strip separates the Note Grid from the Continuous Data 

Grid. It contains only the following discrete MIDI events: patch 

changes, mode changes, switch controllers like #64 (sustain pedal), 

tune requests, song changes, and system exclusive events. Notes and 

continuous data do not appear in the Median Strip. 
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Moving the Median Strip 

Working with Discrete 
MIDI Events in The 
Median Strip 

Inserting an Event in the 
Median Strip 

330 

The Median Strip serves as the border between the Note Grid and the 

Continuous Data Grid. It can be dragged up and down by grabbing 

the handles at either end. Moving the Median Strip resizes the Note 

Grid and the Continuous Data Grid proportionally. For example, if 

you drag the Median Strip down as far as it will go, you will see only 

the Note Grid. If you drag the Median Strip all the way up, you will 

see only the Continuous Data Grid. 

The Median Strip is a convenient way to quickly adjust the size of one 

grid or the other to suit your immediate needs. 

Events in the Median Strip do not have durations. Each event is 

therefore displayed as a single item inside a small box. Patch 

changes, system exclusive events, and controllers are displayed with 

their event list icon; mode changes are displayed as text, such as 

“Poly” or “Omni on”. An event may be pop-edited in the Information 

bar in the same fashion as in the event list window. Location is 

determined by the Main Time Ruler. To indicate time location, the 

vertical grid lines from the Main Ruler extend through the Median 

Strip. 

Discrete MIDI events that are not continuous data, such as patch 

changes, mode changes, switch controllers like #64 (sustain pedal), 

and system exclusive events, appear in the Median Strip. To insert 

such an event: 

1. Press the Insert button in the title bar of the Graphic Editing 

window. 

2. Choose the type of event you wish to insert from the menu. 

The mouse pointer will turn into a cross hair. For system exclusive 

events, an additional box will appear requesting further 

information. 

3. Click once at the desired time location in the Median Strip. 

The event will appear where you clicked. 
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Editing an Event in the 
Median Strip 

The Graphic Editing Window 

Events in the Median Strip can be pop-edited in the Information bar. 

For example, to select such an event, click it and the event will 

highlight. Click the event in the Information bar and a pop-up box 

will appear that you can type in. When system exclusive events are 

pop-edited in this manner, a dialog box will appear. 

Dragging an event in the Median Strip left or right will change its 

location. 

If two or more events occur at the same time, they will overlap in the 

Median Strip. Overlapping events are displayed as shown in the 

example below: 

In this example, the Omni on message occurs near two other events. 

The other events are indicated by boxes preceding the Omni on box. 

To see the other events, click their box. To select the second event 

displayed in the example above, click the second rectangle. The 

event will pop to the front and become highlighted: 

If two or more events occur at the exact same location, a list icon 

appears. If you press on it and drag downwards, a small pull-down 

menu shows all events at that location. Events in the pull-down menu 

can be selected and then edited. For example, if you select the third 

item in the menu, the list icon becomes highlighted. If you then drag 

the list icon left or right, you will only drag the third item that you had 

selected. To select more than one item in the menu, shift click to 

select each item. 
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Graphic Editing 
in the Conductor 
Track 

The Conductor Track 
Median Strip 

Inserting a Meter/Key 
Change or Marker 

332 

The Conductor Track Graphic Editing window is similar to a regular 

track but has several differences. It does not have a Note Grid 

because the Conductor Track cannot contain notes. In addition, the 

Median Strip is wider and fixed at the top of the window just below 

the Time Ruler. Finally, the Conductor Track has a Tempo Change 

Grid similar to the Continuous Data Grid that displays tempo changes 

only. 

Meter changes, key changes, and markers are displayed in the 

Median Strip. 

The Median Strip in the Conductor Track functions much like the 

Median Strip in a regular track. Each meter change, key change, and 

marker is displayed as a single item. The Conductor Track Median 

Strip is wide enough to accommodate all three kinds of events 

without overlapping them. 

Editing in the Conductor Track Median Strip works the same as 

editing MIDI data in a regular track’s median strip: click an item to 

make it appear in the Information bar and click in the Information bar 

to pop-edit its value(s); drag the item left or right to change its 

location. 

Note that only wnlocked markers can be edited in the Conductor 

Track window; to unlock a marker, do so in the Markers window. 

To insert a meter change, key change, or marker: 

1. Press the Insert button in the Conductor Track title bar, 

2. Choose the item you wish to enter. 

The pointer will turn into a cross hair. 

3. Click in the median strip at the location you desire. 

The event will appear at the location. 
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Editing the Location of a 
Meter Change, Key 
Change, or Marker 

The Tempo Change Grid 

Zooming the Tempo 
Ruler 

The Graphic Editing Window 

To change the location of an item in the median strip: 

1. Click the item you wish to move and drag left to advance it or drag 

right to delay it. 

The event will move to the new location when you release the 

mouse. 

Tempo changes are displayed and edited on the Tempo Change grid 

in the same fashion as continuous data. Each tempo change event is 

displayed on the grid as a small icon. When the tempo change event 

is selected, a line extends from its icon to the origin at the bottom of 

the grid. A tempo change ruler on the left measures events on the 

grid. Tempo changes can be selected and edited in the same way as 

an active continuous data type. For more information, see Editing 

Continuous Data earlier in this chapter. 

The Tempo ruler in the Conductor track can be zoomed in for more 

precise tempo editing. Clicking the Tempo ruler toggles quickly 

between your custom zoom scale and the normal scale. 

To zoom the Tempo ruler: 

1. Highlight the range of values you wish to zoom to by dragging in 

the Tempo ruler. 

The Tempo ruler will zoom in on the range that you select. 
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2. Click the Tempo ruler to toggle between your custom zoom scale 

and the normal scale. 

At the zoomed in scale, dragging tempos up or down can be done 

to a higher degree of resolution. 

@ The resolution at which you can insert and edit tempo 

events is one screen pixel (72 dots per inch). 

Therefore, you have a higher degree of resolution 

when you zoom in. 
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Chapter 22 The Notation Editing Window 

Quick Reference 

Time zoom 

buttons 

Octave Up/ 
Down buttons 

Octave Indicator 

Staff margin 

Continuous 

Performer offers four windows in which to edit data in a track: the 

Event List, Graphic Editing, Notation Editing, and QuickScribe 

notation. To open the Notation Editing window, hold down the 

command and option keys and double-click the track name. Or 

choose Notation Editing from the Event List or Graphic Editing 

window mini-menus. You can also option-click the Notation button 

in the main control panel. 

The Notation Editing window provides a scrolling window of a single 

track, very similar to the Graphic Editing window. This chapter covers 

features unique to the Notation Editing window. To display several 

tracks, use QuickScribe notation as described in chapter 23, 

“QuickScribe Notation” (page 345). 

Grand staff Selected Note Display resolution 
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Display Resolution: Determines the shortest duration that will be used 

to display note data on the Grand Staff. Actual attack and release 

times are not affected by Display Resolution. 

Selected Note: Click once to select the note. While the note is selected, 

its information will appear in the Information Box above. Shift-click 

or drag a selection box to select more than one. Drag the note up or 

down to change pitch; drag left or right to change time location. 

Grand Staff: Displays notes on standard treble and bass clef staves. By 

default, middle C between the staves is C3. Click the Octave Up/ 

Down buttons to change middle C to a different octave to place notes 

in higher or lower octaves on the staff. 

Time Zoom Buttons: Contract or expand the Time Ruler, Grand Staff, 

and Continuous Data Grid to display more or less measures at a time. 

The left button zooms out (more measures), and the right button 

zooms in closer ess measures). 

Octave Up/Down Buttons: Transpose the display of notes on the Grand 

Staff by octaves. When untransposed, middle C on the Grand Staff is 

C3. For example, in a bass track, low notes are displayed many ledger 

lines below the staff. To distinguish the pitches, click the Octave 

Down button; middle C will become C2 and the bass notes will be 

displayed an octave higher on the grand staff. The octave indicator in 

the Staff Margin indicates the degree of transposition. 

Octave Indicator: Indicates the octave being displayed on the Grand 

Staff. 

Staff Margin: A non-scrolling region of the Grand Staff that displays 

clefs, key signature, and meter. 

Continuous Data Grid: Displays continuous data in the same manner as 

the Graphic Editing window. 

Notation Editing Set View Filter: Calls up a dialog box in which you specify types of 
Window Mini-menu events to be visible in the Notation Editing window. The View Filter 

applies to all tracks and affects the Graphic Editing, Notation Editing, 

and Event List windows. 
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The Notation Editing Window 

Goto Counter: Automatically scrolls the graphic display to the time 

currently displayed in the Counter. The counter location will appear 

at the left-most position in the window. 

Goto: Automatically scrolls the graphic display to a time you specify, 

which will appear at the left-most position in the window. 

Relnsert: Inserts an event of the same type that you last inserted. This 

is the same as the Insert command but you are not prompted for the 

type of event. This command can also be invoked by option-clicking 

the Insert (1) button in the Notation Editing window title bar. 

Reshape: Changes the mouse pointer to a cross hair that reshapes 

selected continuous data curves when you drag over them in the 

Continuous Data Grid. This command can also be invoked by 

clicking the Reshape button in the title bar. 

Legend: Produces a window that shows the icon representing each 

type of MIDI event. 

Set Rulers: Allows you to configure the Time Ruler in any combination 

of Performer’s three time formats: measures | beats | ticks, SMPTE time, 

and real time. The main ruler is displayed lowest and determines the 

time format for editing. 

Cont. Data Icons: Opens the Continuous Data Icons window, which 

displays icons for each type of continuous data. This window also 

allows you to reassign controller icons. 

Set Ptr. Coords...(Set Pointer Coordinates): Allows you to choose what 

time and pitch formats will be displayed in the Pointer Coordinates 

Box. 

MIDI Edit: Allows data in the graphic editing window to be edited 

from a MIDI controller. 

Switches are Cont. Data: Causes all controllers, including switch 

controllers #64 and above, to be displayed and edited as continuous 

controllers. This is useful for MIDI devices, such as MIDI-controlled 

lighting consoles, that use all MIDI controllers as continuous 

controllers. 
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Selections use Edit Resolution: Causes the cursor to snap to the edit 

resolution when dragging to make selections in the note grid, time 

ruler, and continuous data grid. 

Event List: Opens the track’s Event List window. 

Graphic Editing: Opens the track’s Graphic Editing window. 

QuickScribe Notation: Opens the QuickScribe Notation window. 

Measures|Real timelFrames: These checkable entries control which time 

formats are displayed in the Information Bar and Event List. 

Basics The Notation Window is similar to the Graphic Editing window. It has 

a Time Ruler, a Markers Strip, a Median Strip, and a Continuous Data 

Grid, features that are identical to those found in the Graphic Editing 

window. Instead of a pitch ruler and note grid, however, the Notation 

Editing window displays notes on a grand staff in standard music 

notation. Octave Up/Down buttons are provided to center any octave 

on the grand staff, and a non-scrolling staff margin on the left displays 

clefs, key signature, and meter. 

For further information about the Time Ruler, Markers Strip, Median 

Strip, and Continuous Data grid, refer to chapter 21, “The Graphic 

Editing Window” (page 281) in the Reference Manual. 

Features that are unique to the Notation Editing window are 

discussed below. 

Display Resolution Internally, Performer accurately records the attack and release times 

of notes at a resolution of 480 ticks per quarter note. For example, a 

quarter note that you attempted to play on beat two of measure three, 

3,|2|000, may have actually occurred a split second after the beat at 

3,|2|073, which is 73 ticks after the downbeat: 

[s2l07s GF i64 ted 11000 

Even though the note is a little late, it may sound like it is right on the 

beat because of the sound used, the nature of the music, etc. 
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Octave Up/Down 
Buttons 

The Notation Editing Window 

Instead, Performer internally sets up an evenly spaced grid of note 

durations, finds the nearest grid location, and displays the note as if 

it began at the grid location. For example, at a quarter-note grid 

resolution, the above note at 3121073 is displayed on the nearest 

downbeat at 3121000 (as a much more recognizable quarter note!) 

= 
Even though the note actually occurs after the downbeat, it gets 

displayed on the downbeat, which is the nearest grid location. 

The Display Resolution box allows you to choose at which grid 

resolution notes will be displayed. If the note above is displayed with 

a sixteenth note display resolution, which sets up a grid every 120 

ticks, the note will be notated as a sixteenth rest followed by a dotted 

eighth note because its attack is closer to 3121120 than it is to 

3121000: 

Se 
As you can see, the Display Resolution box determines the shortest 

duration that will be used to display notes and rests in the track. In 

general, a shorter duration produces a more accurate (but maybe not 

as conventional) notational display of the notes in the track. 

Display Resolution does not affect the actual location or playback of 

the notes. Don’t worry about affecting the notes in the track when 

using the Display Resolution: it only affects their display. If you 

would like to make the note data more rhythmically accurate, use the 

Quantize or Smart Quantize commands. 

The Octave Up and Octave Down buttons change the octave of 

middle C, the pitch directly between the treble and bass staves. By 

default, middle C is MIDI note number 60, or C3. If the notes in the 

track fall well below middle C, they will be displayed on ledger lines 

below the grand staff. To raise the display of the notes and make 

them more legible, click the Octave Down button: 
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The result is that the entire Grand Staff display is transposed, as 

indicated above the treble clef, and the notes are displayed within the 

staff. Only the display gets transposed; the actual notes maintain their 

original pitches. 
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Basics 

Inserting Notes 

The Notation Editing Window 

The following sections describe basic procedures in the Notation 

Editing window. 

To insert a note on the grand staff: 

1. Choose a Display Resolution. 

To do so, click the Display Resolution note and choose the desired 

duration. The Display resolution affects the resolution at which 

you can insert the note. 

2. Click the Insert button in the title bar or choose Insert from the 

mini-menu. 

In both cases, the Insert menu will appear. 

3. Choose Note from the menu. 

The menu will disappear and the mouse pointer will turn into a 

cross hair. 

4. (Optional) Press the Shift key. 

This is only necessary if you wish to insert more than one note. 

5. Click at the desired pitch and location on the Grand Staff, drag to 

the right to draw the desired duration, and release the mouse. 

The note’s attack will begin at the nearest grid location. The 

duration is shown as a grey bar extending to the right. As you drag 

to the right, the duration of the note increases in increments of the 
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Inserting a Chord Using 
a MIDI Controller 

Selecting Notes for 
Editing 

342 

display resolution. For example, to enter a half-note with 16th 

note resolution, drag eight increments to the right as shown 

below. 

To insert a note, drag to the right... ..and a note will be inserted. 

If you press the shift key to insert multiple notes, simply click on the 

desired pitch to insert another note of the same duration. To insert a 

note with a different duration, click and drag a new duration. You 

will remain in insert mode as long as you hold down the Shift key. 

To insert a chord: 

1. Choose “Note” from the Insert button pop-up menu in the title bar. 

The Cursor will turn into a cross-hair. 

2. If you would like to insert more than one chord, either hold down 
the shift key, or push down the caps lock key. 

This will keep Performer in insertion mode after you insert the 

chord. 

3. Play the chord you wish to insert on your MIDI controller and, while 

holding the chord, click where you want the chord to begin and 

drag from left to right to the appropriate duration. 

The vertical position of your click is not important; the notes are 

determined by what you play on your controller. Only the attack 

and release of the chord is affect by the cross-hair. 

As long as you remain in insertion mode, you can enter chords in this 

fashion for as long as you like. You can even alternate between 

entering notes with the mouse only or the mouse with a MIDI 

controller. 

Selecting notes on the Grand Staff works the same way as selecting 

notes in the Graphic Editing window. To select a single note for 

editing, just click the note. The notehead will invert to indicate that 
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the note is selected. To select several notes, shift-click each one. Or, 

drag a selection box over them. Shift-click to select non-contiguous 

notes. To select all notes in the track, double-click any note. 

Dragging Notes To change the location or the pitch of a note, simply drag the note to 

the desired pitch or location. This can also be done with more than 

one note selected. As usual, option-dragging will produce a copy of 

the originally selected notes, which can be used to quickly generate 

repeated phrases or chords. 

To copy notes, option-drag... ..and a copy of the notes will result. 

If a note is displayed as several tied notes, you must click the first of 

the tied notes. 

Editing Durations To change the duration of a note: 

1. Command-click the note. 

If the note consists of several tied notes, you must click the first of 

the tied notes. A grey bar will appear to indicate the current 

duration of the note with respect to the Time Ruler. 

——— 

To change a duration, command-click the note... 

..and drag the handle of the grey bar left or right. 
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2. Drag the handle of the grey bar to the left to shorten the note or to 

the right to lengthen it. 

The grey bar will show you the change in duration. 

a. 5 

To change the duration of more than one note, select them first and 

command-drag any one of them. 

When changing a duration in the Notation Editing window, the new 

duration maintains any differences between its actual length and its 

displayed length. For example, if a quarter note ends 17 ticks after 

beat 2, and you lengthen it by one beat to beat 3, the release will still 

be 17 ticks after beat 3. 

Scrolling During The Auto-Scroll command in the Basics menu can make the Notation 

Playback Editing window scroll during playback. In addition, the window will 

automatically open to the current playback location of the sequence. 

Please refer to the Auto-Scrolling section in the Playback chapter for 

more information. 

Zooming Shortcuts Here are some zooming shortcuts: 

Do this: To zoom as follows: 

Command-drag in the Time Ruler _ To fill the window with the region 

you select 

Option-click the zoom out button To zoom all the way out 

Option-click the zoom in button To zoom all the way in 
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Chapter 23 QuickScribe Notation 

QuickScribe 
window basics 

This chapter explains how to use Performer’s QuickScribe™ notation 

window. The notation window allows you to view and edit any 

number of tracks as standard music notation. 7 

Performer interprets unquantized MIDI data, notating it in a readable 

fashion without permanently quantizing the data, so your original 

performance is always preserved. Music is displayed and edited on a 

page on the screen exactly as it will print on your 

Macintosh-compatible printer. 

Notes can be inserted with the mouse, Macintosh keyboard, or via 

MIDI step entry. You can also transpose and edit using all of 

Performer’s powerful commands in the Edit and Region menus. 

The QuickScribe window provides intuitive text entry for preparing 

title pages, headers, footers, and page numbers. It lets you adjust 

system margins, staff spacing, measure spacing, and other aspects of 

formatting. 

Performer provides one QuickScribe notation window per sequence 

(and you can have an unlimited number of sequences in a Performer 

file). The QuickScribe window can display any combination of tracks 

in the sequence, and you can easily change what is displayed. Page 

formatting is preserved, even if you decide to change what is 

displayed in the window. The QuickScribe window is ideal for 

quickly printing scores and parts. Best of all, you can choose to 

display any region, from a single measure to the entire sequence. In 

either case, Performer quickly formats the music. 

Unlike the Notation Editing window, the QuickScribe notation 

window uses engraver spacing so that the notation looks more 

natural for printing. The contents of the QuickScribe notation 

window can be printed at any time. This chapter explains all about 

preparing the appearance of the score. For information about printing 

it, see chapter 43, “Printing” (page 6065) in the Reference Manual. 
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Status strip: displays current cursor coordinates and 
information about the currently selected note. 

Below is a brief overview of the QuickScribe window. 
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Notes being selected 

QuickScribe Notation 

Page number box: click in this box and type in 

a number to go the desired page 
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Choosing what tracks to The QuickScribe notation window can display any region of time in 

display any combination of tracks. To choose what to display in the 

QuickScribe notation window: 

:s 

QuickScribe Notation 

Select one or more tracks in the Tracks window, and set the time 

region in the Tracks window Edit bar (to the nearest measure). 

Actually, you can use any of the many selection methods that are 

available in Performer, which are fully explained in chapter 25, 

“Selecting Regions” (page 387) in the Reference Manual. For your 

convenience, several common selection methods are suggested 

on the following page. If nothing is currently selected, Performer 

displays the entire contents of the sequence (i.e., the currently 

play-enabled sequence in the Chunks window). 

Click the QuickScribe notation window button in the Consolidated 

Control panel or choose QuickScribe from the Windows menu. 

Alternately, you can choose the QuickScribe Notation mini-menu 

command from any edit window. 

QuickScribe notation window button 

The Notation window appears. 

To make adjustments to the formatting, use the Score Options, 

Tracks options, and other mini-menu commands. 

In particular, you may want to change the way the music is 

spaced, which has a large impact on the efficiency of editing, as 

well as how good the music looks. For details, see “Measure 

spacing” on page 356. 

To add a title, use the Text tool in the palette. 

For more information, see “Working with text” on page 367. 
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The selection methods below are interchangeable, and not every 

method is covered here. For more information, see chapter 25, 

“Selecting Regions” (page 387) in the Reference Manual. 

To display this: 

A few notes or mea- 

sures in a track 

Several measures in a 

single track 

One or more measures 

in several tracks 

An entire track 

All tracks for the entire 

sequence 

Select this: 

Drag over them in the Event List, Graphic 

Editing or Notation Editing window. 

Drag over the measures in the Tracks over- 

view. Or, click the track name to highlight it 

and type in the start and end time of the 

region in the Edit bar. 

Drag over the region in the Tracks overview. 

Be sure to highlight a track segment region 

only for the tracks you want to include. Or 

you can highlight the track names and set the 

region with the Edit bar start and end times. 

When you select more than one track using 

either method, the resulting staves are placed 

together in the same staff system. 

Double-click the word “Edit” in the Tracks 

window Edit Bar to select the entire length of 

the sequence and then click the track name to 

highlight it. Or, open an event editing window 

for the track and choose Select All from the 

Edit menu. 

Double-click the word “Edit” in the Tracks 

window Edit Bar to select the entire sequence 

and choose Select All from the Edit menu to 

highlight all the track names. Or, as a shortcut, 

don’t select anything. 

@ The Remember Times command in the Basics menu is 

a time-saving tool for selecting with the Edit bar. See 

“Remember Times” on page 275 of the Reference 

Manual. 
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Changing what is 
displayed 

You don’t need to 
quantize tracks to get 
good-looking notation 

QuickScribe Notation 

To change what tracks are displayed in the QuickScribe notation 

window, or to change the region of time: 

1. Close the QuickScribe window. 

Click its close button at the far left of the title bar. 

2. Select the tracks and time region you wish to display. 

3. Click the QuickScribe notation window button in the Consolidated 

Control panel or choose QuickScribe from the Windows menu. 

Performer does an admirable job of notating music, even though the 

music may not be quantized. Performer accurately records the attack 

and release times of notes at a resolution of 480 ticks per quarter 

note. For example, a note that you attempted to play on beat two of 

measure three, 3121000, may have actually occurred a split second 

after the beat at 3!21073, which is 73 ticks after the downbeat: 

Even though the note is a little late, it may sound like it is right on the 

beat because of the sound used, the tempo, and so on. 

If Performer tried to take into account the 73 ticks when displaying 

the note in standard music notation, the result would be many 64th 

and 128th rests followed by lots of tied 64th and 128th notes— 

certainly not a recognizable quarter note! 

Instead, Performer internally sets up an evenly spaced grid of note 

durations, finds the nearest grid location, and displays the note as if 

it began at the grid location. For example, the above note at 31! 21073 

is displayed on the nearest downbeat at 3121000 (as a much more 

recognizable quarter note!) 

== 
Even though the note actually occurs slightly after the downbeat in 

the track, it gets displayed on the downbeat, which is the nearest grid 

location. As a result, you get the best of both worlds: your original 

performance of the music is preserved, and Performer makes the 

notation display look readable. 
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Displaying triplets and 
tuplets 

The scrolling playback 
wiper 

In addition to being able to properly display unquantized data, 

Performer automatically detects triplets and tuplets and displays them 

with the appropriate bracket and note spacing. In some cases, the 

placement of the notes in the tuplet may not be accurate enough for 

Performer to properly detect the tuplet. If you’d like to see the tuplet 

properly displayed, try quantizing the data with the tuplet option in 

the Quantize command. Try experimenting with Strength settings less 

that 100%, as the tuplet does not need to be fully quantized for 

Performer to recognize it. 

A playback wiper is provided in the QuickScribe window to indicate 

the current playback location. This wiper can be dragged as well to 

change Performer’s current playback location in the main counter. 

You can drag it left or right; you can also drag it up and down to 

jump from system to system. 

Double-clicking anywhere on a staff to make the playback wiper 

jump immediately to that location. To turn off the wiper, uncheck it 

in the Auto Scroll command in the Basics menu. 

More. 

y 

bass 
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Getting around in the Use the commands in the QuickScribe notation window mini-menu 

QuickScribe window to scroll through each page and go to the first or last page. 

The mini-menu commands have the following keyboard shortcuts: 

Mini-menu command: Keyboard shortcut: 

Next page n 

Previous page p 

First page f 

Last page l 

You can also jump to a particular page by using the page number box 

at the bottom of the window. 

Pop-edit the page number 
display to go to any page. 

To scroll up and down by one windowful (instead of an entire page), 
use option-page up and option-page down. 
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Setting the Score Choose Score Options from the QuickScribe window mini-menu to 
Options open the Score Options dialog box: 

Score Options 

All print option settings are saved with the file, and they can be 

included in your New file template. 

Starting page number 
This option allows you to enter the starting page number for the 

piece. Its default value is page 1. 

Creating a title page 
The “First page is title page” option allows the first page of music to 

be formatted differently from the rest of the body pages. Its system 

margins can be adjusted separately from other pages to allow fora 

title, subtitle, composer, and other text. Text can be inserted on the 

title page without having it be displayed on other pages. 

Full part names/Abbreviated part names 
Two options are provided for displaying staff names, which appear 

between left margin and the left edge of the staff. In both cases, the 

staff name is derived from the track name. Check the first option, 

called “Show Full Part Names before first System”, to display the full 
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QuickScribe Notation 

track name to the left of the first staff. Check the second option, 

called “Show abbreviated part names before other systems”, if you 

would like an abbreviated name to appear next to each staff after the 

first one. The abbreviation is the first four letters of the staff name. If 

you don’t want staff names, uncheck both options. 

The Abbreviation maximum length option lets you choose the 

maximum length of abbreviated staff names. 

To set the font, style, size, etc. of all staff names, click any staff name 

and choose the desired text settings from the Text menu. The settings 

you choose will affect all staff names and abbreviations. 

Making more space between staves and staff systems 
In addition to the space created above and below individual staves by 

their ledger line settings, you can make more space between staves 

and staff systems globally with the “Extra spacing” options. When you 

are printing a single track, use either option to increase the amount 

of space between the staves. If you are printing several tracks at the 

same time, they are grouped together into a staff system. Use the staff 

spacing option to increase space within the system; use the system 

spacing option to increase space between systems. 
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Staff spacing { 

Markers 
Markers can be displayed in the score at their location in the 

sequence. The marker text can appear above or below the staff, and 

you can control the distance from the staff by typing in a number of 

ledger lines in the box provided. 

You can also choose to show the exact location of markers along 

with their name in any combination of Performer’s three time formats. 

Just check the box next to the time format you wish. 

To set the font, style, size, etc. of all markers, click any marker name 

and choose the desired text settings from the Text menu. The settings 

you choose will affect all markers. 

System Bracket/Grand Staff Brace options 
These two options let you choose whether to show a system bracket 

and grand staff braces. 
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Show rests in empty measures 
You may choose whether or not to show a whole rest in empty 

measures (measures with no note data in them). 

Show tempo marking above first measure 
Performer takes the tempo for the metronome marking from the 

tempo setting in the first measure displayed in the score. The tempo 

number is taken from the current settings in the metronome panel. 

For example, if the tempo control is set to the tempo slider, the 

current tempo slider setting is used. If tempo control is set to the 

Conductor track, the current tempo setting in the Conductor track is 

used. 

Measure numbers The Measure numbers mini-menu command, shown below, sets the 

frequency and position of measure numbers in the score. 

Measure Number 
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Measure spacing 

356 

The measure spacing mini-menu command lets you determine the 

number of measures per line or the overall spacing of notes. 

5, 

tHE 
$ 

Measure Spacing 

Space measures ____ per line 
This option lets you choose a certain number of measures per line, 

such as 4 or 5. You can type in the desired number. With this option, 

each bar is the same size no matter what notes are in the measures. 

Performer can format pages much faster when measure spacing is 

fixed. As a result, fixed measure spacing is preferable over natural 

spacing if you plan to do a lot of cutting and pasting in the 

QuickScribe notation window because pages need to be reformatted 

every time you cut or paste data. On the other hand, if measures have 

lots of notes in them, use automatic spacing for best results. 

Space measures automatically 

This option lets Performer decide how many measures to put on each 

line, depending on how many notes are in them. You can tightén or 

expand the overall spacing of measures by adjusting the slider. Its 

range depends on the music: don’t hesitate to experiment with its full 

range. 

In many cases (depending on the music itself), automatic spacing 

produces the best-looking results. It can, however, make cut and 

paste operations slow because these operations require page 

reformatting, and page reformatting takes longer with automatic 

spacing. In addition, you'll often need to manually repaginate the 

score after cutting and pasting to properly format the music. If you 
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The effect measure 
spacing has on scrolling 

Track options 

QuickScribe Notation 

plan to use the QuickScribe notation window for cut and paste 

editing, you'll find it to be much faster to use fixed measure spacing 

(discussed in the previous section). 

Another thing you may notice when using automatic measure spacing 

is that a progress window may appear when you are scrolling around 

in the file. This happens when Performer has not yet calculated the 

pagination for all of the pages. Once the pagination has been 

calculated, scrolling from page to page is virtually instantaneous and 

you will no longer see the “Preparing to display page” progress 

window. If you make changes to your music that change the 

pagination, Performer will need to recalculate the page breaks again. 

If you would like to avoid this process entirely, and you would 

always like to be able to jump around instantaneously, use fixed 

measure spacing. 

When displaying a track in the QuickScribe notation window, the 

Track options mini-menu command lets you specify how you want it 

to be displayed, such as whether to display the track on a single staff 

or a grand staff. 

: r Track Option 
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Track pop-up menu 
Choose each track one at a time from this pop-up menu and, below, 

give it the settings you want. Each track can have its own settings, 

and the settings are remembered. You can change them at any time. 

The “Default” item in this pop-up menu has its own settings, too; they 

are applied to any track for which you have checked the Use Default 

option (see below). 

Use Default 

This check box causes the track to use the default settings. To change 

the default settings, choose Default from the Track pop-up menu at 

the top of the dialog box. 

Type of staff 
The Single staff option causes the track to be displayed on its own 

staff, regardless of what notes are in the track. When using a single 

staff, Performer automatically chooses either a bass clef or treble clef 

in an effort to place most of the notes inside the staff and to avoid lots 

of ledger lines. 

The grand staff option causes each track to be displayed on a grand 

staff, regardless of the notes in the track. To set the split point 

between the staves, see the “Put notes lower than ____ in left hand” 

section below. 

Put notes lower than ___ in left hand 
When a track is displayed on a grand staff, this option lets you specify 

what notes will be displayed on the treble staff and what notes will 

be displayed on the bass staff. For example, traditionally, notes are 

split at middle C (C3). If you would like to follow this convention, 

leave the value set to C3. The Split pitch itself always gets included in 

top staff. 

Use single staff unless it requires more than ledgers 
This option causes Performer to use a grand staff for the track if notes 

exist more than the specified number of ledger lines above or below 

a single staff. Use the ledger line option to control when a grand staff 

will be used instead of a single staff. Raise the number if you want to 

avoid using the grand staff very often. 
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Controlling page size 

Adjusting system 
margins 

Setting the score length 

Setting the cursor 
coordinates 

Repaginating 
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Inter-staff spacing 
These options give you control over the amount of space above and 

below the staff. This spacing is specific to the one track you are 

making settings for. To change the spacing of all staves, see “Making 

more space between staves and staff systems” on page 353. 

The size of the page in the QuickScribe notation window is 

controlled by the Page Setup command in the File menu. Custom 

page sizes are not supported. 

System margins can be adjusted graphically by choosing the Show 

System margins mini-menu command in the QuickScribe notation 

window. Doing so causes system margins to appear on each page. 

The adjustments you make on any page will automatically be 

reflected on all other pages, except for the title page if there is one. 

If the “First page is title page” option is checked under the Score 

options mini-menu command, the title page margins can be adjusted 

separately from the rest of the pages to allow for title text. In this 

case, you can adjust the system margins of the other pages by 

scrolling to any page besides the title page. 

The Set Score Length mini-menu command lets you show or hide 

measures at the end of the score by increasing or decreasing the total 

number of measures shown. Choose the command and enter the 

desired number of measures. 

The Set Pointer Coordinates mini-menu command lets you set the 

display for the cursor coordinates shown in the status bar at the top 

of the QuickScribe notation window. Choose the desired time 

formats and pitch representation. 

Cursor coordinates ———» 

The Repaginate mini-menu command completely reformats the music 

on each page to achieve the most appropriate-looking layout of the 

measures. If you have made any changes to the music that require it 
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to be re-spaced or reformatted in any way on the page, the 

reformatting takes place when you choose this command (or close 

and then reopen the window). 

Repaginate is especially useful after you copy and paste sections of 

music to restore appropriate measure spacing. If you plan to do a lot 

of cutting and pasting in the QuickScribe notation window, you may 

want to try using the fixed measure spacing option instead of natural 

spacing. Cutting and pasting can be much faster with fixed spacing. 

When you are done editing, you can return to using natural spacing. 

The QuickScribe window tool palette allows you to insert notes, text, 

and tuplets. The Tools in this palette are explained at length in the 

rest of this chapter. 

Be re 

Arrow cursor ————> 

ii FAK 1 

Page number tool ————> 

~«<—_—_— Current date tool (date is set by the Macintosh) 

Note durations ————-> 

Dot and double-dot ———> * 
tools i 

<«—_—__—_—— Triplet tool 
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Wor, king with The QuickScribe notation window allows you to do basic sequencing 

notes tasks, including inserting, step-recording, transposing, and editing 

notes. The following sections describe what you can do in this 

window. 

In the QuickScribe notation window, you can insert notes with: 

= The mouse 

» The Macintosh keyboard 

a A MIDI keyboard 

All three methods involve using the tool palette. 

Rests are automatic Rests are handled automatically by Performer’s transcription 
algorithms. You do not need to enter them. 

Inserting notes with the Insert notes and other symbols with the mouse as follows: 
mouse 

To insert this: Do this: 

A note Click the desired note duration in 

the tool palette. Press anywhere in 

the measure where you want to 

insert the note. With the mouse still 

held down, drag to the desired pitch 

and location. Watch the cursor 

coordinates to help determine the 

beat location. 

A note with an accidental Same as above. 

A dotted note Click both the desired note duration 

and the dot in the palette. Then 

insert the same as above. 

A chord Insert the first note as described 

above. Click directly above or 

below the first note to add more 

notes to the chord. 
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A triplet Click a note duration in the tool pal- 

ette and click the triplet tool. Both 
are now selected. Insert each note 

in the triplet as described above. 

To add a dot to a note Click the dot tool and then click on 

the notehead you want to add it to. 

To change the duration of a note | Click the desired duration in the 

palette and click the note. 

To change several notes to the Select the notes with the arrow cur- 

same duration sor. Command-click the desired 

duration or dot in the tool palette. 

Note: to scale durations (to double 

or halve them, for example) use the 

Scale Time command in the Region 

menu. 

To change the location or pitch of Click the arrow cursor and then 

one or more existing notes drag the note as desired. To drag 

multiple notes, select them before 

dragging. 

Inserting notes with the To insert notes and other symbols with the Macintosh keyboard: 

Macintosh keyboard 
1. Click the arrow cursor tool in the palette. 

2. Click on the staff at the desired pitch and location for the symbol. 

A blinking insertion cursor appears on the staff. 
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following table: 

To do this: 

To move the cursor 

To determine the exact beat loca- 

tion and pitch of the insertion 

Cursor 

To select a duration 

To insert a note 

To insert a note with an acciden- 

tal 

To insert the first note of a chord 

To insert the second, third, 

fourth, etc. note in a chord 

To insert a tuplet 

To delete a note or chord 

3. Once you have a blinking insertion cursor on the staff, refer to the 

Do this: 

Use the arrow keys. 

Use the cursor coordinates display 

in the status bar at the top of the 

window. 

Use the open bracket ( [ ) and 
closed bracket (] ) keys to choose 

the next highest and lowest dura- 

tion. Or use the extended keypad 

(see “Selecting durations with the 

extended keypad” on page 364). Or 

click the desired duration in the pal- 

ette. 

Press return. 

Press the + or - key on the extended 

keypad. 

Press the enter key. (Enter inserts 

the note without advancing the 

insertion cursor.) 

Press the enter key. 

Press the t key to turn on the tuplet 

tool, and use the bracket keys as 

described above to select any note 
duration. Press t again to toggle off 

the tuplet tool. 

Position the insertion cursor to the 

right of the note and press the 

delete (backspace) key. 
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The following keys can be used on the Macintosh extended keypad 

to select durations in the QuickScribe tool palette. These are the same 

duration keys used for the Step Record command in the Basics menu. 

ew JLJILJ LJ 
Mi JiJLJ ALL 
JisJieJLJ = (YY 
UW SteJts) | 
(co SL Jew | 

The QuickScribe duration selection keys on the Macintosh extended keypad. 

When the QuickScribe window is active (the front-most window), 

several keys on the Macintosh keyboard change their function to 

features that are specific to the QuickScribe window. 

For example, the up and down arrow keys, which normally change 

the currently record-enabled track in the Tracks window (unless you 

programmed them for something else in the Remote Controls 

window), move the note insertion cursor up and down instead. 

To temporarily suspend the QuickScribe key bindings and return to 

the normal bindings (in the Remote Controls window), hold down 

the shift key, or press caps lock. If you use caps lock, the shift key 

temporarily switches back to the QuickScribe key bindings. 

To hear notes played back on a MIDI device as you insert them, click 

the Audible mode button in the title bar of the QuickScribe notation 

window. Notes are played on the instrument that the staff (track) is 

currently assigned to in the Tracks window. 

To insert notes with a MIDI controller: 

1. Click the arrow cursor tool in the palette. 
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Getting the arrow cursor 
temporarily 
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2. Click on the staff at the location where you would like to begin 

entering notes. 

A blinking insertion cursor appears on the staff. Use the cursor 

coordinates to determine the exact location in the measure. If 

necessary, use the left and right arrow keys to move the cursor. 

Cursor coordinates ———» 

3. Select a note duration. 

There are several ways to select a duration: 1) click the desired 

note duration in the tool palette, 2) press the open bracket ( [ ) 

and closed bracket (] ) keys on the Macintosh keyboard 

repeatedly, or 3) use the extended keypad as described in 

“Selecting durations with the extended keypad” on page 364. The 

currently selected duration is displayed in the tool palette. 

4. Play the desired note or chord on your MIDI controller. 

Notes appear when you release the keys, so be careful not to slur 

notes together. It’s best to play in a staccato fashion to avoid 

accidentally inserting two notes when you only want to enter one. 

If you would like to hold one note while inserting others, just 

keep holding it down while inserting the other notes. 

5. Play in as many notes and chords as you'd like. 

Change durations as needed. Step Recording uses many of the 

same keyboard actions as Macintosh keyboard entry, so you may 

want to review the section “Inserting notes with the Macintosh 

keyboard” on page 302. 

While working with the tools in the palette, you may want to 

temporarily restore the arrow cursor for selecting or some other 

purpose. To do so, press the option key. While you hold it down, the 

cursor turns into an arrow. When you release the option key, the 

cursor switches back to whatever it was. 
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Selecting notes for Below is a summary of how to select notes for editing in the 

editing QuickScribe notation window. Notes are selected with the arrow 

cursor. 

To select this: Do this: 

A single note Click the item once. 

Several notes that are not next to Shift-click each item. 

one another 

The notes in several measures Drag a selection box over the mea- 

sures. 

A region of notes Drag a selection box over them. 

@ If a note is displayed as several tied notes, you can 

click any notehead to select the entire note. 

See 1S eee 

When a single note is selected, its information appears in the info bar. 

This information can be edited as usual. 

Cutting, copying & Once notes are selected as described in the previous section, they can 

pasting notes be cut, copied, and pasted using the commands in the Edit menu. To 
paste notes you have either cut or copied, click the staff with the 

arrow cursor on the location at which you would like to paste the 

material. Watch the cursor coordinates box (see “Notation window 
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Quick Reference” on page 346) to specify the exact beat location at 

which you will paste. You can copy and paste between other editing 

windows as well. 

@ Cutting and pasting can be slow if you are using 

natural measure spacing. You can used fixed measure 

spacing to speed things up. See “Measure spacing” on 

page 356 for more information. 

After cutting and pasting, you can reformat the pages using the 

Repaginate mini-menu command to clean up the display. 

Using Region menu Similar to the Edit menu commands mentioned above, Any Region 

commands menu command can be applied to notes you have selected. This 

includes quantizing, transposing, and any other command from the 

Region menu. 

Changing note To change a note duration, click the desired duration from the tool 

durations palette and click on the note you wish to change. To change several 

notes at once, select them and then command-click the desired 

duration in the tool palette. 

Wor, king with The QuickScribe window Tool palette has several text items that let 

text you enter titles and other text on the page, including page numbers 

and metronome markings. 

Text is handled in a similar fashion to standard Macintosh graphics 

programs. Text is placed on the page inside text boxes, which can be 

cut, copied, pasted, and otherwise edited. A text box is a resizable, 

transparent box in which you can type and edit text. If you have 

worked with MacDraw, SuperPaint, or similar graphics software, you 

are already familiar with how to use text boxes in Performer. 

Inserting text To insert text: 

1. Scroll to the page on which you'd like to insert the text. 

If you are inserting title page text, scroll to the title page. If you’d 

like the text to appear on body pages, scroll to any body page. 

2. Click the Text tool in the Tool palette. 
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3. Drag out a text box on the page. 

1. Choose the desired text attributes from the Text menu. 

Choose the desired font, point size, style, justification, and display 

properties from the Text menu. For details about the Display text 

attribute, see “Making titles, headers, and footers” on page 368. 

2. Type the desired text. 

3. Click anywhere outside the text box to complete the text entry. 

Making titles, headers, Titles, headers, and footers are inserted in the manner described in 

and footers the previous section. Just choose the appropriate Display attribute in 

368 

the Text menu as shown below. 

size > 
Style » 

> 
> 

Justify 

Display 7 This page ony 
“ Title page only 

Body pages only 

Both title & body pages 

Avant Garde 

B Avant Garde Demi 

B Clearface Bold 

B Futura Bold 

B Garamond Bold 

If the Title page only and Body pages only menu items are greyed out, 

check the First page is title page option in the Score options command 

located in the notation view mini-menu. For more information about 

this option, see “Creating a tithe page” on page 352. 
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Making page numbers 

Displaying the current 
date 

Selecting text 

QuickScribe Notation 

Page numbers are inserted using the page number tool in the tool 

palette. 

Page number tool 

Using this tool, insert them in the same manner as described in 

“Inserting text” on page 367. The page number automatically appears 

in the text box. Be sure to choose the appropriate Display attribute 

(Body pages only or Both title & body pages). See “Making titles, 

headers, and footers” on page 368 for more information. 

The current date can be inserted using the Date Tool in the Tool 

palette. 

Current date tool 

Using this tool, insert the date in the same manner as described in 

“Inserting text” on page 3067. The current date (as specified by your 

Macintosh) automatically appears in the text box. Be sure to choose 

the appropriate Display attribute (Body pages only or Both title & body 

pages). 

To select an entire block of text, click it once. Handles appear to 

indicate that it is selected. 

7 Title | 
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To select individual words within a text box: 

1. Double-click the text box to edit it. 

2. Select the desired text by dragging over it 

Once text is selected, it can be cut, copied, or deleted. You can also 

change the font, style, and other attributes of the text. 

To edit text, double-click it to get an insertion cursor inside the text 

box. Once you have an insertion cursor inside the text box, use the 

following actions to edit the text: 

To do this: Do this: 

Move the text cursor within the text Press the arrow keys 

box 

Delete a character Position the cursor to the right of it 

and press the delete key 

Select a word Double-click the word 

Select several words or sentences Drag over them inside the text box 

Change the font, point size or style Select the text and choose the desired 

of some text in the text box font, size, and style in the Text menu 

Justify the text to the left margin, to Choose Justify from the Text menu 

the right margin or to the center and select the desired justification 

Finish inserting or editing the text Click anywhere outside the text box 

Cancel text editing Type command-period 

Cut, copy, and paste text within the Select the text and choose the desired 

text box command from the Edit menu. 

You can copy text from a text editing program such as Microsoft 

Word and then paste it into a text box in the QuickScribe notation 

window. Just copy the text from the other program, switch into 

Performer, double-click or insert a text box, and then paste. 
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Changing text attributes 

Installing fonts in the 
Text menu 

Printing a track as a 
single instrument part 

QuickScribe Notation 

Text attributes like point size, style (bold, italic, etc.), justification 

(eft, center, or right), and display properties (title page only, etc.) can 

be changed after text has been entered. 

To change the attributes of an entire text box, click the text once to 

select all of the text in the box. Then choose the desired attributes in 

the Text menu. This works for staff names, staff abbreviations, and 

marker text as well. 

To change the attributes of individual words within a text box: 

1. Double-click the text box to edit it. 

2. Select the desired text by dragging over it 

3. Choose the desired text attribute from the Text menu. 

4. Click anywhere outside the text box to complete the text entry. 

Play very fast 

The fonts that you see in the Text menu are the fonts that you have 

installed in your Macintosh system. If you are not familiar with how 

to install text fonts in your Macintosh system, refer to your Macintosh 

documentation. 

@ When troubleshooting font problems in Performer, 

determine if the problem occurs in your word- 

processing software, or other programs that deal with 
text. For example, if you can’t find a font that should 

be in the list, check the font list in your word 

processor. Most likely, it will be missing there, too, and 

you know that the problem lies somewhere in the 
Macintosh system. 

To print a track as a single instrument part: 

1. Select the entire track. 

If you need help with this, see “Choosing what tracks to display” 

on page 347. 
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2. Click the QuickScribe notation button to open the notation window. 

3. As described in this chapter, add text to the title page and set the 

Score Options in the mini-menu as desired. 

4. To display the track name in front of the staff as the instrument 

name, use the Part Names option in the Score Options mini-menu 

command. 

5. If you are printing several instrument parts, repeat this procedure 

for each track. 

You won't need to change the Score options because the 

formatting is remembered when you change tracks. Just close the 

current part, select the next track and click the QuickScribe 

notation window button to view and print the next part. 

If you want to preserve the notation window separately for each 

track, you can do so by copying each track into its own separate 

sequence. Since each sequence has its own separate QuickScribe 

notation window, each part will be preserved. 

Use the procedure in the previous section to print a keyboard part 

(which is in a single track). To display the track on a grand staff: 

1. Choose Track Options in the QuickScribe notation window mini- 

menu). 

2. Choose the track that contains the keyboard part from the pop-up 

list. 

3. Uncheck the Use Default check box, if necessary. 

4. Choose the Grand Staff option. 

5. Set the spacing options as desired. 

6. Click OK. 

When you select multiple tracks, Performer places them together in 

the same staff system. So, to print a score, select all the tracks you 

want to include in the staff system for the score, and then open the 

QuickScribe notation window. To adjust the spacing between the 

staves in the system, as well as the spacing between systems, choose 

Score Options (score window mini-menu) and set the spacing 

options as needed. 
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Creating blank staff To create blank staff paper: 

paper 
1. Select empty tracks. 

Select as many empty tracks as you'd like staves in the systems on 

the page. 

2. Open QuickScribe notation window. 

3. Use the Measure spacing and Set Score Length mini-menu 

commands to determine the number of empty measures. 

Controlling note Accidentals in the QuickScribe window are governed by the curr 

spellings key signature in the Conductor track. To change the way notes 2 
spelled, use the Change Key command in the Change menu. Fo 

more information, see chapter 32, “Change Key” (page 547). 
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Chapter 24 System Exclusive 

Basics 

Performer allows you to record, playback, and edit MIDI System 

Exclusive messages. Common types of System Exclusive messages 

include patch dumps, preset selections, editing parameters, etc. 

Performer can thus store patches, samples, and other important 

information from your MIDI equipment in system exclusive form. 

Patches, edit parameters, and other special commands can be 

incorporated into musical sequences, greatly expanding the resources 

of your MIDI sound modules. 

System Exclusive messages are a special type of MIDI data. A System 

Exclusive message consists of a header, body, and an ‘end of 

message’ byte. (A byte is a unit of digital information, roughly 

equivalent to a single character or letter.) 

The header labels the following data as System Exclusive information, 

and includes a code identifying the manufacturer of the equipment 

transmitting the data. 

The body of the message contains the actual data being sent. This 

data may take any form the manufacturer desires. While there are 

some standards for the format of System Exclusive information, for 

the most part a System Exclusive message is only understood by the 

type of equipment that generated it. As a result, recording a patch 

dump from one synthesizer and sending it to another will generally 

not produce useful results. Performer does not respond to or interpret 
System Exclusive data; any analysis or editing of the body of the 

message is the user’s responsibility. 

Finally, the end of message byte, F7, marks the end of the System 

Exclusive data, and signals Performer to interpret subsequent 

information as standard MIDI data. 

As defined in the MIDI specification, a System Exclusive message 

must begin and end with an FO and F7 byte, respectively. In addition, 

only hexadecimal values of 7F (127 in base ten) or less are allowed. 
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When you click the OK button after inserting or editing the contents 

of a System Exclusive event, Performer will scroll to and highlight any 

bytes that violate the conditions just stated. 

System Exclusive messages are recorded and played back like any 

other MIDI data. These messages vary in size; information for a bank 

of patches, for instance, may be 10-20K or more. No matter how long 

a message is, it is treated as a single event by Performer. Note that a 

long System Exclusive message can briefly halt recording or playback 

as Performer processes the data; it is best to place larger System 

Exclusive events like patch or bank dumps in separate sequences, or 

at the start of a sequence before the actual music begins. 

Because System Exclusive messages have no channel assignment, 

they are sent to every MIDI device connected to a port. If you have 

several devices of the same model or brand connected to the same 

port they may all respond to a message sent to or from just one of 

them. Conversely, some manufacturers encode channel assignments 

into the body of the System Exclusive message. Performer is unable 

to access or rechannelize such an assignment. 

For example, if the playback assignment for a track is channel 1, but 

a System Exclusive message full of patches intended for that synth 

includes an encoded assignment to channel 16, the synth won't 

receive the patches. 

Find out if any of your equipment encodes channel assignments in its 

System Exclusive messages, and be careful about changing channel 

assignments On equipment to which you intend to send System 

Exclusive. If you encounter difficulty when working with System 

Exclusive data, try patching the MIDI device directly to the Macintosh 

MIDI interface, to prevent interaction with other equipment. 

Note that the Input Filter, found in Performer’s Basics menu, defaults 

to System Exclusive unchecked. Unless you explicitly check the box 

next to System Exclusive, you will be unable to record System 

Exclusive messages. 
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Viewing & Editing 
System Exclusive Data 

System Exclusive 

System Exclusive data can be viewed and edited in the Event Editing 

window for the track on which it is recorded. In an Event List, a 

System Exclusive message will consist of the System Exclusive symbol 

and as much data as can fit on one line: 

GH FO 43 01 O05 7C 25 32 Fe 

To see the entire message, option-click or double-click on the System 

Exclusive event. A window appears: 

Insertion Mode Button Transmit Button Replacement Mode Button 

00 03 33 00 

Hexadecimal System Exclusive data Alphanumeric 
Position (hexadecimal) Translation 

The window is divided into a top and bottom portion. The bottom 

portion displays the system exclusive data contained in the event. 

The top portion is used to type in and transmit short system exclusive 

“request” messages, which can be sent to a synthesizer that requires 

a short system exclusive bulk dump request message to initiate a bulk 

dump to be recorded into the lower portion of the window. 

The System Exclusive data is displayed in hexadecimal (base 16) 

numbering. Each pair of hexadecimal digits, which include the 

numerals 0-9 and the letters A-F, represents a byte of data. Each line 

contains eight pairs of digits. To the left of each line of data is a two- 

digit hexadecimal number indicating the position of the first byte of 
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data in that row. The first row starts at position 00, the next at 08, the 

third at 10 (this equals 16 in hexadecimal), and so forth. To the right 

of each row of data is its translation into alphanumeric characters 

Cusing the ASCII standard). Most of the time this translation will be 

garbled and useless, but patch names and other text in the System 

Exclusive message may be visible. 

The length of the System Exclusive message is displayed at the top 

left. This is the number of bytes of data in the message. 

The scroll bars let you scroll through long messages. The Grow box 

in the lower right corner lets you adjust the size of the window. When 

you press the OK button, Performer checks the changes you have 

made to the data and will scroll to and highlight any byte that does 

not conform to the MIDI specification. After confirming your 

changes, Performer closes the window. Pressing the Cancel button 

closes the window without making any changes to the data. 

You can directly edit the hexadecimal data in the System Exclusive 

window using the mouse and Macintosh keyboard. There are two 

basic editing modes: Insertion mode and Replacement mode. The 

editing mode is selected by clicking on the appropriate button at the 

top center of the window; the currently selected mode is indicated 

with a darkened border. 

Insertion mode: This mode is similar to standard Macintosh text entry. 

To insert new values, click the mouse to position the insertion point, 

and type in new values. Use the delete key to delete previous digits. 

You may edit only in the hexadecimal portion of the display. 

Replacement mode: In this mode, one character is always highlighted. 

Typing a new character replaces the current highlighted character, 

and then highlights the next character. Use this mode if you are just 

changing a few bytes in a system exclusive message, as the display 

requires less updating while typing new values. 
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Cutting, Copying, and 
Pasting 

System Exclusive 

To edit a System Exclusive event: 

4. Activate the Event Editing window that contains the System 

Exclusive event. 

If neither Event Editing window for the track is open, double-click 

on the track name and an editing window will appear. If one is 

open, simply click on it. 

Double-click on the System Exclusive event. 

The System Exclusive window appears. 

Select the editing mode. 

Click on the appropriate button. If just a few bytes need to be 

edited, use Replacement mode. Otherwise, use Insertion mode. 

Edit the data. 

In Insertion mode, delete the incorrect bytes and type in new data. 

In Replacement mode, click on the first digit of data to be replaced 

and type in the new data. The old data is written over. 

Press OK to confirm your changes and close the window, or 

Cancel to close the window without making any changes to the 

data. 

If you press OK, Performer will scroll to and highlight any byte 

that does not conform to MIDI specification requirements. 

To Cut, Copy, or Paste a region of hex data in replacement mode: 

is Select the data. 

To do so, drag over it with the mouse. 
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2. Cut, copy, or replace the selected region. 

To Cut or Copy, press command-X or command-C respectively. 

The selected data will be placed in the Clipboard. To replace the 

selected data, type in or paste new data, which will replace the 

highlighted data. 

You can insert system exclusive data into an Event Editing window. 

This is handy for inserting a short system exclusive message, like a 

parameter change or dump request, without having to record it. The 

following steps apply to System Exclusive insertion in an Event List 

window. Refer also to the chapter 7he Graphic Editing Window. 

To insert a System Exclusive event into an Event List window: 

1. Activate the Event List window into which you want to insert the 

System Exclusive event. 

If the Event List window is not open, double-click on the track 

name to open it. If it is open, simply click on it. 

2. Press the Insert button in the title bar of the Event List window. 

3. Select System Exclusive from the menu. 

A new system exclusive event pops up. 

4. Enter the location for the system exclusive event. 
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Exclusive Data With the 
Edit Menu 

Transmitting a System 
Exclusive Message 

ro] 

Recording Sysex into 
the Editor Window 

System Exclusive 

5. Press the Tab key to move to the data field. 

The System Exclusive window appears. 

6. Select Insertion mode. 

Click on the left button at the top center of the window. 

7. Type in the data. 

In Insertion mode, you can delete the incorrect bytes and type in 

new data. See the above section on editing System Exclusive data 

for more information. 

8. Press OK to confirm the insert and close the window, or Cancel to 

cancel the insert and close the window. 

When confirming your insert, Performer will scroll to and 

highlight any byte that does not conform to MIDI specification 

requirements. 

The commands on the Edit menu work as normal on System 

Exclusive events; these events can be cut, pasted, shifted, etc. within 

a file or between files just like any other Performer event. The only 

way to alter the body of a System Exclusive message is to use the 

System Exclusive window as described above. In all other cases, 

Performer treats the message as a single event. 

To transmit a system exclusive message from the system exclusive 

editor window: 

1. Click the insertion mode button. 

2. Click between the FO and F7 in the top portion of the window. 

3. Type in the system exclusive data. 

4. Click Transmit. 

To record system exclusive into the system exclusive editor window: 

1. Be sure that your MIDI hardware and cables are set up properly. 

Make sure there is a MIDI cable from the MIDI OUT on the device 

you will be recording from to the MIDI IN on your interface. 
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9. 

. If Performer is in MultiRecord mode, switch to regular record mode 

to avoid problems. 

To do so, select MultiRecord in the Tracks window mini-menu to 

uncheck it. 

Open an Event Editing window for a track and press the Insert 

button in the title bar. 

Choose System Exclusive from the menu. 

A system exclusive pop-up event will appear. 

Type in the measure, beat and tick location for the event, using the 

tab key to move from one field to the next. 

Press tab one more time to open the System Exclusive Editor 

window. 

The system exclusive editor window will appear. 

If necessary, type in a bulk dump request message in the top 

portion of the window. 

This is only necessary if your synth requires it. Many synths allow 

you to initiate the transfer by pressing a button on the synth itself. 

Initiate the system exclusive data transfer from your MIDI device. 

To do so, press the button on the device—or whatever is needed— 

—to cause it to transmit the desired system exclusive dump. If you 

typed in a bulk dump request message, click the Transmit button. 

If all is well, the system exclusive data will appear in the lower 

portion of the window. 

Click OK to save the system exclusive data or cancel to discard it. 

It is not necessary to enable system exclusive data in the Input Filter 

when recording data into the system exclusive editor window. 
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Recording System As with earlier versions of Performer, you can also record system 

Exclusive into a Track exclusive data into a track. To record a system exclusive message into 

a track: 

1. Be sure that your MIDI hardware and cables are set up properly. 

Make sure there is a MIDI cable from the MIDI OUT on the device 

you will be recording from to the MIDI IN on your interface. 

2. Choose Set Input Filter from the Basics menu in Performer and 

check the System Exclusive option. 

If the System Exclusive option is not checked, system exclusive 

data will be filtered on input and will not be recorded. 

3. If Performer is in MultiRecord mode, switch to regular record mode 

to avoid problems. 

To do so, select MultiRecord in the Tracks window mini-menu to 

uncheck it. 

4. Record-enable a track in the Tracks window. 

5. Start recording. 

6. Send the system exclusive data from your MIDI device. 

To do so, press the button on the device—or whatever is needed— 

—to cause it to transmit the desired system exclusive dump. If you 

have the MIDI Monitor window open, you will see the MIDI 

System Common light Cabelled Co) turn black while the data is 

being received by Performer. 

7. Wait a few seconds, longer if it is a large bulk dump, and then stop 

recording. 

8. Open the Event List window to view the System Exclusive event in 

the track. 

What you should see is something like this: 
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If the Event List window is empty, or you do not see a System 

Exclusive event, check the Input Filter and cable connections and try 

again. You may also want to open the MIDI Monitor window to see 

if the data is actually being received by the Macintosh. If the Co light 

doesn’t turn black when you send the data from the device, then 

there is a problem with the MIDI connections or with the device that 

is transmitting the system exclusive. 

Hints Most synthesizers and many other MIDI devices allow you to dump 

patch settings as System Exclusive messages. You can use Performer 

to store and organize these messages, creating a library of patches 

and presets. Store each patch or bank of patches as a separate 

sequence in one or more files. This way you can use the name and 

comment fields to label your presets, and use the Load command to 

quickly access them. To restore a patch or bank, load the desired 

sequence and play it. 

You can paste System Exclusive dumps of sounds and settings at the 

start of a sequence. This lets you use patches or settings that can’t fit 

into your MIDI devices’ preset storage, and ensures that the right 

sounds are loaded for the sequence. Use the standard Copy and Paste 

commands to place the system exclusive events at the start of the 

sequence. It is best to leave a measure or two of space after the 

system exclusive messages and the start of the music, to allow your 

equipment to process the data. Use the comments fields in the 

Chunks and Tracks windows to describe the system exclusive data 

you've pasted into your sequence; system exclusive messages are 

hard to identify from their appearance. 

Some manufacturers allow you to edit patch parameters over MIDI, 

using short system exclusive messages. This can add a great deal of 

expression to a sequence. For example, the attack of a filter envelope 

could be controlled with system exclusive and controller data, 

creating different bowing effects with a violin patch. 

Some instruments must receive a handshake message before they will 

transmit a System Exclusive message. If this is the case with one of 

your MIDI instruments, first consult the user’s manual for the 

instrument (or if necessary, the manufacturer) to find out the 

hexadecimal string that comprises the handshake message. Type this 

message into a Performer track using the System Exclusive editing 

window as described above, then copy the track and paste it to a 
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Be Careful 

System Exclusive 

‘library’ sequence for backup purposes. Back in the original 

sequence, play-enable the track containing the handshake message 

and record-enable an empty track. Upon playback, the handshake 

will be transmitted to the instrument, which will respond by dumping 

to the record-enabled track. 

System exclusive data is not associated with a channel, as defined in 

the MIDI specification. System exclusive data in a track is merely sent 

to the port you specify for playback; no channel number can be 

attached. Some manufacturers have decided to include a channel 

number in some of their system exclusive messages. This number 

cannot be changed. Therefore, even if data is being sent to channel 

3, for example, system exclusive messages contained in that data 

might be sent to a channel other than 3. 

System exclusive data is complex, and varies greatly from device to 

device. If you are uncertain about your equipment’s system exclusive 

implementation, you should be very careful in using or editing 

system exclusive data. Most of the time, turning a piece of equipment 

off and then on again will clear any strange behavior caused by 

incorrect system exclusive data; however, incorrect use of system 

exclusive data could permanently erase presets from a synthesizer or 

other MIDI device. 

385 



386 
System Exclusive 



Chapter 25 Selecting Regions 

Selecting a Region to 
Edit 

Selecting a Region 
Using the Tracks List 
and the Edit Bar 

This chapter explains how to unleash Performer’s powerful Edit 

menu and Region menu commands. Specifically, it tells you how to 

select regions of data. Once selected, the region can be modified with 

any command in the Edit menu or Region menu. 

The commands in the Region menu and Edit menu change data in a 

selected region of a single sequence. This region must be specified 

before selecting a command from one of these two menus. 

Otherwise, Performer won’t know where to make the changes to the 

data. We’ll refer to this area as the “selected region”. 

A region can be selected in the Tracks List, the Tracks Overview, or 

in the Event Editing window for a track. Each track has three 

available Event Editing windows: the Event List window, the Graphic 

Editing window, the Notation Editing window, and the QuickScribe 

notation window. 

@ Once you have selected a region in one of these 

windows, the window must remain active when you 

choose the desired Edit menu or Region menu 

command. If the window containing the selected 

region is not activated, either no data will be changed 

or unwanted data will be changed. To activate a 

window, click its title bar anywhere. 

This method of region selection allows you to select a region 

containing any combination of tracks. It lets you specify the region 

numerically, which gives you a high degree of precision. It works 

with a// Edit menu and Region menu commands. 

Another advantage of this method is that the region remains selected 

after you choose an edit command. This allows you to do multiple 

operations on the same region without resetting its Start and End 

times. 
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Shortcuts for using the 
Edit Bar 

388 

1. Activate the Tracks window for the sequence you wish to modify by 

clicking on it. 

The title bar of the window will activate. 

2. Enter the Start time of the region in the Edit Bar. 

See the preceding section, Using the Edit Bar for details on 

entering the Start time in the Edit Bar. 

3. Enter the End time of the region in the Edit Bar. 

See the next section, “Shortcuts for using the Edit Bar” for details 

on entering the End time in the Edit Bar. 

4. Select the track or tracks that contain the region. 

Click on a track name to select a track, or drag over a set of tracks. 

Use Shift-click to select non-contiguous tracks. 

The region is now selected. 

Events occurring on or after the Start time and before the End time 

will be affected by a region command. For example, in 4/4 time, if 

the Start time is 9111000 and the End time is 13111000, all events 

starting on the very first tick of the first beat of bar 9 through the very 

last tick of the fourth beat of bar 12 (12141479) will be modified. An 

event occurring directly on 13111000 (the very first tick of the first 

beat of measure 13) will not be modified. 

The Edit Bar holds the beginning and end times for the selected 

region in the Tracks List. To enter a beginning time, click in a field in 

the Start time and enter a value; to enter the end time, click in a field 
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in the End time and enter a value. You can use the Tab key (or 

decimal point key on the keypad) to cycle through the 

measure | beat | tick fields. 

Clicking on the word “Start” enters the current time displayed in the 

Counter as the Start time. Clicking on the word “End” enters the 

current time as displayed in the Counter window as the End time. 

Double-clicking on the word “Start” enters the beginning time of the 

sequence as the Start time. Double-clicking on the word “End” enters 

the end time of the sequence as the End time. 

Double-clicking on the word Edit sets the Start and End times to the 

beginning and end of the sequence. This is equivalent to double- 

clicking on both the Start and End words. There are several quick 

ways to load times into the Edit Bar. 

The Remember Times command is a powerful way to set the edit bar. 

If you have a region selected in another window besides the Tracks 

window, and you want to load that region’s start and end time into 

the Edit bar in the Tracks window, use Remember Times. To 

“remember” a pair of Start and End times, activate the window 

containing the times and choose Remember Times from the Basics 

menu (or press command-R). 

Times are remembered for each type of window as follows: 

a Markers window: the times of the first and last highlighted 

markers are remembered. 

a Event Editing windows: the times of the first and last 

highlighted events are remembered. 

wm Tracks window: the times in the Edit Bar are remembered. 

= Consolidated Controls panel: the times in either the 

Memory Bar or Auto Record Bar are remembered, 
whichever is visible. If both are, the Memory Bar times are 

remembered. 
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Once you have used Remember Times, click the word “Edit” in the 

Edit bar. The remembered times are loaded into the Edit Bar. 

Selecting a Region in the To edit the data in a segment, you must first select it. When a segment 

Tracks Overview is selected, it highlights. Segment selection is exclusive from track 

name selection in the Tracks List. If you select segments, any 

highlighted track names will deselect. 
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Selecting a Region 
Using Event Editing 
Windows 

Selecting a Region 
Using the Event List 
Window 

Selecting Regions 

Below are several convenient shortcuts for selecting segments: 

To select this: Do this: 

A single segment Click it. 

Several adjacent segments Drag over them. If the segments 
are in several adjacent tracks, 
drag over them in a diagonal 
fashion. 

Several non-adjacent segments Hold down the Shift key and click 
the segments you wish to select. 
They will highlight. 

A segment in all tracks Click the segment in the Time 
Ruler. All segments beneath will 
highlight. 

One or more segments in all Drag in the Time Ruler. 
tracks 

Deselect segments when more Hold down the Shift key and click 
than one are highlighted the segments you wish to dese- 

lect. They will unhighlight. 

After you select one or more segments, Performer loads the start and 

end times of the region into the Edit bar for convenient selection in 

the Tracks List. 

Selecting data in an Event Editing window allows you to precisely 

specify the region’s boundaries; you can even select a single event if 

you want. 

Each track has four available Event Editing windows: the Event List 

window, the Graphic Editing window, the Notation Editing window, 

or the QuickScribe notation window. The data in the track is the 

same regardless of which window you use. For example, if you edit 

data in the Graphic Editing window, the changes you make will be 

immediately reflected in the track’s Event List window. 

This method of region selection allows you to precisely specify the 

region’s boundaries; you can even select a single event if you want. 

The Snip, Repeat, and Retrograde commands do not affect events 

highlighted in the event list. All other edit and region commands do. 
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If the Event List window for the track you wish to modify isn’t already 

open: 

1. Click on the track name containing the region to highlight it. 

This selects the track. 

2. Choose Edit from the Tracks window mini- menu. 

An Event Editing window for that track will appear. If the Graphic 

Editing window appears, go to the mini-menu on its title bar and 

choose Event List. The Event List window for the track will appear. 

Alternatively, you can just double-click on the name of the track 

you wish to modify. If the Event List window is open but not 

active (i.e. its title bar isn’t visible), simply click on the Event List 

window to activate it. 

3. Select the region of events you wish to change. 

Below is a summary of how to select events in the Event List. 

To select this: Do this: 

A single event Click on it. 

Several adjacent events Drag over the desired events. All 

events dragged over will highlight. 

Several non-adjacent events Hold down the Shift key and click on 

the events you wish to select. They 

will highlight. 

Deselect events Hold down the Shift key and click on 

the event(s) you wish to deselect. 

They will unhighlight. 

Extend the currently selected Command-click or Command-drag at 

region the desired end location. 

This defines a region of events which will be affected by the next 

command on the Edit or Region menus. 
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Selecting a Region There are two ways to select data in the Graphic Editing window: 

Using the Graphic 
Editing window 1. Drag a selection box over the desired notes (or other 

data) 

2. Drag horizontally in the Time ruler at the top of the 

window 

Start: 211/000 End: 4/1/0000 

For more information about selecting a region using the Graphic 

Editing window, see “Selecting Notes” on page 311. 
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Selecting a region using If you would like to quickly select the region within the Memory- 

the Memory-cycle repeat cycle repeat barlines to insert a loop, quantize, or any other editing 

barlines operation, double-click one of the two repeat barlines in the Tracks 

Overview or Graphic Editing windows. 

Selecting Chunks in the A Chunk in a song window can be selected by clicking it once. To 

Song Window select several adjacent Chunks, either drag over them or shift-click 

each one. To select non-adjacent Chunks, shift-click each one. 

Selecting in the For information about selecting notes in the QuickScribe notation 

QuickScribe notation window, see “Selecting notes for editing” on page 366. 
window 
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Chapter 26 Edit Commands 

Editing During Playback 

Selecting a Region 

Editing Commands and 
the Song Window 

Setting the Edit Filter 

After you’ve recorded your music, Performer’s powerful editing 

commands are at your disposal to add, remove, and otherwise 

rearrange data in a sequence or song. You can edit any amount of 

data from single events to large regions. 

Almost all of the editing operations discussed in this chapter can be 

done while the music is playing back so that you don’t have to stop 

and start the music to hear the result. For example, you could 

Transpose while the sequence is playing and then use the Undo/ 

Redo command as the music continues playing to compare the 

original and modified data. 

The commands in this chapter act on the a selected region in the 

Tracks List, the Tracks Overview, or one of Performer’s track edit 

windows. Without a selected region, the commands in this chapter 

do nothing. So be sure to learn how to select a region by reading 

chapter 25, “Selecting Regions”. It contains many powerful shortcuts 

that will speed up your work. 

The following Edit commands can be used in the Song window: Cut, 

Copy, Paste, Erase, and Select All. Other Edit commands such as Snip, 

Splice and Repeat have no effect on Chunks in the Song window. 

The Edit Filter allows you to specify what types of MIDI information 

are affected by commands from the Edit menu. It is in effect only 

when you select a region from the Tracks window. (When editing a 

region in an Event Editing window, use the View Filter instead.) 

Using this feature, you can extract different types of information from 

a region without having to laboriously edit out events that you don’t 

want. For example, if you wanted to copy only patch changes and 

aftertouch from a track, you could select only those items in the Edit 

Filter. Only the selected data would be copied to the clipboard. As 

another example, if you were editing Tempo changes in the 

Conductor track, you could set the Edit Filter for Tempo changes 

only. You could then cut and paste Tempo changes without erasing 

or in any way affecting meter and key changes in the same region. 
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Remember, the Edit Filter setting you make will affect a// the 

commands from the Edit menu, and al// editing from the tracks 

window. You should therefore make sure to change it back after 

doing a specific editing task since it may cause unwanted effects the 

next time you use the Edit commands. 

To set the Edit Filter: 

1. Choose Set Edit Filter from the Edit menu, or press command-F. 

A dialog box appears. 

2. Choose the types of data to be edited by checking the check box 

for each. 

You can choose multiple types of data. You can choose all types 

of data at once by clicking on the “Set All” button. You can 

uncheck all the check boxes by clicking on the “Clear” button. 

Using option-click will check only the check box you click on, 

unchecking all others; using command-click will check all boxes 

except the one you click on. Use the Controllers box and its 

options buttons to select which controllers are affected by Edit 

operations. 

3. Press OK to confirm your choice or Cancel to cancel it. 
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Specifying Controller 
Numbers in the Edit 
Filter 

The Clipboard 

Undo/Redo 

Edit Commands 

The types of data you select will stay in effect until you change the Edit 

Filter setting. When you are done using the Edit Filter, you should 

reset it. 

The buttons under the Controllers check box in the Edit Filter allow 

you to quickly choose which controller data to include in Edit 

operations. Click in the Controllers check box, click on the type of 

option you wish and then enter the controller numbers if necessary. 

a A//: All controllers will be affected by Edit operations. 

a All except: All controllers except the controller numbers 

you enter will be affected by Edit operations. 

gw Only: Only the controller numbers you enter will be 

affected by Edit operations. 

To enter controller numbers for the A// except and Only options, click 

in the text boxes next to the option and type in the numbers. You can 

use the Tab key to move between boxes in the same option. 

The Clipboard is a temporary storage place that holds data that is cut 

or copied. All data that is cut or copied is put on the Clipboard. When 

you paste, the data to be pasted comes from the Clipboard. 

The Clipboard retains data until a new cut or copy action is made. 

This means that you can cut or copy a region of data once and paste 

this same information as many times as you like. The Clipboard 

retains its data between files. You can therefore copy data from one 

file and paste it into another. 

To view the Clipboard, choose the Show Clipboard command from 

the Edit menu. To close the Clipboard, choose the Hide Clipboard 

command from the Edit menu. 

The Undo command will undo the effects of both real-time and step 

recording. Undo will also undo the effects of most commands and 

actions that add, delete, move, or otherwise modify data. 

The Undo command will change to reflect the name of the command 

just invoked. For example, if Transpose were chosen from the Region 

menu, Undo Transpose would be displayed on the Edit menu when 

next pulled down. 
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Cut 

Before measure 3 is cut: 

After measure 3 is cut: 

(The length of the music is the same.) 

Copy 

Before measure 3 is copied: 

After measure 3 is copied: 
(The length of the music is the same.) 
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When the Undo command is used, it will generally change to Redo. 

Redo will reinstate the recording or changes to the data you have 

made. This allows you to effectively undo the Undo, that is, return 

the sequence to its state before the Undo command was invoked. 

You can go back and forth between the Undo and Redo commands 

as many times as you like. This allows you to make A/B comparisons 

between the original and modified versions of the region. 

The Cut command removes data in the selected region and places it 

on the Clipboard. This does not remove the time region specified; 

instead, it leaves the measures blank (silent), without MIDI events. 

The type of information that is cut is determined by the Edit Filter. 

The Cut command is undoable. 

Clipboard 

Clipboard 

Track-1 | 

Track-1 | 

3 

The Copy command copies the data from the selected region and 

places it on the Clipboard. The original data is not affected at all. The 

type of information that is copied is determined by the Edit Filter. The 

Copy command is undoable. 

Clipboard 

Clipboard 

Tack =e 

en 
3 

Edit Commands 



Paste 

Measure 3 from Track-1 is 

copied into the clipboard: 

Track-2 before measure 3 is pasted: 

Track-2 after measure 3 is pasted: 

Erase 

Before measure 3 is erased: 

After measure 3 is erased: 

(The clipboard remains empty.) 

Repeat 

Edit Commands 

The Paste command inserts the contents of the Clipboard (i.e. 

whatever was most recently cut or copied) at the Start point in the 

Tracks window, replacing what was previously there. The End time 

in the Edit bar has no effect. The length of the pasted region is exactly 

that of the data in the Clipboard (including any blank space at the 

beginning and end of the region that was placed on the Clipboard). 

The types of information pasted from the Clipboard are determined 

by the Edit Filter. In addition, only the types of data selected in the 

Edit Filter are replaced; all other data is unaffected. The Paste 

command is undoable. 

Track-1 | Clipboard ay 

j 3 

Track-2 ONRASASSNSN 
8 9g 12 11 

Track-2 SSS ~ BANS 
8 9 

The Erase command works like the Cut command except that no data 

is put on the Clipboard: all data in the selected region is removed and 

the region is left blank. The types of data erased are determined by 

the Edit Filter setting. The Erase command is undoable. 

tek) Clipboard 
1 2 3 - 5 

Tack-1 i Clipboard 
1 Z 3 a fe) 

The Repeat command makes an internal copy (which does not go on 

the Clipboard) of the data in the selected region, then pastes, splices 

or merges this data repetitively immediately following the selected 

region. For example, repeating bars 1-3 three times places a copy of 

bars 1-3 in bars 4-6, 7-9, and 10-12. Regardless of the events in the 

region, the entire selected region is repeated. In the above example, 

the start and end locations in the Edit bar would be set to 1111000 
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Merge 

400 

and 4111000, respectively. The entire three bar region is repeated, 

with each repetition starting on the down beat of the following 

measure. In most cases, it is best to select entire measures or groups 

of measures to repeat; this ensures that the repetitions will line up 

correctly with measure boundaries. 

You must select a region with the Tracks window and Edit bar to use 

the Repeat command, this command will have no effect on a region 

selected within an Event Editing window. 

Using the Paste option in the Repeat dialog box, the repeated data 

replaces the data in the repeated region: the pre-existing data is 

erased. Using the Merge option in the Repeat dialog box, the 

repeated data is merged with the data in the repeated region. Using 

the Splice option in the Repeat dialog box, the repeated data moves 

the pre-existing data to a later time in order to make room for the 

data in the repeated region. The types of data repeated are 

determined by the Edit Filter setting, as are the types replaced by the 

Paste option and shifted by the Shift option. 

The Merge command combines the contents of the clipboard with 

pre-existing data in the selected tracks. The new data is inserted at 

the Start time in the Tracks window, mixing together the data already 

in the region and the new material. You need only specify a Start time 

in the Edit Bar of the Tracks window; the End time has no effect. The 

types of data merged from the Clipboard are determined by the Edit 

Filter setting. The Merge command is undoable. 

Since Performer allows unlimited tracks assigned to one channel, the 

Merge command isn’t always necessary. You should use it only when 

you are certain that data in two tracks should be merged together 

(this is often true when you create a track during editing for the 

express purpose of merging it with another track later). Once tracks 

are merged, they cannot be separated later. 

Track-1 SABA RASS SSSA 
4 5 

Track-2 LOLYLLALLAM SL ELL 
5 

Merged Track 
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Snip 

Before measure 3 is snipped: 

After measure 3 is snipped: 
(Measures 4 & 5 are shifted to 3 & 4.) 

Splice 

Before measure A is spliced: 

After measure A is spliced: 
(Measures 3 & 4 are shifted to 4 & 5.) 

Shift 

Edit Commands 

The Snip command removes data in the selected region and places it 

on the Clipboard. The time region containing the data is removed as 

well, closing up the gap between the beginning and end of the 

region: events at the End time are moved to the Start time. The types 

of data snipped are determined by the Edit Filter setting. The Snip 

command is undoable. 

Clipboard 

Clipboard 

Track-1 KXANNKANN Te 
1 2 3 - 5 

Track-1 ANANA\N\ 
1 2 

The Splice command inserts data on the Clipboard in the selected 

region, making a gap for the new data and moving pre-existing data 

later in time to make room for the new material. The event just after 

the Start time moves forward the amount of time of the region on the 

Clipboard. Thus, if a one-measure section is copied to the Clipboard 

and spliced at measure 3, the old events starting at measure 3 shift to 

measure 4. The types of data spliced from the Clipboard are 

determined by the Edit Filter setting, as are the types shifted to make 

room. The Splice command is undoable. 

Track-1 KXAANAAN) Clipboard 
{ oe 5 AHH 

Track-1? ANNNAANHT TE Clipboard 
1 2 S(A) 4 3 “E 

The Shift command moves the selected region ahead or back in time. 

The shift distance is specified by a number of measures and/or a 

quarter notes |ticks duration, entered into a dialog box. Measures are 

computed based upon the meter marking at the start point of the 

selected region. To move the region ahead, select the Advance 
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option; to move it back, select the Delay option. The region will be 

shifted in time by the amount you enter. The types of data shifted are 

determined by the Edit Filter setting. The Shift command is undoable. 

Original track 

Show/Hide 
Clipboard 

Select All 

Editing Between 
Several Tracks 
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Delayed by a half of a measure 

Choosing Show Clipboard from the Edit menu brings up a window 

which describes the contents of the Clipboard (in text). When the 

Clipboard is showing, the menu entry changes to Hide Clipboard. 

When you choose this, the Clipboard window is closed. For a 

description of the Clipboard, see the section The Clipboard earlier in 

this chapter. 

This command generally selects all items in the active window. If a 

Tracks window is active, choosing Select All will select all the tracks 

(thus highlighting all track names). If an Event List window is active, 

choosing Select All will select all events in it. 

You can use the Edit commands to move or change data from one or 

more original tracks to one or more target tracks (even in another 

file). The number of original and target tracks doesn’t have to be the 

same. If they are unequal, Performer will cycle through the target 

tracks, pasting and merging from the original to the target tracks until 

all original material is placed. Three examples are given. In the first 

there is one original track and several destination tracks. In the 

second the number of original tracks is less than the number of target 

tracks. In the third the number of original tracks is greater than the 

number of target tracks. 
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Example one: You have copied data from one track and paste or 

merge it to four destination tracks: 

= ead 

oe 
> 

If pasted or merged, the data from the one original track is placed in 

each destination track. 

Example two: You have cut information from two tracks and paste or 

merge it to five destination tracks: 

If pasted or merged, track A’s information goes to track 1, then track 

B’s goes to track 2. The process proceeds in the same manner until 

track 5: track A goes to 3, B to 4, and A to 5. 
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Example three: You have copied information from five tracks and 

paste or merge it to two destination tracks: 

Paste: 1=E, 2=D 

Merge: 1=A+C+E 

2=B+D 

If pasted, track A’s data will go to track 1, track B’s data will go to 

track 2, track C’s data will go to track 1, etc. This will result in track 1 

containing data from track E, and track 2 containing data from track 

D. If merged, track 1 will end up with data from tracks A, C, and E, 

and track 2 will have data from tracks B and D. 

Hints The following examples illustrate some creative uses of the Edit 

commands. 

Removing a Specific This works for removing one or more particular kinds of data from a 

Type of Data From a track such a mono key pressure, patch changes, etc. 

Track 
1. Choose Edit Filter from the Edit menu, or press command-F. 

2. Check only the check box for the type of data you wish to remove. 

Option-click on the check box for the type of data to be removed; 

all other check boxes will uncheck. 

3. Select the track with the data to be removed. 

Click on the track name; it will highlight. 

4. Enter the Start and End times of the region in the Edit bar. 

5. Choose Erase from the Edit menu. 
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If you want to save this information for possible future use, cut it 

instead of erasing it, and paste the information into a new and 

separate storage track. You can later merge it back into the 

original track if you like. 
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Here’s an alternate method for removing a specific kind of data using 

the Event List window: 

1. Open the Event List window for the track with the data to be 

removed. 

This is done by clicking on the track name and choosing Edit from 

the Tracks window mini-menu. 

2. Choose View Filter from the Event List window mini-menu. 

3. Check only the check box for the type of data you wish to remove. 

This will display only that type of data in the Event List window. 

Option-click on the check box for the type of data to be removed; 

all other check boxes will uncheck. 

4. Select a region of events. 

Click on the first event and drag over the rest of them. 

5. Choose Erase from the Edit menu. 

Creating an Echo Effect Here’s a method for “echoing” a track: all of the data in a track is 

with a Track copied to another track and shifted just slightly in time. The effect is 

a slight delay or echo. 

1. Activate the Tracks window for the sequence that contains the 

track to be echoed. 

Click anywhere in the Tracks window. 

2. Choose Add from the Tracks window mini-menu. 

A new track appears in the track list. 

3. Name the new track. 

Option-click on the name. A pop-up box will appear into which 

you can type the new name. 

4. Select the original track by clicking on it. 

The track name will highlight. 

5. Enter the Start and End times of the region in the Edit bar. 

Edit Commands 405 



The Repeat Command 
vs. Looping 

The Shift Command and 
Attack Times 

406 

6. Choose Copy from the Edit menu. 

The data in the selected region is placed on the Clipboard. 

7. Select the new track by clicking on it. 

The track name will highlight. 

8. Choose Paste from the Edit menu. 

The contents of the Clipboard are pasted into the new track. It 

now contains a copy of the original track. 

9. Choose Shift from the Edit menu. 

10.Select the Delay option and enter zero bars and 0/240 duration. 

This will delay the data in the new track by an eighth note. 

A few variations on the above: 

Before selecting Paste to paste the data into the new track, you could 

set the Start time in the Edit bar in the Tracks window to 240 ticks 

later. This would save you having to use the Shift command to shift 

the data by 240 ticks. You could use the Change Velocity command 

on the Region menu to decrease the velocities on the echo part to 

make it softer than the original. You could assign the echo part to 

another synthesizer or voice with a different patch or the same patch, 

panned in stereo. 

The Repeat command is useful for repeating sections of music, 

creating the same effect as looping. The advantage of using the 

Repeat command over looping is that you can make each of the 

repeats slightly different. Loops take less memory (which is an 

advantage on their side) and each copy is exactly the same. Choose 

between them according to your needs at the time. 

Repeat can also be used to create trills (by repeating just two very 

short notes) or drum rolls (by repeating just one drum note). 

You may find that certain patches on your synthesizers have quicker 

attack times than others. You can play two notes at exactly the same 

time on two different synthesizers (with two different patches) and 

hear them not sounding together: one seems to “play” first and the 
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Shift, Paste, Merge, & 
Splice Using Real Time 
and SMPTE Time 

Place data at: 

@ (M1 000) E: 
2 L__:00.00] 

Edit Commands 

second takes a longer time to come to full volume. The Shift 

command is useful for lining up attacks in situations like this one. By 

shifting a track forward or backwards just slightly (try a value of less 

than 100 ticks to start with), you can make all instruments sound as if 

they are attacking notes at the same time. You may want to leave 

some of the disparity between attack times: let your ear guide you. 

The Shift, Paste, Merge, and Splice commands allow you to specify 

Real Time, SMPTE time, or Measure/Beat/Tick time as the time unit 

used to perform the operation. Just click the radio button 

corresponding to the time unit you wish to use in the dialog box that 

appears when any of these commands are selected. 

The dialog box shown to the left appears when you are working in 

an Event Editing (Graphic, Event List, or QuickScribe notation) 

window, no events are currently selected, and you choose Paste, 

Merge, or Splice. 
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Chapter 27 Region Commands 1 

Editing During Playback 

Selecting a Region 

Transpose 

Quantize 

Some Inaccuracy is 
Good 

Almost all of the editing operations discussed in this chapter and the 

next can be done while the music is playing back so that you don’t 

have to stop and start the music to hear the result. For example, you 

could change note velocities in a track while the music is playing and 

then use the Undo/Redo command as the music continues playing to 

compare the original and modified data. 

The commands in this chapter act on the a selected region in the 

Tracks List, the Tracks Overview, or one of Performer’s three track 

edit windows. Without a selected region, the commands in this 

chapter do nothing. So be sure to learn how to select a region by 

reading chapter 25, “Selecting Regions”. It contains many powerful 

shortcuts that will speed up your work. 

The Transpose command transposes all notes in the selected region. 

For information about the Transpose command, see the chapter 

called Transpose. 

Quantizing changes the attack and release times of note events to 

make them more rhythmically precise. Attacks and releases are 

aligned with a grid, a set of locations that occur on the beat and its 

subdivisions. Quantize is useful in correcting perceived rhythmic 

inaccuracies after your sequence is recorded. It does a rhythmic 

“cleaning up” based upon your specifications. 

Quantizing is, in its simplest form, a way to make all note events in 

your sequence occur on a beat or one of its subdivisions, eliminating 

inaccuracies. But inaccuracy is far from undesirable. In fact, 

inaccuracy is what gives a piece of music its “feel”, its particular 

rhythmic profile. If you always aligned all attacks and releases with 

grid locations, your music might have a mechanical, inhuman quality 

to it. You'll find that you'll often want to preserve some of the 

rhythmic nuances of your playing. Therefore, Performer allows you 

to quantize selectively and specify the degree of quantizing you want. 

The Sensitivity and Strength options accomplish this. In addition, you 

409 



might want to shift the occurrences of the beat slightly ahead or 

behind the metronome beats in a particular track or section. The Grid 

Offset option allows you to do this. 

Basics Quantize will only alter the locations and durations of note events. All 

other data in the selected region will be unmodified. 

Quantizing a region sets up a grid of equally spaced locations. Notes 

are then moved from their original locations to the nearest grid 

location. 
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You can choose to change the attack times and/or release times of 

notes. There is an added option to leave the note durations unaltered. 

Choosing to change attack times causes them to be moved to the 

nearest grid location; release times are left unchanged. Choosing to 

change release times causes them to be moved to the nearest grid 

location; attack times are left unchanged. Both of these operations 

cause an automatic change in note durations. 

You can choose not to change the original durations. This prevents 

durations from being truncated, which may cause the notes to sound 

chopped. 
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Note that if you choose to change both the attack and release times, 

the Don’t Change Duration option is automatically disabled. This is 

due to the nature of the operation: if you change both the attack and 

release times of a note, the durations will automatically be modified. 

To Quantize To Quantize a region: 

1. Select the region you wish to quantize. 

See the section Selecting a Region at the beginning of this chapter 

for instructions selecting a region. 

2. Choose Quantize from the Region menu. 

The Quantize dialog box will appear. 

3. Select Attacks, Releases or both to be quantized. 

If you selected Attacks or Releases (not both), select the Don’t 

change durations option if you wish to keep the original durations 

the same. If you did select both Attacks and Releases, this option 

will be disabled. 
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4. Select a grid value. 

Select any note value from a 128th note to a breve (a double 

whole note). Select the dot or Tuplet option if necessary. 

5. Set Offset, Sensitivity or Strength options. 

Optional: see the descriptions below on these features. 

6. Press OK to confirm your choice, or Cancel to cancel it. 

Choosing the Grid’s The grid value is the distance between grid locations. For example, if 

Duration Value you select an eighth note as the grid value, each grid location is an 

eighth note apart. This means that the note attacks and/or releases 

will be moved to the nearest eighth note location. 

The grid is aligned such that it begins on the first beat of the first 

measure of the selected region. If a meter change occurs in the 

selected region, the grid is realigned at the point of the meter change 

to begin on the first beat of the meter change. 

Generally, you should choose a grid value that is the smallest note 

value in the region. For instance, if you are quantizing a region with 

lots of sixteenth notes and a few quarter notes, choose a grid value 

of a sixteenth note. 

The grid value can be modified with the dot and/or tuplet boxes. 

When the dot is selected, it adds one half of the selected duration to 

the grid value. For example, if the quarter note and dot are selected, 

the grid value is a dotted quarter, equivalent to three eighths. If the 

tuplet box is selected, the tuplet specification is applied to the 

selected duration. This is similar to the way the tuplet box works in 

the Step Record window. Example: you have three eighth notes in 

the time of two specified and the tuplet box is checked. 

The quantize grid will be set to triplet eighth notes. Each triplet grid 

location will have a duration of 160 ticks, which is equal to a third of 

a quarter note (480 ticks). To specify a tuplet grid value: 

1. Select the base duration you want. 

Click on one of the note symbols. 

2. Check the tuplet check box. 
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3. Enter the number of tuplets in the left text box. 

4. Enter the number of regular note values that the tuplet replaces in 

the right text box. 

Grid Offset The start of the grid may be offset from its standard position on the 

first beat of the selected region by a number of ticks. This is done by 

clicking in the check box next to Offset by n ticks and entering a 

number of ticks to offset the grid by. Positive values offset the grid 

forward in time (after the beat), negative values offset it backward 

(before the beat). 
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If you enter an offset greater than the distance (in ticks) between grid 

locations, the number will be scaled down to be less than the 

distance of the grid value. For example, if you are using a grid value 

of a quarter note (480 ticks) and you enter an offset of 500 ticks, it 

will be reduced to an offset of 20 ticks, that is 500 minus 480. Offset 

values range from -9999 to 9999. 
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Swing 

414 

The Swing option delays every other grid point to create a swing, or 

"jazz, tee. 

The Swing option defaults to 100%, which produces straight swing. 

For example, an eighth note grid produces a grid point every 240 

ticks. The swing option, at 100%, will delay every other grid point 80 

ticks to 320, which is the attack time of the third eighth note in an 

eighth note triplet. 

Eighth note 
grid points 

0% swing 
(240 ticks) 

I 1 

sas | 
100% swing 
(320 ticks) 

Every other grid point, 
shifted by swing 

A larger percentage such as 120% would delay every other grid point 

to 336 ticks, creating a “loose” swing feel. A smaller percentage such 

as 80% would advance every other grid point to 304 ticks, creating 

more of a straight swing feel. The percentage can be any value 

between 0% and 300%. 0% does nothing and is the same as 

quantizing without the swing option. 300% delays every other offbeat 

all the way to the next grid point. 
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Sensitivity 
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Each grid location has a “field of effectiveness” in which note events 

can be moved by the Quantize command. Normally, this field 

extends from one grid location halfway to the next, affecting all note 

events. The center of each field is the grid location: each field actually 

extends out in either direction from the grid location. 

100% Sensitivity 

Sensitivity is the size of this field. The default sensitivity (without the 

Sensitivity options selected) is 100%, i.e. extending continuously 

between grid locations. This field is actually split into 50% before the 

grid location and 50% after the grid location. If you select Sensitivity 

and enter a value of 50%, the quantizing field will be reduced: 

50% Sensitivity 

Note that 50% means 25% before the grid location and 25% after it 

G.e. 50% of the way to the midpoint between grid locations). Any 

notes not in the field would not be quantized. 

As illustrated, a positive Sensitivity value quantizes notes surrounding 

a grid location. In contrast, negative Sensitivity values quantize notes 

surrounding the midpoints between grid locations. 

With positive Sensitivity values, the field of effectiveness extends 

outward from the grid location. In the case of negative sensitivity, the 

field extends inward from the midpoints on either side of the grid 

location. As with positive sensitivity, the field is split on either side of 
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the midpoint. So if you enter a Sensitivity value of negative 20%, 

notes from about 41 to 50% before the grid location and about 41 to 

50% after would be moved to the grid location: 

Midpoints \ Notes Gridpoints 

| 

Original music 

Field of effectiveness Direction of quantizing 
for -20% sensitivity from midpoint 

What’s most important is the effect that different Sensitivity values 

will have on your music. To summarize: 

= Positive sensitivities clean up the down beats without 

affecting ‘swung’ or freely played notes in between. 

= Negative sensitivities catch major inaccuracies while 

retaining the music’s ‘feel’. 

To use the Sensitivity option: 

1. Check the check box next to the Sensitivity option. 

2. Enter a number between -100 and 100 for the Sensitivity value. 

Strength Another way to preserve some of the rhythmic character of your 

music while making it more rhythmically accurate is to use the 

Strength option. Without any options chosen, Quantize will move all 

note events so that they align perfectly with grid locations. Since this 

can result in an overly precise effect, you might want to leave some 

of the original inaccuracy in the passage. The Strength option does 

this by not moving the note events all the way to the grid locations. 

Rather, they are moved a percentage of the way toward the grid 

points. Use the Strength option to tighten up a passage without losing 

its “feel”. 
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Randomize 

Region Commands 1 

The Strength value specifies the amount that note events move 

toward grid locations when quantized. A Strength value of 100% (the 

default) moves them all the way to the nearest grid locations. A value 

of 0% leaves them where they are. A value of 50% moves them 

halfway to the grid locations. 

Eee Original Music 

] 

Quantize Attacks 

ae aa with 50% Strength 

Consider this example: there is a note event occurring at 10131450. 

The grid duration is a quarter note, the Strength option is selected 

and a value of 40% is entered. When Quantize is okayed, the note 

will move to 10131462. If no options were selected, it would have 

moved to 10141000, a distance of 30 ticks. A Strength value of 40% 

moved it that percentage of the distance (40% of 30 ticks = 12 ticks) 

to 10131462. 

To use the Strength option: 

1. Click in the check box next to the Strength option. 

2. Enter a number between 0 and 100 for the Strength value. 

Unlike all of the other Quantize options, which try to make notes 

more rhythmically precise, the Randomize option does just the 

opposite: it modifies the quantization randomly to make the notes as 

rhythmically imprecise as you like. 100% randomization causes note 

attacks (and/or releases) to be placed entirely randomly. A value of 

less that 100% reduces the range over which the notes will be 

randomized, and the grid point sits in the middle of the range. For 

example, if you choose a 16th note grid (a grid point every 120 ticks), 

and a randomize value of 50%, the range is 60 ticks, extending 30 

417 



ticks before and after each grid point. Thus, a note attack (and/or 

release) would be randomly placed within 30 ticks of its nearest grid 

point. 

Grid points 

50% Randomization on a 16th note grid produces a region of 30 ticks on either side of 
each grid point: notes will be placed randomly within this region around each grid point. 

Emphasis 
This sub-option causes the tendency of the randomization to be 

earlier or later within the specified range. Thus, if you wish to 

randomize the note placement within a certain range, but you wish 

to push the beat by tending to make the notes occur a little bit early, 

use a negative emphasis; use a positive emphasis if you wish them to 

tend to be laid back—that is, after the beat. A value of zero equals no 

emphasis, which causes the randomization to occur evenly within the 

range. 

Hints If you’re trying to simply line up all notes with the beat and its 

subdivisions, selecting Attacks and Don't change duration will most 

likely yield the results you want. If you select both Attacks and 

Releases, all notes will begin and end at grid locations. This may 

make them foo precise, sounding chopped, inhuman, or just wrong. 

If you are trying to get the notes of a chord to line up to make the 

attack precise, consider using the DeFlam command on the Region 

menu instead of Quantize. It will line up the attacks but will not move 

the notes to a grid location. 

If you want to quantize a region containing a mixture of sixteenth, 

eighth, and quarter notes which contains just two or three thirty- 

second notes, set the grid value to sixteenths for quantizing. You can 
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Smart Quantize 
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subsequently change the thirty-seconds back individually. Otherwise, 

if you choose too small a duration value, many notes may move to 

undesirable locations. Choose a grid value that reflects the general 

rhythmic profile of the region in its most active, complex areas. 

Performer is very capable, but it can’t read your mind; you'll find that 

there are some notes that just don’t get moved to the locations you 

want them to be. This is due to the original location of the note not 

being within the quantize field for the desired grid location. The 

quickest way to fix this is to change them individually in the Event 

Editing Window for the track they are in. 

You can use the Offset command to do some very fancy quantizing 

that may not, at first glance, even seem like quantizing. For example, 

suppose you've just entered your sequence in 4/4 time and you 

decided that you'd like to make notes that fall on the third beat of 

every measure slightly late. First, set the grid value to the whole note. 

Grid locations will occur only once per measure, on the first beat. 

Choose the Offset option and enter a value of 980 ticks. Since 960 

ticks constitute one half note, 980 ticks is 20 ticks after the third beat. 

Now choose the Sensitivity option and enter a value of 20%. This 

limits quantization to those notes near the third beat already Gf you 

didn’t use the Sensitivity option, a//notes would end up quantized to 

the third beat). You may have to experiment with the percentage. Use 

a larger percentage if some notes don’t get quantized that should; use 

a smaller percentage if some notes get quantized that shouldn’t. 

The Offset option was not designed for the mass shifting of notes in 

a region. If you want to move a section of your sequence forward or 

backward in time, use the Shift command on the Edit menu. 

Smart Quantize is especially designed for quantizing data that will be 

transferred to music notation software, such as Mark of the Unicorn’s 

Professional Composer. 

@ Performer’s built-in QuickScribe™ notation window 

does not require quantization of any kind; it will 

notate original, unquantized MIDI data. 

@ Our latest notation software package, Mosaic™, does 

not require Smart Quantize because it uses its own 

quantizing algorithms when transcribing MIDI data. 
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Smart Quantize greatly enhances the transcription of the music when 

it is transferred to programs like Professional Composer, which do 

not have sophisticated transcription algorithms like those employed 

in Performer’s QuickScribe notation window. Using a specially- 

designed, floating quantize grid, Smart Quantize quantizes both 

attacks and releases to ensure that notes are notated on the correct 

beat with the proper duration. Triplets and tuplets will be properly 

quantized, along with notes in straight time. 

Smart Quantize also provides several options to optimize the 

transcription of your musical performance. 

Smart Quantize ° 

The first set of options helps to correct errors in your Performance. 

Often when we play a keyboard or other MIDI controller, we will 

accidentally tap a key next to the one we meant to play, causing an 

extra, short note with a low velocity. Or, we may have held a chord 

and not realized that we were accidentally holding down an extra 

key, creating a long held note, barely audible, with a very low on- 

velocity. Errors like these can interfere with the accurate transcription 

of your music. 

The Filter out notes with options delete unwanted notes when you 

Smart Quantize. The durations less than option allows you to delete 

notes shorter than the duration you specify. What value you choose 
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should depend on the tempo and nature of the music, and your 

individual playing style. The velocities less than option deletes notes 

with velocities shorter than the one specified. 

The second option, Move releases of notes followed by rests to the 

nearest beat, will help prevent dotted durations followed by a short 

rest. Use this option if you do not intend for your music to have 

offbeat releases. For example, if you tend to release notes a little bit 

early when you play, the notes may be transcribed shorter than they 

should, followed by a short rest. This option recognizes premature 

and late releases and notates them properly with their full duration. 

Use this option to reduce the number of rests, especially if you are 

transcribing music with standard durations and very few rests. Don’t 

use this option if your music contains precise, mid-beat releases that 

you want transcribed precisely. 

Smart Quantize tends to close gaps between attacks and releases. The 

Swallow rests options allow you to adjust the size of gaps that will be 

closed. There is no hard and fast rule for choosing these options. In 

general, if you don’t want lots of short rests in the transcription, use 

the /arger options. If you want a more precise transcription of your 

performance, which may contain dotted durations followed by rests 

and so on, use the smaller options. 

To use Smart Quantize: 

1. Select the region that contains the music you will transcribe. 

If you are transcribing an entire sequence, select all the tracks in 

the tracks window and set the Edit Start and End times in the Edit 

Bar to include the entire sequence. 

2. Choose Smart Quantize from the Region menu. 

The Smart Quantize dialog box will appear. 

3. Set the Filter notes, Move releases, and Swallow rests options. 

These options are discussed in detail above. 

4. Click OK to confirm your choice or Cancel to withdraw the 

command. 
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Input Quantize 

Opening the Input 
Quantize Window 

Turning Input Quantize 
On and Off 
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Because Smart Quantize does so many things at once, it may take 

longer than regular quantizing. Expect to wait for a moment if you 

have quantized a large region. 

The Input Quantize feature quantizes notes during recording in the 

same fashion as a standard drum machine. Notes get quantized 

immediately as they are being received and appear quantized in the 

track afterwards. If you are loop recording, the notes will play back 

quantized the next time through the loop. 

To open the Input Quantize window, choose Input Quantize from 

the Windows menu: 

This is a standard Performer window that can be left open while you 

play back, record, edit, and use Performer’s other windows and 

features. This allows you to make changes to Input Quantize during 

recording. 

To turn on Input Quantize, check the Enable input quantization box. 

When Input Quantize is turned on, all incoming notes are quantized 

according to the options shown in the Input Quantize window. To 

turn off Input Quantize, simply uncheck the box. 

Region Commands 1 



Setting the Input 
Quantize Options 

Changing Options 
During Recording 

Loop Recording 

Humanize 
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Input Quantize offers the same type of quantization as the regular 

Quantize command in the Region menu. The only differences are that 

1) the quantization occurs in real time as data is being recorded, and 

2) the options for each type of input quantization are set in the Input 

Quantize window rather than the Quantize dialog box. But Input 

Quantize options behave the same way as their counterparts in the 

Region menu. 

For more information about the Input Quantize options, see the 

section earlier in this chapter regarding the OQuantize command in the 

Region menu. 

Any option in the Input Quantize window can be changed at any 

time, even during recording. For example, you can record several 

bars with quantization turned on and then turn it off on the fly as you 

record the next several bars. As another example, you might check 

the triplet check box while recording triplets and uncheck it as you 

switch back to straight time. 

For information about how to use input quantize while loop 

recording, see the looping chapter. 

The Humanize command lets you add a “random” element—or 

“humanized” feel—to your music. With this command, you can 

randomize any combination of the following elements of your music: 

= Note placement 

mw Note durations 

mw Velocities 

m Pitches 

= Tempo 

In addition, you can create a unique blend of these randomization 

elements and save it as a randomization style, which you can recall 

and use at any time. You can use the Humanize command to create 

arpeggiation effects, hi-hat (or other percussion instrument) grooves, 

and other dramatic musical effects. 
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rs Humanize 

Mixolydian wild Thang 

The Humanize command combines the randomize options of the 

following commands: Quantize, Change Duration, Change Velocity, 

and Scale Tempo. And it adds the randomization of note pitches. 

For even further control over the feel of your music, be sure to check 

out chapter 30, “Groove Quantize’”. 

Choosing What to Each type of musical element is a check box option in the Humanize 

Humanize dialog box. To randomize that element, check its box. If you don’t 

want to randomize it, uncheck it. For example, if you want to 

randomize velocities, but not note placement, uncheck note 

placement. 

Humanize Sub-options Each element has sub-options which affect how it randomizes. These 

sub-options are discussed briefly below. All of the elements have an 

Emphasis sub-option, which is discussed in a separate section. The 

last section explains how to save and recall Humanize styles. 
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Durations 

Velocities 

Pitches 
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The Note Placement sub-option randomizes the attack times of notes 

within a range (in ticks) of the note’s current location. You can 

specify the range as a number of ticks, or as a percentage of the 

note’s duration, in which case longer notes have a larger range and 

shorter notes have a smaller range. 

The Durations sub-option randomizes durations within a range of the 

current duration, which you specify in the box provided. This range 

can be specified as a absolute number of ticks, or by a percentage of 

the current duration. 

The Velocities sub-option lets you choose between on (attack) or off 

(release) velocities. In addition, it lets you randomize the velocity 

within a range of its current value, or within an absolute range. 

Randomizing within a range of its current value lets you preserve the 

overall contour of the velocities, while still mixing them up a little bit. 

Randomizing within an absolute range lets you limit them to a certain 

range of values. 

The pitches sub-option allows you to randomize the pitch of each 

note within the region. You can randomize to: 

gm Any pitch 

m= A range of pitches 

m Certain pitches within a range 

In addition, you can assign weight to each pitch within a range so 

that it is used more or less often during the randomization process. 

For example, if you are creating a humanize style that generates a 

hi-hat part, you can assign more weight to the closed hi-hat pitch and 

less weight to the open hi-hat pitch so that the result is mostly closed 

hit with an occasional open one. 
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Select what pitches can 
be used here. 

lf desired, choose a 

scale in which to 

randomize here. 

Customize the scale by 
creating your own with 
the Create Scale button. 

If you like the random 
pitch map you created, 
and you'll want to use it 
again, name it and save 
it here. 
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The Set Random Pitch Map button lets you determine what pitches 

notes can be randomized to: 

Random Pitch Map. 

Choose what pitches 
notes can be randomized 
to and assign them weight 
here in the random pitch 
map. Weight can have a 
value between 0 (not used 
at all) and 99 (used a lot). 

Recall saved random 
pitch maps by select- 
ing them from this pop- 

Cc Mixoly dian up menu. 

The Create Scale button 
The create scale button opens the create scale dialog box. For 

information about this dialog, see “Creating a Custom Scale” on 

page 484. 

Saving, Recalling, and Deleting a Random Pitch Map 
To Save a Random Pitch Map: 

1. Set up the pitch map as desired. 

2. Type in a name for the Random Pitch Map. 

3. Click Save. 

To recall a random pitch map, select its name from the pop-up menu. 

To delete a random pitch map: 

1. Select the pitch map you wish to delete from the pop-up menu. 

Region Commands 1 



Tempos 

Emphasis 
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2. Click Delete. 

To rename a pitch map: 

1. Select it from the pop-up menu. 

2. Type in the new name. 

3. Click Save. 

4. Delete the original one. 

The Tempos sub-option randomizes existing tempos within the 

selected region. Note that it does not generate new tempo events. (To 

do so, use the Change Tempo command in the Change menu.) Note 

that this option only affects tempo events that already exist in the 

Conductor track. If the region you select has no tempo events in it, 

this option will have no effect. If so, use the Change Tempo 

command in the Change menu to generate tempo events. 

By __% of current value 
This option randomizes the tempo of each selected tempo event 

within a range that is expressed as a percentage of the tempo value. 

For example, if the tempo is 100 bpm, and you enter 10 percent, the 

tempo will be randomized within a range between 90 to 110 bpm 

(+10 bpm). 

By+ bpm 
This option randomizes the tempo of each selected tempo event 

within a range of beats per minute. 

Each Humanize element has an emphasis sub-option, which can be 

any value between -9 and +9. The emphasis value causes the 

tendency of the randomization to be higher or lower within the 

specified range. Thus, if you wish to randomize within a certain 

range, but you wish values to tend to be higher, use a positive 

emphasis; use a negative emphasis if you wish them to tend to be 

towards the lower end of the range. A value of zero equals no 

emphasis, which causes the randomization to occur evenly within the 

range. 
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Saving, Recalling, To Save a Humanize style: 

Deleting, and Renaming 
a Humanize Style 1. Set up the Humanize style as desired. 

2. Type in a name for the style. 

3. Click Save. 

To recall a Humanize style, select its name from the pop-up menu. 

To delete a Humanize style: 

1. Select the pitch map you wish to delete from the pop-up menu. 

2. Click Delete. 

To rename a Humanize style: 

1. Select it from the pop-up menu. 

2. Type in the new name. 

3. Click Save. 

4. Delete the original one. 

DeFlam The DeFlam command looks for groups of note that are very close 

together. When such a group is found, the average attack time of the 

group of notes is computed. All notes in the group are moved such 

that their attack times are aligned exactly to the average time. 

The group of notes that is deflammed is determined by the tick value 

you specify. This creates a “window” of effectiveness. Groups of 

notes within that window will be deflammed. 
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Basics When chords are played in real time, the attacks of individual notes 

are often splayed as in the example below, which shows two four- 

note chords: 

DeFlam is useful for consolidating the attacks of the notes in such 

chords. The following is the result of using DeFlam with a tick value 

of 20 on the above passage: 

The quarter notes are now grouped into two precise chords. 

DeFlam averages the attack times of the groups of notes; there is no 

grid involved as there is with the Quantize command. In the above 

example, the resulting attack time of each chord is the average of the 

attack times of the four original notes. The durations of the notes are 

left unchanged. 

DeFlam attempts to detect grace notes and rolled chords and, if 

found, will leave them as such. 
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Using DeFlam To use DeFlam: 

1. Select the region you wish to modify. 

See Selecting a region at the beginning of this section. The region 

should include only the notes to be deflammed. 

2. Choose DeFlam from the Region menu. 

A dialog box appears. 

DefFlam | 

3. Enter a tick value. 

The tick value sets the “window” for the command. Notes within 

this window will be deflammed. 

4. Press the OK button to confirm your choice, or the Cancel button 

to cancel it. 

If DeFlam leaves some notes out, try using a larger tick value; if it 

includes too many notes, try decreasing the tick value. (Remember, 

you can Undo and Redo the DeFlam command.) The correct tick 

value depends greatly on the particular passage you are working 

with. It may take several attempts to determine the correct value. 

Change Velocity Change Velocity is a powerful command that lets you modify the 

velocities of all notes in a region. You can remove irregularities, make 

passages louder or softer and create crescendos, diminuendos and 

other similar effects. Note that not all MIDI keyboards and sound 

modules respond to velocity data, and those that do may need to be 

set up to respond correctly to this information. Consult your owner’s 

manuals for details. 
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Using Change Velocity To use change velocity: 

1. Select the region you wish to modify. 

See Selecting a region at the beginning of this section. 

2. Choose Change Velocity from the Region menu. 

A dialog box appears. 

Change U 

3. Choose between modifying on (attack) velocities or off (release) 

velocities. 

4. Choose the desired option to alter the velocities. 

Select from the Set all velocities to ___, Add __ to all velocities, etc. 

options. Click on the radio button next to the option. 

5. Enter the values required by the option. 

Click in the box and type in the value. If there are additional 

values to enter, use the Tab key to highlight each successive box 

or click in each box directly and enter or edit the value. 

6. Press the OK button to confirm your choice, or the Cancel button 
to cancel it. 

You can Undo/Redo the Change Velocity command. 
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On Velocities or Off 
Velocities 

Set all velocities to __ 

Add _ __toall velocities 

Limit to a maximum of 

Limit to a minimum of 

432 

There are a number of options in the Change Velocity dialog box. 

Each one allows you to modify velocity values in a different way. 

Don’t let this complexity confuse you; once you select an option, you 

can ignore all information pertaining to other options. 

On velocities control the speed at which a note is attacked. This 

affects the note’s loudness most dramatically, but on velocities can 

also affect other aspects of the note event such as its timbre (e.g. the 

harder the note is struck, the brighter it sounds). Off velocities control 

the speed of the release of the note and are sometimes used to 

control its decay rate. At this time, very few synthesizers utilize off 

velocity information. 

The Change Velocity command can be applied to either on or off 

velocities: choose the type you wish at the top of the dialog box. The 

default setting changes the on velocities. 

This option sets all velocities in the selected region to a single value. 

Enter a value between 1 and 127. A result of this option is that all note 

events in the region will be played back at a constant volume. 

This option adds the value you enter to all velocities in the selected 

region. The value must be in the range -127 to 127. Velocities that end 

up less than O or greater than 127 will be set to zero or 127, 

respectively. A result of this option is a uniform increase or decrease 

in volume of all notes in the region, within the zero to 127 range. 

This option modifies all velocities in the selected region that have a 

velocity greater than the value you enter, by changing them to that 

value. Enter a value between 1 and 127. This option imposes a 

maximum volume level on all notes in the region. You can use it to 

change the velocities of notes that “stick out”. 

This option modifies all velocities in the selected region that have a 

velocity less than the value you enter, by changing them to that value. 

Enter a value between 1 and 127. A result of this option is that there 

will be a minimum volume level for all notes in the region. You can 

use this option to assure that notes that may be inaudible have 

sufficient velocity to be heard. 
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Change to__ % of 
current value 

Change smoothly from 

Region Commands 1 

This option scales all velocities by the percentage value you enter. 

Percentage values must be between 1 and 999. For example, if all 

notes in the region have a velocity of 120 and you enter a percentage 

value of 50%, the velocities will be set to 60. Thus, to halve velocities, 

use a value of 50%. To double them, use 200%. Velocities that end up 

less than O or greater than 127 will be set to zero or 127, respectively. 

Scaling by a percentage may give you better results than using the 

Add ___ to all velocities option above since the original velocity 

contours are preserved. Try both to discover which gives you the 

results you want. 

This option has two basic sub-options: ___% to___% of current value 

and __— to___.. Each gives you a different way to specify the smooth 

velocity changes. The first changes by percentages, creating a smooth 

velocity change for notes in the selected region while preserving 

some of the original velocity characteristics (most notably the 

accents); the second creates a smooth change with no fluctuations. 

You can specify a curvature for the change, which determines its 

contour. 

__%to___% of current Value: This sub-option changes velocities 

similarly to the Change to ___% of current value option described 

above. The difference is that the percentage value changes from the 

first to the second entered value: the first value applies to the 

beginning of the region, the second to the end. Enter a value from 1 

to 999 in each box. The curvature (see below) controls the contour of 

the change. 

____ to ____: This sub-option assigns the first entered value to the first 

note velocity in the selected region and the second entered value to 

the last note velocity in the region. All other velocities are calculated 

to make a smooth transition between the first and last ones. The 

curvature (see below) controls the contour of the change over the 

region. 

Curvature: This sub-option controls the contour of the smooth 

change. With a curvature of zero, the change is linear from the first to 

the second entered value. As you increase the value positively (with 

values from 1 to 99), more of the change will take place towards the 
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end of the region. As you increase the value negatively (with values 

from -1 to -99), more of the change will take place towards the 

beginning of the region. 

Here are a few examples to clarify this option: 

Change smoothly from 1 to 90, curvature O. This results in a linear 

increase. One effect of this is a gradual, even crescendo. 

Change smoothly from 10 to 90, curvature -50. This results in a 

pronounced upward curve with most of the changes happening at 

the beginning. One effect of this is a crescendo that occurs more 

rapidly at the beginning. 

Change smoothly from 96 to 5, curvature 45. This results in a 

downward curve which is more pronounced at its end, e.g. a 

diminuendo that speeds up toward its end. 
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Change smoothly from 100% to 1%, curvature O. When applied to a 

region in which there are several notes accented, this results in a 

downward “curve”, which retains the accent structure of the original. 
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Original velocities Changed smoothly from 100% to 1% with 0 curvature 

The velocity values assigned to notes by this option are calculated 

based on the distance of the note from the beginning or end of the 

selected region. If the first note in the region is after the start time, for 

instance, it will be assigned a velocity value somewhere between the 

values entered. Notes in a chord (with simultaneous attacks) are 

assigned the same velocity. If a specific change sounds too abrupt, it 

is probably due to the position of the note in the region. For instance, 

if notes occur at irregular times (e.g. bunched together followed by a 

sparse section), velocities will be assigned on the basis of note 

placement. The result may not seem smooth on a per-note basis. 

Randomize The randomize option allows you to randomize the velocities within 

a range of the current value, which you specify in the box provided. 

The emphasis sub-option causes the tendency of the randomization 

to be higher or lower within the specified range. Thus, if you wish to 

randomize the velocities within a certain range, but you wish them to 

tend to be higher, use a positive emphasis; use a negative emphasis 

if you wish them to tend to be towards the lower end of the range. A 

value of zero equals no emphasis, which causes the randomization to 

occur evenly within the range. 

Note that the randomize option is a check box, which means that it 

can be selected together with one of the radio button options above. 

This allows you to randomize at the same time as executing one of 

the other Change Velocity options. 

The Effect of Velocity Is Synthesizers vary widely in their response to velocity information. 

Synthesizer-dependent Some do not respond at all to any velocity information; most do not 

respond to off velocities. Some patches sound very different when 

large on velocity values are used. Some patches do not respond at all 

to velocity information, even when the synthesizer as a whole does. 
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Most often, you can be assured that if your synthesizer does respond 

to velocity information, you can control the loudness of note events. 

You should be able to create effective crescendos and diminuendos. 

This will work well for short-range dynamic effects. For longer effects 

(a 30 second fade, for instance), you might notice a “staircase” effect, 

i.e. discrete changes in the volume level. 

Some synthesizers define one of the MIDI controllers as the volume 

control. If so, you might be able to use the Create Continuous Data 

command to create smooth volume changes with a controller. Some 

synthesizers have only a few discrete volume levels, making it hard 

to create smooth changes. Consult the Hints in the Event List Window 

section for details about determining the limits of the controller 

values on your instrument. 

It is also possible with some synthesizers to control volume directly 

from an assignable controller. A patch may use the breath controller 

to control its volume, for instance. By sending this controller data 

through Performer, you can control volume changes. 

There is no single solution for making volume changes effectively 

with every patch on every instrument. You must find the best way for 

each given situation and use the appropriate command (Change 

Velocity or Create Continuous Data) to create the kind of volume 

changes you want. 

The Change Duration command modifies the duration of all notes in 

the selected region without changing the placement of attack times. 

This means that the amount of time a note is “on” or sounding can be 

changed without affecting its actual rhythmic placement in relation to 

other notes and events. The Change Duration command is useful for 

changing the articulation or space between notes. You can make note 

events sound connected or separate in relation to each other, for 

example. It also provides some useful utility functions. 

Duration is the length of a note, i.e. the time between its attack and 

release. Durations are specified in quarter notes and ticks (e.g. a half 

note would be 21000 or two quarter notes). A note must have a 

duration of at least one tick (01001). 
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A note’s duration may be misleading in some cases: what you see 

might not be what you hear. The actual duration of a note event is 

dependent upon the synthesizer and patch used. The attack and 

release sent by Performer are equivalent to manually pressing and 

releasing a key on the synthesizer. Also, some synthesizers have a 

sustain pedal that can be used to hold notes, extending the effective 

duration of notes far beyond the time when the release has been sent 

to the synthesizer. 

Using Change Duration To use Change Duration: 

1. Select the region you wish to modify. 

See the Selecting a region section above. 

2. Choose Change Duration from the Region menu. 

A dialog box appears. 

Change Our 

3. Choose the option you want by clicking in the appropriate radio 
button. 

You can only choose one option. 
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4. Enter the value required by the option. 

Click on the box and type in the value. 

5. Press OK to confirm your choices or Cancel to abort the command. 

You can Undo and Redo the Change Duration command. 

The following options are available: 

All durations in the selected region will be changed to the entered 

value. The value entered must be between 01001 and 99991999. 

The value entered will be added to all durations in the selected 

region. The value entered must be between 01001 and 99991999. 

The value entered will be subtracted from all durations in the selected 

region. The value range is 01001 and 99991999. Notes which would 

have a duration of less than one tick after the subtraction are given a 

duration of one tick. 

Any notes in the selected region which have a duration greater than 

the value entered will be assigned to that value. The value entered 

must be between 01001 and 99991999. 

Any notes in the selected region which have a duration less than the 

value entered will be assigned to that value. The value entered must 

be between 01001 and 99991999. 

The durations of notes in the selected region are scaled by the 

entered percentage value. The relative lengths of the notes are 

preserved and their overall length is modified. The percentage value 

entered must be between 1 and 999. To halve durations, enter a 

percentage value of 50%; to double durations, use 200%. Using this 

option may yield more of the results you want than using the Add __ 

to all option; durations are scaled proportionally instead of uniformly 

lengthened. Try both to see which you like best. 

The release of each note in the selected region is modified to occur 

just before the attack of the nearest note following it in time. The 

duration of the note may increase or diminish depending on when 

the next note occurs. If the next note occurs before the release of the 

current one, the release of the current note will be moved back in 
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Extend releases to the 
closest attack 

Extend Releases sub- 
options 

Region Commands 1 

time, making the duration shorter. If the next note occurs after the 

release of the current one, the release of the current one will be 

moved forward in time, making the duration longer. If the note 

release is after the end of the selected region, the note is left 

unmodified. This option creates a legato effect, where the notes 

follow each other smoothly and without a gap. 

Move Releases to Closest Attack 

Before 

After 

The duration of each note in the selected region is extended until it 

ends at the same time as the next note begins. This is very similar to 

the Move releases to the closest attack option but the durations of all 

notes are guaranteed to increase since the release is always moved 

forward in time. Any notes which end after the last note in the 

selected region begins are left unmodified. 

This option creates a legato effect, where the notes follow each other 

smoothly and without a gap. 

Extend Releases to closest Attack 

RE ae 

ie: ee 

PRR eae Se 
After : 

Use these sub-options to extend releases and still preserve rests in a 

region. If both sub-options are checked, each note in the region is 

analyzed and the option that results in the smallest duration increase 

is used. Try using these options after quantizing attacks and releases 
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to improve the notational display of the notes. Doing so adjusts the 

durations of notes that were not played in a legato style. For best 

results, experiment with different values. A good setting to start with 

is 100%. 

Randomize The randomize option allows you to randomize durations within a 
range of the current duration, which you specify in the box provided. 

This range can be specified as a absolute number of ticks, or by a 

percentage of the current duration. The emphasis sub-option causes 

the tendency of the randomization to be higher or lower within the 

specified range. Thus, if you wish to randomize the durations within 

a certain range, but you wish them to tend to be longer, use a positive 

emphasis; use a negative emphasis if you wish them to tend to be 

shorter. A value of zero equals no emphasis, which causes the 

randomization to occur evenly within the range. 

Note that the randomize option is a check box, which means that it 

can be selected together with one of the radio button options above. 

This allows you to randomize at the same time as executing one of 

the other Change Duration options. 

Hints Some drum machines cannot receive dense bursts of MIDI data; they 

will often miss data altogether, causing drop-outs and other 

perplexing problems. Since the durations of drum machine events 

tend to be very short, the note releases tend to follow the attacks very 

quickly resulting in a very high data density. A problem also arises 

with Step Record: the release for each note is sent immediately before 

the attack of the next note. One way to improve the situation is to 

delay the note releases (most drum machines ignore these anyway 

since their note events have such short decays) by making the note 

durations longer. Use the Change Duration command to set the 

durations of these note events to a value somewhere around 10 to 20 

ticks. 

The Change Duration command is very good for adjusting the 

articulation of note events. Rendering a passage legato or staccato is 

simple: for a legato effect Ceach note releasing just before the next 

one is attacked): 

1. Select the region. 

2. Choose Change Duration from the Region menu. 
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3. Click on the Setal/to___— option. 

4. Enter a value of 1 tick (01001) and press OK. 

This insures that durations are uniform for the next step. 

5. Choose Change Duration from the Region menu. 

6. Choose the Extend releases to the next attack option and press the 

OK button. 

This is useful for removing any rests or gaps between notes. 

For a staccato effect (each note releasing well before the next, giving 

the passage a rhythmically sharp, incisive character): 

1. Select the region. 

2. Choose Change Duration from the Region menu. 

3. Click on the Change to___% of current value option. 

4. Enter a value of 50% and press the OK button. 

If you enter a part in Step Record, all durations will be as long as 

specified, rendering a legato effect. You can use the Change Duration 

command to add the articulation you want to these parts. 

The Split Notes command lets you selectively cut or copy notes in the 

selected region. The selection is based upon pitch, velocity and/or 

duration. This means that only notes with specific pitches, ranges, 

durations and velocities from the selected region are cut or copied. 

For example, all notes between A3 and C#3 with velocities greater 

than 100 and with durations above a half note can be extracted from 

a region. Here are some additional things you can do with Split 

Notes: 

m Use an on-screen graphic keyboard to specify the pitches 

of notes you wish to split. This keyboard allows you to 

pick a non-contiguous range of pitches for splitting. 

= Automatically Paste or Merge the split notes to a pre- 

existing track. 
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= Automatically create a new track and Paste the split notes 

to it. 

= Automatically create a set of new tracks and Paste the split 

notes to each track according to their pitch. 

Split Notes can be used to split a drum track into separate tracks, 

extract or double a melody line, separate one keyboard part into two 

to segregate right and left hand activity, pick out and double accented 

or long tones, and much more. See the hints at the end of this section 

for some unusual effects using the Split Notes command. 

Basics Split Notes is a highly specialized version of the Cut and Copy 

commands on the Edit menu. Only notes in the specified region and 

with specific properties are affected, other events are not affected. 

Each note is tested to see if it meets the requirements you specify, 

including velocity, pitch, and duration. They are then placed ina 

destination you select, such as the Clipboard or a new track. If cut, 

they are removed from the selected region. 

@ The Split Notes dialog box remembers the settings you 

last chose. 

To use Split Notes: 

1. Select the region you wish to modify. 

See the Selecting a region section earlier in this chapter. 

2. Choose Split Notes from the Region menu. 

A dialog box appears. 
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split Notes | 

Choose the Cut or Copy option at the top. 

This determines whether notes are cut (removed from the 

originally selected region) or copied by the Split Notes command. 

Choose a destination for the notes to be split. 

You have several choices here. Select the Clipboard option to 

place notes on the Clipboard (for the purpose of pasting 

afterwards). Select the One track option and select a track name 

from the pop-up menu to send the notes to one existing track. 

Select the One new track option and type in a name or use the 

default name to send the notes to a new track that will be added 

to the bottom of your tracks list. Select the Separate tracks by pitch 

option to separate out the notes by pitch and place them into new, 

separate tracks. Each new track will contain the pitch name in 

parentheses after the track name. The track name used for this 

option can be entered in the One new track option text entry box 

above. This last option is ideal for splitting up a drum track into 

separate tracks. 

Choose whether you would like the split notes to be pasted at their 

destination, which replaces what is already there, or merged 

together with what is already there. 
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6. Choose one of the five pitch selection options. 

These options are discussed in detail in the next few sections. 

7. Enter the data required by the option. 

Type or play in the required values. 

8. Click on the check box to the left of any desired options. 

You can select a combination of pitch, velocity and duration 

options. 

9. Press OK to confirm your choices or Cancel to cancel. 

You can Undo and Redo the Split Notes command. 

You can enter pitch and velocity values directly from your MIDI 

keyboard. The note you play will be entered directly into the value 

box which contains the flashing text cursor or is highlighted. 

If you choose the Cut option, the Split Notes command will place the 

selected notes on the Clipboard and remove them from the selected 

region. If you choose the Copy option, the Split Notes command will 

place the selected notes on the Clipboard without removing them 

from the selected region. 

All notes will be cut or copied unless excluded by velocity or 

duration selections. Use this mode when you wish to cut or copy 

notes based solely on velocity or duration criteria. 

All notes between the two entered pitch values will be cut or copied. 

The pitch range is inclusive Cit includes the two entered pitch values 

and all notes between them). You must enter a pitch in each box for 

this option. 

The specified number of notes from the top of each chord are cut or 

copied. A chord is defined as two or more notes which have the same 

attack times. If single notes are encountered (i.e. not in chords), they 

alone are copied to the Clipboard. It is useful to use the DeFlam 

command on the Region menu to make sure that attack times of all 

chords line up before using this option. Enter the number of notes to 

be cut or copied from the top of each chord in the box for this option. 
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This option is similar to Top notes except that the notes are cut or 

copied from the bottom of each chord. 

Click keys on the keyboard to select and deselect specific pitches. 

Click Clear Keyboard to clear the currently selected pitches on the 

keyboard. Use the scroll bar and scroll arrows to select pitches that 

are above or below those pitches which are currently displayed. You 

can also play keys on your MIDI keyboard (or other controller) to 

select and deselect specific pitches. 

@ The Select notes keyboard remembers the selected 

notes even when those notes are scrolled to the left or 

right and are not displaying. When you open the 

dialog and want to select some pitches on the 

keyboard and are not sure if there are selected notes 

above or below the pitches that are currently 

displayed, click Clear Keyboard to be sure that notes 

that are not displayed are also not selected. 

The following are velocity and duration options that can be selected 

in addition to pitch options. 

Notes in the selected region with durations within the specified range 

are cut or copied. You must enter two durations in the boxes from 

01001 to 99991999. The duration range is inclusive Gt includes the 

two entered duration values and all those between them). 

This option, when selected, allows only notes with the specified 

velocity range to be cut or copied from the selected region. You must 

enter two velocities (between 1 and 127) in the two boxes. The 

velocity range is inclusive Cit includes the two entered values and all 

those between them). 

This mode is similar to the On velocities mode except that notes with 

off velocities in the specified range are cut or copied. 

The Split Notes command by itself is not always completely useful: it 

can be used in conjunction with other region commands and 

operations to fully accomplish an editing task. We therefore have 

included some effective ways to use the Split Notes command as part 

of more complex operations. 
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Splitting up a drum part You can use the Separate tracks by pitch option in combination with 

into separate tracks the Select notes option to quickly explode tracks such as drum parts 
into separate tracks so that each pitch can be treated uniquely. This 

is great for being able to shift, quantize and otherwise edit a certain 

percussion instrument without affecting others. 

Using a Temporary You can process data independently that is cut or copied with the 

Track Split Notes by pasting it into another track. You can perform various 

operations on the data in the temporary track (transpose, velocity 

editing, etc.), then merge it back into the original track and delete the 

extra track. 

Extracting a Lead Line Extracting the lead line from a passage (perhaps from block chords 

where the top notes of each chord form a melody) can be easily done 

with the Split Notes command. After the lead line is separated from 

the chords, it can be modified (doubled, accented or otherwise 

enhanced) in an extra track. 

To extract the lead line: 

1. Select the region to extract the lead line from. 

See chapter 25, “Selecting Regions” for more information. 

2. Choose Split Notes from the Region menu. 

The dialog box appears. 

3. Choose the Cut option. 

This will remove the top note of each chord and place it on the 

Clipboard. 

4. Choose the “One new track” option and type in a name for the new 

track to be created. 

5. Click the radio button next to the Top ___ notes option. 

6. Enter a value of 1 in the box for the option. 

This specifies that only the top note of each chord will be cut or 

copied. 

7. Press OK to confirm your selections. 
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The new track now contains the lead line. You can now use 

commands from the Region menu to modify the lead line. 

Once you have the lead line separated out, you can change it in 

useful ways. Two suggested enhancements are doubling it an octave 

higher and increasing its velocity values. After you have made the 

modifications, you can merge the enhanced lead line back with the 

original material. 

1. Extract the lead line as described above. 

2. Select the extra track which contains only the lead line. 

3. Enter Start and End times in the Edit bar of the Tracks window that 

will contain all notes in the lead line. 

These should be the same ones used with Split Notes above. 

4. Choose a command from the Regions menu. 

To double the lead line an octave higher, choose Transpose. To 

give the lead line higher velocity values, choose Change Velocity. 

5. Choose the options and values you want for the command and 

Press OK. 

For Transpose, enter an octave interval (C3 to C4). For Change 

Velocity, choose the Add ___ to all option and enter a value to 

increase the velocities by (try a value between 10 and 30). 

6. Choose Copy from the Edit menu. 

This puts the modified lead line on the Clipboard. 

7. Select the original track from which you extracted the lead line. 

Click on the track name to select the track. 

8. Choose Merge from the Edit menu. 

The modified lead line is now part of the original passage. 

9. Select the extra track containing only the lead line by clicking on it. 
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10. Choose Delete from the Tracks window mini-menu. 

This gets rid of the extra track. 

The enhancement is now complete. 

A variation on the operation to double the lead line an octave higher 

is to double the bass line an octave lower. Use the Bottom ___ notes 

option and transpose it down an octave with the Transpose 

command. 

Some variations on the operation to increase the velocity values of 

the lead line are as follows: 

Make the notes of the chords softer (by decreasing their velocities) 

instead of the making the lead line louder. This would involve 

modifying the notes of the chords after you extracted the lead line 

from them and merging the (unaltered) lead line back with the 

modified chords. 

Use the Change to % of current Value option in the Change 

Velocity dialog box rather than adding a constant value to the lead 

line. This better preserves the dynamic contour of the lead line. 

Leave the lead line on a separate track and play it back through 

another synthesizer as well as on the synthesizer playing back the 

chords. This highlights the lead line through timbral or tone color 

means. 

This procedure allows you to split out only those notes which have a 

higher velocity in order to accent them. 

1. Select the region containing the lead line. 

See Selecting a region above. 

2. Choose Split Notes from the Region menu. 

The dialog box appears. 

3. Choose the Copy option. 

This will place the selected notes on the Clipboard. 
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4. Choose the All notes option. 

Click in the radio button next to the option. 

5. Choose the On velocities option. 

Enter a range of values that will separate out accented notes in the 

region. 

6. Press OK to confirm your choice or Cancel to cancel. 

7. Paste the Clipboard into a new track. 

See the chapters on Edit Commands and The Tracks Window for 

help with this. 

At this point, you can use other Region commands (such as 

Transpose) to enhance the accented notes. Alternatively, you can 

simply assign the track with only the accented notes to be played 

back on a separate channel by another synthesizer. 

Sometimes, it is useful to be able to treat the left-hand and right-hand 

parts of a keyboard track separately. Performer does this 

automatically in the QuickScribe notation window. If you want, you 

can do it manually by following the earlier procedure for extracting a 

lead line but use the Notes with pitches between ___ and ___ option. 

The pitches you enter should correspond with the range of either the 

right or left hand. Since this range is rarely consistent, you will 

probably have to organize your sequence into sections according to 

one hand’s pitch range and use Split Notes on each section. You can 

then add a new track and paste the notes you've cut into it. 
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Chapter 28 Region Commands 2 

Editing During Playback 

Selecting a Region 

The Continuous 
Data Commands 

Almost all of the editing operations discussed in this chapter and the 

next can be done while the music is playing back so that you don’t 

have to stop and start the music to hear the result. For example, you 

could change note velocities in a track while the music is playing and 

then use the Undo/Redo command as the music continues playing to 

compare the original and modified data. 

The commands in this chapter act on the a selected region in the 

Tracks List, the Tracks Overview, or one of Performer’s three track 

edit windows. Without a selected region, the commands in this 

chapter do nothing. So be sure to learn how to select a region by 

reading chapter 25, “Selecting Regions”. It contains many powerful 

shortcuts that will speed up your work. 

Continuous data is data which changes smoothly over time. The 

continuous MIDI data types include pitch bend, mono and poly key 

pressure and controller information. These types of data are output 

rather quickly, resulting in a large amount of data. Continuous data 

events are closely spaced, each specifying a slightly different value 

for the parameter which is changing. For instance, when you move a 

pitch wheel, a different pitch bend value might be sent every 20 ticks, 

resulting in 120 continuous data events per quarter note. 

Continuous data is not really continuous at all: it is approximated by 

large numbers of events, each of which contain a small value change. 

When played back, they create a change that seems smooth and 

continuous. The closer together in time successive values are, the 

smoother the change will be. If the values are too close together, 

delays can occur due to the baud rate (data transfer speed) limit of 

MIDI transmission. 

There are 16,384 different pitch bend values and 128 different 

controller and aftertouch values. Some synthesizers do not respond to 

every different pitch bend value: several successive values may 

produce the same effect. The response to different controller values 

may also be hard to hear. These facts may influence your decision 
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about how many continuous data events to store. Performer gives 

you the option to decrease or increase the number of continuous data 

events in a region. 

The continuous data commands require you to specify the type of 

continuous data to be modified. The following is a description of the 

different types of continuous data and how they are produced. 

Pitch Bend: On most synthesizers, this controller is a wheel, joystick 

or ribbon controller. When moved, it “bends” or varies the pitch 

either up or down depending on the direction of movement. Pitch 

bend data indicates the movement of the pitch bend device; it does 

not necessarily correspond to a musical interval. When played back, 

this data controls the sound module’s pitch bend device. Most 

synthesizers allow you to specify the interval by which a maximum 

pitch bend value will alter a pitch. Thus, moving the pitch bend 

device to its extreme high position can could cause a pitch to be 

raised by an octave, a fifth or any other interval. All other pitch bend 

values are scaled according to the interval the maximum value 

produces. 

Mono key pressure: Also known as aftertouch or channel pressure, 

this is a special kind of controller, putting out values between zero 

and 127. If you continue to press down a key after you play a note, 

mono key pressure information is sent. The harder you press, the 

higher the value. Mono key pressure is useful for things like changing 

the tone quality of a sound or controlling the amount and depth of 

vibrato. 

Poly key pressure: This is similar to mono key pressure except that 

each key can generate its own pressure information, instead of one 

pressure level for the whole instrument based on the key most 

recently pressed. Poly key pressure therefore allows for much more 

subtle and complicated aftertouch effects. Since each key can have its 

own set of key pressure data, you must specify the note name by 

entering a pitch value when using the Poly key pressure option in the 

continuous data commands. You can enter the pitch directly from 

your MIDI keyboard. If you don’t specify a pitch, a// keys will be 

affected by the command. 
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Controller: Foot pedals, wheels, sliders and breath controllers are 

common types of controller devices. Controllers are general purpose 

devices used to control such effects as vibrato and tremolo. They are 

identified by number; the number assigned to a specific controller 

depends on the synthesizer you are using. Continuous controllers 

(such as wheels and sliders) are generally numbered in the range 

zero to 63. Switch controllers (on-off types like a sustain pedal) use 

higher numbers. Synthesizers will often respond to more controllers 

than they have physical controls for. 

When using the continuous data commands on controller data, you 

must specify the number of the controller whose data you wish to 

modify. This can be done by clicking in the box next to the 

controllers option and moving the correct controller on your MIDI 

input keyboard. 

Synthesizers tend to send continuous data as fast as they possibly 

can. If you record several tracks of this and play them all back at 

once, Performer, your synthesizers, or MIDI itself may bog down. The 

Thin Continuous Data command selectively removes continuous data 

events, “thinning out” the amount of continuous data while retaining 

all of its essential characteristics. This allows you to transmit a 

reasonable amount of continuous data that can be handled easily by 

all components of your MIDI system. 

The Thin Continuous Data command actually determines the contour 

of the continuous data in the selected region. The continuous data in 

this region is erased and new continuous data is generated. This new 

data is more sparse, reconstructing the analyzed contour with fewer 

events. Unless musically necessary, successive continuous data 

events will not occur closer together than the minimum time change 

and will not differ in value from adjacent events by less than the 

minimum value change. 

Since the continuous data is regenerated, it is possible that this 

command will thicken the data instead of thinning it. You may find 

this aspect of the command useful if you have thinned out the data 

too much. 
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The appropriate minimum time change depends on the tempo of the 

sequence and the controller device involved. Generally, a value of 10 

to 20 will work well. The minimum value change should be 1 for 

controllers and 4 to 8 for pitch bend. Experimentation is essential to 

find the best values in each instance. 

Using Thin Continuous To use Thin Continuous Data: 

Data 
1. Select the region you wish to modify. 

See Selecting a region in the Region Commands 1 chapter. 

2. Choose Thin Continuous Data from the Region menu. 

A dialog box appears. 

hin Continuous Data | 

3. Choose the type of data you wish to thin out. 

Click in the radio button next to the type you want: Pitch Bend, 

Mono Key Pressure, Poly Key Pressure or Controller. See The types 

of continuous data above for an explanation of each type. 

4. Specify a minimum time change. 

Click in the box for this parameter and type in a value between 

zero and 999. 

5. Specify a minimum value change. 

Click in the box for this parameter and type in a value. 
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6. Press the OK button to confirm your entry or the Cancel button to 

cancel it. 

You can Undo and Redo the Thin Continuous Data command. 

After you OK this command, it may take some time to carry out the 

change. If you wish to terminate the command while it is working, 

press the Command and period keys together. 

The Create Continuous Data command creates a stream of 

continuous data events that change smoothly over time. You can use 

it to create pitch bends, crescendos and diminuendos, filter sweeps 

and many other effects. 

This command creates continuous data events that change smoothly 

between the starting and ending values. All values must be within the 

range zero to 127, except for pitch bend data which is in the range - 

8192 to 8191. 

The contour of the changing values is controlled by the curvature 

parameter. It allows you to “weight” the change. With a curvature of 

zero, the change is linear from the first to the second entered value. 

The more you increase the value positively Gwith values from 1 to 

99), the more the change will take place towards the end of the 

region. The more you increase the value negatively (with values from 

-1 to -99), the more the change will take place towards the beginning 

of the region. 

The number of events generated are controlled by the minimum time 

change and the minimum value specified: all events created will not 

be any closer together than the minimum time change and they won’t 

be separated by values smaller than the minimum value change. 

Though Performer can create a perfectly smooth set of values, the 

actual result may not be perfectly smooth due to the minimum time 

and value changes you enter. Experimentation is the key to good 

results. 

You can Undo and Redo the Create Continuous Data command. 
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Using Create To use Create Continuous Data: 

Continuous Data 
1. Select the region you wish to modify. 

See Selecting a region in the Region Commands 1 chapter. 

2. Choose Create Continuous Data from the Region menu. 

A dialog box appears. 

Create Continuous Data 

3. Choose the type of data you wish to create. 

Click in the radio button next to the type you want: Pitch Bend, 

Mono Key Pressure, Poly Key Pressure or Controller. See The types 

of continuous data above for an explanation of each type. 

4. Specify start and end values for the data. 

The data created will have values ranging smoothly between the 

start and end values. 

5. Specify a minimum time change. 

Click in the box for this parameter and type in a value between 

zero and 999. 
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6. Specify a minimum value change. 

Click in the box for this parameter and type in a value between 

zero and 127. 

7. Press the OK button to confirm your entry or the Cancel button to 

cancel it. 

After you OK this command, it may take some time to carry out 

the change. If you wish to terminate the command while it is 

working, press the Command and period keys together. 

Any existing data of the type being created in the selected region is 

removed. 

See the Basics section of the 7hin Continuous Data command above 

for suggestions on setting the minimum time and value change 

parameters. 

The Randomize option allows you to generate variability in 

continuous data that you create, as apposed to a perfectly smooth 

line or curve. Doing can introduce can add extra feel and depth to the 

musical effect you are creating with the continuous data. 

Notice that the Randomize option is a check box, which means that 

it can be used with any of the radio button options above. Check the 

box to randomize; uncheck it for no randomization. 
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When this command randomizes, it choose random values within the 

range that you specify. Each continuous data event is first generated 

by the rest of the parameters above, and then the event’s value is 

randomized within the range you specify in the range box. The result 

is a curve or line that is not perfectly straight: 

Figure 28-1: Here is a continu- 
ous data curve without random- 
ization (above) and with a 
randomization of +5 (below). 

The Emphasis sub-option causes the tendency of the randomization 

to be higher or lower within the specified range. Thus, if you wish to 

randomize the continuous data events within a certain range, but you 

wish them to tend to be higher, use a positive emphasis; use a 

negative emphasis if you wish them to tend to be towards the lower 

end of the range. A value of zero equals no emphasis, which causes 

the randomization to occur evenly within the range. 

Change With the Change Continuous Data command, you can modify 

Continuous Data existing continuous data by scaling it or limiting it to a specific range. 

Using Change To use Change Continuous Data: 

Continuous Data 
1. Select the region you wish to modify. 

See Selecting a region in the Region Commands 1 chapter. 

2. Choose Change Continuous Data from the Region menu. 

A dialog box appears. 
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@ Continuous Dat 

Choose the type of data you wish to change. 

Click in the radio button next to the type you want: Pitch Bend, 

Mono Key Pressure, Poly Key Pressure or Controller. See 7he types 

of continuous data above for an explanation of each type. Only 

the type of data you select will be changed. 

Choose the change option you want. 

Click in the radio button next to the option. 

Enter the value required by the option. 

Click in the box for the option and type in the value you want. 

You may select only one option. 

If you would like to randomize the data, check the Randomize 

check box and enter a Randomization range and emphasis. 

For more information about these options, see “Using the 

Randomize Option” on page 457, as this option works the same as 

the Randomize option in the Create Continuous data command, 

except that it changes existing data rather than newly created data. 

Press the OK button to confirm your entry or the Cancel button to 

cancel it. 
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You can Undo and Redo the Change Continuous Data command. 

The entered value is added to all continuous data in the selected 

region. Enter a positive number if you wish to increase the values in 

the region or a negative number if you wish to decrease them. If a 

value exceeds the limit of its data type, it will be truncated at the limit 

value (e.g. if a pitch bend value comes out to -10,150, it will become 

-8192, the minimum limit for pitch bend values). 

Events in the selected region whose values are greater than the 

entered value are changed to the maximum value. 

Events in the selected region whose values are less than the entered 

value are changed to the minimum value. 

The values of all events in the selected region are scaled by the 

entered percentage value. Thus, specifying 50% halves the values, 

while 200% doubles the values. If a value exceeds the limit of the its 

data type, it will be truncated at the limit value (e.g. if a pitch bend 

value comes out to -10,150, it will become -8192, the minimum limit 

for pitch bend values). 

With the Reassign Continuous Data command you can convert one 

type of continuous data into another. For example, you can convert 

pitch bend data into modulation wheel data. This command is very 

useful for changing the controller number of continuous data when 

playing back a sequence on a different synthesizer than the one it 

was recorded with. 

To use Reassign Continuous Data: 

1. Select the region you wish to modify. 

See Selecting a region in the Region Commands 1 chapter. 

2. Choose Reassign Continuous Data from the Region menu. 

A dialog box appears. 
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3. Choose either the Change or Copy option. 

Click in the radio button next to the option. The Change option 

changes data from one type to another. The Copy option makes a 

copy of the data in the same track of the new type you specify. 

4. Enter the type of continuous data to be changed. 

Click on the appropriate radio button. 

5. Enter the type of continuous data you wish it to be changed to. 

Click on the appropriate radio button. 

6. Press OK to confirm your entry or Cancel to cancel it. 

You can Undo and Redo the Reassign Continuous Data command. 

Invert Pitch The Invert Pitch command inverts or flips notes around a specified 

axis. The inversion is chromatic, that is, exact. For example, if the 

following E major scale (starting on E3), 
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is inverted around an axis of D3, the following will result: 

Basics Inversion is an operation in which the interval between a note and 

the inversion axis pitch is measured and the note is transposed the 

same interval on the opposite side of the axis pitch. Two examples 

are shown below: If the note to be inverted is F4 and the axis pitch 

is C4, the interval between them is a perfect fourth. Since F4 is above 

C4, it will be transposed down by the same interval, a perfect fourth, 

resulting in a G3. If the note to be inverted is C#3 and the axis pitch 

is A3, the resulting pitch would be F4. In the following picture, the 

axis pitch in each measure is represented by a diamond: 

The inversion is always exact, transposing the note the same 

chromatic interval above or below the axis pitch. 

Using Invert Pitch To use Invert Pitch: 

1. Select the region to be inverted. 

See Selecting a region in the Region Commands 1 chapter. 

2. Select Invert Pitch from the Region menu. 

A dialog box appears. 

=~ invert Pitch ™ 
exerertes 
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3. Enter the axis pitch for the inversion. 

You can use your MIDI keyboard for input. This is the center pitch 

around which the inversion will take place. 

4. Press OK to confirm your entry or Cancel to cancel it. 

You can invert a region of notes around a pair of axis pitches. Follow 

the above procedure for normal inversion specifying the lower of the 

two pitches in the Invert Pitch dialog box. Then use the Transpose 

command on the Region menu to transpose the region by the interval 

between the two axis pitches. 

Example: You wish to transpose the following passage around the 

axis pitch pair C3 and E flat 3. 

Use Invert Pitch on the passage specifying C3. The following is the 

result: ; 

Select the region containing the passage and use the Transpose 

command on the Region menu transposing from C3 to E flat 3 (a 

minor third, the interval between the two axis pitches). 

This is the final result, inverted correctly around the pair of axis 

pitches: 

The Reverse Time and Retrograde commands reverse the order of 

events in a selected region. However, each command reverses notes 

in a slightly different way, producing much different results. 
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Reverse Time Reverse Time reverses the order of notes’ attack times in a region. A 
note whose attack occurs two beats from the beginning of the region 

is moved so that its attack occurs two beats before the end of the 

region. In doing so, Performer either maintains the note’s duration or 

ends the duration just before the next attack. Notice in the example 

below that Reverse Time places the attack of the first note exactly at 

the end of the region, extending the duration into the next bar. 

Retrograde Retrograde inversion simply reverses the order of notes within the 

region: the first note becomes the last note, the last note becomes the 

first note, and so on. This is analogous to playing a tape backwards 

and recording the result. 

= 
Original phrase gs ti‘(‘aC 

, SEG 
Reverse Time @ 2 2. See 2S See 

= 
Retrograde a <n es ee 

@ Note: for clarity, we have shortened the durations in 

the Reverse Time example so that they don’t extend 

beyond the next attack. In actuality, the notes maintain 

their original durations after being reversed. 

To get an exact reversal of the notes, you have selected a region of 

time, rather than specific events. In addition, the region of time must 

include the duration of the last note in the region. In the example 

above, the last note is the sixteenth note, G4. To obtain the results 

shown on the bottom staff, you would have to select the region from 

1111000 to 2111000, where 2111000 takes into account the duration 

of the G4 sixteenth note. 
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To specify a region of time that includes the final duration, select the 

region using the Edit bar in the Tracks window, or by dragging in the 

Time Ruler of the Graphic Editing window or Tracks Overview. 

Selecting specific events won’t work because the duration of the final 

note is not included. (For example, if you selected the original phrase 

above in the Event List, the end of the region would be 

114136linstead of 2111000. 

To use Reverse Time, you can select the notes in any fashion: 

1. Select the region you wish to modify. 

See Selecting a region in the Region Commands 1 chapter. 

2. Choose Reverse Time from the Region menu. 

You can Undo and Redo the Reverse Time command. 

When using the Retrograde command, you must select a region using 

the edit bar in the Tracks window. The Retrograde command will 

have no effect on data that has been highlighted in an Event Editing 

window. 

1. Select the region you wish to modify. 

See Selecting a region using the Tracks window in the Region 

Commands 1 chapter. 

2. Choose Retrograde from the Region menu. 

You can Undo and Redo the Retrograde command. 

The Scale Time command expands or compresses the duration of 

events in the selected region by the specified ratio. This effectively 

changes the distance between notes, making them closer together or 

farther apart. Since the actual duration of events changes, the region 

will become smaller or larger after this command is invoked. 

Scaling time allows you to double, halve or otherwise alter the 

amount of time an event takes. A wide range of compression or 

expansion of the duration of events is possible. The amount of 

change to the duration is specified by an integer ratio, e.g. 3:2. If the 

first number in the ratio is larger than the second, the region is 
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expanded; if the first number is smaller than the second, the region is 

compressed. A ratio of 2:1 doubles the duration of all events in the 

region (and doubles the length of the entire region as well); a ratio of 

1:2 halves the duration of all events in the region. 

Events at the Start time of the region will remain in place. Since the 

overall length of the region changes, events at the end will be moved. 

If the end of the region expands, events in it will be merged with data 

already there. 

Original selected region: 

Scale Time cuts the selected region... SES SSLS CHESS LRA 

...and then compresses and merges... Vas = Blank space 

LELLA SL 

ee 
Mixed music ...or expands and merges. | 

All MIDI data events are scaled. The Scale Time command does not 

affect loops or any event in the Conductor track. 

Using Scale Time To use Scale Time: 

1. Select the region you wish to modify. 

See Selecting a region in the Region Commands 1 chapter. 

2. Choose Scale Time from the Region menu. 

A dialog box appears. 
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Examples 

Scale Tempo 

Region Commands 2 

3. Enter the ratio values. 

The values must be between 1 and 99. 

4. Press the OK button to confirm your entry or the Cancel button to 

cancel it. 

Here are three examples to give you a better idea of the use of Scale 

Time: 

You've entered a melody in eighths but decided it would sound better 

in sixteenths. Select the region of the melody and use Scale Time with 

a ratio of 1:2. 

Your sequence is in 4/4 time with lots of triplets. You want to modify 

it to be in 12/8, converting the triplets to regular eighths. Select the 

entire sequence. Use Scale Time with a ratio of 3:2. Afterwards, 

change the meter and tempo appropriately. 

Youve entered a melodic idea in quarter notes and decide that it 

should actually be the bass line for the sequence. All notes should be 

whole notes. Select the region with the melody and use Scale Time 

with a ratio of 4:1. Then transpose it down to the correct octave. 

The scale tempo command provides several ways to modify existing 

tempos within a selected region in the Conductor track of a sequence 

or song. It modifies existing tempo events within the region, but it 

does not generate new tempo events. (To do so, use the Change 

Tempo command in the Change menu.) The Scale Tempo command 

is ideal for making global changes to an existing tempo map that you 

have already created with the Change Tempo command. For 
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example, you might have created an elaborate tempo map with many 

tempo nuances, and you would like to increase the overall tempo 

while maintaining the nuances. 

Selecting a Region to The Scale Tempo command requires that you select the tempo events 

Scale you wish to scale in the Conductor track before you select the 

command from the Region menu. 

@ Note that the Scale Tempo command only affects 

tempo events that already exist in the Conductor track. 

If the region you select has no tempo events in it, this 

command will have no effect. If so, use the Change 
Tempo command in the Change menu to generate 

tempo events. 

There are several ways to select a region in the Conductor track. For 

more information, see chapter 25, “Selecting Regions”. 

Once you have selected the tempo events you wish to scale: 

1. Choose Scale Tempo from the Region menu. 
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Add___ bpmtoall 
tempos 

Subtract bpm from 
all tempos 

Limit to a range from __ 
to. 

Change to__ % of 
current value 

Change overall tempo 
from___ to___ and 
scale accordingly 

Scale all tempos to fit 
new end time 

Region Commands 2 

2. Select the desired scaling option. 

Each scaling option is discussed below. 

3. Click OK to confirm your choice or Cancel to withdraw it. 

This option adds the number of beats per minute (bpm) you enter to 

each tempo event within the selected region. 

This option subtracts the number of beats per minute (bpm) you 

enter from each tempo event within the selected region. 

This option searches for tempo events above or below the specified 

range. When it finds one, it changes the tempo to fall within the 

range. For example, if the tempo range is from 200 to 300, a tempo 

of 351 would be changed to 300 and a tempo of 60 would be 

changed to 200. 

This option increases or decreases each tempo event by a percent of 

its current value, where the current value is 100%. Use a percentage 

lower than 100% to slow down the tempo; use a value above 100% 

to raise it. Use this option when you wish to maintain the degree of 

change between tempos within the tempo map when you raise or 

lower it. 

This option scales the tempo events by a percentage, just like the 

option above it. However, it lets you specify the change in beats per 

minute (bpm) rather than as a percentage. For example, suppose you 

have a piece of music with varying tempos, but whose approximate 

tempo is 80 bpm. You simply wish to change it’s overall tempo from 

around 80 bpm to around 96 bpm. Rather than figuring out what 

percent to type in the percentage option to achieve this change, you 

can use this option to type in the original approximate tempo of 80 

bpm and the desired increased tempo of 96 bpm, and let Performer 

figure out the percent increase for you. All in all, this option provides 

a more musical way of specifying a percent by which you wish to 

scale the tempos, even though it accomplishes the same thing as the 

“scale by percent” option. 

This option scales all existing tempo events to increase or decrease 

the overall elapsed time of the selected region. The start time of the 

region is fixed, and the end time can be made earlier or later. Times 

can be expressed in real time or SMPTE frame time. Here is an 
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example: suppose that you have created a sequence with many 

tempo changes, and it is around 3 minutes long. But you would like 

to make it 3 and a half minutes long. This option lets you select the 

three minute region and scale all the tempos so that it stretches out 

evenly to 3 1/2 minutes. 

Here’s another example: suppose you are locking a sequence to 

picture via SMPTE time code. You have composed a section of music, 

: and you’ve programmed all of the tempo changes. You’ve got the 

section starting at the correct frame time, but it ends with a hit that is 

off by several frames. With this scale tempo option, you can select the 

region with the hit as the end time of the region, choose scale the 

tempos, and type in the new end time where the hit should occur, 

changing the elapsed time such that the hit lands at the correct frame. 

Randomize The randomize option is a check box option that works in 

conjunction with the radio button option selected above. 

The randomize options are explained below. 

By__% of current value 
This option randomizes the tempo of each selected tempo event 

within a range that is expressed as a percentage of the tempo value. 

For example, if the tempo is 100 bpm, and you enter 10 percent, the 

tempo will be randomized within a range between 90 to 110 bpm 

(+10 bpm). 

By +t bpm 
This option randomizes the tempo of each selected tempo event 

within a range of beats per minute. 

Emphasis 
This sub-option causes the tendency of the randomization to be 

higher or lower within the specified range. Thus, if you wish to 

randomize the tempos within a certain range, but you wish them to 

tend to be higher, use a positive emphasis; use a negative emphasis 

if you wish them to tend to be towards the lower end of the range. A 

value of zero equals no emphasis, which causes the randomization to 

occur evenly within the range. 
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Chapter 29 JTranspose 

Performer’s Transpose command, found in the Region menu, 

transposes the pitches of all notes in a selected region. With it you 

can: 

m transpose by interval 

m transpose diatonically to create harmonies 

m change key from any root to any other 

m change key from any mode to any other 

= map each pitch to any other pitch for mapping drum track 

note assignments from one drum machine to another 

m transpose using scale sizes larger or smaller than 12 notes 

m transpose up or down, by any number of octaves 

m create and save custom transpose maps 

m create and save custom scales or keys 

When performing the above operations, you can: 

m play in pitches or entire scales from your MIDI keyboard 

when setting up the transposition 

= Undo and Redo the Transpose command 
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Quick Refer @nCe@ | The Transpose dialog box provides several ways of transposing, 

options for each type, a Transpose Map that shows you how each 

pitch will be changed, and a Custom Maps list which can save 

transposition maps. 

This area presents options for the type of 
transposition chosen to the left. 

r Transpose | 
ESTEE 

Natural Minor 

Harmonic Minor 

Dorian 

My map 

RS to D4 map 

Cross-octaye 

All notes to BbS 

C maj to C rin 

Harmonic Minor 

Dorian 

Phrygian 

Once you have set up a transposition, Create your own types of The Transpose Map changes dynamically to 
you can save it by typing in a name scales with the custom reflect the transposition or custom map you 

and clicking Save; it will then appear in scales command. have chosen to the left. You can pop-edit 
the list. You can use the transposition pitches in the To column to create a custom 
map at any time by clicking its name. map. Changes in one octave are reflected in 

all other octaves. 

The Transpose Map is discussed next, and the four types of 

transposition are described in following sections. 

Harmonizing instead of The Transpose dialog box allows you to either transpose or 

Transposing harmonize. The Harmonize option copies the original notes, 

transposes the copied notes, and the merges them together with the 

original notes. This allows you to build harmonies quickly. 
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The Transpose Map 

When the Diatonic or Scale/ 
Key transpose option is 
selected, scale steps in the 
source key are displayed in 
boldface. 

Playing In Pitches From 
Your MIDI Controller 

Transpose 

The Transpose Map displays a scrolling list of all 128 MIDI notes in a 

column on the left and the pitch to which each will be transposed in 

a column on the right. Notes and spellings in the map change 

dynamically according to the transposition options that you choose. 

In addition, you can pop-edit values directly in the Transpose Map list 

as shown below to further modify the map. Changes in one octave 

are reflected in all other octaves. 

Changes in each octave are reflected in 
all other octaves as well. 

You can customize the transposition by 
pop-editing destination pitches to 
change them. Use the up/down arrow 
keys to scroll through the list. You can 
play pitches in the pop-up box from your 
MIDI keyboard. 

View other octaves by 
using the scroll bar. 

As soon as you pop-edit a pitch in the Transpose Map, thus 

modifying it from they way it was originally set up by the transpose 

options, the Custom Map transpose option will then become 

automatically selected to indicate that the transpose map is now a 

custom map. 

When pop-editing the Transpose Map, you can play in individual 

pitches or an entire scale from your MIDI controller. To play in a 

scale, double-click the first pitch to pop-edit it and then play the 

scale. As you play, each pitch gets entered into the current pop-up 

box, which then automatically scrolls down to the next note in the list 

and enters the next pitch you play. If you make a mistake, use the up 

and down arrow keys to move the pop-edit box. 
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When you are using the Custom Map option, Performer provides 

another intuitive way for you to play in pitches from your controller: 

1. Select the Custom Map option. 

2. Hold down the pitch you wish to transpose, and while holding it 

down, play the pitch you wish to transpose it to. 

You DO NOT need to pop-edit any values to do this. 

Saving a Transpose Map | {if you would like to save a transpose map, type in a name for it and 

click Save as shown below. Custom maps are saved with the file and 

can be loaded into other files with the Load command in the File 

menu. 

My map 

RS to D4 map 

Cross-octaye 

All notes to Bhs 

C maj to C min 

My Transpose 

To save a transpose map, type in 

a name and click Save. 

Using Transpose Maps To recall the map, select its name in the list. To remove a Custom Map 

from the list, click its name and click Delete. 

To make changes to an existing map: 

1. Select the existing map in the list. 

2. Make your changes to the Transpose Map. 

3. Click Save. 

The changes you made will be saved to the map. 
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Transposing by Interval 

Transpose 

To create a new map based on an existing map: 

1. Select the existing map in the list. 

2. Type in a new name. 

3. Click Save. 

The new map will appear in the list. 

4. Edit the Transpose Map to make your changes. 

5. Click Save to save the changes you have made. 

Transposing by /nterval is chromatic, exact transposition: pitches are 

shifted by the number of semitones in the interval that you choose. 

Literally, it causes a mass shift of all pitch values in the selected 

region, just like dragging notes up or down in the Graphic Editing or 

QuickScribe notation windows. For example, chromatically 

transposing from C3 to E3 causes all pitches to shift up a major third 

(four semitones). 

The only option for this type of transposition is the from and to 

pitches that define the interval. The notes that you enter to define the 

interval are not important: only the interval between them matters. 

For example, instead of entering C3 to E3 to shift notes up a major 

third, you could enter F3 to A3. 

The two pitches entered also define the direction of transposition. If 

the second pitch is above the first pitch, pitches will be transposed 

up. If the second pitch is below the first, pitches will be transposed 

down. 

475 



Transposin 
Diatonically. 

476 

Having chosen an interval, you can pop-edit the transpose map to 

make modifications to it if you like. As soon as you pop-edit a pitch 

in the Transpose Map, thus modifying it from they way it was 

originally set up by the Interval transpose options, the Custom Map 

transpose option will then become automatically selected to indicate 

that the transpose map is now a custom map. 

al Transpose 

Diatonic transposition transposes notes by a number of scale steps 

within the type of scale that you choose. For example, if you 

transpose up 2 scale steps in the key of C minor as shown in the 

above example, all C naturals (the root) will be transposed up two 

steps to E flat (a third). Notice that the number of scale degrees, 2 in 

this example, refers to the number of scale steps to change by; it does 
not refer to the destination scale step. 

This is extremely useful for quickly creating harmonies. For example, 

as shown above you can copy and paste a melody line into another 

track and transpose it diatonically up a third (two scales degrees) to 

harmonize with the melody. Scale tones in the key you cnoose are 

displayed in boldface in the transpose map column. 
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Transpose 

To Transpose diatonically: 

1. Choose the Diatonic option. 

2. Choose the direction (Up or Down) and number of octaves. 

3. Type or play in the key root pitch and select a mode from the list. 

This sets up the Transpose Map. You can play in the root pitch 

from your MIDI keyboard if you place the insertion point in the 

From text box. 

4. If you would like to transpose all non-scale pitches into the nearest 

scale pitch, select the Constrain to scale option. 

5. If you would like to customize the transposition, pop-edit values in 

the Transpose map. 

As soon as you pop-edit a pitch in the Transpose Map, thus 

modifying it from they way it was originally set up by the Diatonic 

transpose options, the Custom Map transpose option will then 

become automatically selected to indicate that the transpose map 

is now a custom map. 

6. Click OK. 

The Up and Down options determine the direction of transposition, 

and the Plus 7 octaves option allows you to transpose by intervals 

greater than one octave. 

Remember that the key you choose is a way of setting up the diatonic 

transposition in the Transpose Map. Performer doesn’t really “know” 

what key the actual data is in. In fact, just about any musical phrase 

can be described in musical terms as being in one of several different, 

but related, keys. So, when transposing diatonically, it is up to you to 

know which key to choose to get the results that you want. 

The above also holds true for how notes get spelled. The key that you 

choose only affects the spellings in the Transpose Map: it will not 

change the spellings of the actual track data. Track note data spellings 

are controlled by the current key signature in the Conductor track. 
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The Constrain to Scale 
Option 

Transposing by Key/ 
Scale 

478 

The Constrain to scale option is available with the Diatonic and Key/ 

Scale transpose options. If enabled, it causes all non-scale tones to be 

transposed to the nearest appropriate scale tone, as shown below: 

My map 

RS to D4 map 

Cross-octaye 

All notes to BbS 

C maj to C min 

Natural Minor 

Harmeonic Minor 

Transposing by Key/Scale transposes notes from One key to another. 

For example, you can change music that is currently in a major key 

to its corresponding minor key. In the above example, notes in the 

key of C major are being transposed down to a entirely different root 
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Transpose 

and key: E Mixolydian. The Transpose Map shows each note in the 

key of C Major on the left and the pitch each will be transposed to in 

the key of Db Harmonic Minor. 

To Transpose by key: 

1. Choose the Key/Scale option. 

2. Choose the direction (Up or Down) and number of octaves. 

3. Type or play in the source key root pitch and select a mode from 

the top list. 

This sets up the From column in the Transpose Map. You can play 

in the root pitch from your MIDI keyboard if you place the 

insertion point in the From text box. 

4. Type or play in the destination key root pitch and select a mode 

from the bottom list. 

This sets up the To column in the Transpose Map. 

5. If you would like to transpose all non-scale pitches into the nearest 

scale pitch, select the Constrain to scale option. 

6. If you would like to customize the transposition, pop-edit values in 

the Transpose map. 

As soon as you pop-edit a pitch in the Transpose Map, thus 

modifying it from they way it was originally set up by the Kej/ 

Scale transpose options, the Custom Map transpose option will 

then become automatically selected to indicate that the transpose 

map is now a custom map. 

7. Click OK. 

The Up and Down options determine the direction of transposition, 

and the Plus octaves option allows you to transpose by intervals 

greater than one octave. 

Remember that the source and destination keys that you choose are 

a way of setting up the diatonic transposition in the Transpose Map. 

Performer doesn’t really “know” what key the actual data is in. In fact, 

just about any musical phrase can be described in musical terms as 
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Transposing Using a 
Custom Map 

Custom Transposing 
Based on Another 
Transposition 

480 

being in one of several different, but related, keys. So, when 

transposing by key, it is up to you to know which key to choose to 

get the results that you want. 

The above also holds true for how notes get spelled. The key that you 

choose only affects the spellings in the Transpose Map: it will not 

change the spellings of the actual track data. Track note data spellings 

are controlled by the current key signature in the Conductor track. 

The Custom Map option allows you to do several things. You can: 

m create a customized map that is based on one of the other 

transpose options 

m transpose using octave ranges other than 12 halftones 

= map each note to any other note 

= map all notes to a single pitch 

Each of these operations are discussed below. 

Often you may want to slightly modify a transposition set up by one 

of the first three transpose options. For example, you may want to 

transpose diatonically up two scales steps except for each A-flat, 

which you would like to maintain as an A-flat. In this case, you can 

set up the Diatonic transposition and then pop-edit the destination 

pitch for A-flat so that it doesn’t change pitch. 

To create a customized map that is based on the Interval, Diatonic, or 

Key/Scale Transpose options: 

1. Choose the Transpose option you would like to base your custom 

map on. 

Set up the parameters for the option as necessary. 

2. To customize the transposition, pop-edit values in the Transpose 

map as needed. 

As soon as you pop-edit a pitch in the Transpose Map, thus 

modifying it from they way it was originally set up by the 

transpose options, the Custom Map transpose option will then 

become automatically selected to indicate that the transpose map 

is NOW a custom map. 
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3. If you would like to save the map, type in a name and click Save. 

The map will appear in the Custom Maps list. 

4. Click OK to execute the transposition. 

Custom Transposing Interval, Diatonic, and Key/Scale transpose options all set up the 

With a Non-standard transpose map in 12 note octaves. Changes in one octave are 
Octave Range reflected in all other octaves. The Custom Map option can set up the 

transpose map in octaves that are more or less than 12 notes. For 

example, if you have a sampler that has drum pitched drum sounds 

like tom-tom drums every 6 notes, you can transpose that 6-note 

range to the 10-note range of another sampler. Or, you can transpose 

music from a 12-tone synth to a synth that is tuned in quarter-tones. 

The Custom Transpose option frees you from the octave and diatonic 

restrictions of the other transpose options. 

To transpose using an custom octave range: 

1. Select the Custom Map transpose option. 

The Custom Transpose options will appear. 

2. Type in the number of notes in the source and destination octaves 

and a root pitch for the initial octave. 

In the example above, a standard 12-note octave is being mapped 

to a 24-note octave. The scale sizes can be any number between 

1 and 128. The root pitches can be any note. Notice that the 

source octave from C3 to C4 gets mapped to the destination two- 
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octave range of D3 to D5. Also notice that the root pitches do not 

need to be the same. All other octaves above and below become 

mapped in the same fashion as the one you define. If notes in 

other octaves get transposed to pitches outside the 128 note MIDI 

range, they are substituted with pitches inside the range. 

3. If you would like to save the map, type in a name and click Save. 

The map will appear in the Custom Maps list. 

4. Click OK to execute the transposition. 

Transposing AllNotesto | To map all 128 MIDI notes to a single pitch: 
a Single Pitch 

1. Select the Custom Map transpose option. 

The Custom Transpose options will appear. 

2. Type in 128 in the From: option. 

This includes all notes into one, large octave. 

3. Type in 1 in the To: option. 

This maps all note in the 128-note octave to a single note. 

4. Type in or play in a pitch in the To: option. 

In the above example, all notes are being mapped to C1. 
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Transposing Each Pitch 
to Any Other Pitch 

5. If you would like to save the map, type in a name and click Save. 

The map will appear in the Custom Maps list. 

6. Click OK to execute the transposition. 

The Custom Map option can also map each pitch to any other pitch, 

completely independently from the same pitch in other octaves. This 

allows you to create a transpose map to easily change drum tracks 

from one drum machine to another. 

To set up a drum machine transpose map: 

1. Select the Custom Map transpose option. 

The Custom Transpose options will appear. 

2. Type in 128 in both the From: and To: options. 

Since there is only one source and destination octave, each 

change you make in the Transpose Map’s To column will not be 

carried through to any other octaves. 

Transpose 

3. Pop-edit the pitches in the Transpose Map’s To column. 

Notice that each pitch treated individually and does not affect 

surrounding pitches or octaves. Notice in the above example that 

a same destination pitch, like Db3, can be used more than once, 

such as when several pitched tom-tom sounds are being mapped 

to a single tom sound. 
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4. If you would like to save the map, type in a name and click Save. 

The map will appear in the Custom Maps list. 

5. Click OK to execute the transposition. 

Cr €a ting a The Custom Scale option allows you to create your own scale. To do 

Custom Scale so, you select which pitches are diatonic and which ones are not. 

After you create a custom scale, it appears in the list of keys/scales 

for the Diatonic and Key/Scale transposition options, allowing you to 

transpose diatonically using your own scale and any root pitch. 

To create a custom scale: 

1. Click the Create Scale button. 

The Create Scale dialog box appears. 

r Create Scale 
ae 

Natural Minor 

Harmonic Minor 

2. Select the pitches you wish to be diatonic pitches. 

You can have as many or as few diatonic notes as you wish. You 

can also select the diatonic pitches by playing them on your MIDI 

controller. A pitch turns into boldface to indicate that it is diatonic. 

3. Click OK to create the scale. 
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Your custom scale appears in the key/scale list for the Diatonic or 

Key/Scale transpose options. 
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Chapter 30 Groove Quantize 

What is a groove? 

Performer’s Groove Quantize feature is powerful, easy to use, and— 

from a creative standpoint—one of Performer’s most enjoyable 

features. 

This chapter tells you how you can do the following: 

mw Use the Groove Quantize command to control the 

rhythmic depth and “feel” of your music 

= Dynamically adjust the feel of grooves with faders while 

applying them 

mw Use Groove Quantize to apply the rhythmic feel of a track 

to other tracks 

m= Create your own grooves, of any length, from any music 

you have recorded into Performer or loaded from a 

standard MIDI file 

= Build a groove database from which you can instantly call 

up any groove you have created 

In musical terms, a groove is a unique rhythmic feel. Many artists are 

famous for a certain fee+—or groove—in their music that makes their 

sound unique. 

Performer’s powerful Groove Quantize feature gives you complete 

reign over this important aspect of your music. 

The effect of adding a groove to an otherwise mundane track can be 

stunning: the music instantly feels like it has a third dimension, and 

the sensation can be similar to that moment when you put on 3-D 

glasses in an old 3-D movie. Sometimes, the effect is subtle. Often, 

however, you'll find that a groove completely transforms music, 

making it sound totally different from its original form. 



The elements of a To master grooves, it is important to recognize the musical elements 

groove of a groove. A groove is generated by variations in the timing, accent, 

and duration of the notes being played. In Performer, a groove 

consists of a combination of the following elements: 

= A quantize grid that affects the timing of notes (attacks 

only) 

a A note-on velocity map 

A note duration map 

= A meter 

A length (in measures) 

gw An overall beat subdivision 

For example, a swing groove is usually based on a swung 8th note 

beat subdivision. If it’s a hard swing, the eighth-note offbeats may be 

played quite late. The durations of the notes in such a groove tend to 

be longer, and the velocities emphasize the offbeats. The length of 

the groove is usually two bars, and it is often in 4/4 time. 

When you apply a groove to some MIDI data in a track, the selected 

notes are modified according to these groove parameters. 

Applying a To apply an existing groove: 

gor oove 1. Use Performer’s Memory-cycle feature to cycle playback over the 

region you wish to apply the groove to. 

2. Start playback. 

3. Select the data you wish to apply the groove to. 

Make sure that what you select is within the region Performer is 

currently looping. If you don’t, you won’t be able to audition the 

groove before applying it. Use any method of selection that you 

prefer. You can select individual notes or an entire region of data. 

The groove will be applied at the measure boundaries of the 

region you select. 
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Groove Quantize 

4. Choose Groove Quantize from the Region menu, or press 

command-G. 

The Groove Quantize dialog box appears. If you get an error 

message instead, then the Grooves folder is not in the same folder 

as Performer. If so, switch into the Macintosh Finder and move the 

Grooves folder into the same folder as Performer. 

Groove OQuantize 

Hip Hop Grooves 

j Jazz Riffs 

: Rock ‘n Roll Grooves 

4 Straight Grooves 

5. Open one of the Groove files (or folders) in the list by either double- 

clicking its name or by clicking its name once and clicking the 

open button. 

You now see a list of grooves stored in that groove file. 

Select the desired groove by clicking its name. 

If the Instant Preview button is checked and Performer is playing 

back the region you selected, you'll hear the effect of the groove 

right away. You can audition as many grooves as you want 

without permanently applying one. 
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7. If you'd like to adjust the feel of the groove, click the More Choices 

button. 

This option is discussed further later on in this chapter. 

8. To apply the groove, click OK. 

Instant preview When the Instant Preview button in the Groove Quantize dialog box 
is checked, you can preview grooves without having to click OK to 

apply them. This lets you quickly scan through a list of grooves, 

auditioning each one until you find one you like. To apply it, click 

OK. When Instant Preview is unchecked, you won’t hear the groove 

until after you click OK. 

The Recent Files pop-up The Recent Files pop-up menu is provided for your convenience. It 

menu lets you go directly into recently opened groove files. 

The More Choices The More Choices button causes several sliders to appear in the 

button dialog box. A unique and powerful feature, these sliders let you 

adjust the degree to which the groove is applied—in essence, they let 

you “turn up” or “turn down” the groove. For more information, see 

“Adjusting groove parameters when applying a groove” on page 492. 

Locating a groove The groove list works like a standard Macintosh open dialog box. Use 
it in the standard fashion to locate grooves. 

Use this pop-up menu to This pop-up menu lets you go 
navigate through all of the directly into recently opened 
groove files. groove files. 

Groove Quantize 

Drag the groove icon to 
move it up or down in the zc eee Hop 1 

Option-click the name of the 
groove to rename it. 
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Deleting, moving, and 
duplicating grooves 
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To rename a groove: 

1. Select any data or time region. 

It doesn’t matter what you select. 

2. Choose Groove Quantize from the Region menu. 

3. Locate the groove. 

4. Option-click its name to pop-edit the name, and press return to 

enter the new name. 

5. To exit the Groove Quantize dialog box, click either OK or Cancel. 

Click Cancel if you don’t want to apply the groove. Click OK if 

you do. 

Grooves can be cut, copied, and pasted in the Groove Quantize 

dialog box. This allows you to delete them, move them from one file 

to another, and duplicate them. 

Duplicating is useful because you can make a copy of a groove and 

then make adjustments to the copy, which preserves the original. 

To do any of these operations, you first open the Groove Quantize 

dialog box. To do so, select some data or a region and choose 

Groove Quantize from the Region menu. Locate the groove, and then 

do one of the following desired operations: 

Operation: How to do it: 

To delete a groove Click it in the list to select it and 
choose Cut from the Edit menu. 

To move a groove from one file to Cut it (as described above), open 

another another groove file using the pop-up 

menu above the list, and the choose 

Paste from the Edit menu. 

To duplicate a groove Click it to select it and choose Copy 

from the Edit menu. Then choose 

Paste from the Edit menu. After past- 

ing, rename the copy to differentiate 

them. 
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Grooves are stored in Performer groove files. You can store as many 

grooves as you want in a groove file. You can create as many groove 

files as you want. The only requirement is that groove files must be 

placed in a folder called “Grooves”, and this folder must be placed in 

the same folder as Performer. This is all taken care of for you when 

you first install Performer, so unless you have moved the folder, you 

don’t need to worry about it. 

8 itermns 229.9 MB in disk 

a 
DAA Grooves Old Grooyes Cubase grooves 

Hip Hop Grooves Jazz Riffs Shuttles 

Rock 'n Poll Grooves Straight Grooves 

When you create your own groove files (discussed later), we 

recommend that you organize them by category as shown above. 

This will make it easier to locate grooves. 

Notice that you can further organize your groove files by placing 

them in folders (as long as they remain inside the Grooves folder). 

You can even place System 7 aliases in the Grooves folder and place 

the actual groove files somewhere else on your hard disk. 

When you apply a groove, Performer allows you to adjust groove 

parameters without permanently altering the groove itself. For 

example, you can “turn up” the degree to which velocities are 

affected without changing the original velocity map in the groove. To 

permanently edit the groove see “Modifying grooves” on page 500. 
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To adjust groove parameters while applying a groove: 

1. Use Performer’s Memory-cycle feature to cycle playback over the 

region you wish to apply the groove to. 

2. Start playback. 

3. Select the data you wish to apply the groove to. 

Make sure that what you select is within the region Performer is 

currently looping. If you don’t, you won’t be able to audition the 

groove before applying it. Use any method of selection that you 

prefer. You can select individual notes or an entire region of data. 

The groove will be applied at the measure boundaries of the 

region you select. 

4. Choose Groove Quantize from the Region menu. 

5. Click the More choices button. 

Several sliders appear in the Groove Quantize dialog box, along 

with several other options. 

Groove Quantize 

6. Select the groove you wish to apply from the list. 
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Using the groove 
adjustment sliders 
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7. Make sure the Instant Preview check box is checked so you get 

instant feedback while adjusting the groove. 

8. Adjust the groove as desired with the sliders. 

These sliders are discussed in the following section. 

9. If desired, try different beat divisions by choosing them from the 

beat division pop-up menu. 

Changing the beat division often has a dramatic effect on the feel 

of the groove. This is discussed further in a following section. 

10.Once you like the groove, click OK. 

The Fewer Choices button in the Groove Quantize dialog box 

removes the groove parameter sliders from the Groove Quantize 

dialog box to simplify its appearance. Click this button if you do not 

wish to adjust the groove with the sliders. 

The three groove adjustment sliders give you complete control over 

the feel of a groove. They let you dynamically control the degree to 

which the timing, note-on velocities, and durations are affected. 

@ When you move a slider, the change occurs when you 

let go of the slider (as long as the Instant Preview 

check box is checked). No changes occur while you 

move the slider. 

In essence, these sliders let you control the extent to which you are 

applying the original feel of the groove. You can either “turn up” or 

“turn down” its effect. We urge you to experiment with them because 

they produce interesting effects. The sliders perform as follows: 

Groove slider setting: Result: 

Off (0%) Velocities and durations are 

unchanged. For timing, a straight grid 

quantize is applied. 

Full (100%) Applies the exact feeling of the 

groove. 

Double (200%) Groove feeling is exaggerated by a 

factor of 2. 
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You can clearly hear the effect of one slider by setting the other two 

sliders to their off position and then trying different strengths on the 

remaining slider. 

One effective approach with these sliders is to set them all to off (0%) 

and then increase each one in small increments. Use the up and 

down arrow buttons to make small adjustments. This lets you 

gradually apply the groove to a point that sounds best. 

The option called Save slider and beat division settings with groove 

causes the current slider and beat division settings to be saved with 

the groove. In addition, when you first select the groove in the list, 

the sliders will jump as necessary to reflect the currently saved slider 

settings for that groove. 

When this option is selected, slider settings are saved immediately 

when you move the slider. If you want to try changing the setting 

without losing the saved settings, use the option called Audition 

groove with current slider settings (but don't save), which is discussed 

below. 

The option called Audition groove with current settings (but don't 

save) lets you adjust the sliders without affecting the settings that are 

currently saved with the slider. The same goes for the Beat Division 

pop-up menu. In addition, this option lets you quickly audition a 

number of different grooves with the same settings (because the 

settings won’t change when you select a new groove). For example, 

if you like the degree of groove you’ve set with the sliders, but you 

aren’t quite satisfied with the type of groove yet, you can try several 

other grooves with the same slider settings. 

If you’ve auditioned sliders settings and wish to now save them, click 

the Save slider settings with groove button. 

The beat division pop-up menu lets you choose an underlying 

quantize grid for the groove. Divisions range from eighth notes to 

32nd notes in both straight and triplet time; several combination grids 

are also provided. See “Choosing a beat division” on page 499 for 

more information. 
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This pop-up menu allows you to try different beat divisions without 

losing the original beat division in the groove. For example, you can 

try applying an 8th-note division to a groove with a 16th triplet beat 

division. The original beat division is displayed in outline format as 

shown below: 

2) Eighth Notes 

ai 16th Notes 

a: 42nd Notes 

Sh Eighth Triplets 

3h 1th Titel Pll eqt =) Original beat division 

3h 32nd Triplets 

98 Z2nd Nonuplets 

Ph sth Triplet & sth 
Pp sth Triplet & 16th 
Ph Sth Triplet & 16th 

Notice that a groove can have more than one original beat division, 

and each original beat division can have its own unique settings. This 

can be accomplished by editing the groove. See “Adding an 

additional default beat division to a groove” on page 502 for more 

information. 

The beat division pop-up menu is governed by the radio button 

options at the top of the window. (See “Saving groove settings with a 

groove” on page 495.) One option saves the beat division setting with 

the groove. The other lets you audition different grooves with a 

certain beat division. For example, If you have a bunch of grooves 

that were created in 16th note divisions, but the particular section you 

are applying the groove to right now is in triplets, you can set the 

beat division menu to triplets, and leave it there as you audition 

groove after groove. 

The beat subdivision has a dramatic impact on the groove. Try 

experimenting with different choices. 

Grooves usually sound closest to their original feel with the beat 

division at which they were created. 
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Cri e€a ting a The Create Groove command lets you create your own Grooves from 

groove MIDI note data in any track. The source material can come from any 

Performer file or any standard MIDI file. Grooves can be any length. 

To create a groove: 

1. Select the notes (or region of notes) you wish to use as source 
material for the groove. 

You may select them in the Track list, the Tracks Overview, or any 

of Performer’s editing windows. The groove will start at the 

beginning of the first measure of your selection, and its length will 

be a whole number of measures. 

@ When you choose source material for a groove, the 

data must be aligned with Performer’s metronome 

(main counter). For example, you can’t use a rubato 

passage, unless you first use the Record Beats feature 

to align Performer’s measure and beat boundaries with 

the music. 

2. Choose Create Groove from the Region menu. 

The Create Groove dialog box appears. 
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= Create Groove 

Hard Shuffle 2 

Soft & medium Shuffle 

Medium & Hard Shuffle 

32nd Note Shuffle 

Alternate Velocity Shuffle 
— 

avey 's Shuffl 

3. Open a groove file in which to save the groove, or create a new 

groove file with the New File button. 

4. Type in a name for the groove. 

5. If desired, change the meter for the groove. 

This setting affects the overall length of the groove, and it also 

affects how many beats are in each measure. Try to choose a 

meter that most closely resembles the beat structure of the groove 

you are creating. 

6. Choose a default beat division for the groove from the pop-up 
menu. 

See “Choosing a beat division” on page 499 regarding this option. 

7. Click OK to save the groove, or click Cancel to withdraw the 

command. 

The new groove gets added at the bottom of the groove list. 
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Choosing a beat division 

Groove Quantize 

The choice you make for a beat division when creating a groove is an 

important one, for it governs the underlying resolution of the 

quantization that occurs when you apply the groove. The choices 

range from eighth notes to 32nd notes in both straight and triplet 

time; several combination grids are also provided. 

As a rule of thumb, when you choose a beat division, think of how 

the music is notated, and use the shortest note duration that would 

be used to notate it. For example, a swing feel is customarily written 

as straight eighth notes. So when you are choosing a beat division for 

a swing groove, use a straight eighth note grid. 

If the groove style you are defining has both a straight and triplet feel, 

use the appropriate combination grid (the straight and triplet options 

at the bottom of the menu, as shown below). For example, swung 

music often includes straight sixteenths, so you’d choose a triplet 

eight/sixteenth combination. 

_) Eighth Notes 

ai 16th Notes 

a) 42nd Notes 

Sh Eighth Triplets 

A 16th Triplets 

3B 32nd Triplets 

3h 32nd Monuplets 

Py sth Triplet & sth 
Dh sth Triplet & 16th 
Bh 16th Triplet & 16th 

Combination ——» 

beat divisions 

Keep in mind, however, that the combination grid has beat divisions 

for both straight time and triplet time, so there are more grid points. 

If the music you apply the groove to is not rhythmically accurate to 

begin with, there is more of a chance that notes will gravitate to the 

wrong grid point. For this reason, use discretion when applying 

combination grids. In some cases, it might be better to use a non- 

combination grid. When in doubt, you can make two versions of the 

groove: one with a combination grid and another with a straight or 

triplet grid. 



Modifying grooves Performer provides you with the ability to modify the timing, velocity, 
and duration information in the groove itself. Fortunately, you can do 

so quickly and easily, without having to switch files. 

To modify a groove: 

1. Select any data or time region. 

It doesn’t matter what you select. 

2. Choose Groove Quantize from the Region menu. 

3. Locate the groove. 

4. Click the Edit button. 

Click the Edit button to edit the groove. 

5. The Groove Editor dialog box appears. 
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Information about the currently selected beat division. 
Click on the timing, velocity, or duration values to edit 
them. Clicking on the word “early” or “late” toggles it. 

Groove information 

Note Velocities 

Note placement 

Note durations 

Scroll bar to scroll through Currently Beat boundary 
the groove if it does not fit selected beat 
entirely in the window division 

6. Edit each beat division as desired. 

If Instant Preview is enabled, and you are looping a section to 
hear your changes, you'll hear them right away as you make them. 

Here is a summary of what to do in this window. 

To do this: Do this: 

Increase or decrease a velocity Drag it up or down 

Adjust note placement earlier or Drag the note placement bar to the 

later left or right 

Increase or decrease a duration Drag the right side of the duration 

icon left or right (O - 200%) 
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Duplicating a groove 
before modifying it to 
preserve the original 

Adding an additional 
default beat division toa 
groove 

Obtaining grooves 
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7. Click OK to confirm your edits, or click cancel to withdraw the 

command. 

The groove editor makes permanent changes to the groove (unlike 

adjusting the groove sliders, which doesn’t affect the groove data 

itself). As a result, if you want to modify a groove but preserve the 

original, duplicate the groove and then edit the copy. To duplicate a 

groove, see “Deleting, moving, and duplicating grooves” on 

page 491. 

A groove can have several default beat divisions (as shown in the 

pop-up menu on page 496). This lets you produce several permanent 

variations of the groove within the groove itself. To do so, select a 

non-default beat division from the beat division pop-up menu in the 

Groove Quantize dialog box right before you click the Edit button. 

Doing so lets you modify the groove based on the newly selected 

beat division. The modifications you make to the groove in the editor 

will be unique to that beat division; you won’t affect the groove with 

its original beat division setting. When you click OK, the beat division 

you chose will become outlined, and you'll be able to freely change 

between the two groove variations simply by selecting the outlined 

beat divisions in the beat division pop-up menu. 

There are many ways to obtain grooves. You can: 

m Use the stock grooves provided with Performer 

mw Create new grooves from scratch in Performer 

mw “Cop” grooves from any Performer file or standard MIDI 

file 

mw Purchase commercially available standard MIDI file 

libraries and create grooves from the MIDI data in them 

m Purchase commercially available groove libraries 

Commercially available MIDI groove libraries are similar to sample 

libraries; they have been painstakingly produced in the recording 

studio. For example, WC Research, Inc., the producers of DNA™ 

grooves, have pulled industry legends such as Clyde Stubblefield and 

Bernard Purdie into the recording studio specifically for the purpose 
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Cubase grooves 

Applying the groove 
from one track to 
another 

Groove Quantize 

of encoding their unique feel. The results are stunning, and we 

strongly recommend that you check them out. A folder of sample 

DNA grooves is included with Performer. 

MIDI grooves are similar to digital sampling in the sense that they 

present us with similar copyright issues. If you cop someone’s groove 

using Performer’s Create Groove feature, consider handling it in the 

same fashion as you would for samples. 

Performer can read Cubase groove files if they are placed in 

Performer’s Grooves folder. They appear in the Groove Quantize list 

with a different icon along with all of your Performer groove files. 

They can be used in the same fashion as Performer grooves. 

Cubase groove file Ee) BP_62.GRY 
BP_69_70.GRV 

ke BP_71.GRV 
Performer groove file ee] Hip Hop Grooves 

4) Jazz Riffs 

Folder containing Old Grooves 
groove files Bey Rock 'n Roll Grooves 

Shuffles 

Cubase grooves can be viewed in Performer’s Groove Editor, but they 

cannot be edited directly. To edit them, first move them into a 

Performer groove file using the Copy and Paste commands in the Edit 

menu (see “Deleting, moving, and duplicating grooves” on 

page 491). 

To apply a groove from one track to another, create a new groove 

based on the original track. Once you have created the groove, you 

can apply it to any other track you wish using the Groove Quantize 

command. The Groove you create can be of any length. 
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Chapter 31 Custom Control Consoles 

Performer’s custom control consoles provide a host of control items, 

including: 

mw Sliders 

mw Knobs 

ws Buttons 

m Pop-up menus 

Each control item can be used for virtually any musical purpose that 

involves MIDI data. For example, a control item can: 

505 



m Act as a “virtual” MIDI instrument, generating continuous 

data which can be sent to synthesizers and recorded into 

tracks 

m= Remap data, such as velocities into controllers 

= Modify velocities of notes as you play back 

m= Generate system exclusive data to modify synth parameters 

on the fly 

You can build customized control consoles, such as: 

= Mixing consoles with sliders and knobs that control MIDI 

volume and pan 

mw Patch editing consoles that control and shape the sounds 

in your synthesizers. 

The sliders, knobs, and buttons can be controlled in real time, while 

Performer is playing back or recording, to create musical effects. In 

addition, they animate during playback to reflect what you have 

recorded. 

Basics Custom Control items serve two functions. First, they monitor MIDI 

data being played from their target track or MIDI channel, animating 

in real time to reflect the data’s current value. For example, let’s say 

you have a track containing a stream of controller #7 (volume) data, 

and the controllers increase in value (in the range from zero to 127), 

making a crescendo. A control item assigned to monitor controller #7 

in the track will move as the track is played back, reflecting the 

changes in the values of the controller. 

Secondly, control items generate new continuous MIDI controller data 

in real time when you take control of them, and send the data to 

either a FreeMIDI device or track. When you take control of a control 

item, the new data that it generates overrides the data already in the 

track. 

To demonstrate this, let’s return to the volume example above with 

the crescendo in the track. If you play back the track and grab the 

control item with the mouse half way through the crescendo, you will 

take over the volume of the track with the control item. The 

crescendo still exists in the track, but it does not get played as long 
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as you are gripping the control item with the mouse. If you release 

the control item, it will immediately begin monitoring the existing 

data in the track again. 

In summary, control items monitor continuous data being played 

back from their target track or MIDI channel. Grabbing a control item 

generates new data which overrides the data in its target track. The 

new data does not modify the track; it only temporarily overrides the 

continuous data in the track. 

Custom controls are created and displayed in custom console 

windows. You can create as many custom console windows as you 

like. They save, close, and open like other Performer windows. 

You can create control consoles automatically or by hand. 

For basic MIDI controls, such as volume sliders, pan knobs, mod 

wheel sliders, and pitch bend sliders, you can create them 

automatically using the Create Console command in the Tracks 

window. 

To quickly create a control console with sliders and knobs for MIDI 

volume and pan in the Tracks window: 

1. Highlight the Track(s) for which you wish to make a console. 

Click each track name to highlight it. Shift-click to select tracks not 

next to one another. 

2. Choose Create Console from the Tracks window mini-menu. 

The Create Console dialog box appears. 
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=> Lreate Console 

3. Select the dimensions of the sliders you will create in the console. 

Pan control items are created as knobs. All of the other types of 

items are created as sliders. The slider dimensions you choose can 

be modified after the console is created. 

Select the type of control items you want to create for each track 

that you have selected. 

The Other option allows you to choose a controller of your choice 

and name it. If you select multiple items, they are placed together 

in the same console. If you would like each type of item to be in 

a separate console, select one type at a time and repeat this entire 

procedure for each type. For example, if you want volume sliders 

in one console, and pan sliders in a different console, choose only 

volume, click OK and then repeat the procedure for pan. 

If desired, choose a source for the control items. 

The most common form of a source is an external MIDI controller, 

such as the mod wheel or pitch bend wheel on your controller 

keyboard. This allows you to move the slider or knob with your 

mod wheel. If you do not need to do this, leave the source option 

settings as they are. 
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@ Note that the control item doesn’t not require a source 

data type to record data and animate during playback! 

Instead, it records and monitors the target data 

(volume, pan, etc.) that you have selected. 

6. If necessary, choose the source data type. 

7. Click OK to create the console. 

Clicking OK creates the console and adds the Console’s name to 

the Windows menu. The console that you created will appear in 

the center of the screen. 

Building a If you would like to create your own customized console, you can 

Custom Console open a new, blank custom console. To do so, click the Custom 

Consoles button in the Consolidated Controls panel. 

Custom consoles button 

creates a new, empty console 

in which you can build controls. 

Quick Reference A new, empty console window appears. It has a title bar, close box, 

push down box, mini-menu and grow box like a standard Performer 

window. Drag the title bar to move it. Click the close box to close it. 
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Edit Mode button 
Insert ie | = Snapshot button 

Control item area 

Resize button 

Insert button: inserts a slider, knob, button, or other control item. 

Edit Mode button: Toggles between two modes in the console. When 

Edit Mode is on (the button is highlighted), console items can be 

moved, resized, deleted, and otherwise graphically manipulated. 

When Edit mode is off, control items cannot be moved; instead, 

sliders slide, knobs turn, buttons push, and so on. 

Snapshot button: takes a snapshot of the current knob, slider, and 

other control settings and records the current setting in the track at 

the current counter location. This can be done while Performer is 

stopped or playing back. 

Control Items area: this is the area where you create and position the 

knobs, sliders, buttons, etc. 

Resize button: resizes the window. 
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Mini-menu Quick 
Reference 

Custom Control Consoles 

Set Console Name: Provides a dialog box in which you can change the 

name that displays in the title bar of the console and in the Windows 

menu. 

Duplicate: Makes a copy of selected control items. 

Snap to Grid: Toggles whether or not control items snap to an invisible 

grid in the console when they are moved or resized. When checked, 

Grid Snap is on. When not checked, Grid Snap is off. 

Set Grid Spacing: determines the resolution of the snap grid when 

snapping is turned on. The resolution is measured in screen pixels, 

which are approximately 72 dots per inch (dpi). 

Align controls: Lines up selected controls to one another in a 

configuration that you choose. For example, you can line up the 

centers of several control items by selecting them and choosing this 

command. 

Background pattern: Allows you to fill the control item area with a 

standard Macintosh background pattern similar to the fill patterns 

found in paint programs. Sliders, knobs, and buttons appear 

superimposed on top of the background pattern. 

Goto Zero: Sets the value of the highlighted control item(s) to zero. 

Goto Null Point: Sets the value of a highlighted master control item to 

its null point. 

Auto Punch-In: A special record mode for control items which causes 

them to record data into their target track only when the control item 

is moved, either with the mouse or an external source. 

Set Punch-Out: Opens the Set Punch-Out dialog box, which allows you 

to adjust the delay before punch-out when you are in Auto Punch-In 

mode and are controlling a control item from an external MIDI 

source. The Punch-Out time is the amount of time (Cin tenths of a 

second) between when the last event is received by a control item 

from its external source and the time at which the control item drops 

out of Record. 
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Group: Opens the Grouping dialog box for the highlighted control 

items. This command allows you to assign control items to a group 

all at once rather than one at a time. 

Ungroup: Removes the highlighted control items from their assigned 

group. 

Control Assignment: Opens the Control Assignment dialog box for the 

currently selected control item in the console. This dialog contains all 

of the settings for how the control item behaves. 

Name item: Lets you type in a name for a currently selected control 

item. 

Delete Control: Removes the currently selected control item(s) from 

the console. 

Delete Console: removes the console from the screen and removes its 

name from the windows menu. 

To create a control item: 

1. (Optional) Select the Snap to Grid menu item to turn the snap grid 

on or off. 

This causes the control item to snap to an invisible grid in the 

console window when you create it, which can be useful for 

lining up multiple buttons and sliders. 

1. Press the insert button in the title bar. 

2. Choose the item you would like to insert. 

The cursors turns into a cross-hair. 

3. Drag across a blank portion of the console window. 

As you drag, the item appears. You can choose any length or size 

that you like. You can also resize the item at any time. 
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4. When you release the mouse, the control Assignment dialog box 

appears. 

Control Assignment 

5. (Optional) Choose a source data type for the control item. 

See “Making the Source Assignment” on page 516 for more 

information. 
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6. Choose the Target data type for the control item. 

See “Making the Target Assignment” on page 515 for more 

information. 

. (Optional) Set the minimum and maximum time change. 

These two options (on the left) control the density of the data that 

the control item generates. The lower the values, the more dense 

the data. Higher values thin out the data. Try to use as high a value 

as you can while still maintaining the musical effect you wish to 

achieve. If you use values that are too high, and the data is too 

thinly generated, it may not sound good. 

. Choose the minimum and maximum values for the control item. 

These are the absolute lowest and highest values that the control 

item can have. For controllers, the maximum range is 0 to 127. For 

pitch bend, the range is -8192 to +8191. 

. (Optional) Assign the control item to a group. 

See “Grouping Control Items” on page 533 for more information. 

10. Type in a name for the control item. 

11. If desired, change the type of item (slider, knob, button) by 

choosing a different item type from the Type pop-up menu. 

12.When you have set all of the parameters as desired, click OK. 

The control item appears in the console. Notice that it has a box 

around it. You can click the handle in the lower left of the box to 

further reshape the item. 
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Making the Target The target assignment is made in the Control Assignment dialog box 

Assignment when you first create the slider, knob or button as shown in the 

previous section. The target can changed at any time by double- 

clicking the control item. 

The target assignment consists of two things: the type of MIDI data 

and the target, which is place where the data will be sent. 

Control Assignment 

The target data type is the specific type of MIDI data that the control 

item will send and monitor. A control item only monitors one track 

and one data type at a time. 

Sliders, knobs, and buttons in Performer can control just about any 

type of MIDI data, including: 
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Making the Source 
Assignment 
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= Continuous controllers 

= Switch controllers (either as switch controllers or as 

continuous controllers) 

m= System exclusive messages 

mw Notes and velocities 

For velocities, the slider or knob modifies the velocities of notes in 

the target track as they play. 

The Target is the place where the data will be sent by the slider, knob 

or button. The target can be: 

aw A track 

mw A FreeMIDI device 

When the target is a track, the data from the control item is sent to the 

track, which then records and plays the data. In turn, the control item 

monitors the material it recorded in the track, animating as it does so. 

However, the control item only records into that one track in that one 

sequence; it cannot control another track in another sequence, unless 

you reassign it. 

When the target is a FreeMIDI device, the data from the control item is 

sent to the track in the current sequence which is assigned to that 

device. This is the most flexible of the target assignments because it 

doesn’t matter what sequence is playing at the time. As long as one 

of its tracks is assigned to the device, the control item data will be 

recorded and monitored in the track. 

The source assignment is made in the Control Assignment dialog box 

when you first create the slider, knob or button as described in 

“Creating a Slider, Knob, or Button” on page 512. The source can 

changed at any time by double-clicking the control item. 

What is a source for the slider or knob? It is a device other than the 

mouse which you can use to control the slider or knob. Normally, 

you change the value of a slider or knob by dragging it with the 

mouse. At times, however, it might be useful to move it from an 

external controller, such as the modulation wheel or data entry slider 
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Changing the Source or 
Target 

Custom Control Consoles 

on your MIDI keyboard controller. To do so, set the Source 

assignment to match the incoming MIDI channel and data type for 

the controller you wish to use. 

The source assignment consists of two things: a type of MIDI data and 

the MIDI channel or track from which the data is being generated. 

Notice that the slider or knob can be controlled by notes, velocities, 

pitch bend, controllers, or even mono pressure. 

Set the MIDI channel to match the transmit channel of the controller, 

pitch bend wheel, or whatever you are using. 

Notice that the source can also be a track. Source data in the track 

then controls the slider. This allows you to create interesting effects. 

For example, you can assign the source of a slider to be the velocities 

of notes in track 3. You can then assign the target to be controller 

number 7 (volume) and assign it to the synth playing back the notes 

in track three. When you play the track, the slider reads the velocities 

and sends out a volume controllers to match the velocities, thus 

enhancing the volume change effect from the velocities. 

To change the source or target assignment: 

1. Be sure the Edit mode button in the title bar of the console window 

is unhighlighted (turned off). 

2. Click the knob or slider to select it. 

3. Choose Control Assignment from the mini-menu. 

As a shortcut, double-click the control item. 

517 



Adding Arrows toa 
Slider or Knob 

518 

4. Set the source or target assignments as needed. 

5. Click OK. 

To connect a scroll arrow to a slider: 

1. (Optional) Select “Snap to Grid” from the Console window 

mini-menu to check it. 

Doing so causes the arrow to be lined up with the slider or knob. 

Otherwise, you may need to manually adjust the position of the 

arrow to line it up with the slider. The arrow doesn’t have to be 

lined up, however; it will control the slider no matter where you 

place it. 

. Insert the slider or knob. 

To do so, press the insert button, choose slider Cor knob), and 

drag out the slider. The Control Assignment dialog appears. Select 

the desired settings and click OK. 

. Press the insert button again and choose “Arrow” from the menu. 

Once you have chosen to insert an arrow, the cursor turns into a 

cross-hair. 

. Click directly on top of the slider and drag in the direction to which 

the arrow should point. 

Don’t worry about the exact placement of the arrow yet. You can 

take care of that after you have inserted it. Drag up or to the right 

to create an increment button; drag down or to the left to create a 

decrement button. Control the size of the arrow with the size of 

the box that you drag out. Below, an increment arrow is being 

inserted by dragging to the right. Notice that the cross-hair was 

initially clicked on top of the slider. 
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When adding arrows to a slider, click on top of the slider and drag 
in the direction that the arrow should point. 

__ Once inserted, you can adjust the size and placement by 
_ dragging the arrow and its size handle. Use the Align 

command in the mini-menu to quickly line things up. 

5. Adjust the size and placement of the arrow as needed. 

Use the Align command in the mini-menu to automatically align 

the arrow with the slider. 

6. To use the arrow, click the edit button in the console title bar to 

unhighlight it and click the arrow button. 

Adding a Value Box toa A value box displays the current value of the slider, knob, or button, 

Slider, Knob, or Button and it will update continuously as you move the slider or knob. 

If you want, you can add a value box to a button. However, buttons 

can only send up to two values, so a value box might not be useful 

since it will only display two different values. (On the other hand, 

you might have a situation in which it would be useful, so that’s why 

we mentioned it.) 
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Click on top of the 
knob or slider and 

drag out a box for the 
appropriate size. 

Using Value Boxes 
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To add a value box: 

1. (Optional) Select “Snap to Grid” from the Console window 

mini-menu to check it. 

Doing so causes the value box to be lined up with the slider or 

knob. Otherwise, you may need to manually adjust the position of 

the value box to line it up with the slider. The value box doesn’t 

have to be lined up, however; it will be connected to the slider no 

matter where you place it. 

1. Insert the slider, knob, or button. 

To do so, press the insert button, choose slider, and drag out the 

slider. The Control Assignment dialog appears. Select the desired 

settings and click OK. 

2. Press the Insert button again and choose “Value Box” from the 
pop-up list. 

3. Click on top of the item to which you wish to add the value box, and 

drag diagonally to create the value box. 

Once inserted, If grid snapping is enabled, 
you can adjust the Click in the corner to line up 

size and place- the value box with the knob 
ment. or slider. 

You can enter a value into a value box just like Performer’s main 

counter. To change the value inside an edit box: 

1. Click inside the value box. 

The numbers inside become highlighted. 
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2. Type the desired value. 

Use the arrow keys if necessary. 

3. Press return to confirm your choice. 

Labelling a Slider, Knob, Often you will want to label the sliders, knobs, and buttons that you 

or Button create. If you didn’t set the name when you first created the control 

item, set it as follows: 

1. Click the border of the control item to select it. 

Alternately, you can shift-click anywhere on the control item to 

select it. 

2. Choose “Name Item” from the mini-menu. 

3. Type in the desired name. 

4. Click OK to confirm your choice. 

To add a label to the control item: 

1. Press the insert button and choose “Label” from the menu. 

2. Click directly on top of the control item. 

The label appears. 

3. If necessary, drag the label to the desired position. 

You can do so with grid snapping enabled or disabled. 

Changing a Label To change the text of a label: 

1. Click the label to select it, or click the border of the control item. 

2. Choose “Name Item” from the mini-menu. 

3. Type in the new name and click OK. 

@ Note: as a shortcut, you can option-click the label. 

Creating a Button Buttons send one MIDI message at a time. For example, a button 

might send a patch change to a synth or a MIDI patcher. 
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To create a button: 

7 Press the insert button and choose “Button” or “Text Button” from 

the menu. 

A text button displays its label inside the button. 

Drag the cross-hair across the console to insert the button. 

The Control Assignment dialog box appears. 

. Set the Source and Target items as desired. 

See “Making the Target Assignment” on page 515 and “Making the 

Source Assignment” on page 5106. 

Select the type of button you wish it to be. 

There are three types of buttons: 

Single-state Two-state On/off 

= Single state button: sends a single message only. 

= Two-state button: toggles between two messages, sending 

the first when it is pressed and the second when it is 

released. For example, you might want to create a 

temporary mute button that mutes the track only while you 

are holding down the button. If you choose this type of 

button, you have two values to enter to the right of the 

option. 

= On/off button: toggles between two messages, sending the 

first when it is pressed and the second when it is pressed 

again, and so on. For example, the button might toggle 

between a volume controller of zero and 127 to mute and 

unmute a track. If you choose this type of button, you have 

two values to enter to the right of the option. 
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Selecting Control Items 

Cutting, Copying, and 
Pasting Console 
Controls 

Custom Control Consoles 

5. 

8. 

If you want the button to act like a mute button, click the “M” next 

to off value button as shown below. 

When this setting is enabled, the button sends the current value of 

its target controller type at the time the button is unmuted, instead 

of sending a specific maximum value. This makes a button 

assigned to controller #7 (volume) act just like a real mute button 

by returning the track to the current volume at the moment it is 

unmuted. 

Figure 31-1 

If desired, choose a group for the button. 

Buttons can be grouped, either by a master button or even by a 

slider or knob. 

If desired, type in a name for the button. 

If it is a text button, the name will be displayed inside the button. 

Click OK. 

Shift-click anywhere on a control item to select it. You can also use 

shift-clicking to select multiple items. 

To select a group of items, drag a selection box over them. 

To select all the items in the console, choose Select All from the Edit 

menu, or press command-A. 

Console controls can be cut, copied, and pasted. This greatly 

facilitates the process of building a custom control console. For 

example, if you are creating a number of items that are similar, make 

one first and then copy and paste it as many times as needed. Then 

make the necessary minor adjustments to each copy. 
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To cut or copy a control item: 

1. Select the desired item(s). 

Note that you can select more than one at a time. For information 

about selecting control items, see “Selecting Control Items” on 

page 523. 

2. Choose Cut or Copy from the Edit menu. 

To paste a control item after cutting or copying, choose Paste from 

the Edit menu. 

Aligning Control Items There is an Align Controls command in the Console mini-menu to 

help align selected console controls. 

To use this command: 

1. Select the items to be aligned. 

2. Choose Align Controls from the console mini-menu. 

The Align Controls dialog appears. 
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el Alignment 

3. Choose the desired options. 

In this example, we are aligning the centers of the objects left-to- 

right. 

4. Click OK. 

Nudging Control Items Selected control items can be nudged using the arrow keys. Be sure 

that the item you want to nudge is selected. (You can nudge several 

at once, too.) Also make sure that the Edit Mode button in the title bar 

of the console is highlighted as shown below. Items are nudged one 

screen pixel each time you press an arrow key. 
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Edit Mode button 

Once you have selected control items as described in the previous 

section, you can drag them anywhere in the console window. You 

can also remove them from the console by hitting the delete key or 

by choosing Erase from the Edit menu. 

To duplicate a control item: 

1. Select the control item. 

See “Selecting Control Items” on page 523. 

2. Choose “Duplicate” from the Console mini-menu. 

To change the source, target, grouping, and other parameters for a 

control item, double-click it. The Control Assignment dialog box 

appears. Change what you wish and then click OK. 

To move or resize a control item, you need to be in edit mode. To 

enter edit mode, click the Edit Mode button in the title bar so that it 

becomes highlighted. When you are in edit mode, you can only edit 

control items. You cannot use them, i.e. you cannot slide a slider, turn 

a knob, press a button, etc. To use the control items again, 

unhighlight the edit mode button. 

As a shortcut, you can enter edit mode temporarily by holding down 

the command key (instead of clicking the edit button) as you click 

the control item. Doing so allows you to move it or resize it without 

clicking the Edit Mode button in the title bar. 

The Background Pattern command in the Console window 

mini-menu opens a dialog from which you can choose a foreground 

and background pattern for the console. Click the pattern you wish 

for each, and the sliders, knobs, and buttons in the console will be 

superimposed on top of that pattern. 
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You can use this feature to visually differentiate different types of 

consoles. For example, you could give your volume consoles a 

different background pattern from your effects consoles. 

Contr olling The following sections explain how to control sliders and knobs. 

Knobs and 
Sliders 

Controlling a Slider or Try moving the slider with the following mouse actions to familiarize 

Knob with the Mouse yourself with them. 

Drag the handles to 

change the slider’s 
value smoothly. 

Pop-edit the slider 

value directly. 

Click the +/- buttons to 
move the slider by one. 

Click anywhere on the bar to —? - Press the +/- buttons to 
the slider to that position. move the slider smoothly. 

To move a knob, simply click on it and drag horizontally or vertically. 
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Once you have made the source assignment as described in “Making 

the Source Assignment” on page 516, click the slider or knob name 

to highlight it and move the mod wheel. You will see the slider 

respond as you move the wheel. 

@ Remember, the slider or knob must be selected for 

external control to work. 

When a slider or knob is being controlled externally, data from the 

external source is exclusive to the slider; that is, the data is used 

solely to control the slider and will not be accidentally recorded into 

another track. 

External control is a very powerful feature because it allows you to 

reassign continuous data in real time as you move the controller. For 

example, a volume slider that is being controlled by a mod wheel is 

actually receiving controller #1 data from the wheel and then 

converting it into controller #7 data on-the-fly. 

Performer also allows you to control sliders with several types of data 

that you might not consider at first: notes, velocities, and aftertouch. 

To move the slider during playback, simply press the play button and 

move the slider with the mouse or mod wheel, while the scale is 

playing back. Notice that the volume changes as you move the slider. 

MIDI notes are numbered from 0 to 127. C3 is note number 60, for 

example. Note numbers correspond exactly to controller numbers, so 

pressing a note on your keyboard will set the slider to its 

corresponding value. This is useful for creating sudden, precise 

changes in controller value rather than smooth changes. Keep in 

mind while you do this that most keyboards do not have 127 keys 

and therefore will not allow you to span the entire zero to 127 range 

of the slider. 

Note velocities can also be used to control the slider, since they also 

span the range from zero to 127. The harder you strike a key, the 

higher (or lower) the slider will go. This might be useful for setting 

up a slider to send a controller that, in turn, affects a synth in a certain 

way: as you strike the key harder, the musical effect will become 

stronger (or weaker). 
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The same applies to aftertouch data. The harder you press on the 

key, the higher (or lower) the control item will go. 

Recording a Once a control item’s target and source parameters have been set up, 

Kn O b Sli de ror ou can record data generated by it aa its target track. Recording 

J J with custom controls is specially designed so that the data from the 

Button control item will not erase data that already exists in the track. 
Instead, data generated by a knob, slider, or button is merged with 

existing data. For example, you can record a crescendo (in the form 

of controller #7 data) from the control item without erasing any of the 

notes in the track. 

On the other hand, data from the control item replaces any existing 

data of the same type. If a track already contains controller #7 data 

from measure 1 to measure 10, and you record briefly with the slider 

in measure 5, the new data recorded from the slider will replace the 

existing controller #7 data in measure 5. 

With this in mind, sliders, knobs and buttons can be recorded in one 

of three ways: 

m You can record a single “snapshot” of the current setting of 

all the sliders and buttons in a console. To do so, set up the 

console the way you wish, set the Main Counter to the 

desired location, and then click the Snapshot button in the 

title bar of the console. Or, click the Snapshot button 

during playback or recording. For more information, see 

“Taking a Snapshot of a Console” on page 532. 

m You can record without Punch-in mode Canchecked in the 

console window mini-menu), which causes the slider or 

knob to record continuously, even when you are not 

moving the slider, so that it continually replaces its own 

data type in the track. 

m You can record with Punch-in mode, which causes the 

slider or knob to only record when you move it. Punch-in 

mode is enabled by default. 

Record-enabling an When recording console controls, a track has to be record-enabled. 

empty track Note, however, that you do not need to record-enable the track 

whose fader you want to record. 
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To avoid accidentally erase notes and other data when recording 

faders, do one of the following: 

m Record-enable an empty track 

OR 

m Record-enable any track and turn on Overdub Record 

mode 

To enable Auto Punch-In mode, select it from the mini-menu. A 

check appears next to it indicating that it is activated. 

To record data when punching in, press the Record button in the 

Consolidated Controls panel and move the control item. When the 

control item moves, data in the track of the same type as what the 

control item is sending will be replaced by the new control item data, 

just like normal control item recording. When you release the control 

item, recording will stop and it will return to monitoring the track. 

Moving the control item from an external control while punching in 

works much the same way: to punch in, the control item waits to 

receive an event from its external controller. When it does, it punches 

in. Punch out, however, is done automatically by Performer and is 

determined by the amount of time after the last event was received 

from the controller. 

Since controllers send data with different degrees of sensitivity, you 

may find that punch out occurs too frequently. To avoid stuttering 

punch out, you can lengthen the delay before Performer punches out 

with the Set Punch Out command in the console window mini-menu. 
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Summary 

Custom Control Consoles 

The Set Punch Out dialog box allows you to determine the punch out 

delay in tenths of a second. Usually, values between 5 and 15 work 

well. 

Here are several situations and a description of what control items 

will do in each case: 

Performer is not playing or recording: When the current location of the 

sequence is changed with the Controls or Counter Window, all 

control items jump to the value of their assigned parameter on their 

assigned track. They may then be moved; as they move they send out 

MIDI data of the assigned data type on the channel(s) of their 

assigned track. 

Performer is playing back: As Performer plays, the control items 

animate to reflect the values of their target data type from their target. 

A control item may be grabbed and moved independently, either by 

simply grabbing the handle or by external control; it then transmits 

MIDI data that takes the place of out-going data from its source track. 

The data it generates does not get recorded. When the control item is 

released, it returns to tracking the target track. 

Performer is recording: When Performer is recording, a control item is 

either in or out of Punch-in mode. Here is what happens in each 

condition: 

= With Punch-in mode, the control item simply monitors its 

target, just like playback. When you move it with the 

mouse, it records your movement. Data in the target track 

is replaced by data generated by the control item. (Only 

data of the same type is replaced). When the control item 
handle is released, the control item starts tracking the 

target track again. 

= Without Punch-in mode, a MIDI event corresponding to the 

current position of the control item is inserted into the 

target track(s). As recording continues, old data is either 

erased or replaced by new data of the same type generated 

by control item motions. Only data of the type assigned to 
the control item is affected. For example, recording a pitch 

bend control item would replace any existing pitch bend 

data with new data; notes, controller data, etc. would be 

unaffected. 

531 



Takin a Once you have created your custom console, you can take a 

snapshot of it. A snapshot captures all of the current slider and knob 

Snap sh ot of a settings. The snapshot is placed into the tracks of the currently play- 

Console enabled sequence. 

If you would like to record the snapshot, the target assignment of the 

sliders and knobs must be either a track or a device (instead of a 

MIDI channel). 

To take a snapshot of the current position of the sliders, knobs, and 

buttons in a console: 

1. Set the main counter to the desired location at which you wish to 

record the snapshot. 

You can also take the snapshot during playback or recording. 

2. Set up the sliders, knobs and other control items the way you 

would like them to be in the snapshot. 
Snapshot button 

3. Select the control items in the console that you want to include in 

the snapshot. 

See “Selecting Control Items” above. 

4. Click the Snapshot button in the title bar. 

When you click the snapshot button, each control item generates 

a MIDI event at that instant. The value of the event, such as the 

level of a volume controller, is determined by the control item’s 

position at the time the snapshot is taken. The event is inserted 

into the control item’s target track. If you have taken the snapshot 

of many sliders, knobs, etc., each item places its data into its own 

target track. 

Editing a snapshot Once data has been inserted into one or more tracks by taking a 
snapshot, the data can be edited in the standard fashion in the 

track(s). For example, if you wanted to remove the snapshot, select 

the data in the tracks window and delete it. 

Animation Unless the control item is being dragged, it monitors its target track, 

Durin g Playback animating during playback to reflect MIDI data that it has recorded 

into the track. 
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In general, the control item always reflects the current value of its 

target data type, even when cueing the sequence to a different 

playback location. For example, press the rewind button of the 

sequence. The volume control item will snap to zero. Now, type in 

measure 5 into the Counter window and press the return key. This 

sets the current playback position at measure 5. When you do so, the 

volume control item will snap to whatever the value of controller #7 

is at measure 5. 

Only controllers 0 to 63 are considered to be “continuous” MIDI 

controllers—ones that can express any value between 0 and 127. 

Controllers 64 to 120 are defined by the MIDI specification as 

“switch” controllers—ones that are either on or off. Controllers 121 to 

127 are reserved for special purposes. 

Some MIDI hardware, however, treats controllers 64 to 120 as 

continuous controllers. Performer’s control items can generate any 

controller from 0 to 120 as continuous data, providing you with 

maximum flexibility with MIDI devices that treat controllers 64 to 120 

as continuous controllers. 

Performer’s custom consoles provide the ability to group control 

items together and control them from a master control item. 

Grouping allows you to control an entire bank of controls at the same 

time from one control item. Up to 32 control items can be assigned to 

a single group, and Performer allows up to 26 groups, identified by a 

letter from A to Z. Any control item can be a master control item or a 

grouped control item. 

In addition, a master control item that controls a group can, in turn, 

be a member of another group controlled by another master. This 

allows you to create sub-groups of control items, and sub-groups 

within sub-groups. There is no limit to the number of layers you can 

create. 

Each control item in the group can have its own, customized relation 

to the group’s master control item. Grouping provides three ways in 

which a control item (slave) responds to its group master: the 

grouped control item can match, offset, or scale values received from 

the master. 
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When matching the master, the slave simply goes to the same value as 

the master. For example, if the master control item is set to 79, the 

slave goes to 79 as well. 

When offsetting the master, the slave can start at a different value than 

the master. When the master moves, the slave moves by the same 

amount, or by a percentage of the amount. For example, let’s say that 

the master is at 0, the slave is at 20, and the slave is offsetting by 

100%. If you move the master to 50, the slave will move to 70. If the 

slave is offsetting by 50%, it will only move to 45, which is 20 plus 

half of 50 (25). 

When scaling the master, the slave can start at a different value than 

the master. When the master moves, the slave moves by a percentage 

of the distance that the master moves in its relation to the end of the 

control item. For example, lets say that the master is at 0, the slave is 

at 64, and the slave is scaling by 100%. When the master moves to 64, 

which is half way to the top, the slave moves to 96, which is halfway 

of its distance to the top. If the master goes to 96, which is 3/4ths of 

its distance to the top, the slave goes to 112, which is 3/4ths of its 

distance to the top. By the time the master has reached 127, so has 

the slave. 

Slaves can be offset or scaled by a percentage between 0 and 999%, 

In addition to matching, offsetting, and scaling, a slave can react 

positively or negatively to its master. Positive polarity causes the 

control item to move in the same direction as its master. Negative 

polarity causes the control item to move in the opposite direction 

from its master. 

Negative polarity is extremely useful for many musical effects, such as 

cross-fading or panning. You can bring the volume of one track up at 

the same time as you bring the volume of another track down. 
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End Part | 

End Part | 

In this example, “End Part I” is the master and is being faded down 

from right to left. As it does, “Begin Part II” fades up from left to right. 

Null Points In the grouping offset and scaling examples above, you may have 

noticed that an important part of how masters and slaves work is their 

initial values. In Performer, the master’s initial value is called the null 

point and the slave’s initial value is called its reference value. 

A master’s null point is the value of the master slider on which 

changes to slaves are based. It is indicated on a slider as a bold hash 

mark behind the slider bar. 

The slave’s reference value is its value when the master is at its null 

point. Whenever you would like to see the reference value of a slave, 

move its master to its null point. 

Null point aon 
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The slave responds to changes in the master slider’s value, which are 

measured from the master slider’s null point, and it moves from its 

reference point based on those changes. As the master moves from 

its null point, the slave moves from its reference value. 

Performer’s null point is similar to the null point on most recording 

studio mixing consoles: it is a base value from which slaved sliders 

are measured. 

Hardware mixers usually have a fixed null point somewhere near the 

middle of the slider’s range. The null point of Performer’s sliders, 

however, can be set to any value on the slider, from zero to 127 (or 

—8192 to 8191). This provides an added level of flexibility when 

achieving the musical effects that you want. 

Slaves always follow their master. However, a slave is not “locked” by 

the master; it can be moved independently at any time, regardless of 

the master’s current value (position). When you move a slave, you 

are changing its reference point with respect to the master. In 

addition, its relation to the master is temporarily severed. The only 

way to reestablish the connection is to move the master, or reset the 

master to its current value. 

If you move both a master and a slave at the same time from the same 

external source, you will sever the master/slave connection between 

them and the slave will track the external source as if it was not 

connected to the master. 

To assign a control item to a group: 

1. Select one or more control items. 

2. Choose Group from the console window mini-menu. 

The Grouping dialog box will appear. 
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Assigning a Master 
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3. Type the group letter to which you want to assign the control item. 

The only restriction here is that a control item cannot be the 

member of a group if it is already the master of that group. Up to 

32 control items can be included in one group. 

4. Select the polarity. 

5. Choose whether to match, offset, or scale from the master. 

If you want the grouped control items to reach their highest and 

lowest value at the same time as the master, choose scale at 100%, 

which is perhaps the most intuitive way to group control items. 

6. Click OK to confirm your choice or Cancel to withdraw it. 

To assign a master control item: 

1. Unhighlight the Edit Mode button in the console title bar and select 

the control item. 

2. Choose Control Assignment from the mini-menu. 

ie) . Type a letter in the Group text box. 

You can enter any single letter. The only restriction is that the 

control item cannot be a master of its own group. 

4. Choose the Master option. 

5. Click OK. 
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To change the null point of a master slider: 

1. Option-click anywhere on the slider. 

The null point, which is indicated by a bold hash mark, will snap 

to the location, and you can drag it freely from there. 

The null point can also be changed more precisely as follows: 

1. Select the master slider. 

2. Choose Control Assignment from the console mini-menu. 

3. Make sure the Master radio button option is selected. 

4. Type in the desired null point in the box provided. 

5. Click OK to confirm your choice or cancel to withdraw the 

command. 

To change the reference value of a slave, move the master back to its 

null point, and then move the slave to the desired value. It is not 

mandatory to move the master to its null point beforehand, but if you 

do not, the value you are setting is the actual reference value and 

does not reflect the current difference between the master and its null 

point. As soon as you move the master again, reestablishing the 

master/slave connection, the slave will pop to its new relative 

position, often causing an unexpected result. 

To move a master to its null point, either drag the master’s handle to 

the bold hash mark, or highlight the slider and choose Goto Null 

Point from the Slider window or Console mini-menu. 

You can group buttons to a master button to send various messages 

to various destinations all at once. Just assign each button to the same 

group. Make sure each button is of the same type. Then create a 

master button that is also the same type. When you press the master 

button, the slaved buttons will be pressed and released at the same 

time. 

@ Please note: if you group buttons, the slaved buttons 

do not animate when you click the master button. 

They do, however, transmit data. 
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Performer allows you to generate system exclusive data from a slider 

or knob. The slider generates a continuous stream of messages, each 

containing a range of bytes (up to four) that are changed 

incrementally by the slider or knob. 

Doing so allows you to control device-specific parameters of MIDI 

hardware in ways that can not be achieved with continuous 

controller data. 

@ Please note! This section is not for the technically faint 

of heart. You should have a firm knowledge of MIDI, 

and you should be familiar with your hardware’s MIDI 

implementation. 

Before you begin this procedure, here’s what you need to know 

about the sysex message: 

= The message itself, or how to dump it into Performer 

a Whether or not the message contains a checksum, and if 

so, how many bytes the checksum consists of 

a What the data bit format is (7-bit or 4-bit nibble) 

mw Which comes first, the LSB or the MSB 

mw The specific bytes within the message that will be the 

variable bytes controlled by the control item (up to 4 

bytes) 

To set up a control item that generates sysex, you must first enter the 

sysex data into Performer, and you have two choices for how you can 

do so. You can: 

1. Type it in by hand 

2. Type in a request message and record it from the synth 

To set up a sysex slider or knob: 

1. Create the slider or knob. 

If the sysex message you'd like to control was recorded as a bulk 

dump into a device, be sure to assign the target to the device. 
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2. Select it and choose Control Assignment from the console mini- 

menu. 

3. Choose system exclusive from the Target data type pop-up menu. 

4. Click the Sysex setup button. 

The Assign Slider Sysex window appears. 

Hssign Slider Sy 

If you want to type in the sysex message, type the message into the 

sysex editor. For more information about how to use this editor, see 

the System Exclusive chapter. 

If you would like to enter a bulk dump request message, click 

Transmit. Performer’s standard sysex editor window appears, into 

which you can type in the bulk dump message. See the System 

Exclusive chapter if you need more information. 

Choosing the Variable Once you have the sysex message you want in the sysex editor 

Data Bytes display, you can now select which data bytes are to be the variables 

that will be controlled by the slider. 
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To select the variable data bytes: 

1. Choose replacement mode for the edit cursor so that you can 

highlight the desired bytes. 

2. Select the desired data bytes. 

You can select up to four bytes. 

3. Once the bytes are selected, click the Value button. 

Notice that the bytes now turn into a slider. 

FO (2 1) 20 
UU) Zi Ue 
30 30 30 33 
00 00 00 O00 

@ Note: if the sysex message is a device bulk dump, 

several sliders can edit the same bulk dump message. 

To see the values of the bytes being covered up by the slider, use the 

arrow keys to scroll the insertion cursor through the bytes. When it 

passes through the slider, the slider disappears for a few seconds. 

Setting the Checksum If the synth requires a checksum, Performer must generate the proper 

checksum as well, and it needs to know an initial value to do so. 

To set the initial checksum value: 

1. Click the Use Checksum check box. 

2. Select either the Straight sum or Sum to zero option. 

3. Type in the number of bytes for the checksum value. 
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4. Identify the first data byte that is checksummed. 

To do so, type in the byte number next to the Checksum button, 

or place the cursor at the first byte of checksummed data 

(normally the first byte immediately after the sysex header) and 

click the Checksum button. 

Setting the Bit Formats Select the appropriate bit format from the pop-up menu and select 

either LSB-->MSB or MSB-->LSB. 

You are done! Click OK. The slider will now generate the sysex 

message. If the synth does not respond, verify the checksum values. 

Monitor. ing a Sysex Sysex sliders cannot monitor the data they generate. This is due to the 

Slider During Playback amount of data processing that would be required in real time. 

Here is a work-around for this problem: 

1. Create two sliders. 

2. Make one the master and the other a slave. 

3. Make the Master slider generate an unused controller and assign 

its target to a track. 

4. Make the slaved slider read that unused controller from the same 

track as its source. 

5. Then make the slaved slider generate the sysex data. 

In this scenario, you move the master slider. It generates controller 

data at the same time that it is controlling the sysex slider, so that the 

sysex slider matches its movement. On playback, the sysex slider 

monitors the controller data and generates the sysex. Thus, the sysex 

data never gets recorded in the track; only the controller data does. 

But the controller data and sysex data match because the were slaved 

when originally recorded. The end result is that the sysex slider 

animates and plays back exactly as it was record. 
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Control items can serve many purposes. Some suggestions are 

discussed below. 

Control items can be used for remapping continuous controller data 

in real time. For example, you may have a synth module that 

responds to controller #10 CMIDI Pan), but you may not have any 

keyboards that can send this particular controller. A control item can 

solve this problem by remapping a controller that your keyboard does 

send into controller #10. To do so, assign the source of a control item 

to be a controller that your keyboard can transmit, such as controller 

#1 (mod wheel). Set the control item’s target to be the Device or track 

that sends to the synth module. Set the target data type to controller 

#10. Now, when you send controller #1 data from your keyboard by 

moving the mod wheel, you will be controlling the Pan settings on 

your synth module. 

Control Items also offer a way to reassign continuous data in real time 

instead of using the Reassign Continuous data command. For 

example, you may have a track of controller #3 continuous data that 

you wish to change to controller #7. You can set up the source of a 

control item to be the track containing controller #3. In turn, you can 

assign the target data type to be controller #7, and assign the control 

item to send the data to a different target track. When you press 

record, the control item will read in the controller #3’s and generate 

controller #7’s, which in turn will be recorded into the target track. 

Performer’s first priority is to keep up with the flow of MIDI data. If 

it encounters a great deal of data, it selectively ignores its graphic 

display until the microprocessor load decreases. This may affect the 

animation of control items, and they may not move smoothly when 

lots of data is being played—especially if there are many control 

items on the screen. This is Performer’s way of keeping up and does 

not necessarily mean that MIDI data is being transmitted inaccurately. 

Performer gives the currently active window highest priority when 

animating control items. Therefore, whenever you want to watch 

control items while Performer is playing back, make sure their 

window is active. To activate the window, simply click anywhere on 

the window. 
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If the control items you want to watch are in different consoles, you 

may want to create another single console that contains all of the 

control items you wish to monitor during playback. You can then 

make it the active window, and all of the control items in it will 

animate as smoothly as possible. You will find that as long as the 

console is active, Performer does a pretty good job of animating 

control items accurately. 

Another way to improve control item animation is to close as many 

consoles as possible. 

Loading Control Items Consoles from one Performer file can be imported into any other 

and Consoles From Performer file using the Load command, found in the File menu. This 

Another File means you can set up control items the way you like them, once, and 

they'll be available for importing into any of your files. 

The Consoles that you create in a file are automatically saved as part 

of that file. The Load dialog box, however, enables you to extract 

them from an unopened file, then load them into the file in which 

you are working. 

To load Consoles into an open file: 

1. Choose Load from the File menu. 

The standard Macintosh Open dialog box appears. 

2. Click the file containing the assignments you wish to load, then 

click Open. 

Alternately, you can double-click the file name. Performer’s Load 

dialog box appears, displaying the file name at top. 

3. Choose the Load Consoles option. 

4. Optional: If you wish to load any Chunks from the selected file, 
choose the Load Chunks option and either the Data or Link sub- 

option. 

If you wish to load more than one Chunk, you can drag to select 

contiguous Chunks and shift-click to select discontiguous Chunks. 

Deselecting this option loads only the file’s Control Items. 
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5. Click OK to confirm your choice(s) or Cancel to withdraw the Load 

command. 

Clicking OK causes the selected file’s Consoles, as well as any 

selected Chunks, to be loaded into the open file. The imported 

consoles appear in the Windows menu. 

When you program a button or slider to generate notes as shown 

below by the “Send” pop-up menu, you have three possibilities: 

1. Send notes (both note-ons and note-offs) 

2. Send note-ons only 

3. Send note-offs only 

For option 1, leave both check boxes unchecked. In this case, the 

slider, knob, or button will send a note-on when you click it, and it 

will send a note off when you either release it or move it to another 

note. 

For options 2 and 3, click the appropriate check box. In this case, the 

slider, knob, or button sends only a note on or a note off when you 

click it or move it. 

@ Please note: note-ons and note-offs by themselves do 

not constitute an entire note. Therefore, they cannot 

be recorded into a track. 

To create a mute button, create a button as described in the section 

“Creating a Button” on page 521. For the maximum value, click the 

“unmute button” as shown in Figure 31-1 on page 523. 

Master console controls can control their slaves while monitoring a 

target track. This means you can automate the movement of many 

slave controls at once by recording only the data of their master 

control. For example, you can automate a master fade-out at the end 

of a sequence by slaving multiple sliders (one for each track or device 

in your sequence) to a master slider and then recording the master 

slider. When you play back the result, the master slider monitors the 

data you recorded in its target track and simultaneously drives the 

volume sliders for all other tracks. To accomplish this, make sure that 

the master slider target assignment is a track (or a device which is 

assigned to a track). 
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@® Remember that the master slider’s track must be play- 

enabled for this to work. (It can’t be muted.) As a 

result, you might consider assigning the master slider’s 

track to a MIDI channel that you don’t use. Also, since 

the target data type for the master slider doesn’t matter 

(as long as it is some type of continuous controller), 

you might consider using a target data type for the 

master slider that is unlikely to affect anything else 

dike controller number 45). 
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Chapter 32 Change Key 

Quick Reference 

Key signatures provide a way to interpret MIDI note data. In music 

notation, there are several ways to write every pitch. For example, 

although G sharp and A flat sound the same and describe the same 

pitch, a G sharp would make less sense in the key of E flat than an A 

flat would. Performer allows you to specify key signatures in your 

sequences, making the display of notes in the Event Editing windows 

clear and musically accurate. Key signatures are also extremely 

important when viewing a sequence in music notation with 

Performer’s QuickScribe notation window; setting the correct key 

signatures ensures that the music will be properly notated. 

Start and end 
locations Spelling table 

Key type Spelling pop-up 

ios. menu 

Key select 
scroll bar 

Key name 

Start and End Locations: Displays the region over which the key change 

occurs. Click on a value to highlight it, and type the desired starting 

and ending measure locations. After each change is made, the From 

location is set to the previous To location. Click on the end of 

sequence button to change key from the From location to the end of 

the sequence. 
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Key type: Click on the appropriate radio button to select a Major, 

Minor, or user-defined Custom key. 

Key Signature Scroll Box: Use the scroll bar and arrows to select the 

desired key signature. Changing the key in this box automatically 

updates the key name and spelling table. 

Key Name: Displays the name of the key signature. The name appears 

as the key change event in the Event Editing windows. The name is 

set automatically when the Major or Minor key types are chosen. 

Click the name and type to change it. 

Spelling Table: Displays the spelling of the twelve chromatic notes for 

the currently selected key. Change a spelling by pressing on the note 

letter and selecting the desired spelling from the pop-up menu that 

appears. 

Key signatures in the Conductor track of a sequence apply to all the 

tracks in the sequence. At any given location, there can be only one 

key signature for all tracks. You can have as many key changes as 

you like in a sequence. 

Key changes appear for reference in all track Event Editing windows. 

They may be edited only in the Conductor track, either directly in the 

Conductor track Event Editing window or from the Tracks window. 

Each key change affects the spelling of notes to just before the 

beginning of the next key change. Key changes only affect the display 

of note pitches; they do not change the actual MIDI data in your 

sequence. 

If there is no key signature entered at the beginning of the sequence, 

the default key is C major (no sharps or flats). 

It is possible to put key changes in the Conductor track of a song, but 

they will have no effect on the spellings of notes in sequences 

contained in the song. Only key changes in the Conductor track of 

the sequence will affect notes within that sequence. 

Key signatures in Performer actually have two components: the 

standard key signature (up to seven sharps or seven flats), and note- 

spelling assignments for non-diatonic notes (notes not in the basic 

scale of the key). A key has five non-diatonic notes; Performer allows 
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you to decide how each of them will be spelled. In the key of D, for 

instance, you can name the note that lies between B and C sharp 

either B sharp or C natural. 

You can choose from three types of key signatures: 

= Major: Any key from C sharp major (7 sharps) to C flat 

major (7 flats) 

= Minor: Any key from A sharp minor (7 sharps) to A flat 

minor (7 flats) 

= Custom: You can choose a signature with 7 sharps to 7 flats 

and call it what you wish. This is useful for modal key 

signatures: C Phrygian, for example, has 4 flats. The key 

signature name is only for your reference: only the key 

signature itself is displayed on the staff in the QuickScribe 

notation window. 

To set a key signature or add a key change: 

FE Specify which sequence the key change affects. 

If a Tracks window is active, the key insertion will apply to that 

sequence. If the Chunks window is active, the key insertion will 

apply to the highlighted Chunk or, if no Chunk is highlighted, to 

the current play-enabled Chunk. If an Event Editing window is 

active, the key insertion will apply to whatever sequence it 

belongs to. 

. Choose Change Key from the Change menu. 

A dialog box will appear. Notice that the name of the sequence in 

which the key change will be placed is displayed at the top of the 

dialog box. 

Specify the From and To locations. 

These locations specify the starting and ending locations for the 

key change. Click on the fields and enter the desired 

measure | beat | tick values. If you have just entered a key change, 

the From location is automatically set to the previous To location. 

Click on the end of sequence button to change key from the From 

location to the end of the sequence. 
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4. Specify the type of key signature to be inserted. 

Click the options for major, minor, or custom, as explained above. 

5. Use the Key Signature Scroll bar to select the key signature. 

Use the scroll bar and arrows to choose the desired number of 

sharps or flats. The key name and spelling table are automatically 

updated as you scroll. 

6. Enter a name for the key change. 

Optional: If you have chosen a Major or Minor type, the name is 

automatically set. 

7. Choose the note spellings for each non-diatonic note in the key. 

Click on each note to select it and choose the desired spelling 

from the available ones displayed. 

8. Press the Change button to enter the change. 

The Change button enters the key change and leaves the dialog 

box open so that you can insert more key changes. 

You can repeat this procedure to enter as many key changes as you 

wish. When you are done entering changes: 

9. Click on the triangular Close box at the top left to close the dialog 

box. 

Key changes in a sequence can be viewed in two places: in the Event 

Editing windows for each track and in the Conductor track for that 

sequence. Key changes can be edited only in the Conductor track: 

they cannot be modified in the Event Editing windows for standard 

tracks. Key changes can be omitted from the editing windows by 

turning off their display with the View Filter. 

Key changes can be edited directly in either Event Editing window 

(Event List or Graphic Editing) for the Conductor track. This section 

discusses the editing of key changes in the Event List window. See 

the chapter 7he Graphic Editing Window for details on editing 

Conductor Track information graphically. 
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In the Event List for the Conductor Track, the location of a key 

change can be edited by altering its starting time. The key change 

itself may be modified by Option-clicking on it. The Change Key 

dialog box appears in which you can enter the modification. The box 

that appears is slightly different than the one chosen with the Change 

Key command: the Change button is replaced by OK and Cancel 

buttons, and the sequence name and From and To location fields are 

missing. Otherwise, this box works exactly as described above. 

To edit a key change in the Event List window for the Conductor 

track: 

1. Double-click on the Conductor track in the Tracks window. 

An Event Editing window will open. If the Graphic Editing 

window appears, go to the mini-menu on its tithe bar and choose 

Event List. The Event List window for the Conductor track will 

appear. 

2. Option-click on the key change event that you wish to change. 

If necessary, use the scroll bar to locate the desired key change 

event. The Change Key dialog box appears. 

3. Change the key type, signature, name, and spelling as desired. 

See the section above on entering key changes for information on 

these fields. 

4. Press OK to confirm your changes or Cancel to cancel them. 

You can apply the commands from the Edit menu to key changes in 

the Conductor track: key signatures can be cut, copied, pasted, 

spliced, etc., just like other events. The region to edit in the 

Conductor track may be selected by highlighting events in its Event 

Editing window or clicking on the Conductor track to highlight it and 

specifying a region in the Edit bar. Key change information can be 

included in an edit operation involving note and other MIDI events 

by including the Conductor track along with the selected tracks. 
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Chapter 33 Change Meter 

Quick Reference 

Meters specify the way musical time is counted and measured. In 

Performer, meters affect the way measure | beatI tick locations are 

displayed in the Counter, dialog boxes, and Event Editing windows. 

Meters also affect the Click and countoff. In addition, they impact the 

way information is displayed in Performer’s QuickScribe notation 

window. The Change Meter command allows you to enter any 

number of meter changes in a sequence. 

. Metronome 

Meter marking Click value 

Start and end 

locations 

Options 

Meter Marking: Displays the meter in standard musical format. Click on 

the numerator and/or denominator and type in new values to change 

it. 

Start and End Locations: Displays the region over which the meter 

change takes effect. Click in the From box to set the starting location. 

Click in the To box to set the ending location. Click on the end of 

sequence button to extend the region to the end on the sequence. 
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Options: Click on the appropriate radio buttons and/or check box to 

select the desired options. The Only move barlines option does not 

affect the actual events in the sequence. The Realign music 

automatically and Adjust durations options erase or change events 

to fit the meter. 

Metronome Click value: Displays the duration between clicks and 

between counter updates. Click on the desired note value. Click on 

the dot for dotted durations (i.e. one and a half times the chosen note 

value). 

Basics A meter consists of a beat value and the number of beats per 

measure. The beat value is generally the rhythmic pulse or beat of the 

music; a measure consists of a certain number of these beats. 

Performer displays meters in the standard musical fashion as a 

fraction, with the beat value in the denominator (on the bottom) and 

the number of beats per measure in the numerator (on top). In 

Performer, the numerator can be a value between 1 and 99. The 

denominator must be a power of 2 (1, 2, 4, 8, 16, 32, or 64). 

Numerator 

3 
“4 

Denominator 

A Meter Change event in Performer consists of a meter displayed in 

this way, along with a metronome click value. This value determines 

the spacing between the sounds and MIDI events produced by the 

Click feature. It also determines how often the Counter is updated 

during playback or recording. 

The meter’s denominator value, the beat value of the current tempo 

and the metronome click value are all related, though they need not 

be set to the same value. You may wish to have a meter of 4/4 with 

a tempo of half note = 180 with the metronome clicking every eighth 

note. The ability to use separate values allows a great deal of 

flexibility and accuracy during recording. 
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Using the 
Change Meter 
Dialog Box 

Change Meter 

If a sequence or song contains several meters, the resulting 

configuration of meters is termed a “meter map”. This map is simply 

the complete set of programmed meter changes for an entire 

sequence. These changes are displayed in the Event Editing windows 

for each track in the sequence. The meter changes for a given 

sequence or song can only be altered in its Conductor track. 

It is often useful to set up the meter map before recording the music, 

this way the measure locations of the events you record will stay 

consistent through the recording and editing process. If you change 

meter after recording a track or tracks, the measure | beat | tick 

locations of the events may change. 

Inserting a new meter may or may not have an audible effect on the 

music. Depending on the options you select for inserting a new 

meter, note events may be excluded and durations may change. 

These options are explained in detail below. 

Performer starts a new bar at every meter change. Thus, if a meter 

change is inserted in the middle of a measure, that measure will 

terminate early, and a new one will begin with the meter change 

event. 

To enter a meter or meter change: 

1. Specify which Chunk (Sequence or song) the meter insertion 

affects. 

If a Tracks window is active, the meter insertion will apply to that 

sequence. If the Chunks window is active, the meter insertion will 

apply to the highlighted Chunk or, if no Chunk is highlighted, to 

the current play-enabled Chunk. If an Event Editing window is 

active, the meter insertion will apply to whatever sequence it 

belongs to. 

2. Choose Change Meter from the Changes menu. 

The Change Meter dialog box will appear. The name of the Chunk 

in which the meter insertion will be placed is displayed at the top 

of the dialog box. 
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3. Enter the numerator and denominator of the meter to be inserted in 

the boxes next to the words Change meter to. 

Click in each box and type in the numbers. The numerator must 

be a value between 1 and 99. The denominator must be a standard 

note value: 1, 2, 4, 8, 16, 32 or 64. 

4. Choose the metronome click value. 

Click on the note value you want the metronome to click on. If 

you want a dotted note value, click on the dot in addition to the 

note value. 

5. Enter the beginning measure of the region which the meter change 

should affect. 

Click in the box under the word “From” and type in the beginning 

measure number. When you press the Change button the From 

value is automatically set to the previous To value. 

6. If you are going to be entering a series of meter changes quickly, 

choose the Next Measure option. 

This option lets you press the enter key once for each measure. If 

you have several measures in a row in the same meter, just press 

the enter key once for each measure. The “from” measure is 

automatically updated as you do so. This lets you enter meter 

changes efficiently for an entire sequence by quickly pressing the 

enter key repeatedly as many times as necessary for measures 

with the same meter. When you need to the meter changes, type 

in the new meter and press enter again as many times as necessary 

for the new meter. Keep going as long as necessary. 

7. If you are entering a meter change over a fairly long region, choose 

either one of the two remaining options; if necessary type in the 

end measure of the region. 

There are two options here: you can either specify a particular 

measure or the end of the sequence (or song). Click on the button 

next to the option you want. If you choose the specific measure 

option, click in the text box next to the word measure and type in 

a measure number. 
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The Metronome Click 
Value 

The Measure Range 

Realign Music 
Automatically 

Change Meter 

8. Choose to realign music in the region and adjust durations if you 

wish. 

To realign the music, choose the Realign music automatically 

option. If you wish to adjust the durations of notes in the region, 

click in the Adjust durations box. If you wish to leave the music 

unaltered, click in the Only move barlines button. A full 

explanation of these options is given below. 

9. Press the Change button to enter the change. 

The Change button enters the meter insertion and leaves the 

dialog box open so that you can insert more meters. 

10.To close the Change Meter dialog box, click in its close box. 

The metronome click value you specify will be associated with the 

meter change you choose. You can specify a different metronome 

click value for each meter change. See the chapter Click and Flash for 

more on the Click feature. 

When you enter a range of measures, Performer will change the 

meter up to but not including the to measure. The to measure does 

not change; it remains in the same meter as before the operation. This 

is very similar to the way most edit/region operations work; events at 

the end time are not affected. If you choose the end of sequence 

option, the meter change will continue to the end of the sequence, 

no matter how the sequence may change. 

For example, assume a sequence is completely in 4/4. Entering a 

change to 3/4 from measure 8 to measure 12 will place a 3/4 meter 

change in measure 8, and a 4/4 meter change in measure 12. The 

result is that measures 8 through 11 are now in 3/4, and measure 12 

remains in 4/4. 

This option allows you to maintain the metrical structure of each 

measure by deleting some note events and changing the durations of 

others. There is a sub-option, Adjust durations, which is discussed 

below. The following assumes that the Adjust durations box is not 

checked. When you change the meter of a measure that contains note 

events with this option on, beats are either added or removed 

according to the new meter you specify. If beats are added, rests are 

inserted for the new beats. If beats are removed, any note event 
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Adjust Durations 
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occurring in the removed beat will be removed as well. The durations 

of note events that start before the deleted beats are preserved. For 

example, suppose you have the following two measure passage in 4/ 

4 time: 

Graphically, the durations would be represented like this: 

Changing the meter to 3/4 and using the Realign music automatically 

without adjusting durations, the fourth beats would be removed. This 

would remove the quarter note in the first measure but not the whole 

note since it began before the deleted (fourth) beat: 

The whole note is 

not removed 

because it began 
before the fourth 

beat. Notice that it 

maintains its 

duration (four 
beats). 

The B-natural 

that was on beat 

four is removed. 

The Adjust durations sub-option can only be used when the Realign 

music automatically option is selected. The Adjust durations sub- 

option alters the durations of notes that begin before the removed or 

added beats. The durations are altered to conform to the new 

measure boundaries. In the example above, the original version in 4/ 

4 has a note lasting the whole second measure. With the Adjust 

durations option on, the duration of this note is altered such that the 

note will last for the entire measure in the new meter: 
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Only Move Barlines 

The duration of the 

four-beat whole 

note is truncated to 

fit the new 3/4 

measure. 

This option does not change any durations. It imposes the new 

barline structure over the music, keeping all durations the same. The 

above original 4/4 passage would look like this with the Only move 

barlines option: 

Original music 

Viewing Meters 

Editing Meters in the 
Conductor Track 

Change Meter 

Realigned using the Only Move Barlines option 

The meters in a sequence can be viewed two places: in the Event 

Editing windows for each track and in the Conductor track for that 

sequence. Meters can be edited only in the Conductor track; they 

cannot be modified in the Event Editing windows for standard tracks. 

The meters in a sequence will appear in the Event Editing windows 

for all tracks in that sequence. Meters can be omitted from the editing 

windows by turning off their display with the View Filter. Conversely, 

the entire meter map may be viewed alone by turning off the display 

of all other types of events. 

Meter changes can be edited directly in either Event Editing window 

(Event List or Graphic Editing) for the Conductor track. This section 

discusses the editing of meter changes in the Event List window. See 

the chapter 7he Graphic Editing Window for details on editing 

Conductor track information graphically. 
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To edit a meter change in the Conductor track Event List window: 

1. Double-click on the Meter Change event you wish to edit and enter 

the new values. 

Use the Tab key to move from field to field. The location and 

meter marking fields are edited like standard event values. Editing 

the metronome beat value field calls up a small pop-up box with 

note symbols for the possible values. Click on the note 

corresponding to the value you desire. 

2. Press the Return key to confirm the changes, or Command-period 

to cancel them. 

Clicking anywhere else on the screen will also cancel the edit. 

Using the Edit You can apply any editing command to meters in the Conductor 

Commands with Meter track: they can be cut, copied, pasted, spliced, etc., just like other 

Changes events. The region to edit in the Conductor track may be selected by 

highlighting events in its Event Editing window or clicking on the 

Conductor track to highlight it and specifying a region in the Edit bar. 

Meter information can be included in an edit operation involving 

note and other MIDI events by including the Conductor track along 

with the selected tracks. 

Hints and Editing meter changes can be confusing. If you feel that your meter 

E xXamples map has become too complicated, has errors that you can’t easily 

detect, or has somehow become excessively complex, you can delete 

it and re-enter it correctly from the start. 

To erase the current meter map: 

1. Activate the Tracks window for the sequence with the meter map 

you wish to erase. 

Click in the window to activate it. 

2. Double-click on the word “Edit” in the Edit Bar. 

This loads the start and end times of the entire sequence in the 

Edit Bar. 

3. Select the Conductor track by clicking on it. 

4. Choose Edit Filter from the Edit menu. 
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Uncheck all check boxes except for meter changes. 

Hold down the Option key and click on the meter change check 

box. Now the Edit commands will only affect meter changes. 

Choose Erase from the Edit menu. 

This gets rid of all the meter changes for the sequence. 

. Choose Edit Filter from the Edit menu. 

Restore your previous Edit Filter setting. 

You should always reset the Edit Filter after using it. 

Be careful when pasting into the Conductor track: pasting replaces 

events of all types selected in the Edit Filter. This may be what you 

want. If, however, you are just rearranging meters and wish to leave 

the other data where it is, make sure to set the Edit Filter for meter 

changes only. 

Here’s a method for inserting a number of new bars with a different 

meter into your sequence. 

2 Shift over the sequence to make room for the new bars. 

Enter the insertion point for the new bars in the Start time in the 

Edit Bar and double-click on the End time to set it to the end of 

the sequence. Then choose Shift from the Edit menu, and enter 

the number of bars you want in the current meter. 

. Choose Change Meter from the Change menu. 

Set the From and To locations for the meter change. 

Enter the beginning location of the new bars in the From field. 

Add the number of bars being inserted to the beginning time. 

Enter this in the To field. 

Click on the Realign Music Automatically option. 

Leave the Adjust durations box unchecked. This option adds or 

subtracts the necessary number of beats to ensure that new 

measures line up with the new meter. 
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5. Click on the Change button. 

This enters the meter change. 

6. Click on the close button to close the dialog box. 
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Chapter 34 Change Tempo 

Tempo is very flexible in Performer. Not only can there be several 

tempos in a Chunk (sequence or song) but they can change 

dynamically, resulting in accelerandos, ritards other programmed 

tempo effects. 

In Performer, tempo is controlled by the Metronome panel in the 

Consolidated Controls panel. The metronome provides three possible 

settings for tempo control: 

a The Tempo slider 

a The Conductor track 

m An external device, such as a mod wheel on a keyboard 

controller 

Only one of these sources can be chosen at a time. 

When Tempo Control is set to the Conductor track, you program all 

the tempo changes into the Conductor track. Collectively, these 

tempo changes are called the tempo map, and they occur 

automatically when you play the Chunk under Conductor track 

tempo control. 

Tempo maps can be programmed using the Change Tempo 

command as described in this chapter. Alternately, you can create a 

tempo map in real time by slaving Performer to Tap tempo synchro- 

nization. See the chapter called Receive Sync to learn more about 

creating tempo maps in real time using Tap tempo sync. 

563 



Quick Reference 

Change Tempo 
Time Display Button 

Beat value Tempo Density Button 

Tempo curves 

Start and end locations 

Anchored tempo————— 
indicators Tempo parameters 

Randomization option 

Beat Value: Displays the note value on which the tempo is based. Click 

on the desired note to choose it. Click on the dot to make the beat 

value a dotted duration (i.e. one and one half of the chosen note’s 

duration). 

Start and End locations: Displays the region over which the tempo 

change will take effect. Click on the box and type in the desired 

values. Use the Tab key to move from field to field. 

Anchored Tempo Indicators: Click on the anchor icon to toggle a 

starting or ending tempo between anchored and unanchored. 

Anchored tempos are automatically set to the current tempo in the 

region, preventing unwanted jumps in tempo. 

Time Display Buttons: Click on the appropriate radio button to select 

real or frame time for the tempo parameters. 
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Basics 

Change Tempo 

Tempo Density Buttons: Click on the appropriate radio button to choose 

between Coarse and Fine tempo event densities. The Fine setting 

generates 12 tempo events a beat; the Coarse setting generates far 

fewer events. 

Tempo Curves: Click on the desired curve button to select the type of 

tempo change desired. Each curve has a set of parameters and 

options which control the shape and range of the tempo change. 

Tempo Parameters: The number and type of parameters depends on 

the Tempo Curve selected. Parameters outlined by a box can be set 

by the user; other parameters are computed and verified by 

Performer when the Compute or OK buttons are pressed. Values that 

are incalculable or out of range will highlight and cause the 

Macintosh to beep (or the menu bar to flash). Press the Option button 

to change the parameters that can be edited. 

Randomize tempos: Check this box to randomize tempos within a 

specified range, expressed as a percent or as a number of beats per 

minute (bpm). 

Emphasis: Type a value between -9 and +9 to weight the 

randomization either lower or higher. 

The Options Button: Click on this button to select which parameters are 

user-definable. 

The Compute Button: Click on this button to compute the values for 

parameters that are not user-definable. 

The OK Button: Click on this button to enter the tempo change and 

close the dialog box. 

The Cancel Button: Click on this button to cancel the tempo change and 

close the dialog box. 

The Change Tempo command is used to create tempo changes. You 

can specify a static tempo change (i.e. a constant tempo) or a 

dynamic one (a smooth change) via a curve. A constant tempo 

contains no variation of the tempo for its duration; it is merely a 

change from one tempo to another. A smooth change contains 

varying tempo values. The way that these values change is specified 

by one of four curves. An accelerando, for example, is a smooth 
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change with a linear curve in which the tempo gradually increases. 

When a smooth change is specified with a curve, Performer 

approximates the smooth change with a large number of discrete 

tempo changes in quick succession. 

When you use Change Tempo, any existing tempo data in the 

specified region is erased and replaced by the new data generated by 

the command. 

A tempo map is simply the complete set of programmed tempo 

changes for an entire sequence or song. These changes are displayed 

in the Conductor track. 

‘@ The tempo changes for a given Chunk can only be 

edited in its Conductor track. 

To get a clear picture of the tempo map of a Chunk, you can use the 

View Filter to view only tempo changes in its Conductor track. 

The tempo map specifies the relationship between real or frame time 

and measure time. Each tempo map consists of tempo changes 

occurring at measure time locations. Performer always maintains a 

correlation between real and measure times according to the tempo 

map. When you move to a measure time location, the corresponding 

real time is computed and vice versa. The same measure will always 

occur at the same real time location no matter where you start 

playing. 

When you change the tempo map, the real times of all markers and 

events (viewed in Event Editing windows) are updated. The real time 

locations of locked markers do not change in this case. Rather, their 

measure times change. 

Performer’s tempo capabilities were designed to be very effective in 

film and video applications. Tempo calculations are very accurate 

resulting in very precise location abilities. Finding a frame time 

location will bring you to the exact measure time location 

consistently. Real time locations of events and markers are 

completely reliable and give an accurate representation of the timing 

of the music. 
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This precision is possible because Performer maintains a very high 

degree of internal tempo resolution, much greater than the two 

decimal places that you can enter. This resolution allows you to set 

the tempo for a region by specifying its length in real or frame time: 

Performer will calculate the correct tempo to make the end of the 

region occur at the time you specify. 

When you set the tempo control in the metronome to the Metronome 

slider, the programmed tempo map is temporarily disabled by the 

current metronome slider tempo setting. When you switch back 

tempo control to the Conductor track, the programmed tempo map is 

re-enabled. 

The Change The Change Tempo command lets you create smooth tempo changes 
in a defined region of time. The start and end of the region are 

Tempo defined by measure locations. With this command, you can calculate 

Command a tempo for a region by giving a real time length for it. 

To use the Change Tempo command: 

1. Choose the sequence or song in which you wish to insert a tempo 

change. 

If a Tracks window is active, the tempo change will apply to that 

sequence. If the Chunks window is active, the tempo change will 

apply to the highlighted Chunk or, if no Chunk is highlighted, to 

the current play-enabled Chunk. If an Event Editing window is 

active, the tempo change will apply to whatever sequence it 

belongs to. 

2. Choose Change Tempo from the Change menu. 

The Change Tempo dialog box appears. The name of the selected 

Chunk is displayed after the words “Change tempo of sequence 

(or song)” at the top of the dialog box. 

3. Choose the beat value of the tempo. 

Click on the value to select it; click on the dot if you want a dotted 

value. For example, a tempo of dotted eighth = 90 would require 

you to click on the eighth note and the dot. 

4. Choose between displaying times in real or frame time. 
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Selecting a Tempo Beat 
Value 

568 

5. Choose between coarse or fine tempo changes. 

Click on the appropriate radio button. 

6. Choose the curve you want for the tempo change. 

The curve type you select is highlighted. 

7. Enter the Start and End locations. 

Type in the measure | beat | tick values for the start and end of the 

region for the tempo change. 

8. Press the Options button repeatedly until the desired combination 

of Start/End tempo/times have boxes around them. 

There are several combinations of tempos and times that can be 

entered and computed. For each combination, the values you can 

set are enclosed by boxes. 

9. Enter all parameters enclosed in boxes. 

Type in the desired values. To set a Start or Ending tempo to the 

current tempo, click on the anchor icon for the parameter. 

10.Press the Compute button to calculate the tempo and time values 

based upon the parameters you entered. 

If the computed values are not satisfactory, enter new parameters 

and try again. 

11. Press OK to enter the tempo changes or Cancel to terminate the 

action without entering the changes. 

Tempo calculations may take some time after you press the Compute 

or OK button. To stop calculations in progress, press the Command 

and period keys at the same time. 

Tempos are measured in beats per minute. You can select any beat 

value for the tempo from a sixteenth note to a whole note. The beat 

value can be dotted. The number of beats per minute can be between 

20 and 400. At very slow tempos, you may want to use smaller beat 

values such as an eighth note. At fast tempos, you may want to use 
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Selecting a Time Display 

Setting the Start and End 
Points 

Using the Fine and 
Coarse Options 

Anchoring the Start and 
End Tempos 

Change Tempo 

larger values such as a half note. Your choice of beat value does not 

affect the frequency of the Click. This is set separately with the 

Change Meter command. 

When you type in a number of beats per minute in Performer (in the 

Metronome, in a pop-edited tempo event, or in the Change Tempo 

window), you can type in a timing resolution of up to a hundredth of 

a beat per minute (136.45, for example). In addition to providing you 

with a high degree of resolution, this also allows you to easily enter 

tempos that match standard frame click metronome values. 

You can choose whether to display start and end times in real or 

frame time. This is very useful for calculating timings in film and 

video work. 

The measure time locations entered in the Start and End boxes in the 

Change Tempo dialog box delineate the region in which the tempo 

change occurs. New tempo data will be inserted into this region 

according to your specifications. 

The Fine and Coarse options determine the density of tempo change 

data generated. Selecting the Fine option causes tempo changes to be 

generated 12 times per beat. This creates the smoothest changes but 

generates lots of data, taking up memory and possibly slowing down 

the display of real and frame times in the Markers or Event Editing 

windows. This option is best used over regions of only a few 

measures. With the Coarse option, fewer tempo changes per beat are 

generated. This is the best option to use in a large region. 

In most situations, the tempo changes generated by the Coarse option 

will sound completely smooth. The rule of thumb here is to use the 

Coarse option unless the tempo changes are not smooth enough: in 

this case, the Fine option can be used. 

The Start and End tempo parameters have an anchor icon next to 

them. When the anchor icon is highlighted, the tempo is anchored. If 

the anchor icon is unhighlighted, the tempo is not anchored. 

Start tempa 

60.0 End tempo 

To anchor or unanchor a tempo, click on the anchor icon next to it. 
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When a tempo is anchored, the current tempo at that location in the 

Chunk is used. For example, if you anchor the Start tempo parameter, 

the value used for that parameter will be the pre-existing tempo at the 

Start location. 

The anchoring option is used to make sure that tempos just before 

and just after the region are matched exactly. This insures that there 

are no sudden jumps in tempo at the start or end of the region. It is 

best to anchor tempos when you want this continuous tempo effect; 

you cannot achieve the same degree of accuracy when entering 

tempos manually. 

Using Tempo Curves The tempo curve buttons specify the values for the individual tempo 
change events created by the Change Tempo dialog box. Rather than 

inserting each tempo change manually, you can select a curve and set 

a few parameters; Performer will calculate the tempo changes 

necessary to create the desired effect. The flat, straight line (the 

constant curve) generates just one tempo change at the beginning of 

the region. The other curves -- linear, logarithmic, exponential and 

polynomial -- generate a number of tempo changes which 

approximate the shape of chosen curve. These curve types are 

described in detail below. 

Regular 

Linear 

Curve 

Flipped 

Linear 

Curve 

To select a curve, click on the button containing the picture of the 

curve. The currently selected curve is highlighted. When a curve is 

selected, the associated parameter fields are displayed in the lower 

section of the dialog box. 

The curves are all displayed as increasing values. However, if you 

specify an End tempo that is less than the Start tempo, the tempo 

changes generated will decrease over time according to the chosen 

curve. In effect, this flips the curve upside down. For example, if you 
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Curve Parameters 

The Constant Curve 

Change Tempo 

wanted to program a ritard (slowing down), you’d choose the linear 

curve and enter a lower ending value. This would “flip” the effect of 

the curve from up to down, as shown to the left. 

Each curve has unique parameters. These parameters are the specifi- 

cations for the tempo change data to be generated: starting time, 

ending time, etc. In addition, these parameters can be combined in 

several different ways for each curve. For example, the linear curve 

allows you to set different combinations of the Start tempo, End 

tempo and End time. After selecting a curve, pressing the Options 

button cycles through the various combinations of parameters 

possible for that curve. Parameters that you can enter are in boldface 

type and are enclosed in a box; parameters that Performer will 

compute (and that you cannot enter) are in plain type without the 

box. 

After you enter the parameters for a curve, you must press the 

Compute button for the other parameters to be calculated. These 

calculations are not automatic: you must explicitly request them by 

pressing the Compute button. These calculations can take time; if you 

are certain about the values you have entered it is not necessary to 

use the Compute button. To abort a calculation in progress, press the 

Command and period keys at the same time. 

Each curve displays its Start time parameter. This value is not user- 

changeable; it is always computed from the starting measure time 

location. It is provided as a reference for viewing the length of the 

region. 

The following paragraphs describe the effects of each curve on the 

specified region and the parameter options for each. 

The constant curve sets the region to a constant tempo by inserting 

only one tempo change at the beginning of the region. 

Parameters: 

Tempo: This is the tempo for the entire region in beats per minute. 

You can use one decimal place value if you wish, e.g. 89.7. If you 

anchor the tempo, it will be the same as the pre-existing tempo at the 

Start location of the region. 
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The Linear Curve 

The Logarithmic and 
Exponential Curves 

572 

End Time: This is the time at which the end measure location will 

occur. 

The linear curve creates a smooth tempo change with no fluctuations 

in the specified region. 

Parameters: 

Start Tempo: This is the tempo at the Start location of the curve in 

beats per minute. If you anchor this value, it will be the same as the 

pre-existing tempo at the Start location. 

End Tempo: This is the tempo at the End location of the curve in 

beats per minute. If you anchor this value, it will be the same as the 

pre-existing tempo at the End location. 

End time: This is the time at which the End location occurs. 

These two curves are similar: they both create a smooth change in the 

specified region. The logarithmic curve changes tempo more rapidly 

at the beginning of the region; the exponential curve changes tempo 

more rapidly at the end. 

Parameters: 

Start Tempo: This is the tempo at the Start location of the curve in 

beats per minute. If you anchor this value, it will be the same as the 
pre-existing tempo at the Start location. 

End Tempo: This is the tempo at the End location of the curve in 

beats per minute. If you anchor this value, it will be the same as the 

pre-existing tempo at the End location. 

End time: This is the time at which the End location occurs. 
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The Polynomial Curve 

The Randomize Option 

Change Tempo 

Curvature: This is a value that controls the degree of curve in the 

smooth change (.e. its non-linearity). Enter a value between 1 and 

99. Low curvature values flatten the curve and produce a more even 

rate of change. For example, a value of 1 results in a near-linear 

change that is similar to the linear curve. High curvature values round 

out the curve and result in more change at the beginning or end of 

the region depending on the button selected. For example, a value of 

99 will cause much of the tempo change to occur at either the 

beginning (for the logarithmic curve) or the end (for the exponential 

curve). The higher the curvature value, the more pronounced the 

curve shape. 

The polynomial curve creates a change in the specified region which 

starts smoothly at the beginning of the region, changes most rapidly 

in the middle and ends smoothly. Note that the unique parameter 

Mid Beat is included with this curve, allowing you to control aspects 

of the middle of the curve. 

Parameters: 

Start Tempo: This is the tempo at the Start location of the curve in 

beats per minute. If you anchor this value, it will be the same as the 

pre-existing tempo at the Start location. 

End Tempo: This is the tempo at the End location of the curve in 

beats per minute. If you anchor this value, it will be the same as the 

pre-existing tempo at the End location. 

Curvature: Allows values between 1 and 99. Low curvature values 

flatten the curve; high values round it. Values of 30 to 60 work 

particularly well with this curve. 

Mid Beat: This is the measure time location at which the Mid Tempo 

value occurs. This is the point at which the most rapid tempo change 

occurs. This location can be any time between the Start and End 

times and allows you to control where most of the changing will 

occur. 

End time: This is the time at which the End location occurs. 

The Randomize option causes the tempo or tempos being generated 

by one of the selected curves to be randomized within a range for the 

entire region over which the tempo change is being made. For 
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example, if you are inserting a constant tempo of 120 bpm without 

randomization, the result is a single tempo event at the beginning of 

the region as shown below: 

However, with the Randomize option checked and the range set to 

+25 bpm, the result is a tempo map that constantly and randomly 

changes between 95 and 145 bpm: 
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Randomization can be used in conjunction with any 
curve 

Randomization option is a check box option, which means that it can 

be used in conjunction with any of the tempo curves: 

A linear tempo curve with no randomization. 

The same curve with randomization set to +10 bpm. 

Controlling the degree of randomization 
The Randomize option is ideal for adding “human feel” to the tempos 

of a sequence. By controlling the range over which the randomizing 

occurs, you control the degree of that feel. You can specify the range 

either as a percentage or as a range of bpm. In either case, each 

tempo event generated is placed randomly within the range. 

Emphasis 
This sub-option causes the tendency of the randomization to be 

higher or lower within the specified range. Thus, if you wish to 

randomize the tempos within a certain range, but you wish them to 

tend to be higher, use a positive emphasis; use a negative emphasis 

if you wish them to tend to be towards the lower end of the range. A 

value of zero equals no emphasis, which causes the randomization to 

occur evenly within the range. 
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The Options Button 

The Compute Button 

The OK and Cancel 
Buttons 

Viewing and Editing 
Tempo Changes 
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The effect of Density on randomization 
A Fine density setting causes tempo events to be generated more 

frequently than a Course density setting. Notice that these two 

settings have an effect on the constant tempo curve, which normally 

only produce a single tempo event. 

Pressing the Options button cycles through the different 

combinations of entered/computed parameters for the selected 

curve. This allows you to specify the curve in a variety of manners. 

For example, if you select a constant curve, you can specify just the 

tempo or you can specify the End time, in which case the tempo will 

be calculated to make the end measure location occur at the end 

time. 

If you are not working with externally imposed timings such as are 

used in film and video work, you will probably not need to use the 

Options button. 

The Compute button calculates and displays computed parameters 

(those which you cannot enter yourself) based upon the parameters 

you enter. Traditionally, these calculations are done by the composer 

or arranger either with arithmetic or by using a reference book. 

Performer gives you a quick means to make these calculations with 

the Compute button. Since computed parameters are not updated 

automatically, you must use the Compute button to see their current 

values. The Compute button doesn’t make any internal alterations to 

the tempo data; it is just a utility to let you see all the parameters. 

Pressing the OK button computes the tempo changes and enters 

them in the Conductor track. The computation may take a while. If 

you want to terminate the computation, press the Command and 

period keys together. Pressing the OK button automatically makes all 

the calculations for all the parameters. 

Pressing the Cancel button terminates the Change Tempo command 

without entering any of the changes you made. 

Tempo change data is stored in the Conductor track for the Chunk. 

Tempo changes look like continuous MIDI data (such as pitch bend 

or controller information) in the Conductor track Event Editing 
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windows. Each tempo change has a time and a tempo value. The 

tempo has two parts, the tempo value in beats per minute and the 

beat value (e.g. 1/4 note, 1/8 note, etc.) 

Editing tempo changes can be done in either the Tracks window or 

the Event Editing windows for the Conductor track. You can apply all 

the commands on the Edit menu to tempo changes. Make sure that 

tempo changes are selected in the Edit Filter, available from the Edit 

menu. 

Note that smooth tempo changes require a large number of discrete 

tempo changes very close together. Also note that Performer’s 

internal resolution of tempo events is much higher than that 

displayed in the Event Editing windows. So, tempo events that seem 

identical actually represent different tempos with higher resolutions 

than can be shown. 

To edit tempo changes using the Tracks window, set the Edit Bar 

times and select the Conductor track. To edit tempo changes in one 

of the Event Editing windows for the Conductor track, just highlight 

One or more tempo change events as you normally would in any 

other track’s editing window. Make sure that tempo changes are 

selected in the View Filter. You can also insert single tempo changes 

by using the Insert button in the title bar. See the chapter The 

Conductor Track for more information. 

Tempos can be manually edited to a resolution of a hundredth of a 

beat per minute. When you use the Compute button in the Change 

Tempo dialog box, tempos are calculated to a much higher degree of 

accuracy. 
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Chapter 35 The Conductor Track 

Basics 

The Conductor track is a special track containing markers, meter, 

tempo and key change information. Every sequence and song has a 

Conductor track; it cannot be deleted. You may use the commands 

from the Edit menu in the Conductor track to Cut, Paste, Repeat, Shift, 

and otherwise edit tempo, meter, and key maps, as well as markers. 

In addition, the Conductor track can be used to directly insert simple 

tempo, meter, and key changes, as well as to ‘record’ a tempo map 

entered in real time using Tap tempo synchronization. 

The Conductor Track has two available Event Editing windows: the 

Event List window and the Graphic Editing window. The examples in 

this chapter refer to the Conductor track’s Event List window; see the 

chapter 7he Graphic Editing Window to learn about editing the 

Conductor track graphically. 

The Conductor track automatically appears in the Tracks window for 

each sequence. The Conductor track cannot be deleted or renamed; 

it can be moved and given comments like a standard track. The 

Conductor track has a record-enable button for use with Tap tempo 

synchronization, described in the Receive Sync chapter. The 

Conductor track cannot be looped. 

A song’s Conductor track can be opened by choosing Edit Conductor 

Track from the Song window mini-menu. 

The Conductor track contains four types of events: Tempo changes, 

Meter changes, Key changes, and Markers. These events are not MIDI 

data; instead, they control or conduct your music’s performance 

during playback. The tempo, meter, and key events can be edited like 

standard MIDI events, either with the commands on the edit menu or 

directly in the Conductor track Event List or Graphic Editing window. 

Unlocked markers may be edited in the Conductor Track; locked 

markers may only be edited in the Markers window. 
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The following sections describe each type of event in some detail; for 

more information on the Change Key, Change Meter, and Change 

Tempo commands, or the Markers window, see the appropriate 

chapters. 

Key change events display the name of the key. User-defined key 

signatures are displayed as ‘Custom’. See the Change Key chapter for 

a full description of key signatures in Performer. 

Also note that this section discusses the editing of key changes in the 

Conductor track Event List window. See the chapter The Graphic 

Editing Window for information on editing the Conductor track 

graphically. 

To insert a Key change event in the Conductor track Event List 

window: 

1. Press the Insert button in the Event List window title bar. 

2. Select Key Change from the menu. 

A new Key change event appears, with the location field 

highlighted for editing. 

3. Type in the measure, beat, and tick location and key for the event. 

Use the Tab key to move from field to field. When you highlight 

the key field, the Change Key dialog box will appear. See the 

Change Key chapter for information on this dialog box. Click OK 

to confirm the key; the key you specify will be in effect until the 

next key change. 
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4. Press the Return key to confirm your choice. 

You can cancel the insertion by clicking anywhere else on the 

screen. 

To edit a Key change event in the Conductor track Event List window: 

1. Option-click or double-click on the Key change event. 

A pop-edit box will appear. 

2. Change the location or key information. 

Use the Tab key to move from field to field. When you highlight 

the key field, the Change Key dialog box will appear. See the 

Change Key chapter for information on this dialog box. Click the 

OK button to confirm the key change; the key you specify will be 

in effect until the next key change. 

3. Press the Return key to confirm your edit. 

You can cancel the edit by clicking anywhere else on the screen. 

Meter Changes Meter change events display the time signature (the number of beats 
per bar, over the duration value which gets the beat) and the click 

4/4 click J value, (the duration value between metronome clicks). See the 

Change Meter chapter for more information about these values. 

Moving meter change events, or inserting them using the Insert 

button, can cause unexpected results: please read the section later in 

this chapter on Meter Changes and Partial Measures before 

attempting to move or insert a meter change. 

This section discusses the editing of meter changes in the Conductor 

track Event List window. See the chapter 7he Graphic Editing 

Window for information on editing the Conductor track graphically. 

To insert a Meter change event in the Conductor track Event List 

window: 

1. Press the Insert button in the Event List window title bar. 

2. Select Meter Change from the menu. 

A new Meter change event will appear, with the location field 

highlighted for editing. 
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3. Type in the measure, beat, and tick location, meter, and metronome 

click value for the event. 

Use the Tab key to move from field to field, and type in the correct 

values. Use the mouse to select your choice of click value. 

4. Press the Return key to confirm your choice. 

You can cancel the edit by clicking anywhere else on the screen. 

Note that if you typed in a tick location other than 000, the meter 

change will show 000 after you press return. This is because a 

meter change always starts a new measure. See the section on 

Meter changes and partial measures later in this chapter. 

To edit a Meter change event in the Conductor track Event List 

window: 

1. Option-click or double-click on the Meter change event. 

The event will be highlighted. 

2. Change the location or meter information. 

Use the Tab key to move from field to field, and type in the correct 

values. Use the mouse to choose the click value from the pop up 

box. 

3. Press the Return key to confirm your edit. 

You can cancel the insertion by clicking anywhere else on the 

screen. Note that if you typed in a tick location other than 000, the 

meter change will show 000 after you press return. This is because 

a meter change always starts a new measure. See the section on 

Meter changes and partial measures later in this chapter. 

Tempo change events display the duration value for the tempo 

marking, i.e. the note value of the basic beat, and the tempo value 

itself, as a certain number of beats per minute. Tempo changes can 

appear singly, indicating an abrupt change in tempo, or as a series of 

events, approximating a smooth increase or decrease in tempo. In 

this regard they resemble continuous controller or pitchbend 

information. For more information on tempo events, see the Change 

Tempo chapter. 
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There are two ways to insert Tempo change invents in the Conductor 

Track: by directly inserting them, and by recording them while slaved 

to Tap tempo synchronization. The following procedures cover direct 

insertion and editing in the Conductor Track. 

For information on recording a tempo map in real time, refer to the 

Tap tempo section in the chapter Receive Sync. Recording in Tap 

tempo creates normal tempo events which can be edited as described 

below. 

Also see the chapter The Graphic Editing Window for information on 

editing tempo changes graphically. 

To insert a Tempo change event in the Conductor track Event List 

window: 

1. Press the Insert button in the Event List window title bar. 

2. Select Tempo Change from the menu. 

A new Tempo change event will appear, with the location field 

highlighted for editing. 

3. Type in the measure, beat, and tick location and tempo for the 

event. 

Use the Tab key to move from field to field, and type in the correct 

values. Use the mouse to select your choice of beat value. 

4. Press the Return key to confirm your choice. 

You can cancel the insertion by clicking anywhere else on the 

screen. 

To edit a Tempo change event in the Conductor track Event List 

window: 

1. Option-click or double-click on the Tempo change event. 

The event will be highlighted. 
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2. Change the location or tempo information. 

Use the Tab key to move from field to field, and type in the correct 

values. Use the mouse to choose the beat value from the pop up 

box. 

3. Press the Return key to confirm your edit. 

You can cancel the edit by clicking anywhere else on the screen. 

Markers Markers are visible in all Event Editing windows, but they may only 

be edited in the Conductor track editing windows. Markers cannot be 

created directly in the Conductor track editing windows; use the 

[F Bridge Markers window to insert or record new markers. In addition, locked 

markers cannot be edited in the Conductor track. Unlocked markers 

can be edited in the Conductor track with the Edit Menu commands. 

For more information on pop-editing markers see The Markers 

Window chapter. 

Editing in the The Edit commands Cut, Copy, Paste, Erase, Repeat, Merge, Snip, 
Conductor Track Splice, and Shift all function on the events in the ea track. 

You can use them to move tempo and meter changes together with 

other tracks in a sequence, shift tempo maps for precise alignment 

with synchronized video or audio, or to repeat tempo, meter, and key 

changes in looped sections. 

To use the Edit commands on the Conductor track of a sequence: 

1. Highlight the Conductor track name in the Tracks window and set 

the Start and End times in the Edit bar for the correct region, 

OR 

2. Open an Event Editing window (Event List or Graphic Editing) for 

the Conductor track and highlight the correct events. 

3. Select the desired command from the Edit menu. 

To use the Edit commands on the Conductor track of a song: 

1. Open the Song window. 

Do so by double-clicking the Song name in the Chunks window. 
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2. Choose Edit Conductor track from the Song window mini-menu. 

The Event Editing window for the song’s Conductor track will 

appear. 

3. Highlight the events you wish to edit. 

4. Select the desired command from the Edit window. 

The Edit menu commands affect events in the Conductor track in the 

same way as normal MIDI data. See the chapter Edit Commands for 

more on how to select regions and use these commands. 

When a region is cut or copied from the Conductor track, meter and 

tempo events representing the current meter and tempo values are 

automatically inserted at the beginning of the region in the clipboard. 

This guarantees that the region will keep its original meter and tempo 

when pasted elsewhere in the sequence or song. These automatically 

created meter and tempo change events may be edited normally after 

the region is pasted back into the Conductor track. 

Note that editing meter changes can cause unexpected results. Read 

the section on Meter Changes and Partial Measures below before 

editing Meter change events. 

To effectively edit events in the Conductor track it is important to 

understand how the Edit and View Filters affect the commands on the 

Edit menu. Please review the section Setting the Edit Filter in the 

chapter Edit Commands and the section The View Filter in the chapter 

The Event List Window before working extensively with the 

Conductor track. Both filters affect the Conductor track the same way 

as they do for regular tracks. 

Here are some guidelines to remember when using the Edit and View 

Filters: 

a The Edit Filter selects which types of events are edited 

from the Tracks window. 

a The View Filter selects which types of events are viewed 

and edited in each Event Editing window. 
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m The Edit Filter does not affect editing in the event editing 

windows; all visible, highlighted events in an editing 

window are affected by the editing commands. 

Both filters will affect all Edit commands used in the filters’ respective 

windows. For example, pasting over existing events will erase only 

those types of events selected in the filters; other events are retained 

and merged with the pasted data. 

The Edit and View Filters are important when editing the Conductor 

track because it is common to want to edit just one element, e.g. 

tempo changes, without affecting the other events in the track. For 

example, the tempo changes in measure two of this sequence can be 

moved to measure One using the Edit Filter and Tracks window. 

1. Select the Edit Filter from the Edit menu, or press command-F. 

The Edit Filter dialog box appears. 
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2. Option-click the check box for Tempo. 

This is a easy way of deselecting everything but Tempo change 

events. 

3. Highlight the Conductor track in the Tracks window. 

4. Set the Edit bar for the correct region. 

In this case, the region starts at 2/1/000 and ends at 3/1/000. 

5. Select Cut from the Edit menu. 

The Tempo changes are removed; the Meter change is unaffected. 

6. Change the Edit bar start time to 1/1/000. 

7. Select Paste from the Edit Menu. 

The Tempo changes appear in the first measure; the Meter 

changes are unaffected. 
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8. Set the Edit Filter back to normal. 

Select it from the Edit menu (or press command-F) and use the Set 

All button to check all the boxes. 

If the Edit Filter had not been set during this example, the Meter 

change in the second measure would have been cut along with the 

Tempo changes, and the Meter change in the first measure would 

have been erased during the Paste command. 

Pertormer lets you to place a Meter change event anywhere in a 

sequence or song. This allows a great deal of flexibility in laying out 

your music, but can produce unexpected results. For example, it is 

possible to place a Meter change in the middle of a measure, but this 

measure will be truncated at the location you specify for the new 

meter. This location becomes the downbeat of the first measure in the 

new meter. 

The following simple rule should help clarify what happens in such 

situations: 

@ A Meter change event always starts d new measure. 

For example, if the Insert button in the Event List title bar is used to 

place a meter at 3111240, when you press the Return key to confirm 

the insertion, the meter change location will change to 3111000. This 

is because a meter must begin a new measure, and all measures 

begin at zero (O00) ticks. 
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Here’s another example: if the Insert button is used to place a 3/4 

meter at the third beat of a 4/4 measure, the result is a two beat 

measure (still marked as 4/4!) followed by a whole 3/4 measure. 

Inserting the Meter change results in a partial measure, that is, a 

measure lacking its full duration. 

While such partial measures are not always useful, they can be handy 

in lining up cues for film and video work, since they let you start a 

measure precisely at a SMPTE time by creating a meter change at the 

right spot. 

Partial measures may also result from using the Edit commands to 

Paste, Merge, or Repeat meter changes in the middle of existing 

measures. Once again, each new meter change event will begin a 

new measure. 

It is important to remember that meter changes only affect the way 

data is displayed; they never affect the MIDI data itself or the way it 

sounds when it is played back. If the meter map for a sequence or 

song becomes complex or confusing during editing, simply erase the 

meter changes and re-enter them from the start of the region. 

Another way to avoid partial measures is to use the Change Meter 

command found in the Change menu. The Change Meter dialog box 

will never create partial measures. 

The Conductor track cannot be looped. If you need to repeat tempo 

or meter changes in a looped region, use the Repeat command from 

the Edit menu to make consecutive copies of the Conductor track 

over that region. 

When using the Memory-cycle feature to play a section repeatedly, 

meter and tempo changes in the conductor track will play as usual. 

When doing so, it is often useful to switch tempo control in the 

Metronome panel to the Metronome slider. Doing so temporarily 

disables tempo changes so that they don’t complicate recording. 
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Chapter 36 The Record Beats Command 

The Record Beats command, found in the Change menu, allows you 

to record music without listening to a metronome click and then 

afterwards realign Performer’s internal beats and barlines with the 

music you recorded. 

Here’s a simple example. The Graphic Editing window below is the 

tune Mary Had a Little Lamb recorded without Performer’s 

metronome click: 

Mary Had a Little Lamb recorded in the Graphic Editing window without using 
the metronome click. Notice that the first note is not on beat 1 and that none of 

the downbeats in the music match the downbeats in the measure ruler above. 

Notice that the music does not line up with the beats and barlines in 

the measure | beat | tick ruler. This prevents many useful editing tasks, 

such as quantizing and easy region selection. 

After using the Record Beats command, Performer’s beats and 

barlines have been realigned to match the beats in Mary Had a Little 

Lamb: 
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Mary Had a Little Lamb after using the Record Beats command. 
Notice that the beats and barlines in the time ruler now match the 
downbeats in the music. Also note that the music plays back exactly 
the same way as the original recording (as long as the Tempo 
Control in the Metronome is set to the Conductor track). 

It is important to note that Performer’s beats have been realigned to 

the music, not the other way around. The music plays back in the 

same fashion as the original recording. When using Record Beats, 

you are in no jeopardy of losing the original feel of your 

performance. Performer accomplishes this by creating a tempo map 

at the same time as realigning the beats. Thus, Performer’s beats 

speed up and slow down to match the original performance. 

Once beats and barlines have been realigned, many useful editing 

commands can be employed that were not possible beforehand. For 

example, the above tune can now be successfully quantized for 

rhythmic accuracy and transcription: 

After using Record Beats, music can be 
quantized, groove quantized, and edited. 

To use Record Beats: 

1. Record music into a track. 

You can play as freely as you like. Pay no attention to Performer’s 

Counter window. You can even turn off the Metronome click. 
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2. Open the Event List window and make note of the time of the first 

event. 

In the Mary Had a Little Lamb example above, the first note 

occurred at 1121115: 

3. Set the Main Counter to the same time as the first event. 

In this example, we enter 1121115 into the main Counter. 

4. Choose Record Beats from the Change menu. 

The Record Beats dialog box will appear. 

- Record beats = 
Se PePES ES ESS 
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5. Use the OK is first beat option. 

This option means that Performer will place the first downbeat 

right at the current counter location, which is 1121115, the 

location of the first note in this example. 

6. Check the Shift data to option and type in the measure and beat at 

which you want to place the first downbeat. 

For example, if the first note of music should be at measure 1, beat 

4, as a pickup note, type in measure 1, beat 4. Be sure that the 

location you choose here is NOT before the sequence start. 

7. Get ready to tap any note on your MIDI controller. 

Get ready to tap along with the music you played. 

8. When you are ready, click OK and begin tapping on the second 

beat. 

With the OK is first beat option, Performer begins playback and 

taps the first beat for you at the starting location of the Counter. In 

this example, Performer places the first tap at 1121115. You 

should then begin tapping on the second beat. If you miss the 

second beat, stop, Undo, and try again. 

9. Keep tapping along with the beats in your music as accurately as 

you can. 

10.When you reach the end of the piece, click Stop. 

Performer may take moment to realign the beats and enter the 

newly generated tempo data in the Conductor track. 

After Performer calculates the changes, the downbeat of your music 

will now be at the measure and beat that you indicated with the Shift 

data to option. In addition, the Counter will beat in 4/4 time on the 

downbeats that you tapped. To change the meter, refer to the section 

later in this chapter called Handling Odd Meters. 
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Listening to What You To listen to the result of your tapping: 

Have Done 
1. Choose Conductor track from the tempo control pop-up menu in 

the Metronome panel. 

Performer will now play back according to the new tempo map in 

the Conductor track. 

2. Press the Play button. 

The music will sound the same, and the metronome and Counter 

windows will line up with the music as accurately as you tapped 

while Recording Beats. 

Using a Countoff and the The Tap first beat option in the Record Beats dialog box allows you 

Tap First Beat Option to tap the first beat when you recorded a countoff at the beginning of 

your original performance, or a visual cue on film or video at which 

to start tapping. 

In this case, you have an aural or visual cue before the first tap that 

allows you can prepare to hit the first tap accurately. 

To use the Tap first beat option: 

1. Set the counter to a position several seconds before the first tap. 

This will give you enough time to prepare for the first tap. You can 

have as much preroll time as you like to get ready for the first 

beat. 

2. Choose Record Beats and select the Tap first beat option. 

3. Click OK to begin Recording Beats. 

Performer will begin playing back. Listen carefully to the countoff 

or music and get ready for your first tap. Performer will not begin 

recording beats until your first tap. 

4. Begin tapping on the downbeat where you would like to begin 

realigning beats. 

5. If you are punching out, click Stop immediately after your last tap. 

This prevents music after the punch-out time from being realigned 

inadvertently. Performer may take a moment to realign the beats. 
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The Record Beats command realigns your original Performer into a 

default meter of 4/4 time. However, if you would like the music to be 

expressed in an odd meter or in changing meters, you can do so by 

using the Change Meter command after using Record Beats. 

For example, let’s say that you would like to bar your music in 6/8 

time. After using Record Beats, it will be in 4/4 time. To convert it to 

6/8, open the Change Meter dialog box, type in 6/8 as the meter, set 

the beat value to a dotted quarter note, choose the measure range 

you wish to convert to 6/8, select the Only move barlines option, and 

click OK. This will re-bar the music in 6/8 time without changing the 

playback of the music. For more information, please refer to the 

Change Meter chapter. 

The Shift data to option allows you to determine the placement of the 

first downbeat of the re-recorded beats. The most important thing to 

remember is this: do not choose a beat that occurs before the Chunk 

Start Time. For example, let’s say that your music has two pickup 

beats and that you would like the following downbeat to occur at 

1111000. Before you use Record Beats, create a pickup measure from 

0111000 to 1111000 to accommodate the two pickup beats at 

0131000 and 0141000. 

To create a pickup measure: 

1. Click the Start Time button in the main counter to open the Set 

Chunk Start dialog box. 
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Recording Beats While 
Slaved To Tape 
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2. Set the Measure Start Time to 0. 

If you need two measures of pickup, set the Measure start time to 

-1. 

Set Chunk Sta 

3. Click OK. 

Now, when you press Rewind back to the beginning of the sequence, 

the Counter window will read 0111000. 

Once you have set up measure 0, you can set the Shift data to option 

in the Record Beats dialog box to measure 0, beat 3 to accommodate 

the two pickup beats in your music, and the first downbeat will occur 

at 1111000. 

i Hecord beats 

Record Beats may also be used while Performer is slaved SMPTE time 

code via Direct Time Lock or MIDI Time Code. This allows you to 

freely record music while slaving Performer to film or video without 

being concerned with Performer’s metronome. After recording, you 

can then line up the beats and barlines afterwards with Record Beats. 
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Here are a several important preparations you will need to make to 

Record Beats while slaved to tape: 

a Establish lockup to tape using Direct Time Lock or MIDI 

Time Code and a SMPTE-to-MIDI converter such as Mark of 

the Unicorn’s MIDI Time Piece™ or Video Time Piece™. 

For more information, consult the chapters called Receive 

Sync, Performer and MIDI Time Piece, and Performer and 

Video Time Piece. 

= Lither before or after you record your music, make sure the 

first downbeat of the music occurs at the very beginning of 

the sequence and set the SMPTE Chunk Start Time at so the 

music starts at the desired SMPTE frame. You can either 

record the music this way, or shift the music after 

recording. This makes it easy to play the first beat 

accurately when you Record Beats. 

a Set up a countoff before the sequence start using 

Performer’s click so that you can easily record the first 

downbeat. To do so, enable Performer’s click and select 

Only during Countoff in the Click & Countoff Options 

dialog box. To set the number of measures for the 

countoff, double-click the Countoff button in the 

Consolidated Controls panel. 

Once you have made the above preparations, you are ready to record 

beats while slaved to tape: 

1. Set Performer in Slave to external sync mode. 

2. Rewind the tape to several seconds before the Chunk start time. 

3. Choose Record Beats from the Change menu. 

The Record Beats dialog box will appear. 

4. Select the Tap first beat option, but don’t click OK yet. 

This option means that you will tap the first downbeat (in addition 

to all subsequent beats). 

5. While the Record Beats dialog box is still open, get ready to tap any 

note on your MIDI controller. 
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6. When you are ready, roll tape and immediately click OK. 

Right after the Record Beats dialog box disappears, Performer’s 

play button should turn black, indicating that it is slaved to tape. 

The Counter will be counting down negative measures before the 

sequence start time. 

7. Listen for Performer’s countoff and begin tapping on the first 

downbeat of the sequence. 

8. Keep tapping along with the beats in your music as accurately as 

you can. 

9. When you reach the end of the piece, click Performer’s Stop 

button. 

Performer may take moment to realign the beats and enter the 

newly generated tempo data in the Conductor track. 

Before you listen to the results, be sure that Tempo control in the 

Metronome is set to the Conductor track so that the sequence will 

play back with the tempo changes generated by the Record Beats 

command. 
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Chapter 37 Receive Sync 

Basics 

Basic Types of Sync 

The Receive Sync dialog box, found in the Basics menu, allows you 

to ‘slave’ Performer to a wide variety of ‘master’ timing sources. 

Performer supports all standard MIDI synchronization formats, 

including MIDI Time Code and MIDI beat clocks with Song Position 

Pointer data for synchronization with drum machines, hardware 

sequencers, and other MIDI devices. With an FSK or SMPTE to MIDI 

converter such as Mark of the Unicorn’s MIDI Time Piece (MTP), 

Performer can synchronize (or ‘sync’) to audio tape, video, or film, 

ensuring that events in your sequence happen at exactly the same 

spot on tape or film every time. For more information about 

synchronizing Performer with the MTP, see the chapter called 

Performer and the MIDI Time Piece. Performer also has a unique Tap 

tempo feature for synchronizing to prerecorded music, conducting a 

sequence as it plays back, or simply recording a tempo map in real 

time. For a technical description of Performer’s sync formats, see 

Appendix A: Synchronization Specifications. 

Performer supports all standard modes of synchronization: standard 

MIDI beat clocks, Indirect Time Lock, Direct time lock/MIDI Time 

Code for SMPTE time code sync, and Tap tempo. These modes are 

selected in the Receive Sync dialog box. When Standard beat clocks, 

Indirect time lock, or Tap tempo is selected, other parameters appear 

in the Receive Sync dialog box and must be set correctly; the Direct 

time lock/MIDI Time code mode has no other parameters. The mode 

you use depends on the equipment to which you are synchronizing; 

the following section describes the common forms of synchronization 

and the corresponding modes in Performer. 

MIDI Beat Clocks are produced by most MIDI compatible drum 

machines and sequencers, and by some synthesizers (particularly 

those with built-in sequencers). 

MIDI beat clocks are transmitted 24 times a beat. If the master device 

changes tempo, the MIDI beat clocks slow down or speed up 

accordingly; any slave device will follow this tempo change. Most 

devices that generate MIDI beat clocks also send Start, Stop, and 
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Continue messages; slave devices will start playback, pause, rewind, 

or play from the current location according to the combination of 

these messages received. In addition, many devices send Song 

Position Pointer data. These messages set the current location for 

playback, much like setting the Counter in Performer. To sync 

Performer to devices using these MIDI messages, use the Standard 

Beat clock mode in the Receive Sync dialog box. 

FSK is an audio signal which can be recorded on audio tape. Like 

MIDI clock signals, it provides metrical timing information based 

upon a certain frequency of oscillations per beat. FSK does not 

include any positioning information; when using it, playback must 

always begin from the beginning of the signal. If you are using 

Performer with an FSK converter, you must rewind the sequence and 

the tape each time to sync correctly. Performer does not read FSK 

directly, a special device is needed to read the code and convert it to 

MIDI clock signals. To sync Performer to FSK converters, use the 

standard beat clocks mode in the Receive Sync dialog box. 

SMPTE time code is an international standard that was developed for 

film and video work but has proven to be very useful in normal audio 

work as well. This is an absolute time code, expressing hours, 

minutes, seconds and divisions of the second in digital form. It can 

be recorded on tape or film and read by a special device to convert 

it to MIDI. Since SMPTE has no intrinsic tempo information, the 

sequencer or device converting SMPTE to MIDI must generate its 

own tempi. Performer’s flexible tempo map and frame time display 

make it ideal for work with SMPTE time code. Because of its accuracy 

and wide-spread acceptance, SMPTE is the most powerful of the time 

code formats. Depending on your converter, you can use the 

Standard beat clock, Indirect time lock, or Direct time lock/MIDI 

Time Code modes. Direct Time Lock/MIDI Time Code is the easiest 

and most accurate mode. Indirect Time Lock, Direct Time Lock, and 

MIDI Time Code allow the use of Performer’s tempo maps, and are 

far superior to the Standard beat clocks mode. 

Tap Tempo is Performer’s real-time tempo control facility. This form of 

synchronization slaves Performer to a ‘tap’ entered from your MIDI 

controller. Performer receives a MIDI event for each tap and 

computes a tempo based on the current meter, the click value, and 

each event’s distance in time from the previous event. Any tempo 

information in the sequence is ignored while Performer is slaved to 
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Tap tempo. Tap tempo supports both recording and playback, so 

your tap can conduct or be recorded into any sequence, empty or 

finished. When you record in Tap tempo, each tap becomes a tempo 

event in the Conductor Track. Even if you have a minimum MIDI 

setup, you have everything you need to use Tap tempo synchroni- 

zation. 

The following sections describe Performer’s sync modes. 

Standar d Beat This is the standard form of synchronization between two MIDI 

Clocks devices. When the Standard beat clocks option is selected, Performer 

can sync to a master device that is generating MIDI clock signals. If 

you want to slave Performer using a drum machine, external 

sequencer, FSK converter, or other MIDI device as master, use this 

mode. This mode may also be used with a SMPTE converter that 

generates its own tempo map. In Standard beat clocks mode, 

Performer’s tempo will match that of the master device; Performer’s 

tempo features are disabled. 

When you select the Standard beat clocks option, the Receive Sync 

dialog box looks like this: 

Heceive SUNC 
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Default Settings 
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Implementations of MIDI have evolved over the years. As a result, not 

all devices transmit and send MIDI clock signals in the same way. 

Performer provides several options for maximum synchronization 

compatibility with your master device: 

24 clocks per metronome click/24 clocks per quarter note: Some 

manufacturers have begun to make devices which send 24 clock 

signals per beat (one click of the device’s metronome) instead of the 

standard 24 clocks per quarter note. This new method is very useful 

when there are meters which do not use the quarter note as the beat 

unit: 3/8, 5/16, etc. In 6/8, for example, there might be a metronome 

click every three eighth notes; in 4/1, the metronome would click 

once every whole note. If you were using a less common meter such 

as 5/32 or 3/16 + 4/16, using the quarter note as the timing base 

would not be very useful. Instead, use the 24 clocks per metronome 

click option. 

Start on any clock: When this option is checked, Performer will 

automatically start if it receives a time clock even if no start or 

continue command was received. This option is necessary when 

using some early MIDI devices which don’t send start or continue 

commands, only timing clocks. 

First clock is time 1: When this option is checked, Performer interprets 

the first MIDI clock signal it receives as the second timing clock of the 

sequence, 1/24th of a beat after the beginning. Devices manufactured 

recently send the first clock signal (time 0) after the start command 

for the sequence. Some earlier devices assume the start command to 

be the first clock signal. The first clock signal they send would be 1/ 

24th of a beat after the beginning. If you are using one of these 

devices, you should check this option. 

Since manufacturers rarely explain this aspect in their documentation, 

you may not know if your device behaves this way. The best way to 

find out is to experiment: set the metronome to the slowest possible 

tempo, play both devices (with Performer as slave) and listen for 

discrepancies in attacks and beat alignment. The difference of 1/24th 

of a beat is very audible at a slow tempo. If Performer seems slightly 

behind the master device, try checking this option. 

The default settings reflect the most commonly used MIDI standards. 

It is best to set them this way before choosing to alter them: 
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mw 24 clocks per quarter note 

m start on any clock: unchecked 

m first clock is time 1: uwnchecked 

Using Standard Beat To put Performer into Standard beat clocks mode: 
Clocks Mode 

4; 

2. 

6. 

Select Receive Sync from the Basics menu. 

Choose the port receiving the sync information. 

Choose the port from the pop-up menu provided. 

Click on the Standard Beat clocks button. 

Choose between 24 clocks per metronome click or per quarter 

note. 

Select the timing options you want by checking their check boxes. 

Selecting the Start on any clock will cause Performer to 

automatically start upon receipt of any clock signals. Selecting the 

First clock is time 1 option will interpret the Start signal as the first 

timing clock. 

Press OK to confirm your choice or Cancel to cancel it. 

To slave Performer to an external source transmitting MIDI beat 

clocks: 

1. 

Receive Sync 

select Slave to External Sync from the Basics menu. 

This puts Performer into slave mode, waiting for sync information 

from an external device. 

Click on the Play or Record button in the main transport controls. 

The Play button will flash on and off, meaning that Performer is 

waiting for syne information to start. 

. To start Performer, start the external device. 

When Performer is locked and playing, the Play button will turn 

to solid black. Once locked, Performer will follow, start, stop and 

rewind under control of the master. 
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4. To terminate the lock up with the master, click on the Stop button. 

Clicking on the Stop button will both stop Performer and remove 

it from the master’s control. This can be done at any time. To 

return to normal operation, turn off Slave to External Sync by 

reselecting it from the Basics menu. 

Indir ect Time Indirect time lock allows Performer to lock to time code (such as 

L ock SMPTE) using standard MIDI clock signals. This requires a specific 

method of setting your SMPTE to MIDI converter. Indirect time lock 

works as follows: First, a steady tempo (60 BPM) and a starting 

SMPTE frame are set in the SMPTE to MIDI converter. The converter 

reads the time code and generates MIDI clock signals at the specified 

tempo. Performer reads these clock signals and computes SMPTE 

frame locations based upon the constant MIDI beat clocks it receives: 

the original SMPTE frame times are regenerated by Performer. 

To use Indirect time lock, you must set the converter to a constant 

tempo of 60 beats per minute and pick a starting frame that is before 

the point at which you want playback to start. The starting frame for 

the converter should be at least 10 seconds before the start of the 

sequence and no more than 45 minutes before the end of the 

sequence, the exact time is not important. 

The starting frame time must be entered into Performer. It is 

important to set exactly the same frame time in Performer and your 

converter, as all subsequent frame times are computed from this 

starting time. For best results, use a round number to start from such 

as 1:28:00:00. This will reduce the chances of rounding errors in the 

converter. Once locked up, Performer follows the tempo map you’ve 

programmed for the sequence. Also upon lockup, if Click is enabled, 

Performer will click in the meter specified at 1111000 or will default 

to 4/4. 

Due to the limitations of the MIDI song position message, Performer 

can only locate over a 45 minute range in this mode. If you try to 

work on a longer piece, Performer will not be able to lock to it after 

45 minutes. 
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To put Performer into Indirect time lock: 

Set the starting frame number on your converter. 

Make sure that this time is at least 10 seconds before the start of 

the sequence and not more than 45 minutes before the end of the 

sequence. 

Choose Receive Sync from the Basics menu. 

A dialog box appears. 

Choose the port receiving the sync information. 

Click on the button next to “Indirect time lock”. 

Set the converter start frame time. 

This must match the frame number you set in the converter. 

Set the timing options if necessary by checking their check boxes. 

If your converter Outputs non-standard timing information, you 

may need to check the Start on any clock and/or First clock is time 

1 options. See the Standard beat clocks section above for an 

explanation of these. 

Press OK to confirm your choices or Cancel to cancel them. 

Set the SMPTE frame format. 

All standard SMPTE frame rates are provided, including 29.97 

Drop and 29.97 non-drop. The Drop frame check box is available 

only when the 29.97 frame rate option is selected. 
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9. Set the start time for the counter, if necessary. 

Click the Start Time button in the counter and enter the start time 

in the dialog box provided. 

The counter start time is different from the starting frame number you 

entered in the converter and the Receive sync dialog box: it is the 

time that Performer will display as the starting time when the 

sequence begins. The time you enter should be later than the one 

you set on your conversion unit or external device (a few seconds, at 

least): Performer will take this amount of time to “chase” the correct 

frame number to lock with it. 

10.Select External Sync from the Basics menu. 

This puts Performer into slave mode, waiting for sync information 

from an external device. 

11. Click on the Play or Record button in the main transport controls. 

The Play button will turn grey, meaning that Performer is waiting 

for sync information to start. 

12. To start Performer, start the external device. 

When Performer is locked and playing, the Play button will turn 

to solid black. Once locked, Performer will follow, start, stop and 

rewind under control of the master. Also upon lockup, if Click is 

enabled, Performer will click in the meter specified at 1! 11000 or 

will default to 4/4. 

13. To terminate the lock up with the master, click on the Stop button. 

Clicking on the Stop button will both stop Performer and remove 

it from the master’s control. This can be done at any time. To 

return to normal operation, turn off Slave to External Sync by 

reselecting it from the Basics menu. 

Don’t confuse the counter’s start time with the converter starting time. 

The converter starting time is an arbitrary number that is necessary for 

Performer to calculate frame numbers from the MIDI clock signals it 

receives. The sequence starting time, set with the Start Time button in 

the Counter, is the time at which the sequence will actually begin 

playing. 
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Slaving to 
SMPTE with 
MTC, DTL, or 
DTLe 

Receive Sync 

Use this mode when you are slaving Performer to SMPTE time code 

via a converter that supports one of these formats. The SMPTE time 

code is fed from a master source such as a audio tape recorder, video 

tape recorder, or SMPTE generator into a SMPTE-to-MIDI converter 

such as a MIDI Time Piece II, which translates the SMPTE into MIDI 

timing information. This MIDI timing information can be produced in 

one three popular formats: Direct time lock (DTL), Direct time lock 

enhanced (DTLe), and MIDI time code (MTC). There are only slight 

differences between these three MIDI timing formats. For the most 

part, they produce identical results. The differences are discussed 

later in this chapter. 

MTC/DTL/DTLe sync mode is the simplest and most direct way to 

slave Performer to an external source generating SMPTE time code. 

Performer is able to lock to the frame times of the master, insuring 

precise synchronization between devices. To use this mode, you 

must have a SMPTE to MIDI converter that supports at least one of 

these three sync formats, such as a MIDI Time Piece or MIDI Express 

SMPTE/MIDI interfaces from Mark of the Unicorn. 

There are no special options to select in the Receive Sync dialog box: 

when in MTC/DTL/DTLe mode, Performer simply responds to timing 

data directly. 

Once Performer is locked to the master, there is no need to use 

Performer’s main transport controls unless you wish to record. 

Performer will start, stop and locate under control of the master. Also 

upon lockup, if Click is enabled, Performer will click in the meter 

specified at 1111000 or will default to 4/4. 

You can put Performer into play or record either before or after you 

start rolling tape. In either case, Performer will lock up quickly. 

To put Performer into MTC/DTL/DTLe lock up: 

1. Choose Receive Sync from the Basics menu. 

A dialog box will appear. 

2. Specify the port to receive sync information. 

3. Choose the MTC/DTL/DTLe option as the “Type of sync” by 

clicking its button. 
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4. Set the SMPTE frame format. 

All standard SMPTE frame rates are provided, including 29.97 

Drop and 29.97 non-drop. The Drop frame check box is available 

only when the 29.97 frame rate option is selected. 

5. Click OK to confirm the Receive Sync settings. 

6. Set the sequence starting frame. 

Click the Start Time button in the Main Counter. 

7. Select Slave to External Sync from the Basics menu. 

This puts Performer into slave mode, waiting for sync information 

from an external device. 

8. Click on the Play or Record button in the main transport controls. 

The Play button will begin to blink, meaning that Performer is 

waiting for sync information to start. 

9. To start Performer, start the external device. 

When Performer is locked and playing, the Play button will turn 

to solid black. Once locked, Performer will follow, start, stop and 

rewind under control of the master. Also upon lockup, if Click is 

enabled, Performer will click in the meter specified at 1111000 or 

will default to 4/4. 
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and DTLe 

Tap Tempo 

Receive Sync 

10. To terminate the lock up with the master, click on the Stop button. 

Clicking on the Stop button will both stop Performer and remove 

it from the master’s control. This can be done at any time. To 

return to normal operation, turn off Slave to External Sync by 

reselecting it from the Basics menu. 

Like Direct Time Lock enhanced, MIDI Time Code is a simple and 

direct way to slave Performer to an external source reading SMPTE 

time code. In fact, the only difference between MIDI Time Code and 

Direct Time Lock enhanced is that MIDI Time Code uses two bytes for 

each quarter-frame message, where DTLe uses only one. Performer 

supports MIDI Time Code because it was added to the MIDI 

specification. However, Performer, along with most SMPTE-to-MIDI 

converters, provides Direct Time Lock as a more efficient alternative. 

Which mode should you use? We recommend Direct Time Lock 

enhanced because of its higher efficiency. If your converter does not 

support Direct Time Lock enhanced, then you will need to use MIDI 

Time Code. 

The procedure for using MIDI Time Code is exactly the same as the 

procedure for Direct Time Lock enhanced. See the previous section 

in this chapter for detailed information. 

Direct time lock (DTL), when it was first introduced, had only one 

frame-advance message per SMPTE frame. A year or so later, Direct 

time lock enhanced (DTLe) was developed. It consists of four 

quarter-frame advance messages per frame, as well as a full-frame 

message once per second; these enhancements produce the highest 

degree of SMPTE sync accuracy currently available with MIDI. 

MTC and DTLe both have a higher timing resolution than DTL. If your 

converter supports DTL instead of DTLe, you may want to use MTC 

instead in order to take advantage of its timing higher resolution. 

Tap tempo is Performer’s real-time tempo control feature. Tap tempo 

lets you slave Performer to a tap entered from any MIDI controller 

before, during, or after the recording of your sequence. You can 

‘conduct’ an existing sequence by tapping the tempo, complete with 
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Using Tap Tempo Mode 
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accelerandos, ritards, and rubato passages; Performer will follow 

precisely. More importantly, you can record your tap into the 

Conductor Track for use in subsequent playback and recording. 

Tap tempo can be used during virtually any stage in the creation of a 

sequence. For example, if you have acoustic music on tape, two 

completed tracks in Performer, and three more Performer tracks to 

record, you can ‘teach’ the two existing tracks to follow the 

prerecorded music. Your remaining tracks will be recorded into a 

sequence that has all of the temporal nuances of the prerecorded 

music. 

The following are general points to consider when preparing to use 

Tap tempo sync. 

Establish a meter. When slaving to Tap tempo, Performer must know 

how many of your taps to group as one measure. Before recording or 

playing back a passage in Tap tempo mode, make sure you’ve 

entered the correct meter(s) using the Change Meter command in the 

Change menu. 

Establish a metronome click value. Your taps correspond to the 

current metronome click value, specified using the Change Meter 

command from the Change menu. For example, the tempo of a 4/4 

passage can be tapped and expressed in whole notes, one tap per 

measure, or in sixteenth notes, sixteen taps per measure. Each tap 

becomes a tempo change event, so the smaller the click value, the 

higher the resolution of the resulting tempo map. However, tempo 

events in very small increments will fill up your Conductor Track — 

and your supply of RAM — fairly quickly. Choose a click value that 

will give your tempo map high enough resolution but not generate 

too much data to be recorded at one time. 

Choose a tap source. You can use any standard MIDI event as your 

tap source. Performer will interpret this MIDI event as a tap whenever 

it occurs on the specified input channel. If you plan to record music 

while slaved to Tap tempo, choose a combination of MIDI event and 

channel that won’t be needed in the musical passage. For example, 

let’s say you’re tapping C3 on a controller keyboard, transmitting on 

Modem channel 1. The result? Any other C’3’s transmitted on the same 
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channel will not be recorded. Again, this is only true for C3’s 

transmitted on Modem channel 1. C3’s transmitted on other channels 

will be recorded normally. 

Note that although pitch bend and controller events are acceptable as 

tap sources, the most common controls for sending them (wheels, 

joysticks) make reproduction of a single, specific value difficult. For 

example, to define your tap you enter a pitch bend value of 392 using 

a pitch bend wheel. To slave Performer, you'll need to generate 

values of 392 or higher — you send a 392 value by going precisely to 

it, but also by going past it. That much is easy, but remember that 

Performer will treat only the events with 392 values as taps. All other 

values sent by your mod wheel will be recorded and interpreted as 

normal pitch bend events. This makes bend and controller events less 

practical tap choices than events with precise triggers or more limited 

values, such as a note or a Controller #64 (sustain pedal) event. 

To use Tap tempo: 

1. Ensure that you’ve established the correct meter(s) and 

metronome click value(s) for the sequence. 

Use the Change Meter command in the Change menu. See the 

chapter Change Meter for more information on establishing 

meters. 

2. Choose Receive Sync from the Basics menu. 

The Receive Sync dialog box appears. 

3. Select the port that will receive the tap. 

4. Click on the radio button next to “Tap tempo”. 

The right side of the box displays the Tap tempo parameters M/D/ 

beat input data and Sync countoff beats. 
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Choose the MIDI device you will be tapping from in the pop-up 

menu provided. 

Specify the MIDI event you wish to use as a tap. 

Tab to the Event box or click in it, then enter a MIDI event from 

any MIDI controller connected to the specified port (play a note, 

tap a sustain pedal, etc.). The event appears, highlighted; click on 

the highlighted event if you wish to change it. You can use any 

standard MIDI event as a tap source. 

Specify the number of times you wish to tap as a countoff. 

The default number of sync countoff beats is four, but the countoff 

can be any number between 1 and 127. If you enter a number 

outside this range, the Macintosh will beep (or the menu bar will 

flash) when you click the OK button and the number will be 

highlighted. If this happens, click on the highlighted value and 

enter a new one. 

Click OK to confirm your choices or Cancel to cancel them. 

Choose Slave to External Sync from the Basics menu. 

This puts Performer in slave mode; it is now waiting for sync 

information from an external source. 

10.If you wish to record the tap into your sequence, record-enable the 

Conductor Track. 

Activate the Tracks window by clicking once on it, then click on 

the Conductor Track’s Record-Enable button. Your tap will be 

stored as tempo change events in the Conductor Track and used 
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in subsequent playback and recording. Existing tempo changes 

will be replaced. Other Conductor track information will be 

unaffected. 

11. If you wish to record music into your sequence, record-enable the 

desired track(s). 

If you wish to record the tapped tempo and music simultaneously, 

or record music onto more than one track, choose Multi-Record 

from the Tracks window mini-menu. Specify the record device for 

each track that is record-enabled. The Conductor Track will record 

from the device specified in the Receive Sync dialog box. 

12.Press the Play or Record button in the main transport controls. 

The Play button will flash, meaning that Performer is waiting to 

receive sync information. Overdub mode will not function on the 

Conductor Track; that is, recording in either normal or overdub 

mode will erase any existing tempo events. 

13.If you will be tapping along with a prerecorded passage, start 

playback of the recording. 

Ideally, the prerecorded music will have a sufficient countoff so 

that you can tap the number of countoff beats specified in the 

Receive Sync dialog box. 

14. Begin ‘tapping’ the MIDI event that you designated in the Receive 

Sync dialog box. 

Performer will listen for the specified number of countoff beats to 

predetermine the tempo for the beginning of playback or 

recording. When Performer has received the countoff, playback or 

recording will begin. 

15. Tap the desired tempo and tempo changes. 

Make your tap as expressive and dynamic as you wish; Performer 

will follow. The Counter display will update as you tap. 
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16.To end recording or playback, press the Stop button in the main 

transport controls. 

Don’t be alarmed if the Macintosh wristwatch icon remains 

onscreen for an extended period of time after you stop recording. 

Performer is calculating precise tempo changes from the taps you 

just recorded. 

17. Take Performer out of slave mode by choosing Slave to External 

Sync from the Basics menu. 

18.If you recorded your tap, you can hear the results by rewinding the 

sequence, making sure the metronome under Conductor track 

tempo control, and pressing Play. 

Your sequence will play back using the tempo(s) that you tapped. 

If you are not satisfied with the results, you can use the Undo 

Record command in the Edit menu and then repeat the above 

process. You can make adjustments by rerecording certain 

sections and by editing individual tempo changes in one of the 

Conductor Track’s Event Editing windows. 

You can use Tap Tempo to record a tempo map while Performer is 

slaved to tape—or, more accurately, referenced to external time code. 

You can record a tempo map that matches the music on tape, 

allowing you to perfectly synchronize your sequence to the 

prerecorded music. This process is explained in detail in the chapter 

called Tap Tempo While Slaved to Tape. 

Recording music simultaneously. If you plan to record music simulta- 

neously with your tap, choose a tap event that doesn’t require use of 

your hands. Controller #64, sustain, is usually triggered by a foot 

pedal and is a good choice for a tap because it has only two values: 

On or Off. 

Further, Performer will let you use either value for your tap. 

Using alternative tap values and sources. You can set the tap as an Off 

value for a particular note or controller: 

1. In the Receive Sync dialog box with Tap tempo chosen, Tab to the 

Event box. 
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2. Depress the note or controller, leaving it depressed. 

For example, push a modulation wheel away from its ‘zero’ 

location. The controller number and its value will appear in the 

box, highlighted. 

3. Without releasing the note or pedal, click on the highlighted Event 

value. 

4. Release the note or pedal. 

To continue the example, let the mod wheel spring back to its 

zero location. The Event box will show Off or 0 as the tap value. 

So far, our examples of using Tap tempo have involved tapping a 

MIDI instrument to ‘teach’ Performer the temporal details of a 

sequence. When you tap, you simply send a MIDI event and 

Performer does the rest. This means you can use any MIDI sequencer 

to load its own tempo map into Performer — just program the 

sequencer to play a song’s worth of quarter notes while Performer is 

slaved to Tap tempo sync. 

Yet another way of sending Performer a tap is to use a device that 

converts an audio click into a MIDI event. A click or other regular, 

amplified signal (a click track on tape, a miced rim shot, etc.) can be 

fed into such a device and converted into MIDI events from which 

Performer can generate a tempo map. 

Punching In a tempo. Auto-Record can be used with Tap tempo to 

‘punch in’ tempo changes for a section while preserving the tempi 

outside that section. Enter the punch In and Out times in the Auto- 

Record bar, found in the Consolidated Controls panel, click on the 

Auto-Record button, then follow the applicable steps above. (Don’t 

be alarmed if both the Play and Record buttons go grey at first; the 

Play button is waiting for sync information, and the Record button is 

waiting for the Counter to reach the punch In location.) 

Remember also that slaving Performer to Tap tempo disables the 

sequence’s existing tempo map. So when you start playback in Auto- 

Record mode, even though Performer will only record taps from the 

In location to just before the Out location, you will have to tap 

throughout the pass. Give yourself the most accurate temporal 

‘context’ — the tempi before and after the punch-in passage — as is 
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possible, so that the recorded section will fit smoothly into the rest of 

the sequence. As always, you can fine-tune all tempo change events 

in the Conductor Track. 

Recor d While The Receive Sync dialog box has an option called Record while still- 

Still-framed framed. Without this option checked, Performer drops out of record 

as soon as you stop the tape after a record pass while slaved to tape; 

Performer will not record again until you press the Record button. 

This prevents unintentional recording while cueing and accidental 

loss of Undo Record. When this option is checked, Performer stays in 

record when you stop the tape so that you can record a hit while 

parked on a frame. This is particularly useful when frame-advancing 

using VITC and the Video Time Piece, which provides accurate 

frame-advancing. Unless you are recording while frame-advancing, 

we recommend that you leave this option unchecked. 

Multi-track Let’s look at an example which illustrates a number of techniques you 

= may find useful in the recording studio. 
Audio 
Recording You are recording a five minute song in the studio. You’ve 

preproduced the drum and synthesizer track with Performer. Now 

you want to record guitar and vocal tracks using live players. You 

plan to use a synchronization code conversion box (a converter) to 

translate audio synchronization code recorded on tape into MIDI 

timing data. Let’s start by assuming you are using a SMPTE/MIDI 

converter, then discuss what you will have to do differently if you are 

using an FSK conversion box. 

Synchronizing with The first thing you should do when you get to the studio is to “stripe” 

SMPTE (i.e. record) one track of your multi-track tape with an audio sync 

signal. For this example, let’s assume you are using SMPTE time code. 

Start striping the tape at time 0:59:00:00. We recommend that you use 

30 frames per second, non-drop-frame code, unless you have a 

specific reason to use one of the other frame rates. Continue for at 

least 7 minutes; you should always have at least a minute of time 

code on the tape prior to the start of your song, and you should 

record plenty of extra time code at the end in case you decide to 

lengthen the song at some point. Many people stripe the whole reel 

straight out of the box with one continuous time code track. Striping 

may take some time; get it started first thing upon arriving at the 

studio, so that it will be finished by the time you get everything else 

set up for recording. 
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Now, set up Performer to play in syne with the multi-track. Feed the 

time code from the tape into your SMPTE to MIDI converter. Connect 

the converter to the Macintosh; some converters connect directly, 

others have a MIDI Out which must go to the MIDI In of an interface 

connected to the Macintosh. If you have a MIDI Time Piece CUI) or 

MIDI Express, no additional connections are necessary beyond the 

normal one to the modem (or printer) port. 

If your converter supports Direct time lock, Direct time lock 

enhanced, or MIDI Time Code, set the appropriate mode on the 

converter (to lock to SMPTE). Select Receive Sync... from the Basics 

menu. Choose the correct port (Sync to port:) and MTC, DTL, or DTLe 

(Type of sync:). OK the dialog box. 

Otherwise, you should use Indirect time lock. Set the converter to 

generate a constant tempo of 60 beats per minute, and have it start at 

0:59:00:00. Select Receive Sync... from the Basics menu. Choose the 

correct port (Sync to port:) and Indirect time lock (Type of sync:). For 

Converter start frame: enter 0:59:00:00 (the same time that you set the 

converter to). You won't need to check either of the other options 

unless your converter is non-standard. See the Synchronization 

section for more information on these options. 

Let’s start the song at time 1:00:00:00 on the tape (this is a minute after 

the start of the time code). Click the Start Time button in the Counter. 

Enter 1:00:00:00 + O time code bits for the frame time. Set the other 

values as you wish. OK the dialog box. 

Set the frame rate correctly in Performer in the Receive Sync dialog 

box. Choose the correct frame rate; use 30 frames per second unless 

you have a specific reason to use another format. 

Check the Slave to External Sync entry in the Basics menu. Press the 

play button in the motion controls; it will turn grey. At this point, 

Performer should be slaved to the tape. Display frame time in the 

counter window, and roll the tape from before the time code. Make 

sure Performer starts, stops, and follows the tape when you wind 

through the tape. 

For overdubbing, you need to provide your players with a reference 

mix of the song. You can have Performer sync live to the tape and 

send the players a cue mix. Or, you might find it easier to just place 

a scratch mix on one or two of the tracks of the multi-track. That way, 
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you won't have to worry about Performer while recording. If your 

session is spread out over several dates, putting a scratch mix on the 

tape will save you having to set up your computer and synthesizers 

every time. 

When you get to the final mix, you have two choices. You can mix 

from Performer playing slaved to the tape. This provides the ultimate 

in sound quality, as the synthesizers are first recorded on the master 

tape. On the other hand, you may wish to record each synthesizer 

part on a separate track of the multi-track. This has several benefits. 

Since the tracks are recorded one at a time, each track can use all of 

your synths to create a sound. Blending several synthesizers together 

often creates a more full-bodied sound than you could otherwise 

achieve. Also, if you have limited outboard effects gear, you can 

record each track with effects, allowing you to reuse what equipment 

you have. 

When recording a single part to tape, we recommend you turn off the 

play-enable buttons in the tracks window for all tracks except the one 

you are recording. When you do this, Performer completely ignores 

the other tracks, letting it concentrate all of the computer’s processing 

power on playing one part. Jf you use the Solo button instead, 

Performer will scan the other parts while playing. If you have dense, 

complicated music, or lots of continuous data, this may cause the 

Macintosh to become bogged down during playback. 

When recording each part separately, you can slide individual parts 

slightly ahead or behind to compensate for delays in your 

synthesizers, or the specific sounds. For example, string parts often 

need to be attacked ahead of the beat in order to sound on the beat. 

With sampling synthesizers, you may find that some sounds have as 

much as 100 milliseconds of “dead air” at the beginning of the 

sample, which results in that much delay between turning the note 

on and hearing any sound. 

To slide a part, just adjust the start time relative to the start time the 

other parts were recorded with. For example, if you did have a 

sample with 100 milliseconds of dead air at the start, you could set 

the start time to 0:59:59:27 + O time code bits. That’s 3 frames ahead 
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of the other parts, and at 30 frames per second, 3 frames is 1/10th of 

a second, or 100 milliseconds. Your sample’s audible attack times will 

now be aligned with those of the other parts. 

It’s best to slide parts by ear — just keep trying different start times 

until the part seems most lined up. 

If you are using an FSK converter in the above example, you can 

proceed in a very similar fashion. 

When striping the tape, you must usually feed the converter with 

MIDI beat clock information. This information is recorded more or 

less directly onto the tape. When the tape is played back through the 

converter, you should receive exactly the same MIDI beat clock 

information. 

When synchronizing to an FSK converter, Performer follows the 

tempo recorded onto the tape; Performer’s internal tempo map is 

disabled. 

The FSK converter usually sends out a carrier tone when it is not 

receiving MIDI beat clock information. You should record a minute 

or so of this carrier tone prior to starting Performer. 

When synchronizing to tape, you must use the Standard beat clocks 

mode to receive synchronization. Remember that the tempo is 

already recorded on the tape. 

When using FSK, you must always begin playing the tape from the 

beginning; FSK code does not encode any position information on 

the tape. 

When locking to external SMPTE synchronization, you can shift parts 

forward and backward in time to compensate for the numerous time 

delays in a complex system (each device used in a MIDI path 

introduces at least 2 milliseconds of delay) or to adjust for envelope 

delays in certain synthesizer patches (such as strings or any other 

slow-attack patch). 
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When recording in external sync, the Record button is turned off 

every time the master device stops or rewinds. This is a safety 

precaution, to prevent accidental erasure of previously recorded data. 

To record in external sync, start the master device, wait for Performer 

to lock up, and then press the record button. 

Many new digital effects devices, like reverbs, delays, equalizers, and 

even mixers, allow MIDI control. By using Performer with a time 

code converter to sync to your multi-track tape recorder, you can 

automate effects changes and other aspects of mixing accurately and 

flexibly. Read cue points from Performer’s counter, or use the Record 

Hits feature in the Markers window to find locations to insert patch 

changes and controller information to control your MIDI devices. 

Alternatively, use the sliders, switches and pedals of your controller 

keyboard or MIDI mixer to record your mix in real time, then use 

Performer’s editing features to correct any problems. 

If you are working in a studio situation where you need a countoff 

before the beginning of the sequence while slaved to tape, here is 

how you can set up the Performer’s countoff feature: 

1. Choose a Click Option in the Click & Countoff Options dialog box 

that will enable the click during Performer’s countoff. 

For example, choose the Always Click option or the Only during 

countoff option. 

2. Set the number of measures you would like for the Countoff. 

Do so by double-clicking the Countoff button and typing in the 

number of measures. 

3. Make sure that the Click is enabled. 

The Click item on the Basics menu must be checked. 

If you now rewind well before the sequence start time and roll the 

tape, Performer, as it counts down, will begin the countoff at the 

appropriate number of measures before the downbeat of the first 

measure. 

In general, we recommend using Direct Time Lock Enhanced (DTLe) 

to lock Performer to SMPTE time code. If you are using an Opcode 

Studio 5, however, use MIDI Time Code (MTC) instead. Just set up 
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the Studio 5 to generate MTC instead of DTLe. In Performer, no 

change is needed because Performer uses the same settings for either 

type of time code. For other hardware interfaces, including the 

Opcode Studio 4, we recommend using Direct Time Lock Enhanced. 
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Chapter 38 [I ansmit sync 

Basics 

The Transmit Sync dialog box, available from the Basics menu, allows 

you to configure Performer as a master time source. When being used 

as a master, Performer sends synchronization signals to which other 

MIDI devices can slave. Performer generates standard MIDI beat 

clocks; devices which do not recognize MIDI beat clocks require a 

converter to the appropriate type of synchronization information. For 

more information on synchronization, see the Receive Sync chapter 

and Appendix A: Synchronization Specifications. 

You may use Performer as a master of some devices while Performer 

itself is slaved to another device. This is especially useful when 

slaving Performer to SMPTE time code; Performer (slaved to the tape) 

can generate tempos for other sequencers slaved to Performer. 

When Transmit Sync is selected for one or both of the serial ports, 

Performer becomes a master time source: any compatible MIDI 

devices connected to Performer will follow Performer’s tempo 

changes, and start or stop along with the program. If the slave devices 

respond to MIDI Song Position Pointer data, then they will also 

follow Performer when the Counter location is changed or the 

Rewind button and Position bar are used. 

Performer can transmit sync information in two ways: it can simply 

pass on (or echo) any sync messages it receives, or it can generate 

new sync information based upon its own tempo map and controls. 

These options are described below: 

Echo received sync: This option echoes synchronization information 

which is received. No processing is performed. The reception port 

must be selected in the Receive Sync dialog box, and Performer must 

be in External Sync mode for sync to be echoed. Sync is echoed to 

the ports selected in the Transmit Sync dialog box. There is less delay 

between reception and re-transmission using this mode than if 

Generate MIDI beat clocks is selected. 
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Use this mode if you wish to slave Performer and another device to 

a master which generates MIDI beat clocks. However, for best results, 

you should use a MIDI thru box and connect both Performer and the 

other slave directly to the master. Echoing sync through Performer 

results in a small delay. 

Generate MIDI beat clocks: Performer generates MIDI beat clocks in 

tandem with the other MIDI information being played back. Use this 

mode when Performer is the master. You may also find this mode 

useful when slaving Performer to SMPTE using one of the time lock 

modes. Performer will generate MIDI beat clocks according to its 

tempo map in sync with the SMPTE code, so you can slave a 

sequencer or device that doesn’t support SMPTE through Performer. 

To set Performer to transmit sync information: 

1. Choose Transmit Sync from the Basics menu. 

A dialog box appears. 

Transmit 

2. Select the Macintosh ports that you wish Performer to send sync 

information over. 

If neither port is selected, Performer will not generate or echo 

sync information. If you are not slaving external devices to 

Performer, setting the ports option to none improves performance. 
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24 clocks per 
metronome click/24 
clocks per quarter note 

First clock is time 1 

Transmit Sync 

3. Choose between echoing and generating sync information. 

Click on the corresponding radio button. 

4. Set any necessary options. 

If you are using Generate MIDI beat clocks, set the options 24 

clocks per metronome click / 24 clocks per quarter note and First 

clock is time 1 as necessary. These options have no effect when 

echoing received sync. 

Performer is now set to transmit sync information. If your slave 

devices are set up correctly, they will start, stop, rewind, and play in 

time with Performer. 

Generally, you must put the slave device in an external sync mode 

before it will respond to Performer’s transmissions. Consult the 

owner’s manual for the device to determine the exact procedure. The 

mode may be called external clock, MIDI sync, MIDI clock, etc. 

Some MIDI devices expect 24 clock signals per beat (one click of the 

device’s metronome) instead of the standard 24 clocks per quarter 

note. This method is very useful when there are meters which do not 

use the quarter note as the beat unit: 3/8, 5/16, etc. In 6/8, for 

example, there might be a metronome click every three eighth notes; 

in 4/1, the metronome would click once every whole note. If you 

were using a less common meter such as 5/32 or 3/16 + 4/16, using 

the quarter note as the timing base is not very useful. Instead, use this 

option to make the metronome click value the timing base. 

When this option is checked, Performer interprets the first MIDI clock 

signal it sends as the second timing clock of the sequence, 1/24th of 

a beat after the beginning. Recently manufactured devices expect to 

receive the first clock signal (time 0) after the start command for the 

sequence. Some earlier devices assume the start command to be the 

first clock signal; the first clock signal would thus be 1/24th of a beat 

after the beginning. If you are using one of these older devices, you 

should check this option. 
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Chapter 39 Using MIDI Machine Control 

MIDI Machine Control (MMC) is a recent and significant addition to 

the original MIDI specification. MMC consists of an extensive set of 

system exclusive commands that allow multiple recording devices to 

be remotely controlled from a single source. MMC expands 

Performer’s ability to serve as “a recording studio at your fingertips” 

by allowing you to control the transport and recording functions of 

your recording hardware entirely from within Performer. 

This chapter explains how to use Performer with hardware devices 

that support the MIDI Machine Control (MMC) specification, such as: 

a The Alesis ADAT™ digital multitrack recorder (with the 

BRC or other MMC interface) 

a The Akai DR4d™ digital hard disk recording system (with 

the additional card necessary for MMC) 

Performer serves as a computer-based front end for MMC devices, 

causing them to play, stop, rewind, and otherwise follow Performer’s 

transport control functions. In addition, you can record-enable tracks 

on a MMC device remotely from within Performer (for MMC devices 

that support this capability). 

@ As you begin working with Performer and your MMC 

gear, keep the following in mind. Performer provides 
features that are supported by most MMC devices. 

However, not all MMC devices support every feature 

explained here. In addition, there can be slight 

variations in the way each device handles MMC that 

cause it to behave differently than described. Try to 

familiarize yourself as much as possible with the 

features your device supports via MMC. Also, check 

for “Read Me” files in your Performer folder and 

update note booklets that accompany your Performer 

manual; they may include further information about 

specific devices. 
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Setting up MMC MIDI Machine Control requires two-way MIDI communication 

hardware between Performer and the MMC device. Performer sends control 

commands (in the form of system exclusive messages) to the MMC 

hardware, and the MMC hardware sends SMPTE time code back to 

Performer. 

Some MMC devices can generate SMPTE time code in the form of 

MIDI Time Code (MTC). (Some MMC devices support other forms of 

MIDI timing information as well, including standard MIDI beat 

clocks, Direct Time Lock, and Direct Time Lock Enhanced.) Other 

devices generate SMPTE time code in the form of longitudinal time 

code (LTC), an audio signal that must be converted to MIDI Time 

Code by way of a SMPTE-to-MIDI converter such as the MIDI Time 

Piece II. These two hardware setups are shown below. 

a MIDI Interface MMC Device 
Serial cable OL —== ||\| 

MIDI cables 

Figure 39-1: If the MMC device can generate MIDI Time Code (MTC), the MIDI connections 
shown here are all that are necessary. Be sure the MIDI interface internally routes the MTC to the 
Macintosh. 

MIDI Interface IN MMC Devi 
; ; evice 

Serial cable with SMPTE converter OUT =I  ||\| 
MIDI cable 

SMPTE time code SMPTE time code 

IN OUT 

| Audio cable | 

Figure 39-2: If the MMC device generates SMPTE Time Code, connect its time code output to a 
SMPTE-to-MIDI converter like the MIDI Time Piece II as shown here, which converts it to MTC. 

Route the resulting MTC to the computer. 
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ijjeeo amare 

Serial cable | 

If you have more than one piece of MMC gear, decide which one will 

be the time code master. Hook up the master device as shown in 

either Figure 39-1 or Figure 39-2 (whichever is required by the 

device), and then feed the time code from the master device to the 

other MMC devices in your setup. Doing so establishes one time code 

source, which keeps all devices (and Performer) in sync with one 

another. Connect the remaining devices to your MIDI interface as 

shown below. 

a —_ MMC Master Device 
Sona MN on ae ERS ET SS RT 

MIDI Interface 

= 
MMC Device 

MMC Device 

The hardware setups shown in Figure 39-1 and Figure 39-2 support 

open-loop MMC configurations. Performer does not currently support 

closed-loop MMC communication. Closed-loop communication is not 

necessary for accurate synchronization between Performer and MMC 

hardware. 

Setting up Performer for MMC is simple. All you need to do is create 

a MMC device in your FreeMIDI setup. 

1. Open the FreeMIDI Setup Application. 

If you are currently running Performer, click the FreeMIDI button 

in the Control Panel, or choose Edit FreeMIDI Configuration from 

the Basics menu. Otherwise, double-click the FreeMIDI Setup icon 

in the Macintosh Finder. The FreeMIDI Setup application launches 

and your current studio configuration appears. 

2. If the MMC device already exists in your FreeMIDI configuration, 

double-click it. If not, add it using the Create Device command in 
the Configuration menu. 

The FreeMIDI Device Specification window appears. 
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3. Inthe Device Specification window, make sure that “MIDI Machine” 

Device Property is checked in the Device Properties pop-up menu 

as shown below, as well as the “Receives MTC” and “Transmits 

MTC” properties. 

If any of these items are not checked, select them to check them. 

Name: 
Manufacturer: Model: 

ADAT 
Transmit Channels: 

i 2.3.4 5 Controller 

Li LG Receives Clock 
Receive Cha-Receives MITC 

12354 3)| Transmits Clock 
IL] transmits MTC 

Properties: |“MIDI Machine 

General MIDI 

Bank Select Ctri 0 

Bank Select Ctrl 32 jj = = —_f_——_s |, gu, 

Does not accept prog changes 

Does not play notes 

Sampler | 
Drum Machine Cpe ae ET 

Effects Unit 

Miter 

Device ID: iS 

(0-126) 

Transmits MTG 

4. Make sure that the Device ID setting correctly matches the setting 

in the device itself. 

@ If you used FreeMIDI’s Auto Config feature to 

automatically detect the MMC device, the ID setting is 

already correct. The device ID setting is important 

because if it is not correct, the MMC device will not 

respond to Performer. 

5. If you are creating the FreeMIDI device for the first time, set the rest 

of the device information as needed. 
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6. Click OK. 

7. Make sure that both the MIDI IN and MIDI OUT ports of the MMC 

device are connected to the MIDI interface. 

If not, connect them by dragging a patch cord from the MIDI 

interface port to the device icon. For more information, see 

“Connecting Devices to Interfaces” on page 696. 

The presence of a MMC device in the MIDI configuration activates the 

MMC features in Performer. 

“MME FreeMIDI Setup 

oe 
MIDI Time Piece Il, Modem 
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Acti vating MM Each MMC device that you have defined in your FreeMIDI setup 

in Performer appears in Performer’s MIDI Machine Control window, which can be 

opened from the Windows menu. 

TheMMC master 

button 

The MIDI Machine The area at the top of the window contains several important buttons 

Control window MMC-related controls. 

The MMC master button 
The MMC master button activates all of Performer’s MMC features. To 

activate these MMC features, click the arrow button between the 

computer and tape deck icon at the top of the window. When this 

button is on, MMC is activated. In addition, Performer is placed in 

Slave to External Sync mode. For more information about external 

sync mode, see “Setting Performer’s Receive Sync options” on 

page 638. 
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The Record mode pop-up menu 
The Record mode pop-up menu has three modes: Safe, rehearse, and 

record. 

m Safe: no recording can occur in any MMC device 

= Rehearse: this mode depends on the MMC device. Usually, 

it causes the device to act as if it is recording, punching in, 

punching out, etc. but no recording actually occurs. 

@ Make sure that your deck supports rehearse mode 

before attempting to use this record feature. If it 

doesn’t, rehearse mode may actually record. 

= Record: allows recording on the currently record-enabled 

track(s) for any MMC device. To actually record, press the 

record button in Performer’s main transport controls. 

Preroll 
When this option is checked, MIDI Machine Control devices get cued 

to 5 seconds before the location you specify with Performer’s 

transport functions. Click the preroll value in the box to change it 

(1-99 seconds). 

Preroll saves you the trouble of figuring out preroll time in your head. 

Preroll lets you cue Performer to musically intuitive locations or hit 

points while giving the hardware and Performer enough time to fully 

synchronize by the time they reach the cue location you chose. 

Auto Record Advance 
When the Auto Record Advance button is checked, Performer will 

automatically record-enable the next higher track (or set of tracks for 

stereo recording) during Memory-cycle recording. As Performer loops 

the same section over and over, each pass is recorded on a new track 

(or set of tracks), preserving all previous takes. For example, when 

you begin cycle-recording, you could record a section on track 1. The 

second time around the loop, Performer releases track 1 and record- 

enables track 2, and the second pass gets recorded on track 2. The 

third time around, Performer record-enables track 3, and the third 

pass gets recorded there. Performer will continue to record-enable 

the next track until it records on the highest available track. 
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@ Make absolutely sure that the consecutive tracks in line 

for recording do not have material on them that you 
wish to keep. 

When this check box is unchecked, the same track (or tracks) remain 

record-enabled until you change them manually by clicking the 

record-enable buttons in the MIDI Machine Control window. 

The Auto Record Advance option requires the following preparations 

in Performer: 

1. Memory-cycle must be enabled. 

2. Auto-Record must be enabled. 

3. The Record mode popup in the MIDI Machine Control 

window must be set to Record mode. (It does not advance 

in Safe or Rehearse mode.) 

4. Performer must punch-in at some point before cycling 

back to the beginning of the Memory-cycle loop. 

Setting up each MMC The MIDI Machine Control window provides a list of MMC devices in 

device your FreeMIDI Setup. Any connected device that has the M/DI 

Machine device property assigned to it appears in this window. 

Several settings are provided for each device. 

Device name and icon 
The name and icon of the device comes from its name in your 

FreeMIDI studio configuration. You can change the name using the 

FreeMIDI Setup application. To change the icon, see “Editing 

FreeMIDI Icons” on page 759. 

Bringing a MMC device on line 
When the On line button is selected, the device is on line, which 

means that it will respond to Performer’s transport control 

commands. When a device is off line, it will not respond to 

Performer. 

Specifying the number of tracks 
The Set number of tracks... mini-menu command sets the number of 

tracks that the MMC device has. Keep in mind that in some situations, 

a single device in Performer’s MIDI Machine Control window actually 
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represents several physical devices. For example, an Alesis BRC may 

be connected to several ADAT’s, each with 8 tracks. In this example, 

you’d want to include the tracks for all of the ADAT’s. Be sure to set 

the number of tracks accordingly. 

Setting a timecode track 
The timecode track option in the Set number of tracks command lets 

you specify one of the tracks as a timecode track. The timecode track 

becomes record-protected, and it cannot be record-enabled by the 

arrow keys (discussed below) or Auto Record Advance. You can 

record-enable the timecode track manually by clicking it, but a 

warning appears to confirm that you would like to do so. 

Changing the order of the devices in the window 
To change the order of the devices in the window, drag the panels 

up or down. 

Ejecting a tape 
Th Eject mini-menu command ejects the tape from the currently 

selected MIDI Machine Control device in the list. To select a device, 

click its name. The device must be on line and the master MIDI 

Machine Control button must be active for this to work. 

Keyboard shortcuts for record-enabling tracks 
Option-click a track to record-enable it and at the same time turn off 

all other record-enabled tracks. Command-click a track to turn it off 

and record-enable all others. 

User the up and down arrow keys to record-enable the next or 

previous track. This works with adjacent pairs as well. 
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Selecting a MMC device in the MMC window 
To select a device, click its name. 

Setting Performer’s While controlling external MMC devices, Performer actually slaves to 

Receive Sync options time code generated by the MMC hardware to remain synchronized 

with the hardware during playback and recording, as explained in the 

diagram below. 

Performer sends play, stop, rewind, 
and other transport commands to the 
MMC hardware (in the form of MIDI 

system exclusive messages). MMC Devi 

During playback and recording, the 
MMC devices sends MIDI time code 
back to Performer to keep Performer 
in sync with the hardware. 

Figure 39-3: When Performer controls the transport functions of MMC hardware, 
Performer simultaneously slaves to time code from the MMC hardware. 

Performer governs the transport control functions, and the MMC 

device serves as the master timing source to keep them synchronized. 

As a result, when you activate MMC control in Performer, Performer 

is automatically placed in Slave to external sync mode, in which 

Performer slaves to external time code. To successfully slave 

Performer to the time code, make sure that the settings in Performer’s 

Receive Sync command in the Basics menu match the time code 

being generated by the MMC master device. For complete 

information on the Receive Sync dialog settings, see “Slaving to 

SMPTE with MTC, DTL, or DTLe” on page 609. 
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Figure 39-4: Make sure that Performer’s Receive Sync dialog box settings 
(Basics menu) match the time code generated by the master MMC device. 

Because MMC control involves SMPTE synchronization, be sure to set 

Performer’s SMPTE start time (SMPTE offsef) to a value that is 

appropriate for the time code being generated by the MMC device. 

To set the start time, click the start time button in the main counter, 

or select Set Chunk Start from the Chunks window mini-menu. For 

more information, see “Setting the start time” on page 90. 

Once you activate MMC and set up each device as described in the 

previous sections, Performer will shuttle the transport controls on 

each on-line MMC device in sync with Performer’s own transport 

controls. For example, when you press play, stop, and rewind in 

Performer’s main transport control panel, each MMC device will do 

the same. 

All of Performer’s transport control functions are supported. For 

example, if you use Memory-cycle to loop over a region, the MMC 

device will follow. Keep in mind, however, that Performer’s transport 

functions are virtually instantaneous, whereas MMC hardware devices 

are mechanical devices that take time to cue. As a result, Performer 
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will stop and wait at times when the MMC device is cueing to a new 

location. The longer the cue time, the longer the wait will be. Once 

the MMC device has finished cueing, Performer will resume at the 

same time as the MMC device. 

Transport features that are supported include: 

a Play 

m Stop 

m Rewind 

m Pause 

= Record 

=» Auto-punch in/out 

Cueing functions include the following: 

= Typing a time into the Main Counter 

= Using Fast-forward and rewind cueing buttons below the 

main transports 

m Clicking a marker in the Markers window 

mw Double-clicking in any time ruler 

=» Memory bar features such as Auto-stop, Auto-rewind, 

Memory-cycle 

a Dragging the scrolling wiper 

All of these functions behave normally, except for the waiting period 

mentioned above. 

Once you have set up MMC in Performer as described in this chapter, 

you can record MIDI data into Performer in the usual fashion (as 

described in chapter 9, “Recording”). Record-enable a MIDI track in 

Performer’s track list, press record, and play your controller. All of 

Performer’s MIDI recording features work normally, including Multi- 

record, Auto punch-in, etc. Since Performer is slaved to the external 

MMC device, there may be an occasional wait during cueing. 
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Using Performer to To record to a track on a MMC device: 
record a track on a MMC 
device 1. Make sure that the device you wish to record on is on line in the 

MIDI Machine Control window. 

If not, click the Off Line button to bring it on line. 

2. Choose either Record or Rehearse from the pop-up menu in the 

MIDI Machine Control window. 

For details about Rehearse mode, see “The Record mode pop-up 

menu” on page 635. 

3. Record-enable one or more tracks on the device by clicking the 

appropriate track button(s) in the MIDI Machine Control window. 

@ Note: some devices do not support remote record- 

enabling. If so, record-enable the track directly on the 

device. 

Until you actually begin recording, the record-enable button 

flashes. When you begin recording, it becomes solid. 

Record -enable buttons 

4. If you would like to loop a section to record several passes, click 
the Memory-cycle button in the Main Control Panel and set the 

Start and End points in the Track Overview. 

For information about using Memory-cycle, see “The Memory- 

cycle button” on page 71. 
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Memory-cycle button 

5. If you are going to loop a section with Memory-cycle as described 

in the previous step, and you would like to record each pass ona 

new track to preserve each take, check the Auto Record Advance 

box in the MIDI Machine Controls window. 

For details, see “Auto Record Advance” on page 635. Make sure 

that Auto-record and Memory-cycle are enabled. Also, make sure 

that the record mode pop-up menu in the MIDI Machine Control 

window is set to Record mode. Auto Record Advances doesn’t 

work in Rehearse or Safe mode. 

6. If you would like to set punch-in and punch-out points, click 

Performer’s Auto Punch-in button below the main transports, and 

set the punch-in and out times in the Memory bar 

You can even set punch locations while looping a section with 

Memory-cycle. In Performer the punch location can be set 

independently from the loop points. If you want, you can set the 

in and out times on the fly by clicking the In and Out buttons in 

the Memory bar during playback. For more information, see “The 

Auto-Record button” on page 76. 
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Auto Punch-in Auto Record bar 

7. To begin recording, cue Performer’s main counter to a point that is 

at least 5 seconds before the punch-in point, or set the pre-roll time 

in the MIDI Machine Control window to at least 5 seconds. 

The amount of pre-roll depends on the device; some may require 

longer. 

8. Press Performer’s record button. 

9. Record at the punch in location. 

10.Press stop to end recording. 
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Chapter 40 Using Performer with the MIDI 
Time Piece™ 

About this chapter This chapter discusses how Performer and the MIDI Time Piece 

(MTP) and MIDI Time Piece II (MTP ID work together. This chapter 

also applies to the MIDI Express and multi-port interfaces from other 

manufacturers, such as Opcode’s Studio 5. 

Performer relies on FreeMIDI to identify what type of interface is 

connected to the Macintosh. FreeMIDI automatically figures out what 

is connected. If a MIDI Time Piece, MIDI Time Piece II, MIDI Express, 

Studio 5, or other similar interface is present, several important 

features are automatically enabled in Performer. The sections below 

refer to features that are fully documented in other chapters of this 

manual, such as the MIDI Monitor window. You may want to review 

these chapters as you read this one; this will help you understand 

how Performer works with the MIDI Time Piece. 

The MIDI Time Piece, MIDI Time piece H, and MIDI Express can 

each be thought of as four MIDI devices wrapped into a single rack- 

space unit. Each one is: 

= an 8 IN/8 OUT MIDI interface (4 IN/6 OUT in the MIDI 

Express) 

mw a MIDI patch bay with routing, channelizing, and muting 

» a SMPTE-to-MIDI synchronizer 

mw a SMPTE time code (LTC) generator 

Performer has three features that support them: 

mw high data transfer rate with FAST mode (not available with 

the MIDI Express) 

m 128 MIDI channels through data cablization (96 channels 

with the MIDI Express) 

= Improved SMPTE synchronization with Enhanced Direct 

Time Lock™ 
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High data transfer rate When Performer and the MIDI Time Piece are set to FAST mode, they 

with FAST mode communicate two to four times faster than a regular interface running 
at 1 Megahertz. As a result, they sustain greater data throughput to all 

8 MIDI OUT cables on the MTP. Fast mode also alleviates irregular 

timing problems that occur when too much data is being transmitted, 

commonly referred to as “MIDI logjam.” 

128 MIDI channels via 8 The MIDI Time Piece is unique because it offers eight independent 

independent cables MIDI INs and MIDI OUTs. Independent means that each cable 

handles its own, separate set of 16 MIDI channels. Eight cables, 

multiplied by 16 MIDI channels each, equals 128 separate MIDI 

channels. Performer provides access to all 8 cables and all 128 

channels. In addition, up to four MTPs can be networked together for 

a total of 512 MIDI channels. 

The MIDI Express provides 96 MIDI channels (6 outputs times 16 

channels each). 

In either case, the primary benefit is that you’ll never have to worry 

about overlapping MIDI channels—MIDI channels that are being 

used by more than one MIDI device at a time. Each device has its 

own channels, so you'll never have a conflict. 

Another benefit is that both the MIDI IN and MIDI OUT of each 

device can be connected at all times, allowing easy access to and 

from the instrument. This is especially useful when using a editor/ 

librarian software such as Mark of the Unicorn’s Unisyn™. 

Improved SMPTE sync Enhanced Direct Time Lock (DTLe) is an improved form of the DTL 

with Enhanced Direct supported in earlier versions of Performer. Instead of one frame 

Time Lock™ advance message per SMPTE frame, DTLe consists of four frame 

advances per frame. In addition, DTL’s tape position (full frame) 

message has been expanded to include the frame rate of the SMPTE 

and an identification of which device in an MTP network is sending 

the DTLe. 

To fully support DTLe, the MIDI Time Piece sends a tape position 

message approximately once every second. This prevents even the 

slightest amount of drift due to small dropouts or other inconsis- 

tencies in the SMPTE time code. 

646 Using Performer with the MIDI Time Piece™ 



Synchronizing to 
SMPTE with DTLe 

Locking the MTP to 
SMPTE 

When used with Performer, the MIDI Time Piece provides the most 

reliable. SMPTE-to-MIDI lockup available. In addition, DTLe allows 

Performer to establish lockup without stopping the tape transport. 

While the film or video tape is rolling, you can press Performer’s Play 

button and the program will jump right into sync with the tape. 

Enhanced Direct Time Lock™ (DTLe) is an improved form of DTL 

supported by earlier versions of Performer. The following sections 

provide a brief overview of how to sync Performer to SMPTE time 

code via DTLe and the MIDI Time Piece. If you are not already 

familiar with the synchronizing process, please refer to the chapter in 

the MIDI Time Piece user’s manual called Working with SMPTE. 

The principal benefits of DTLe are: 1) you are less likely to have 

problems such as dropouts, drifting, etc. and 2) lockup can be 

achieved while the tape continues rolling. You no longer have to stop 

the tape to reestablish lockup. 

Performer still supports old DTL if you are using an original DTL 

converter. The procedure for using original DTL is the same as for 

ETL, 

To lock the MTP to SMPTE, connect an audio out from the tape deck 

to the AUDIO IN jack on the rear panel of the MTP. In the MTP Desk 

Accessory (MTP DA) MIDI Sync window, choose the DTLe option, 

and make sure that DTLe is being routed to the Macintosh. 

To verify lockup, open the SMPTE Reader window from the MTP 

software and roll the tape. The SMPTE Reader should begin to roll. 

Lockup is indicated on the MTP by the LTC/LOCK light (LED) on the 

front panel, which glows steadily as long as the MTP is locked. In 

addition, the POWER/TACH (tachometer) LED flashes regularly once 

per second. If the LEDs flicker erratically, the MIDI Time Piece is not 

locking up consistently. Try boosting or attenuating the SMPTE 

output from the tape deck. 
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Using the MIDI Monitor To verify that Performer is receiving the incoming DTLe properly, use 
to check incoming DTLe the MIDI Monitor window. When DTLe is being received, the RT light 

turns dark (due to the four F8 bytes being received each frame): 

The real-time data light (“Rt”) lights up 
when Performer is successfully receiv- 
ing DTLe. 

Locking Performer to Once the MTP has been successfully locked to tape, and you have 

the MTP verified that it is sending DTLe to Performer, lockup is easy. Choose 

MTC/DTL/DTLe in the Receive Sync dialog box, set a start time in the 

counter with the Start Time button, choose Slave to External Sync, 

press Play (or Record), and roll the tape. You can press stop at any 

time and reestablish lockup by pressing Play again, even while the 

tape is rolling. 

Troubleshooting If you have trouble establishing lockup, refer to the MIDI Time Piece 

manual SMPTE chapter for detailed, step-by-step instructions. Also 

refer to “Slaving to SMPTE with MTC, DTL, or DTLe” on page 609. 

If you continue to have problems, check out the troubleshooting 

chapter at the end of the MTP manual. It discusses solutions to 

common synchronization problems. 
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Chapter 41 Performer & the Video Time Piece 

The Video Time Piece is Mark of the Unicorn’s affordable SMPTE/ 

VITC/MIDI time code converter and character generator. VITC 

(Vertical Interval Time Code) is SMPTE time code that is recorded 

directly in the video signal, freeing up both audio tracks and allowing 

lockup to be maintained while freeze-framing or frame-advancing the 

video. 

Performer supports many of the Video Time Piece’s unique features. 

With the Performer/Video Time Piece combination you can: 

= Lock Performer to VITC and remain in sync while frame 

advancing 

g Download Markers as streamers to the video display 

mw Display a Conductor Crawl Line that displays the hit point 

of each downbeat in the sequence 

= Convert an audio click track into a Performer tempo map 

in the Conductor track 

= Prevent dropouts during tape sync with adjustable 

freewheeling 

Seiting Up To set up Performer for the Video Time Piece, you need to add the 

Performer Video Time Piece to your FreeMIDI configuration using the FreeMIDI 

setup application. If Performer is currently running, you can launch 
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FreeMIDI setup by choosing Edit FreeMIDI Configuration from the 

Basics menu. Choose Create Device from the Configuration menu 

and set up the options as needed. 

Saas Ee MID] Time Piece i, Modem 

Cy t -O ad 
E2000 

Cr 
VFA SD 

ce ecto | 
Proteus/1 KR 

Video Time Piece 

When you have a Video Time Piece in your FreeMIDI configuration 

as shown above, special features for the Video Time Piece are 

automatically enabled in Performer; they are discussed in this 

chapter. 

Locking Once you have installed the Video Time Piece, you can lock 
Performer to video that has been recorded with VITC or LTC. 

Performer to 
VITC Before attempting lockup to VITC, it is a good idea to make sure that 

the Video Time Piece is successfully converting the VITC into MIDI 

sync and transmitting the sync data to Performer and the Macintosh. 
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Verifying Incoming Time 
Code with the MIDI 
Monitor 

Performer & the Video Time Piece 

To verify incoming time code from the Video Time Piece: 

1. Open the Video Time Piece desk accessory and open the Convert 

SMPTE window. 

Convert SMPTE 

SMPTE Source: : [Don't Convert 
LTC : 
@ VITC 
© MTC/DTL 

- SMPTE to MIDI tT t: 
{> first available : 2 orma 

MTC 
@ DTL 

2. Choose the VITC option and the DTL (Direct Time Lock) option. 

Alternately, you can use MTC (MIDI Time Code) option. 

Roll the Video tape. 

When the VITC LOCK light on the Video Time Piece indicates that 

lockup has been achieved, the COMPUTER OUT LED should 

begin to glow, indicating that the Video Time Piece is sending DTL 

(or MTC) to the Macintosh and Performer. 

4. Open Performer’s MIDI Monitor window. 

If you are using Direct Time Lock enhanced, the “Rt” light on the 

port to which the VTP is connected will turn black. In addition, 

the Co light on the Video Time Piece panel will blink regularly if 

DTLe is being successfully received by Performer. 

The Co light will turn black if you are using MTC. 
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You can now lock up Performer, even while the video tape is still 

rolling: 

1. Choose the MTC/DTL/DTLe timecode option in Performer’s 

Receive Sync dialog box. 

Be sure to match the same type of sync that the Video Time Piece 

is sending. 

2. Enable the Record while still-framed option in the Receive Sync 

dialog box. 

This causes Performer to remain in record when you are frame- 

advancing. 

3. Choose Slave to external sync from the Basics menu. 

This puts Performer into slave mode. 

4. Press the Play or Record buttons. 

You can do so even while the tape is rolling. Performer will 

immediately lock to the tape. If necessary, you may have to stop 

and adjust the start time in the Counter. (Click the Start Time 

button to do so.) 

To record hits while frame-advancing: 

1. Freeze the video image. 

Performer will also stop at the frozen video SMPTE frame. 

2. Choose Add from the Markers window mini-menu or play a MIDI 

event into the currently record-enabled track. 

The new marker will be added to the list at the current tape 

location. If the Markers window isn’t already Open, press stop, 

open it, and press play again. 

3. Advance to the next hit using your VCR’s frame-advance button. 

Performer will follow along. 
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4. Repeat the above two steps as many times as necessary. 

When you are through, you can rename each marker and lock it 

to its SMPTE time. 

Performer remains in sync during freeze-frame because the VCR tape 

heads keep spinning—even when the tape is stopped. Thus, they 

continually scan the video image (and the VITC). The Video Time 

Piece, in turn, remains locked to the frozen image as it is being 

continually scanned and sends periodic tape position messages to 

Performer to let Performer know where the current tape location is. 

You can see these periodic tape position messages as brief flashes on 

the COMPUTER OUT LED on the Video Time Piece. To record notes, 

you must have the Record while still-framed option checked in the 

Receive Sync dialog box. 

Using Str Camers The Markers window has an additional capability designed for the 

Video Time Piece’s character generator. The Video Time Piece can 

superimpose graphic images on a video picture, including streamers. 

A streamer is a solid white bar that travels across a video screen from 

left to right to reach the right-hand side of the screen at an exact hit 

point. Streamers help studio musicians and sound effects engineers to 

anticipate hit points during video post-production. 

Performer’s markers have the ability to serve as triggers for streamers 

generated by the Video Time Piece. Here is how it works: while 

Performer is slaved to the video via SMPTE time code and the Video 

Time Piece, it sends a message to the Video Time Piece several 

seconds before playback reaches the marker location. This message 

tells the Video Time Piece the name of the marker and its exact 

location. To warn the viewer of the approaching hit point, the Video 

Time Piece immediately displays the name of the marker on screen 

for several seconds before the streamer. The Video Time Piece then 

displays a moving streamer for the marker such that the streamer hits 

the right side of the screen at the exact SMPTE frame location of the 

marker. 
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To enable streamers in Performer, check the “Generate VTP 

Streamers” mini-menu command. Then you will see the Streamers 

column next to the marker names in the Markers window: 

VTP Streamers 

To enable a streamer for a marker, click in the Streamer column next 

to the marker name and the streamer icon will appear. The marker 

will then appear as a streamer on the Video Time Piece’s video 

picture. If you option-click, the marker will be assigned a streamer 

and all others will not. Conversely, if you command-click, all markers 

except the one you click will be assigned a streamer. 

Remember that marker names are displayed onscreen for 

approximately 3 seconds before the streamer. If your markers are 

closer than 3 seconds to one another, they may overlap onscreen; that 

is, the name of the second marker may be displayed before the first 

marker’s streamer. 

When the Video Time Piece displays the name of the marker, it 

displays up to 20 characters. Names longer than 20 characters will be 

cut off. So, you may want to keep your marker names as short as 

possible. 

Together, Performer and the Video Time Piece have the ability to 

display a crawl line on the video screen. A crawl line is a series of 

white “blips” that travel across the video screen from right to left, 

striking the left-hand side of the screen in time with each beat of 

music in the Performer sequence. The Conductor Crawl Line is useful 

for lining up downbeats in your Performer sequence with hit points 

on the video. 
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Performer triggers each beat in the Conductor Crawl line when the 

Click feature in the Basics menu is enabled. To set up the click 

feature: 

1. Choose Click & Countoff Options from the Basics menu. 

If you do not want to hear the click, uncheck both the Internal 

speaker and MIDI options. 

2. If you do want to hear the click, check the option you would like 

and, if necessary, enter the data for the MIDI click. 

Choose the Always click option. 

3. Click OK to confirm your choices. 

4. Select Click from the Basics menu to enable the click. 

The Click menu item will become checked. 

To display the Conductor Crawl line: 

1. Choose Video Time Piece from the Apple menu to open the VTP 

DA. 

2. Choose Video Setup from the VTP menu. 

The Video Setup window will appear. 

Video Set-up 

SMPTE Burn-in : | oeation: 

Background: : 

@ Clear 

Black 

Streamers : 

Background: : 

@ Clear 

> Black 

Conductor 

Background: 

@ Clear 

Black 

Bit-mapped 

graphics 

Overlay onto: 

‘a Video in 

House syne 
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3. Check the Conductor option. 

You can choose a clear or black background for it, and you can 

adjust its position on the video screen by dragging the crawl line 

display up or down in the Video Setup window. 

4. To turn off the Conductor Crawl Line, simply uncheck the option or 

turn off Performer’s click. 

Converting a With the Video Time Piece, you can convert an audio click track into 

" ” a MIDI event. This allows you to convert the click track into a tempo 
Click Track into map in a Performer sequence’s Conductor track. You can even record 

a Tempo Map the tempo map while Performer’s time base is referenced to SMPTE 

time code, allowing you to accurately synchronize a Performer 

sequence to prerecorded music. 

Before attempting to convert the click track into a tempo map, make 

sure that the Video Time Piece is successfully converting the audio 

click into MIDI data and transmitting the data to Performer and the 

Macintosh. 

Verifying Incoming MIDI To verify incoming MIDI clicks from the Video Time Piece: 

Clicks with the MIDI 
Monitor 1. Make sure that an audio cable is plugged into the CLICK IN phone 

jack on the rear panel of the Video Time Piece. 

2. Choose Video Time Piece from the Apple menu to open the VTP 

DA. 

3. Choose Set Click to MIDI from the VTP menu. 

The Click to MIDI dialog box will appear. 

MIDI Click is @ On 

Convert click to: +: Click data: 

@® Note : 

{> Controller > Channel as 

Pitch [ cz | 

tat 

ete 
whe 
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4. Choose the MIDI data type and parameters for the MIDI click. 

Most of the time, any event will do, such as a note like C3. 

5. Click OK to Confirm your choice. 

6. Roll the tape. 

When the CLICK light on the Video Time Piece indicates that the 

click is being received, the COMPUTER OUT LED should begin to 

blink, indicating that the Video Time Piece is sending the MIDI 

click event to the Macintosh and Performer. 

7. Open Performer’s MIDI Monitor window. 

8. A channel light (and cable light with the MTP) will flash if the MIDI 

click is being successfully received by Performer. 

If none of the channel lights flash, check your connections and try 

again. 

Setting Up Tap Tempo The next step is to set up the Tap Tempo options in the Receive Sync 

dialog box. 

1. Choose Receive Sync from the Basics menu and select the Tap 

Tempo option. 

2. Choose Video Time Piece from the device pop-up menu. 

3. Press the tab key to move to the Event parameter and play in the 

MIDI click event by simply rolling the tape. 

Since you have already successfully set up the MIDI click in the 

previous section, as soon as you roll the tape, Performer will 

receive the MIDI click event from the Video Time Piece and enter 

the proper value in the Event box. 

4. Type in the number of countoff beats. 

Be sure to type in the same number of countoff beats as there are 

on the click track on tape. 

5. If you do not need to synchronize the sequence containing the 

resulting tempo map to the tape with the audio click track, choose 

the Internal clock option. 
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6. If, later on, you will be synchronizing the sequencing containing 

the resulting tempo map to the tape with the audio click track, 

choose the External time code option and check the Capture start 

time box. 

These options tell Performer to reference your clicks to time code 

while it is recording the tempo map. By doing so, Performer will 

then be able to accurately synchronize the resulting tempo map 

with the tape. 

7. Click OK to confirm your choices. 

Before recording anything, check to make sure Performer will follow 

the MIDI clicks sent by the Video Time Piece. 

1. Choose Slave to external sync from the Basics menu. 

2. Press the Play button. 

3. Roll the tape. 

After a few bars or so of countoff click, the sequence will begin to 

play back, following the clicks on tape. If not, check the MIDI 

Monitor window to make sure Performer is receiving the MIDI 

click. Also check the Tap Tempo options in the Receive Sync 

dialog. 

4. Stop the tape and rewind it to the beginning of the cue. 

You are now ready to record the tempo map. 

If you will be synchronizing the sequence containing the new tempo 

map to the click track using SMPTE time code, make sure that you: 

m already have SMPTE time code recorded on one track and 

the click recorded on another 

m already have Performer and the Video Time Piece set up 

for SMPTE synchronization such that when you roll the 

tape, Performer is receiving both the MIDI click and Direct 

Time Lock (or MIDI Time Code) at the same time 

m have selected the External time code and Capture start 

time options in the Receive Sync dialog box 
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Locking the Recorded 
Tempo Map to Tape 

Preventing Dropouts 
While Slaved to SMPTE 

Performer & the Video Time Piece 

@ Please note: if you want to be able to synchronize the 

sequence to the click track via SMPTE, it is absolutely 

necessary that Performer is receiving both the MIDI 

click and either DTL or MTC when you record the 

tempo map. 

To record the tempo map: 

1. Record-enable the Conductor track in the Tracks window. 

2. Press the Record button in the main transport controls. 

3. Roll the tape. 

If you chose the Capture start time option and are referenced to 

time code, Performer will remember the exact SMPTE frame of the 

tap that is the first downbeat and automatically remember to start 

the sequence at that SMPTE frame when you lock the sequence to 

SMPTE afterwards. 

4. When you are finished recording, stop the tape. 

Performer may take a few moments to process the new tempo 

data. 

You now have a new tempo map the matches the click track on tape. 

If you recorded the tempo map referenced to time code, you can 

now lock the sequence to tape. Just choose the Direct Time Lock (or 

MIDI Time Code) option in the Receive Sync dialog box, make sure 

the Metronome is under Conductor track tempo control, and roll the 

tape. The Capture start time option automatically sets the Chunk 

SMPTE start time, so the first downbeat of the sequence should occur 

at exactly the first click downbeat (not including countoff beats, of 

course). 

The Video Time Piece has an adjustable freewheeling feature. When 

a SMPTE reader such as the Video Time Piece encounters a drop-out 

—a series of missing or unreadable frames—in the SMPTE time code, 

it “freewheels” past them, pretending that they were not missing and 

briefly generating its own code to make up for the missing frames. 
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Most converters will freewheel for only up to 3 or 4 frames. The 

Video Time Piece can freewheel from 0 frames up to 127 frames (over 

4 seconds). This allows it to maintain lockup with Performer over 

even the most pernicious SMPTE drop outs. 

If you encounter a time code drop out while slaving Performer to 

tape with the Video Time Piece, try increasing the freewheel amount 

in the Convert SMPTE window. The default value is 4 frames. Try 

adding a few frames at a time when adjusting the amount. 
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Chapter 42 Tajo Tempo While Slaved To Tape 

Tapping to Prerecorded 
Music on Tape 

You can use Tap Tempo to record a tempo map while Performer is 

slaved to tape—or, more accurately, referenced to external time code. 

You can record a tempo map that matches the music on tape, 

allowing you to synchronize your sequence to the prerecorded 

music. 

This process can be performed in a more precise fashion if you have 

an audio click track recorded on the tape and a click-to-MIDI 

converter such as Mark of the Unicorn’s Video Time Piece™. For 

more information, please refer to the chapter called Performer and 

the Video Time Piece. 

The following are general points to consider before tapping tempo to 

prerecorded music: 

Before you begin, establish SMPTE synchronization to tape. This is 

necessary for two reasons: 1) Performer needs to receive a timing 

reference from the tape while creating the tap tempo map, and 2) 

later on, after you successfully record the tempo map, you will be 

using the SMPTE to lock the sequence to the tape. To establish 

SMPTE synchronization, simply sync Performer to the tape in the 

fashion that you normally do with Direct Time Lock (DTL), Direct 

Time Lock Enhanced (DTLe) or MIDI Time Code (MTC). If you have 

never synchronized Performer to SMPTE, now is a good time review 

the Receive Sync chapter. (Please note that you must synchronize to 

tape via MIDI Time Code or Enhanced Direct Time Lock.) 

Once you have set up SMPTE sync, set up Tap Tempo. To do so, simply 

follow the directions in the Receive Sync chapter called Setting Up Tap 

Tempo. Test it to be sure that when you tap, Performer does indeed 

follow your taps. This will ensure that you have the proper channel 

and event for Tap Tempo mode. Remember, you may also need to set 

up a meter map in the sequence that matches the meter map of the 

music on tape. 
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If possible, set up two full measures of countoff on the tape before the 

first downbeat of music. This will be extremely helpful to your 

accuracy when tapping the first downbeat, which is the most 

important downbeat because all subsequent taps—the entire tempo 

map—will be referenced to its exact location. 

Tapping Tempo While Once you have made these preparations, you are ready to begin. To 

Referenced to Tape Tap Tempo to prerecorded music on tape: 

1. Open the Receive Sync dialog box from the Basics menu. 

Receive Sync 
See 

2. Set the Sync to port option to the port that will be receiving the 

SMPTE sync data from tape. 

For example, if your SMPTE-to-MIDI converter is sending 

Enhanced Direct Time Lock to the modem port, select the modem 

port. Uf the converter does not send Direct Time Lock or Direct 

Time Lock enhanced, use MIDI Time Code instead.) 

3. Select the Tap Tempo option. 

The tap event can be received from any controller device on either 

serial port. 
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8. 

9. 

Type in a number of countoff beats. 

Be sure that the number of countoff beats you choose here 

corresponds in a useful way to the number of countoff beats on 

tape. For example, ideally, you should have 2 measures of 

countoff on tape; if so, set the countoff beats here to 1 measure. 

When you roll the tape, you can get ready during the first bar of 

countoff, tap along for the second bar, and hit the downbeat right 

on the money. If you don’t have an countoff on the tape, you will 

have to develop a system that works best for you. You might try 

just one countoff beat. 

Enter the beat input data. 

Select the External time code option. 

Performer will now reference your taps to incoming DTL, DTLe, 

or MTC. 

Select the Capture start time option. 

This option makes Performer remember the exact SMPTE frame of 

your first tap (excluding the countoff beats) so the sequence will 

start at the correct SMPTE time. 

Click OK to confirm your choices and close the dialog box. 

Record-enable the Conductor Track. 

10. Choose Slave to External Sync from the Basics menu. 

11. Press the Record button in the main transport controls. 

12. Get ready to tap, and roll the tape. 

13. Listen for the countoff, and ‘tap’ along with it such that the first 

downbeat of the sequence corresponds to the first downbeat of 

music on tape. 

Performer automatically remembers the exact SMPTE time of your 

tap on the first downbeat of the sequence and saves it as the 

Chunk start time. When you later slave the sequence to tape, 

Performer will automatically start the sequence at the correct 

SMPTE time. 
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14. Tap along with the music as accurately as you can. 

Remember that synchronization later on will only be as accurate 

as the accuracy with which you tap in this procedure. 

15. To end recording, press the Stop button in the main transport 

controls. 

Don’t be alarmed if the Macintosh wristwatch icon remains 

onscreen for an extended period of time after you stop recording. 

Performer is calculating precise tempo changes from the taps you 

just recorded. 

Now that you have recorded the tempo map, try slaving Performer to 

the tape using your usual method of synchronization, such as Direct 

Time Lock or MIDI Time Code, in the Receive Sync dialog box. Also, 

make sure that the Metronome is under Conductor track tempo 

control. You will now be able to playback, rewind, or fast forward 

anywhere in the song on tape, and your Performer sequence will 

exactly reproduce your tapping performance with respect to the 

music on tape. If you tapped accurately, Performer will play along 

accurately. If you goofed, so will Performer. You can always try again. 
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Chapter 43 Printing 

This chapter explains how to: 

mw Print out the contents of a Performer list window, such as 

the Event List, Tracks, Markers, Chunks, and Remote 

Controls windows. 

mw Print one or more tracks as music notation and display the 

results on the computer screen or print them on a printer 

=» Customize the page layout for notation printing 

a Get best-looking results when printing notation 

Checking your serial Before you print anything—either a list window or notation, consider 

ports before you print which Macintosh serial port you will be using for printing. To check 

the status of the serial ports, choose Interface Settings from the Basics 

menu. These settings reflect your current FreeMIDI studio configu- 

ration. 

Mac interface: Serial Ports od 

.5 MHz / 16H 

1 MHz / 32H 

2 MHz / 64H 

Fast / 1H 

Not in use 
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In the example above, the printer port is “Not in Use”, which means 

that it is OK to print if your printer is connected to it. If your printer 

is connected to modem port in this example, you’d need to change 

the way the serial ports are set up for MIDI. 

Using MIDI on one port and printing on the other 
If you plan to do a lot of printing from Performer, your best bet is to 

use one serial port for MIDI and the other for printing as shown 

above. Affordable multi-port MIDI interfaces such as Mark of the 

Unicorn’s MIDI Express and MIDI Time Piece II provide a convenient 

connection for all of your MIDI gear through one Macintosh serial 

port. 

Printing when you use MIDI on both serial ports 
Depending on your MIDI setup, you may require MIDI on both serial 

ports. For example, you may have a large MIDI rig that requires 

multi-port interfaces connected both serial ports, or you may have an 

old MIDI interface that calls for using both ports. In either case, you 

probably have your printer connected to a “thru” port on the 

interface. When you want to print something, you press a “thru” 

switch to temporarily suspend MIDI and allow printing. 

In this scenario, MIDI activity must be temporarily suspended on the 

serial port being used for MIDI. Use the Interface Settings command 

in the Basics menu to temporarily set the port to No Interface while 

printing. 

To print the contents of a track’s Event List window, the Tracks 

Window, the Markers Window, the Chunks list window, or the 

Remote Controls window: 

1. Bring the window you want to print to the front to make it the active 

window. 

To do so, click its title bar or choose its name from the Windows 

menu. 

2. Open the Chooser from the Apple menu and select the desired 

printer and serial port. 

See “Checking your serial ports before you print” on page 665. 
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Printing 
Notation 

Printing 

3. Choose Page Setup from the File menu, make any desired changes 

to the page settings, and click OK to confirm the settings. 

The options that appear in this dialog box depend on the type of 

printer you are using. For example, if you are printing on a laser 

printer, you can choose an enlargement or reduction above or 

below 100%. 

4. Choose Print from the File menu. 

The standard print setup dialog box appears for your printer. 

5. Set up the printer options as needed, such as the number of 

copies, and click OK. 

The entire contents of the list is printed. 

Printing notation in Performer is easy, as you'll see in the following 

sections. Performer transcribes unquantized or quantized MIDI data 

in a readable fashion. You can format the music on screen exactly as 

it will print, including text, page margins, staff spacing, measure 

spacing, and more. 

To print notation: 

1. Open the Chooser from the Apple menu and select the desired 

printer and serial port. 

See “Checking your serial ports before you print” on page 665. 

2. Choose Page Setup from the File menu, choose the desired page 

size, make any desired changes to the page settings, and click OK 

to confirm the settings. 

The options that appear in this dialog box depend on the type of 

printer you are using. For example, if you are printing on a laser 

printer, you can choose an enlargement or reduction above or 

below 100%. 
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3. Select the data or the region of data that you would like to print 

using any method of selection that you prefer. 

Performer is extremely flexible because you can use any one of 

Performer’s many ways to select data—from a single note to the 

entire piece. You can select any portion of a track, or any portion 

of multiple tracks. See “Choosing what tracks to display” on 

page 347 for more information. 

4. Click the QuickScribe notation editing window button in the 

Consolidated Controls window. 

A window appears containing staves for the track or tracks you 

have selected. This window displays the music on a page exactly 

as it will print out. For information about editing music and 

formatting it in this window, see chapter chapter 23, “QuickScribe 

Notation”. 

5. Use the QuickScribe window mini-menu and Page Setup 
commands to format the music on the page as desired. 

Summarized below, these menu commands are discussed in detail 

in chapter chapter 23, “QuickScribe Notation”. 

Formatting command: Brief description: 

Score Options Provides control for title page, staff 

(Mini-menu) names, measure numbering and 

spacing, and staff spacing. 

Page Margins Lets you adjust top, bottom, left, and 

(Mini-menu) right page margins. 

6. Add text as desired with the text tools in the Tools palette. 

See “Working with text” on page 367 for more information. 
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7. Choose Print from the File menu. 

The standard print setup dialog box appears for your printer. For 

example, if you are printing with an Apple LaserWriter in System 

7, you'll see the window below: 

LaserWriter “LaserWriter IIg” 712 [ print | 

Cover Page: @ No) First Page (> Last Page 

Paper Source: @ Paper Cassette ©) Manual Feed 

Print: @) Black & White (> Color/Grayscale 

Destination: ®@ Printer €) PostScript® File 

8. Set up the printer options as needed, such as the number of copies 

desired, and click Print. 

Performer proceeds to print the document, providing you with a 

status window as it does. 
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Chapter 44 Using Performer With Unisyn 

What is Unisyn? 

How Are Unisyn and 
Performer Integrated? 

Integration Happens 
Automatically 

Selecting 
Sounds 

Unisyn is Mark of the Unicorn’s state-of-the-art editor librarian 

software. Unisyn provides you with a complete MIDI sound 

management environment, coupled with powerful tools for creating 

and editing sounds. 

Unisyn and Performer are both FreeMIDI compatible applications. As 

a result, they are integrated with one another through FreeMIDI in the 

following ways: 

mw FreeMIDI allows Performer to play back a sequence in the 

background when you switch into Unisyn under System 7 

(or MultiFinder in System 6) to audition patches, edit a 

patch, or perform any other task in Unisyn. 

a While you are working in Unisyn, you can start, stop, and 

play a Performer sequence without ever leaving Unisyn. 

m= Unisyn keeps all of the FreeMIDI patch lists completely up 

to date. In turn, FreeMIDI shares the patch lists with 

Performer and all other FreeMIDI compatible applications. 

These patch lists show up through Performer, most notably 

in the Tracks window default patch and current patch 

columns. 

With FreeMIDI installed in your system, all of the integration features 

above happen automatically as you use Performer and Unisyn. No 

additional effort is required on your part. 

With Performer and Unisyn working together, you have many choices 

for how to select sounds in your sequences. In general, they fall into 

two general approaches: 

1. Using patch change events in Performer 

2. Using Unisyn for general sound management 
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These approaches are discussed in the following sections. Which 

approach you will use depends on how you work. These consider- 

ations are also discussed. 

One way to select sounds is to choose them by name from 

Performer’s patch list pop-up menus. For example, you can select a 

default patch for each track in the Performer’s Tracks window. When 

you play the sequence from the beginning, the default patch gets 

transmitted to the synth to recall the patch before music begins 

playing. You can also insert (or record) patch change events in the 

sequence’s tracks to change sounds during playback. 

The critical concept with this approach is that you are dealing with 

MIDI patch change events, which are MIDI events numbered from 

zero to 127. Unisyn provides names so that you can conveniently 

refer to them by name, rather than by number. 

When managing sounds in this fashion in Performer, Unisyn serves 

two purposes: 

1. To provide Performer with accurate names in the patch 

lists—that is, names of patches that are currently in the 

synth. For example, if you send a bank to a synth from 

Unisyn, the patch names from that bank will be displayed 

in Performer’s patch lists. If you then send a different 

bank to the synth, Unisyn updates Performer’s patch lists 

to the patches in the new bank. 

2. To save the current bank in each synth in a performance 

so that this same bank can be restored when you work on 

the sequence at a later time. 

If you don’t save the current banks as a performance in Unisyn, you 

have no easy way to restore the banks if you need to work on the 

sequence at a later date. If you don’t restore the patch banks, the 

patch lists in Performer may not be the ones you originally used, and 

your default patch selections, as well as patch changes you’ve 

inserted in tracks, won’t recall the correct sounds. 

As you can see, the integrity of this approach depends on having the 

correct banks of sounds loaded in the synth. If you don’t change 

banks in your synths, handling sounds in this manner works very 

well, and the only role Unisyn plays is to provide accurate factory 
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Disadvantages 

Patch Maps 

Using Performer With Unisyn 

preset patch lists. This.is the easiest way to handle sound selection 

because everything is done in Performer alone. Once Unisyn has 

provided the patch lists, you don’t even need to run it when using 

Performer. 

If you do change banks in your synths, this approach still works fine. 

But be absolutely sure to save the banks to disk in Unisyn and 

include them in the performance that you create for the sequence. 

This technique is described further in “Using Unisyn for General 

Sound Management” on page 674. 

Of course, if you know you'll never be working on the project again, 

and you will never need to recall the sound setup, you certainly don’t 

need to save a Unisyn performance. 

When you select a patch from Performer’s patch list pop-up menu, 

sometimes what you selected won’t be what you hear. This is 

because many synths have more than one “mode”, e.g. “multi” and 

“voice” mode, which have a dramatic effect on what happens when 

you send a patch change to the synth from Performer. If the synth is 

not in the right mode, you won’t get the patch you expect. You must 

learn enough about your synths to choose the necessary mode, either 

from its front panel controls or by selecting the appropriate module 

in Unisyn’s Modules window (depending on the synth). Refer to the 

synth’s documentation for clues. 

Another drawback to this method is that you are limited to the zero 

through 127 range of patch changes allowed by MIDI, which, for 

most synths, only select RAM sounds. New synths support a new 

MIDI command called bank select, which provides direct access to 

many more ROM sounds; however, if a synth is more than about a 

year old, it won't support bank select. As a result, you are forced to 

go through considerable gymnastics in the synth to have access to all 

your patches via MIDI patch change events. 

In general, if a synth has many ROM sounds, you will have an easier 

time selecting sounds for it with Unisyn rather than with patch lists in 

Performer. 

Some synths, such as the E-mu Proteus, address the 128-patch 

limitation by providing a “patch map” which lets you choose from a 

larger set of sounds. However, Unisyn doesn’t take patch mapping 
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into consideration when providing patch lists to Performer, so once 

again you are left with a situation where the patch you select in 

Performer won't be the one you hear from the synth. 

Unisyn sets up Performer’s patch list so that the first patch in the list 

always selects the first patch in Unisyn’s bank window, the second 

selects the second patch, etc. If your synth has a programmable patch 

map, it should be permanently set to correspond in this fashion. If 

you need to access patches that are not available via the program 

change table, use Unisyn to copy them into RAM locations that are 

available via the program change table. If you employ this technique, 

the patch list in Performer should show the correct name. 

@ The E-mu Proteus 1,2, or 3 are exceptions. Patch 0 in 

Performer’s patch list selects ROM preset 000. Patch 64 

in Performer’s patch list selection RAM preset 004, 

patch 65 selects RAM present 065, etc. (This exception 

does not apply to the Proteus XR.) 

In general, Unisyn keeps Performer completely updated as far as 

what patches are available in your synths. Performer’s patch menus 

should always reflect the sounds currently available via patch 

changes sent from Performer. 

On the other hand, Performer doesn’t have the same powerful 

features as Unisyn, so it cannot automatically inform Unisyn if you 

select a different patch from its patch list. If you make patch 

selections in Performer and you want Unisyn to know about them 

(such as to save them in a Unisyn performance), use the Get Group/ 

All Patches command in Unisyn after you make the changes to 

update Unisyn. If you select patches entirely in Performer, however, 

there’s no need to update Unisyn in this fashion, unless you need to 

edit a patch. 

Beyond its integration with Performer, Unisyn has many features of 

its own that serve as a powerful compliment to Performer. By 

following the general guidelines below, you can select all your 

sounds and banks via Unisyn and then save them as a Unisyn 

performance, which captures the entire state of your MIDI setup for 

the Performer sequence you are working on. You can easily recall 
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this setup before you begin work on the sequence at a later date. 

Using this approach, you can rely on Unisyn to handle most, if not 

all, of your sound selection needs. 

@ The tasks below are basic Unisyn procedures that you 

will become very familiar with as you learn Unisyn. 

They are explained in detail in the Unisyn manual. 

Use Performer to create your sequence, and use Unisyn to select the 

desired banks and patches for the sequence. 

After you have set up your synths with the correct banks, and you 

have selected all of the appropriate sounds for the tracks in your 

sequence, go into Unisyn and create a performance to save them for 

the sequence. To keep things clear, you might want to give the 

performance the same name as the sequence, such as “On the Road 

Again/Sounds&Banks”. 

If you are using patch change events in the tracks of your sequence 

to change patches during playback, or if you used Performer’s 

“Default Patch” feature, be sure to save the necessary banks with the 

performance. This ensures that the synth will have the correct bank 

of sounds the next time you work on the sequence. 

To recall the project, load it’s corresponding Unisyn Performance 

before you begin playing the sequence. By doing so, you load all of 

the correct patch banks and sounds for each module so that the 

sequence plays back with the correct sounds. 

Using Unisyn gives you many powerful capabilities, such as patch 

editing, sound libraries, and more. In terms of sound selection, you 

get the best of both worlds: you can select sounds using both 

Performer’s patch changes and Unisyn’s sound management features. 

However, you need to decide how you are going to choose default 

patches for each track: either by using Performer’s default patch 

feature (in the Tracks window) or by saving patches for Unisyn’s 

modules in a Unisyn performance file. You may find that the decision 

differs for each synth and depends on how you use the synth. 

By using Unisyn’s libraries and powerful searching features, you 

potentially have thousands of sounds at your fingertips, as opposed 

to the restricted 0-127 range imposed by MIDI patch changes. 
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Another great advantage is that you can easily incorporate Unisyn’s 

patch editing capabilities into your sequencing. Does that bass patch 

need more snap in the attack? Just open Unisyn’s Patch Edit window 

and tweak away. You can even do so while the sequence is playing. 

The only (small) price you pay for using Unisyn to its fullest potential 

with Performer is that there is a bit of extra housekeeping required 

on your part. You need to organize your files on the hard disk in a 

way that makes it easy for you to determine which Unisyn 

performance file goes with which Performer sequence file. Here’s a 

suggestion: create a folder for the project and place the Performer 

sequence file and the Unisyn performance file together in the folder. 

2 items 143.5 MB in disk 13.7 MB availab 

Here are a few common problems you might encounter. 

You get a “Not enough memory” message when you try 
to run both Performer and Unisyn at the same time. 
Cause: There isn’t enough free RAM (random access memory) in your 

computer to support the memory requirements of both applications 

at the same. Solution: Make sure there no other applications running. 

Try restarting the computer and launching them again. If you still 

don’t have enough memory, you may need to get a memory upgrade. 

Contact Mark of the Unicorn technical support. 

You select a patch in Performer’s patch list, but you 
don’t hear the correct sound on the synth. 
Cause: There could be many causes for this. One possibility is that 

the synth is in a mode that causes it to respond to your patch change 

differently than by calling up a sound. In this case, try switching into 

Unisyn and selecting a different module for the synth. Also, check the 
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MIDI channel of the device for the patch list. Is the device perhaps 

transmitting on a channel that the synth isn’t set to receive patch 

changes on? Also, have you changed the patch map in the synth? If 

so, read “Patch Maps” on page 673. 

You hear a pause during Performer’s playback. 
If Performer is playing back when you switch between Unisyn and 

Performer, you will hear a brief pause in Performer’s playback. Also, 

if you send a bank or other data intensive operation in Unisyn while 

Performer is playing in the background, this can also stop playback 

momentarily. 

You make a change to a patch in a bank in Unisyn, but 
the change is not reflected in Performer’s patch list. 
Under some circumstances, changes you make to an individual patch 

in the synth’s current bank in Unisyn will not be immediately 

reflected in Performer’s patch list. This includes things like changing 

a patch name, moving it to a different location in the bank, adding a 

new patch to the bank, etc. To bring Performer’s patch list up to date, 

use the Send Bank command in Unisyn’s MIDI menu, which will 

update Performer’s patch list. 
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Chapter 45 MIDI Utilities 

Interface 
Settings 

Edit FreeMiDI 
Configuration 

FreeMIDI Sync 

Panic 

The Interface Settings command in the Basics menu allows you to set 

the communication speed between Performer (actually FreeMIDID 

and other MIDI hardware and software. Use the Interface Settings 

command to open the Interface Settings dialog box. This dialog box 

allows you to enable and disable the two serial ports for MIDI. If, for 

instance, you have a printer attached to the Thru port of your MTP II 

and the MTP II is connected to the Printer serial port, you will need 

to disable MIDI on the printer port in order to do any printing. 

The Edit FreeMIDI Configuration command in the Basics menu opens 

the FreeMIDI Setup program. Doing so lets you add, remove, and 

modify devices in your FreeMIDI setup. Use this command when you 

would like to make changes to the device list pop-up menus that 

appear throughout Performer. 

Free MIDI Sync command in the Basics menu, when checked, causes 

all FreeMIDI programs that are currently running to play, stop, 

rewind, and locate together. When you enable it in Performer, it 

automatically gets enabled in all other FreeMIDI programs, too. 

Conversely, if you enable it in any other FreeMIDI program, it gets 

enabled in Performer automatically. When it is checked, it is enabled; 

when it is unchecked, it is disabled. For complete information about 

this command, refer to “The Transport Controls” on page 710. 

The Panic command in the Basics menu sends an A// Notes Off MIDI 

message and then a note off MIDI message for every MIDI note on 

every possible MIDI channel on every MIDI output cable on both 

serial ports. It also resets MIDI buffers in FreeMIDI software. This 

command can take quite a while. If you wish to stop the operation, 

type command-period on your Mac keyboard. 
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P r efi erences The Preferences command in the File menu gives you several choices 

for various features in Performer. 

Preferences 

Startup options 
Choose how you would like Performer to open when you first launch 

the application. Performer can do one of three things: 

m Open a new file. 

m Present you with the Open file dialog box. 

= Neither of the above. In this case, no window or dialog 

box appears. Instead, Performer’s menu bar appears at the 
top of the screen, and the only menu available is the File 

menu, from which you can choose New or Open. 

Pitch Representation 
Lets you choose how note octaves are numbered. 
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Default Editing Window 
This setting determines what you get when you double-click a track. 

The other two windows can be opened by command-double-click 

and option-command-double-click. 

Settings in the Preferences window are stored in the Performer 

Preferences file, which is automatically created in the Preferences 

Folder in the System Folder. They are global settings and affect all 

files. 
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Chapter 46 Using FreeMIDI Setup 

The Current FreeMIDI 
Configuration 

FreeMI/DI 
Preferences 

This chapter explains all the major functions of the FreeMIDI Setup 

application. 

FreeMIDI Setup is the application that you use to edit your FreeMIDI 

configuration or FreeMIDI System Preferences. It is the application 

that is launched or switched to when the Edit FreeMIDI Configuration 

command is chosen in FreeMIDI-compatible applications such as 

Performer, Mosaic, or Unisyn. In FreeMIDI Setup, you can edit the 

properties and connections of devices as well as the various settings 

in the FreeMIDI System, such as Inter-application MIDI and Monitor 

Patch Changes. You can view the current patch list for a device in a 

pop-up menu. You can control the Transport functions of a FreeMIDI 

sequencer, such as Performer. You can also use FreeMIDI Setup to 

test your studio connections. 

There is no need to make a FreeMIDI configuration “current”. The 

configuration that is visible in the FreeMIDI Configuration window is 

the current configuration that all FreeMIDI applications will use. 

Whenever you launch FreeMIDI Setup to view or edit your FreeMIDI 

configuration, the configuration document with which you were last 

working is opened automatically. If you do not launch FreeMIDI 

Setup, other FreeMIDI applications will be using the FreeMIDI 

configuration that was last opened in FreeMIDI setup. 

If you open a new or existing configuration, it will immediately 

become the current configuration that all FreeMIDI applications will 

use. 

See “Working with FreeMIDI Configurations” on page 703 for 

information on working with multiple FreeMIDI configurations. 

The FreeMIDI Preferences dialog box is where you tell FreeMIDI 

which serial ports you will be using for MIDI, whether you want to 

use Inter-application MIDI, whether FreeMIDI should monitor patch 

changes and whether FreeMIDI should allow non-FreeMIDI 
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applications to use the serial ports for MIDI. See “Launching 

FreeMIDI Setup” on page 46 of the Getting Started booklet for more 

information on FreeMIDI Preferences. 

Quick Setup Use the Quick Setup command to add and delete devices from your 

FreeMIDI configuration. This command is especially good to use 

when you need to add or delete more than one device from your 

configuration. Quick Setup can also shorten the process of 

connecting devices to interfaces, since the connections can be 

specified before the devices appear in the FreeMIDI Configuration 

window and then automatically appear when the setup is completed. 

Auto Config The Quick Setup dialog box contains an Auto Config push button 
which opens the Auto Config dialog box. Auto Config can 

automatically find many of the MIDI devices in your MIDI studio. See 

“Configuring Your studio automatically” on page 51 of the Getting 

Started booklet for information on using Auto Config to configure 

FreeMIDI for your studio. 
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Using Quick Setup to To use Quick Setup to add devices: 

Add FreeMIDI Devices 
1. Choose Quick Setup from the Configuration menu. 

Neu Device: 

Manufacturer: 

The Quick Setup dialog box appears. 

Current Configuration: 

MIDI Time Piece Il, Modem 

K2000 
Model: 

T6500 

Proteus/? 
T6100 ¥ Pc-200 

Studio Location: 

MIDI Time Piece I... 

Cable: 

(Clicking a device in the “Current 

' Configuration" list displays its information : 

fabove. To edit this information, first 

fremove the device and re-add it. 

Using FreeMIDI Setup 

Figure 46-1: Quick Setup Dialog Box 

This dialog box contains a list of all the MIDI devices that are 

contained in your current FreeMIDI configuration on the right side 

under the label Current Configuration. 

. Select the correct manufacturer, model, studio location and cable 

(if applicable) from the pop-up menus on the left and then click 

Add. 

If the pop-up menus do not contain a description of a particular 

device, choose Other and click Add. We will see how you can re- 

name and re-define these devices later in this manual. For now 

they will be called by the default name Device-/ for the first such 

device, Device-2 for the next and so on. If you accidentally add a 

685 



device to the list that you do not want to appear in your studio 

configuration, select its name from the list on the left and click 

kemove. 

3. When you have added all the devices to the list that you wish to 

add to your studio configuration, click Done. 

The FreeMIDI Configuration window will appear containing all of 

the MIDI devices defined in the Quick Setup dialog box and their 

connections. 

Kurzweil 
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Figure 46-2: FreeMIDI Configuration Window 
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Using Quick Setup to 
Remove FreeMIDI 
Devices 

New Device: 

Manufacturer: 

To use Quick Setup to remove devices: 

1. Choose Quick Setup from the Configuration menu. 

The Quick Setup dialog box appears. 

Current Configuration: 

MIDI Time Piece Il, Modem 

K2000 
Model: 

PC-200 ¥ 

Studio Location: 

MID! Time Piece I... 

Cable: 

T6500 

Proteus/? 

(Clicking a device in the “Current 
Configuration" list displays its information 

fabove. To edit this information, first 

fremoye the device and re-add it. 

The FreeMiDI 
Configuration 
Window 

Using FreeMIDI Setup 

2. Select the device or devices you wish to remove from the Current 

Configuration list and click Remove. 

The selected devices will disappear from the list. 

3. When you have finished removing devices, click Done to close the 

Quick Setup dialog box. 

The FreeMIDI Configuration window will appear containing all of 

the MIDI devices defined in the Quick Setup dialog box and their 

connections, minus the devices which were removed. 

This window is where you edit your FreeMIDI Configuration. It is the 

window that will appear when you choose the Edit FreeMIDI 

Configuration command in other FreeMIDI applications such as 

Performer, Mosaic, and Unisyn. 
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Close button 

Info Bar 

MIDI Device Input 

MIDI Interface Input 

688 

This window contains a graphical representation of your MIDI studio. 

It contains MIDI interfaces, FreeMIDI devices, interface-to-device 

connections and an Info Bar. 

Use the title bar of the window to move it as with any standard 

Macintosh window. Use the horizontal and vertical scroll bars to view 

portions of the window not currently visible as with any standard Mac 

window. Use the Zoom button to toggle the window between full 

size and its current state. Use the grow handle to change the size or 

shape of the window. 

| 
Zoom button 

Title bar MIDI Device Output MIDI Interface 

> 
| eee come |e 
Proteus /3 Selected device 

MIDI Device 
rea iat Thru Port 

Connection 

Polaris 

Figure 46-3: FreeMIDI Configuration Window Grow handle 
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Editing Device Info in the 
FreeMIDI Configuration 
Window 

Using FreeMIDI Setup 

In the FreeMIDI Configuration window, you can view, edit, and 

rearrange your FreeMIDI configuration in most any way that you like. 

The FreeMIDI Configuration window shows your current 

configuration. You can make any other previously saved 

configuration the current configuration simply by opening it. 

Use the Quick Setup command along with the Auto Config command 

to quickly set up a configuration that matches your MIDI studio. For 

more information, see “Configuring Your studio automatically” on 

page 51 of the Getting Started booklet. 

You can edit some of the properties of devices that appear in your 

FreeMIDI configuration directly in the FreeMIDI Configuration 

window. The properties that you can change are the manufacturer 

name, model name, device ID, device name, and MIDI transmit and 

receive channels. See “Editing FreeMIDI Devices” on page 693 in this 

chapter for information on editing a// the properties of FreeMIDI 

devices. 

To quickly change the manufacturer, model, device ID or MIDI 

channel for a device: 

1. Select the device you wish to edit by clicking its icon. 

It’s device info appears in the info bar near the top of the window. 

Kurzweil 

Figure 46-4: FreeMIDI Configuration window Info Bar 
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2. Select anew manufacturer or model name from the appropriate 

pop-up menus. 

Unless you want to leave the model name blank, you will need to 

change the model name for a device if you change its 

manufacturer. 

Other 

460 Systems 

404, Signal Processors 

Adams-Srmith 

Akai 

AKG Acoustics 

Alesis 

Other 

Ernulator 

Procussion 

Proteus /'1 

Proteus/1 #R 

Proteus /2 

ART ~ Proteus /2 KR 

Bien Proteus /3 

Casio Proteus /3 KR 

Proteus “MPS 
Clarity 

JL Cooper 

Digitech 

Digital Music Corp. 

DOD Electronics 

Vintage Keys 

VFS SD Yersion II 

~ E-mu Systems 

Ensonit Figure 46-5: Pop-up menus in Info Bar 
Eventide 

Fender 

3. Enter new device ID or MIDI transmit and receive channels 

numbers in the appropriate text entry box(es). 

If you would like to enter consecutive MIDI channel numbers, 

enter the numbers like this: 1-8. If you would like to enter non- 

consecutive numbers, enter the numbers like this: 1,3,5,7,10. 

Editing FreeMIDI You can add, delete, edit, rename, duplicate, connect, disconnect, 

Configurations and rearrange FreeMIDI devices in the FreeMIDI Configuration 

window. Use the techniques below to add and remove devices from 

your FreeMIDI configuration if you only need to add or remove one 

device at a time. Otherwise, it is usually easier to use the Quick Setup 

command to add or remove multiple devices. See “Using Quick Setup 

to Add FreeMIDI Devices” on page 685 in this chapter for more 

information on using the Quick Setup command. 

See “Working with FreeMIDI Configurations” on page 703 in this 

chapter for information on working with multiple FreeMIDI configu- 

rations. 
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Adding FreeMIDI To add a single FreeMIDI device to your configuration: 
Devices 

1. Choose Create Device from the Configuration menu or type 

command-K on your Mac keyboard. 

The FreeMIDI Device Specification dialog box appears. If you do 

not wish to add a device at this time, click Cancel and the 

FreeMIDI Configuration window reappears. 

FreeMID! Device Specification 

Name: |e Device ID: LS 

Manufacturer: Model: (1-16) 

ESM : 
Transmit Channels: 
1234567 8 9101112 13141516 

Bd 
Receive Channels: =... 
1234567 8 9101112 13141516 

Properties: Controller,... ¥ 

Controller, Receives Clock, Transmits Clock 

Studio Location: Cable: 

MIDI Time Pieces, Mod... EES 

Figure 46-6: FreeMIDI Device Specification Dialog Box 

2. Select a manufacturer and model from the pop-up menus. 

Steps 2-7 below are optional. FreeMIDI ships with default settings 

for each device in it’s model list. These default settings appear 

when you select a specific model from the model pop-up menu. 

If you would like to change any of the settings such as the device 

name, ID, properties, MIDI channels or icon, proceed to steps 2-7 

below. Otherwise, click OK and the new device will appear at the 

top of FreeMIDI Configuration window. 
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3. Enter a name for the device by typing the name into the name text 

box. 

4. Set a device ID number by entering a new number in the Device ID 

text box. 

5. Select up to eight different Properties for the device by selecting 

properties from the Properties pop-up menu. 

For more information, see “Device Properties” on page 716. 

6. Set transmit and receive channels for the device, by clicking the 
appropriate box(es) below the MIDI channel numbers that are 

displayed. 

It is very important to set the MIDI channel information correctly, 

since this controls the amount of channels that appear for the 

device in other FreeMIDI applications such as Performer. 

7. Select an icon to represent the device in the FreeMIDI 

Configuration window. 

Click Icons and scroll until the icon that you wish to use is 

displayed in the middle, bordered field and click OK. For 

information on entering your own icons into FreeMIDI, see 

chapter 49, “Editing FreeMIDI Device Files”. 

8. Indicate the studio location of the device by selecting the 

appropriate MIDI interface and cable number from the pop-up 

menus provided. 

If you don’t have a multi-port MIDI interface like the MIDI Time 

Piece II or MIDI Express, the cable pop-up menu will not be 

available. 

Removing FreeMIiDI To remove FreeMIDI devices from your configuration: 

Devices 
1. Select the device you wish to remove by clicking its icon. Shift- 

click device icons to select more than one device. 

2. Type backspace or delete on your Mac keyboard or choose Cut or 

Clear from the Edit menu or type command-X or command-B on 

your Mac keyboard. 

Any of these commands removes the selected devices. 
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3. If you remove the wrong devices, choose Undo from the Edit menu 

and try again. 

Editing FreeMIDI Once FreeMIDI devices are defined and appear in your FreeMIDI 

Devices configuration, you can change any of their properties with the 

FreeMIDI Device Specification dialog box. 

To edit a FreeMIDI device: 

1. Double-click the device you wish to edit. Alternately, select the 

device and choose Edit Device from the Configuration menu or 

type command-E on your Mac keyboard. 

The FreeMIDI Device Specification dialog box appears. If you 

select more than one device in the FreeMIDI Configuration 

window, the Edit Device menu item becomes grayed-out 

(disabled) since you can only edit the properties of one FreeMIDI 

device at a time. 

Name: |AIM. Device ID: 

Manufacturer: Model: (17-372) 

JD-990 hd 
Transmit Channels: 
1234567 8 9101112 13141516 

Receive Channels: 
t 2S. 4°36 Tee 2 This BS ie 

Bank Select Ctrl 0 

Figure 46-7: FreeMIDI Device Specification Dialog Box 
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2. Make the changes you desire and click OK or click Cancel to 

cancel the edit operation. 

See “Adding FreeMIDI Devices” on page 691 in this chapter for 

information on the various properties you can edit in this dialog 

box. 

Naming FreeMiDI When devices are added to your FreeMIDI configuration using Quick 

Devices Setup and Auto Config, they are given default names that correspond 

to their model names. You can easily rename these devices if you 

wish. See “Editing FreeMIDI Devices” on page 693 in this chapter for 

information on one method of changing the name of any existing 

FreeMIDI device with the FreeMIDI Device Specification dialog box. 

An even easier way to change a FreeMIDI device name follows: 

1. Select the device by clicking its icon. 

You can skip step 2 below by clicking the device’s name directly. 

The mouse cursor will change to the text insertion I-beam to 

indicate that it is in text entry mode. 

2. Type the Return or Enter key on your Mac keyboard. 

3. Enter a new name for the device. 

4. Type the Return or Enter key on your Mac keyboard to confirm your 

choice. Alternately, you can click any where in a blank part of the 

FreeMIDI Configuration window to confirm the new name. 

5. If you enter the wrong name, choose Undo Rename from the Edit 

menu and try again. 

@ For users familiar with System 7, FreeMIDI’s naming 

convention is identical to naming icons in the Finder. 

Selecting FreeMIDI To select a FreeMIDI device in the FreeMIDI Configuration window, 

Devices click its icon. To select more than one FreeMIDI device, shift-click 

each icon. To deselect a previously selected FreeMIDI device, shift- 

click its icon. To deselect all selected FreeMIDI devices, click in a 

blank area of the FreeMIDI Configuration window. 
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Duplicating FreeMIDI 
Devices 

Using FreeMIDI Setup 

You can make copies of FreeMIDI devices in two ways. Using the 

Copy or Cut command along with the Paste command, you can make 

copies of devices to paste into other FreeMIDI configurations. Using 

the Duplicate command, you can make copies of devices in the 

current FreeMIDI configuration with one command. 

To copy or cut and then paste devices: 

1. Select the device you wish to copy or cut by clicking its icon. Shift- 

click device icons to select more than one device. 

2. Choose Copy or Cut from the Edit menu. Alternately, you can type 

command-C for Copy and command-X for Cut on your Mac 

keyboard. 

Copy makes a copy of the selected items and places it on the 

clipboard for pasting. Cut makes a copy of the selected items and 

places it on the clipboard for pasting and removes the original 

selection. 

3. (Optional) If you wish to paste the devices into a different FreeMIDI 
configuration, close the current configuration and open a new or 

existing configuration. 

For info on opening new and existing configurations see 

“Opening Existing FreeMIDI Configurations” on page 705 and 

“Creating a New FreeMIDI Configuration” on page 703 in this 

chapter. 

4. Choose Paste from the Edit menu. Alternately, you can type 

command-V on your Mac keyboard. 

The pasted devices will appear in some blank portion of the 

FreeMIDI Configuration window. 

To duplicate devices: 

1. Select the device you wish to duplicate by clicking its icon. Shift- 

click device icons to select more than one device. 

2. Choose Duplicate from the Edit menu. Alternately, you can type 

command-D on your Mac keyboard. 

The duplicated devices will appear in some blank portion of the 

FreeMIDI Configuration window. 
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Connecting Devices to 
Interfaces 

696 

Once you have added a FreeMIDI device to your FreeMIDI 

configuration, you need to connect its inputs and outputs to an 

interface in your configuration. FreeMIDI is unable to send or receive 

MIDI to or from the device unless it is connected to an interface. 

FreeMIDI does not require that the input and output cable of a device 

be the same number, but, in most cases, setting up your studio this 

way may be more organized and simpler to understand. 

@ Outputs are represented by small triangles that are 

located on the right side of devices and interface ports. 

Inputs are represented by small triangles that are 

located on the left side of devices and interface ports. 

To connect a device output to an interface: 

1. Drag a “patch cord” from the output of a device to an input on an 

interface. 

When you release the mouse, the connection will appear. If you 

have a multi-cable interface such as the MTP II or MIDI Express, 

be sure to connect the device output to the input to which the 

device is physically connected. If you are using both the modem 

and printer serial ports, be sure to connect the device output to 

the input on the interface on the serial port to which the device is 

physically connected. 

2. Alternately, you can drag the “patch cord” from the input of an 

interface to an output on the device. 

3. If you connect the wrong ports for a device, choose Undo Drag 

from the Edit menu and try again. 

To connect a device input to an interface: 

1. Drag a “patch cord” from the input of a device to an output on an 
interface. 

When you release the mouse the connection will appear. If you 

have a multi-cable interface such as the MTP II or MIDI Express, 

be sure to connect the device output to the input to which the 

device is physically connected. If you are using both the modem 

and printer serial ports, be sure to connect the device output to 

the input on the interface on the serial port to which the device is 

physically connected. 
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Making MIDI Thru 
Connections 

Making Multiple MIDI 
Input Connections 

Connecting Devices to 
other Devices 

Removing Device 
Connections 

Using FreeMIDI Setup 

2. Alternately, you can drag the “patch cord” from the output of an 

interface to an input on the device. 

3. If you connect the wrong ports for a device, choose Undo Drag 

from the Edit menu and try again. 

When more than one MIDI device shares a single output port from a 

MIDI interface, you need to connect the MIDI Thru port of the device 

to the input of the other device. This mirrors the physical connection 

that you should have between the devices. 

Po nasnnnes nnsnnss 
MIDI Time EB gies. Moder 

= 
__ > ro 

eC) aes - os 2 
$1000 

Figure 46-8:MIDI Thru Connection 

FreeMIDI Setup allows you to connect more than one MIDI output 

from a device to a single MIDI input on an interface. When you make 

such a connection, you are telling FreeMIDI that both devices’ MIDI 

outputs are connected to a single MIDI input on an interface. Without 

some type of MIDI merger, this type of connection is not possible. 

FreeMIDI Setup allows one connection per port (input output, or 

thru) on each device. You cannot connect devices to each other 

except from MIDI Thru to MIDI In of a separate device. If you would 

like to make such connections, use the Cable Routing (on MIDI Time 

Piece and MIDI Express interfaces) or similar features in your MIDI 

interface or MIDI patch bay/merger gear. 

Once you have made connections between devices and interfaces, 

you can remove the connections to make different connections if you 

physically change the connections in your MIDI studio. 
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To remove FreeMIDI device connections: 

1. Click at the intersection of the Device port and the patch cord and 

drag the connection away from the device and then release the 

mouse. 

The connection is broken. 

=a 
CC eee [-- 

> G)r SL  tes00 ; 
Wate 

Figure 46-9; Breaking a Connection 

An alternate way to remove FreeMIDI device connections follows: 

1. Select a connection by clicking it. Shift-click connections to make 

multiple selections simultaneously. 

When a connection is selected, it appears as a thicker, heavier 

line. To deselect a connection, click somewhere in a blank area of 

the FreeMIDI Configuration window. 

ll [= oes | 

cee —— = TGso00 

Figure 46-10: Selecting a Connec- 

2. Type backspace or delete on your Mac keyboard or choose Cut or 

Copy from the Edit menu or type command-X or command-B on 

your Mac keyboard. 

Any of these commands will remove the selected connections. 

3. If you remove the wrong connections, choose Undo from the Edit 

menu and try again. 

Arranging the FreeMIDI You can arrange the FreeMIDI Configuration window any way you 
Configuration window like. We suggest that you drag device icons so that they appear as 

they do in your studio. For instance, you can arrange all the modules, 

which are in a rack to the left of your Mac, to the left side of the 

window and all the modules, which are in a rack to the right of your 

Mac, to the right side of the window. You can drag the patch cords, 

which connect the devices to the interfaces, up or down so that you 

can view the connections clearly. You can drag MIDI ports in a multi- 
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cable interface, such as the MTP, MTP II or MIDI Express, up or down 

to create more or less space between them. You can delete input or 

output cables, which are not part of your studio setup, by clicking the 

patch cord to select it and typing the backspace or delete key on your 

Mac keyboard. You can also make and break connections by just 

dragging the ends of the patch cords. You can use the different 

options in the Views menu to change the size of the icons and to 

view input and outputs separately or together. 

The Clean Up Window You can use the Clean Up Window command in the Views menu to 

Command quickly arrange all the devices in the window into uniform columns. 

Updating Interfaces Interfaces are an important part of the FreeMIDI Configuration. They 

appear automatically when FreeMIDI scans the serial ports for MIDI 

interfaces. This happens the first time you set the FreeMIDI System 

Preferences to access one or both serial ports for MIDI. You can use 

the Update Interfaces command in the Configuration menu to have 

FreeMIDI check for MIDI interfaces that you may have installed or 

powered on after originally setting the Preferences file. 

To do so: 

1. Choose Update Interfaces from the Configuration menu 

The Update Interfaces dialog box appears. 

Serial Ports: Current Interface: 

Modem MIDI Express v 

: To find interfaces automatically, press the Scan button next to the desired 

i port. For interfaces that are presently off-line, you may choose an option 

i from the popup menus on the right, but you must then use the Interface 

i Settings dialog so FreeMID!| can cormmunicate with the interface(s). Press 

i OK when the interfaces listed are correct. 

Figure 46-12: Update Interfaces dialog box 
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Figure 46-11: Arranging FreeMIDI devices and connections 
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Adding Interfaces 

Using FreeMIDI Setup 

2. Click the Scan button for the Serial port(s) you wish FreeMIDI to 

search for interfaces and click OK. 

Interfaces that FreeMIDI finds appear in the FreeMIDI 

Configuration window. 

You can use the Update Interfaces command in the Configuration 

menu to add MIDI interfaces that may currently be off-line (powered 

off or disconnected) to the current FreeMIDI configuration. 

To do so: 

: ee Choose Update Interfaces from the Configuration menu. 

The Update Interfaces dialog box appears. See Figure 46-2 above. 

Sselect the interface you require from the pop-up menus and click 

OK. 

The interfaces are added to your FreeMIDI configuration. 

Choose Interface Settings from the MIDI menu. 

This step is essential to ensure that FreeMIDI can communicate 

with the newly-added interface(s). The Interface Settings dialog 

box appears. 

Mac interface: Serial Ports hd 

.5 MHz / 16H 

1 MHz / 32H 

2 MHz / 64H 

Fast / 1H 

Notin use 

Figure 46-13:Interface Settings dialog box 
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4. Select the appropriate settings for the interface(s) you have added 

and click OK. 

Moving FreeMIDI To move a FreeMIDI interface, drag its icon to the desired position. 

Interfaces Choose Undo Drag command from the Edit menu to return the 

device icon to its original position. 

You can drag the input/output ports of a MIDI interface up and down 

to make more room between each port by dragging the port number 

icon that you wish to move. Choose Undo Drag command from the 

Edit menu to return the port number icon to its original position. 

. . 
ee ny 

Figure 46-14: Moving interface ports vertically 

Editing FreemiDI After a FreeMIDI interface appears in the FreeMIDI Configuration 

Interface Names window, you can change its name. To do so: 

1. Select the FreeMIDI interface you wish to edit by clicking its icon. 

It’s info appears in the info bar. If you clicked the interface icon’s 

name, the mouse cursor changes to a text insertion I-beam and 

you can enter a new name by just typing. If you did not click the 

icon name, you can still edit the name by typing the Return key 

on your Mac keyboard and the name will pop-up for editing and 

the mouse cursor changes to a text insertion I-beam when it is 

over the icon name. If you are familiar with System 7, this naming 

convention works identically to the Finder in System 7. 
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Working with 
FreeMIDI 
Configurations 

Creating a New FreeMIDI 
Configuration 

Using FreeMIDI Setup 

We call the documents created by the FreeMIDI Setup application 

“FreeMIDI configurations”. When FreeMIDI Setup is open, the 

FreeMIDI Setup document that is currently open and whose 

FreeMIDI configuration is visible in the FreeMIDI Configuration 

window is the current configuration that all FreeMIDI applications 

use. Whenever you launch FreeMIDI Setup to view or edit your 

FreeMIDI configuration, the configuration document with which you 

were last working is opened automatically. If you do not launch 

FreeMIDI Setup, other FreeMIDI applications use the FreeMIDI 

configuration that was last opened in FreeMIDI Setup. 

If you open a new or existing configuration, it will immediately 

become the current configuration that all FreeMIDI applications use. 

Although only one FreeMIDI configuration can be current or active at 

a time, you can create as many FreeMIDI configurations as you like. 

Once you have created a FreeMIDI configuration for your own MIDI 

studio, you might want to create a FreeMIDI configuration for another 

studio that you might be working at in the future or you might want 

to create several variations of your home studio for different 

situations. 

To create a new FreeMIDI configuration: 

1. If you have not done so already, open FreeMIDI Setup by double- 

clicking its icon in the Finder. Alternately, you can open FreeMIDI 

setup by choosing the Edit FreeMIDI Configuration command in 

any other FreeMIDI application. 

The FreeMIDI Configuration window opens and displays the 

current FreeMIDI configuration. 

2. Choose New from the File menu or type command-N on your Mac 

keyboard. 

If you have made changes to the current configuration and have 

not yet saved them, FreeMIDI Setup will ask if you would like to 

save these changes before the new configuration opens. 

3. The Update Interfaces dialog box appears. 

This dialog is shown in Figure 46-12 on page 699. 
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4. If you have an interface connected, click Scan on the port it is 

connected to. 

5. If you don’t have an interface connected at the moment, choose an 

interface from the pop-up menu and click OK. 

You now see a new, window with the interface you just found (or 

chose by hand). 

Figure 46-15: New FreeMIDI Configuration 

6. Use Quick Setup or Auto Config to add and connect devices to the 

interface in this new FreeMIDI configuration. Alternately, you can 

add devices to the configuration individually by choosing Create 

Device from the Configuration menu. 

For more information on adding and connecting devices in this 

new FreeMIDI configuration, see “Quick Setup” on page 684, 

“Auto Config” on page 684, and “Editing FreeMIDI Configurations” 

on page 690 in this chapter. 
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Opening Existing 
FreeMIDI Configurations 

Saving FreeMIDI 
Configurations 

Using FreeMIDI Setup 

You now have a FreeMIDI configuration that can be used in the 

studio for which it was designed. See “Saving FreeMIDI Configura- 

tions” on page 705 for information on how to save this configuration 

to disk so that you can open it when you start work in the studio for 

which it was designed. 

Once you have saved more than one FreeMIDI configuration to disk, 

you can open any existing configuration for use in a situation such as 

starting a project in another MIDI studio. 

To open an existing configuration: 

1. If you have not done so already, open FreeMIDI Setup by double- 

clicking its icon in the Finder. Alternately, you can open FreeMIDI 

setup by choosing the Edit FreeMIDI Configuration command in 

any other FreeMIDI application. 

The FreeMIDI Configuration window opens and displays the 

current FreeMIDI configuration. 

Choose Open from the File menu. Alternately, you can type 

command-O on your Mac keyboard. 

If you have made changes to the current configuration and have 

not yet saved them, FreeMIDI asks if you would like to save these 

changes before another configuration opens. Otherwise, a 

standard Macintosh File Open dialog box opens. 

Select the FreeMIDI configuration that you would like to open and 

click Open or click Cancel to leave the current FreeMIDI 

configuration open. 

The selected configuration opens and you can proceed to use this 

configuration in your other FreeMIDI applications. Use the 

directory pop-up menu to navigate to a disk and folder in which 

the configuration you wish to open is located. See your Macintosh 

owner’s manual for more information on saving files and 

navigating to disk and folders. 

You can save each FreeMIDI configuration that you create to disk so 

that you can recall them at a later date. 
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To save a FreeMIDI configuration: 

1. Choose Save from the File menu. Alternately, you can type 

command-S on your Mac keyboard. 

If the configuration has been saved before, it replaces the current 

version of the configuration. If there are no changes since the last 

time the configuration was saved, the Save menu item is disabled 

(grayed-out) in the File menu. If the configuration has never been 

saved before, a standard Macintosh File Save dialog box opens. 

2. Use the suggested name “FreeMIDI Configuration” or enter 

another name for your configuration if you like, and click Save or 

click Cancel to cancel the operation. 

Use the directory pop-up menu to navigate to a disk and folder in 

which you wish to save this configuration. If you like, you can use 

the New Folder button to create a new folder in which to save this 

configuration and others that you might create in the future. See 

your Macintosh owner’s manual for more information on saving 

files and navigating to disk and folders. 

The configuration is now safely saved and you can recall it at a later 

date. 

Popup Patch Librarian applications, such as Unisyn or PatchList Manager, which 

L ists support FreeMIDI’s patch lists, can be used to define patch lists for 

your FreeMIDI devices. You can view the patch lists assigned to 

FreeMIDI devices and send patch changes to their default channels 

directly in the FreeMIDI Setup application. For more information on 

how to define patch lists for a FreeMIDI device, consult your 

Librarian software’s users manual. If you use the PatchList Manager, 

this information is in chapter 48, “Using PatchList Manager’. 

To view and send patch changes in the FreeMIDI Setup application: 

1. Check to be sure that the Popup Patchlists menu item in the MIDI 

menu is enabled. 

The Popup Patchlists command should have a check next to its 

name. If it does not, choose it to select it. 
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2. Press the mouse on a device in the FreeMIDI Configuration window 

and its current patch list appears in pop-up menu. 

Figure 46-2 below shows a portion of an Ensoniq ESQ-M popup 

patch list. 

001 STEIN 033 WIND 

O02 Way O34 BOYS 1 

025 QUANT2 
004 RHODES O36 4IRTO2 
O03 PICT O37 VaINYS 

006 PNOST1 O35 LIFLIN 

OOF PHOST2 O39 KRAFT? 

OOS HARPS! O40 QUANTA 
~~. Pt Fm. F Fm 8 —“™ ff —— 1‘ 

Figure 46-16: Popup Patchlist 

3. (Optional) If you want to send a patch change command to the 

device whose patch list you are viewing, choose the patch you 

want to send and release the mouse. 

The patch change will be sent to the device on its default channel. 

The PatchThru command lets you send MIDI data from one FreeMIDI 

device to any selected FreeMIDI device while FreeMIDI Setup is the 

current application. 

Before using PatchThru, be sure to set the Audition Channels the way 

you need them. 

707 



To do so: 

1. Choose Audition Channels from the MIDI menu. 

The Audition Channels dialog box appears. 

(@® Use default channel only 

() Use all channels 

MIDI Preferences are used for 

PatchThru and Check Connections. 

Figure 46-17: Audition Channels Dialog Box 

2. Select one of the two options available. 

The Use default channel only option is the default setting. With 

this setting PatchThru sends all incoming MIDI data to the selected 

device on the first available MIDI receive channel for that device. 

The Use all channels option will cause PatchThru to send all 

incoming MIDI data to the selected device on all of the selected 

device’s MIDI receive channels at once. This option is mostly 

useful for detecting to which channels a device is currently 

responding. 

3. Click OK to confirm your choice or Cancel! to leave the Audition 

Channels settings unchanged. 

Using PatchThru PatchThru is a checkable menu item. This means that its state (on or 

off) is toggled each time you choose it from the menu. When there is 

a check next to the PatchThru menu item in the MIDI menu, 

PatchThru is enabled. 
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To use PatchThru: 

1. Check to be sure that the PatchThru menu item in the MIDI menu is 

enabled. 

The PatchThru command should have a check next to its name. If 

it does not, choose it to select it. You can also use the Mac 

keyboard shortcut to toggle the state of PatchThru by typing 

command-T. 

2. Select a device and play notes on your MIDI controller keyboard. 

You should hear the notes being played coming from the device 

that is selected. 

@ You can only patch thru to one device at a time. To 

Patch Thru to more than one device, use Multi-record 

mode in Performer or cable routing in the MTP, MTP II 

or MIDI Express. 

MidiLocate is a unique feature designed to make adding devices to 

your FreeMIDI configuration easier. In this mode, FreeMIDI 

automatically determines the proper input cable to which a device is 

physically attached and then displays this connection in the FreeMIDI 

Configuration window. 

MidiLocate is a checkable menu item. This means that its state (on or 

off) is toggled each time you choose it from the menu. When there is 

a check next to the MidiLocate menu item in the MIDI menu, 

MidiLocate is enabled. 

To use MidiLocate: 

1. Select a FreeMIDI device in the FreeMIDI Configuration window. 

2. Check to be sure that MidiLocate menu item in the MIDI menu is 

enabled. 

The MidiLocate command should have a check next to its name. 

If it does not, choose it to select it. You can also use the Mac 

keyboard shortcut to toggle the state of MidiLocate by typing 

command-L. 
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3. Play some MIDI data from the MIDI device. 

FreeMIDI will determine from where the MIDI data is coming and 

redraw the FreeMIDI Configuration window to indicate the 

appropriate connection. 

Here is an example of MidiLocate in action. Let’s say you have a 

Kurzweil K2000 that is connected to some MIDI input on your 

MTP II, but you are not sure which input: 

1. Add a K2000 FreeMIDI device your configuration using Quick 

Setup or Create Device. 

2. Enable MidiLocate. 

3. Select the K2000 device. 

4. Play some notes on its keyboard or send some other MIDI data 

from it and the K2000 device automatically is connected to the 

correct MIDI input port on your MTP Il in the FreeMIDI 

Configuration window. 

The Tr. ansport The Transport Controls window contains buttons that can control the 

Controls transport functions (Play, Stop, Rewind, Locate) of other FreeMIDI 

applications from within FreeMIDI Setup. For instance, you might 

want to start a sequence playing in Performer while you are working 

on some aspect of your FreeMIDI setup. You do so by opening the 

Transport Controls window, enabling FreeMIDI Sync, and clicking 

Play. With this feature, there is no need to switch to Performer. 

@ Playing MIDI in the background using the transport 

controls only functions when FreeMIDI Preference’s 

Software Compatibility is set to allow FreeMIDI 

applications only. For more information, see 

“Launching FreeMIDI Setup” on page 40. 

Once FreeMIDI Sync is enabled you can also stop Performer, rewind 

the sequence, or locate to up to 8 predefined positions within the 

sequence directly from FreeMIDI Setup. 
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FreeMIDI Sync can be enabled from any FreeMIDI application that is 

currently open and that supports this feature of FreeMIDI. In 

Performer, this command is in the Basics menu. When you enable 

FreeMIDI Sync in any open FreeMIDI application, it is enabled for all 

FreeMIDI applications on that Macintosh. 

@ The state of FreeMIDI Sync (ON or OFF) cannot be 

changed while a FreeMIDI application such as 

Performer is playing. 

To use the Transport Controls: 

1. Choose Transport Controls from the MIDI Menu or type 

command- = on your Mac keyboard. 

The Transport Controls window appears. 

REWIHD 3STOF FLAY FAUSE 

OOOOOOO 
1 ee i ee a ee 

Figure 46-18: Transport Controls Window 

Auto-locate buttons 

2. Click FreeMIDI Sync to enable FreeMIDI Sync. 

You can skip this step if FreeMIDI Sync has already been enabled 

by some other FreeMIDI application. If it is already enabled, the 

FreeMIDI sync check box appears checked. 

3. Click the Transport Control function that you want to use. 

Click Rewind, Play, Stop, or Pause to send those commands to the 

FreeMIDI application that you are controlling. The FreeMIDI 

application should respond to these commands as if you were 

using its own controls. 
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4. If the FreeMIDI application that you are controlling supports their 

use, you can use any of the 8 auto-locate buttons to auto-locate to 

some pre-defined location in the sequence or song that is currently 

playing. 

In Performer, you can define these auto-locate points in the 

Markers window. Assign a number from 1-8 for a marker in the 

Seek column and that marker’s location in the sequence will be 

defined as one of the 8 FreeMIDI auto-locate points. Click the 

corresponding button in the Transport Controls window and 

Performer will locate to that point. You can auto-locate at any 

time, even during playback. 

The Panic command found in the MIDI menu sends an A// Notes Off 

MIDI message and then a note off MIDI message for every MIDI note 

on every possible MIDI channel on every MIDI output cable on both 

serial ports. It also resets MIDI software buffers in FreeMIDI software. 

This command can take quite a while. If you wish to stop the 

operation, type command-period on your Mac keyboard. 

The Check Connections command is a utility that FreeMIDI Setup 

provides for troubleshooting and testing the connections of your 

MIDI studio. 

Check Connections is a checkable menu item. This means that its 

state (on or off) is toggled each time you choose it from the menu. 

When there is a check next to the Check Connections menu item in 

the MIDI menu, Check Connections mode is enabled. 

To use Check Connections mode to check MIDI output connections: 

1. Check to be sure that the Check Connections menu item in the MIDI 

menu is enabled. 

The Check Connections command should have a check next its 

name. If it does not, choose it to select it. When the menu item is 

checked, Check Connections mode is enabled and the mouse 
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cursor will change to the Check Connections cursor when it is 

within the FreeMIDI Configuration window as shown in Figure 46- 

2 below. 

Figure 46-19: Check Connections mouse cursor 

Press a device icon and hold the mouse button down. 

While you hold the mouse button down, FreeMIDI sends a C 

major chord on all MIDI channels to the MIDI output port to 

which the selected device is connected. If you have an MTP, MTP 

Il, MIDI Express or other interface which can show MIDI output 

activity, the LED should light up on the selected output port. 

Additionally, the device to which you are playing MIDI should 

play the C major chord. If you do not see MIDI activity or do not 

hear the C major chord, check the connections, cables and power 

switches of all your MIDI gear. 

Press other device icons to test the rest of your studio. 

Uncheck the Check Connections menu item in the MIDI menu by 

selecting it. 

To use Check Connections mode to check MIDI input connections: 

1. Check to be sure that Check Connections menu item in the MIDI 

menu is enabled. 

The Check Connections command should have a check next its 

name. If it does not, choose it to select it. When the menu item is 

checked, Check Connections mode is enabled and the mouse 

cursor will change to the Check Connections cursor when it is 

within the FreeMIDI Configuration window as shown in Figure 46- 

2 above. 

. Send MIDI data from one of your MIDI devices. 

If the device has a keyboard, play notes on it. If it is a rack-mount 

unit, you will need to find a way to send some type of MIDI data 

from it. Try changing patches or initiating a system exclusive 

dump from its front panel. 
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3. The MIDI port to which the device is connected should flash the 

eighth note icon as shown below inFigure 46-2. 

Il 
> (F)e 

-e Ode 

Figure 46-20: Incoming MIDI Data indicator 

If no ports flash, this means that FreeMIDI is not receiving the 

MIDI data. Check the connections, cables and power switches of 

all your MIDI gear. If a port flashes, but it is not the port you 

expected, you will need to re-connect the MIDI device to the 

correct port or better yet, change the connection in your FreeMIDI 

configuration to match the physical connection. See “MidiLocate” 

on page 709. for a quick and easy way to re-connect a device in 

your FreeMIDI configuration. 

The View Menu The View menu allows you to change the way the FreeMIDI 

Configuration window displays. The Clean Up Window command 

automatically aligns devices in straight columns. For more 

information, see “The Clean Up Window Command” on page 699. 

There are three size options, which control the display of FreeMIDI 

device icons and four input/output options, which control the display 

of the “patch cords” that connect devices and interfaces, as illustrated 

in Figure 46-2 below. 
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The two upper sections in this menu each have mutually exclusive 

options. Choosing one of the icon size options disables the other two 

icon size options. Similarly, choosing one of the input/output view 

options disables the other three input/output view options. 

View 

by Small Icon 

by Icon 

“by Large Icon 

Show Inputs Only 

Show Outputs Only 

“Show Inputs & Outputs 

Show On Select 

Clean Up Window 

Figure 46-21: The View Menu 

To use the View menu to change the display of your FreeMIDI 

configuration: 

1. Choose an icon size option from the View menu and the FreeMIDI 

Configuration window will redraw (if necessary) to display your 

choice. 

The choices are Small Icon, Icon, and Large Icon. These three 

choices represent the three icon sizes possible for each FreeMIDI 

device. See “Editing FreeMIDI Devices” on page 693, for 

information on changing the icons of your FreeMIDI devices. 

These options are useful for displaying more or less of your 

FreeMIDI Configuration, depending on what you are doing at the 

time. 

Choose an input/output view option from the View menu and the 

FreeMIDI Configuration window will redraw (if necessary) to 

display your choice. 

These choices are useful for making the FreeMIDI configuration 

window display easier to read. 
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Changing Normally, FreeMIDI finds out what your interface settings are 
automatically. In this case, you should never need to change the Interface : : 8 

i interface settings. 

Settings 
There are, however, a few situations in which you might need to 

make the interface settings manually, such as the following cases: 

m You have an interface that FreeMIDI does not 

automatically recognize 

m You have just changed the communication speed on your 

interface (for example, you’ve changed it from FAST/1X 

speed to 1 MHz). 

There are other possible situations as well. In these cases, you can set 

the interface speed manually using the Interface Settings command in 

the MIDI menu. 

To changing the interface settings: 

1. Choose Interface Settings from the MIDI menu. 

The Interface settings dialog box appears. See Figure 46-2 above. 

2. Select the appropriate options and click OK. 

Device Device properties are descriptive words that can be assigned to any 

7 FreeMIDI device. FreeMIDI applications can use these device Properties re oe | 
properties in any way that they require. Here are two examples of the 

use of device properties: 

a A FreeMIDI application which knows about the General 

MIDI specification could check FreeMIDI devices for the 

General MIDI device property. If the application found this 

property assigned to a certain device, it could then adjust 
itself to display and send the General MIDI patch changes 

only to this device, without having to know anything else 

about the device (such as the device model name or patch 

list). 
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m= A FreeMIDI application that needs to synchronize its 

timing to a certain device could check for the Transmits 

Sync device property. If the property existed, the 

application would know that it could successfully sync to 

the device. 

You can assign device properties to a device when the device is first 

added to your FreeMIDI configuration or at a later time. The 

FreeMIDI Device Specification dialog box is where this assignment is 

made. See “Editing FreeMIDI Devices” on page 693 and “Adding 

FreeMIDI Devices” on page 691, for information on assigning device 

properties to devices. 
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Chapter 47 Quick Reference for FreeMI/DI 
Setup 

The Apple Menu 

About FreeMIDI Setup 

The File Menu 

New 

Open 

Close 

Save 

Save As 

This chapter contains brief descriptions of all the commands and 

dialog boxes contained in the FreeMIDI Setup application. Use this 

chapter as a reference guide for finding out how a certain feature is 

used. Read the chapters that are cross-referenced for more detailed 

information on these features. 

' The Apple menu contains Desk Accessories under system 6 and what 

ever is in the Apple Menu Items folder under system 7. The first 

command in the Apple Menu is About FreeMIDI Setup. 

Choose About FreeMIDI Setup to display the FreeMIDI Setup startup 

screen and version number. Click the mouse anywhere to make this 

display go away and return to the FreeMIDI Configuration window. 

The File menu contains all the commands that allow you to open, 

close, and save FreeMIDI configuration files. 

Use the New command to close the current configuration and open a 

new empty configuration. You will be asked if you are sure that you 

want to close the current configuration, since this will affect all 

FreeMIDI applications that are currently being used. Before the new 

configuration is created, the Update Interfaces dialog appears so that 

FreeMIDI can establish what type of MIDI interface you have. 

Use the Open to close the current configuration and open a 

previously defined configuration. 

Use the Close command to Quit FreeMIDI Setup. 

Use the Save command to save changes you have made to the current 

configuration file on disk. 

Use the Save As command to save the current configuration file with 

a new name. 

To save the current configuration file with new name: 
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Revert 

Page Setup 

Print 

FreeMIDI Preferences 

Quit 
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To save the current configuration file with new name: 

1. Choose Save As from the File menu. 

The Save As dialog box appears. 

2. Enter a new name for the configuration file. 

You can’t use a colon (:) in the name; however all other characters 

are permitted, including spaces. Navigate to the disk and folder to 

which you wish to save the configuration file using the directory 

menu at the top of the window. If you enter a name that is already 

in use, a dialog box asks you to confirm your choice. 

3. Click Save. 

Your configuration file is saved on the disk in its current state 

under the new name. 

Use the Revert command to discard any changes you have made to 

the current configuration file and restore it to the state it was in when 

you last saved it. 

Use the Page Setup command to control the way your configuration 

is printed when using the Print command. See your Macintosh user’s 

manual for more information on Page Setup. 

Use the Print command to print a picture of your FreeMIDI 

configuration. See your Macintosh and printer user’s manual for more 

information on printing. 

Use the FreeMIDI Preferences command to open the FreeMIDI 

Preferences dialog box. This dialog is where you control some of the 

global settings of FreeMIDI such as which serial ports FreeMIDI will 

use, whether Inter-application MIDI is enabled, whether non- 

FreeMIDI applications will have access to the serial ports and 

whether patch change monitoring is enabled. 

Use the Quit command to exit the FreeMIDI Setup application. 
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Undo 

Cut 

Copy 

Paste 

Clear 

Duplicate 

Select All 

Quick Reference for FreeMIDI Setup 

The Edit menu contains commands for copying and pasting FreeMIDI 

devices in the FreeMIDI Configuration window. These commands 

also work in the standard Mac way anywhere in FreeMIDI Setup 

where you edit text. 

Use the Undo command to undo the last edit or change that you 

made to your FreeMIDI Configuration. Generally, this command 

displays the command that it will Undo, such as Undo Drag or Undo 

MidiLocate. As a shortcut, type command-Z on your Mac keyboard to 

invoke this command. 

Use the Cut command to place a copy of the current selection on the 

Clipboard and then remove the current selection. As a shortcut, type 

command-X on your Mac keyboard to invoke this command. 

Use the Copy command to place a copy of the current selection on 

the Clipboard. As a shortcut, type command-C on your Mac keyboard 

to invoke this command. 

Use the Paste command to insert whatever data is currently on the 

Clipboard. As a shortcut, type command-V on your Mac keyboard to 

invoke this command. 

Use the Clear command to remove the current selection. No copies 

are placed on the Clipboard. As a shortcut, type command-B on your 

Mac keyboard to invoke this command. 

Use the Duplicate command to make copies of the currently selected 

FreeMIDI devices. This command only works on selected FreeMIDI 

devices, so it is grayed-out(disabled) unless at least one FreeMIDI 

device is selected. As a shortcut, type command-D on your Mac 

keyboard to invoke this command. 

Use the Select All command to quickly select all of the current type 

of data. For instance, if there is no selection in the FreeMIDI 

Configuration window, Select All selects all the FreeMIDI devices, 

interfaces, and connections in the window. If a text entry box is 

active, such as the name field for a FreeMIDI device, Select All will 

select all the text in the name field. As a shortcut, type command-A 

on your Mac keyboard to invoke this command. 
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The Configuration menu provides access to various commands for 

setting up and changing your FreeMIDI configuration. 

Use Quick Setup to open the Quick Setup dialog box, which allows 

you to quickly add and remove devices to and from your current 

FreeMIDI configuration. For more information, see “Quick Setup” on 

page 684. 

Use Update Interfaces... to inform FreeMIDI of changes you have 

made to the MIDI interface(s) that you have connected to the serial 

port(s) on the Macintosh. For more information, see “Updating 

Interfaces” on page 699. 

Use Create Device to open the FreeMIDI Device Specification dialog 

box and add a new FreeMIDI device to your current FreeMIDI config- 

uration. For more information, see “Adding FreeMIDI Devices” on 

page 691. 

Use Edit Device to open the FreeMIDI Device Specification dialog 

box and edit an existing FreeMIDI device in your current FreeMIDI 

configuration. You must select a device before this command 

becomes enabled. With no devices selected, it remains grayed-out 

(disabled). For more information, see “Editing FreeMIDI Devices” on 

page 693. 

The MIDI Menu contains commands which provide control over 

FreeMIDI Setup’s various MIDI settings. 

Use the Interface Settings command to open the Interface Settings 

dialog box. This dialog box allows you to enable and disable the two 

serial ports for MIDI. If, for instance, you have a printer attached to 

the Thru port of your MTP II and the MTP II is connected to the 

Printer serial port, you will need to disable MIDI on the printer port 

in order to do any printing. 

Use the Return command to return to the FreeMIDI application that 

was last active before switching to FreeMIDI Setup. This command 

will only have an effect if you switch to FreeMIDI Setup with the Edit 
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Transport Controls 

Check Connections 

MidiLocate 

PatchThru 
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FreeMIDI Configuration command from any other FreeMIDI 

application. As a shortcut, type command-R on your Mac keyboard to 

invoke this command. 

Use the Transport Controls command to open the Transport Controls 

window. The Transport Controls window contains buttons that can 

control the transport functions (Play, Stop, Rewind, Locate) of other 

FreeMIDI applications from within FreeMIDI Setup. For more 

information, see “The Transport Controls” on page 710. 

This command, when checked, causes the arrow cursor to change to 

a small keyboard cursor. 

ie JUL 

When you click a device in the FreeMIDI configuration window with 

the keyboard cursor, FreeMIDI sends a C-major chord to the device 

via MIDI. If all is well, the device plays the chord. If there is a 

communication problem between FreeMIDI and the device (such as 

a lose cable or something), the device does not play the chord. 

Conversely, when this command is checked, and you send MIDI from 

one of your MIDI devices to FreeMIDI, the port to which the device 

is connected flashes a note symbol to indicate that FreeMIDI is 

successfully receiving data from the device. 

This command serves as a diagnostic tool for you to determine if 

MIDI communication is OK. 

Use the MidiLocate command to toggle the state of MidiLocate. When 

the menu item is checked, MidiLocate is enabled. When it is 

unchecked, MidiLocate is disabled. For more information, see 

“MidiLocate” on page 709. 

Use the PatchThru command to toggle the state of PatchThru. When 

the menu item is checked, PatchThru is enabled. When it is 

unchecked, PatchThru is disabled. For more information, see “Patch 

Thru” on page 707. 
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This command, when checked, causes the arrow cursor to change to 

a MIDI patch change icon cursor. 

3 

When you then press on a device in the MIDI configuration window 

with the patch change cursor, a popup patch list appears containing 

a list of the patches for the device. For more information, see “Popup 

Patch Lists” on page 706. 

Le! 

The Audition Channels command allows you to choose how 

PatchThru and Check Connections will function. For more 

information, see “Audition Channels” on page 707. 

Use the Panic command to send an “All Notes Off’ MIDI message 

and then a “note off’ MIDI message for every MIDI note on every 

possible MIDI channel on every MIDI output cable on both serial 

ports. This command will also reset all MIDI buffers in all FreeMIDI 

software. This command can take quite a while. If you wish to stop 

the operation, type command-period, on your Mac keyboard. For 

more information, see “The Panic Command” on page 712. 

The View menu controls the display of the FreeMIDI Configuration 

window. The three options at the top of the menu, by Small Icon, by 

Icon and by Large Icon, are mutually exclusive. Choosing one option 

disables the other two. When an option is chosen from the menu, it 

gets a check mark next to its menu item. 

The next four options, Show Inputs only, Show Outputs only, Show 

Inputs and Outputs, and Show On Select, are also mutually exclusive. 

For more information, see “The View Menu” on page 714. 

Use the Clean Up Window command to quickly arrange all the 

FreeMIDI devices in the window in a neat column. For more 

information, see “The Clean Up Window Command” on page 699. 
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Chapter 48 Using PatchList Manager 

What is PatchList This chapter explains how to use PatchList Manager, a FreeMIDI- 
Manager? compatible application included with Performer. You can find it in 

the FreeMIDI Applications folder on the top level of your hard disk 

(unless you have moved it since installation). 

PatchList Manager helps you create and maintain accurate patch lists 

for your MIDI instruments, so that the sound names in Performer 

match the sounds in the instrument. In fact, the word patch refers to 

a specific sound in your MIDI instrument. 

0 SoloCello 

1 ColoViola 

2 SoloViolin 

3 Quartet 

4 SoloChamber 

5 ArcoBasses 

6 ArcoCelli 

7 ArcoViolas 

8 ArcoViolins 

9 Marcatol 

10 Mareato2 

11 LegatoStr 

12 Concerto 

13 PizzBasses 

14 PizzCelli 

15 PizzViolas 

16 Pizz¥iolins 

17 Pizzicatol 

18 Pizzicato2 

19 TremStrings 

20 Strgs/Flutes 
21 RestingPad 

22 Divertimento 

23 Flute 

24 Piccolo 

25 Oboe 

26 EnglishHorn 

27? Clarinet 

28 BassClarinet 

29 Bassoon 

30 Contrabassoon 

31 Charmber'winds 

32 Epilogue 

33 WindStack 

34 FrenchHorn1 

35 FrenchHorn2 

36 SectionHorns 

37 Trumpeti 

38 Trumpet2 

39 TwoTrumpets 

40 HarmonMute 

41 Trombone1 

42 Trombone2 

43 Tuba 

44 BackBrass 

45 ChamberBrass 

46 BrassStrings 

47 Timapni 

48 Gong/Cymbal 
49 Bass /Snare 
50 TempleBlock 

51 Xylophone 

52 Glockenspiel 

53 Celesta 

54 TubularBells 

55 Percussion1 

56 Percussion2 

S? Harp 

58 Harpstrings 

S59 Harpsikord 

60 NotreDame 

61 WinterSigns 
62 DeepPad 

63 Portamento 

64 BellEnsemble 

65 Cyberspace 

66 PizzMoogBass 

67 Marimbala 

68 GrimReaper 

69 TinkerBell 

70 Carousel 

71 ExoticHarp 

72 DarnSaucers 

73 BronzePad 

74 Vibraphone 

75 AstralFlute 

76 KoolBass 

77? Sombre'winds 

73 SpaceCowboy 

79 TheMachine 

80 EarlyPerc 

81 GentlyNow 

82 Piccolodeeyo 

83 InfiniteOne 

84 Shimmer'w ays 

85 TurboBass 

86 Requiem 

87 WrongRoorm 

88 AnalogPad 

89 ChapelOrgan 

90 Electrovocal 

91 FatBoy Tuba 

92 SawBass/Lead 
93 ViennaDream 
94 VertigoPad 

95 TarkusTwin 

96 RoomOfStrings 

97 MagicBells 

98 Reginatron 

99 Sublt! 

100 Psychlotron 

101 CloudChamber 

102 Sepulcher 

103 LurchPluck 
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Figure 48-1: For many popular MIDI devices, Performer automatically displays sound names in 
its pop-up patch lists. If not, you'll see generic names as shown on the right. PatchList Manager 
lets you replace generic names with the actual names in the synth. In addition, it provides a host 
of capabilities that allow you to maintain accurate patch Lists for all of your MIDI devices. 
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Do you need to use 
PatchList Manager? 

Situations that call for 
PatchList Manager 

A brief overview of 
PatchList Manager 
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FreeMIDI automatically provides factory default patch lists for over 70 

popular synthesizers and sound modules. If your device is one of 

them, the patch lists you see in Performer’s Patch and Default Patch 

pop-up menus will be accurate and complete, and you probably 

won't need to use PatchList Manager. To check the accuracy of a 

device’s patch List in Performer, choose a sound from a track’s 

Default Patch pop-up menu in the Tracks window and then see if the 

track plays with the sound you chose. If so, you are all set. 

Here are the most common situations in which you would need to 

use PatchList Manager: 

mw Performer is displaying generic sound names for one of 

your devices as shown in Figure 48-1 on page 725 (i.e. 

“Patch 1, Patch 2, Patch 3” etc.) and you want to see actual 

sound names instead. 

= The current sound names in Performer don’t match the 

sounds you hear in the instrument. 

= YOu want to make minor changes to a patch List, such as 

changing the order of the sounds in the list. 

m You have loaded a new bank of sounds into the 

instrument (or have otherwise changed the internal state of 

the instrument) and you want to access them by name in 

Performer. 

= YOu want to set up, reorganize, add, or remove multiple 

patch Lists for an instrument that has multiple banks of 

sounds. 

PatchList Manager has the three main windows shown in Figure 48-2. 

The FreeMIDI Devices window shows the MIDI device or devices 

that you want to work with. The Patch List window shows all of the 

patch lists that can be assigned to the devices. The Programs window 

displays the list of sounds contained in a particular patch list. 

The information shown in these three windows is saved in your 

FreeMIDI Setup document, as well as a separate PatchList Manager 

document, which you'll save to disk when you have finished working 

with PatchList Manager. 
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The mini-menu 

contains commands that 

apply to the window. 

The Close 

button closes 

the window. 

"—_ BEUICES MODULES 

> aoe K2000R 

b> TS-12 
> aoe XS i 
—7 RCH Morpheus : 

fa Channel 1 

The Expand ff Channel 2 
button shows n eeeet = 

and hides the ‘ — 
MIDI channels $ 2 mes 

. anne 

for the device. 1) Channel & 
ga Channel 9: 
ya Channel 10 : 10 
ya Channel 11 i 11 
fa Channel 12 | 12 
yg? Channel 13 : 13 

Drag the Move yi Channel 14 | 14 
handles to ys Channel 15 5 15 

fa Channel 16 } 
reorder the 

channels. You 
can also drag 
patch lists and 

~ 
Pap or tant ei ie Pe Pa 

~ Pa ie te ees has te 
ae ae 

FreeMIDI Devices 
CURRENT FATCH 

wow eo AR 

The FreeMIDI Devices window shows the MIDI instru- 
ments you would like to work with, along with the MIDI 
channels belonging to each device. Use the Choose 
Devices command in the mini-menu to decide which 
devices you want to see in this list. 

PATCH LIST 
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In the Patch List column, you choose 

The Patch Lists window shows patch Lists, which can be 
grouped into folders. To place a patch List in a folder, drag 
its diamond move handle and drag it on top of the folder 
icon. Use the Add Folder command to create a new one. 

The Programs window gives 
you access to the sound names 
in the patch list. Use the mini- 
menu commands to arrange 
the list and set the numbering 

“4 Patch Lists 
USED CMD? COMMENT 

. .. ~ a ee eee SSS 
‘== ]- Pde OO Plas 

~ ON . * 1 ie, NS SONS 
we ee at ge 4 ra ff 

HAME LENGTH Ean K COMMENT 

sounds this way. which patch list (or patch list folder) to 
display in Performer for each MIDI 
channel of the device. In this example, 
the patch list folder called Morpheus 
Banks is assigned to all Morpheus 
channels. As a shortcut to assign all 
channels at once, click in this column 
next to the device name instead of one 

of its channels. 

Opening PatchList 
Manager 
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Figure 48-2: PatchList Manager's main windows 

To open PatchList Manager, double-click the PatchList Manager icon 

on your hard disk. It is located in the FreeMIDI Applications folder on 

the top level of your hard disk Cunless you have moved it since instal- 

lation). What you'll see at first is the Choose Devices dialog box as 

shown in Figure 48-3 on page 728. 
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Choosing the devices The first thing you need to do is choose the device or devices you 

you want to work with need to work with. Only choose the devices whose patchlists you 

need to edit. Remember, if their patch lists are already fine, you don’t 

need to do anything with them in PatchList Manager. 

1. Select each device you would like to work with by highlighting its 

name; deselect devices you don’t need to work with. 

2. If Performer’s pop-up menus already display sound names for the 

device, and you would like to work with this default list of names in 

PatchList Manager, choose the list by its manufacturer and device 

name in the “PatchList template” pop-up menu to the right of the 

device. 

Choose Devices f|- 

Figure 48-3: Choosing the 
devices you want to work with 

ighting the name(s) on 
the left. To configure patchlists for a device automatically , press the 

PatchList Template column and choose the appropriate template frorm the popup 

menu. Click “Auto” and devices supported by PatchList Manager templates are 

automatically selected and configured. 

Click the devices 

shown here to select 

or deselect them. If a 

device’s lists are 

showing up in 
Performer and select- 

ing the correct 
sounds, there is no 

need to select it here. 

FreeMIDI Device 

ProMixO1 

Patchlist Template 

lf you want to work with FreeMIDI’s 
default patch List(s) for a device in 
PatchList Manager, choose the list by 
name here. Note that some devices 
aren't supported and therefore will not 
have a default list, as shown in this 

example by the Korg DW-8000. 

Kurzweil K2000 

E-mu Proteus 1 

01 fw Prox 

Under the hood: what happens when you choose a sound by name? 

The sounds in a patch list are the sounds that are evoked 

when a MIDI program change message (sometimes called a 

patch change) is sent to the device. MIDI patch change 

events are numbered from 0 to 127 (or 1 to 128), so patch 
Lists will commonly have 128 sounds in them, although 

you'll frequently encounter other sizes. 

Some MIDI devices have more than 128 sounds. In this case, 

the instrument either organizes them into multiple banks of 

sounds Cusually ranging in size from 50 to 128 each), or it 

allows you to “map” sounds higher than 128 to a program 

change number below 128, replacing the original sound that 

used that number. 

If an instrument has multiple banks, a separate patch list is 

set up for each bank. In this case, the term patch list is pretty 

much synonymous with the word bank. 

If a device has multiple banks, it often requires an additional 

message, called a bank select message. To call up a sound 

from the bank in this case, Performer sends several MIDI 

messages: a bank select message (usually controller #0 and/ 

or controller #32) followed by a patch change message. 

Some devices use a different type of MIDI message for bank 

select, such as a short system exclusive message. FreeMIDI 

can handle any type of bank select message. To learn more, 

see “Using multiple patch lists & bank select messages” on 
page 747. 
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3. The devices appear in the FreeMIDI Devices window with their MIDI 

channels shown below them. 

: b Dw-so000 ; 
Devices ——— > _ || PP ec Proteus /1 

vy BOB K2500R 

The Device’s MIDI channels 

Figure 48-4: A device in the FreeMIDI Devices window 
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i K2000 banks: 
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The current patch list (or patch 
list folder) assigned to each 
MIDI channel. The K2000 
Banks folder holds all ten 
banks for the K2000, as shown 
below in Figure 48-5. 

4. If you imported FreeMIDI’s default patch lists along with the 

devices, they appear in the Patch Lists window. 

Patch list folder 

Patch lists in the K2000 folder 

*+¢¢¢44¢44 4 
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Figure 48-5: Imported FreeMIDI patch lists 
appear in the Patch Lists window. 
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Decidi ng wha fo What you do next depends on what the situation is with each MIDI 

do next device. Here is a summary: 

Situation What to do 

Performer is displaying generic sound names for See “Creating a new patch list” on page 731. 

one of your devices as shown in Figure 48-1 on 

page 725 (.e. “Patch 1, Patch 2, Patch 3” etc.) and 

you want to see actual sound names instead. 

Most or all of the current sound names in Per- See “Creating a new patch list” on page 731. 

former don’t match the sounds you hear in the 

instrument. 

You have loaded a new bank of sounds into the See “Creating a new patch list” on page 731. 

instrument (or have otherwise changed the inter- 

nal state of the instrument) and you want to 

access them by name in Performer. 

You want to set up, reorganize, add, or remove “Using multiple patch lists & bank select messages” on 

multiple patch lists for an instrument that has page 747. 

multiple banks of sounds. 

You want to make minor changes to a patch list, See “Making changes to a patch list” on page 741 

such as changing the order of the sounds in the 

list or renaming a few sounds. 
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Creating a new 
patch Iist 

Ways to create a patch list 

Load the Device’s patch list (or lists) 

from old Performer or Digital Per- 

former files 

If PatchList Manager supports the 

device, it can get a “patch dump” from 

the device to automatically extract 

accurate patch lists from it 

If PatchList Manager doesn’t support 

the device, you can use Unisyn, Mark 

of the Unicorn’s universal editor/ 

librarian software, to extract an accu- 

rate patch list for each bank in the 

device 

If none of the above methods apply, 

you can type in the patch names by 

hand 

If your MIDI instrument doesn’t have a patch list yet, or if the current 

patch list is inaccurate for some reason (i.e. more than just a few 

sound names are incorrect), your next step is to create a new patch 

list for the device. There are several ways to do so. They are 

summarized below in the order in which you should try them. 

If you already have patch lists for the “Importing patch lists” on 

device in a Performer 4.2 (or earlier) page 732 

or Digital Performer 1.4 (or earlier) 

file, you can import the list(s) into 

PatchList Manager. Regular Per- 

former files and configuration files 

can be read by PatchList Manager. 

PatchList Manager gets a system “Using PatchList Manager to 

exclusive bulk dump from the load patch names” on 

device, extracts the patch names, & page 733 

generates a patch list for each bank. 

Get banks using Unisyn and then “Getting patch lists with Uni- 

import the Unisyn-generated patch syn” on page 7306 

list for the bank into PatchList Man- 

ager. 

You add a new, generic patch list “Creating a patch list by 

and type the names in by hand. hand” on page 738 

What is a “system exclusive bulk dump”? 

The phrase system exclusive refers to a certain kind of MIDI The term bulk dump is used to refer to system exclusive 

message. Without getting too technical, system exclusive messages containing large amounts of information. Often, a 

messages are used to communicate information that is bulk dump represents the complete internal state of a MIDI 

unique to a specific MIDI instrument or device. System device. In other words, the bulk dump serves as a 

exclusive messages have a special format that allows them to “snapshot” of the current state of the instrument. PatchList 
hold a varying amount of information. They can be so small Manager usually deals with bulk dumps that consist of one 

that they are transmitted in a fraction of a second; they can bank of sounds. For some devices, it gets the entire internal 

be so large that they take minutes to transmit. state. Either way, you'll probably wait at least a few seconds 

for the transmission to be completed. 
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impor ting patch You can import patch lists from Performer 4.2 (or earlier) or Digital 

/ " t Performer 1.4 (or earlier) files. You can import the patch lists from 
ISTS | 3 Ries <= either complete sequence files or configuration files. You can also 

import them from other PatchList Manager files you may have saved 

on disk. 

To import patch lists from a Performer or Digital Performer file: 

1. Choose Import Patch Lists from the File menu. 

A standard Mac open file dialog appears. 

2. Select the Performer or Digital Performer file that contains the 

patch list you wish to import and click Open. 

Use the directory menu as needed to navigate on your hard disk 

in order to find the file. You can select either configuration or 

complete sequence files. 

3. If the Patch Lists window isn’t already open, choose it from the 

Windows menu to view the imported list(s). 

4. (Optional) If several of the imported lists belong to the same MIDI 

device, create a folder in the Patch Lists window and place them in 

the folder. 

See “Grouping patch lists in a folder” on page 744. If the MIDI 

device supports some form of bank select, you will want to set up 

the bank select message for each list so that you can effortlessly 

choose sounds from any bank. See “Using multiple patch lists & 

bank select messages” on page 747. 

5. To make the imported lists appear in Performer, assign them to 

their appropriate device in the PatchList Manager Devices window. 

See “Getting patch lists to appear in Performer” on page 740. 
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Using PatchList 
Manager to load 
patch names 

Determining if PatchList 
Manager supports your 
device 

Getting device help 

Using PatchList Manager 

For some MIDI devices, PatchList Manager can get a system exclusive 

bulk dump — also called a patch dump — from the instrument to 

extract an accurate patch list (or lists). (See the side-bar on page 731 

for an explanation of this term.) The most common situation in which 

you would want to do this is when you have changed the sounds or 

banks in the instrument (so that it is no longer in its factory default 

state), and you would like the patch lists in Performer to reflect those 

changes. 

For example, if you have an E-mu Proteus, and you have changed the 

patch map in order to access sounds above 128, you can use 

PatchList Manager to get a new patch list with names that match the 

current patch map. As another example, you may have loaded a new 

bank of sounds into your Korg M1 and you would like the new bank 

to appear as a patch list in Performer instead of the factory bank. 

PatchList Manager can only get patch dumps from devices that it 

specifically supports. To see if your device is supported, look at its 

icon in the Devices window as shown below: 

TES IETS, Freemini Devices | . ie ae 
DEVICES “MODULES CH. PATCH LIST CURRENT FATCH COMME 

Not supported b € Dw-s000 | 

Supported-—sexaiseaa er + Bae RHO 
> gow Proteus/'1 

If your device is not supported, chances are good that you can use 

Unisyn, Mark of the Unicorn’s universal editor/librarian software, 

instead. Unisyn currently supports 212 MIDI devices (with more on 

the way). See “Getting patch lists with Unisyn” on page 736. If you 

don’t have Unisyn (yet), your only recourse at this point is to type in 

the patch names by hand. See “Creating a patch list by hand” on 

page 738. 

If your device is supported by PatchList Manager, check its Device 

Help window for important information about how to use PatchList 

Manager with the device. This window often contains information 

about settings that you need to enable/disable in the MIDI device to 

successfully get a patch dump from it. It may also contain other 

important and relevant information about the device. 
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Make sure the device 
has both its MIDIIN and 
MIDI OUT connected 

Getting a patch dump 
from a device 

734 

To check Device Help: 

1. Click the device in the FreeMIDI Devices window to select it. 

2. Choose Device Help from the Devices menu. 

The Device Help window appears. This is the Device Help 

window for the Ensoniq ESQ-M: 

Vee 

Before using the Get Patch Durnp command, use the 

O5SR W's front panel to manually turn off protection for 

Pragrams and Combis (menu pages 034 and OSB), and 
enable system exclusive in the Global MIDI filter menu Cit 

should read ‘EX -EN4' on page O2C if you set it correctly). 

‘fou only have to set these once because the OSF/W 

remembers the settings unless you change the battery or 

perform a Preset Data Load from page OSC. 

FreeMID| automatically sets the OSF/W to Combination 

mode the first time you choose a patch from the 

Combinations patch list. This combi mode MIDI message is 

not sent again unless you quit all FreeMID| applications , 

open a FreeMIDI| application, and then choose a patch from 

the Combinations patch list again. 

Before you go further, make sure that the device has both its MIDI IN 

and MIDI OUT connected to your MIDI interface. Otherwise, 

PatchList Manager won’t be able to get the patch dump successfully. 

If you add a connection at this time, use the Edit FreeMIDI 

Configuration command in the MIDI menu to make sure both 

connections are present in your FreeMIDI configuration. 

Once you have checked device help and MIDI cable connections, 

you are ready to get a patch dump from the device. By doing so, 

PatchList Manager will automatically extract a patch list for each bank 

in the device. To get a patch dump: 

1. Click the device in the FreeMIDI Devices window to select it. 

2. Choose Get Patch Dump from the Devices menu. 

3. The Patch Dump progress dialog appears while PatchList Manager 

receives the patch dump. 

@ Depending on the format of the MIDI device’s sysex 

data dump, this progress bar may fill up slowly or all 

at once when the dump is complete. 
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Sending the dump back 
after editing it 

Editing the bulk dump in 
its raw hex form 

Using PatchList Manager 

Current Device: O5R/W 

Click Cancel or press command-period (.) to 

cancel. 

Cancel 

Two things happen when the patch dump is complete: 

m The factory default patch list is updated, and the updated 

lists will automatically appear in Performer. 

m The device’s move handle icon changes slightly to indicate 

that it contains a sysex data dump. 

MAE} SE 4, FreeMIDI Devices 
DEVICES “TAODULES CH. FATCH LIST CURRENT PATCH Lal 

bP eoHK2500R : | : : 
> ecw Proteus/1 ; 
<7 2B ose s/w 

4 Channel 1 1 | OSR/w banks! Sunrise 
ya Channel 2: 2: OSR/W banks! Sunrise 
ya Channel 3: 3] OSR/W banks: Sunrise 
yi Channel 4: 4] OSR/W banks? Sunrise 

Patch dump indicator 

For most instruments, PatchList Manager will allow you to edit the 

patch lists (change names of sounds, etc.) and then send the bulk 

dump back to the instrument to update the device itself. See “Sending 

a patch list back to a configured device after editing it” on page 743. 

If you enjoy doing such things, PatchList Manager lets you view and 

edit bulk dump in its raw hexadecimal form. To do so: 

1. Click the device in the FreeMIDI Devices window to select it. 

2. Choose Edit patch dump from the Devices menu. 

If the bulk dump 

consists of several 
separate sysex 

messages, use 
these buttons to 

scroll through them. 

Use this section to 

transmit any sysex 
message you want 

to the device. 

Edit the hex data 
directly here. 
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Getting patch 
lists with Unisyn 

736 

If you have a synthesizer or sound module that is not supported by 

PatchList Manager, Unisyn can save you the trouble of typing in the 

patch lists by hand. Unisyn is Mark of the Unicorn’s Universal Editor/ 

Librarian software. Unisyn supports 212 MIDI devices Gnore are on 

the way) with complete library and editing functions. If PatchList 

Manager doesn’t support one of your MIDI devices, chances are that 

Unisyn does. Contact Mark of the Unicorn to see if your device is 

supported. 

Unisyn specializes in getting banks from synths. When it gets a bank, 

it automatically publishes the patch list for the bank to all FreeMIDI- 

compatible programs. If you want to work further with it in PatchList 

Manager, you can load this Unisyn-generated patch list into PatchList 

Manager as follows: 

1. Get the bank from the device using Unisyn’s Get Bank command. 

Consult the Unisyn manual if you need help with this step. As 

soon as Unisyn gets (or sends) a bank, it “publishes” a patch list 

for the current bank to all FreeMIDI programs. In some cases, you 

may need to transfer the bank into RAM before getting it. Consult 

Unisyn’s profile help for the device. 

2. Back in PatchList Manager, select the device by clicking its name 

in the FreeMIDI Devices window. 

UE), FreeMIDI Devices ~~ le 
YY (——7 . ca 

DEVICES MODULES CH. PATCHLIST CURRENT PATCH COMME 
> Bog K2500R i i 
> Row Proteus/1 : 
> SE osr Ww 
b 

3. Choose Load FreeMIDI Patch Lists from the Devices menu. 

The Unisyn-generated patch list is added to the bottom of the list 

in the Patch Lists window. Some devices produce several lists. 

4, FreeMIDI Devices | Devices || /~7./Ee)- 
| DEDICES MODULES CH. PATCH LIST CURRENT PATCH COMME LENGTH BANK USED CMD? COMMENT 
> eo K2500R H # Proteus/1 Presets § 128} Pati i 
> Bow Proteus/1 : ; : > CO K2000 banks 
pb MB ose/wy  f: > CO OSR/W banks 
b ) [Dw-s000 |] eno i i i @ DW-8000 Programs: 64 

The ifeened aw list 
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4. (Optional) Rename the newly loaded patch list(s) by clicking its 

name in the Patch Lists window. 

This step is especially recommended if you are loading multiple 

lists for a single device because it helps you better identify each 

bank. 

5. (Optional) If Unisyn produced several separate patch lists for the 

device (one for each bank), create a folder in the Patch Lists 

window and place them in the folder. 

See “Grouping patch lists in a folder” on page 744. If the MIDI 

device supports some form of bank select, you will want to set up 

the bank select message for each list so that you can effortlessly 

choose sounds from any bank. See “Using multiple patch lists & 

bank select messages” on page 747. 

6. To make the imported list (or newly created folder) appear in 

Performer, assign it to the appropriate device in the PatchList 

Manager Devices window. 

See “Getting patch lists to appear in Performer” on page 740. 

7. If the device has other banks that you want to import, repeat this 

procedure for each bank. 

For example, Unisyn may be able to import data card banks for 

the device. In this case, you can import a patch list for each data 

card. In fact, you can import as many banks as you want into 

PatchList Manager and then place them together in a folder so that 

you have all the names at your fingertips in Performer. If you do, 

however, you'll need to keep track of which banks are actually 

loaded into the instrument at any given moment. 
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Cri eating a patch If none of the methods discussed in the previous sections for creating 

7 a patch list apply to you, you can create a new patch list manually 

list by hand and type in the patch names by hand. 

To create a new patch list: 

1. Choose Add Patch List from the Patch Lists menu. 

A new patch list appears at the bottom of the list. It is named 

“PatchList 1”. 

Ut 2 ee Rh hE Ee 
ee OT ee Pe Pe 
tes WS SN SS 

OL PS ae a SS BS IS Dae ee sae BO 

Duplicate 

Delete 

* Piano 

2. Click its name and enter an appropriately descriptive name for the 

patch list. 

=] General MIDI Lists 
* Strings is be 

# Basses 1d 
* Guitars : 3 ; 

* Brass 7 

3. Double-click the new patch list’s move handle icon to open its 

patch list window. 

The sound names window appears. Alternately, you can choose 

the patch list’s name from the Windows menu to open its window. 

i Patch 4 
i Patch 5 
: Patch 6 
i Patch 7 
i Patch & 
: Patch 9 
. 6B.knk tm IW OOO BW he a + 
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. If you’d like to list the names alphabetically, choose Sort by name 

. (Optional) If you are creating several separate patch lists for the 

. Choose Set Numbering Format from the patch list window mini- 

menu to set the numbering of the patch list. 

See “Setting the numbering format for a patch list” on page 743 for 

more information. 

. Click the first patch name in the list, “Patch 1” and type in a new 

name. 

. Press the Return key on your Mac keyboard to confirm the edit, or 

press the Enter key to move to the next name in the list. 

Similarly, you can move up and down between patch names with 

the up and down arrow keys. 

| Patch 6 

from the mini-menu. 

device (one for each bank), create a folder in the Patch Lists 

window and place them in the folder. 

See “Grouping patch lists in a folder” on page 744. If the MIDI 

device supports some form of bank select, you will want to set up 

the bank select message for each list so that you can effortlessly 

choose sounds from any bank. See “Using multiple patch lists & 

bank select messages” on page 747. 

. To make the new list (or folder) appear in Performer, assign it to the 

appropriate device in the PatchList Manager Devices window. 

See “Getting patch lists to appear in Performer” on page 740. 
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Getting patch To make a patch list or patch list folder show up in Performer’s 
" . pop-up menus, you need to assign it to the device in PatchList 

I | sts fo app Car in Manager’s Devices window. You can assign the patch list to all of the 

Performer device’s MIDI channels, or you can assign it to individual channels. 

You can even assign different lists to different channels. For example, 

you might assign a drum kit list to channel 10 and a list of all other 

sounds to channels 1-9 and 11-16. 

To assign a patch list or patch list folder to all of a device’s MIDI 

channels at once: 

1. In the FreeMIDI Devices window, press in the Patch List column to 

the right of the device name. 

A pop-up menu of patch lists appears. 

+ FreeMIDI Devices 
DEVICES “MODULES cH. PATCH LIST CURRENT PATCH COMMEN 

w7G) Dw-s000 | H 
fa Channel 1; 

7 BCH K2500R 
{7 Channel 1 

“vt, FreeMIDI Devices 
PATCH LIST CURRENT PATCH COMMEN DEVICES “MODULES CH. PATCH LIST CURRENT FATCH COM 

v7) Dw-s000 | i 1 
ya Channel 1 i : 

7 BCH K2500R 

7G bw-s000 | 
fi Channel 1: — 

7 Channel 2 

{4 Channel 3 

f4 Channel 4 

fa Channel S 

fa Channel 6 

fa Channel 7 

7 Channel 8 

fa Channel 9 

2 Channel 10 } 

2 Channel 11; 
yi Channel 12 
ya Channel 13 } 
ya Channel 14 : 
fa Channel 15: 
fa Channel 16 | 

= BOB K2500R ; “None 

fi Channel 1: 

ga Channel 2; 
ya Channel 
fa Channel 4 

fa Channel 5 

fa Channel 6 

fa Channel 7 

fa Channel & 

4 Channel 9 

ya Channel 10 
fa Channel 11; 
ff Channel 12 ; 
ya Channel 13 
ya Channel 14 i 
ya Channel 15 

4 Dw-8000 Programs 

4 Proteus/1 Presets 

4 Channel 1 

fa Channel 2 

fa Channel 3 

fa Channel 4 

4 Channel 5 
fa Channel 6 

fa Channel 7 

fa Channel 8 

fa Channel 9 

ga Channel 10 
ga Channel 11; 
ya Channel 12 : 
ya Channel 13 
ya Channel 14 
ya Channel 15 : 

i K2000 banks: 
: K2000 banks} 
? K2000 banks: 
: K2000 banks: 
? K2000 banks: 
? K2000 banks: 
? K2000 banks: 
? K2000 banks 
? K2000 banks: 
? K2000 banks! 
? K2000 banks! 
? K2000 banks! 
? K2000 banks! 
? K2000 banks: 
? K2000 banks! 

ya Channel 16 4 Channel 16 | 16 ; K2000 banks: 
> ecw Proteus/1 ; i > mow Proteus /1 > mow Proteus /1 

2. Choose the desired patch list. 

To assign a patch list to an individual MID channel: 

1. If the MIDI channels for a device are hidden, click the Expand 
button to display them. 

ZEDIETS, Freemini Device: 
DEVICES “MODULES CH. PATCH LIST CURRENT 

b Vintage Keys | : 

Expand button 
fa Channel 1 aon 

7 Channel 2 : 2: 

2. Press in the Patch List column next to the MIDI channel and choose 

the desired list from the pop-up menu. 
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Making In a patch list, you can: 

chang es to a = Edit the names of the sounds 

patch list Change their order in the list by dragging them up and 

down 

m Sort them by numerically or alphabetically 

Change the numbering scheme 

Change the patch change number for any sound 

Opening up a patch list To open a patch list, double-click the patch list’s name or move 
handle icon to open its patch list window. 

# K2000 Programs 

# Proteus/1 
# Proteus/2 
a vavestation Sk 

+ 

+ 

+ 

ZIQUS, Wavestation sh 
FATCH HAME 

: Layers Of Funk 
O01: Leaving the Pod 

Roland J¥V880 Perform 

Roland J¥Y880 Patch : 64 

~-C) OSR Ww Banks o2 Vocal Highlands 
# Drum Kits Sis 03: MIDI Piano 

# Bank G $128: 3 O04: Ob Mini 2 
OS: Saw Bass 
O06: Bliss Pad 
OF: AFT Vocal Pad 
O08: Guitaro 2 2 et Le Le et Le 

The sound names window appears. Alternately, you can choose 

the patch list’s name from the Windows menu to open its window. 
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Editing a patch list 

To do this 

Change the name of a sound 

To move a sound up or down in the list 

To sort the sounds alphabetically 

To sort the sounds numerically 

To change the numbering scheme 

To create a custom numbering scheme 

To change the overall number of 

sounds 

To make the numbering start at 0 

instead of 1 or vice versa 

To set up a bank select message for the 

list 

To change a sound’s patch number 

742 

Here is a summary of what you can do in the patch list: 

Do this 

Click the patch name in the list that you wish to edit, enter a new 

name and press the Return key on your Mac keyboard to confirm the 

edit. The new name appears. If you press the Enter key instead of 

Return, the edit is confirmed and the next patch name is ready for 

editing. Similarly, you can move up and down between patch names 

with the up and down arrow keys. 

37 - EEE), Wavestation § 
FATCH HAME 

Zs eens 
Leaving the Pod 

| MIDI Piano 

Drag its handle 

Choose Sort by name from the mini-menu 

Choose Sort by number from the mini-menu 

Choose Set Numbering format from the mini-menu. For more infor- 

mation, see “Setting the numbering format for a patch list” on 

page 743. 

Choose Show ASCII String from the mini-menu. For more informa- 

tion, see “Creating a custom numbering format” on page 743. 

Same as above 

Same as above 

See “Using multiple patch lists & bank select messages” on page 747 

Click its current patch number 
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Setting the numbering 
format for a patch list 

Creating a custom 
numbering format 

Sending a patch list 
back to a configured 
device after editing it 

Using PatchList Manager 

Most MIDI devices number the sounds in a bank using one of several 

common conventions. For your convenience, PatchList Manager lets 

you choose the numbering scheme that most closely matches the 

instrument. To set the numbering format, choose Set Numbering 

format from the sound names window mini-menu or click in the 

Length column. Choose the appropriate options and click OK. 

@ You can always change the format, but you can’t 

change the number of patches in the list after it has 

been assigned to a device MIDI channel. If you need 

to do so, you have to temporarily de-assigned it, make 

the change, and then reassign it. 

Preset A 

4 Sortby Name 9 [-+——————pexg 

Sort by Murmber avered 
Patches : Digits : 

@ Zero-based @ One 

© One-based @ Two 

@ Roland © Three 

Number of patches: 

Divide into [0] banks 

Examples : 

11 Patch 1 

88 Patch 64 

t Set Nurmberine 

Set Bank SiMect... 

4 Set MIDI Message... 

4 tserh fhessseazer? Mack. 

Shaw Husk Deiecd 

dv Show Program Change 

iv Show ASCH String 

10: 23) GuitarPiano 
11 as HonkTonkPno 

12 : 2 : Clavinet 

Figure 48-6: Setting the numbering format 

If your device has a specialized numbering scheme, use the Show 

ASCII String command in the mini-menu instead. This displays a 

column in the patch list in which you can type any number or text 

string next to each patch. This gives you complete flexibility in setting 

up the patch numbers. Use the Show Program Change and Show 

ASCTI String commands to hide the program change column and 

display the ASCII numbers. 

If the patch list you are editing is one that you loaded from a 

configured device using the Get Patch Dump command, making 

changes in the patch list may also change the patch dump, depending 

on the device. Check the device’s Device Help (see “Getting device 

help” on page 733) to see what the patch dump actually contains Cit 

varies by instrument). If the patch dump only contains the patch 
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names , then you can only change the names of the sounds when you 

send it back to the instrument. If the patch dump is a complete bulk 

dump of the whole instrument, you may be able to control other 

aspects of the bank. Device Help will give you specific advice for 

your instrument. 

Duplicating a patch list At times, you may need to duplicate a patch list to make a separate 

copy of it. For example, you may want to place the list in more than 

one folder. To duplicate a patch list: 

1. Click the patch list move handle to select it. 

2. Choose Duplicate from the Patch Lists menu. 

Gri ouping patch A patch list folder allows you to group several patch lists together. 

" 7 You can then assign the folder to a MIDI channel, which makes all of 

lists ma folder the lists available to it. The resulting pop-up patch list for the MIDI 

channel is hierarchical and shows each patch list as shown below. 

“t FreeMIDI Devices 
PATCH LIST CURRENT PATCH COMMENT CH. 

> SoundCanvas : 
> OSR sw i 
b Proteus/'1 
vt) Jb-990 

y4 Channel 1 

i Channel 2 i 411 Killer Pad 451 12 String Guitar 

#7 Channel 3 ; JD-990 Folde 412 Pulse Pad A52 Clang Guitar 
2 
z 

IRONS |S eee ee AlZ Lovely Vox Pad ASS Stratomaster Pu 
f Channel 5 H JD-9930 Folder : Patch 85 Aid Tempest A54 That's Funk 

7 
O 

a keen s | UD-990 Folder: Patch 85 | 415 Deep Breath Pad © A5S5 Ghina Guitar 
fa Channel ? i JD-990 Folder! Patch 85 i i i 416 Pure Glass AS6 Reso Strat 
fi Channel 10 : 1 JD-990 Folder : Patch 85 417 Cherish AS? Big Country 

v Boe M1 : : : 418 GlassYoices 458 Velo-Crunch 
77 Channel 1 421 Ac. Piano 2 461 Fretless Bass 

A22 Ac. Piano Hybrid A62 Woody Bass 

423 Crystal Rhodes 2 463 Yelo-Switch Bass 

A424 E. Piano 1 464 Slap Bass 

425 E. Piano 2 465 Pick Bass 

426 Agogo Rhodes A466 Fingered Bass 

AZ? Seq E. Piano A467 Flubber Bass 

428 Whispery Piano 465 House Bass 

431 Pipe Organ 471 Rubber Bass 

Folders are ideal for handling devices that have multiple banks, and 

therefore multiple patch lists. For more information about multiple 

banks, see “Using multiple patch lists & bank select messages” on 

page 747. 

To group patch lists in a folder: 

1. Choose Add Folder from the Patch Lists window mini-menu. 

The folder appears at the bottom of the list. 
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2. Click its name to rename it. 

@ ‘Wavestation SF 2 128: 

* E—SQ-M i 128: 
# Drum Kits oe ad 
# Bank A : 100: ft 
# Bank G i 126; yf i 
* Roland JVSS0 Patch i 64} 
| General M4 i : 

3. Drag each list on top of the new folder by dragging the diamond list 

icon. 

Once inside the folder, the lists are indented to the right to 

indicate that they are inside the folder, just like the System 7 

Finder. Use the show triangle to show or hide the patch lists in the 

folder. You can put as many patch lists as you like in the folder. 

You can use this feature to help organize patches. 

mo Ps = Weed BRE Patch Lists 
TENGTH EANK USED COMMENT 

# K2000 Programs i199; inf i 
# Proteus /1 :-129 ; ‘ee 
# Proteus /2 i 128: 
# Roland JVS80 Perform : 16: 
# ‘Wavestation SR : 1263 
# ESQ-M : 128} Pf 
Sa Crurn Kits i. iy? i 
+ : : Roland JYSS0 Patch 64 

> (CO General MIDI Lists i 

4. Assign the folder to the device it is intended for. 

See “Getting patch lists to appear in Performer” on page 740 for 

information about how to do this. 

(Optional) If you want a particular bank in the folder to appear on 

only certain MIDI channels for the device, use the Set Channel 

Mask command in the patch list’s mini-menu. 

See the next section for more information. 
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Making a patch list 
appear on only certain 
MIDI channels 

746 

When you place multiple patch lists in a folder and then assign the 

folder to the entire device as described in “Getting patch lists to 

appear in Performer” on page 740, all of the patch lists in the folder 

will appear on all the device’s MIDI channels. In some cases, 

however, you may want to limit the channels on which a particular 

patch list appears. For example, if your MIDI instrument only plays 

drum kits on channel 10, you’d want the drum kit patch list to appear 

on channel 10 only, and you’d want all of the other patch lists to 

appear on channels 1-9 and 11-16. To do so, you can set the channel 

mask for each patch list in a folder. The channel mask lets you 

choose which channels the patch list will appear on. This can only be 

done on patch lists that currently reside inside a folder. 

To set the channel mask for a patch list: 

1. Open the patch list by double-clicking its diamond move handle in 

the Patch Lists window. 

2. Choose Set Channel Mask from the mini-menu. 

If this command is grayed out, the patch list is not in a folder yet. 

eal 
| Sort by Mare 

4) Sort by Number 

Set Numbering Format... 

4 Set Bank Select... 

Set MIDI Message... 

+ Set Channel task... 

4 Show Bank Select 

¥ Show Program Change 

Av Show ASCII String 

: : GM Kit 
i Jazz Kit 
Orch Kit 

i Power Kit 

3. Click the channels as necessary so that the channels on which you 

want the list to appear have a black dot. 

GM Drum Kits 

tn2 Sc: 6° 7-8 

9101112 131415 16 

Please choose the channels on which 

this bank can appear. The bank will 

not show up on any channels that 

are not checked above. 
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Using multiple 
patch lists & 
bank select 
messages 

Determining your 
device’s bank select 
implementation 

Which banks can be 
accessed via bank 
select? 

Does the device use one 
controller or two for the 
bank select message? 

Using PatchList Manager 

For devices that support MIDI bank select messages, set up a folder 

containing one patch list for each bank. (See the earlier sections of 

this chapter to learn how to do this.) 

Once you've arranged all the banks into a folder and assigned the 

folder to the MIDI channels for the device, all that is left to do is 

assign the appropriate bank select number to each patch list. 

Once you've set up a device in FreeMIDI for bank select, you need 

to find out is how your MIDI device handles bank selection. This can 

get a little tricky. All MIDI devices that support bank select do so a 

little differently. And often you'll have to wade through the MIDI 

implementation charts in the back of the manual. 

The following sections tell you what you should find out about your 

synth. 

The most important thing to know about a bank is: can it be called 

up with a bank select message and can items within the bank be 

called up with a MIDI program change event? 

Try to get a feel for what the banks are. Some banks are not actually 

sounds. Instead, they consist of internal configurations for the synth, 

such as multi-timbral setups dike Yamaha and Korg multis) or 

multiple layers of sounds (such as combis). Some banks represent a 

card slot and are therefore only available when a card is present. 

Banks can be designated as General MIDI, which means that they 

contain a standard set of sounds or drum kits. Some banks are drum 

kits only and may only be available on certain MIDI channels (usually 

channel 10). 

Some devices use a single MIDI controller, either #0 or #32. Others 

use both. 
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What is the controller MIDI controllers have a number that identifies them (such as #32), 

value for each bank? but they also have a value between 0 and 127. The controller number 
identifies the controller as a bank select message, and its value calls 

up a specific bank. Here’s an example: 

Bank: Controller used to call it up: 

Bank A Controller #32, value 0 

Bank B Controller #32, value 1 

Bank C Controller #32, value 2 

If your device uses both controller #0 and #32, be sure to obtain the 

value for both for each bank. 

The fun part about this is that often the device’s manual gives you this 

information in hexadecimal form. Don’t worry. PatchList Manager lets 

you use the hexadecimal numbers without even knowing what they 

are. 

Once you are armed with the information above, you are ready to 

proceed. 

Setting up bank select To use bank select messages with a MIDI device, you first need to tell 

devices in FreeMIDI FreeMIDI which MIDI controller the device uses for bank select: 

1. Open FreeMIDI Setup. 

If you are running Performer or PatchList Manager, choose Edit 

FreeMIDI Configuration from the Basics menu or MIDI menu, 

respectively. If are running neither, double-click the FreeMIDI 

Setup program in the FreeMIDI applications folder on your hard 

disk. 

2. Double-click the icon for a MIDI device that supports bank select. 

The Device Specification window appears. 
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Assigning a bank select 
number to a patch list 

Using PatchList Manager 

== FreeMIDI Device Specification 

Name: |eivaly Device ID: ee 

: (1-16) 
Controller 

Receives Clock 

Receives MITC 

Transmits Clock 

|| Transmits MTC 
MIDI Machine 

Cancel 

3. Choose the appropriate bank select device properties from the 

Properties pop-up menu. 

If the synth uses both controllers for bank select, choose both 

bank select properties. See “Determining your device’s bank select 

implementation” on page 747 if you need help with this step. 

Click OK to confirm your choice. 

Repeat this procedure for each device in your FreeMIDI setup that 

uses bank select. 

Now you are ready to assign the bank select controllers to each patch 

list: 

E Places all of the patch lists together in a folder. 

See “Grouping patch lists in a folder” on page 744. 

. Click in the Bank column to the right of the Patch List name. 

The Bank Select dialog box appears. 

Choose the necessary number format, and type in the correct bank 

select number or numbers. 

If the bank number information you got from the device’s manual 

is in hexadecimal format, you'll need to choose the Hexadecimal 

option. Otherwise, use decimal format. 

749 



Bank Select Format: 

No Bank Numbers & Decimal 

@ One Murnber Hexadecimal 

} Two Murmbers 

4. Click OK when you are done. 

5. Repeat this procedure for each bank. 

6. Assign the folder to the MIDI channels for the device. 

See “Getting patch lists to appear in Performer” on page 740. 

What to do if bank select Once bank select messages are assigned as described in the previous 

doesn’t work section, you can choose any patch from the pop-up patch lists in 

Performer, PatchList Manager, and FreeMIDI setup, and doing so 

should call up the correct sound from the correct bank. 

If it doesn’t, check to make sure that the device has been given the 

proper Bank Select device property in your FreeMIDI setup. To do 

so, choose Edit FreeMIDI Configuration from the MIDI menu. 

Next, check the synth. Sometimes they have a mode that makes them 

ignore bank select or program changes. Still no response? Then the 

controller information you have is probably incorrect, or perhaps the 

instrument still isn’t in the correct mode. Or the actual MIDI 

connections between FreeMIDI and the synth are somehow not 

working correctly. 

Assigning additional Some devices don’t use controller #0 or #32 for bank select and use 

MIDI messages toa bank | another type of MIDI message instead. For these devices, you can 
type in any MIDI message the device calls for. This includes system 

exclusive data, a MIDI program change event with certain value, or 

any other type of event. 
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Set MIDI Message... 

x 
x 
4, 
Fy : 

™ 415 Deep Breath Pad 
™ 416: Pure Glass 
| 417: Cherish 
™ A198: Glass¥oices 
™ 421: Ac. Piano 2 
® 422) Ac. Piano Hybrid 
% 423: Crystal Rhodes 2 
™% 424: E. Piano 1 
% 425: E. Piano 2 
™ 426: Agogo Rhodes 
5 : Seq E. Piano 
x ? Whispery Piano 

Saving your 
patch lists 

Using PatchList Manager 

Ba) ah, Kurzweil 1000P# 
Sort by Mame | Free e 

Sort by Nurmber a: 
Set Numbering Format... 

To assign a MIDI message to a patch list: 

1. Open the patch list by double-clicking its icon in the Patch Lists 

window. 

2. Choose Set MIDI Message from the mini-menu, or click in the 

“CM?” column in the Patch Lists window next to the patch list. 

Kurzweil 1000PX 

Please enter the MIDI message(s) to be sent whenever this 

patchlist is selected. Realtime bytes (FS - FF) cannot be 

used. Spaces and tabs will be ignored. 

co 65 

Format: 

@ Hexadecimal 

© Decimal 

Cet gt ge al ed 

3. Choose the desired number format (either decimal or hexadecimal) 

and type in the MIDI message. 

4. Click OK when you are done. 

Now, the MIDI message you entered will be automatically sent 

whenever necessary to call up the bank (such as at the beginning of 

a session or when you change banks). 

When you are done setting up your patch lists, you need to save your 

work: 

1. Choose Save from the File menu. 

2. Type in a name for the patch list file. 

3. Click Save. 

PatchList Manager then saves the entire contents of the FreeMIDI 

Devices and Patch Lists windows in a file on your hard disk. In 

addition, PatchList Manager tries its best to stay in sync with the 

FreeMIDI devices in your current FreeMIDI Configuration. Each 

PatchList Manager document is associated with a specific FreeMIDI 
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Hot tips 

Splitting up a patch list 
into instrument 
categories 

752 

Configuration. If you change FreeMIDI Configurations, PatchList 

Manager will close the current file and open the file associated with 

the new, current FreeMIDI Configuration. If you change back to a 

FreeMIDI Configuration, PatchList Manager will automatically use the 

corresponding PatchList Manager file. 

Here are some things you can do with PatchList Manager. 

PatchList Manager allows you to organize the sounds in an device 

into instrument categories as shown below in Figure 48-8. To do so, 

you will make one copy of the patch list for each category. In the list, 

you ll move the patches that you want to appear in the category to 

the top of the list, and then hide the rest. Finally, you’ll group the lists 

into a folder and give them an appropriate name for each category. 

PP ae ie ae a a ie eal i 4 F MIDI D 
Pie te te. pe a ai ie Se a hr a ree evices 

cH. PATCH LIST CURRENT FATCH COMMENT DEVICES “MODULES 
=) SoundCanvas | 

f4 Channel 1 : Piano 01 Piano 1 1: 

4 Channel 2 2 i Chromatic Percussion O02 Piano 2 
fa Channel 3 Si Organ 003 Piano 3 

fa Channel 4 4 i Guitar 004 Honky Tonk Piano 

ya Channel 5 Sj Bass 005 E. Piano 1 
ya Channel 6 6 i Strings ‘Orchestra 006 E. Piano 2 
ya Channel 7 Fi Ensernble OOF Harpsichord 
7 Channel 8 8: Brass 008 Clavinet 
fa Channel 9 i 9} Reed 
ga Channel 10: «10: Pipe 
ya Channel 11 oes Synth Lead 
ya Channel 12 Synth Pad 
fa Channel 13 Synth Fx 

Ethnic 

Percussive 

Sound FR 

Drurn Kits 

SFX rrryryryTyyY v¥ ¥, 

Figure 48-7: Patch lists that have been 
organized into instrument categories 

To split up a patch list into instrument categories: 

1. Duplicate the original patch list. 

For information on duplicating a patch list, see “Duplicating a 

patch list” on page 744. 

2. Rename the duplicate list with the category name, such as Pianos 

or Basses. 

Click the name of the patch list in the Patch Lists window to pop- 

edit the name. 
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Getting back the factory 
default patch Lists 
provided by FreeMIDI 

Using PatchList Manager 

3. Double-click the move handle of the list to open it. 

4. Drag the sounds that belong to that category to the top of the list. 

A short cut for this is to type in a space at the beginning of the 

name of each sound and then choose Sort by name from the mini- 

menu. When you are done, you can remove the spaces. 

5. Count the number of patches that are now at the top of the list that 

you want to include in the category. 

6. Choose Set Numbering Format from the patch list mini-menu and 

type in the number of patches you just counted. 

The list now displays only the patches you chose for the category. 

7. Repeat this procedure, starting at step 1, for each category you 

would like to create. 

8. After you have created a separate patch list for each category as 
described in this procedure, place them together in a folder. 

See “Grouping patch lists in a folder” on page 744. 

There may be times when, after assigning your own patch list (or 

folder) to a device, you want to return to the factory default patch 

lists that were originally provided for the device by FreeMIDI. To 

restore the factory default patch lists, choose None from the Patch List 

column next to the device name in the Devices window as shown 

below. 

Heh FreeMiDpl Devices 
CURRENT FATCH COMMEN 

fa Channel 14 : 14 | Morpheus banks: 
4 Channel 15 } 15 } Morpheus banks: 

fa Channel 16 : 16 : Morpheus banks: 

yg Channel 1: ; a7 

ya Channel2 § 4 Morpheus banks ane 
fi Channel 3 7 K2000 banks 

mo banks 

OSR Ww banks 

Figure 48-8: Restoring FreeMIDI's original 
factory default patch lists for a device 
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Duplicating MIDI 
channels in a device 

754 

In PatchList Manager, the MIDI channels listed below a device are 

called modules. Modules are added to Devices automatically by 

PatchList Manager. The number of modules added and their MIDI 

channel assignments are based on the number of MIDI receive 

channels specified for the device in FreeMIDI Setup. 

There is rarely a need to do so, but you can add, edit, and delete 

modules for a device. 

To add modules: 

1. In the FreeMIDI Devices window, select a device to which you wish 

to add a module. 

2. Choose Create Module from the mini-menu. 

The new module appears at\the bottom of the selected devices 

module list. 

3. [Optional] Assign a MIDI channel for the module by selecting it 

from the pop-up menu in the CH column. 

4. [Optional] Enter a name for the module by clicking its name and 

then typing. 

To delete a single module: 

1. In the FreeMIDI Devices window, select the module you wish to 

delete. 

Shift-click modules to select more than one. 

2. Choose Delete Module from the mini-menu. 

To delete all modules for a device: 

1. Select the device itself (not one of its modules). 

2. Choose Delete Module from the mini-menu. 
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Chapter 49 Editing FreeMIDI Device Files 

Working with 
FreeMIDI Icons 
Adding or Replacing 
Icons to FreeMIDI 

This chapter explains how to: 

a Edit the icons that FreeMIDI uses to display devices in the 

FreeMIDI Configuration window. 

m Add devices to the FreeMIDI Devices file so that MIDI 

devices that are in your studio but not already defined in 

the current version of FreeMIDI will appear in the 

manufacturer and model name pop-up menus in places 

such as the Quick Setup dialog box and the FreeMIDI 

Device Specification dialog box. 

You can add, delete, and edit icons that ship with FreeMIDI so that 

you can customize the look of your FreeMIDI configurations. 

To add icons to FreeMIDI’s icon list: 

1. Copy the icon you wish to add from your icon editor to the 

Clipboard, so that it will be ready to paste. 

When you create an icon, note that there are actually three sizes 

for the display in FreeMIDI: small, medium, and large. If you make 

an icon for each size, you’ll need to paste in the three icons one 

at a time using this procedure. 

2. If you have not done so already, open FreeMIDI Setup by double- 
clicking its icon in the Finder. Alternately, you can open FreeMIDI 

Setup by choosing the Edit FreeMIDI Configuration command in 

any other FreeMIDI application. 

The FreeMIDI Configuration window will open displaying the 

current FreeMIDI configuration. 
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3. Choose Create Device from the Configuration menu or type 

command-K on your Mac keyboard. 

The FreeMIDI Device Specification dialog box appears. 

FreeMIDI Device Specification 

Name: | [a ah terad| Device ID: a 

Manufacturer: Model: (1-16) 

Transmit Channels: 
i234 204 ee 678 a wen Tete 

Receive ee 
eeu 2. = sees 678 9101112 oa 

Properties: | Controller,... ——-¥_| [_Controller,... | 

Controller, Receives Clock, Transmits Clock 

Studio Location: Cable: 

MIDI Time Pieces, Mod... Ea. 

Figure 49-1: FreeMIDI Device Specification Dialog Box 
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Editing FreeMIDI Device Files 

4. Click Icons or type commancd-! on your Mac keyboard. 

The Device Icons dialog box appears. 

Device Icons 

Device Name: Proteus/? 

Figure 49-2: Icons Dialog Box 

. If you want to replace an existing icon, scroll to it now. 

. Click one of the three boxes shown to select the size of the icon 

that you are pasting. 

FreeMIDI has three possible sizes at which it can display the 

device icon. Each size is shown in the boxes. Click the box into 

which you want to paste. 

. Click Paste to paste the icon from the Clipboard into FreeMIDI’s 

icon set. 

If there is an icon currently selected, you are asked whether you 

want to replace the current icon or create a new icon. 

. If you want to add a new icon, choose the create option and the 

new icon options. 

The icon is added to FreeMIDI’s icon set and you can assign it to 

any FreeMIDI device. 
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Deleting FreeMIDI Icons 
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9. If you want to replace the existing icon, choose the replace option. 

The icon replaces the currently selected icon. For more 

information, see “Editing FreeMIDI Devices” on page 693. 

10. Click OK to close the Icons dialog box. 

The FreeMIDI Device Specification dialog box reappears. 

11. Click Cancel to close the FreeMIDI Device Specification dialog box. 

If you do not cancel the FreeMIDI Device Specification dialog 

box, you are adding a FreeMIDI device to your FreeMIDI 

configuration. 

To delete icons from FreeMIDI’s icon set: 

1. If you have not done so already, open FreeMIDI Setup by double- 

clicking its icon in the Finder. Alternately, you can open FreeMIDI 

setup by choosing the Edit FreeMIDI Configuration command in 

any other FreeMIDI application. 

The FreeMIDI Configuration Window opens displaying the current 

FreeMIDI configuration. 

2. Choose Create Device from the Configuration menu or type 

command-K on your Mac keyboard. 

The FreeMIDI Device Specification dialog box appears as shown 

in Figure 49-1 on page 756. 

3. Click Icons or type command-! on your Mac keyboard. 

The Icons dialog box appears as shown in Figure 49-1 on 

page 756. 

4. Use the horizontal scroll bar and arrows to scroll the FreeMIDI icon 

list until you see the icon you wish to delete in the center panel. 

Alternately, you can click icons to the left or right of the center 

panel and they will be scrolled to the center panel. 

5. Click Cut. 

Since this operation cannot be undone, you are asked to confirm 

this deletion. 
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Editing FreeMIDI Icons 

Editing FreeMIDI Device Files 

To 

Click OK to close the Icons dialog box. 

The FreeMIDI Device Specification dialog box reappears. 

Click Cancel to close the FreeMIDI Device Specification dialog box. 

If you do not cancel the FreeMIDI Device Specification dialog 

box, you are adding a FreeMIDI Device to your FreeMIDI 

Configuration. 

edit icons in FreeMIDI’s icon set: 

. If you have not done so already, open FreeMIDI Setup by double- 

clicking its icon in the Finder. Alternately, you can open FreeMIDI 

setup by choosing the Edit FreeMIDI Configuration command in 

any other FreeMIDI application. 

The FreeMIDI Configuration window opens displaying the current 

FreeMIDI configuration. 

Choose Create Device from the Configuration menu or type 

command-K on your Mac keyboard. 

The FreeMIDI Device Specification dialog box appears as shown 

in Figure 49-1 on page 7560. 

Click Icons or type commancd-!I on your Mac keyboard. 

The Icons dialog box appears as shown in Figure 49-1 on 

page 750. 

Use the horizontal scroll bar and arrows to scroll the FreeMIDI icon 

list until you see the icon you wish to edit in the center panel. 

Alternately, you can click icons to the left or right of the center 

panel and they will be scrolled to the center panel. 

Click Copy to copy the icon to the Clipboard. 

Click OK to close the Icons dialog box. 

Click Cancel to close the FreeMIDI Device Specification dialog box. 

Launch your icon editing program and paste the icon into your 

editing program. 
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Preserving Your Custom 
Icons 

Editing Text File 
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9. Make the icon look the way that you want and then copy it back to 

the Clipboard. 

10. Choose Create Device from the Configuration menu or type 

command-K on your Mac keyboard. 

The FreeMIDI Device Specification dialog box appears. 

11. Click Icons or type command-l on your Mac keyboard. 

The Icons dialog box appears. 

12. Click Paste to paste the icon from the Clipboard into FreeMIDI’s 

icon set. 

You are asked whether you want to replace the current icon or 

create a new icon. The new icon is added to FreeMIDI’s icon set 

and you can assign it to any FreeMIDI device. For more 

information, see “Editing FreeMIDI Devices” on page 693. 

13. Click OK to close the Icons dialog box. 

The FreeMIDI Device Specification dialog box reappears. 

14. Click Cancel to close the FreeMIDI Device Specification dialog box. 

If you do not cancel the FreeMIDI Device Specification dialog 

box, you are adding a FreeMIDI device to your FreeMIDI 

configuration. 

Icons are stored in a file called FreeMIDI Icons, which is located in 

the FreeMIDI Folder in the System Folder. If you create your own 

icons and paste them into FreeMIDI as described in this chapter, 

make a copy of the FreeMIDI Icons file as a backup copy so you 

don’t lose your work. 

Edit the text within the FreeMIDI Devices text file so that FreeMIDI 

can have more information about various MIDI devices than the 

information that was shipped with your version. 
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Editing FreeMIDI Device Files 

To edit the text in the FreeMIDI Devices file: 

1 Open your text editor application. 

You can use any text editor which can save files in a “text only” 

format. Even the TeachText application from Apple will work. 

. Open the FreeMIDI Devices file. 

This file is found within the FreeMIDI Folder that is located inside 

your System Folder. 

. Enter the information that you wish to add. 

The file contains a description of the data format. that is required 

by FreeMIDI. Enter the information about devices following this 

format. If you do not understand this format by reading these 

descriptions, we suggest that you have someone else do this type 

of editing for you. 

Save the file in the “text only” format. 

TeachText does this automatically. 

The next time you open FreeMIDI Setup your changes appear in the 

various pop-up menus. 
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AppendixA Synchronization Specifications 

MIDI Beat 
Clocks 

Technical Specification 

This appendix describes the synchronization formats supported by 

Performer. 

MIDI beat clocks (also called MIDI clock) are a standard form of 

synchronization which may be transmitted between two MIDI 

devices. Using MIDI beat clocks requires no synchronization code 

conversion box; the signals are simply carried on a MIDI cable along 

with other MIDI information. To synchronize MIDI beat clocks to 

other forms of sync code, such as FSK or SMPTE time code, you must 

use a converter which translates from the audio code to MIDI beat 

clocks. 

MIDI beat clock synchronization consists of five different MIDI 

messages: start, timing clock, stop, continue, and song position. These 

messages are transmitted from the MIDI Out of the master to the 

MIDI In of the slave. 

Start signals the slave to prepare to begin playback from the 

beginning of the sequence. Playback does not actually begin until a 

timing clock is received. 

Timing clocks are sent 24 times per quarter note. These keep the 

slave locked to the master. Because the signals are based on the 

quarter note, the master controls tempos. 

Stop signals the slave to stop playback. 

Continue resumes playback. If the last signal was a stop, the first 

timing clock following the continue message is the one which follows 

the last timing clock sent before the stop. Thus, it is as if the stop and 

continue messages never happened, and the timing clocks had just 

kept on going. However, if the last message was a song position, the 

first timing clock following the continue message is the timing clock 

specified by the song position message. 
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Implementation 
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Song position signals the slave to rewind to a specified position, and 

prepare to resume playback. The position is specified in multiples of 

6 timing clocks (sixteenth notes). The position value is only 14 bits 

long. In 4/4 time, this limits the range to 1024 measures. 

Some MIDI equipment only implements part of the MIDI clock 

synchronization specification. This can cause confusion when used 

with Performer, which implements the full specification. 

Timing clocks only. Some equipment only sends and receives timing 

clocks. When slaving such a device to Performer, you must rewind 

the device manually. Since there is no positioning control, Performer 

will begin at the current Counter location, and the device will begin 

playing wherever it is located. You must make sure the two positions 

match manually. 

When slaving Performer to this type of device, you must set the Start 

on any clock option in the Receive Sync dialog box. As above, you 

must make sure that both the device and Performer are positioned to 

the same location before starting the device. 

Start/stop (and timing clocks) only. The device can only begin 

playback from the beginning of its sequence. Performer will slave to 

such a device without problems. If you slave the device to Performer, 

it will only start playing if you start at the beginning of the Performer 

sequence. Note that some devices do not send a continue command 

via MIDI, even if they have an internal continue feature. 

Start/stop/continue (and timing clocks) only (no song position). 

Performer slaves properly to such a device. When slaving the device 

to Performer, you must be careful when rewinding Performer: 

If you stop Performer and then start again without rewinding, the 

master and the slave will remain in sync. 

If you stop Performer, cue in either direction, and start again, 

Performer will begin at the location you moved to but the slave 

device will begin where it had last stopped. No song position 

command is passed, and the two will no longer be in sync. 
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If you rewind to the beginning of the sequence and start Performer 

again, Performer will send a start command. The slave will respond 

to this and start correctly at the beginning of the sequence, and 

master and slave will remain in proper synchronization. 

Dir ect Time Lock Enhanced Direct Time Lock (DTLe) is a synchronization standard 

which allows Performer to easily lock to SMPTE or other time code 

(Enhanced) through a converter supporting this standard, such as Mark of the 

Unicorn’s MIDI Time Piece™. What follows is a detailed technical 

specification of the standard and its implementation in Performer. 

This specification is a revision of the original Direct Time Lock 

specification released in June, 1987. 

Technical Specification There are two messages associated with direct time lock: full frame 

and frame advance. The full frame message should be sent when the 

time code source (such as a tape machine) is started and the 

converter first achieves lock, followed by a full frame message once 

per second while the converter maintains lock. The message is 

implemented as a system exclusive message. The data specifies the 

full frame in hours, minutes, seconds, frames. 
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<fubil-frame> :== 

<FOH> <QOH> <33H> 

</FH> 

<OCH> 

<OnH> 

<OffhhhhhB> 

<mmH> 

<ssH> 

<ffH> 

<F/H> 

(Manufacturer’s ID) 

(Universal real time mes- 

sage) 

(DTL full frame message 

ID) 

(MTP network specifier) 

n = 0 specifies Box 1-8 

n = 8 specifies Box 9-16 

(ff specifies SMPTE time- 

code frame rate, and hhhhh 

specifies the hour from 0 to 

23.) 

ff = 00 specifies 24 fps 

ff = O1 specifies 25 fps 

ff = 10 specifies 30 drop 

ff =11 specifies 30 non-drop 

(Specifies minutes from 

0 to 59 

((Specifies seconds from 

0 to 59 

(Specifies frames from 

0 to 29 

(End of message) 

The full frame message is a starting reference for the frame advance 

messages; it need not be sent in synchronization with anything. A 

converter may wish to send the message a few frames before the 

specified frame is reached. 

The frame advance message is sent four times each frame. The first 

frame advance sent after a full frame message corresponds to the 

beginning of the frame specified in the full frame message. Successive 

frame advances correspond to successive frames. 

<frame advance> :== <F8H> 

Appendix A: Synchronization Specifications 



The frame advance message is the same as the standard MIDI clock 

message used in normal MIDI sync. This message is a real time 

message as defined by MIDI, and may be inserted in the middle of a 

normal MIDI message for minimum timing delay. 

While the tape is running, the converter should send a tape position 

message once per second. These messages should be sent between 

frame advances. As with the initial full frame message, the frame 

advance following the full frame message corresponds to the 

beginning of the frame specified in the full frame message. 

Sending periodic full frame messages allows slave devices to come 

on line at any time and sync up to the master. Periodic full frame 

messages also ensure that any slippage due to data loss over the MIDI 

line is corrected. 

Performer’s Direct Time If Direct lock mode and Slave to External Sync are selected and the 

Lock Implementation Play button is grey, Performer waits for a full frame message. When 

one is received, the sequence is rewound to that point and playback 

is readied. When frame advances are received, Performer advances in 

sync with the frame messages, playing the sequence. This continues 

until one of two things happens. 

If more than 8 frames of time pass without a frame advance message, 

Performer assumes playback has been stopped. The sequence is 

stopped (notes are turned off), and Performer begins looking for a 

full frame message again. 

When another full frame message is received, Performer compares 

the position in the message to the current playback position. If they 

are the same, Performer does nothing. Otherwise, Performer makes 

whatever adjustment is needed. If the full frame message is not close 

to the current location, Performer immediately stops playback and 

rewinds to the new location. Playback is then readied at the new 

location, and frame advances are looked for. 

If you are designing a converter, you should be aware of the 

automatic time out. If your converter has the capability to sync to 

slow tape motions (tape rocking), it should send full frame messages 

only without frame advances when doing so. It is also not 

recommended that you send frame advances at high speed when the 
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tape is cueing rapidly. It’s better to stop sending frame advances, and 

then send a new full frame command when the tape returns to 

normal playback speed. 

If the tape is being rewound, the converter should stop sending 

messages and wait until the tape is moved forward again. At that 

point the first full frame message should be sent. 
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AppendixB Troubleshooting and Customer 
Support 

Preventing 
Catastrophe 

Write-protected (Hole is open) 

Troubleshooting 

Keep up-to-date backups of your sequences as you work, so that you 

always have copies of the most recent work you have done. Almost 

any software problem is survivable as long as you have kept backups 

of your work. Refer to Helpful File and Disk Hints in the chapter 

Working With Files for detailed suggestions about file management. 

Keep plenty of free space (20K or more) on any disk containing 

sequences which you are actually working on. This will prevent the 

Macintosh from attempting to save your file onto a disk that doesn’t 

have enough space for the whole file. Running out of disk space 

while saving can result in an unreadable and irretrievable sequence. 

Keep track of your RAM (Random Access Memory) usage with the 

Memory Window, and save often. Recording and editing both use a 

great deal of RAM. Also watch the Message Center — it will 

sometimes warn you that a recording pass or a requested edit 

operation requires more memory than is available. In this situation, 

try recording or editing the region in smaller sections; for example, 

transpose a 20-track, 200-measure sequence 5 tracks at a time. 

Keep your Mark of the Unicorn master disks locked (write-protected) 

at all times by sliding the tab on the back of the disk open so that 

light can be seen through the rectangular aperture. We recommend 

that you use the master disks only as resources from which you can 

make working copies, and as key disks with which to start the 

program when you begin a session. Should your copies become 

damaged, you will always be able to go back to the master disk for 

fresh working copies. 

Troubleshooting is always simplest and most effective when the exact 

problem can be specified clearly and concisely. If you are surprised 

by an error message or by seemingly erratic behavior in the program, 

take a moment to jot down the relevant details: exactly what the error 

message said (including any error ID numbers), what actions were 

done on-screen just before the problem occurred, what kind of file 

you were working with, how you recovered from the problem, and 
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any unusual conditions applying during the occurrence of the 

problem. This may not enable you to solve the problem at once, but 

will greatly aid in isolating the problem should it reoccur. 

If the problem you are encountering seems inconsistent, try to 

determine what the necessary pattern of actions are that will cause it 

to occur. Genuine bugs in application software like Performer are 

almost always consistent in their manifestation: the same set of 

actions under the same conditions invariably brings about the same 

results. Determining the exact cause of a bug often requires 

experiments which replicate the problem situation with one factor 

changed: starting the program from a different disk drive, restarting 

the Macintosh with a system folder containing different versions of 

the System File and the Finder, working with a new sequence instead 

of an existing one, etc. 

If the problem is truly inconsistent, then it is likely to be a hardware 

problem: improper disk drive alignment, a loose connection, 

overlong cables, signal ‘aliasing’, etc. For example, if you play a 

sequence several times consecutively from 1111000 without making 

any changes to it, and on one pass you hear a wrong note at 

3111043, and on another pass you hear a different wrong note at 

6121332, and the other times it plays back without any errors, the 

problem is almost certainly external to Performer. At this point you 

will want to experiment with changes in your hardware configuration 

(where possible) to attempt to isolate the source of the problem. 

The most important tools for tracking down problems are the MIDI 

Monitor window and the Event List windows. The MIDI Monitor 

window indicates the type and channel assignments of all MIDI data 

being sent to Performer. If there is a hardware problem, or if your 

channel assignments are wrong, the problem should be apparent in 

the MIDI Monitor window. 

On the other hand, the Event List windows show all the MIDI data 

being sent from Performer. If you’re hearing something unusual in 

your sequence, the first thing to do is to bring up the Event List 

windows for the tracks in question. Go to the points in the track at 

which you are hearing the discrepancy and look for events that may 

correspond to what you are hearing. Use the View Filter if necessary 

to clearly isolate the events you are interested in. If the problem is 

visible in the event list, you can erase or edit the events in question. 

770 Appendix B: Troubleshooting and Customer Support 



If an audible problem does not correspond to anything in the event 

list, its cause is likely to be something external to Performer: the 

Macintosh, interface, cables, instruments, or other equipment. 

If the Counter, Click, or Flash move irregularly, or if playback is erratic or 

seems to stall and skip: the problem may be a “MIDI logjam”, in which 

the Macintosh is asked to process too much MIDI information too 

quickly. This is not a serious problem if the actual playback timing is 

not affected; Performer gives priority to sending and receiving MIDI 

data over most screen redisplay. However, with enough of an 

overload you may hear delays or erratic timing in your music. 

Usually the overload is caused by vast reams of aftertouch (mono or 

poly key pressure), controller, or pitch bend events in one or more 

synthesizer tracks. Open Event List windows for the tracks in 

question and look for large amounts of data of this type. 

To solve the problem, you must reduce the amount of MIDI 

information being passed through the modem and/or printer port in 

the following ways: 

mg Slow down the tempo of the sequence during the problem 

passages. 

m Delete a track or tracks from the sequence. 

a Turn off the play-enable buttons for one or more tracks. 

When you do this, Performer completely ignores these 

tracks, letting it concentrate all of the computer’s 

processing power on playing one part. Do not use the Solo 

button instead; if you do, Performer will scan the other 

parts while playing and the problem will remain. 

= Use the Edit Filter and the Cut or Erase commands to 

remove some data from one or more of the tracks. See the 

Edit Commands chapter for help with this. Remember to 

set the Edit Filter back to its default setting before going on 

with your work. 

m Use the Thin Continuous Data command to reduce the 

amount of continuous data in one or more tracks. This 
command preserves the original contour and basic effect 

of the controllers you are editing, while thinning out 

unnecessary information. 
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m Reassign some of the tracks to be output through the other 

serial port. There is a limit on the amount of information 
which can be passed through each port individually; 

balancing your output through both ports can eliminate 

the overload. 

If Performer starts correctly, but you are unable to record (or play) 

anything: double-check your cable connections and synthesizer 

settings. Check the MIDI interface dialog box, and be sure you have 

chosen to receive data at the correct frequency through the correct 

serial port Gnodem and/or printer) on the back of the Macintosh. 

Often only A/B tests will reveal the source of the problem. It may be 

necessary to switch your MIDI cables, and if possible, to try using a 

different MIDI interface or synthesizer for input/output. The easiest 

way to test if MIDI data is actually getting to Performer is to open the 

MIDI Monitor window. Make sure that any recording channel 

assignments in the Tracks window and Input Filter correspond to the 

MIDI channels set in the controlling keyboard or device. 

If you cannot open a particular file: first try opening other existing files, 

or a new file, to be sure Performer is working at all. Refer also to the 

list of disk and file errors in the chapter Working with Files. If a file is 

opened and seems damaged, will not let you save changes, etc., you 

still may be able to save some or all of its musical information by 

using the Clipboard to copy the tracks and paste them into another 

file on another disk. 

If Performer will not start up at all, or always brings up an irregular or 

damaged file when the Performer icon is opened from the Finder, 

your working copy may be damaged. Make a fresh working copy 

from one of your master disks. To be thorough, make this new 

working copy by dragging the Performer program icon from another 

master disk (i.e. not from the key disk from which the original 

working copy was made). Restart the Macintosh and try opening 

another (new or existing) file with your new working copy to see if 

you have the same problem. Check also to see if other applications 

(Professional Composer, MacWrite, MacPaint, etc.) are working 

properly. 

If one of your key disks becomes damaged and fails to work as a key, our 

Customer Support Department will be glad to replace it. See the 

Customer Support section below for more information. 
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If you’re having problems synchronizing Performer with other equipment: 

refer carefully to the chapter called Receive Sync and the section 

called Variations in MIDI Implementation in Appendix A. Remember 

that Performer inputs and outputs only MIDI, and that the MIDI beat 

clock specification consists of only five different types of messages. 

Try to deduce exactly which signal(s) are not being sent or are being 

misinterpreted by which piece(s) of equipment. The MIDI Monitor 

window is helpful in determining if timing information is being sent: 

the RT (real time) indicator will highlight for the port(s) receiving 

beat clocks or other timing data. 

Disk Repair. S We are glad to replace damaged disks belonging to registered users. 

Please contact Mark of the Unicorn Technical support by phone, fax, 

or letter if your disk needs to be repaired or replaced. Our Technical 

support phone number is: (617) 576-3066. Fax: (617) 576-3609. 

Customer We are happy to provide customer support to our registered users. If 

Support you haven’t already done so, please take a moment to complete the 

registration card in the front of the manual and send it in to us. When 

we receive your card, you'll be placed on our mailing list and sent a 

free backup key disk. 

Registered users who are unable, with their dealer’s help, to solve 

problems they are encountering with Performer may call our 

technical support line. The number is (617) 576-3066, and is staffed 

Monday through Friday 9 AM to 8 PM, Eastern Time. If you decide to 

call, please have your Performer manual at hand, and be prepared to 

provide the following information to help us solve your problem as 

quickly as possible: 

= The serial number of the program. This is printed on the 

cardboard page (at the front of the manual) which holds 

the registration card. Be sure to retain this page in the 

manual for your reference. You must be able to supply this 

number to receive technical support. 

= The version of Performer you are working with. This is 

displayed briefly in the start-up screen when Performer is 

started; it is also available through the About Performer 

command on the Apple menu from within Performer. 
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= A brief explanation of the problem, including the exact 

sequence of actions which cause it, and the contents of 

any error messages which appear on the screen. It is often 

very helpful to have brief written notes to refer to. 

= The pages in the manual which refer to the parts of the 

program which you are having trouble with. 

a The version or creation date of the system software you are using 

to run the Macintosh. See the Installation Guide for help in 

finding version numbers for the system software. 

We're not able to solve every problem immediately, but a quick call 

to us may yield a suggestion for a problem which you might 

otherwise spend hours trying to track down. 

Our technical support telephone line is dedicated to helping 

registered users solve their problems quickly. In the past, many 

people have also taken the time to write to us with their comments, 

criticism and suggestions for improved versions of our software. We 

thank them; many of those ideas have been addressed in this version 

of Performer. If you have features or ideas you would like to see 

implemented in our music software, we’d like to hear from you. 

Please write to the Performer Development Team, Mark of the 

Unicorn Inc., 1280 Massachusetts Avenue, Cambridge, MA 02138. 

Although we do not announce release dates and features of new 

versions of our software in advance, we will notify all registered users 

immediately by mail as soon as new releases become available. If you 

move from the address indicated on your registration card, please 

send us a note with your change of address so that we can keep you 

informed of future upgrades and releases. 
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a 
About FreeMIDI Setup command 719 
About Help 29 
About Performer 

Version number 773 
About this Manual 25 
Accelerando 567-568, 611 
Active sensing 242 
Activity Meters 173 
ADAT™ 629 
Add 

Chunks window 206, 208 
Defaults 99, 104 
Markers window 246, 248 
Master 99, 103 
Tracks window 179 

Add Sequence 206, 208 
Add Song 206, 208, 221 
Adding measures 401-402, 561-562 
Adjust durations 554, 558-559 
Akai DR4d™ 629 
Alesis ADAT™ 629 
Always click option 235 
Anchoring tempos 564, 569-570 
Apple Menu 

About FreeMIDI Setup command 719 
Apple menu 237, 719 
Articulation 440-441 
Assign Target 515-516 
Attack times 

Shift 406-407 
Audible button in Step Record 140, 150 
Audible Mode 

Event List window 258, 276-278 
Graphic Editing window 314 
speaker icon 258, 276-277, 277-278, 278 
System Exclusive 278 

Audition Channels command 707, 724 
Auto button 84-85 
Auto Channelize 122 
Auto Config button 684 
Auto Record Advance option 636 
Auto Rewind button 68 
Auto/Manual end time 79, 206, 214-215, 231 
Auto-locating 39 
Automatic tempo mode 563 
Automatic timeout 767 
Auto-Record 65, 69, 76-77, 81-83, 136, 182 

Bar 65, 69, 76-77, 81, 82 
Button 65, 69, 76-77, 81-83 

Index 

Tap Tempo 617 
Auto-Rewind button 66, 68, 71, 81-82 
Auto-Scroll 117-120, 262, 344 

Tracks window 185-186 
Auto-Step button 140, 149 
Auto-Stop button 66, 71, 81-82 
Auxiliary Counters 161 
Auxiliary Time rulers 283, 293-295 

B 
Backstep button 140, 149, 152 
Backup copies of files 50, 769 
Backup Master disk 769 
Backup master disk 19 
Bank select 268 
Basics menu 

Click 233 
value 233, 554, 557, 581 

volume 233, 236, 237 

Click & Countoff Options 234 
Click & Countoff options 237 
Edit FreeMIDI Configuration command 679 
Flash 238 
FreeMIDI Sync 679 
Input Filter 134 

Patch Thru 124, 124 

System Exclusive 376 
Interface Settings 679 
MIDI interface 

echo options with Patch Thru 124 

Patch Thru 125 

Panic 679 
Patch Thru 121-125 
Receive Sync 601-622 
Remember Times 82, 83, 182, 250-251, 

275-276, 389-390 
Slave to External Sync 605, 608, 610, 614, 616, 

619, 767 
Step Record 134, 139-159 
System Reset 242 
Transmit Sync 625-627 

Beat button 140, 152 
Beat clocks 242, 601-602, 603-606, 763 

converted from SMPTE 603, 763 
implementation 763-765 
start/stop clocks 601-602, 604, 627, 763 
timing clocks only 764 
transmitting 625-627 
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Beat division (in Groove Quantize) 495 
Beat value 86 

Counter window 94 
meters 554 
tempo 564, 568-569 

Beats per minute 86 
Beep 

Macintosh 237 
bpm 84 
Byte 375 

C 
Cablization 646 
Capture start time 658, 663 
Chaining 

Chunks 66, 78-81, 217-231 
sequences and songs 66, 78-81, 217-231 

Change Continuous Data 458-460 
Change Duration 436-441 
Change Key 547-551, 580-581 

custom key signatures 549 
Step Record 142 

Change menu 
Change Key 547-551, 580-581 
Change Meter 553-562, 581-582 
Change Tempo 563-577, 582-584 
Clear Loops 203 
Set Loop 200-201 

Graphic Editing window 300 

Change Meter 553-562, 581-582, 596 
Adjust durations 554, 558-559 
denominator 554 
meter maps 555, 589 
numerator 554 
Only move barlines 554, 559 
partial measures 589 
Realign music automatically 554, 557-558 
Step Record 142 

Change Tempo 563-577, 582-584 
Anchor indicators 564, 569-570 
beat value 564, 568-569 
Compute 565, 576 
curves 570-573 
density 565, 569 
mid-beat 573 
Options 5065, 576 

Change Velocity 430-436 
limiting velocities 432 
Step Record 158 
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Channels 166, 168 
activity 242 
playback 110-111, 129, 166, 168, 174 
recording 121, 132-134, 134 
Tap tempo 612-613 

Character generators 649 
Check Connections command 712, 723 
Chords 278 

Inserting 310, 342 
Chunk 

Control Buttons 66, 78-81 
Controls 66, 78-81 
loading 46-49, 209 
merging to sequence 47, 220, 229 
naming 206, 213 
overview 22-23 
play-enabling 66, 78-81, 205, 211-212 
size in Song window 218 
skipping 78-79, 81 
synchronization 229-230 

Chunk select 107-108 
Chunks window 205-216 

Add 208 
adding sequences & songs 206 
Auto/Manual end time 79, 206, 214-215, 231 
comments 206, 213-214, 384 
copying 209 

Tracks between Sequences 216 
current playback Chunk 205, 211-212 
Delete: 207, 211 
Duplicate Track Layout 206, 208 
End time 206, 211, 214-215 
loading Chunks 209 
loading Chunks into 46-49 
mini-menu 206-207 
naming 206, 213 
Open Chunks 206, 212 
opening 207 
play-enabling 66, 78-81, 205, 211-212 
printing 666 
rearranging Chunks 213 
selecting 208 
Set Chunk Start 207 
song select message 205-206, 212 
type icon 205, 213, 215 

Clean Up Window command 699 
Clear all devices command 243 
Clear command 721 
Clear default patch 168 
Clear Keyboard button 445 
Clear Loops 203 
Click 233-237 
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accented 233, 235 
value 233, 554, 557, 581 

Tap Tempo 612 
volume 233, 236, 237 

Click & Countoff Options 
Accented click 235 
gate 235 
pitch 235 
velocity 235 

Click-to-MIDI converter 661 
Clipboard 397, 402 

Show/Hide Clipboard 402 
Close 44, 57 
Close box 32 
Close command 719 
Closed-loop (MIDI Machine Control) 631 
Co light 651 
Color 31 
Columns 218, 219, 220-221 
Columns setup 167 
Comments 

Chunks window 206, 213-214, 384 
Conductor Track 579 
Tracks Window 165, 176, 384 

Compute 565, 576 
Conductor Crawl Line 649 
Conductor crawl line 654-656 
Conductor Track 165, 183, 579-589 

Copy Conductor Tracks 219, 230 
Delete Markers 219, 229 
Edit commands 584-585 
Edit Conductor Track 219 
Edit Filter 560-561, 585-588 
Graphic Editing window 332-334 
key changes 580-581 
looping 589 
Markers 584 
meter changes 581-582 

partial measures 588-589 

meter maps 555, 589 
Record-enable Conductor 219, 226-228 
recording 614-615 
tempo changes 582-584 
tempo maps 226-228, 563, 566-567 
View Filter 585-588 

Configuration menu 

Edit Device command 722 

Create Device command 722 
Quick Setup command 684, 722 
Update Interfaces command 722 

Index 

Consoles 168, 183-184, 505-545 
loading from another file 544 
opening 66 

Consolidated Controls Panel 63-66 
Consolidated Controls window 

Auto-Record 65 
Auto-Record Bar 65 
Auto-Rewind 66 
Auto-Stop button 66 
Chunk Control Buttons 66 
countoff 65 
Current Beat 64 
Current Meter 64 
Current Tempo 64 
Events List window button 65 
Graphic Editing button 65 
Main Counter Display 64 
Memory Bar 66 
Memory-shuttle 66 
Notation Editing button 65 
Set Loop button 65 
Tempo Slider 63 
Tempo Slider Remote Control 64 
Tracks Window button 65 
Wait button 65 

Constrain to scale 478-480 
Continuous data 451-453 

Change Continuous Data 458-460 
Create Continuous Data 455-457 
icons 316, 328-329 
Reassign Continuous Data 460-461 
Remapping in real time w/sliders 543 
Ruler 317-318 
scaling 326-327 
Thin Continuous Data 453-455 

Control Panel 237 
Controller chasing 116-117 
Controls window 20, 63, 64 

Auto-Record 69, 76-77, 81-83, 182 
Auto-Rewind 71, 81-82 
Auto-Stop button 71, 81-82 
Chunk Control Buttons 78-81 
countoff 74-75 
keypad controls 83 
Memory Bar 71-72, 81-82 
Memory-shuttle 71-72, 81-82 
Message Center 212 
Overdub 69-70 
Pause button 68 
Play button 67 
Position bar 67, 70-71 
Position bar arrows 67, 70-71 
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Record button 69-70, 76-77 
Remote Controls for 83, 97, 99, 101 
Rewind button 68 
Set Countoff 74-75 
Stop button 68, 69 

Convert SMPTE window 651 
Converters 601-602, 618, 765-768 
Copy 398 

Chunks in the Song window 223 
Tracks between Sequences 216 

Copy all tracks option 220 
Copy command 695, 721 
Copy Conductor Tracks 219, 230 
Counter 88-95 

display 90 
formats 88-89 
screen update 94-95 

Counter window 64-162 
auxiliary 161, 162 
editing 39 
frame time 38, 90-92 
Looping 197-198 
measure time 38, 90-92 
real time 38, 90-92 
Set Chunk Start 90-92 
Set Display 161-162 

Countoff 74-75 
beats 663 
While slaved to tape 622 

Countoff button 65 
Countoff n measures 235 
Countoff only when recording 235 
Crawl line option 656 
Create Chunk 167 
Create Chunks 

Tracks window 190-191 
Create Console 507-509 

Tracks window 168, 183-184 
Create Continuous Data 455-457 
Create Device command 691, 722 
Create Groove command 497 
Crescendos 430, 436 
Cubase 

grooves 503 
Cue sheet 245, 255 
Cueing 67, 70-71 

Chunks 66, 78-81, 97, 107-108, 211-212 

sequences 66, 78-81, 97, 107-108, 211-212 
songs 66, 78-81, 97, 107-108, 211-212 

using the counter 89-90 
Current Configuration 683, 685 
Curvature 433-435, 571-573 
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editing in Graphic Editing window 323-327 
Curves 

Change Tempo 570-573 
Change Velocity 433-435 
Create Continuous data 455 
Graphic Editing window 323-327 

Custom consoles 505-545 
Custom Maps list 472 
Custom Scale button 484-485 
Custom transpose map 480-482 
Customer support 19, 773 
Customizing 

key signatures 549 
New file 55-57 
Remote Controls 100-104, 105 

Cut 225 
Cut command 695, 721 
Cycle-recording 130 
Cycle-recording (Memory-cycle) 71 

D 
Data sub-option 209 
Decrescendos 430, 436 
Default patch 165, 176 
DeFlam 418, 428-430 
Delete 

Chunks window 207, 211 
Markers 219, 229, 251 
Markers window 246 
Remote Controls window 99, 103-104 
Tracks window 168, 180 

Denominator 554 
Density Threshold 167, 185, 189 
Desktop 47-49 
Device 

group 110, 112 
Patch 165, 175 

Device column 111 
Device Icons window 757 
Device properties 716 
Dialog boxes 35 
Diatonic transposition 476-477 
Diminuendo 430, 436 
Direct Echo 122 
Direct Time Lock 646, 647-648 

view with MIDI Monitor 651 
Direct time lock 242, 602, 609-611, 765-768 
Disks 

damaged master disk 773 

Index 



errors 59-60 
keeping enough free space 769 
key disk 19 
locking 769 
master disk 19 
saving files to 49-55 

Display Resolution 336, 338-339, 349-350 
DNA™ grooves 502 
Dot boxes 139, 145 
DR4d™ (Akai) 629 
Drop frame 

29.97 607, 610 
Dropouts 649, 659-660 
Drum machine 

loop recording as 204 
Patch Thru 124 
short note durations 440 
transposing 483-484 

DTL and DTLe 611 
Duplicate 99 

Track Layout 206, 208 
Duplicate command 695, 721 
Duplicate track layout (Tracks window) 166 
Duration 260, 267, 305, 313 

adjusting short durations 440 
Change Duration 436-441 
changing individual note 274-275 
drum machines 440 
editing 

Notation Editing window 343-344 

Scale Time 465-466 
Step Record 140 

= 
Echo 

creating echo effect 405-406 
Song window 228 

MIDI echo 121-125 
synchronization 124, 625-626 

Edit Bar 164, 181-182, 250-251 
Edit commands 388-390 
looping 200, 203 

Edit command in Tracks window 167 
Edit commands 

Clipboard 397, 402 
Edit Conductor Track 219 

Event List window 272, 391 
Graphic Editing window 300, 301 
Markers 251 

Index 

selecting region 300, 311-312, 387-394 
Song window 218, 223-224, 395 

Edit Conductor Track 219 
Edit Device command 693, 722 
Edit Filter 395-397, 404, 771 

Conductor Track 585-588 
Markers 255 
meter changes 560-561 
MIDI controllers 397 

Edit FreeMIDI Configuration 679 
Edit FreeMIDI Configuration command 115, 687 
Edit menu 395-407 

Copy 223, 398 
Copy command 721 
Cue225, 598 
Cut command 721 
Duplicate command 721 
Erase 399 
Merge 400 
Paste 399, 402-404 
Paste command 721 
Repeat 399-400 

Conductor track 589 

Event List window 272 

Graphic Editing window 300 

versus looping 197, 406 
Select All 402 
Select All command 721 
Shift 401-402 

attack times 406-407 

Show/Hide Clipboard 402 
Snip 401 

Graphic Editing window 300 

Song window 218, 223-224, 395 
Splice 401 
Undo command 721 
Undo/Redo 397-398 

Edit resolution box 282, 292-293, 300 
Editing 

Chunks 207-209, 209-211, 213-215, 216 
Counter 39, 64 
during playback 40-41, 60, 67, 115-116, 395, 

409, 451 
Edit Conductor Track 219 
Key change events 580-581 
Markers 248-249, 251, 252, 584 
Meter change events 581-582 
MIDI events 272-275, 391-392 
selecting 366 
System Exclusive 269, 274, 377-381 
Tempo events 583-584 
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tracks 181-183, 187, 216, 387, 402-404 
Eject command 637 
Emphasis 470 

Humanize 427 
quantizing 418 
tempos 575 
velocities 435 

End time 220 
Auto/Manual 79, 214-215, 231 
Chunks window 206, 211, 214-215 

Enhanced Direct Time Lock 646, 647-648, 765-768 
Erase 399 

Song window 224 
Error messages 59-60, 769, 772 
Errors 

disk 59-60, 769, 772, 773 
file 59-60, 770, 772 
fonts 371 
system 769, 774 

Escape key 101 
Event 

Chasing 116-117 
Editing windows 181, 257 
information box 282, 291-292 

Event List window 21, 257-280 
Audible Mode 258, 276-278 
Conductor track 271, 579 
editing 272-275, 391-392 
Goto 259, 265-266 
Goto Counter 259, 265 
Graphic Editing window 266, 281, 288 
Insert 272-274 
key changes 271 
Legend 259, 266 
loops 201-203, 271 
Markers 251, 271 
meters 271 
mini-menu 259 
note events 267 
opening from Tracks Window 181 
patch change 267-268 
printing 666 
RelInsert 259, 266 
selecting a region 263, 272, 391 
System Exclusive 269, 380-381 
tempo changes 271 
View Filter 259, 263-265 

Events 
Event List window 257, 267-271 
Graphic Editing window 281 
Tap Tempo 612-613, 614 

Events List window button 65 
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Extend releases to closest attack 439-440 
External sync 

Tap Tempo 661-664 
External time code option 663 
Extracting parts 446-447 

F 

Fast mode 645 
Fast-forwarding 70-71 
Fewer Choices button 494 
File 

Help 27-29 
icon 43 

File menu 
Close 44, 57 
Close command 719 
FreeMIDI Preferences command 683 
Load 46-49, 104-105, 209 
New 44, 56-57 
New command 719 
Open 44-45 
Open command 719 
Preferences 58, 680 
Quit 57 
Quit command 720 
Revert command 720 
Revert to Saved 55 
Save 49-50 
Save As 50-54 
Save As ‘New’ Template 55-57 
Save As Composer 54-55, 229 
Save command 719 

Files 43-60 
errors 59-60, 770, 772 
loading 

Chunks 46-49, 209 

Remote Controls 104-105 
opening existing file 44-45 
opening MIDI files 45 
opening new file 43 
opening Performer files 45 
opening Performer Version 1 files 45 
opening Professional Composer files 45 
Revert to Saved 55 
Save As 50-54 
Save As ‘New’ Template 55-57 
Save As Composer 54-55, 229 
Save As MIDI File 51-54 
Save As Performer 2.41 54 



saving files 49-55 
saving sequences 49-55 

Film/video 25 
hit points 245, 251, 253-254, 255 
Markers 245-256 
partial measures 588-589 
Song window 229-230 
synchronization 229-230, 252-254, 602, 

606-611, 618-621 
tempo maps 229-230, 566-567 

Filters 
Edit Filter 560-561 

Conductor Track 585-588 

Markers 255 

meter changes 560-561 
MIDI controllers 397 

Input Filter 134 
Patch Thru 124 

System Exclusive 376 

Quick-Filter 292, 316, 319, 320, 328 
View Filter 259, 263-265, 287, 301, 307, 

316-317 
Conductor Track 585-588 

Flash 238 
Fonts 

installing in text menu 371 
Frame advance messages 766-767 
Frame advancing 652-653 
Frame click metronome values 87, 569 
Frame time 38-39, 90-92 
FreeMID 

Devices 
duplicating 695 

FreeMIDI 
Configuration file 703, 705 
Configuration Window 688 
Configuration window 686, 687, 698 
current configuration 683 
Devices 

connecting 696 
editing 693 
naming 694 
removing 692 
selecting 694 

Devices file 760 
Edit FreeMIDI Configuration command 679 
FreeMIDI Sync command 679 
how it provides playback devices 114 
playback devices 110, 174 

Index 

Preferences 683 
Remote control devices 99 
seek points 246 

FreeMIDI Setup 
Device properties 631 

FreeMIDI Sync 711 
Freewheeling 659 
Freeze-frame 653 
FSK 22, 602, 603-606 

standard MIDI beat clocks 602, 603-606 
Full frame message 765-767 

G 
Gate 

Click & Countoff Options 235 
Generate VTP Streamers option 246 
Goto 

Event List window 259, 265-266 
Graphic Editing window 288 
Tracks window 167 

Goto Counter 
Event List window 259, 265 
Graphic Editing window 287 
Tracks window 167 

Grand staff 
bracket 354 

Graphic Editing window 281-334 
Audible Mode 314 
Auxiliary Time rulers 283, 288, 293-295 
Conductor Track 332-334 
Continuous data 

grid 315-329 
icons 316, 328-329 

Ruler 315, 317-318 

editing 298-301 
Event List window 288 
example of 591 
Goto 288 
Goto Counter 287 
Information bar 282, 289-293 

Edit resolution box 283, 292-293 

Event information box 283, 291-292 

Pointer coordinates box 282, 290-291 

Insert button 282, 289 
Legend 288 
Loops 303 
Main ruler selector 283, 295 
Marker strip 283, 302-304 

781 



Median strip 284, 329-331 
Conductor Track 332-333 

Move handles 305, 330 

MIDI Edit 288, 309-310, 313, 322 
mini-menu 287-289 
note events 284, 305-307, 308-314 
Note grid 283, 304-314 
opening from Tracks Window 181 
opening from Tracks window 285 
overview 21 
Pitch ruler 284, 296-297, 307-308 

listening to 307-308 

selecting all notes of one pitch 312 

Quick-Filter 292, 316, 319, 320, 328 
ReInsert 288 
scaling 326-327 
selecting events 

Continuous Data grid 319-321 

Note grid 299, 311-312 

Set Pointer Coordinates 288, 290-291 
Set Rulers 288, 294-295 
shift key 298-299 
Time ruler 283, 293-295, 300 
View Filter 287, 301 
viewing 285 
zooming 295-297, 308, 318-319 

Graphic Editing window button 65 
Greyed menu items 30 
Grid 

Chunk Grid 217 
Continuous data 315-329 
Graphic Editing window Note Grid 283, 

304-307 
offset 413 
Quantize 409, 412-413 
Step Record 154-158 

Groove Editor 500 
Groove Quantize 487-503 

applying a groove 488 
creating a groove 497 
deleting,moving,duplicating 491 
Groove folder 492 
grooves defined 487 
renaming a groove 491 

Grouping Sliders 533-538 
Grow box 34 
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H 
Half solo mode 178-179 
Handshake 384-385 
Hardware requirements 19 
Harmonic transposition 478 
Harmonies 

creating 476 
Harmonizing 472 
Help 27-30 

cursor 27 
File 27-29 
loading file 28-29 
Menu 29 

Hexadecimal 375, 377-378 
Hide Balloons 30 
Hide Clipboard 402 
High-density track segment 165, 185, 189 
Hit points 245, 253-254, 255 
Hits 

recording 652-653 
Humanize 423-428 

existing tempos 470 
tempos 573-576 

/ 
Icons 755 
Indirect time lock 602, 606-608, 619 
Information bar 282, 289-293 

Edit resolution box 282, 292-293, 300 
Event information box 282, 291-292 
Pointer coordinates box 282, 290-291 

Input Filter 134 
Patch Thru 124, 124 
System Exclusive 376 

Input Quantize 422-423 
Insert 

Conductor Track 580-581, 581-582, 583 
Event List window 258, 272-274 
Insert button 218, 219, 220-221 
inserting multiple events 

Event List window 266, 279-280 

Graphic Editing window 323-324 

Notation Editing 341-342 
Song window 220-221 

Insert button 
Chunks window 218, 219, 220, 228 

Insert column 218, 219, 220-221 
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Inserting measures 401-402, 561-562 
Instant 490 
Instant Preview 490 
Interface 

echo options with Patch Thru 124-125 
Interface Settings command 679, 716, 722 
Interfaces 

moving 702 
naming 702 

Interval transposition 475-476 
Invert Pitch 461-463 

K 
Key changes 547-551, 580-581 

Conductor track 550-551, 580-581 
custom key signatures 549 
editing 550-551 
Event List window 271, 550-551 
Graphic Editing window 303, 332-333, 550-551 

Key disk 19 
Key/scale transposing 478-480 
Keyboard commands 37-38, 99, 101, 107 
Keyboard controller 101, 107, 121 

changing values from 275, 313, 322 
Keyboard durations diagram 158 
Keyboard parts, splitting into right/left hand 442, 

449 
Keypad 90 

controls 158 
Keypad controls 83 

L 
Lead line 

enhancing 447-448 
extracting 446-447 

Legato 438-440 
Legend 

Events List window 259, 266 
Graphic Editing window 288 

Level Meter Setup 167 
Level meters 173 
Link sub-option 209 
Linking 47-49, 209 

Link sub-option 209 
Live performance 

cueing Chunks 78-81, 97, 107-108, 211-212 
linking Chunks 209 

Index 

Load 209 
Chunks 46-49 
Consoles 544 
Help file 28-29 
Remote Controls 104-105 

Local control 270 
Lock 245, 246, 252 
Locking 

disks 769 
Markers 245, 252 

locking 
Markers 246 

Loop Indicator 164 
Loop recording (Memory-cycle) 71 
Loops 197-204 

Clear Loops 203 
compared to Memory-cycle 197 
Conductor Track 589 
conflicting 199-200 
editing 

Event List window 202-203 

Graphic Editing window 303 

end time 198-201 
Event Chasing 117 
indicator 180, 198 
inserting 201-202, 303-304 
meter changes 589 
nested 198-199 
recording (See Cycle-recording) 
recording while looping 204 
repetitions 197, 201 
set Loop 200-201 

Graphic Editing window 300 

Start time 198-201 
Tracks window 189-190 
Tracks window indicators 173 
versus Repeat 406 
viewing 

Event List window 202-203 

Low-density track segment 185, 189 

M 
MacDraw 367 
Macintosh 

68020-based 238 
Classic 30 
color monitors 31 
2. 256 
IIcx 19 
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IIx 19 
keyboard equivalents 83, 99, 101-102, 107 
mouse 35 
Plus 30 
SE 30 

SE/30 19 
user interface 31-38 

Macintosh Keyboard Controls 83 
Macros 107 
Manual button 84-85 
Manual end time 79, 206, 214-215, 231 
Manual tempo mode 563 
Margins 359 
Marker strip 

Graphic Editing window 283, 302-304 
Song window 218, 229-230 

Markers 245-256 
Add 246, 248 
changing font in notation window 354 
changing location 249, 252-253, 333 
Conductor Track 252, 332-333, 584 
Delete Markers 219, 229 
Deleting 246, 251 
displaying in notation window 354 
Event List window 251, 271 
Graphic Editing window 251, 302, 332-333 
hit points 245, 253-254 
locating with 249 
Lock 245, 246, 252 
Merge Markers 229 
mini-menu 246 
naming 246, 248 
Notation Editing window 251 
opening Markers window 247 
position indicator 246, 249 
printing 666 
Record hits 246, 253-254 
selecting 250 
setting Counter location 249 
Shift locked markers 246, 252-253 
Song window 218, 219, 229-230 
streamers 653-654 
time display 245 
Unlock 246, 252 

Markers window 
Generate VTP Streamers 246 

Markers window button 66 
Master Control 99, 100-101 
Master disk 19 
Master sliders 533-538 
Matching sliders 533-534 
Measure button 140, 152 

784 

Measure numbers 
display options 355 

Measure range 
Change Key 547, 549 
Chafige Meter 554; 557 
selecting 181-183, 272 

Measure spacing 356 
Measure time 38 

Events List window 259 
Graphic Editing window 289, 294-295 

Median strip 284, 329-331 
Conductor Track 332-333 

Melody 
enhancing 447-448 
extracting 446-447 

Memory 
Message Center 769 
RAM 239 
running out of 59, 239 
saving with the Link feature 209 

Memory Bar 66, 71-72, 81-82 
Memory window 239-240 
Memory-cycle 

compared to loops 197 
loop points 164 
repeat barlines 72 
selecing the region 74, 394 
setting end points 73 
when applying a groove 488 

Memory-shuttle 71-72, 81-82 
Memory-shuttle button 66 
Merge 400 
Merge Chunks to Sequence 47, 220, 229 
Merge Markers 219, 229 
Merge Tracks with identical names option 220 
Message Center 212 

RAM available 769 
Meter 

display 86 
Meter changes 553-562, 581-582 

Conductor Track 581-582 
Edit Filter 560-561 
Event List window 271, 559-560, 581-582 
Graphic Editing window 303, 332-333 
inserting measures 561-562 
looping 589 
partial measures 588-589 

Meter maps 555, 589 
Metronome 84-86 

beat value 86 
button 66 
marking 355 

Index 



slider 86, 87-88 
remote control 85-86 

Metronome window 
Automatic tempo mode 563 
Click 233 
Click value 233, 554, 557, 581 

Tap Tempo 612 
Manual tempo mode 563 

Mid-beat 573 
MIDI 

Activity meters 173 
beat clocks 242, 601-602, 603-606, 763-765 

converted from SMPTE 603, 763 

implementation 763-765 
start/stop clocks 601-602, 604, 627, 764 

timing clocks only 764 
transmitting 625-627 

channels 166, 168, 173 
activity 242 

playback 110-111, 129, 166, 168, 174 

recording 132-134, 168, 173 

Tap tempo 612-613 
controller 

instruments 19 

controllers 451-453 
Audible Mode 278 

controlling volume 436 

Edit Filter 397 

Event List window 268-269, 269, 275, 279 

Input Filter 135 

Tap tempo 613, 616 
View Filter 264-265 

data stream 116 
delay 771-772 

Patch Thru 124-125 

echo 121-125 
echo options with Patch Thru 124-125 
Edit 288, 309-310, 313, 322 
events 

Event List window 267-271 

Graphic Editing window 291-292 

interface 645-648 
logjam 771-772 
mapper 124 
merger 124 
Monitor window 241-243 
rechannelizer 124 
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Song Position pointer 242, 601-602, 606 
Song Select 107-108, 205-206, 212 
System Reset 242 
thru 121-125 
Thru connections 697 
Time Code 602, 611 
Time Piece 645-648 
timing clocks 601-602, 603-606, 763 

transmitting 625-627 
transmission rate 453, 771-772 
variations in implementation 764-765 

MIDI Activity Meters 166 
MIDI Configuration 

window 
button 66 

MIDI Express 
SMPTE sync with 609 

MIDI files 
opening 45 

MIDI Machine Control 
Auto Record Advance option 636 

MIDI machine control 629-643 
MIDI menu 

Audition Channels command 724 
Check Connections command 712, 723 
Interface Settings command 716, 722 
MidiLocate command 709, 723 
Panic command 712, 724 
PatchThru command 707, 723 
Popup Patchlists command 706, 724 
Return command 722 
Transport Controls 723 
Transport Controls command 710 

MIDI Monitor window 241-243, 651, 770 
MIDI Sequencer 

description 19 
MIDI Time Code 

view with MIDI Monitor 651 
MIDI Time Piece 598, 645-648, 765 

SMPTE sync with 609 
MIDILocate command 709 
MidiLocate command 723 
Mini-menu 32 

Chunks window 206-207 
Event List 259 
Graphic Editing 287-289 
Markers 246 
MIDI Monitor 242 
Notation Editing 336-338 
Remote Controls window 99 
Song window 219-220 
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Step Record window 140 
Tracks 166-168 

Mode changes 
Event List window 270 
Graphic Editing window 330 

Modem port 241 
Modes 

transposing 478 
Module 121, 124 
Monitor Patch Changes FreeMIDI option 175 
Mono key pressure 452 
Mono mode 270 
More Choices button 490 
Mosaic 139 

Edit FreeMIDI Configuration command 687 
Mouse techniques 35-37, 298-299, 327-328 

dragging in Song window 224 
Move handle 

Chunks window 205, 213, 215 
Median strip 305, 330 
Track Window 166, 172-173 

Move releases to closest attack 438-439 
MultiRecord 132-134, 167 

Tap Tempo 615 
Multi-track audio recording 618-621 

N 
Naming 

Chunks 206 
Files 49-51 
Markers 246, 248 
Song window 218 
Tracks 164, 174-175 

New 44, 56-57 
New command 719 
New device group command 110 
No accent option 235 
Notation (see QuickScribe notation window) 
Notation Editing Window 335-344 

inserting notes 341-342 
Notation Editing window 

overview 22 
Notation Editing window button 65 
Note events 

doubling 448-449 
Event List window 267 
Graphic Editing window 284, 305-307, 308-314 
mapping to single pitch 482-483 
randomizing 423-427 
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setting preference for the display of 680 
Note grid 

Graphic Editing window 283, 304-314 
Step Record 154-158 

Null points 535-536, 538 
Numerator 554 

O 
Octave range 

transposing 481-482 
Octave Up/Down buttons 336, 339-340 
Odd Meters 596 
Off velocities 432, 445 

Event List window 267 
Graphic Editing window 306-307, 318 

Offset 
grouped sliders 534 
SMPTE 

bit 92 

Chunk start time 90-92, 222, 608, 610, 619 

converter start frame 606, 619 

Offset grid option 413 
Offset option (Step Record) 140 
OK is first beat option 594 
Omni mode 270 
On velocities 432, 445 

Event List window 267 
Graphic Editing window 306-307, 318 

One new track option 443 
One track option 443 
On-line Help 27-30 
Only during countoff option 235 
Only move barlines 559 
Only when recording option 235 
Opcode 

Studio 5™ 622 
Opcode Studio 5 

syncing to SMPTE with 622 
Open 44-45 
Open Chunks 206, 212 
Open command 719 
Open-loop (MIDI Machine Control) 631 
Options 5065, 576 
Overdub 69-70 

looping 204 
Overdub record 

button 65 
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p 
Page numbers 369 

starting number 352 
Page size 359 
Palette 360 
Panic command 679, 712, 724 
Partial measures 588-589 
Partial solo mode 178-179 
Parts per quarter note 38 
Paste 399, 402-404 

Conductor track 584-585 
Event List window 272 
Song window 224 

Paste command 695, 721 
Patch change 

Event List window 267-268 
Patch chasing 116-117 
Patch List 

window 175 
Patch list 

printing 666 
Patch Lists 175 
Patch lists 706 
Patch Thru 121-125 

Audition Channels setup 707 
Auto Channelize 122 
Direct Echo 122 
Input Filter 124, 124 
MIDI delay 124-125 
MIDI interfaces 124-125 
MIDI merge 124 
MultiRecord mode 123-124 
Song Window 124 
timing information 124 

Patch Thru command 707 
PatchList Manager 706, 725 

add Patch List command 739 
bank select 747 
configure device command 733 
create module command 754 
creating a new patchlist 732 
creating patchlists by hand 739 
delete module command 754 
device help command 734 
editing a patchlist 742 
grouping patchlists into a folder 746 
importing patchlists 737 
importing Performer/Digital Performer patch 

lists 737 
loading patch names 732 
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loading Unisyn patchlists 738 
multiple patchlists 747 
overview 726 
re-initializing 752 
saving patchlists 752 
set numbering format command 740 

PatchThru command 723 
Patterns 

see Memory-cycle 
see the Song window 

Pause button 68 
Performer 

as master sync device 625-627 
as MIDI merger 124 
Cycle-record 132 
Edit FreeMIDI Configuration command 687 
files 

opening 45 

Hardware requirements 19 
MIDI Time Piece 645-648 
overview 19-25 
user interface 31-41 
Version 1 files 

opening 45 

version number 773 
phrases 

playing 277-278 
Piano parts 

splitting into right/left hand 442, 449 
piano roll 20 
Pick-up 

beats 596 
measure(s) 596 

Pick-up measure(s) 93-94 
Pitch 

Click & Countoff Options 235 
Pitch bend 452 

determining value range 279 
Event List window 267 
Graphic Editing window 315, 316, 317-318 

Pitch ruler 284, 296-297, 307-308 
listening to 307-308 

Play button 67 
Playback 109-120, 174 

channels 110-111, 129, 166, 174 
chasing during 116-117 
Chunk 211-212 
controller chasing 116-117 
Event List window 276-278 
features active during 67, 115-116 
locating with mouse 186, 294 
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selecting a device 111 
sequence 211-212 
song 211-212, 223 
System Exclusive 376 
track play assignment 111 

Play-Enable button 109, 110, 166, 174, 177, 
184-185 

Chunks window 205, 211-212 
Play-enabling chunks 66 
player piano 19 
Play-Select button 109-110, 166, 174, 177, 184-185 

Chunks window 205, 211-212 
Pointer coordinates box 282, 290-291 

Set Pointer Coordinates 288, 290-291 
Polarity 534-535 
Poly key pressure 452 

Event List window 269 
Popup Patchlists 706 
Popup Patchlists command 706, 724 
Preferences 

Startup options 58 
Preferences command 680 
Preroll option 635 
Printer port 241 
Printing 345-373, 665-669 

instrument parts 371 
keyboard part 372 
list windows 666 
margins 359 
page size 359 
score 372 
title page 352 

Professional Composer 229 
files 

opening 45 
opening files from 45 
Saving As 54-55 
separating keyboard part for 446-447, 449 

Properties 716 
Punch-In 

recording with sliders 530-531 
Pushdown box 33 

Q 
Quantize 409-419 

Attacks 410-411 
Don't change duration option 411 
Durations 410-411 
for notation 349 
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freely played music 592 
erid 409, 412-413 
Input 422-423 
Offset grid option 413 
Releases 410-411 
Sensitivity option 415-416 
Strength 416-417 
Swing 414 
tuplets 412, 412-413 

Quick Setup command 684, 722 
Quick-Filter 292, 316, 319, 320, 328 
QuickScribe notation window 345-373 

date 369 
displaying markers 354 
inserting notes 361 
margins 359 
measure numbers 355 
page numbers 369 
page size 359 
Score Options 352 
Text 367 
Tool palette 360 
track splitting 357 

Quit command 720 
Quitting Performer 57 

R 
Radio buttons 35 
RAM 239, 769 
Random Pitch Map 425-427 
Randomize 

quantizing 417 
tempos 470, 573-576 
velocities 435 

Real time 38 
building a song 221 
editing 40-41, 60, 67, 115-116, 395, 409, 451 

Realign music automatically 557-558 
Reassign Continuous Data 460-461 
Receive Sync 601-622 

MIDI Machine Control 638 
Recent Files pop-up menu 490 
Record Beats 591-599 
Record hits 246, 253-254 
Record while still framed 136 
Record while still-framed 618, 652, 653 
Record-enable Conductor 219, 226-228 
Recording 69-70, 76-77, 81-83, 127-136 

Auto-Record 65, 69, 76-77, 81-83, 136, 182 
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Bar 69, 76-77, 81-83 

button 69, 76-77, 81-83 

Tap Tempo 617 
Chunk 211 
Conductor Track 614-615 
hits 246, 253-254, 652-653 
in a sequence 211, 218, 219, 224-226 
in a song 224-226 
in external sync 136 
Input Filter 124, 134 
memory allocation 769 
MultiRecord 123-124, 127-134 

Tap Tempo 615 
quantizing on input 422-423 
real-time 127-134 
Record channels 132-134, 134 
Record-Enable button 129, 133, 166, 173 
Set Record sequence 219, 224-226 
Sliders 529-531 
step recording 134, 139-159 
System Exclusive 376, 381-384 
Tap tempo 614-615, 616 
Undoing 70 
while looping 204 

Recording on option (Step Record window) 139 
Redo/Undo 397-398 

Graphic Editing window 301 
Song window 224 

Region menu 409-449, 451-485 
Change Continuous Data 458-460 
Change Duration 436-441 
Change Velocity 430-436 

limiting velocities 432 

Create Continuous Data 455-457 
DeFlam 418, 428-430 
Groove Quantize 489 
Invert Pitch 461-463 
Quantize 409-419 
Reassign Continuous Data 460-461 
Retrograde 463-465 

Graphic Editing window 300 

Reverse Time 463-465 
Scale Time 465-467 
Split Notes 441-449 
Thin Continuous Data 453-455 
Transpose 409, 471-485 

Region selection 
Event List window 263, 391 
Graphic Editing window 300, 311-312 
Tracks window 387 
using Markers 250-251 
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with the Edit Bar 181-182 
with the Tracks window 182-183, 187 

Registration 
care £9. 773 
number 773 

Rehearse mode 635 
RelInsert 

Event List window 259, 266 
Graphic Editing window 288 

Releases 
Extend Releases to Closest Attack 439-440 
Move Releases to Closest Attack 438-439 
Quantize 410-411 

Remember Times 74, 82, 83, 182, 250-251, 
275-276, 389-390 

Remote Controls 97-108 
Add Defaults 99, 104 
Add Master 99, 103 
cueing with 97, 107-108, 212 
customizing 100-104 
Cycle-record control 132 
Delete 99, 103-104 
Duplicate 99 
Loading 48, 104-105 
Macros 107 
Master 98-99, 100-101 
Master Control Status icon 99 
opening Remote Controls window 98 
Play-enabling chunks 79 
Play-enabling with 97, 107-108, 212 
printing 666 
Saving 100, 104, 105 

Remote Master 98, 100-101 
Repaginate command 359 
Repeat 399-400 

Conductor track 589 
Event List window 272 
Graphic Editing window 300 
versus looping 197, 406 

Repeat barlines 72 
Resolution 38 
Restoring 

deleted Remote Controls 104 
Retrograde 463-465 

Event List window 272 
Graphic Editing window 300 

Return command 722 
Reverse Time 463-465 
Revert command 720 
Revert to Saved 55 
Rewinding 68, 70-71, 71-72, 81-82 

Markers 246, 249 
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Ritard 611 
Rt light 651 
Rubato 611 
Rulers 167 
Running update option 162 

S 
Safe option in MMC window 635 
Save 49-50 
Save As 50-54 
Save As ‘New’ Template 55-57 
Save As command 719 
Save As Composer 54-55, 229 
Save As MIDI File 51-54 
Save As Performer 2.41 54 
Save command 719 
Saving 

files 49-55 
Remote Controls setup 100, 104 
sequences 49-55 
Transpose maps 474 

Scale Tempo command 467-470 
Scale Time 465-467 
Scale/key transposing 478-480 
Scaling 

Sliders 534 
Score Options 352 
Screen updating 94-95 
Scroll bar 32 

Tracks window 176 
Seamless chaining 79, 80, 81, 217-231 
Seek (Markers window) 246 
Segments 185, 187, 189 

selecting 390-391 
Select All 402 
Select All command 721 
Select Notes 445 
Selecting 366 

all notes of a single pitch 312 
Chunks 208, 218, 223 
events 

Continuous Data grid 319-321 

Event List window 263 
Notation Editing window 342-343, 366 
Note grid 284, 299, 311-312 

Markers 250 
Notation window 366 
Song window 394 
Tracks 180, 182-183, 187 
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Selecting a region 387-394 
all notes of a single pitch 312 
Edit Bar 181-182 
Event Editing window 391 
Event List Window 263, 391 
Graphic Editing window 300, 311-312 
Markers 250-251 
Song window 218, 223 
Tracks Overview 390-391 
Tracks window 182-183, 187, 391 

Sensitivity 415-416 
Separate tracks by pitch option 443 
Sequence controls 78-81 
Serial number 773 
Set Chunk Start 90-92, 93-162, 230, 596, 608, 610, 

619 
Chunks window 207 

Set Countoff 74-75 
Set Density Threshold 165, 167, 185, 189 
Set Display 94, 161 
Set Loop 200-201 

Graphic Editing window 300 
Set Loop button 65 
Set number of tracks command 636 
Set Pointer Coordinates 288, 290-291 
Set Record sequence 219, 224-226 
Set Rulers 167, 288, 294-295 
Set Score Length command 359 
Set View Filter 115, 167 
Shift 401-402 

attack times 406-407 
Shift data to option 594 
Shift locked markers 246, 252-253 
Shortcut commands 37 
Show all input devices command 242 
Show controllers only command 243 
Show/Hide 

Balloons 29 
Clipboard 402 

Skip buttons 64, 78-79, 81 
Slave sliders 533-537 
Slave to External Sync 605, 608, 610, 619, 767 
Slave to external sync 

Record Beats 597-599 
Tap Tempo 661-664 

Slave to External Sync 614 
Sliders 183-184, 505-545 

loading from another file 544 
Smart Quantize 419-422 
SMPTE 38-39, 602, 618-621 

29.97 drop & non-drop 607, 610 
bit offset 92 
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bits per frame 92 
converter start frame 606, 619 
converters 601-602, 618, 645-647, 765-768 
Direct time lock 242, 602, 609-611, 646, 

647-648, 765-768 
Drop frame 607, 610 
Enhanced Direct time lock 646, 647-648 
frame time display 38-39, 94, 289, 290, 294-295 
Indirect time lock 602, 606-608 
multi-track audio recording 618-621 
offset 95 
Overview 22 
Set Chunk Start 90-92, 230, 608, 610 
Slave to External Sync 608, 610, 619, 767 
sliding synchronized parts 620-621 
standard MIDI beat clocks 603, 763 
Start time 230 
syncing with the Studio 5 622 
tape striping 618 

SMTPE 

start time 639 
Snip 401 

Event List window 272 
Graphic Editing window 300 

Solo Button 164 
Solo Playback option (Step Record) 140 
Solo Setup 167 
Soloing tracks 116, 166, 177-178, 184-185 

partial solo mode 178-179 
Song Change 242, 268 
Song Position pointer 22, 242, 601-602, 606 
Song Select 107-108, 205-206, 212 
Song window 217-231 

Add Song 206, 208 
Chunk Grid 217 
Chunk size 218 
Columns 218, 219, 220-221 
Copy all tracks option 220 
Copy Conductor Tracks 219, 230 
creating a song 221-223 
Delete Markers 219, 229, 251 
dragging in 224 
echo effect with 228 
Edit commands 218, 223-224 
Edit Conductor Track 219 
End times 220, 231 

Insert column 218, 219, 220-221 
Markers 218, 219, 220, 229-230 
matching chunk times 230 
Merge Chunks to Sequence 47, 220, 229 
Merge Markers 219, 229 
Merge Tracks with identical Names 220 

Index 

mini-menu 219-220 
name 218 
names 218 
opening 206, 212, 221 
Patch Thru 124 
playing a song 223 
Record-enable Conductor 219, 226-228 
recording into a sequence 218, 219, 224-226 
selecting 223 
Set Record sequence 219, 224-226 
song description 208 

Song window button 66 
Sound module 124 
Speaker volume 236, 237 
Splice 401 
Split Notes 441-449 
Spot-erase 105, 132 
Staccato 441 
Staff names 

changing font in notation view 353 
Staff system 

bracket 354 
spacing 353 

Standard beat clocks 242, 601-602, 603-606, 
763-705 

converted from SMPTE 603 
implementation 763-765 
start/ stop clocks 601-602, 604, 627, 764-765 
timing clocks only 764 
transmitting 625-627 

Standard MIDI beat clocks 22 
Startup options 58 
Step button 140, 149-150 
Step Duration buttons 139 
Step Record 134, 139-159 

Audible button 140, 150 
Auto Step 140, 149 
Backstep button 140, 149, 152 
Beat button 140, 152 
dot boxes 139, 145 
duration 140 
keyboard diagram 158 
manual stepping 150, 159 
Measure button 140, 152 
Mini-menu 140 
Offset Option 140 
remote controls 100 
selecting durations 144-146, 154-158 
Solo Playback option 140 
Step button 140, 149-150 
Step Duration buttons 139 
Tick box 140 
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tick box 146 
Transport Lock button 140 
tuplet box 140, 145-146 

Stop button 68, 71 
Streamers 653-654 
Strength 416-417 
Striping SMPTE 618 
Studio 5 

syncing to SMPTE with 622 
Studio 5™ 

Syncing to SMPTE with 622 
SuperPaint 367 
Sustain pedal 269 

Tap Tempo 616-617 
Swing Quantize 414 
Synchronization 

basic types 601-603 
Chunks in Song window 229-230 
Direct time lock 242, 602, 609-611, 646, 

647-648, 705-768 
Enhanced Direct Time Lock 765-768 
Enhanced Direct time lock 646, 647-648 
FSK 602, 603-606 
Indirect time lock 602, 606-608, 619 
MIDI Monitor window 241-243 
MIDI Time Piece 646, 647-648, 765 
multi-track audio recording 618-621 
overview 22 
Record Beats 597-599 
recording in external sync 136 
Slave to yee Sync 605, 608, 610, 614, 619, 

707 
SMPTE 38-39, 602, 618-621 
Song window 229-230 
specifications 763-768 
Standard beat clocks 242, 601-602, 763-765 

converted from SMPTE 603 
implementation 763-765 
start/ stop clocks 601-602, 604, 627, 764 

timing clocks only 764 
transmitting 625-627 

Tap tempo slaved to tape 661-664 
Tempo Slider 87-88 
VITC 650-653 

System 
compatibility with Performer 234 
troubleshooting 770 

System common MIDI data 242 
System errors 769, 774 
System Exclusive 375-385 

Audible Mode 278 
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editing 
Event List window 269, 274, 380-381 

Graphic Editing window 330 

sysex editing window 378-380 

generating with slider 539-542 
handshake 384-385 
Input Filter 376 
inserting in Event Editing windows 380-381 
insertion mode 378, 381 
playback 376 
recording 376, 381-384 
replacement mode 378-380 
viewing 

Event List window 269 
System real time MIDI data 242 
System Reset 242 
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Tap first beat 595 
Tap Tempo 

slaved to tape 661-664 
Tap tempo 602-603, 611-618 

channel 612-613 
click value 612 
Conductor Track 614-615, 617-618 
countoff 614 
event 612-613, 614 
overview 22 
recording 226-228, 614-615 
recording music 615 
tap source 614 
tempo maps 226-228, 563, 616 

Tape position message 767 
Target track 515-516 
Techical support 19 
Template files 55-57 
Tempo 

Anchor indicators 564, 569-570 
automatic mode 563 
basics 86 
Change Tempo 563-577 
curves 570-573 
density 5605, 569 
humanize 470 
in a Song 226-228 
manual mode 563 
maps 563, 566-567, 616 
mid-beat 573 
randomize 470 
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randomizing 573-576 
recording 614-615 
resolution 87, 569 
scaling 467-470 
setting 86-87 
synchronization 611-618 

Tempo changes 563-577, 582-584 
Anchoring tempos 564, 569-570 
beat value 564, 568-569 
Change Tempo 563-577, 582-584 
editing 576-577 
Event List window 271, 582-584 
Graphic Editing window 333-334 
recording into a song 226-228 
resolution 87, 569 

Tempo Slider 86, 87-88 
remote control 85-86 
resoluion 87, 569 

Tempo slider 63 
Tempo Slider Remote Control 64 
Text 367 

box 
defined 367 

typing and editing 370 
The 163 
The Page Setup command 720 
The Print command 720 
Thin Continuous Data 453-455, 771 

MIDI logjam 453, 771-772 
Thru connections 697 
Tick box 140, 146 
Ticks 38-39 
Time 

display 90 
Event List window 259, 262 
formats 88-89 
frame time 38, 90-92, 218, 259, 262 
Graphic Editing window 283, 293-295 
measure | beat | tick time 38, 218, 259, 262 
real time 38, 218, 259, 262 
specification 38-39 
step time 127, 134, 139-159 

Time Ruler 164 
Time ruler 

Graphic Editing window 283, 293-295, 300 
locating playback 294 

Song window 218, 220 
Tracks window 186 

locating playback 186 
Timecode bits 92 
Timecode track option 637 
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Timing clocks 242, 601-602, 603-606, 763 
transmitting 625-627 

Timing resolution 
beats per minute 87, 569 
frames 92 
ticks 38 

Title page 352 
Tool palette 360 
Tracks 

splitting in notation window 357 
Tracks Overview 164, 185-191 

segments 
selecting 390-391 

Tracks window 163-191 
adding tracks 166, 179 
Auto-Scroll 185-186 
comments 165, 176 
Conductor Track 165, 579-589 
copying Tracks between Sequences 216 
Create Chunk 167, 190-191 
customizing 192 
deleting 168, 180 
Device Patch 165, 175 
Edit 167 
Edit Bar 164, 181-182, 187 
editing multiple tracks 402-404 
ellipsis in play assignment 115 
Goto 167 
Goto Counter 167 
hiding columns 171 
Loop Indicator 164 
loop indicator 180, 198 
Loops 189-190 
Move handle 166, 172-173 
MultiRecord 167 
naming 164, 174-175 
opening a Graphic Editing window 285 
opening a new Tracks window 168-169, 206, 

Ziz 

Opening an Event List window 259 
opening in Song window 218 
partial soloing 178-179 
pasting 216 
playback channels 110-111, 129, 166, 168 
playback devices 174 
Play-Enable button 166, 174, 177, 184-185 
Play-Select button 166, 174, 177, 184-185 
printing track list 666 
Record-Enable button 129, 133, 166, 173 
recording channels 132-134, 134, 168 
re-ordering columns 172 
selecting 180, 182-183, 187 
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selecting a region 181-183, 391 
Set Density Threshold 165, 167 
Set Rulers 167 
Set View Filter 167 
soloing 116, 166, 177-178, 184-185 
Time Ruler 164, 186 
View Filter 188-189 
Zoom buttons 165 

Tracks window button 65 
Transcription 592 
Transmit Sync 625-627 

echoing sync 625-626 
generate sync 626 

Transport Controls 710 
Transport Controls command 723 
Transport Lock button 140 
Transpose 471-485 

key/scale transposing 478-480 
Map 473-475 
saving maps 474 

Triplets 
notating 350 
Quantize 412, 412-413 
Step Record 145-146 

Troubleshooting 769-774 
checking MIDI input/output 712 
disk errors 59-60, 769, 772, 773 
error messages 59-60, 769, 774 
file errors 59-60, 770, 772 
fonts 371 
Help feature 27-30 
MIDI Monitor window 241-243 
system errors 769, 774 

Tune request 242, 269 
Tuplet box 140, 145-146 
Tuplets 

notating 350 
Quantize 412, 412-413 
Step Record 140, 145-146 

Type icon 205, 213 

U 
Undo command 721 
Undo/Redo 397-398, 398, 471 

Graphic Editing window 301 
Record 70 
Song window 224 

Unisyn 671-677 
Edit FreeMIDI Configuration command 687 
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Unlock 246, 252 
Unlocking markers 246, 252 
Update Interfaces command 699, 701, 722 
Use all channels 708 
Use default channel only option 708 
User Interface 31-41 
Utilities disk 27 

V 
Velocities 

Change Velocity 430-436 
Click & Countoff Options 235 
limiting 432 
Off Velocities 267, 306-307, 318, 432, 445 
On Velocities 267, 306-307, 318, 432, 445 
randomizing 435 

Version numbers 
Performer 774 

Vertical Interval time code 650-653 
Video Time Piece 598, 649-660, 661 

Generate VTP Streamers option 246 
View Filter 167, 259, 263-265, 287, 301, 307, 

316-317, 770 
Conductor Track 585-588 
Tracks window 188-189 

View menu 714, 724 
VITC 650-653 
Volume 

Click 236, 237 
creating volume changes 436 

W 
Wait button 65 
WC Research, Inc. 502 
Window mini-menu 32 
Windows 31-34 

Fs 
Zoom box 34 
Zoom buttons 

Tracks window 165 
Zooming 

Continuous Data Grid 318-319 
Graphic Editing window 295-297 
Pitch ruler 308 
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shortcuts 298, 344 
Time Ruler 295 

Tracks window 186-187 
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